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Part I.

Unit 1: Background
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1. Knowing before Making
Blender is a powerful and complex 3D modeling and rendering package. Before you can use
it eﬀectively to make things, you need to know a few things about how it works:
•
•
•
•
•
•

the process of 3D modeling and rendering (what Blender does)
some rudiments of 3D analytic geometry (axis and coordinates)
orthographic and perspective views of a 3D object
local coordinate systems and child objects
the fundamentals of Blender's user interface (hotkeys, windows, and menus)
how to view a 3D scene from diﬀerent vantage points (in Blender)

This unit is devoted entirely to this sort of background knowledge. You won't create your
ﬁrst Blender model until the next unit.
Knowing this, you might be tempted to skip ahead. Depending on your background, that
may or may not work. For instance, if you've used other 3D graphics packages, you might
be able to skim (or skip) ahead as far as the user interface tutorial. But if there's any doubt,
please proceed through the tutorials in sequence.
Blender is not the kind of software you can launch into and grope about until
you ﬁnd your way. It's not like exploring an unfamiliar city. It's more like ﬂying
a spaceship. If you hop into the pilot's seat without knowing the fundamentals,
you'll be lucky to ever get oﬀ the ground, and it'd take a miracle for you to
reach your destination safely.

1.0.1. A Word about Jargon
Like any subject, 3D modeling has its own jargon: terminology speciﬁc to the subject and
ordinary words that have special meanings in the context of computer graphics.
In this book, important new words are highlighted on ﬁrst appearance and deﬁned soon
after. If you suspect you've missed (or forgotten) the meaning of a word, try looking it up
in the Glossary1 .

1.0.2. Things You'll Need
In order to work through the tutorials, you'll need access to a computer that has Blender
installed (download the latest stable release2 ).

1
2

Chapter 213 on page 1735
http://www.blender.org/download
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Depending on what is installed on your system, you may also need the appropriate Python
installation. Each version of Blender works with only one speciﬁc version of Python, which
is generally included in the download.
Blender version
2.49
2.5x
2.6
2.76
2.77
2.78
2.79

Python version
2.6
3.2
3.3
3.4
3.5
3.5
3.5

Since Blender is open-source software, you can download the source code and build it
yourself, but it's easier to download a pre-built install package. Install packages are provided
for each supported operating system:
•
•
•
•
•
•

Microsoft Windows (32-bit and 64-bit)
Linux (32-bit and 64-bit x86)
Apple Mac OS X (PowerPC and Intel)
FreeBSD (32-bit and 64 bit)
Solaris
Irix

Many Linux distributions have Blender available in their package repositories, though it
may be a slightly older version. You can use your system's package manager to download
and install the package.
Windows users get to choose between an executable installer (”setup wizard”) and a ZIP
archive.
After the installation process is ﬁnished, Blender should appear in the Graphics section of
your desktop environment application menu.
You may also want to download a 2D image editor, such as GIMP (http://www.gimp.
org/downloads), Paint.NET (http://www.getpaint.net/), or Photoshop. For viewing
video ﬁles, you may want to install VLC (http://www.videolan.org/vlc/index.html)
media player.
It's a good idea to have pencil and paper handy for sketching and taking notes. There's a
lot to absorb. Taking notes as you go will pay dividends later.

1.0.3. Where to Go for Help
If you get stuck, you can ask for help from other Blender users3 in the appendices4 .

3
4

6

Chapter 218 on page 1751
https://en.wikibooks.org/wiki/..%2F%23Appendices

Additional Resources

1.1. Additional Resources
Many modules have a section like this at the bottom, listing websites with information on
the topics covered in the module.
•
•
•
•
•
•

Blender system requirements5
the GIMP6 wikibook
Windows installation7
Linux installation8
OSX installation9
About the Python programming language10

ko:블렌더_3D_배우기/만들기_전에_알아야할_것11

5
6
7
8
9
10
11

http://www.blender.org/features-gallery/requirements/
https://en.wikibooks.org/wiki/GIMP
http://wiki.blender.org/index.php/Doc:Manual/Introduction/Installing_Blender/Windows
http://wiki.blender.org/index.php/Doc:Manual/Introduction/Installing_Blender/Linux
http://wiki.blender.org/index.php/Doc:Manual/Introduction/Installing_Blender/Mac
http://www.python.org/about/
https://ko.wikibooks.org/wiki/%EB%B8%94%EB%A0%8C%EB%8D%94_3D_%EB%B0%B0%EC%9A%B0%EA%
B8%B0%2F%EB%A7%8C%EB%93%A4%EA%B8%B0_%EC%A0%84%EC%97%90_%EC%95%8C%EC%95%84%EC%95%BC%
ED%95%A0_%EA%B2%83
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2. What Blender Can Do
In this module, you'll learn what Blender does, both in terms of the product (images) and
the process (3D modeling).
Blender is a free software1 package for authoring ”three-dimensional” (3D) graphics (also
known as computer graphics or “CG”), including still images, games, and video.
While the end-product of most Blender projects is a two-dimensional (2D) raster image on
a ﬂat surface (be it a monitor, movie screen, or sheet of paper) except for Head Mounted
Virtual Reality applications, the images are said to be ”3D” because they exhibit the illusion
of depth. In other words, someone looking at the image can easily tell which parts are
meant to be closer and which are farther away.

2.1. An Example
Here's a realistic still image that was authored with Blender.

Figure 1

1

”A Lonely House”, by Mayqel

https://en.wikipedia.org/wiki/free%20software

9

What Blender Can Do
Look closely at the building.
• Because it is obscured by the building, you can tell that the tree-lined hillside is behind the
building instead of vice versa.
• The way the top and bottom edges of the front wall appear to converge toward the base
of the tree allow you to judge the angle between the front wall and your viewpoint.
• Your brain interprets dark portions of the wall as shadows, allowing you to estimate where
the light is coming from, even though the sun is outside the frame of the image.
While an illusion of depth can be authored by hand with 2D graphics software (or a paintbrush!), Blender provides a much easier way.
It's likely that the lonely house never existed outside of the artist's mind. Instead of building
a big set on a rural lot in Germany, waiting for the right light, and photographing it, the
author built a scene in a virtual 3D world—one contained inside a computer. This is called
CGI (Computer Generated Imagery). He or she then used Blender to render the scene
(convert it into a 2D image). You can view more of what Blender can do at the Blender
gallery: http://www.blender.org/features/

2.2. Steps in the 3D Production Process
To produce an image like the one above involves two major steps to start with:
• Modelling, which is the creation of your miniature 3D world, also known as a model
or scene. This involves deﬁning the geometry of the objects, making it look like they
are made out of particular materials, setting up the lighting, and deﬁning a camera
viewpoint.
• Rendering, which is the actual generation of the image of the world from the viewpoint
of the camera (taking a “photograph” of the scene, if you like), for your audience to enjoy.
3D is often used to produce not just single still images, but animations as well. This
requires some additional steps:
• Rigging — setting up a rig, namely a way of deforming (changing the shape of)
a character in various repeatable ways to convincingly mimic joint movements, facial
expressions and other such actions of real-life people or animals.
• Posing — choreographing the positions of the objects and their parts in the 3D scene
over time, using the previously-created animation rigs
• Rendering now involves creating a whole sequence of frames representing movement over
time, rather than just a single still frame.
But that’s not all. There are frequently additional processes to embellish the results of the
above, to make them look more realistic:
• Sculpting — a more organic form of modelling objects by shaping them as though they
were made out of clay. This produces more complicated, irregular shapes which mimic
real objects found in nature, as opposed to clean, simple, geometrical ones which mostly
only exist in the world of mathematics.
• Texture painting — You’re probably familiar with programs that let you paint an image
on a 2D digital canvas. Such programs are commonly used in 3D production, to create
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textures which are “wrapped” around the surfaces of 3D objects to give them a more
interesting appearance. 3D programs also often allow direct painting on the surfaces of
those objects, so the eﬀect of the design can be observed immediately, instead of having
to go through a separate paint-on-a-ﬂat-surface-then-wrap sequence of steps.
• Physical modelling — simulating the behaviour of real-world objects subject to realworld forces, for example hard balls colliding, soft cloth draping itself over an obstacle
under gravity, water ﬂowing and pouring. Mathematical formulas are available for these
that give results very close to real life, all you need is the computing power to calculate
them.
• Motion capture, or mocap: producing convincing animations, particularly ones that
look like the movements of real people (walking, running, dancing etc) can be hard.
Hence the technique of capturing the motions of live actors, by ﬁlming them with special
markers attached to strategic points on their bodies, and doing computer processing to
track the movements of these markers and convert them to corresponding movements of
an animation rig.
• Compositing — this is where 3D renders are merged together with real
photographic/live-action footage, to make it look like a rendered model is in the middle of a real-world scene, or conversely a real live actor is in the middle of a rendered
scene. If done with proper skill, in particular due care to matching the eﬀects of lights
and shadows, the viewer becomes unable to tell what is real and what is not!
And just to add another complication to the mix, there are two kinds of rendering:
• Real-time rendering is rendering that has to happen under tight time constraints, typically for interactive applications like video gaming. For example, most gamers expect the
screen to be updated 60 times per second in order to render smooth motion and respond
quickly enough to player actions. These time constraints impose major limitations on the
kinds of rendering techniques that can be used.
• Non-real-time rendering is where the time constraints are not so tight, and quality is the
overriding factor. For example, when producing a single still frame, it may not matter so
much that it takes minutes or hours to do so, because the beauty and detail of the ﬁnal
image is worth it. When rendering a Hollywood-quality movie, it may still take hours per
frame, but the use of a renderfarm of hundreds or thousands of machines, all working
on diﬀerent frames at the same time, allows the entire sequence to complete in just a few
weeks.
But wait, there’s more: There are also some areas, which might be considered to be
stepping outside of traditional 3D production work, where Blender provides functionality:
• Video editing — having rendered your animation sequences and shot your live-action
footage, you will want to combine them in a properly-timed linear sequence to tell a
coherent story.
• 3D printing2 — Though still in its early days yet, many people are already experimenting with creating objects using 3D printers. The shape data may be obtained from real
objects with 3D scanning, or it may be created from scratch using 3D modelling, or you
can even combine both processes.

2

https://en.wikipedia.org/wiki/3d_printing
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What Blender Can Do
Blender is a capable tool for every single one of these processes. There’s quite a lot there,
isn’t there? But don’t be too intimidated: this Wikibook will take things step by step, and
you will be able to produce some fun stuﬀ from early on.

2.3. Additional Resources
•
•
•
•
•
•

w:3D rendering3
w:Comparison of 3D computer graphics software4
w:Computer-generated imagery5
w:Depth perception6
Blender Art Gallery7
Blender Homepage8

3
4
5
6
7
8
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https://en.wikipedia.org/wiki/3D%20rendering
https://en.wikipedia.org/wiki/Comparison%20of%203D%20computer%20graphics%20software
https://en.wikipedia.org/wiki/Computer-generated%20imagery
https://en.wikipedia.org/wiki/Depth%20perception
http://archive.blender.org/features-gallery/gallery/index.html
http://www.blender.org/

3. 3D Geometry
If you haven't previously studied 3D graphics, technical drawing, or analytic geometry, you
are about to learn a new way of visualizing the world, an ability that's fundamental to
working with Blender or any 3D modeling tool.
3D modeling is based on geometry, the branch of mathematics concerned with spatial relationships, speciﬁcally analytical geometry, which expresses these relationships in terms of
algebraic formulas. If you have studied geometry, some of the terminology will be familiar.

3.1. Coordinates And Coordinate Systems
Look around the room you’re in. The odds are it will have a cuboidal shape, with four
vertical walls at right angles to each other, a ﬂat, horizontal ﬂoor, and a ﬂat, horizontal
ceiling.
Now imagine there’s a ﬂy buzzing around the room. The ﬂy is moving in three-dimensional
space. In mathematical terms, that means its position within the room at any given moment,
can be expressed in terms of a unique combination of three numbers.
There are an inﬁnite number of ways —coordinate systems— in which we could come up
with a convention for deﬁning and measuring these numbers, i.e. the coordinates. Each
convention will yield diﬀerent values even if the ﬂy is in the same position. Coordinates only
make sense with reference to a speciﬁc coordinate system! To narrow down the possibilities
(in a purely arbitrary fashion), let us label the walls of the room with the points of the
compass: in a clockwise direction, North, East, South and West. (If you know which way
really is north, feel free to use that to label the walls of your room. Otherwise, choose any
wall you like as north.)
Consider the point at ﬂoor level in the south-west corner of the room. We will call this
(arbitrary) point the origin of our coordinate system, and the three numbers at this point
will be (0, 0, 0). The ﬁrst of the three numbers will be the distance (in some suitable units,
let’s say meters) eastwards from the west wall, the second number will be the distance north
from the south wall, and the third number will be the height above the ﬂoor.
Each of these directions is called an axis (plural: axes), and they are conventionally labelled
X, Y and Z, in that order. With a little bit of thought, you should be able to convince
yourself that every point within the space of your room corresponds to exactly one set of
(x, y, z) values, and that every possible combination of (x, y, z) values, with 0 ≤ x ≤ W ,
0 ≤ y ≤ L and 0 ≤ z ≤ H (where W is the east-west dimension of your room, L is its northsouth dimension, and H is the height between ceiling and ﬂoor) corresponds to a point in
the room.
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The following diagram illustrates how the coordinates are built up, using the same colour
codes that Blender uses to label its axes: red for X, green for Y and blue for Z (an easy
way to remember this if you're familiar with RGB is the order -- Red X, Green Y, Blue Z).
In the second picture, the x value deﬁnes a plane parallel to the west wall of the room. In
the third picture, the y value deﬁnes a plane parallel to the south wall, and in the fourth
picture, the z value deﬁnes a plane parallel to the ﬂoor. Put the planes together in the ﬁfth
picture, and they intersect at a unique point.

Figure 2

This style of coordinate system, with the numbers corresponding to distances along perpendicular axes, is called Cartesian coordinates, named after René Descartes, the 17th-century
mathematician who ﬁrst introduced the concept. Legend has it that he came up with the
idea after watching a ﬂy buzzing around his bedroom!
There are other ways to deﬁne coordinate systems, for example by substituting direction
angles in place of one or two of the distance measurements. These can be useful in certain
situations, but usually all coordinate systems in Blender are Cartesian. However, in Blender,
switching between these coordinate systems is simple and easy to do.

3.1.1. Negative Coordinates
Can coordinate values be negative? Depending on the situation, yes. Here we are only
considering points within our room. But suppose instead of placing our origin in the bottom
southwest corner, we put it in the middle of the room, halfway between the ﬂoor and ceiling.
(After all, it is an arbitrary point, we can place it wherever we like, as long as we agree on its
location.) If the X-coordinate is the distance east from the origin, how do we deﬁne a point
west of the origin? We simply give it a negative X-coordinate. Similarly, points north of the
origin have a positive Y-coordinate, those south of it, have negative Y-coordinates. Points
above the origin have a positive Z-coordinate, those below it, a negative Z-coordinate.

3.1.2. Handedness Of Coordinate Systems
It is conventional for most Cartesian coordinate systems to be right-handed. To understand
this, hold the thumb, index ﬁnger and middle ﬁnger of your right hand perpendicular to
each other:
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Figure 3 Figure 1: The three axes form a
right-handed system

Now orient your hand so your thumb points along the X-axis in the positive direction
(direction of increasing coordinate numbers), your index ﬁnger along the positive Y-axis,
and your middle ﬁnger along the positive Z-axis. Another way of looking at it is, if you
placed your eye at the origin, and you could see the three arrows pointing in the directions
of positive X, positive Y and positive Z as in Figure 1, the order X, Y, Z would go counter
clockwise.

15
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Figure 4

Figure 2: Another view of right-handed system

Another way to visualize this is to make a ﬁst with your right hand, with your curled ﬁngers
towards you. Stick out your thumb directly to the right (X). Now aim your pointer ﬁnger
straight up (Y). Finally, make your middle ﬁnger point toward yourself (Z). This is the view
from directly above the origin.

3.2. Axes Of Rotation
Consider a spinning sphere. Every point on it is moving, except the ones along the axis.
These form a motionless line around which the rest of the sphere spins. This line is called
the axis of rotation.

16
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More precisely, the axis of rotation is a point or a line connecting points that do not change
position while that object rotates, drawn when the observer assumes he/she does not change
position relative to that object over time.
Conventionally, the direction of the axis of rotation is such that if you look in that direction,
the rotation appears clockwise, as illustrated below, where the yellow arrow shows the
rotational movement, while the purple one shows the rotation axis:

Figure 5

To remember this convention, hold your right hand in a thumbs-up gesture:
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Figure 6

If the rotation follows the direction of your curled ﬁngers, then the direction of the axis of
rotation is considered to be the same as the direction which the thumb is pointing in.
This gesture is a diﬀerent form of the right-hand rule and is sometimes called the right-hand
grip rule1 , the corkscrew-rule or the right-hand thumb rule. From now on we will refer to it
as 'the right-hand grip rule'.
When describing the direction of a rotating object, do not say that it rotates left-toright/clockwise, or right-to-left/counterclockwise. Each of these on their own are meaningless, because they're relative to the observer. Instead of saying this, ﬁnd the direction
of the axis of rotation and draw an arrow to represent it. Those who know the right-hand

1

18

https://en.wikipedia.org/wiki/Right-hand%20rule%23Direction%20associated%20with%20a%
20rotation

Additional Resources
grip rule will be able to ﬁgure out what the direction of rotation of the object is, by using
the rule when interpreting your drawing.

3.3. Additional Resources
•
•
•
•
•

2
3
4
5
6

the Geometry2 wikibook
w:Analytic geometry3
w:Cartesian coordinate system4
w:Right-hand rule5
w:Rotation6

https://en.wikibooks.org/wiki/Geometry
https://en.wikipedia.org/wiki/Analytic%20geometry
https://en.wikipedia.org/wiki/Cartesian%20coordinate%20system
https://en.wikipedia.org/wiki/Right-hand%20rule
https://en.wikipedia.org/wiki/Rotation
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4. Coordinate Transformations
4.1. Coordinate Transformations
A transformation is any operation that changes coordinate values in some way. For example,
if you pick up an object and move it to a diﬀerent place in the room without changing
its orientation, then the coordinates of each point on the object relative to the room are
adjusted by an amount that depends on the distance and direction between the old and
new positions. This is called a translation transformation.

Figure 8

Figure 7

Object translated to new position

Object at original location

Simply turning the object without moving it from its original location is called rotation.
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Figure 9

Object rotated 45°

If the object were to get bigger or smaller, that is a scaling transformation. In the real
world, only a few objects can be scaled in this way. For example, a balloon can be inﬂated
or deﬂated to a larger or smaller size, but a bowling ball cannot. Regardless of what can
and can't be re-sized in the real world, any object can be scaled (re-sized) in the world
of computer graphics. Scaling may be uniform, i.e. apply equally in all dimensions, or
non-uniform.

22
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Figure 10

Object uniformly scaled to 50% of original size

Figure 11

Object scaled vertically to 50% of original size

4.2. Linear Transformations
The main types of coordinate transformations we’re concerned with are called linear transformations. Lines that were straight before the transformation remain straight. i.e. they
do not become curved. For example, the following diagram illustrates three linear transformations applied to the square in the center: Clockwise from the left, a shear or skew, a
scale, and a rotation, plus one non-linear transformation that causes two sides of the box
to become curved.
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Figure 12

4.3. Multiple Transformations
It is possible to concatenate or compose a series of transformations. The resulting transformation can do many things in one operation — translation, rotation, scaling etc. However,
the order of composition of the component transformations becomes important. In general,
transformations are not commutative. For example, compare the result of moving our model
some distance along the Y axis followed by rotating it about the X axis (If this doesn't make
sense, consider that the axes are ﬁxed, they aren't moving with the object. More on that
later Global and local coordinates1 ):
1

24

Chapter 7.1 on page 38

Multiple Transformations

Figure 13

Translation followed by rotation

versus the result of doing the rotation ﬁrst:
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Figure 14

Rotation followed by translation

In some instances, the three forms of transformation may be applied on a single object
concurrently. Such a feature exists in Blender and is normally implemented in creating
animations. For example, you can decide to pick up the object (ﬁrst transformation translation), twist it (second transformation - rotation), and, in a 3D modeling environment,
increase the size of the object (third transformation - scaling).

4.4. Inverse Transformations
Often there is a need to ﬁnd the inverse of a transformation. That is, a transformation that
has the opposite eﬀect. For example, a rotation of +45° about the X axis is undone by a
rotation of -45° around the same axis.
Inverses have many uses, one of which is to simplify the construction of certain kinds of
transformations.
For example, it is easy to construct a rotation transformation about the X, Y or Z-axis of
the coordinate system. But what about a rotation of Θ° around an arbitrary axis? This
can be made out of the following parts:
• a translation that makes the rotation axis pass through the origin.
• rotations about the Y and/or Z axes, as appropriate, so the rotation axis lies along the
X axis.
• a rotation of Θ° about the X axis.
• the inverse of the rotations that aligned the rotation axis with the X axis.
• the inverse of the translation that made the rotation axis pass through the origin.
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Projections
Most of the transformations we deal with in 3D modelling have an inverse, but not all. See
the next section for some that don’t.

4.5. Projections
Most of our display and output devices are not three-dimensional. Thus, three-dimensional
images need to be projected onto a two-dimensional surface (like a display screen or a printed
page) before we can see them.
There are two main ways to perform such projections. One is orthographic projection, where
parallel lines are drawn from all points of the three-dimensional object until they intersect
a plane representing the display surface:

Figure 15

More on orthographic projections2
The other way is perspective projection, where the lines drawn are not parallel, but intersect
at a point representing the location of the eye of the viewer:

2

Chapter 5 on page 29
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Coordinate Transformations

Figure 16

Projections are also linear transformations. But since they take a three-dimensional space
and ﬂatten it onto a two-dimensional surface, some information is lost. Those transformations are non-invertible i.e. they cannot be undone, at least in a unique way as the depth
information is gone.
More on perspective projections3
The mathematics of perspective were ﬁrst worked out in the 11th century by Alhazen4 , and
used to great eﬀect by the Italian Renaissance painters four hundred years later.
--

3
4
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5. Orthographic Views
Blender provides two diﬀerent ways of viewing 3D scenes:
• orthographic view
and
• perspective view.
In order to use them eﬀectively, you need to understand their properties.
An orthographic view (or projection) of a 3D scene is a 2D picture of it in which parallel
lines appear parallel, and all edges perpendicular to the view direction appear in proportion,
at exactly the same scale.
Orthographic views are usually aligned with the scene's primary axes. Edges parallel to the
view axis disappear. Those parallel to the other primary axes appear horizontal or vertical.
The commonly used orthographic views are front, side, and top views, though back and
bottom views are possible.
Uniform scale makes an orthographic view very useful when constructing 3D objects, not
only in computer graphics, but also in manufacturing and architecture.
Here's one way to think about the orthographic view:
Imagine photographing a small 3D object through a telescope from a very great distance.
There would be no foreshortening. All features would be at the same scale, regardless of
whether they were on the near side of the object or its far side. Given two (or preferably
three) such views, along diﬀerent axes, you could get an accurate idea of the shape of the
object, useful for ”getting the feel” of objects in a virtual 3D world where you're unable to
touch or handle anything!

5.1. Example
Here is a drawing of a staircase:
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Figure 17

An isometric view of a staircase

and here are three orthographic views of the same staircase, each outlined in red:
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Additional Resources

Figure 18

Figure 1: Orthographic views of a staircase

The views are from the front, top, and left. Dashed lines represent edges that, in real life,
would be hidden behind something, such as the left wall of the staircase. (Think of each
view as an X-ray image.)
The leading edges of the steps are visible in both the front and top views. Note that they
appear parallel and of equal length in 2D, just as they are in 3D reality.

5.2. Additional Resources
• w:Orthographic projection1
1

https://en.wikipedia.org/wiki/Orthographic%20projection
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6. Perspective Views
As you know, the main reason for modeling 3D objects in Blender is to render images that
exhibit the illusion of depth.
Orthographic views are great for building a house, but seriously ﬂawed when it comes to
creating realistic images of the house for use in a sales brochure. While a builder wants
blueprints that are clear and accurate, a seller wants imagery that's aesthetically pleasing,
with the illusion of depth. Blender makes it easy to use tricks like perspective, surface
hiding, shading, and animation to achieve this illusion.
How does perspective work?
The essence of perspective is to represent parallel edges (in a 3D scene) by edges (in the 2D
image) that are not parallel. When done correctly, this produces foreshortening (nearby
objects are depicted larger than distant ones) and contributes to the illusion of depth.
Perspective is challenging to draw by hand, but Blender does it for you, provided you give
it a 3D model of the scene and tell it where to view the scene from.
If you're conﬁdent you understand perspective, you can skip the rest of this module and
proceed to the ”Coordinate Spaces in Blender” module .
Note:
Blender only does 3-point perspective, not 1-point or 2-point.
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6.1. One-point Perspective

Figure 19

Figure 1: 1-Point Perspective.

Drawing classes teach various kinds of perspective drawing: one-point perspective, twopoint perspective, and three-point perspective. In this context, the word ”point” refers to
what artists call the vanishing point.
When you're looking at a 3D object head-on and it's centered in your view, that is an
example of one-point perspective.
Imagine looking down a straight and level set of train tracks. The tracks appear to converge
at a point on the horizon. This is the vanishing point.
The image on the right is a 2D image of a cubic lattice or framework. Like any cube, it has
six square faces and twelve straight edges. In the 3D world, four of the edges are parallel to
our line-of-sight. They connect the four corners of the nearest square to the corresponding
corners of the farthest one. Each of these edges is parallel to the other three.
In the 2D image, those same four edges appear to converge toward a vanishing point,
contributing to the illusion of depth. Since this is one-point perspective, there is a single
point of convergence at the center of the image.
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Two-point Perspective

6.2. Two-point Perspective

Figure 20

Figure 2: 2-Point Perspective.

Now the cube is at eye level, and you're near one of its edges. Since you're not viewing it
face-on, you can't draw it realistically using one-point perspective. The horizontal edges on
your left appear to converge at a point on the horizon to the left of the cube, while those
on the right converge to the right. To illustrate the cube with a good illusion of depth, you
need two vanishing points.
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6.3. Three-point Perspective

Figure 21

3-Point Perspective.

Now imagine you're above the cube near one of its corners. To draw it, you'd need three
vanishing points, one for each set of parallel edges.
From that perspective, there are no longer any edges which appear parallel. The four
vertical edges, the four left-right edges, and the four in-out edges each converge toward a
diﬀerent vanishing point.

6.4. Additional Resources
• w:Perspective (graphical)1

1
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7. Coordinate Spaces in Blender

Figure 22 Figure 1: Objects in a three dimensional space. In the center of the
coordinate system is the origin of the global coordinate system.

We'll start looking at how 3D scenes are represented in Blender.
As was explained in the ”3D Geometry” module , Blender represents locations in a scene
by their coordinates. The coordinates of a location consist of three numbers that deﬁne its
distance and direction from a ﬁxed origin. More precisely:
• The ﬁrst (or x-) coordinate of the location is deﬁned as its distance from the YZ plane
(the one containing both the Y and Z axes). Locations on the +X side of this plane are
assigned positive x-coordinates, and those on the -X side are given negative ones.
• Its second (or y-) coordinate is its distance from the XZ plane, with locations on the -Y
side of this plane having negative y-coordinates.
• Its third (or z-) coordinate is its distance from the XY plane, with locations on the -Z
side of this plane having negative z-coordinates.
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Thus the origin (which lies at the junction of all three axes and all three planes) has the
coordinates (0, 0, 0).
Note:
The images for this tutorial were produced using Blender v2.46.

7.1. Global and local coordinates
Blender refers to the coordinate system described above as the global coordinate system,
though it's not truly global as each scene has its own global coordinate system. Each global
coordinate system has a ﬁxed origin and a ﬁxed orientation, but we can view it from diﬀerent
angles by moving a virtual camera through the scene and/or rotating the camera.
Global coordinates are adequate for scenes containing a single ﬁxed object and scenes in
which each object is merely a single point in the scene. When dealing with objects that
move around (or multiple objects with sizes and shapes), it's helpful to deﬁne a local
coordinate system for each object, i.e. a coordinate system that can move with, and
follow the object. The origin of an object's local coordinate system is often called the
center of the object although it needn't coincide with the geometrical center of the
object.
3D objects in Blender are largely described using vertices (points in the object, singular
form: vertex). The global coordinates of a vertex depend on:
• the (x, y, z) coordinates of the vertex in the object's local coordinate system
• the location of the object's center
• any rotation (turning) of the local coordinates system relative to the global coordinate
system, and
• any scaling (magniﬁcation or reduction) of the local coordinate system relative to the
global coordinate system.
For example, the teacup in Figure 1 is described by a mesh model containing 171 vertices,
each having a diﬀerent set of local (x, y, z) coordinates relative to the cup's center. If you
translate the cup (move it without rotating it), the only bits of the model that have to
change are the global coordinates of the center. The local coordinates of all its vertices
would remain the same.
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Global and local coordinates

7.1.1. Coordinates of child objects

Figure 23 Figure 1b: A parent serves as the source of the global coordinates for its
child object. The child is the cup; the parent's orientation is shown with the colored
arrows.

Figure 23

Animation of the above

Any object can act as a parent for one or more other objects in the same scene, which are
then referred to as its children. (An object cannot have more than one direct parent, but
parent objects may themselves be the children of other objects.)
If an object has a parent, its position, rotation, and scaling are measured in the parent's
local coordinate system, almost as if it were a vertex of the parent. i.e. the position of
the child's center is measured from the parent's center instead of the origin of the global
coordinate system. So if you move a parent object, its children move too, even though
the children's coordinates have not changed. The orientation and scaling of a child's local
coordinate system are likewise measured relative to those of its parent. If you rotate the
parent, the child will rotate (and perhaps revolve) around the same axis.
Parent-child relationships between objects make it simpler to perform (and animate) rotations, scaling and moving in arbitrary directions. In Fig. 1b the teacup is a child object
of the coordinate cross on the right. That cross is itself the child of an invisible parent. (It
is both a parent and child.) In the cup's local coordinate system, it is not rotating, but as
the cross on the right rotates around its Z axis, it causes the cup to rotate and revolve. In
real animations, it will be much easier when the character holding the cup rotates, the cup
changes its position respectively.
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7.2. View coordinates

Figure 24

Figure 2: View coordinates and Projection Plane

Taking the viewer of the scene into consideration, there is another coordinate space: the
view coordinates. In Fig. 2 the viewer is symbolized by the camera. The Z axis of the
view coordinates always points directly to the viewer in orthographic projection. The X
axis points to the right, the Y axis points upwards (Fig. 3).

Figure 25 Figure 3: View coordinates in
viewing direction

In fact you always work in view coordinates if you don't set it any other way*. This is
particularly useful if you have aligned your view prior to modeling something, e.g. if an
object has a slanted roof and you want to create a window to ﬁt in that roof, it would be very
complicated to build the window aligned to the local coordinate system of the object, but
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if you ﬁrst align your view to the slanted roof, you can easily work in that view coordinate
system.
(* In the Blender 2.6 series, the default has been changed to global coordinates. View
coordinates remain as an option.)
If you work in one of the three standard views (Front/Top/Side) the alignment of the view
coordinates ﬁts the global coordinates. Therefore, it is quite natural to model in one of the
standard views and many people ﬁnd this the best way to model.

7.3. Normal coordinates

Figure 26

Figure 4: Normal coordinate spaces for faces. The normal is shown in blue.

Although Blender is a 3D program, only objects' faces are visible. The orientation of the
faces is important for many reasons. For example, in our daily lives it seems quite obvious
that a book lies ﬂat on a table. This requires the surface of the table and that of the book
to be parallel to each other. If we put a book on a table in a 3D program, there is no
mechanism that forces these surfaces to be parallel. The artist needs to ensure that.
The orientation of a face can be described with the help of the so-called surface normal.
It is always perpendicular to the surface. If several faces are selected, the resulting normal
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is averaged from the normals of every single face. In Fig. 4 the normal coordinates of the
visible faces are drawn.
This concept can be applied to individual points on the object, even if the points themselves
have no orientation. The normal of a point is the average of normals of the adjacent faces.

7.4. UV Coordinates
In later parts (for example, talking about textures) you will come across coordinates labelled
“U” and “V”. These are simply diﬀerent letters chosen to avoid confusion over “X”, “Y” and
“Z”. For example, a raster image is normally laid out on a ﬂat, two-dimensional plane.
Each point on the image can be identiﬁed by X and Y coordinates. But Blender can take
this image and wrap it around the surface of a 3D object as a texture. Points on/in the
object have X, Y and Z coordinates. So to avoid confusion, the points on the image are
identiﬁed using U and V to label their coordinates instead of X and Y. We then refer to
“UV mapping” as the process of determining where each (U, V) image point ends up on the
(X, Y, Z) object.
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8. Overview
Blender's user interface (the means by which you control the software) is not particularly
easy to learn. However, it has improved over time and is expected to continue doing so. The
current version of the Blender software is 2.79b. You can download it1 from the Blender
Foundation2 's website.
The tutorials in this section will familiarize you with the basics of the user interface. By
the end of this section, you should be able to:
•
•
•
•
•

resize, split, and merge any Blender window;
change the type of any Blender window;
access user preferences;
access panels containing buttons and other controls;
change the viewpoint of a viewport.

For those new to Blender, this is a fundamental section of the book.

8.0.1. Advice on Customization
Blender is a complex software package with many customizable features. You can customize
the user interface to assign new functions to buttons and hotkeys. In fact, you can change
almost anything to suit yourself. However, this complicates the giving and following of
directions. It is recommended you adhere to the default screen arrangements of Blender in
order to be able to follow the remaining parts of these tutorials. Blender ships with 4 to
5 screen-content arrangements which are suitable for almost any kind of job you'll want to
use it for - from creating motion and animation to making games.
We recommend leaving Blender's user interface in its ”factory settings” while working
through the Noob to Pro tutorials. At the very least, wait until you've mastered the basics
before you customize the interface - and we know you deﬁnitely will when you master it!

1
2

http://www.blender.org/download
http://www.blender.org/
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9. Keystroke, Button, and Menu
Notation
As you read through these tutorials, you will encounter cryptic codes such as SHIFT +
LMB and Timeline → End Frame. They describe actions you perform using the keyboard
and mouse. The notation used in this book comes from the standard used by the Blender
community. We will try to import those standards here to facilitate our studies.
If you're reading this book online, you may wish to print this page for future reference. In
addition, you can bookmark it in your browser for faster reference.

9.1. Hotkeys

Figure 27
numpad

A typical

Most computer keyboards have number keys in two diﬀerent places. A row above the letters,
and in a numpad (numeric keypad) to the right of the keyboard. While many applications
use these two sets of keys interchangeably, Blender does not. It assigns diﬀerent functions to
each set. If you're using a laptop keyboard without a separate numeric keypad, this might
cause some diﬃculty. You'll need to use your function key to do some things. It is possible
to indicate to Blender the type of keyboard you are using, but we strongly recommend you
use a standard external keyboard if you use a laptop for these tutorials as it will make your
studies and usage of Blender much more straightforward and enjoyable.
This book often assumes your keyboard has a numpad. If yours doesn't, consult the tutorial
on Non-standard Input Devices1 for alternative ways to access the numpad's functions.
1

Chapter 10 on page 51
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9.1.1. Notation
Notation

Action or Key

ALT
CMD

(press and hold) the Alt (Option) key
(press and hold) the Command or Super key (On a Windows keyboard, the key bearing the Windows logo; on a Macintosh, it bears the
word command.)

CTRL
FN

(press and hold) the Ctrl (Control) key
(press and hold) the Fn (Function) key (generally found only on
laptops)

SHIFT
ENTER
ESC
F1 through F12

(press and hold) the Shift key
(press) the Enter (Return) key (on the main keypad)
(press) the Esc (Escape) key
function keys F1 through F12 (often in a row along the top of the
keyboard)

SPACE
TAB
A through Z
0KEY through 9KEY
NUM0 through NUM9
NUMLOCK , NUM/ , NUM* , NUMNUM+ , NUMENTER , and NUM.
DELETE
DOWN ARROW
LEFT ARROW
RIGHT ARROW
UP ARROW

(press) the space bar (usually unmarked)
(press) the Tab key
the letters (on the main keypad)
the numerals (above the letters) on the main keypad
the numerals on the numpad
,

other keys on the numpad

NUM. !)
NUM2 !)
(press) the left Arrow key (not NUM4 !)
(press) the right Arrow key (not NUM6 !)
(press) the up Arrow key (not NUM8 !)
(press) the Delete key (not

(press) the down Arrow key (not

Combinations that involve holding down a key while performing another action are written
with a plus sign (+). Thus:
•

SHIFT

+ TAB means to TAB while holding down SHIFT

and
•

SHIFT

+ CTRL + F9 means to F9 while holding down both CTRL and SHIFT .

9.2. Mouse Notation
Blender uses three mouse buttons and the scroll wheel, if you have one. If your mouse only
has one or two buttons, consult the tutorial on Non-standard Input Devices2 for alternative
ways to access the functions assigned to these buttons.
Notation
LMB
RMB
MMB
SCROLL

2
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Action or Button
click with the Left Mouse Button
click with the Right Mouse Button
press down on (don't turn) the scroll wheel or Middle Mouse Button
turn the scroll wheel in either direction

Chapter 10 on page 51

Navigating Menus
Mouse and keyboard actions are often combined.
while holding down SHIFT .

SHIFT

+ RMB

means to click

RMB

9.3. Navigating Menus
Blender uses both pop-up and pull-down/pull-up menus.
Many menus have sub
menus (menus that are reached via another menu). If a menu item displays a triangle,
that means it leads to a sub menu. For instance, the pull-down menu shown below has
seventeen items, four of which lead to sub menus:

Figure 28

The File menu
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You can move through items in a menu by:
• moving the mouse pointer up and down
or
• pressing UP ARROW and DOWN ARROW
You can enter a sub menu by:
• moving the mouse pointer to the right
or
• pressing RIGHT ARROW
You can leave a sub menu by:
• moving the mouse pointer to the left
or
• pressing LEFT ARROW
To initiate a menu action, you can:
• click LMB
or
• press ENTER
You can escape from a menu by:
• moving the mouse pointer away from the menu
or
• pressing ESC
For each menu, Blender remembers your last choice and highlights it for you the next time
you enter the menu.

9.3.1. Notation
Menu notation is fairly self-explanatory.
SHIFT

+ A

Mesh → UV Sphere

Means:
1.
2.
3.
4.
5.
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Press Shift+A
In the menu that pops up, move through the items until Mesh is highlighted
Enter the Mesh sub menu
Move through the items until UV Sphere is highlighted
Press Enter or click the left mouse button to initiate the action

Additional Resources

9.4. Additional Resources
• The Blender Manual page on keyboard and mouse at http://wiki.blender.org/index.
php/Doc:Manual/keyboardandmouse
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10. Non-standard Input Devices
This module is applicable only to users with non-standard input devices. If you have both:
• a three-button mouse
and
• a keyboard with a numpad,
you can skip this module.

10.0.1. Keyboards lacking a numpad
Most modern laptops have a pseudo-numpad, a set of keys in the main keypad which
double as a numpad. The keys typically used for this purpose are:
7KEY

8KEY

9KEY

0KEY

U

I

O

P

J

K

L

;

M

,KEY

.KEY

SLASH

When used as a pseudo-numpad, these keys typically act as the following keys from a true
numpad:
NUM7

NUM8

NUM9

NUM/

NUM4

NUM5

NUM6

NUM*

NUM1

NUM2

NUM3

NUM-

NUM0

NUMENTER

NUM.

NUM+

The numpad functions of these keys can often be toggled with F11 or NUMLOCK on
PCs or with F6 on Macs. Alternatively, you can often temporarily activate the numpad
behavior by holding down FN .
If your keyboard has the alternate labellings but you don't know how they work, consult
your laptop owner's manual.
As a last resort, you can use the ”Emulate Numpad” feature of Blender. This will allow you
to use the normal numeric keys as if they were numpad numerics. Instructions for enabling
this feature may be found in the ”User Preferences Windows” module .
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Blender uses the numeric keypad quite a bit. If you envision using your laptop for this kind
of work, it may be worth investing in a USB Numeric Keypad. On eBay, prices for simple
external numpads start around $10 USD.

10.0.2. Non three-button mouse
For single-button mouse users, make sure that Input for Blender 2.79 (under ”User Preferences” on the left-most drop-down menu) → Emulate 3 Button Mouse is enabled.
On many computers with two-button mice, MMB can be emulated by simultaneously
clicking LMB and RMB . On Windows machines you'll need to enable this in the mouse
settings in the Control Panel. On a Mac, open the Keyboard and Mouse preference pane and
enable Use two ﬁngers to scroll. Alternatively, by selecting Emulate 3 Button Mouse under
User Preferences, MMB can be emulated by simultaneously clicking ALT and LMB .
Recent IBM Thinkpad laptops allow you to disable the 'UltraNav' features of the middle
mouse button in order to use it as a 'normal' third button. Alternatively, some laptops
allow areas (called gestures) on the movement pad to act as MMB or RMB , and these
can be set up in the Control Panel in the Mouse Pointer options, selecting gestures and
editing features there.
Apple single-button mouse
Apple single-button mouse substitutions
Notation
Single-button Substitute
Description
LMB
MB
the Mouse Button
RMB
CMD + MB
Apple key + the Mouse Button
MMB
ALT + MB
Option (Alt) key + the Mouse Button
While Mac OS X natively uses both the CTRL + MB and CMD + MB to emulate
RMB , recent Blender releases for Mac OS X use only CMD + MB for this purpose. This
behavior is documented in the OSX Tips ﬁle that comes with the Mac version. You can
also set the mouse to sense a right-click in System Preferences.
Note also that in the new, ”unibody” design, the mouse button is under the trackpad, and
the shortcut for RMB is clicking with two ﬁngers simultaneously, which can be enabled in
the System Preferences.
Laptops lacking a middle button but with a smart-pad
Many laptops have smart pads. Smart-pads can use gestures to give the eﬀect of MMB .
The default for an Elan® Smart-Pad is two-ﬁnger tapping equivalent to clicking a MMB
. Dragging two ﬁngers is the same as turning a mouse wheel.
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Additional Resources

10.0.3. Tablet PCs
To get the eﬀect of
ALT key.

MMB

in a viewport, drag your pen around while holding down the

10.0.4. Additional Resources
• version 2.4: keyboard and mouse (old documentation)1 — Blender 2.4 Manual2
• Input devices (version 2.7x)3

1
2
3

http://wiki.blender.org/index.php/Doc:2.4/Manual/Interface/Keyboard_and_Mouse
http://wiki.blender.org/index.php/Doc:Manual
http://www.blender.org/manual/interface/input_devices.html
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11. Operating System-speciﬁc Issues
This tutorial covers user-interface issues that are speciﬁc to particular operating systems or
window managers. Read the section that applies to your computer; you may skip the rest.

11.1. GNU/Linux
ALT + LMB is used for changing the angular view on two angular axes of the 3D View
window, if ALT + LMB moves the current window, then there's a conﬂict with your
window manager. You can resolve the conﬂict or use CTRL + ALT + LMB or MMB
instead. (Also, you may have activated Compiz->Rotate Cube. Default conﬁguration for
rotating the Cube is also CTRL + ALT + LMB ; you may have to change this binding
to an alternative conﬁguration.) If you are running KDE this can be resolved by: RMB
on the title bar of the main Blender window → select Conﬁgure Window Behavior → go
to Actions → Window Actions → in the Inner Window, Titlebar and Frame section →
select the Modiﬁer key to be ALT and set all the select boxes beneath it to Nothing. An
alternate method within KDE might be to RMB click on the title bar of the main Blender
window; then select Advanced → Special Application Settings... → Workarounds and then
click Block global shortcuts with Force selected and checked.

In Gnome, Click System → Preferences → Window Preferences. Look for the last
three options Control, Alt and Super. Select Super. Or in Xfce, click Whisker →
Settings → Window Manager Tweaks, and in the Accessibility pane, change Key
used to grab and move windows to Super. Now you can press and hold CMD or

FREESERIF.TTF[PATH=/USR/SHARE/FONTS/TRUETYPE/FREEFONT/,UPRIGHTFONT=FREESERIF,BOLDFONT=FREESER

to drag windows around, and use CTRL and ALT as normal.

11.1.1. KDE
Under KDE, CTRL + F1 through CTRL + F4 are by default conﬁgured to switch to
the corresponding one of the ﬁrst four desktops, while CTRL + F12 brings up Plasma
settings. You can change these in System Settings.

11.1.2. Gnome
You'll want to disable the Find Pointer functionality in Gnome, which will impair your
ability to use certain functions such as Snap to grid and the lasso tool. If your mouse
pointer is being highlighted when you press and release CTRL , go to: Mouse in Gnome's
Desktop Settings and uncheck the box Find Pointer.
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11.1.3. Ubuntu
As of Ubuntu versions prior to about 09.10 (“Karmic Koala”), there was a known incompatibility between Blender and the Compiz Fusion accelerated (OpenGL) window manager
used in Ubuntu. By default, Compiz Fusion is enabled in Ubuntu, causing the problems
to manifest themselves in Blender as ﬂickering windows, completely disappearing windows,
inconsistent window refreshes, and/or an inability to start Blender in windowed mode.
The ﬁx for this is simple. Install compiz-switch (might be in universe). Go to Applications
→ Accessories → Compiz-Switch. This will disable compiz temporarily. Do the same to
turn compiz back on when you're done using Blender.
This is no longer needed for current releases of Ubuntu.

11.2. Mac OS X
You may need to press FN in order to use the F1 through F12 keys.
To expand a section in Blender, you would usually press CTRL + UPARROW . On a Mac,
if “Spaces” is enabled, you may have to use CTRL + ALT + UPARROW .

11.3. Microsoft Windows
11.3.1. Two Ways to Launch Blender
Blender requires a console for displaying error messages, so if you launch Blender by means
of an icon, two windows will appear: the graphical user interface plus a console window.
Closing either window will terminate Blender. These windows are indistinguishable in the
Windows taskbar in versions of Windows before Windows 71 , which leads to confusion.
Also, launching this way does not provide any way to pass command-line arguments to
Blender.
Launching Blender from a command prompt is extra work, but it overcomes these issues:
1.
2.
3.
4.

Start → Run...
enter cmd
enter cd c:\Program Files\Blender Foundation\Blender
enter blender

Blender version 2.6 onwards doesn't have this problem, and hides the console window by
default. You can show it by clicking Window > Toggle system console

1
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Microsoft Windows

11.3.2. Sticky Keys
Pressing SHIFT ﬁve times in a row may activate StickyKeys, an accessibility option
which alters how the computer recognizes commands. If a StickyKeys dialog box appears,
you should LMB the ”Cancel” button.
If you don't need the accessibility features, you can disable sticky keys:
1. Start → Control Panel (OR search for ”Accessibility Options” on the Start
menu/Search)
2. double-click on Accessibility Options (Ease of Access Center in Windows 10)
3. LMB the Keyboard tab
4. for each of the options StickyKeys, FilterKeys, and ToggleKeys:
a) clear the Use . . . checkbox
b) LMB the Settings button
c) uncheck the Use Shortcut checkbox in the settings
d) LMB the OK button for the settings
5. LMB the OK button for Accessibility Options/Ease of Access Center.

11.3.3. Multiple Keyboard Layouts
On systems with multiple keyboard layouts, pressing SHIFT + ALT can alter the layout.
(For instance, it might change from QWERTY to AZERTY or vice versa.) Because of this
issue, Noob to Pro avoids SHIFT + ALT hotkeys.
If you ﬁnd your keyboard layout altered, press SHIFT + ALT again to change it back.
You can also disable the hotkey:
1. Start → Control Panel
2. double-click on Regional and Language Options
3. LMB the Languages tab
4. LMB the Details button
5. LMB the Key Settings button
6. LMB the Change Key Sequence button
7. uncheck the Switch Keyboard Layout checkbox
8. LMB the OK button

11.3.4. Additional Resources
• Input method editor keyboard shortcut (CTRL+SHIFT+0) switches the input language
in Vista2 — Microsoft Support Knowledge-Base
• w:StickyKeys3

2
3

http://support.microsoft.com/kb/967893
https://en.wikipedia.org/wiki/StickyKeys
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12. Blender User Interface
Here's a preview screenshot of Blender's interface.
For those familiar with older (pre-2.5x) versions of Blender, this will look very diﬀerent.
The redesign makes it much easier to ﬁnd things.
For a detailed rationale explaining the redesign, read this1 .

Figure 29

1

http://download.blender.org/documentation/bc2008/evolution_of_blenders_ui.pdf
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Figure 30
2.63 OSX

Startup interface for Blender

2

12.1. Why Doesn’t It Follow UI Conventions For [Insert OS
Of Choice Here]?
Blender follows its own user interface conventions. Instead of making use of multiple windows as deﬁned by your particular OS/GUI, it creates its own “windows” within a single
OS/GUI window, which is best sized to ﬁll your screen. Many people accustomed to how
applications normally work on their platform of choice, get annoyed by Blender’s insistence
on being diﬀerent. However, there is a good reason for it.
The essence of the Blender UI can be summed up in one word: workﬂow. Blender was
originally created by a 3D graphics shop for their own in-house use. Being a key revenue
engine for them, they designed it for maximum productivity, speed and smoothness of
operation. That means avoiding “bumps” that slow down the user. For example, windows
never overlap, so there’s no need to keep reordering them. You don’t have to click in a
window to make it active, just move the mouse. There is a minimum of interruption from
popups asking for more information before performing some action. Instead, the action
is immediately performed with default settings, which you can adjust afterwards and get
immediate feedback on the results.
Blender may not be “intuitive” to start learning, in that you cannot simply sit down in front
of it and ﬁgure out things on your own, especially from a position of knowing nothing at
all. But once you have picked up some basic conventions, you will ﬁnd it starts to make
sense and then you will be free to experiment and discover things on your own.

12.2. Why Doesn’t It Prompt To Save Changes?
Most modern applications will ask for conﬁrmation if you try to close a document that has
unsaved changes. Blender is frequently criticized for not doing so.
2
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Why Doesn’t It Prompt To Save Changes?
But think about it. What constitutes an “unsaved change”? Are switching tools or adjusting
the window layout changes worth saving? In Blender’s case, the answer is “yes”, because all
that is part of the document state to be restored upon opening. So Blender would have to
prompt for conﬁrmation practically every time you closed a document or quit Blender.
Instead, Blender always saves changes when it closes, to a ﬁle called 'quit.blend'. The next
time you use Blender, simply select File → Recover Last Session and you can resume right
where you left oﬀ.
However, as of Blender version 2.79, you are warned on exit when there are unsaved changes.
You can change this behaviour in User preferences / Interface / Warnings / Prompt Quit.
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13. Blender Windowing System
i Information
Applicable Blender version: 2.69
The Blender user interface may appear daunting at ﬁrst, but don't despair. This book
explores the interface one step at a time.
In this module, you'll learn about Blender windows:
•
•
•
•

recognizing windows and their headers,
the diﬀerent types of windows,
how to activate and resize windows,
how to split and join windows.

You'll also practice launching and leaving Blender.

13.1. An Interface Divided
Blender's user interface is divided into rectangular areas called windows (or sometimes,
areas). The overall arrangement of windows is called a workspace.
If you haven't already launched Blender, go ahead and do so. You should soon see something
that resembles the following.
Blender has had some major changes to its user interface (UI) since version 2.4x. Some
of these changes include moving buttons and changing the space bar hot key from the
“add menu” to the “search menu” ( SHIFT + A is now the ”add menu” hot key). This is
important to know when trying to follow tutorials.
Other changes include the addition of the tool bar and window splitting widget. The shelf
widget (indicated by a plus sign) opens hidden tool shelves. The object tool shelf can be
toggled on and oﬀ by pressing T . The properties tool shelf can be toggled on and oﬀ by
pressing the N . The split window widget allows you to split and join windows. Blender
2.69 is shown below.
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Figure 30

• You may be running a diﬀerent version of Blender - perhaps a newer version. The
screenshot was made using the 2.69 release.
If you're running an older version, you should probably upgrade. Download instructions
are in the Introduction1 .
• The user-interface settings on your computer may have been changed.
Try resetting the user interface with File → Load Factory Settings.
To take a video in Blender, press ALT + F3 , and click Make Screencast. This will
record what's on your screen until you click the red Close button on the info header.
The screencasts will be saved in the tmp folder. In Microsoft Windows, the tmp folder is
located at 'C:\tmp'.

13.2. Window Headers
Did you ﬁnd all ﬁve headers?
Every Blender window has a header. A header can appear at the top of the window, at the
bottom of the window, or it can be hidden. Let's take a closer look at the headers.

1
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Window Headers

Figure 31 The header of the Info window is outlined in green .
The header of the 3D View window is outlined in red . Note that it runs along the
bottom of the 3D View window, not the top.
The header of the Properties window is outlined in blue .
The header of the Outliner window is outlined in white.
The header of the Timeline window is the one on the bottom (not outlined)

If you click with RMB on the header, a menu pops up which lets you move the header
(to the top if it’s at the bottom, or vice versa), or maximize the window to ﬁll the entire
workspace:
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Figure 32

To hide the header completely, move the mouse to the edge of the header furthest from the
edge of the window (i.e. the top edge of the header if it is at the bottom of the window, or
vice versa); it will change into a vertical double-headed arrow. Now click with LMB and
drag towards the window edge, and the header will disappear. In its place, you will see the
following symbol appear at the corner of the window:
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Figure 33

. Click this with LMB to bring the header back.

13.3. Window Types
Blender has many types of windows (there are 16 of them in Blender 2.69) and a Console for
the Python programming language. You've just encountered the Info, 3D View, Properties,
and Outliner windows. The rest will be introduced as needed in later modules.
Every window header in Blender has an icon at the left end to indicate the window type.
For instance:
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•

Figure 34
= Info

•

Figure 35

68

Window Types
= User Preferences

•

Figure 36
= 3D View

•

Figure 37
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= Outliner

•

Figure 38
= Properties
If you LMB on the icon, a menu will pop up. (If you don't know what
please review the Keystrokes, Buttons, and Menus Notation2 module.)

2
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LMB

means,

Window Types

Figure 39 By matching the icon in the header to the icons in the menu, you can tell
that the window here is a 3D View window.
The menu can be used to alter a window's type. In this screenshot, the user is about to
change the window into a Properties window.

Note:
Any window can be changed to any type. Blender doesn't mind if there are multiple
windows of the same type.
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Note:
The workspace layout is saved along with the document. Anybody subsequently opening
the document will see the last-saved layout.
If you've changed any window's type, please change it back (or reload the factory settings
with File → Load Factory Settings) before continuing with this tutorial.

13.4. The Active Window
The active window is the one that will respond if you press a key. Only one Blender
window is active at any given time.
The active window is usually the one containing the mouse pointer. (Blender uses a ”focus
follows mouse” user interface model. When a hotkey fails to work as expected, it is often
because the mouse pointer has strayed into a neighboring window.) To change the active
window, simply move the mouse pointer into the window you wish to activate.
Practice changing the active window by moving your mouse between the 3D View and the
Timeline windows. The Timeline window is directly below the 3D View header. At this
point, it's worth mentioning that the header for the 3D View window and Timeline window
is at the BOTTOM of its own window instead of the top as the name ”header” implies.
Note:
When a window becomes active, its header gets brighter.

13.5. Resizing Windows
Resizing windows is easy.

13.5.1. Dragging on a Border

Figure 40 Press and hold LMB .
Drag with the mouse to move the border up and down.
When the border is where you want it, release LMB .
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Whenever you increase the size of one window, you decrease the size of another. That's
because Blender has a non-overlapping window interface: unlike many other programs,
it does not permit windows to overlap. Neither does it move windows; it just resizes them.
If you ﬁnd that you cannot increase the size of a window (e.g. the Info window) any further
although there seems to be enough space to do so, it may be because you decreased the size
of another window (e.g., the Outline window) to its minimum size (i.e, just the heading).

13.5.2. Maximizing a Window
Another way to resize a window is to maximize it. When Blender maximizes a window,
it makes the window as large as possible. The previous window conﬁguration is saved.
• To maximize the active window, press CTRL + UPARROW , CTRL + DOWNARROW
or SHIFT + SPACE . On a Mac, if “Spaces” is enabled, you may have to use CTRL +
ALT + UPARROW .
• When a window is maximized, use CTRL + UPARROW , CTRL + DOWNARROW or
SHIFT + SPACE to restore the previous (unmaximized) window conﬁguration.
Practice maximizing and un-maximizing the 3D View and Timeline windows.
Note:
If you are running a version of Blender before 2.57, you cannot maximize a User Preferences window.

13.6. Shelves
You will notice that the 3D View

73

Blender Windowing System

Figure 41

window (the largest window in the screenshots above) has several buttons down the left side.
This rectangular portion is called the Tool Shelf. This is like a window within a window you can drag the boundary between it and the main part of the 3D View to resize.
If you drag all the way to the window boundary, the shelf will disappear. In its place, the
following symbol will appear:
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Figure 42

. Click it to bring the shelf back.

13.7. Too Much To Fit
If a window or shelf contains too much information to ﬁt within its display area, scrollbars
will appear along the bottom or right edge. You can scroll the contents by dragging these
with LMB ; alternatively you can drag with MMB directly within the contents.
A window header may also contain more than ﬁts within its displayable area. There is no
explicit visual clue for this (though some of the widgets at the right edge might not be
visible), but if that happens, you can drag sideways within the header with MMB to scroll
its contents.
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13.8. Splitting And Joining Windows
At the top right and bottom left of every window, you will see something like this:

Figure 43

. If you move the mouse over the icon, you will see the pointer turn into a cross. At that
point, you can do one of the following by clicking and dragging with LMB :
• Split the window into two copies horizontally by dragging horizontally away from the
edge.
• Split the window into two copies vertically by dragging vertically away from the edge.
• Join the window to the adjacent one horizontally (getting rid of it and taking over its
space) by dragging towards it.

76

The Default Workspace
• Join the window to the adjacent one vertically (getting rid of it and taking over its space)
by dragging towards it.
Of course, the last two are only possible if there is in fact another window in that direction.
Note: you can only join windows horizontally that are the same height, and windows
vertically that are the same width.

13.9. The Default Workspace
If you look at the above screenshot of the default workspace, you will see the following
window types:
• The menu bar at the top (outlined in green) is actually a window, called Info

Figure 44
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. In previous versions of Blender, you could resize this to reveal the User Preferences, but
in 2.5x they have been moved to their own window type. Instead, all you can see here
if you enlarge the window are some debug messages, which may be removed in a future
version of Blender. As of 2.70, the debug messages are still present in this menu.
• The largest window on the screen is the 3D View

Figure 45
. This is where you work on your model.
• The Properties
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Figure 46
window is the tall area on the right; this is where most of the functions are located for
performing operations on models, materials etc. In previous versions of Blender this was
called the Buttons window. Over time, it evolved into a disorganized area that made it
diﬃcult to ﬁnd things. It has been cleaned up signiﬁcantly in 2.5x. Note that it defaults
to a vertical layout, rather than the horizontal one of previous versions. The new design
prefers a vertical layout, which better suits today’s widescreen monitors.
• The Outliner
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Figure 47
(at the top right) gives you an overview of the objects in your document. As your models
get more complex, you will start to appreciate the ability to quickly ﬁnd things here.
• The Timeline
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Figure 48
(across the bottom) becomes important when you’re doing animation.
The default layout may not be optimal. For example, if you’re doing a static model or scene,
not an animation, you can get rid of the Timeline. If you’re doing heavy script development,
you’ll probably want the Console available to try things out. And so on.

13.10. Workspace Presets
In the Info window/titlebar, you will see a menu with an icon like this
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Figure 49

. Clicking on it with LMB will show the following menu:
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Figure 50

Selecting from this menu lets you quickly switch between various predeﬁned workspace
layouts, tailored to various workﬂows. Try it and see. You can return to the default layout
by selecting “Default” (but note that any changes you make to the layout are immediately
associated with the name being displayed here). The menu has a search box at the bottom.
Typing text here will restrict the menu to showing items containing only that text. It might
not appear to have much use, but in a complicated project that needs dozens of diﬀerent
layouts, the search function could become very useful indeed!
The name of the currently selected item appears to the right of the menu icon. In the
illustration above, this is ”Default”. Blender allows you to rename the current menu item
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by clicking on it with the LMB and typing a new name, so take care not to do so unless
you actually want to rename the menu item. For example, if you replace the name ”Default”
with ”MyDefaults”, you will subsequently see that ”MyDefaults” appears in the list of menu
items.
Note also the “+” and “X” icons to the right of the menu; clicking “+” creates a new entry
which is a duplicate of the last-selected entry, while clicking “X” gets rid of the currentlyselected entry. You will see these conventions appear consistently in menus elsewhere in
Blender’s new, revamped interface.

13.11. One Document At A Time
Blender can only work with one open document at a time. To save changes to the current
document, select one of the Save options from the File menu (or press CTRL + S to
save under the last-saved name). To open a new document (actually load a copy of your
last-saved user preferences), select “New” from the File menu (or press CTRL + N ),
and select “Reload Start-Up File” from the popup that appears, but be aware this will not
automatically save any changes to the previous document.

13.12. Scenes
A scene is like a separate Blender-document within-a-document. Diﬀerent scenes within
the same document can easily share objects, materials etc. You can deﬁne them once and
make diﬀerent renderings and animations from them. You create, delete and switch scenes
using the scene
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Figure 51

menu in the info header. A new document starts by default with just one scene, called
“Scene”.

13.13. Leaving Blender
To exit Blender:
1. If there's a tool active, press ESC to exit the tool.
2. Press CTRL + Q . This brings up an OK? menu.
3. Conﬁrm Quit Blender by clicking LMB or pressing ENTER .
Note:
In versions before 2.79, Blender will not prompt you to save your work. However, you
can easily pick up where you left oﬀ by using File → Recover Last Session.

13.14. Additional Resources
• YouTube video on Splitting and Joining Windows in 2.49 at www.youtube.com/watch?
v=uYb1j8X-{}ulc
• YouTube video on Splitting and Joining Windows in 2.59 at www.youtube.com/watch?
v=mGK1gwFhx9M
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• The Blender Manual page on window types at http://wiki.blender.org/index.php/
Doc:Manual/windowtypes
• The Blender Manual page on changing window frames at http://wiki.blender.org/
index.php/Doc:Manual/changingwindowframes
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14. User Preferences Windows
i Information
Applicable Blender version: 2.57
In this module, we'll take a closer look at the User Preferences window. In the process,
you'll encounter three diﬀerent user-interface controls: radio buttons, toggle buttons, and
sliders.

14.1. Saving User Preferences
Most applications have a place to keep user-conﬁgured settings (including document defaults), separate from any user-created documents. Blender works in a slightly diﬀerent
fashion. All user-conﬁgured settings are saved in every document you create. Each time you
create a new Blender document, it reloads your default document, which is called .B.blend.
To save your current state as the default document, press CTRL + U . This will save
everything you’ve done to the current in-memory document, including objects and materials
created, to .B.blend.

14.2. Accessing the User Preferences
First we must open the User Preferences window. There are 3 ways to do this:
• Click LMB File → User Preferences...
• Change the window type of the top header to User Preferences

87

User Preferences Windows

Figure 52
and drag the header down.
• Press CTRL + ALT + U , which will open the User Preferences into a separate window
which you can resize at will.
The User Preferences window should look something like the screenshot below.
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Figure 53

14.3. Conﬁguring Your Preferences
In order to get to modeling and rendering sooner, this tutorial will cover only a few of the
many user-settable preferences.

14.3.1. Auto Save
As the name suggests, Auto Save automatically saves the current .blend after a speciﬁed
period of time. The settings are:
• Auto Save Temporary Files: This enables/disables the auto save feature.
• Timer (mins) slider: This speciﬁes the time in minutes between each auto save.
Note:
In Blender 2.66 and later, an additional option is available: ”Keep Session”. This option
always saves a quit.blend at Quit, and loads it on starting Blender. If you close Blender
with an ”empty ﬁle” session (the startup.blend), it keeps the Window header name
”Blender” and treats the session as if no ﬁle was loaded. For the purposes of this tutorial,
it can be left disabled.
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Figure 54

14.3.2. Number of Undo Levels
Next we'll look at the undo settings. By default, Blender remembers your last 32 actions
and allows you to undo them one at a time by pressing CTRL + Z . If your computer
has plenty of memory, you may wish to increase that number. If it has relatively little
memory, you might consider decreasing it to 10 or 20. The Memory Limit slider speciﬁes
the amount of RAM (in megabytes) to use for storing the undo levels. Undo level ”0” is
unlimited.
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Figure 55

14.3.3. Numpad Emulation
Blender uses numberpad keys (such as 7 ) to control the 3D View and ordinary numeral
keys (such as 7 ) to change layers. If you are working on a laptop or if you ﬁnd the
numberpad inconvenient, you can select Emulate Numpad to reassign the 3D View controls
to the ordinary numeral keys.
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Figure 56

If you ever need to restore Blender to its factory settings, you can delete your personal
”.blend” ﬁle then restart Blender, or click LMB File → Load Factory Settings
Note:
The second method only aﬀects the current session. To make the settings persist, you
would need to save them with CTRL + U or File → Save User Settings - This menu
name has been changed to Save Startup File in Blender 2.67b.

14.4. Additional Resources
• The Blender Manual page on Conﬁguration at http://wiki.blender.org/index.php/
Doc:Manual/Configuration
• The tutorial on Non-standard Equipment1 describes other workarounds for numpad issues.

1
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15. Properties Window
i Information
Applicable Blender version: 2.67
The Properties

Figure 57
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window is where you will ﬁnd most of the functions that Blender can perform with objects
and materials, animation, rendering, etc. It is the area where you will see the greatest
number of changes from earlier versions of Blender (in which, it was called the Buttons
window). Hopefully you’ll agree the new layout makes it much easier and quicker to ﬁnd
things!
In the header of the Properties window, you will see a row of buttons that looks like this:

Figure 58

The actual icons will vary depending on the type of object selected in the 3D view. In the
default layout, the Properties window may be too narrow to show the entire row, in which
case you can widen the window, click drag across the buttons with MMB to scroll the
button row, or use your mouse wheel within them. Each of these buttons gives you access to
a diﬀerent context, or subsection of the Properties settings. Unlike older verions of Blender,
there are no more “subcontexts” — no additional buttons will appear in the header when
you click any of these.
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16. The Contexts
16.1. Render Context
File:Blender255RenderContextButton.png
Here we ﬁnd the settings that control overall rendering of the ﬁnal images, i.e. what
resolution to use, output format, performance, post processing, etc.

16.2. Render Layers Context
File:Blender267RenderLayersContextButton.png
Additional settings that oﬀer ﬁner control over rendering of the ﬁnal images: which scene
layers to render, which separate parts (passes) of the rendering process to actually perform,
and how to group them into render layers (not to be confused with the scene layers) for
input into subsequent compositing.
Note:
In versions of Blender prior to 2.67, these settings were combined into the Render Context.

16.3. Scene Context
File:Blender255SceneContextButton.png
Contains settings for colour management, choosing which camera to use for rendering, and
units and gravity settings for physical modeling.
You can also select another scene to be a “background” for this scene. That is, all renders
of this (foreground) scene will also include the contents of the background scene, as though
they had been copied into this scene. While the background appears in the 3D viewport
when editing this scene, none of its contents are editable, or even selectable; that has to be
done in the background scene itself.

16.4. World Context
File:Blender255WorldContextButton.png
Settings that govern the environment in which the model is rendered. e.g. background sky
color, mist and star settings, lighting etc.
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16.5. Object Context
File:Blender255ObjectContextButton.png
Settings that apply to all types of objects. e.g. overall transformations, layer assignments,
grouping etc. The settings shown here (and any changes made) apply to the last object
selected. This is also the case for the following object-speciﬁc contexts.

16.6. Object Constraints Context
File:Blender255ObjectConstraintsContextButton.png
These settings limit the motion of the object for animation purposes. The limits can also
be tied to the motion of other objects in various ways.

16.7. Object Modiﬁers Context
File:Blender255ObjectModiﬁersContextButton.png
Settings for applying modiﬁers to the object geometry. These make changes to the geometry
that only take eﬀect at rendering time. Note: lamps, cameras and empty objects cannot
have modiﬁers.

16.8. Object Data Context
File:Blender267ObjectDataContextButtons.png
Settings speciﬁc to the type of object, e.g. mesh vertex groupings, text font, lamp settings,
camera settings, etc. This is reﬂected in the icon, which changes according to the type of
object selected.

16.9. Material Context
File:Blender255MaterialContextButton.png
The material settings for an object control its appearance, e.g. its colour, whether it has a
shiny or dull surface, how transparent it is, and so on.
Note:
The chosen rendering enginea — Blender Internal (the default), Blender Game, or Cycles
— will impact the choices available for material and texture settings.
a
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Texture Context File:Blender255TextureContextButton.png

16.10. Texture Context
File:Blender255TextureContextButton.png
The texture settings specify patterns that break up the uniform appearance of a material.
These patterns can aﬀect the colour of the material, give it a rough surface, or modify it in
other ways.

16.11. Particles Context
File:Blender255ParticlesContextButton.png
An object can be set to emit particles, like smoke, ﬂames or sparks. The concept of “particles” (and the underlying algorithms) also includes the generation of hair or fur. Particles
can be entirely custom objects, to produce eﬀects like blades of grass interspersed with
ﬂowers in a ﬁeld, water droplets on a wet surface, or even scatterings of entire buildings to
make up a large cityscape!

16.12. Physics Context
File:Blender255PhysicsContextButton.png
Settings that control how the object reacts to forces similar to objects in the real world,
e.g. whether it behaves like a rigid body that keeps its shape but can be knocked around,
something soft e.g a pillow, or a ﬂowing liquid.

16.13. Where Did The Old Stuﬀ Go?
The old Logic Context has been moved into its own window type, the Logic Editor.
The old Script Context is gone. Python scripting is now much more closely integrated into
the Blender UI, and old scripts will not work anyway.
The functions of the other contexts have been rearranged into the new contexts as listed
above. Once you get used to the new arrangement, it should make much more sense than
the old one.
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17. 3D View Windows
i Information
Applicable Blender version: 2.70
3D View

Figure 59
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windows are used to visualize 3D scenes. You’ll do a lot of work in these windows, so you
will need to learn your way around.
Note:
The 3D view only shows an approximation of the ﬁnal appearance of the scene. The
overall geometry should be correct, but don’t expect accurate rendition of materials,
textures, lighting etc, since that can be very time consuming. The 3D view is designed
to respond to your actions at interactive speeds. There are additional view options
(wireframe, hiding etc) that make it easier to see which parts of the model you’re working
on, have no eﬀect on the ﬁnal render. You can change your viewpoint at any time (which
will be essential while working on your model/scene), while the viewpoint of the render
is controlled by the camera position.
In this module, you'll learn:
•
•
•
•

to recognize 10 things commonly seen in viewports
to tell which mode Blender is in
how to change viewport options and viewpoints
how to position the 3D cursor

You'll also learn the fundamentals of:
• visibility layers

17.1. The Viewport and its Contents
Aside from its header, the remainder of a 3D View window is its viewport. You use
viewports any time you need an up-to-date view of the scene you're working on.
Viewports are busy places. Go on a scavenger hunt and see what you can ﬁnd in a simple
viewport.
1. Launch Blender.
2. Just so we're all looking at the same scene, load the factory settings using File →
Load Factory Settings.
3. Conﬁrm the “Load Factory Settings” popup with LMB (or ENTER ).
4. If the NumLock indicator on your keyboard is unlit, press NUMLOCK so that numpad
hotkeys will work properly.
(If you're unsure what
Notation module1 .)

LMB

means, please review the Keystroke, Button, and Menu

You should see something like this:

1

100

Chapter 9 on page 45

The Viewport and its Contents

Figure 60

17.1.1. A Virtual Scavenger Hunt
Look at the default scene and ﬁnd the following eight items:
In the Center

1.

a solid gray cube with orange edges.

• This is the default cube, your ﬁrst Blender object!

2.
circle

Three arrows, one red, one green and one blue, their tails joined to a white
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• This is not an object (part of your model/scene), but part of Blender’s user interface
for manipulating objects. It is the manipulator, also known as the 3D transform
widget.
• The arrows represent the directions of the X , Y and Z axes of the currently chosen
transform orientation coordinate system. Initially this is the global coordinate
system.
• The circle represents the center of the selected object (the cube).
• If you don't know what the ”global coordinate system” is, please review the module on
Coordinate Spaces in Blender2 .
• It's possible that a tool is active. Press ESC to cancel any tool action.
• Another possibility is that the manipulator has been disabled:
• Toggle it on or oﬀ with CTRL + SPACE .
3.

2
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Figure 63

A red-and-white striped circle with black cross-hairs
• This is not an object. It is the 3D Cursor, which indicates where newly-created objects
will appear in the scene.
• The cursor is similar to the insertion point in a text editor, which indicates where new
text will be inserted in a document.
In the Lower Left Corner
4.
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Figure 64

• This is not an object. It is the mini axis, and its orientation matches that of the global
coordinate system, with the usual conventions: red for X, green for Y and blue for Z.
Think of it as a little compass, reminding you which way is left/right, front/back and
up/down.
5. The notation ”(1) Cube”
This is not an object. It is object info, indicating that:
• You're viewing the ﬁrst frame of an animation.
and
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• The current or most recently selected object is named ”Cube”.
In the Upper Left Corner
6. The notation “User Persp”
This is not an object. This tells you which mode the viewport is in. The ﬁrst word will
change if you select one of the perfect views or the camera view (see below), otherwise it
just says “User”, and the second word is “Persp” or “Ortho” to indicate whether this is a
perspective or orthographic view.
To the Right of Center
7.

Figure 65
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A black round thing that resembles a sun symbol
This represents a lamp, a light source for the scene. (It is an object.)

8.

A pyramidal wireframe item
This represents a camera, a viewpoint that can be used for rendering. (It too, is an
object.) The camera is looking at the base of the pyramid. The solid triangle attached
to one side of the base is to remind you which way is up in the image that the camera
takes.
On a small display, the camera might initially lie outside of the viewport and thus be
invisible. In that case, SCROLL to zoom out until it becomes visible.

Throughout
9. A dark gray background, divided into squares by lighter lines. This is the grid ﬂoor,
which you can (but don’t have to) use as a ground plane for positioning your models.
Each grid square is one blender unit (or BU) on a side. A BU can be whatever you
wish, e.g. an inch, a centimeter, a mile, or a cubit. Blender lets you choose your scene
scale in the Scene tab of the Properties Panel.
10. Three mutually perpendicular coloured lines associated with the grid ﬂoor: the red and
green ones lying horizontally in the ﬂoor and the blue one running vertically. These are the
global coordinate axes for orienting your scene. Red is the X-axis, green the Y-axis, and
blue the Z-axis.
• In Blender 2.67a, you can't see the blue line for Z-axis here, but you can see it in Front
or Side view.

17.2. Modes
Blender has many modes, i.e. settings that aﬀect its behavior, and this is especially true
of the 3D View window.
Sometimes it's not obvious which mode is active. This leads to mode errors where Blender
will do something you didn't expect because you thought it was in one mode and it was
actually in another.
The function performed by a hotkey or mouse button can depend on:
•
•
•
•
•
•

what mode the user interface is in,
whether the keyboard is in NumLock mode,
which window is active,
the mode the active window is in,
which item or items are selected,
whether you've initiated a hotkey sequence.

It helps to recognize the common modes and how to get out of them.
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17.2.1. Object Mode vs. Edit Mode
The 3D View windows are normally in Object Mode. In this mode:
• • The mouse pointer is the default arrow normally used on other programs.
• RMB is used to select objects in the scene
If there are objects in the scene, you can get into ﬁve other modes:
• Edit Mode: used to edit the shapes of objects
• The mouse pointer is a thin inverse-video cross.
• RMB is used to select vertices, faces or edges of the current object.
• Press TAB to enter/exit this mode.
• Sculpt Mode/Vertex Paint/Texture Paint/Weight Paint
• The mouse pointer is now a thin, orange (white in Texture Paint) circle.
These modes are also indicated by a menu in the 3D View header. You can use this menu
to change modes.
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Figure 67

These modes are a setting shared by all 3D View windows. In other words, when you change
the mode in one window, any other 3D View windows change mode also.

17.3. Viewport Options
Note:
The options in this section only aﬀect 3D View viewports. They do not aﬀect renders.
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17.3.1. Solid vs. Wireframe
By default, the 3D View window draws objects using the Solid drawtype, in which surfaces
are opaque. To toggle between Solid and Wireframe drawtype (edges only, no faces) for a
particular viewport:
1. Activate the 3D View window.
2. Press Z .
Alternatively, you can choose these and other drawtypes from the ”Viewport shading” menu
in the 3D View window header.

17.3.2. Orthographic vs. Perspective
By default, viewports draw orthographic views. To toggle a viewport between orthographic
and perspective views:
1. Activate the 3D View window.
2. Press NUM5 .
(If you're unsure what the diﬀerence is, please review the ”Orthographic Views” module
and the ”Perspective Views” module .)
Note this perspective versus orthographic setting for the 3D viewport is completely separate
from the similar setting in the camera properties. The former takes eﬀect while you’re
working on the model, the latter when you render.
So why have a separate setting for the 3D view? Because certain aspects of modelling are
easier in one view than another. If the ﬁnal render will be using perspective, then showing
perspective in the 3D view naturally gives you a better idea of how the ﬁnal render will
look. But perspective foreshortening can sometimes make it hard to ensure the model has
the proper shape, which is why there is the option to switch to orthographic view.
... you should activate the View Name option. This is enabled by default and causes the
name of the current view (”User Persp”, for instance) to appear in the upper left corner of
every viewport. If there is no text, then you can enable it by:
1. Accessing the User Preferences window.
2. Click on the Interface tab.
3. Enable View Name.

17.4. Changing Your Viewpoint, Part One
Each viewport has a viewpoint, which takes into account:
• the location of the viewer in the 3D scene (There doesn't need to be an object at that
location.)
• the direction the viewer is looking
• the magniﬁcation (or zoom factor) used
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Changing your viewpoint allows you to navigate your way through a 3D scene.
We'll start with three very basic techniques:
• Zooming
• Orbiting/View Rotation
• Perfect Views.
Additional techniques will be covered later in this module.

17.4.1. Zooming
Blender oﬀers several ways to zoom in and out:
• Use SCROLL
• Click and drag vertically with CTRL + MMB .
• Use NUM+ and NUM- to zoom in and out in small increments.
Note the following limitations of Blender's zoom feature:
• If the viewport is in orthographic mode, Blender zooms as if looking through a telescope.
You can increase the magniﬁcation, but the viewpoint's location doesn't change. For this
reason, you cannot zoom into or through objects in orthographic mode.
• If the viewport is in perspective mode, Blender zooms to the center of the viewport. The
viewpoint can pass through objects, but can't pass beyond this point, no matter what
you do. Zooming only gets slower and slower and slower. If the center of the viewport is
somewhere you don't expect, zooming may appear to be broken.

17.4.2. Orbiting and View Rotation
Let's ﬂy around the default cube, viewing it from diﬀerent angles. In this way you'll see
that it really is a cube, centered on the origin, half above the X-Y plane and half below it.
1. Activate the 3D View window by placing the mouse pointer inside it.
2. Now you can:
• Click and drag with MMB to orbit freely around the center of the view.
• Use SHIFT + ALT + SCROLL to rotate the viewpoint vertically around the center
of the view.
• Use NUM2 and NUM8 to rotate the viewpoint vertically around the center of
the view in 15-degree increments.
• Use CTRL + ALT + SCROLL to rotate the viewpoint around the Z axis.
• Use NUM4 and NUM6 to rotate the viewpoint around the Z axis in 15-degree
increments.
If this is all very confusing for you, don't worry! You'll learn as you get more experience.
When you are ﬁnished ﬂying around the cube, you can restore the original view by reloading
the factory settings with File → Load Factory Settings.
You may have pressed number keys above the letters instead of the ones on the numpad. If
you do, the default cube will vanish. This is because the scene consists of multiple layers.
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The default cube is in layer 1, and you've told Blender to switch to the layer of the number
you just pressed. The selected object (the cube in this case) remains in layer 1, which is no
longer visible. For instance, 2KEY tells Blender to switch to layer 2. To switch to layer 1
again, press 1KEY . You can view the diﬀerent layers by clicking on the little squares on
the layer map:

Figure 68

Note:
The center of the viewport is not marked, i.e. it's diﬃcult to tell where it is. This can
cause unexpected behavior during rotation.

17.4.3. Perfect Views
It's often useful to get a perfect view of a scene, i.e. to view it along one of the main axes,
with the other two main axes oriented up-down and left-right.
Perfect View Hotkeys
Hotkey
View
NUM7
”top”
CTRL + NUM7
”bottom”
NUM1
”front”
CTRL + NUM1
”rear”
NUM3
”right side”
CTRL + NUM3
”left side”

Axis Pointing Right
+X
+X
+X
-X
+Y
-Y

Axis Pointing Up
+Y
-Y
+Z
+Z
+Z
+Z

The following screenshot shows all three perfect views plus camera perspective for the
Suzanne primitive:
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Figure 69

This layout is used so often, it has a keyboard shortcut: ( CTRL + ALT + Q ).

17.5. Positioning the 3D Cursor
Positioning the 3D cursor is a very basic operation, yet one that many beginners ﬁnd
challenging. It touches on an issue common to all 3D graphics software: ”How do you
specify points in a 3D scene when we can only see two dimensions at a time?”

17.5.1. Basic Technique
1. Go into either Object Mode or Edit Mode.
2. Move the mouse pointer to the desired position (in any viewport).
3. Click LMB .
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B

Warning

This technique will fail if the 3D manipulation widget is enabled and your desired
position is too close to it. Clicking LMB on or near the widget (the white circle with
the colored arrows) will initiate a transform operation; the object's outline will turn
white and the mouse pointer will begin dragging the object around. If this happens,
press ESC to cancel the transform operation.

B

Warning

Clicking LMB in a viewport can only reposition the cursor in two out of three
dimensions. (The cursor's projected distance along the central line-of-sight remains
unchanged.) For this reason, any time you reposition the cursor this way you should
immediately verify its position using a diﬀerent viewpoint.

17.5.2. Two Challenges
Challenge #1. Using only tools presented thus far, try positioning the 3D cursor on the
virtual camera.
Try it!
When you're done, check your work by orbiting the camera.
Perhaps you thought you were done when you clicked on the camera. But the moment you
changed your viewpoint, you probably found that the 3D cursor was actually behind (or in
front of) the camera.
Hints:
• Try positioning the cursor in two diﬀerent perfect views.
• Use orthographic, not perspective, view.
Challenge #2. Using only tools presented thus far, try repositioning the 3D cursor at the
origin (that is, at the center of the cube).
As before, check your work by orbiting the cube. Don't spend too much time on this.
”I found that I would select the cube when left clicking on it in object mode, if the ”Use 3d
transform manipulator” button was enabled. To toggle this oﬀ, you click on the gray
pointing hand in the 3d panel header, or (Ctrl Space).”
”When you want the cursor back into the cube, just select the camera with RMB, put the
cursor into the cube following the steps above, and re-select the cube with RMB.”
”I've discovered it helps a lot if you are in Object Mode and not in Edit Mode. I wrote the
following before discovering this: The problem with this exercise, for me, is that left clicking
on the cube selects the cube instead of moving the 3d cursor. If I click on the cube outside
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of its central white circle I can get the cursor to move there, but only to outside of this white
circle, and even then this only works sometimes.”
”I failed at this until I had zoomed in close enough to the cube. When I was too far zoomed
out I kept selecting the cube rather than creating an edit point.”
”I had the same problem and found it was because the cube was selected. I made sure I was
in object mode, right clicked on the camera to select the camera instead of the cube, and I
could then position the edit point in the cube. However, doing this messed up the next part
of the tutorial because you cannot switch into edit mode with the camera selected! Perhaps
the suggestion of trying to put the 3D cursor in the cube should be dropped as it raises too
many questions at this stage.”
”You can deselect all by pressing the AKEY or the select button in the 3D View.”
”Use wireframe mode works better to get the cursor in.”
”To get it back in the cube: 1) Make sure you're in object mode. 2) Select the cube. 3)
Object > Snap > Cursor to selection (cursor refers to the 3D cursor here) so it puts it right
in the middle of the cube.”
”I think it's an essential point to note that in order to place the cursor inside the cube, the
cube must NOT be selected. AKEY was probably the best way to deselect the object.”
”If I remember correctly, undo history gets cleared when you switch between object and
edit mode.”
”I wasted a lot of time here. Thank you to the reader who suggested (on the 3D view header)
Object > Snap > Cursor to selection. It was the only thing that worked to get the cursor
visible again and placed where clicked.”
”I missed the point of the exercise ﬁrst time around. You can't set a 3D point on a 2D screen
without technique. Orthographic views are crucial. I am just learning, but take that, at
least, away from it.”
”Positioning the 3D cursor in othographic views always made it snap to the cube surface,
making it impossible to center precisely. Fix this by disabling ”Cursor Depth” on the
”interface” tab under ”User Preferences”.
”The phrase check your work by orbiting the camera needs additional clariﬁcation, such as
a referenced section or the precise commands to use.”
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17.5.3. More Ways to Position the Cursor

Figure 70

Here's an easy way to position the cursor at the center of an object:
1. Make sure Blender is in Object Mode, with the object selected.
2. Move the mouse pointer to any 3D View window.
3. Snap the cursor to the selected object using either:
• SHIFT + S → Cursor to Selected
or
• Object → Snap → Cursor to Selected
Here's 2 easy ways to relocate the cursor to the scene's origin (0, 0, 0):
1. Move the mouse pointer to any 3D View window.
2. Press SHIFT + C to reset the cursor to the origin.
• Note that this also changes the view location, meaning that when you zoom in, you
won't zoom in to the scene origin.
3. A better way is to click Object → Snap → Cursor to Center
• You can also do this by SHIFT + S → Cursor to Center.

17.6. Changing Your Viewpoint, Part Two
Now you'll learn some additional techniques for obtaining the view you want:
•
•
•
•

Panning
Centering
Jumping to the camera's viewpoint
Zooming in on a selected area
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17.6.1. Panning
When you orbited the cube, the viewpoint's position and direction both changed at the
same time. You also can shift the viewpoint up-down or left-right without changing its
direction. (This is similar to the side-scrolling eﬀect in the classic Mario and Sonic video
games.)
This is called panning3 , and it's an important skill to master. Try it now:
1. Activate a 3D View window by placing the mouse pointer inside it.
2. Now you can:
• Use SHIFT + SCROLL to pan up and down.
• Use CTRL + NUM2 and CTRL + NUM8 to pan up and down in small increments.
• Use CTRL + SCROLL to pan left and right.
• Use CTRL + NUM4 and CTRL + NUM6 to pan left and right in small increments.
• Click and drag with SHIFT + MMB or SHIFT + ALT + LMB to pan freely in
the viewplane.
You will likely ﬁnd this to be a distraction in some cases. To move the viewpoint position
back to the center, snap the cursor to the center, then click View → Align View → Center
View to Cursor. You could also snap the cursor to the center then press CTRL + NUM. .
In versions ≥2.74 you can also use ALT + HOME to center the view to the cursor.

17.6.2. Centering
When you zoom or rotate the view, you always zoom or rotate around the center of the
view.
To make sure everything in your scene is visible:
1. Press HOME .
To center the view on an arbitrary point:
1. Move the 3D cursor to the point of interest.
2. Verify the cursor position from a second viewpoint.
3. Press ALT + HOME to center the view.
To center the view on an object in the scene:
1.
2.
3.
4.
5.

3
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Make sure Blender is in Object Mode.
Zoom out until the object is in the viewport.
If any objects are selected, use A (or Select → Select/Deselect All) to deselect them.
Select the object of interest by clicking RMB on it.
Press NUM. to center the view.

https://en.wikipedia.org/wiki/Panning_%28camera%29

View Navigation

17.6.3. Jumping to the Camera's Viewpoint
To see the scene as the virtual camera sees it, press NUM0 . Afterwards, you can rotate,
pan, and zoom normally, but the virtual camera will not follow. To go back to your previous
view, press NUM0 again. (In the latest versions of Blender, the virtual camera can be
made to follow all the changes made in viewpoint while in camera view by checking the
option ”Lock Camera to View” on the Transform panel. Hit N on your keyboard to bring
up the transform panel. To disable this option uncheck ”Lock Camera to View.”)

17.6.4. Zooming into a Selected Area
Suppose you want to get an extreme closeup of a particular area. Because there's no center
mark on the viewport, you might have to pan and zoom several times to get the desired
view.
The shortcut for zooming to an area is:
1.
2.
3.
4.

Activate a 3D view window that contains the area of interest.
Press SHIFT + B . A crosshair appears in the viewport.
Click and drag with LMB to draw a rectangle around the area of interest.
When you release LMB , the viewport will zoom in on the area you selected.

17.7. View Navigation
You can also change your viewpoint in the 3D view by “walking” or “ﬂying” through it. To
activate this, press SHIFT + F . By default in Blender 2.70, this puts you in “walk” mode.
Earlier versions only oﬀered “ﬂy” mode. (In Blender 2.70 and later, you can choose which
one you prefer in User Preferences, under the Input tab.)
In both modes, helpful prompts appear in the header of the 3D view window to remind you
of the key functions while the mode is in eﬀect. When you have reached the position and
orientation you want, press LMB or ENTER or SPACE to end the navigation mode
and stay there, or RMB or ESC to abandon the navigation mode and be teleported
immediately back to your original position and orientation. (In 2.77+, pressing SPACE
will teleport you to where the cross hairs point towards.)

17.7.1. Walk Mode
In this mode, you move the mouse to turn your view up/down/left/right, and W , A ,
S and D or the corresponding arrow keys to move forward, left, back or right, and E
and Q to move up or down respectively. Hold a movement key down to keep moving.
Movement stops as soon as you release it. Pressing MMB will “teleport” you close to
whatever objects lie within the crosshairs at the centre of the view.
You can also use TAB to turn on gravity. Make sure there is a ﬂoor or other object under
you to land on! With gravity on, you can no longer use the vertical movement keys, but
you can use V to make jumps. Press TAB again to turn gravity oﬀ.
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17.7.2. Fly Mode
In this older mode, moving the mouse to change the view works the same as in Walk mode,
but the above direction keys ( W , A , S , D , E , Q and the arrows) apply
“thrust” in the respective directions, so you keep moving after releasing the key. Press the key
repeatedly to increase your speed in that direction, or press the key for the opposite thrust
direction to reduce your speed. You can roll the mouse wheel up to apply forward thrust,
or roll it down to apply backward thrust.
Your current velocity vector automatically changes direction with you when you turn. Thus,
you can apply a single burst of sideways thrust while facing an object, then, without applying
any additional thrust, keep turning to face the object, and you will go right around it.

17.8. Visibility Layers
Every object in the scene is assigned to one or more of 20 visibility layers.
Visibility layers have many uses:
• You can put scenery, characters, particles, and lamps in diﬀerent layers, to help organize
your scene.
• By changing which layers are visible, you can simplify your view of the scene and work
with only one or two layers at a time.
• When rendering, only visible layers are included. You can use this to render your scene
layer by layer, checking each layer separately.
• You can conﬁgure lamps to illuminate only objects in the same layer.

Figure 71 Left: Viewing layer 1 only.
Right: Viewing all 20 layers.

In Object Mode, you can tell which layers are visible by looking at the twenty small boxes
located in the 3D View header between the Transform Orientation menu and the ”Lock”
button. The top row of boxes represents layers 1 through 10, with 1 being the leftmost and
10 being the rightmost. Similarly, the bottom row of boxes represents layers 11 through 20.

17.8.1. Hotkeys
•
•
•
•

To
To
To
To
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view
view
view
view

just
just
just
just

one of layers 1 - 9, press 1KEY .. 9KEY .
layer 10, press 0KEY .
one of layers 11 - 19, press ALT + 1KEY ..
layer 20, press ALT + 0KEY .

ALT

+ 9KEY

Count Your Polys
• To toggle the visibility of one of layers 1 - 9 without aﬀecting the visibility of the other
layers, press SHIFT + 1KEY .. SHIFT + 9KEY .
• To toggle the visibility of layer 10 without aﬀecting the visibility of the other layers, press
SHIFT + 0KEY .
• To toggle the visibility of one of layers 11 .. 19 without aﬀecting the visibility of the other
layers, press ALT + SHIFT + 1KEY .. ALT + SHIFT + 9KEY .
• To toggle the visibility of layer 20 without aﬀecting the visibility of the other layers, press
ALT + SHIFT + 0KEY .
• To make all layers visible at once, press ~ . Press ~ again to return to your previous
layer visibility setting.
Note:
The hotkeys in this section will not work if you've enabled numpad emulation in the User
Preferences window. See the ”User Preferences Windows” module for more details.
On the AZERTY keyboard layout, the standard number keys are the &é”'(-è_çà keys. Do
not use SHIFT unless you want to toggle visibility as explained below.
Holding down SHIFT while selecting a layer (by keyboard or mouse) will, instead of making
only that layer visible, toggle the visibility. In this way, you can select combinations or to
hide particular layers.
The key to press to select all layers at once diﬀers by keyboard layout. It is:
•
•
•
•
•
•
•
•
•
•
•
•

(the key under Esc) on UK keyboards,
US,
Ö German, Swedish, Finnish and Hungarian,
¨ Swiss German,
Æ Danish,
Ù AZERTY,
Ø Norwegian,
Ñ Spanish,
Ç Portuguese,
34 Brazilian Portuguese,
Ò Italian, and
�
Russian.
¬

‘~

After pressing the aforementioned key, holding down SHIFT while pressing it again will
restore the visibility settings you had before you made all layers visible.
When only one layer is selected, new objects are automatically assigned to that layer. When
two or more layers are visible, new objects are assigned to the most recently visible layer.

17.9. Count Your Polys
If you want to count the polygons in your scene, the data is available in the Info Header.
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Figure 72

As you can see in the above image, this scene has 507 vertices and 500 faces (polygons).
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18. Object Mode
i Information
Applicable Blender version: 2.70

18.1. Introduction
In this module, you will learn some basics about operating in Object mode. This is
normally the initial mode Blender is in when you open a new document. It is the mode
where you operate on whole objects, rather than on their parts.
Many of the conventions involving selection and manipulation of objects or parts of objects apply to other modes as well, so this is a good place to become familiar with those
conventions.
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Figure 73
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Figure 74

Cube selected in Object mode.

Open a new document, then conﬁrm you are in Object mode by checking the mode menu.
Select the default cube by clicking on it with RMB . You will see it framed in an orange
outline.

18.2. Object Origin
When you select an object, you will notice a round dot appears, normally in the middle of
the object, the same orange-yellow as the rest of the selection.
This is the object’s origin. It is the reference point for the object’s local coordinate system.
Certain kinds of edits to the object can cause this origin to end up at a position well outside
the object. If that happens, operations like transformations applied with reference to the
origin may not behave as expected. However, Blender has capabilities to deal with this.
They will be explained when you need them.

18.3. Multiple Selections
You can select more than one object at a time. With the cube still selected, change your
view until you can see both it and the default lamp. Select the lamp by clicking on it with
SHIFT + RMB , so both it and the cube are selected. You will notice that the lamp takes
on the orange-yellow colour, but the cube now has a more reddish highlight.
The active object is the last one selected. Other objects can be part of the selection, but
the reddish-orange highlight indicates that they are not active. The Properties window
shows properties for the active object, not the entire selection, although operations in the
3D view like moving and deleting objects will aﬀect the entire selection. Some operations
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(like parenting, which you will learn about later) set up a special relationship between the
active object and the rest of the selection, so for these, the order of selection of objects
becomes important.
You can remove the active object from the selection with SHIFT + RMB ; the small spot
indicating the origin of the object’s geometry stays highlighted in the yellow-orange colour,
even though the rest of the object loses the selection highlight. If you do this to an inactive
object, it will make that object active.
Pressing CTRL + I inverts the selection. i.e. it deselects what was previously selected,
and selects everything else instead. It does not change the active object.

18.4. Selecting Obscured Objects
If multiple objects lie under the mouse, you can choose which one to select by clicking ALT
+ RMB : this will bring up a menu listing the names of the selectable objects.
Alternatively, you can add an object to the current selection, or remove it from the current
selection, by clicking ALT + SHIFT + RMB and selecting it from the menu.
On Ubuntu 16.04 LTS, it appears that ALT + RMB has the same eﬀect as RMB on a
Window's title bar. But ALT + SHIFT + RMB does the trick of Selecting Obscured
Objects.

18.5. Selecting Everything and Nothing
Pressing A does one of two things: if anything is selected, it clears the selection (i.e.
selected objects are no longer selected). But if nothing is selected, then it selects everything.
You will often see instructions to press A either once or twice, to ensure that either nothing
is selected, or everything is selected.

18.6. Hiding Things
When working on a complex model or scene, things are likely to get cluttered, making it
hard to see the speciﬁc part you’re working on. It is possible to hide objects, so they no
longer appear in the 3D view. Select the object(s) you wish to hide, and press H . This
is purely a convenience for working in the 3D view, i.e. hidden objects remain unchanged
when you render them.
Pressing SHIFT + H hides everything except the current selection. This is a quick way
to remove the clutter and narrow the view to the objects of interest.
Pressing ALT + H brings back all hidden objects and selects them. If you lose track of
what is hidden and what is visible, press this to bring everything back.
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18.7. Local Versus Global View
Local view is another way of selectively hiding parts of the scene. Pressing NUM/ (
for emulated numpad) hides everything that is not selected, and automatically zooms in or
out as necessary so the selected objects ﬁll the 3D view. Pressing NUM/ again, restores
the items to the normal global view.
This diﬀers from simple hiding with H in that a render done in local view only shows
the objects currently visible in that view. In particular, if your lights are excluded from the
local view, you are liable to see black blobs in place of your objects.
How do I determine the viewing mode? Look at the words in the upper-left corner
of the 3D view. They indicate your current view orientation and perspective settings (e.g.
“User Persp”). If the word “(Local)” appears at the end of the string, you are in local view.
Otherwise, you are in global view.

18.8. Border Select (Box Selection)
A quick way to select many objects at once is with the Border Select (box selection).
Press B to activate it. You will see a pair of dotted crosshairs appear centred at the
current mouse position. Drag diagonally with LMB to mark a selection rectangle, then
release the LMB . Everything within the rectangle will be added to the selection. If you
didn’t mean to engage box-selection mode, pressing ESC exits border select mode.
Alternatively, to remove things from the current selection, after pressing B , drag the
selection rectangle with MMB . When you release the mouse button, everything in the
drawn box will be deselected.

18.9. Circle Select (Brush Selection)
Another way to select several objects at once is with the Circle Select (brush selection),
engaged by pressing C . In this mode, clicking or dragging on objects with LMB adds
them to the selection, while MMB removes them from the selection. Thus the mouse
becomes a brush that you can use to “paint” objects in or out of the selection.
The circle showing the size of the brush can be adjusted with the mouse wheel. This allows
you to use a broad brush for selection of lots of objects at once, or a ﬁner one for better
control.
Clicking RMB or pressing ESC terminates Circle Select mode.
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18.10. The Manipulator

Figure 75
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Manipulator transformation buttons & orientation menu

The Manipulator

Figure 76

Manipulator—translation
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Figure 77
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Manipulator—rotation

The Manipulator

Figure 78

Manipulator—scaling

The manipulator appears in the middle of the selection. There are three kinds of manipulator as shown in the illustrations. It can be used to apply translation (position changes),
rotation and scaling (size changes) to objects. Its appearance changes according to which of
these functions are enabled. You can click on the menu transformation buttons that appear
when the manipulator is visible, to choose a single transformation, or shift-click to enable
more than one simultaneously. You can toggle the visibility of the manipulator with CTRL
+ SPACE , or by clicking the menu button with the red, green and blue arrows.
If you have troubles selecting the red arcs of the rotation manipulator select File→ User
Preferences... System → Selection and change it to ”OpenGL Select” or ”OpenGL Occlusion
Queries”.
Transform orientations: the “Orientation” menu governs how the axes of the manipulator
are aligned, with the default “Global” corresponding to the global coordinate system. Other
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useful options are “Local”, which corresponds to the local coordinates system of each object,
and “View”, which is always aligned to your view.
To demonstrate this, click on the camera with RMB so that it is the only object selected.
Set the manipulator to do only translations (blue arrow button is selected in menu), and
ensure the orientation is set to “Global”. Drag any of the manipulator's coloured arrows
with LMB to move the camera in the corresponding direction.
Now switch the orientation to “Local”. You will see the manipulator arrows re-orient themselves. Note that the Z-direction (blue arrow) is now in the direction of the camera view.
The local co-ordinates of the camera have the optical axis of the camera running along the
Z axis. By default, that is pointing towards the cube object.
The cube, by default, has its own local Z-direction running vertically.
With the manipulator orientation still set to Local, add the cube to the selection with
SHIFT + RMB . You will see the manipulator move so it is in the centre of the selected
objects. It is now between the camera and the cube. Now if you drag the manipulator
Z axis arrow with LMB , each object will move along its own version of that axis. The
camera moves towards or away from the cube and the cube rises or falls.
Switch the orientation to “Global”, and try dragging a manipulator arrow again. This time,
both objects will appear locked together and will move in the same direction, along the
same (global) axis.

18.11. Transformation Hotkeys
The manipulator is not the only way to apply transformations to objects. That can also be
done via keyboard shortcuts.
Hide the manipulator to reduce clutter. Select the cube, and only the cube, with RMB .
Now press G to Grab the object. The selection outline around the object turns white,
as it did when you were dragging with the manipulator, except this time, you didn’t press
any mouse buttons. Now move the mouse without pressing any buttons, and you will see
the object move along with it. Press LMB or ENTER to terminate the movement and
leave the selected object at the new position, or RMB or ESC to cancel the operation
and leave the object at its original location.
Similarly, use R

to Rotate the object, and S

to Scale it.

You can constrain the movement to particular axes by pressing the appropriate axis key.
For example, press G to start moving the cube again, then press X and you will see a
bright colored line appear parallel to the global X-axis. Now when you move the mouse, the
cube will move along only that colored line. Similarly Y and Z constrain movement to
the Y and Z axes respectively. The colored lines that appear are a brighter reddish, green
or blue that correspond to the red, green or blue lines for the X, Y or Z axes, respectively.
Transform orientations: to constrain the transformation to a diﬀerent set of axes, press
the constraint key twice. The coordinate system used depends on the selection in the
Transform Orientation menu:
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• Local or Global — the transformation happens in the object’s local coordinate system.
• View — the transformation is aligned to view coordinates.
For example, with the default “Global” selection from this menu, select the camera with
RMB , press G to move it, then press Z twice, and you will see the coloured line orient
itself along the direction of view of the camera.
The axis constraints also work with scaling, and rotation (which only happens around the
speciﬁed axis).
You can also constrain movement and scaling to happen along two axes, but not the third
one, by holding down SHIFT when typing the axis constraint. For example, G followed
by SHIFT + Z will constrain movement to the global X-Y plane (i.e. any direction
except along the Z-axis). To constrain movement to the local X-Y plane, type the contraint
SHIFT + Z
SHIFT + Z .
twice: G
Here’s a summary of what the transformation hotkeys do, with and without constraints:
Key
G
R
S

without constraint
moves in plane perpendicular to view direction
rotates about view direction
scales uniformly along all
axes

followed by
followed by SHIFT -axis
axis
moves along
moves in plane perpendicaxis
ular to axis
rotates about axis
scales along
axis

scales uniformly in plane
perpendicular to axis

In addition, the hotkey sequence R
R enables free rotate, i.e. the object can rotate
around all three axes as you move the mouse.

18.11.1. Transforming by Numbers
Sometimes you need to position things accurately, using calculated numbers, instead of estimating by eye. Blender can do that too. Simply type the number after the transformation
X
1KEY
hotkeys before pressing ENTER to conﬁrm the operation. For example, G
ENTER will move the selection by 1 unit in the positive X direction.
G
X
-KEY
1KEY
ENTER will move by 1 unit along negative X. Decimal points are allowed, thus
S
0KEY
.KEY
5KEY
ENTER will scale the selection by a factor of 0.5, or 50%.
Rotation works similarly, using degrees clockwise around the selected X, Y or Z axis.
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18.11.2. Transformation Menu

Figure 79

Yet another way is shown at right, in the Transform panel that appears at the top of the
Properties shelf (press N to toggle its visibility at the right side of the 3D view). Here
you can see the existing transformations values. You can drag the sliders to change them,
or click on them and enter new values.
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18.12. Choosing the Pivot Point

Figure 80

When you do a scaling or rotation operation, you can choose the pivot point, which is
the central origin point that remains unaﬀected by the operation. By default this is the
“Median Point”, or centre point of the selection, but the Pivot Point menu lets you choose
some other options. For example, select both the cube and the camera, and rotate them (
R ). By default they will rotate around their common centre. Now go to the Pivot Point
menu and choose “Individual Origins” and rotate your two selected objects with R again,
and you will see each one now rotates about its own centre, rather than the common one.
Another useful pivot option is “3D Cursor”, which places the transformation origin at the
3D cursor location.
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Finally, the button with three dots and a double-headed arrow immediately to the right of
the one that pops up the Pivot Point menu is titled “Manipulate center points.” Selecting
this means transformations do not rotate the actual objects themselves, only their positions.
To see the eﬀect, you need to choose a pivot point that is not the object’s origin. Now try
rotating the object. You will see its centre describes an arc around the pivot point, without
changing the object's orientation. Think how the seats in a Ferris Wheel rotate around the
wheel's pivot, yet still maintain their orientation.
Similarly scaling will change the distance between the chosen pivot point and the object’s
origin, but will not aﬀect the size of the object itself. A bursting ﬁrework scales rapidly in
this way.
Why can’t I rotate or scale objects? One pitfall you might encounter is that you select
an object, try rotating with R or scaling with S , and nothing happens, though moving
with G still works. It’s quite likely you have the “Manipulate center points” button active
when you didn’t mean to. Check if it’s active, and click it to deactivate if so.
Hotkeys — there are keyboard shortcuts for all the above options:
Pivot Option
Active Element
Median Point
Individual Origins
3D Cursor
Bounding Box Center
Toggle Manipulate Center Points

Key
+ .KEY
CTRL + ,KEY
CTRL + .KEY
ALT

.KEY
,KEY
ALT

+ ,KEY

18.13. Basic Camera Technique
The camera view NUM0 is very useful for making adjustments to your camera while getting
continuous feedback on how the render will look. This view shows a framing rectangle
covering the area that will appear in the render, surrounded by a passepartout which gives
a darkened view of the surrounding part of the scene. You can use the mouse wheel to
zoom in and out, adjusting how much of your view is the rendered area and how much is
passepartout.
In this view, use RMB on the framing rectangle to select the camera, and it will show
the usual orange-yellow highlight. The manipulator will not appear even if enabled, so you
must use the transformation hotkeys to perform camera transformations.
Use G to move the camera around parallel to the view plane. Since the view stays locked
to the camera, you will see the scene move in the direction opposite of what you might
expect.
The camera’s local Z-axis lies along its direction of view. This allows useful operations like
G
Z
Z to move the camera in or out without aﬀecting the direction in which it’s
pointing. Also the X axis runs left to right in the camera view so rotating around X R
X
X will adjust the up-and-down pitch angle. Rotating around the vertical Y axis R
Y
Y will change the yaw (left-right) angle, and you can rotate around the optical axis
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of the camera using R
axis.

Z

Z

to produce an eﬀect of rolling the view around the visual

Another useful technique is to position the 3D cursor at a point of interest, set the pivot
point to the 3D cursor, then rotate the camera about a global axis, like the global Z-axis (
R
Z ), to adjust the angle of view while keeping the same objects in view, and without
altering the distance of the camera from the point of interest. In real life you'd get that eﬀect
by walking in a circle around your subject with your camera mounted on a Steadicam rig.
Scaling the camera object changes its size as shown in the 3D view, but has no eﬀect on
the actual render. Regardless of what axis constraints you try to apply, the camera object
will always scale uniformly along all axes.
You can also use Fly mode SHIFT + F
taking the camera with you.

in camera-view mode to ﬂy around the scene,

Another choice for moving your camera in Camera View is to bring up the Properties panel
( N ) and, in the View section, tick the box next to Lock Camera to View. Now you will
be able to use the MMB to ”move objects” just as you move things around in other views
such as the 3D view. Holding down the MMB and dragging will rotate, SHIFT + MMB
will allow you to ”move the object” around in the view (panning), and the scroll wheel will
allow you to ”move the object” closer or farther from the camera. You are actually moving
the camera with these manipulations and not the object(s) themselves.
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Note:
Scaling the Camera: You can scale the camera object with S as you can most
other objects. However, this has no eﬀect on what is seen with that camera. Think of
it as strictly a cosmetic thing to make the camera object easier to spot (if it’s too small
relative to other objects in the scene), or scale it down to keep it in proportion when
working with smaller objects.
Another way of changing the displayed size of the camera is to look in the Camera

Figure 81
data context in the Properties window, in the Display panel. Here there is a Size ﬁeld
that you can use to increase or reduce the size of the camera

18.14. Adding/Removing Objects, Undo/Redo, Repeat
Select the cube with RMB again. Press either X or DEL and, after conﬁrming the
popup, the cube disappears! It has been deleted from your scene. Unlike mere hiding, it
really has disappeared. Press CTRL + Z to undo your last operation, and it reappears.
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Click with LMB to position the 3D cursor away from the default cube. Press SHIFT +
A to bring up the Add menu, go to its Mesh submenu, and add another cube to the scene.
Again, undo with CTRL + Z , and you are back to a single cube again.
Now press CTRL + SHIFT + Z : this will undo the undo, and redo the last operation
you undid, bringing back the second cube.
Try adding a third cube. Now CTRL + Z should undo that and take you back to two
cubes, and pressing CTRL + Z again should undo the addition of the second cube, taking
you back to one. Try CTRL + SHIFT + Z at this point to restore the second cube, then
CTRL + SHIFT + Z again to restore the third one.
Blender remembers up to the last 32 things you did (depending on the limit set in your user
preferences) in its undo stack. You can go backward and forward through it with CTRL +
Z and CTRL + SHIFT + Z .
Sometimes you want to perform an action repeatedly. To repeat the last action, type SHIFT
+ R .

18.15. Assigning Layers
Earlier, you learned about showing and hiding layers in the 3D view. To assign layers for
selected objects, press M . The same keyboard shortcuts apply here as when choosing
which layers to display, i.e. 1KEY for only the ﬁrst layer, 2KEY for only the second etc,
SHIFT + 1KEY to include/exclude the ﬁrst layer and so on.
After assigning an object to a diﬀerent layer, it disappears! If this happens to
you, it’s because the layer(s) you assigned to the object, and the layer(s) you currently
have visible in the 3D view, have nothing in common. Simply change the visible layers to
include at least one of those you assigned the object to, and it will reappear. For example,
if currently only layer 1 is visible, and you assign an object to only layer 2, it will disappear,
but reappear when you change the visible layer to layer 2.

18.16. Object, Action, Settings
Bring up the Add menu again ( SHIFT + A ). This time, add a new cylinder mesh to the
scene. Look to the left of the 3D view, in the Tool Shelf (toggle its visibility with T if it’s
not visible), at the bottom you should see a new panel has appeared, titled “Add Cylinder”.
Near the top of it is the “Vertices” number, initially defaulting to 32, which gives a fairly
round-looking cylinder. Reduce it to 6, and adjust the view as necessary to get a good view
of your “cylinder”, and you will see it is now a hexagonal prism. Change the number of
vertices to 3, and it becomes a triangular prism.
This is an example of an important user-interface convention that runs right through
Blender: ﬁrst you select the object you want to perform an operation on as appropriate
(not applicable here because we are creating a new object), then you perform the speciﬁed
action with some default settings, and ﬁnally you adjust the settings to give the exact result
you want. This way, instead of getting a popup before the action is performed, into which
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you have to put the right settings and hope they will give the right result, you get to interactively adjust the settings and immediately see the results, without having to continually
redo the operation and deal with popups.
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19. Meshes and Edit Mode
i Information
Applicable Blender version: 2.67
A mesh is one of the most important and frequently-used object types in Blender. While
there are other types of objects that can be used to model parts of a model or scene (text,
NURBS patches, etc.), they often get converted to meshes at some point anyway, because
it is the object type that oﬀers the greatest amount of detailed control. And as it happens,
Blender oﬀers more functions, both built-in and available as addons, for dealing with meshes
than for any other object type.
Edit mode is the mode in which you make changes to the internals of the active object.
Not every object has an Edit mode (e.g. cameras), and the details of what you can do in
Edit mode vary between the object types where it is available. This module speciﬁcally
covers Edit mode for mesh objects.

19.1. What Is a Mesh?
A mesh is made up of one or more vertices; each vertex is just a point in space. A pair of
vertices can be joined by a straight line called an edge, and a complete loop of edges can be
ﬁlled in to form a face.
It is the faces that make up the visible surface of the object. The edges and vertices are
essentially geometrical ”scaﬀolding” necessary to hold the object together.
A face must have three or more sides (edges). Prior to version 2.63, only three or four sides
were allowed, so faces had to be triangles or quadrilaterals (usually abbreviated to quads)
respectively. Starting with v2.63, and the introduction of the BMesh architecture, that
restriction has been lifted. You can have faces with 5 or more sides, but you will usually
ﬁnd that things work best if all faces, as far as possible, are quads. Particularly when
constructing a model for animation purposes.
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Figure 82

Blender’s Object-mode “Add” menu ( SHIFT + A ) contains a Mesh submenu with a
collection of pre-made mesh objects. Think of these as starting points. They make building
your own objects easier by enabling you to modify an object that is an approximation of
the form you want instead of having to construct a mesh entirely from scratch.

19.2. Introduction to Edit Mode
Start a new model. Hide the manipulator if it is visible ( CTRL + SPACE ). You should
be in Object mode. Click with RMB on the default cube to ensure it is selected and the
active object.
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Figure 83

The default cube in Edit mode

You can switch modes using the mode menu, as you previously learned. However, because
switching between Object mode and Edit mode is such a frequent operation, it has a keyboard shortcut: TAB . Do this now, and you should see the appearance of the cube change,
as shown at right. The mode menu should also update. Press TAB again, and you should
be back in Object mode. Press TAB once more before continuing, to ensure you are in
Edit mode.
Note the following features of the cube, and how they relate to the description of a mesh
above:
• The dots at the corners are the vertices.
• The lines joining them are the edges.
• The ﬁlled areas bordered by the lines are the faces.
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19.3. Selection Modes

Figure 84 Select mode buttons in a 3D View header, showing Vertex select mode
active. (Found below the edit area.)

In Edit mode, the header (it's at the bottom) of the 3D View window changes to show the
selection-mode controls. If you hover over each of the buttons in the group of three, you will
see they represent vertex-select, edge-select and face-select respectively. You can shift-click
to enable more than one at a time.
In vertex-select mode, you select a single vertex by clicking on it with RMB , and select
more than one by shift-clicking on additional vertices with RMB . Shift-clicking with RMB
on an already-selected vertex will deselect it.
Pressing A will select all vertices if none are currently selected, otherwise it will unselect all
vertices.
Edge-select mode works in a similar way, except with edges instead of vertices. Similarly,
face-select mode will allow you to select and unselect faces.
The single button immediately to the right of these three is titled “limit selection to visible”.
When it is active (the default), the mesh object being edited is displayed as opaque which
means that vertices, edges or faces on the side away from you are hidden and cannot be selected. Click this button, and the object becomes translucent, allowing clicking through front
faces to select parts of the mesh behind them.
Another useful display mode for working in the 3D view is wireframe, which can be
selected from the Viewport Shading menu or toggled with the Z key. In this mode, the
faces become transparent, almost invisible, and the edges and vertices are displayed more
prominently.
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Figure 85

Here is what these various selection and display modes look like in combination: in the ﬁrst
row, a single vertex is selected. In the second row, a single edge, and in the third row, a
single face. In the ﬁrst column, limit-selection-to-visible is enabled. In the second column,
it is disabled, and in the third column, wireframe mode is enabled.

19.3.1. Selection Mode Hotkeys
You can also switch selection modes with CTRL + TAB . In the menu that appears, you
can switch to a single selection mode by selecting it with the mouse or up/down-arrow keys
and pressing ENTER or LMB . But if you press SHIFT + ENTER or SHIFT + LMB
that toggles the enabling of only that selection mode, without aﬀecting the state of the
others, as does shift-clicking on the icons above.
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In common with other Blender popup menus, you can quickly select an item from the CTRL
+ TAB menu and immediately conﬁrm by pressing one of 1KEY , 2KEY or 3KEY to
select the ﬁrst (vertex), second (edge) or third (face) item in the menu. Or, SHIFT + 1KEY
, SHIFT + 2KEY and SHIFT + 3KEY while the menu is up, will toggle the enabling of
vertex, edge, and face-select modes respectively.

19.4. Multiple Selections
You can use SHIFT + RMB to select multiple items, and CTRL + I
to invert the
selection, just like in Object mode. Only here, the “items” are vertices, edges or faces,
depending on the selection mode in eﬀect. The active (last-selected) part is shown in white,
while the rest of the selection (if any) is drawn in the usual orange-yellow colour.
As mentioned above, A works similar to the way it works in Object mode, only instead
of applying to everything, it applies to all parts of the object being edited.

19.5. Hiding Things
H , SHIFT + H and ALT + H work in a way analogous to their behaviour in Object
mode. Again, instead of applying to everything, they apply to all parts of the object being
edited.

Remembering What’s Hidden: If you switch out of Edit mode with some parts hidden,
they will reappear, then disappear again when you re-enter Edit mode, i.e. each object
remembers what was hidden when you last edited it.

19.6. Local Versus Global View
You can toggle local/global view in Edit mode, as you can in Object mode. However,
instead of narrowing the view to one or more selected objects, it narrows it to just the
object being edited.

19.7. Border Select (Box Selection) & Circle Select (Brush
Selection)
B and C work analogously to the way they do in Object mode, i.e. you select multiple
items by drawing a box or by “painting” over them.

19.8. Select More, Select Less
Edit mode has some additional selection capabilities. To demonstrate them, let’s use something other than the default cube, for a change. TAB back to Object mode, and delete
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the cube. Now add ( SHIFT + A ) a Grid object. TAB into Edit mode, and you will see
that the grid is made up of 9×9 faces, or 10×10 vertices. Initially they will all be selected.
Use A to unselect them then C to brush-select a few vertices in the middle. End
brush-select mode with RMB or ESC . Now watch what happens to the selection when
you press CTRL + NUM+ (select more). Additional vertices adjacent to those already
selected are added to the selection. Now try CTRL + NUM- (select less), and you will see
the vertices on the edge of the selection are removed from it.

19.9. Manipulator, Transformation Hotkeys, Pivot Point
All of these are available for use in Edit mode as they are in Object mode, except for the
“Manipulate center points” button.
Note that scaling vertices scales the distances between them. The vertices themselves have
no size, so they do not get larger or smaller. Similarly, rotating vertices only changes their
direction relative to the pivot point, since a featureless point itself has no orientation.

19.9.1. Transform Orientations
The Global, Local and View options in the Transform Orientation menu apply in Mesh
Edit mode as they do in Object mode. In addition there is Normal mode, where the
transformation axes are aligned relative to the selection:
• If a single face is selected, the X and Y axes are aligned along the face, while the Z axis
is aligned perpendicular (normal) to the face.
• If a single edge is selected, the Z axis is aligned along the edge, with the X and Y axes
perpendicular to it.
Other selections are also possible. Feel free to investigate their behaviour for yourself.
Thus, with a single face selected, G

Z

Z

will move the face along its normal.

In addition, it is possible to deﬁne the current Normal transformation orientation as a
custom orientation for use in transforming other vertices and even other objects. To do
this, you need to go to the Properties Shelf, which is made visible on the right of the 3D
view with N . Near the bottom is the Transform Orientations panel which contains a
Transform Orientation menu which looks the same as the one in the header of the 3D View
window, except it also has a “+” button next to it. Click the ”+” and the current Normal
transformation orientation will be added to the menu initially labeled “Vertex”, “Edge” or
“Face”, depending on what is currently selected (and with a unique numeric suﬃx added if
there is already a custom orientation deﬁned with that name). Now if you look in either
Transform Orientation menu, you will see a new selectable item, in a separate section above
the ﬁve standard items.
With your new orientation option selected, an editable text ﬁeld will appear in the Transform
Orientations panel, allowing you to change the name if you wish, and there is also a “X”
button allowing you to delete the orientation item when you no longer need it.
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With your new orientation option selected, you can now select a diﬀerent part of the object,
or even TAB into Object mode and select some other object. The manipulator and the
doubled axis hotkeys will now align their transformations along this custom orientation.
This is handy, for example, for aligning objects to a sloping plane.

19.10. Proportional Editing
When trying to produce natural, organic shapes, moving vertices one by one gets tedious.
To produce smoother looking shapes, you need a mode where unselected vertices close to
the selection also get some movement. In contrast to the sharp distinction between selected
vertices which are moved and unselected ones that remain in place, there is a gradual
transition from one to the other.
This is where proportional editing comes in. If you select “Mesh” in the header and
examine the pop-up menu, you will see two submenus, titled “Proportional Editing” and
“Proportional Editing Falloﬀ”. The former toggles the mode on and oﬀ, the latter controls
the falloﬀ function choice. There is also an icon for “Proportional Editing” in the header of
the default 3D view. Look to the right of the ”Limit Selection to Visible” (on edit mode).
The hot key is the letter O. Pressing O will toggle between Enable and Disable. Pressing
SHIFT + O will change the Falloﬀ type.
The “Proportional Editing” submenu has 4 options: “Disable”, “Enable”, “Projected (2D)”,
and “Connected”. Do you still have the Grid object you created in the “Select More, Select
Less” section above? If not, add a fresh Grid object. Switch to Edit mode, and ensure that
just a few vertices in the middle are selected. Enable proportional editing, and now use G
to move the selected vertices. You should notice 2 things:
• unselected vertices near the selected ones also move, and
• there is a white circle enclosing all the vertices that undergo any movement.
Try using the mouse wheel while moving the vertices, and you will see the white circle grow
or shrink, and the proportional region of inﬂuence will grow or shrink correspondingly.
Try diﬀerent falloﬀ functions in the “Proportional Editing Falloﬀ” submenu. Some ensure
the mesh stays smooth and curvy, others give a more angular eﬀect, etc.
The third option to ”Disable” and ”Enable” proportional editing is ”Projected (2D)”. This
view is similar to enabled, except depth is ignored. The radius of the inﬂuence region is
applied to the mesh two dimensionally.
The fourth option to “Disable” and “Enable” proportional editing is “Connected”. This one
makes a diﬀerence in more complicated meshes, which might have folds or concavities in
them. In this situation, “Enable” aﬀects all vertices within a particular distance of the
selected ones, while “Connected” only measures the distance via connected edges, rather
than directly through space. This lets you move one part of the mesh without aﬀecting
another part which might be located nearby purely as a result of a fold.
Of course, proportional editing works with scale S
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operations as well.

Deleting Things

19.11. Deleting Things

Figure 86

Now let’s try deleting parts of a mesh. This is the menu that comes up when you press X
or DEL when editing a mesh. For now, we will concentrate on the ﬁrst three items.
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Figure 87

Figure 88

First, go into face-select mode. Select one face of the default cube, press the delete key, and
select “Faces”. As shown in the screenshots, the selected face should disappear.

Figure 89
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Figure 90

Use CTRL + Z to undo your previous deletion. Now go into edge-select mode. Select
one edge this time. Press delete again, this time select “Edges”. As the screenshots show,
the selected edge disappears, but the faces bordering that edge also disappear. Faces cannot
exist without their bordering edges!

Figure 91

Figure 92

Use CTRL + Z to undo your previous deletion again. Go into vertex-select mode. Select
one vertex, make sure it’s the one closest to you so you get the best view of the eﬀect.
Press delete, and select “Vertices”. Not only does the selected vertex disappear, but also the
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edges connected to that vertex. Edges cannot exist without their endpoint vertices. And
since those edges disappeared, the faces dependent on them for their borders were deleted
as well.
So, to recap:
Note:
• An edge cannot exist without its endpoint vertices.
• A face cannot exist without its boundary edges.
• Hence, a face cannot exist without the endpoint vertices of its boundary edges.

19.12. Undo/Redo
You can undo your last Edit-mode operation with CTRL + Z , and undo your undo with
CTRL + SHIFT + Z , similarly to Object mode. However, Edit mode maintains its own
undo stack, separate from the Object-mode stack. To undo/redo an Edit-mode operation,
you must be in Edit mode, not Object mode.

19.13. Adding Things
Back to the default cube and Edit mode. Ensure you are in vertex-select mode with nothing
selected. Do a CTRL + LMB somewhere near the cube. Do you see a little orange-yellow
dot appear where you clicked? You just added a new, unconnected vertex to the mesh. (If
not, you may need to set this hotkey in user preferences - CTRL + ALT + U and search
for ”duplicate or extrude”.)
Undo your addition ( CTRL + Z ). Select an existing vertex with RMB . Now CTRL
+ LMB to add a new vertex again. You will notice that it is connected to the previously
selected vertex by a newly added edge as well. Since the newly added vertex is now the
selected vertex, doing CTRL + LMB again at another position, and so on repeatedly, lets
you construct a whole chain of new edges. But what good are edges and vertices without
faces?
To construct a face, you need a closed loop of edges. To close a loop of edges, select all the
vertices in the chain, and press F . That will add another edge joining the ﬁrst and last
vertex into a complete loop of edges and ﬁll in the loop with a new face.
If you want to close the loop without ﬁlling in the face, select only the ﬁrst and last vertex
in the chain before pressing F . Since only two vertices are selected, a new face will not
be added, i.e. it will only add an edge joining the two vertices.
You can also extrude new sections of mesh with a single click in this way. Try selecting two
adjacent corner vertices of the cube (i.e. two joined by an edge). Now CTRL + LMB near
them, and you will see you’ve created two more vertices, joined to the previous two by a
new face. CTRL + LMB again, and you can construct a whole sheet of new mesh in this
way.
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Figure 93

Undo all your additions, and get back to the pristine cube. Now select all four vertices of
a single face. CTRL + LMB near your selection, and you should have four new vertices
(corresponding to the original four you selected), plus a new face connecting them, plus
four new faces connecting them to the original four. (You may not have noticed it, but
the face formed from the original four vertices has been removed as well.) Another CTRL
+ LMB does the same thing again. So with just a few clicks, you started with a cube
and ended up with something (see at right) that is starting to resemble — who knows? A
square-cross-sectioned piece of some wonky-looking pipe, perhaps?

19.14. Simplifying Things
It is possible to remove vertices without leaving holes behind in the mesh, by merging two
or more vertices into one. Select the vertices you want to merge, and press ALT + M ; a
menu will pop up with some options, including whether to position the resulting vertex in
the middle of the ones being merged, or at the position of the ﬁrst or last one you selected.
The resulting vertex inherits all the edges that were connected to the vertices being merged,
as well as the faces connected between those edges.
Sometimes an operation creates duplicate vertices in exactly the same positions, or very
close together. You can merge these en masse by ensuring you have selected all possible
candidate vertices (e.g. the whole mesh), bringing up the Vertex Specials menu ( W )
and selecting the “Remove Doubles” item. Look for a message saying “Removed n vertices”
to show brieﬂy in the Info window. If n is 0, nothing was done. If you look in the lower
left part of the Tool shelf, you will see a “Remove Doubles” panel has appeared, with a
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“Merge Distance” slider that governs the maximum distance allowed between vertices that
are merged. Change this value as appropriate (either by clicking on the left and right
arrows, or by clicking and typing in a new value and pressing ENTER ), and the Remove
Doubles operation is immediately redone. A new message will indicate how many vertices
were removed. Simply keep adjusting the value until you are satisﬁed you haven’t removed
too many or too few vertices.
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i Information
Applicable Blender version: 2.63

Figure 94

Open a new Blender document. Delete the default cube, and add a “UV Sphere” mesh. In
the “Add UV Sphere” panel which appears at the lower left of the Toolshelf (press T to
make the Toolshelf visible if it’s not), set both the Segments and Rings to a low number,
e.g. 8. The result will be very angular, as shown to the right, not round like you would
expect a sphere to be.

Figure 95

Press F12
Editor

to do a quick render. The 3D view will be replaced with the UV/Image
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Figure 96

view, showing the rendered image, as at right. Press ESC to return to the 3D view
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Figure 97
.

Figure 98
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Select the sphere object ( RMB ). Now look in the Toolshelf for the shading buttons:

Figure 99

, and click on “Smooth”. Now try a new render with F12 .
As you can see, the surfaces of the object look a lot smoother and curved, even though the
outline or silhouette is just as angular as before.

Figure 100

Return to the 3D view with ESC . Ensure the UV sphere object is selected, and you are in
Edit mode. Bring up the Properties shelf at the right side of the 3D view with N if it’s
not already visible. Look for the Mesh Display panel, and ﬁnd the settings for Normals.

Figure 101
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. If you check both icon boxes, the display of the UV sphere should change to look something
like the image to the right.
Those spiky little lines are the normals; the green ones in the middle of each face are face
normals, the blue ones protruding from each vertex are vertex normals.
In the physical theory of light, the normal is a line perpendicular to the surface of the object
the light is hitting. When your eye (or the camera) C is positioned on a plane through the
normal of a particular surface observing a certain surface point P illuminated by a coplanar
light source L, a speciﬁc amount of light will be reﬂected and hence be registered by the
camera depending on the physical characteristics of the surface. The observed intensity of
reﬂected light is at a maximum if the angle C-P-L is divided into two equal halves by the
normal.
In the real world, a lot of surfaces are curved or otherwise not ﬂat. But a mesh can only be
made up of straight edges and ﬂat faces. So how can it represent an object with a curved
surface?
When you added the UV sphere to your scene, you had the option of specifying how many
segments and rings it was made from. The more of those present, the closer the geometry
approximates a curve. However, the more there are, the longer the render will take, and
the more memory the model will consume to hold information about all the extra vertices,
edges and faces.
Which is where that “Smooth” shading button you clicked comes in. It applies a trick called
Phong shading1 . Instead of doing the lighting calculation based on a normal for each face
as the physical theory says you should, it starts with a normal assigned to each vertex, and
interpolates the normal at each point on a face from the vertex normals at its corners, based
on the distance at that point to those corners. The result fools the eye into seeing curved,
rounded surfaces where there aren’t any.
This completely violates the laws of physics. To start with, how can you deﬁne a “normal”
which is perpendicular to a point? But as you can see, the results look rather good, with
relatively little extra computation involved, much less than actually generating all the extra
geometry.
As you learn more about computer graphics, you will come across more tricks like this.
Physically accurate modelling is still very diﬃcult to do, even with modern computers,
and the results may not look all that good. But by adopting a bit of lateral thinking
that goes completely against physics, we can often, ironically, come up with much more
realistic-looking results.

1

https://en.wikipedia.org/wiki/Phong%20shading
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20.1. Not So Smooth?

Figure 102

If you have been adding lots of vertices, edges and faces to your mesh, you may end up with
discontinuities in smooth shading causing unsightly blotches, as shown to the right.
Assuming your mesh is constructed properly (e.g. no edges and faces cross each other in
physically impossible ways), the most likely reason for this is the normals in the newly
added vertices and faces are pointing the wrong way. To ﬁx it, select the troublesome part
of the mesh (or select the whole thing) in Edit mode, and press CTRL + N to recalculate
all the normals. Re-render the scene to conﬁrm the shading discontinuity has disappeared.
Note:
Note the diﬀerent meaning of CTRL + N
a new default Blender document!
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in Edit mode. In all other modes, it opens

21. More Mesh Editing Techniques
i Information
Applicable Blender version: 2.67
You previously scratched the surface1 of the tools that Blender provides for editing meshes.
This page will introduce more of them.

21.1. Adding More Mesh Pieces
Start with the default cube again. Select it and TAB into Edit mode. Press SHIFT +
A to bring up the Add menu. Instead of all the submenus with all the objects you could
add in Object mode, you will see only a single menu containing only mesh objects. Select
another cube, and use G to move it away from the ﬁrst cube.
If you TAB into Object mode, you will see that the two cubes look like separate, disconnected objects, but they are in fact one object, and cannot be selected separately in Object
mode. You can TAB back into Edit mode, and make connections between the vertices of
the two cubes, which you cannot do with separate objects. Therefore:
Note:
A single mesh object can be made of separate, disconnected pieces.

21.2. Linked Selections
If you have some part of a mesh selected, pressing CTRL + L will select all other parts of
the mesh that are connected to the already-selected parts. In the above case of the object
made up of two disconnected cubes, you can RMB on a single vertex of one cube, then
use CTRL + L to select all the rest of that cube but not the other.
Another way to do linked selections is to simply move the mouse over some part of the
piece you want to select, and press L to immediately select everything connected to that.
Conversely, SHIFT + L will unselect everything connected to the vertex under the mouse.

1

Chapter 19 on page 141
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21.3. Separating and Joining Meshes
You can separate a part of a mesh into its own object. The part you are separating doesn’t
have to be disconnected from the rest of the mesh. Simply select the part you want to
separate in Edit mode, and press P , and in the menu that appears, choose “Selection”.
You will see the selected part immediately change to a reddish-orange highlight, indicating
it is part of the object selection but not the active object.
Conversely, you can join two or more mesh objects into one. Select all the desired objects
in Object mode, and press CTRL + J , and you will see them all immediately take on
the orange-yellow highlight indicating they are all the active object. TAB into Edit mode,
and you can conﬁrm all are editable as part of the same mesh object.

21.4. Proper Extrusion
You previously discovered how to add whole new sections to a mesh with CTRL + LMB .
Blender also has a proper Extrude function, which lets you do this with a bit more control.
Start with the default cube, as usual. Go into Edit mode. Select just the top four vertices.
Press E to start extruding, and move the mouse roughly along the direction of the Zaxis. You will ﬁnd yourself dragging out a whole new face formed from four new vertices
connected to the ones you previously selected. You will notice also that the movement of
the newly-added part of the mesh is automatically constrained to be parallel to the Z-axis.
Press LMB or ENTER to ﬁnish the extrusion operation.
Deselect everything. Now try selecting another four vertices of the original cube, say making
up a face pointing along the X-axis. Now if you extrude these, you will see that the extrusion
is automatically constrained to move only parallel to the X-axis.
A quirk of the extrusion function is that if you press E and then immediately abort with
RMB or ESC , the additional mesh piece is still created, but it is left in the same position
as the original mesh. To really abort the extrusion, you have to undo it with CTRL + Z .

21.4.1. More Extrusion Options
ALT + E brings up the Extrude menu, which gives you access to more options, depending
on what you have selected:

• “Region”—extrude the entire selected area as one, exactly equivalent to E .
• “Individual Faces”—if you have more than one face selected, then they are extruded
separately. In particular, any edge common to two selected faces will give rise to two
separate extruded edges, rather than one.
• “Edges Only”—extrudes only the edges; new faces are created only connecting the new
edges to the existing ones, not between the new edges.
• “Vertices Only”—extrudes only the vertices; edges are created only connecting the new
vertices to the existing ones, not between the new vertices, and no new faces are created.
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21.5. Edge Loop Selection
Edge loop2 s are an important concept when constructing meshes. They are so important
that Blender provides a shortcut for selecting an entire edge loop with one click: ALT +
RMB on an edge or vertex that is part of the loop you want to select, and it will select the
entire loop. Alternatively, ALT + SHIFT + RMB adds an edge loop to the selection; or,
if the part you click on is already selected, it will deselect the entire loop.
For example, try experimenting with a UV sphere: every line of “latitude” and “longitude”
in this mesh is an edge loop.

21.6. Loop Cuts
Sometimes you need to add more vertices to the interior part of a mesh, perhaps to ﬂesh in
some detail. The loop cut function lets you add more edge loops between existing ones.
Ensure you are in Edit mode. It doesn’t matter what parts of the mesh are currently
selected. Press CTRL + R to activate the Loop Cut function. You will see a magentacoloured loop wrap itself around diﬀerent parts of the mesh as you move the mouse. You
can press RMB or ESC to abandon the operation at this point, or once you see the
loop appearing around the correct part of the mesh, you can use LMB or ENTER to
proceed. Now the magenta colour changes to the usual orange-yellow selection highlight,
and will now restrict itself to sliding along this section of the mesh as you move the mouse.
If you press LMB or ENTER at this point, you will end up with a new loop of vertices
and edges at the last-shown point, while RMB or ESC will still create the new loop, but
leave it positioned at the midpoint.
When the loop is still at the magenta stage, you can use the mouse wheel to increase the
number of cuts to 2 or more. You can also type a number of cuts using 0KEY ... 9KEY .

21.7. Edge Loop Deletion
Conversely, you can get rid of edge loops as well, reducing the complexity of the surface
without leaving holes in it. Select the edge loop (the quick way is ALT + RMB on a
component edge or vertex as described above), then bring up the deletion menu ( DEL or
X ) and select “Edge Loop”. The selected loop will disappear, and adjacent edges and faces
will be merged.

21.8. Subdividing Parts
A loop cut always cuts a complete loop. Alternatively, you can subdivide just a selected
part of the mesh: make your selection, then press W to bring up the Vertex Specials
menu, and select the top option, “Subdivide”. This will create one cut, but a panel will
2

https://en.wikipedia.org/wiki/Edge_loop
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appear at the lower left of the Toolshelf ( T to make it visible at the left of the 3D view
if it’s not), where you can alter the number of cuts and other settings. This same option is
also available on Edge Specials CTRL + E .
Another option is the second one on the W menu: “Subdivide Smooth”. This one computes
a Catmull-Clark3 interpolation to give more of a curve rather than a ﬂat subdivision.

21.9. Subdivision Surface Modiﬁer
A modiﬁer causes some change to the geometry of an object just before it gets rendered.
The change does not aﬀect the object as you view and edit it in the 3D view, or as it is stored
in the document (unless you apply the modiﬁer, which makes the change permanent). This
allows you to create some complicated eﬀects at render time, while the original mesh stays
simple and easy to edit. Modiﬁers for the active object are applied and controlled in the
Modiﬁers

3
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Subdivision Surface Modiﬁer

Figure 103

tab in the Properties window.
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Figure 104

A subdivision surface modiﬁer (also known as a “subsurf” modiﬁer) applies the CatmullClark interpolation discussed above as a modiﬁer. Being a modiﬁer, it applies to the entire
object, not just to selected vertices. But since the original mesh is preserved, you use it as
a control cage to adjust the shape of the interpolated curve.
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Figure 105

Start with the default cube selected in Object mode, as usual. Go to the Modiﬁers tab in
Properties
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Figure 106

. When you select “Subdivision Surface” from the “Add Modiﬁer” menu, a new panel appears
as at right. Notice the two value sliders under the “Subdivisions” heading; 'View' controls
the level of subdivision within the 3D view, while 'Render' applies to the actual render;
the higher the number of levels, the closer to a curve the interpolated geometry becomes.
Having two separate settings for working environment and render allows for faster operation
in the 3D view, with the usual tradeoﬀ of lower quality, while still allowing maximum quality
for the ﬁnal render.
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Note:
Keyboard shortcuts: Because the Subdivision Surface modiﬁer is so heavily used,
there is a set of hotkeys for adding the modiﬁer to the current object if it doesn’t
already have one, and setting the number of subdivision levels in the 3D view: CTRL
+ 1KEY .. CTRL + 5KEY for setting the view levels to 1 .. 5 respectively.

Figure 107

As soon as you add the modiﬁer, the appearance of the cube should change to look something
like at right (here shown with just one level of subdivision).
The upper part of the panel (from the “Apply” and “Copy” buttons upwards) is common to
all modiﬁers. Note the X button at the right. Clicking it gets rid of the modiﬁer. Notice
also a group of 4 icon buttons in the middle, the leftmost two look like a camera and an
eye. The icons are deﬁned as follows (from left to right):
• Use the modiﬁer during rendering
• Show the modiﬁer eﬀect in the 3D view
• Show the modiﬁer eﬀect in the 3D view in Edit mode (if this is unchecked and the previous
one is checked, the modiﬁer eﬀect disappears while in Edit mode)
• Show the mesh as though the modiﬁer were applied to it in Edit mode.
Unchecking the ﬁrst one lets you disable the modiﬁer without losing its settings. The
remaining three can be handy if you’re trying to disentangle the eﬀects of diﬀerent modiﬁers
during editing.

Figure 108
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When the third button is enabled, the mesh will look like this in Edit mode. The original
mesh remains highlightable and editable. A preview of the eﬀect of the modiﬁer is also
visible, and responds immediately to any changes made to the original mesh. (Try moving
some vertices around, and see what happens.)

Figure 109

The fourth button goes one step further and acts as if the modiﬁer has already been applied,
while allowing you to edit only those parts corresponding to the original mesh. (This button
aﬀects the behavior of the third button. It cannot be used independently, and may disappear
if the third button is unchecked.)

21.10. Sharpening the Curves
The subdivision surface modiﬁer oﬀers much more control over the resulting shape than
might be apparent from above. For example, you may not want uniform curvature everywhere, you may want some parts of the shape to have sharper edges. This can be achieved
in two ways:
• by applying a crease value to selected edges
• by strategic positioning of additional vertices in the control-cage mesh.
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21.10.1. Applying a Crease

Figure 110

Select the edges where you want the curve to be sharper. Press SHIFT + E . Note how
the curve gets pulled more or less closer to those edges as you move the mouse. The selected
edges take on a magenta colour, indicating they have a nonzero crease value applied.
The crease value can be seen and edited in the Transform panel at the top of the Properties
Shelf at the side of the 3D view (you can toggle its visibility with N . Values can range
from 0.0 (no crease, the default) to 1.0 (maximum sharpness of the edge).

21.10.2. Adding Vertices

Figure 111

For example, start with the subdivided cube example as above. Press CTRL + R to start
a loop cut, and position the magenta outline something like this:
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Figure 112

Press LMB or ENTER ...

Figure 113

... and move the mouse so the newly-added loop moves closer to one side of the cube. See
how the subdivided mesh develops a sharper curve on this side?
To conﬁrm the placement of the new loop, press LMB or ENTER .

21.10.3. Which to Use?
The basic principle is, the closer together the vertices are, the more control you have over
the curve at that point. So the question is, do you just want a sharper edge, or do you want
more detail? That will govern whether you need to add vertices, or just apply a crease to
the existing edges.
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i Information
Applicable Blender version: 2.63

Figure 114

Open a new default Blender document. Without doing anything else, hit F12 to render
the default cube with the default settings. The result should look something like the image
to the right.
Note the lower left visible face of the cube is completely black because the default light is
at the upper right.

Figure 115

Go back from the render to the 3D view ( F11 ). Now select (with RMB ) the default
light, and either delete it or move it to another layer (with M ). Go to your World tab
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Figure 116

in the Properties
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Figure 117

window, and look for the Environment Lighting panel:

Figure 118
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Check the box next to the title, and leave the “E:” (energy) value at its default 1.0. This
gives us a pervasive, directionless light, illuminating all objects equally from all directions,
which means there will be no shadows. Do another render, and it should now look like the
image to the right.
See how we have gone from inky-black shadows to no shadows at all. In the real world,
lighting is almost never perfectly uniform, and this variation of light and shade is important
to help us distinguish details of the scene around us. Without such variations, everything
devolves into featureless blobs.

Figure 119

Now undo your deletion of the default lamp (or move it back to layer 1). Enable Environment Lighting again, but this time lower the Energy value to 0.1. Do another render, and
it should now look like the image to the right. The shadowed face is still shadowed, but
not enough to make it impossible to see any details it may have. This is usually the type
of eﬀect you want, unless you are aiming for really dramatic contrasts.
So the lesson is:
Note:
A single light is rarely enough for a good looking scene.
As you learn more, you will ﬁnd that it is common to use two or three lights, or even more,
to ensure proper illumination of a scene. In simple tutorials, where no explicit details are
given about lighting, you can probably get by with the default light, plus some environment
lighting (as we added earlier) to soften the shadows.
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i Information
Applicable Blender version: 2.57

Figure 120

Your goal.
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In this module, you'll learn how to extrude and merge vertices of a mesh and how to save
a model. This module also introduces the File Browser window type.
Your ﬁrst model will be a house, which we will develop over the course of several modules.
Here we will start with four walls and a pyramidal roof. Simple! Since you're going to use
the default cube as a base, all you actually need to build is the roof!
Editing in Blender generally involves four steps:
1.
2.
3.
4.
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Selecting an object to edit.
Activating Edit Mode on that object.
Selecting part(s) of the object to act upon.
Specifying the action(s) to be performed on those parts.

Bring up the Default Cube

23.1. Bring up the Default Cube

Figure 121

The default cube in Object Mode.

1. Launch Blender.
2. Load the factory settings using File → Load Factory Settings.
This should give you a perspective view of a scene containing three objects:
• a cube,
• a light source,
• a camera.
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23.2. Setting up the Viewport
It will be easier to work on the roof of your house in a perspective side view:
1. Press NUM3 to switch to a ”perfect” right side view.
Note:
NUM5 puts the viewport into perspective only if it's not already in perspective. Otherwise, NUM5 switches the viewport back to orthographic view.

”Right Persp” will be shown on the top left of the 3D View. The ”up” ( Z ) direction in the
scene is now ”up” on your monitor as well.
It will also help to zoom in a bit:
1. Make sure the 3D View window is active (which means your mouse cursor is in it).
2. SCROLL or press NUM+ a few times until the cube is about 1/3 the height of the
viewport.
Because you just loaded the factory defaults, the 3D transform manipulator will be enabled.
For mesh editing, it will help to turn the manipulator oﬀ:
1. Make sure the 3D View window is active.
2. Press CTRL + SPACE to toggle the manipulator on or oﬀ.
Press TAB once. This puts you into Edit Mode on the selected object, i.e. the cube.
Note:
If the lamp and/or camera were selected instead of (or in addition to) the cube, you
wouldn't be able to enter Edit Mode. (Cameras and lamps are edited in a diﬀerent
fashion.)
Here's how the cube should look at this point:
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Figure 122

Note:
The Occlude Background Geometry button is only visible when Blender is in Edit Mode
and the draw type is Solid, Shaded, or Textured.
The default cube is constructed as a mesh. Now that you're in Edit Mode, you can access
the individual vertices, edges, and faces that make up the mesh. The default cube consists
of eight vertices, twelve edges, and six faces.
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23.3. Adjusting the Height
Right now, all eight vertices are selected, so any vertex edits you make will aﬀect them all.
For instance, if you were to move a vertex, the other seven vertices would follow. In order
to build a roof peak for the house, you need to alter just the four top vertices of the cube.
To do that, you must change the selection so that only those vertices are selected.
1. Turn 'Occlude Background Geometry' oﬀ, so you can see all vertices. Note, in newer
versions, this button is called ”Limit Selection to Visible.” It is one of the buttons
to the right of transform orientation which is to the right of the mode select which
should be currently set to ”edit mode”.
2. Deselect the bottom four vertices, one by one, using SHIFT + RMB .

Figure 123
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Adjusting the Height
The picture to the right shows the cube (in right perspective view and occlude background
geometry ”oﬀ”) with the correct vertices selected.
Note:
Remember, if you make a mistake, you can undo your work step-by-step by pressing
CTRL + Z .
Now you'll adjust the height of your house's ceiling. Activate the grab tool:
1. Make sure Blender is in Edit Mode, with the relevant part(s) of the object selected.
2. Make sure the 3D View window is active.
3. Press G .
The 3D View header will be replaced by numbers: ”Dx: 0.0000 Dy: 0.0000 Dz: 0.0000
(0.0000)”.
You want to lower the ceiling without making the walls crooked. This is hard to do freehand,
but happily the grab tool provides an option for doing just that.
With the grab tool activated:
1. Press Z

to limit movement to the global Z-axis.

Figure 124

When your ceiling is the height you want, conﬁrm the grab with LMB (or ENTER ).
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23.4. Extruding

Figure 125

Step 7: the extruded attic, ready to conﬁrm

Now you're going to ”add on” to your house by extruding. Extrusion begins by duplicating
selected parts of an object. Then the new parts are pulled away from the old ones, with
new faces and edges created as necessary.
To add an attic to your house:
1.
2.
3.
4.
5.
6.

Make sure Blender is in Edit Mode, with the top four vertices selected.
Make sure the 3D View window is active.
Press E to activate the extrude tool.
Restrict movement to the Z axis and move the mouse pointer upward.
When the attic is the height you want, conﬁrm the extrude with LMB or ENTER .
Keep the extrusion visible: you will need it for the next exercise.

Note:
At the end of this process only the four new vertices (the upper corners of the attic)
will be selected. The others (including the four that were originally selected) will not be
selected.
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Note:
If you cancel an extrude operation without conﬁrming it, duplicate vertices and edges
have already been created. If this isn't what you wanted, use CTRL + Z to undo the
duplication.

23.5. Merging

Figure 126

The Specials menu

You can change the roof from a ﬂat one to a pyramidal one by merging the vertices of the
roof:
1. Make sure that you still have the extruded roof from the previous exercise visible.
2. Make sure Blender is in Edit Mode, with the four top-most vertices selected.
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3.
4.
5.
6.

Make sure the 3D View window is active.
Press W to bring up the Specials menu.
Select Merge. (You can also access this by pressing ALT + M .)
The Merge menu should pop up, select At center.

A message should appear on the Info header saying that 3 vertices have been deleted, this
is because in order to merge four vertices into one, three vertices must be deleted.

Figure 127
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Your house now has a pyramidal roof!

Saving your Work

23.6. Saving your Work

Figure 128

Saving the .blend

We will be developing the house in later modules, so save your work now. To save the
current scene in a .blend ﬁle:
1. Press F2 (or select File → Save As). The active window temporarily changes into
a File Browser window.
2. Navigate to the directory (folder) where you want to write the ﬁle by clicking LMB
on directory names in the File Browser window. (Clicking on ”..” will take you up one
level.)
3. If you wish to name the ﬁle something other than ”untitled.blend”, type a ﬁlename
in the text box to the left of the ”Cancel” button. (The .blend suﬃx will be added
automatically.)
4. Click LMB on the ”Save As Blender File” button. As soon as the save operation is
complete, the window will automatically revert to its former type.
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23.6.1. Saving Further Changes
Once you have saved your work to a ﬁle for the ﬁrst time, you can save subsequent changes
to the same ﬁle name by pressing CTRL + S and conﬁrming you want to overwrite the
existing ﬁle.

23.7. Additional Resources
• A Video Tutorial on Edit Mode1

1
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http://www.youtube.com/watch?v=LL-cYoTQI4Q

24. Quickie Render
i Information
Applicable Blender version: 2.63

Figure 129

If you haven't completed the ”Quickie Model” module , do so now. You will need the
resulting model for this module.
Now that you've created your ﬁrst model, you'll probably want to try rendering it. Your
ﬁrst render, with a single light source and only nine faces, should ﬁnish quickly. However,
as your 3D scenes become more complex, you'll ﬁnd that rendering can take a long time.
In this module, you'll render your quickie model and save the result in various ﬁle formats.
You'll also learn how to aim cameras and create lamps.
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24.1. Rendering the Quickie Model
1. Launch Blender and load factory settings.
2. To load the house model from the previous module, select File → Open Recent, and
select the ﬁle you saved. Alternatively, press F1 or select File → Open, ﬁnd the ﬁle,
and open it. As soon as the operation is complete, the window will load the quickie
model that you created in the previous exercise.
3. Press F12 or select Render → Render Image. This opens the Image Editor so you
can watch the render progress.
• With the new Apple keyboard, use FN + F12 to avoid the Mac Dashboard.
• With Macintosh OS X 10.5, use ALT + FN + F12 .
• With Gnome, use ALT + F12 to avoid the Gnome Search Dialog.
Note:
You can stop a render in progress by pressing ESC any time the render window has
the focus. Bear in mind this will stop the rendering of the current frame and abandon
any partial results. Pressing F12 will start rendering the image from the beginning
again.

24.2. Seeing Your Render
By default, pressing F12 will switch to the UV/Image Editor window, and show your
render there. You can switch back to the 3D view with F11 . Pressing F11 in the 3D
view will switch you to the UV/Image Editor window without redoing the render, i.e. you
will see the same image as last time.

24.3. Aiming the Camera
If you don't get a picture of the house, or if the picture is not framed well, try moving or
re-aiming the camera:
1. Press ESC to get back to Edit Mode, if needed.
2. Press NUM0 to take the camera's viewpoint.
3. Press SHIFT + F to put the 3D View window into camera ﬂy mode.
In camera ﬂy mode, you can:
•
•
•
•

Pan and tilt by moving the mouse pointer up, down, left, or right.
Accelerate by SCROLL forwards.
Decelerate by SCROLL backwards.
Press any key or button to exit ﬂy mode.

(It works diﬀerently in version 2.70 and later, more like a FPS game with possibility to slide
and so on, buttons are regular FPS controls)
When you're done positioning the camera, try rendering again.
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24.4. Lighting
If your cube is completely black, you may not have a lamp in the scene. Either the default
lamp got deleted, or you're using a version of Blender that doesn't provide a default lamp.
To add a lamp:
1. Make sure Blender is in Object Mode.
2. Place the 3D cursor where you want the lamp to go; or add the lamp then immediately
grab it, and move it somewhere else.
3. Press SHIFT + A .
4. In the popup menu, select Lamp → Point.

24.5. Saving the Render
Saving the scene (with F2 , for instance) does not save any renders. Saving renders is a
separate step.
To save your current render:
1.
2.
3.
4.
5.
6.

Make sure you are in the Image Editor. If not press F12 to render
Press F3 . This temporarily changes the active window into a File Browser window.
Navigate to the directory (folder) where you want to write the ﬁle.
Type a ﬁlename in the text box (to the left of the ”Cancel” button).
To the left of the window, choose your preferred ﬁle type.
Click LMB on the ”Save as Image” button. As soon as the save operation is complete,
the window will return to the Image Editor.
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24.6. Renderer Selection

Figure 130

Blender oﬀers a choice of diﬀerent rendering engines for producing images. The menu for
selecting from these appears in the Info window (the thin one that contains the menu bar
at the top of the default layout). In most of these tutorials, you will leave this choice set at
Blender Render. But it is worth knowing what other choices are available:
• Blender Render—the oldest renderer, commonly known as the Blender Internal renderer.
Built into Blender right from its early days. Can still produce good results with the
right tricks, but considered by the Blender developers to be antiquated and not worthy
of continuing development.
• Blender Game—this is the renderer used by the Blender Game Engine. Designed to be
fast enough for interactive use in a game, which means there are limitations in the quality
of renders it produces. You also use this renderer to create rigid-body physics simulations.
• Cycles Render—for this and other choices, see Advanced Rendering1 .
1
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Chapter 153 on page 1345

Render Control

24.7. Render Control

Figure 131

The top panel under the Render tab
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Figure 132

in the Properties window shows 3 buttons and a menu. The ﬁrst button renders a single
frame, equivalent to F12 . The other two buttons are more relevant to animations2 .

2
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Render Control

Figure 133

The “Display:” menu controls what happens when you press F12 : the default “Image
Editor” causes the 3D view to be switched to the UV/Image Editor showing the rendered
image. “Full Screen” causes the UV/Image Editor display to take over the entire screen,
while “New Window” makes it appear in a separate OS/GUI window (similar to how older
versions of Blender used to work). Finally, “Keep UI” causes no changes to your window
layout at all; you have to explicitly bring up the Image Editor with F11 to see the rendered
image.
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24.8. Render Image Dimensions

Figure 134

You can control the size of the image that Blender creates when rendering. This is speciﬁed
in the “Dimensions” panel under Render
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Figure 135

properties. Apart from the menu at the top, the settings in this panel are grouped into two
columns:
• The column on the left controls settings for a single image.
• The column on the right speciﬁes additional settings for rendering a whole sequence of
images as part of an animation3 . These settings will be discussed later4 .
At the upper left, under “Resolution:”, we have the dimensions in pixels of the image (the
default settings are 1920×1080 as shown in the screenshot), plus an additional scale factor
slider below (showing 50% by default). With these settings, the image will actually be
rendered at (1920×50%)×(1080×50%) = 960×540. Having the scale factor is a convenience.
3
4

Chapter 100 on page 955
Chapter 105 on page 979
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Rendering smaller, lower-quality images is faster, which speeds up initial work on your
model, but you'll want full quality for the ﬁnal result. Instead of mentally having to work
out numbers for render quality, you can simply set the resolution to full quality, and use
the scale factor to reduce this to, say, 50% or 25% for interim work, then set it to 100% for
the ﬁnal output.

24.9. Image File Formats

Figure 136

You set the format and location for saving rendered images in the “Output” panel under the
Render
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Figure 137

properties.
In current versions of Blender, the default format for saving rendered images is PNG5 .
This is a lossless format which has the option for alpha transparency (which means the sky
background is replaced by transparent pixels—enabled by clicking the “RGBA” button).
This is a good format if you intend to do further work with the image (e.g. in an image
editor like Gimp or Photoshop), but the ﬁles can be large.
JPEG6 is a lossy7 image format, which means it throws away information that the human
eye doesn’t see. This produces much smaller ﬁles than PNG, and is adequate if you just

5
6
7

https://en.wikipedia.org/wiki/Portable_Network_Graphics
https://en.wikipedia.org/wiki/JPEG
https://en.wikipedia.org/wiki/lossy%20compression
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want to upload the render directly for use in a Web page or other such document, but is not
the best choice if you intend to do further processing of the image. It also doesn’t support
alpha transparency.
To change the render ﬁle format:
1.
2.
3.
4.

Switch to the Render tab in the Properties window.
Look for the “Output” panel.
Click LMB on the popout menu with the current ﬁle format.
Select your preferred format.

24.10. Additional Resources
• the ”Output Formats” module
• Tutorial on Using Multiple Cameras8 ← Pictures are missing from this tutorial
• Ira Krakow's Basic Blender Camera Positioning (Rigging)9

8
9
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http://forum.nystic.com/viewtopic.php?f=34&t=2966#
http://www.youtube.com/watch?v=NzEy2sCZcHo

25. Enter the World
i Information
Applicable Blender version: 2.70
In the properties panel, the World

Figure 138
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settings control the background or sky settings for your scene. A scene doesn’t have to have
a World, in which case, the background will simply be black. If you save your images with
a transparent Sky setting, the background doesn’t matter. But in other situations, you will
want to control what appears here.

Figure 139

Here is what the top two panels in the World Context look like in a new default document.
(Settings further down for Ambient Occlusion, Environment Lighting and Indirect Lighting
will be discussed later, when we discuss lighting.)
“Ambient Color” is a sourceless, shadowless light, coming from all directions, applied to all
objects. Trouble is, its eﬀect is very “ﬂat”, i.e. it washes out detail. It's probably better
to use the Environment Lighting or Ambient Occlusion options (in panels further down) to
soften murky shadows.
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With none of the boxes checked, “Zenith Color” has no eﬀect, only “Horizon Color” does.
The sky will simply be a ﬂat expanse of this colour. Selecting “Paper Sky” and “Real Sky”
on their own has no eﬀect, they work only in conjunction with “Blend Sky”.
Check “Blend Sky” on its own. Now the sky takes on a gradient from “Zenith Color” at
the zenith (straight up) to “Horizon Color”, not at the horizon, but at the nadir (straight
down).
Check both “Blend Sky” and “Real Sky”. Now you get “Horizon Color” at the horizon, with
a gradient to “Zenith Color” at both zenith and nadir.
The eﬀect of “Blend Sky” with “Paper Sky” is a bit more subtle. It means the horizon is
always in the middle of the image, regardless of the orientation of the camera. The eﬀect
is more noticeable if you check “Real Sky” as well, otherwise it looks little diﬀerent from
“Blend Sky” on its own.
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Figure 140

Here is an example with contrasting horizon and zenith colours. I also set the camera ﬁeld
of view to 90°.
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Figure 141

With only “Blend Sky” checked, a render looks like this.

Figure 142

With “Blend Sky” and “Real Sky” checked, this is how the render comes out. Note how the
cube is noticeably oﬀ-centre relative to the horizon band, because the camera view is at an
angle to the horizontal.
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Figure 143

With all three of “Blend Sky”, “Real Sky” and “Paper Sky” checked, the result is this. The
cube now looks like it is on the horizon, even though the camera angle is the same as the
previous image.
You can also add a texture to your sky. That will be discussed later1 .

1
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26. Understanding the Camera
26.1. Real-World Cameras
Before discussing the camera in Blender, it helps to understand something about how cameras work in real life. We have become accustomed to so many of their quirks and limitations
when looking at real photographs, that 3D software like Blender often expends a lot of eﬀort
to mimic those quirks.
When taking a photo with a real camera, a number of important factors come into play:
• the focus — because of the way lenses work, only objects within a certain distance range
from the camera (the depth of ﬁeld) will appear sharp in the image. Objects outside this
range will begin to appear noticeably blurred, the blur getting worse the farther they are
outside the focus range. The narrower the range of in-focus distances (the shallower the
depth of ﬁeld), the more quickly this blurring happens with objects outside it.
• the exposure time — how long the shutter remains open. The longer this is, the more
light is captured, but also the more likely the image is to pick up motion blur from moving
objects.
• the aperture — how wide the iris opening is. This is expressed, not as an actual distance
measurement, but as a fraction of the focal length of the lens (loosely, distance between
the lens and the image-capturing surface when the image is properly focused), written
as f: thus, say, f/2.8 (“f over 2.8”, not “f 2.8”) is a larger number, hence representing a
wider aperture, than f/8. A wider aperture increases the amount of light being captured
without contributing to motion blur, but it reduces the depth of ﬁeld. The extreme case
of a pinhole camera has a very tiny aperture with inﬁnite depth of ﬁeld (no need to focus
at all), but captures very little light, so it needs a very well-lit scene, a long exposure, or
a very sensitive image-capturing surface.
• the sensitivity of the image-capturing surface to light. In the days of ﬁlm cameras, we
talked about ﬁlm sensitivity (“fast” ﬁlm being more sensitive to light than “slow” ﬁlm).
Nowadays, with digital cameras we talk about the gain of the light-ampliﬁcation system.
High-sensitivity ﬁlm was more likely to produce a grainy image. In a somewhat similar
manner, high light-ampliﬁcation in a digital camera is more likely to produce a noisylooking image under low-light conditions.
• the ﬁeld of view — how much of the scene the camera can see at once. A wide-angle lens
gives a wider ﬁeld of view, but you have to be closer to objects to be able to see them,
and there is greater perspective distortion. At the other extreme, a telephoto lens gives
a very narrow ﬁeld of view, but can take pictures of things from much further away. A
wide-angle lens also has a shorter focal length than a narrow-angle one (remember that
aperture is expressed as a ratio of the focal length f), therefore the telephoto lens is going
to capture less light than the wide-angle one with the same aperture width. You may
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also have heard of the zoom lens, i.e. one with a variable focal length. It can be adjusted
from a wide-angle mode to a telephoto mode.
As you can see, many of these diﬀerent factors interact with each other. The brightness of
the image can be aﬀected by the exposure time, the aperture, the gain sensitivity and the
focal length of the lens. Each of these have side-eﬀects on the image in other ways.
Blender and other computer graphics software are, in principle, free of the problems of
focus, exposure time, aperture, sensitivity and focal length. Nevertheless, it is common to
want to introduce deliberate motion blur into an image, to give the impression of movement.
Sometimes it is useful to introduce a deliberately shallow depth of ﬁeld, blurring objects
in the background in order to draw emphasis to the important part of the image, i.e that
which is in focus.
Exposure (the total amount of light captured in the image) is also less of a problem in
computer graphics than in real-world photography, because in computer graphics you always
have total control over the amount and placement of lighting in the scene. Nevertheless, if
you’re not careful, you can produce overexposed (bright parts losing detail by saturating
to a solid, featureless white) or underexposed images (dark parts losing detail by becoming
solid black).
The ﬁeld of view issue arises from basic principles of geometry, and Blender’s camera is just
as much subject to that as real cameras.

26.2. The Camera In Blender
Here we are going to concentrate on the important issue of ﬁeld of view.
You can change the ﬁeld of view in two ways - move the camera closer to or farther from
the scene (called dollying in ﬁlm/TV production parlance), or change the angle of the lens
(zooming). You do the latter in the Object Data
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Figure 144

tab in the Properties window (the Camera has to be selected by RMB in Object Mode,
or the required tab will not be visible).
Perspective1 is the phenomenon where objects that are farther away from the viewer look
smaller than those nearby. More than that, diﬀerent parts of the same object may be at
diﬀerent distances from the eye, leading to a change in the apparent shape of the object
called perspective distortion. The mathematical theory of perspective was worked out by
Alhazen2 in the 11th century, and famously adopted by the Italian Renaissance painters
four hundred years later.
Here are two renders of the same scene with two diﬀerent cameras, to illustrate the diﬀerence.
This one moves the camera closer but gives it a wider ﬁeld of view:

1
2

https://en.wikipedia.org/wiki/Perspective_%2528visual%2529
https://en.wikipedia.org/wiki/Alhazen
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Figure 145

This one moves the camera back, while narrowing its ﬁeld of view, to try to give the scene
the same overall size.
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Figure 146

The latter is like using a “telephoto” lens with a real camera. Notice how the wider ﬁeld of
view gives you a greater perspective eﬀect. The boxes are all cuboids, with parallel pairs of
opposite faces joined by parallel edges, yet there is a noticeable angle between notionallyparallel edges in both images, which is more pronounced in the upper image. That is what
perspective distortion is all about.
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26.2.1. Specifying the Field of View

Figure 147

When you select a camera object, its settings become visible in the Camera Context
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Figure 148

in the Properties window, which should initially look something like at right.
Photographers are accustomed to working in terms of the focal length of the lens - longer
means narrower ﬁeld of view, shorter means wider ﬁeld of view. But the ﬁeld of view also
depends on the size of the sensor (image capture area). Modern digital cameras typically
have a smaller sensor size than the exposed ﬁlm area in older 35mm ﬁlm cameras. Thus,
the focal length measurements have to be adjusted accordingly, in order to give the same
ﬁeld of view.
Blender allows you to work this way, by specifying the focal length in the “Lens” panel, and
the sensor size in the “Camera” panel. It even oﬀers a “Camera Presets” menu, which sets
the sensor size for any of a range of well-known cameras.
Also, you might be doing compositing of your computer-generated imagery on top of an
actual photograph. In which case, to make the results look realistic, you need to closely
match the characteristics of the camera and lens that were used to take the photo. If you
know the lens focal length and camera sensor size, it makes sense to be able to plug those
values in directly.
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Figure 149

But if you’re not doing photo compositing, but generating completely synthetic imagery,
you might consider this a somewhat roundabout way of working. Why not specify the ﬁeld
of view directly as an angle?
Blender allows for this as well. From the popup menu in the Lens panel that says “Millimeters”, select “Field of View” instead, and the Focal Length ﬁeld will turn into a Field of View
ﬁeld, showing the angle in degrees directly. This is much easier to relate to the geometry
of the scene!
Note:
Relationship between the two: If the width of the sensor is d, the focal length of the lens
d
is f, and the angle of view is θ, then they are related by 2f
= tan 2θ .

26.3. See Also
• Improving Blender Renders with Photography Techniques3 — another explanation covering similar ground.
es:Entendiendo la cámara4

3
4
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27. Improving Your House
i Information
Applicable Blender version: 2.57

Figure 150

Your goal.

In this module, you'll reﬁne the house model you created two modules ago. In the process,
you'll learn how to access Blender's predeﬁned meshes and how to set a pivot point. You'll
also learn how to select, extrude, delete, and subdivide the edges and faces of a mesh model.
To begin, set up Blender as follows:
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1.
2.
3.
4.
5.

Launch Blender and load the factory settings.
If you have a numpad, make sure NumLock is on.
Load the house model you created in the ”Quickie Model” module .
If the 3D manipulator is active, disable it.
Adjust the viewpoint until you can clearly see two walls of the house and two sides of
the roof.

27.1. Adding a Ground Plane
Your house needs some ground to rest on. You can model the ground as an object in your
scene. Blender has many predeﬁned mesh objects built in. Happily, one of these is a ﬂat,
square surface.
Recall that new objects are added at the 3D cursor. Before creating the ground, you should
position the cursor at ground level:
1.
2.
3.
4.
5.
6.

Select the house by clicking RMB on it.
Enter Edit Mode by pressing TAB .
Select one of the bottom vertices by clicking RMB on it.
Bring up the Snap menu by pressing SHIFT + S .
Choose Cursor to Selected.
Leave Edit Mode by pressing TAB so your ground is created as a separate object.

Note:
There's an ”Aligned To View” setting in the ”Editing” tab of User Preferences which is
oﬀ by default in Blender 2.5x. When this setting is on, the orientation of new objects
depends on the current viewpoint. Pre-2.48a releases of Blender had ”Aligned To View”
on by default. If you've turned this setting on (or are using an old release) go to ”top
view” (by pressing NUM7 ) before creating the ground object.
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Figure 151

The ground added.

Now create the ground object:
1. Activate a 3D View window.
2. Press SHIFT + A .
3. Choose Mesh → Plane.
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Figure 152

The scaled ground.

To enlarge (or scale) the ground object, use the scale tool:
1.
2.
3.
4.
5.

Make sure Blender is in Object Mode.
Select the ground by clicking RMB on it.
Activate the scale tool by pressing S .
Type 7KEY to enlarge the ground 7x.
Press ENTER or LMB to conﬁrm and exit the scale tool.

27.2. Scaling with a Pivot
Suppose you want to shrink the house by 50%. As you can probably guess, this would be
done with the scaling tool. However, if you did so right now without the right pivot point,
the reduced house would no longer rest on the ground (check this by selecting the house
and scaling it to 0.2). Blender scales (and rotates) objects around a pivot point, which by
default is located at the median point (geometric center) of the selected object(s).
In order to scale the house while keeping its base on the ground, you need the pivot point
to be at ground level. Since the 3D cursor is at ground level, you can do this as follows:
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Figure 153

Origin to 3D Cursor Menu Item.

1. Make sure Blender is in Object Mode.
2. Select the house by clicking RMB on it.
3. In the 3D View header, click LMB on menu item ”Object” and put the mouse cursor
over Transform and select Origin to 3D Cursor from the pop-up menu. This can
also be done with Ctrl+Shift+Alt+C, select Origin to 3D Cursor from the pop-up
menu. (A.K.A. select ”Object” which is just left of where you've been going into
object mode/edit mode, as shown in the image. So Object>Transform>Origin to 3D
Cursor)
The origin of the house is now at the center of the 3D cursor. If you scale the house, the
place where the 3D cursor is located will remain ﬁxed, and everything else will expand or
contract from that point. The pivot is marked with an orange-ﬁlled circle. Do not mistake
it for a selected vertex.

27.3. Edge Selection
It is often useful to select edges instead of vertices.
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Figure 154

1.
2.
3.
4.

The select mode buttons.

Make sure Blender is in Object Mode.
Select the house by clicking RMB on it.
Press TAB to enter edit mode.
Click LMB on the Edge select mode button in the 3D View header.

In Edge select mode, edges appear as orange or white line segments when they're selected
and as black line segments when they're not.
Just as you selected vertices in Vertex select mode, you can now select (and deselect) edges
in the same way as vertices. This is also the same for Face select mode.
It may be because those edges are doubled. This can happen if you cancel an extrude
operation and forget to undo the duplication. Here's a solution:
1.
2.
3.
4.
5.

Switch to Vertex select mode.
Activate a 3D View window.
Select all vertices by pressing A once or twice.
Press W to bring up the ”Specials” menu.
Choose Remove Doubles.

27.4. Extruding Edges
You can extrude edges in much the same way as you extrude vertices.
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Figure 155

Step 5

To add an overhang to the roof of your house, ﬁrst move the pivot point to the peak of the
roof:
1.
2.
3.
4.
5.

Switch to Vertex select mode.
Select just the vertex at the peak of the roof.
Press SHIFT + S to bring up the Snap menu.
In the Snap menu, choose Cursor to Selected to move the 3D cursor to the peak.
Use the ”Pivot” menu (located to the left of the 3D Manipulator button) in the 3D
View header to change the pivot to ”3D Cursor”.
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Figure 156

After step 2

Now extrude by scaling from that point:
1. Switch to Edge select mode.
2. Select just the four edges at the base of the roof.
3. Press E to activate the extrude tool. The eﬀect is that you have just made a copy
of the four edges.
4. Press S to scale the four edges uniformly from the pivot point.
5. As you move the mouse pointer away from the pivot point, the roof of your house will
expand.
6. When the roof is the size you want, conﬁrm by LMB (or pressing ENTER ).
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7. Press CTRL + SPACE to toggle the manipulator on then make the overhangs slanted
by holding LMB on the blue arrow that appears in the center of the house, and
dragging down.

Figure 157

After step 7

27.5. Face Selection
It is often useful to select faces.
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Figure 158

The select mode buttons after step 2

1. Make sure you're in Edit Mode on the house.
2. Click LMB on the Face select mode button in the 3D View header.
In Face select mode, the center of each face is marked with a small square. Faces appear as
orange or stippled grey areas with orange edges when they're selected (depending on which
face is active), and as grey areas when they're not.
Just as you selected edges in Edge select mode, you can now select (and deselect) faces:
• If any faces are selected, press A to deselect all faces.
• If no faces are selected, press A to select all faces.
• To select a single face (and deselect the rest), click RMB (or CMD + LMB ) on the
center of the face.
• To toggle the selection status of a face (without aﬀecting the rest), click SHIFT + RMB
on the center of the face.
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Figure 159

The three faces on the +X side, selected

Use these techniques to select all three faces (two roof and one wall) on the +X side of your
house, as shown.
• Remember that the positive direction of the axis is the direction the arrows point to.

27.6. Extruding Faces
Just as you extruded edges to grow the roof, you can extrude faces to grow the entire house.
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Figure 160

After step 6

To double the size of your house without changing the pitch of the roof:
1.
2.
3.
4.

With the three faces on the +X side selected, activate a 3D View window.
Press E to activate the extrude tool.
Press X to extrude along the X axis
As you move the mouse pointer in the +X direction, the +X half of your house will
expand.
5. Press 2 to expand by exactly 2 Blender units. (If you scaled your house earlier,
you must change this value accordingly, e.g. scaling by 50% means you press 1 .)
6. Conﬁrm and exit the extrude tool by clicking LMB (or pressing ENTER ).
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27.7. Deleting Edges

Figure 161

After step 2

If you look closely at the model, you'll notice an extra edge, inside the house, connecting
the seams between the two halves of the roof. To delete this edge:
1.
2.
3.
4.

Edit the house object in Edge select mode.
Select just the edge you want to delete.
Press X or DELETE .
When the ”Delete” menu comes up, choose Edges.

Note:
Deleting an edge automatically deletes any face(s) that include that edge.

27.8. Subdividing Faces
In order to add openings such as doors or windows to the walls of your house, you'll need
to subdivide the wall (vertical) faces into smaller faces.
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Figure 162

After step 2

To subdivide each wall face into a 10x20 grid:
1. Make sure you are not in wire-frame mode (otherwise the occlude hidden geometry
button will not appear)
2. Edit the house object in Face select mode.
3. Select all six wall faces of your house.
4. Press W to bring up the Specials menu.
5. Choose Subdivide.
6. Set the number of cuts to 9 in the Operator panel (also accessible through F6).
Note:
In some versions of Blender older than v2.70, there may be a bug that prevents the
subdivide function from operating properly.
You might be wondering why to make 9 cuts instead of 10, the reason is that in case of
dividing a ﬁnite surface along one axis there will be always n-1 cuts to generate n single
faces. Here the number of cuts is applied in 2 dimensions. So, if you count the number
of faces on the subdivided walls, you will ﬁnd a 10x20 grid. The reason why there are 20
faces instead of 10 lengthwise is because you doubled the size of the house along the X axis
(lengthwise).

Figure 163
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After step 6

Subdividing Faces

Figure 164

Step 2

Figure 165

After step 3.2

Now you can extrude windows and doors:
1. Edit the house object in Face select mode.
2. Turn on the ”Limit selection to visible (clipped with depth buﬀer)” (for old Blender
versions ”Occlude background geometry”) option by clicking LMB on the toggle
button in the 3D View header.
3. For each wall of the house:
a) Go to the perfect view for that wall:
• NUM1 for ”front”
• CTRL + NUM1 for ”back”
• NUM3 for ”right”
• CTRL + NUM3 for ”left”
b) Select faces where you want to create a window or door. An easy way to do this
is by:
i. Deselecting all faces by pressing A once or twice.
ii. Pressing B to activate the Border Select tool.
iii. Clicking and dragging LMB to delimit a rectangular area.
iv. After you release LMB , all faces in the rectangular area will be selected.
c) Press E to activate the extrude tool.
d) Extrude inward 1/10th of a BU by typing -.1 and conﬁrming it with ENTER
or LMB .
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27.9. Final Steps
1. Adjust the position of the lamp and aim the camera until you obtain a good render.
2. Save your work!
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28. Extruding a Simple Person
i Information
Applicable Blender version: 2.57

Figure 166

Your simple person will look like this.
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In this module, you will model a simple human ﬁgure. Along the way, you will practice
using extrusion and learn additional ways to select vertices, edges, and faces.

28.1. Start a New Scene
1. Start with the default cube (File → Load Factory Settings) and NumLock ”on”.
2. Press TAB to edit the cube.
3. Scale the cube down 50% by pressing S
.
5KEY
ENTER .

28.2. Selection Methods
Just as you did for the house model, you will begin by selecting the top four vertices of the
cube. This section presents six methods for doing so.
Ease of selection depends partly on the viewport settings and viewpoint. For greatest ease,
you want a view in which the parts you are trying to select are both visible and close
together.
For clarity, use a view of the cube in which all vertices are visible:
• Go to right side view with NUM3 .
• Disable the manipulator widget with CTRL + SPACE .
• Make sure the Limit selection to visible option is ”oﬀ”.
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Figure 167

The picture on the right shows the cube with the correct vertices selected.
To begin, make sure you start in Vertex select mode.

28.2.1. Border Select Tool
The border select tool selects things that lie in a rectangular region of the viewport.
1. Activate (place the mouse pointer in) a 3D View window.
2. Deselect all vertices by pressing A .
3. Press B to activate the border select tool. Two dashed gray lines should appear,
one vertical and one horizontal, forming a crosshair in the viewpoint.
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4. Click and drag LMB diagonally across the area you want to select. The area will be
outlined in dashed gray lines.
5. When you release the mouse button, the vertices inside the rectangle will be added
to the selection.
Practice selecting the top four vertices this way. If you make a mistake, press A
again.

and try

28.2.2. Circle Select Tool
The circle select tool selects or deselects things that lie in a circular region of the viewport.
1. Activate a 3D View window.
2. Deselect all vertices by pressing A .
3. Press C to activate the circle select tool. A dashed gray circle should appear. note:
Prior to Blender 2.5 B B twice.
When this tool is active, you can do various things:
•
•
•
•
•

To
To
To
To
To

move the select area, simply move the mouse pointer.
resize the select area, use SCROLL or NUM+ / NUM- ..
select all vertices within the circle, click LMB .
deselect all vertices within the circle, click MMB or SHIFT + LMB .
deactivate the tool, press ESC or RMB .

Practice selecting the top four vertices this way. If you make a mistake, press A
again.

and try

28.2.3. Lasso Select Tool
Like many graphics programs, Blender 3D has a lasso select tool.
1.
2.
3.
4.

Activate a 3D View window.
Deselect all vertices by pressing A .
Click and hold CTRL + LMB .
Drag the mouse pointer in a loop around the vertices you want to select. As you drag,
a dashed gray line will appear.
5. You can deselect with lasso by pressing CTRL + SHIFT + LMB .
6. Release the LMB when you're done.

28.2.4. Vertex by Vertex Selection
You can select (or deselect) vertices one by one, as you did in the ”Quickie Model” module
.
1. Click RMB on a vertex to make it the only selected vertex.
2. Toggle the select state of additional vertices by clicking SHIFT + RMB .

234

Selection Methods

28.2.5. Edge Select Mode
You can select (or deselect) edges one by one, as you did in the ”Improving Your House”
module .
1. Click LMB on the Edge select mode button in the 3D View header.
2. Select the top left edge of the cube by clicking on it with RMB .
3. Toggle the select state of top right edge of the cube by clicking on it with SHIFT +
RMB .
4. Switch back to Vertex select mode by clicking LMB on the Vertex select mode button
in the 3D View header.
After you switch back to Vertex select mode, all four vertices in the two selected edges are
selected.

28.2.6. Face Select Mode
You can select (or deselect) faces one by one, as you did in the ”Improving Your House”
module .
1. Click LMB on the Face select mode button in the 3D View header.
2. Select the top face of the cube by clicking on its center dot with RMB .
3. Switch back to Vertex select mode by clicking LMB on the Vertex select mode button
in the 3D View header.
After you switch back to Vertex select mode, all four vertices in selected face are selected.
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28.3. Extruding Limbs

Figure 168

The view menu.

The illustrations in this section are in front orthographic view, so:
• Use NUM5 (or View → Orthographic) to switch to orthographic view.
• Use NUM1 (or View → Front) to switch to front view.
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28.3.1. Region Extrusion
1. Make sure you're still in Edit Mode, with the top four vertices selected. (Only two
will be visible in front ortho view.)
2. Activate the extrude tool by using E (or Mesh → Extrude Region).
3. Move the mouse pointer upwards. As you do, four new vertices will appear, each
connected to one of the four that were previously selected.
The new vertices and their associated edges will move with the mouse pointer. You can
lock them into place with LMB or ENTER ).

28.3.2. Extruding a Leg

Figure 169

frame

Suppose you want to extrude a region the same size as the default cube -- in other words,
one Blender unit on a side.
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1. Undo your previous extrude by pressing CTRL + Z .
2. Activate the extrude tool again by using E (or Mesh → Extrude Region).
3. This time, as you're moving the extruded vertices around, hold down the CTRL key.
You'll see that the new vertices will only move in multiples of a Blender unit. This is
called snapping, and it makes it easy to extrude by exactly one blender unit. The
size of the snapping depends on the zoom level; if you are zoomed out a long way
from the object the snapping will be done in large increments and if you are zoomed
in close you can snap in ﬁner amounts.
Continue extruding until you have ﬁve cubes of equal size stacked atop one another. This
will be one leg of your ﬁgure.
Note:
Another way to extrude by exactly one Blender unit is to press 1KEY while the tool
is active.
If you press 2KEY when no tool is active, Blender will switch to the second layer, and
your (ﬁrst-layer) object will disappear. To make it visible again, press 1KEY .
Note:
If you are not using Front Ortho view, the blender unit will be much larger than the
cube. Switching to that view will allow for the proper size, although you can manually
enter the extrusion as 0.4 units.
Note:
Don't extrude any cube more than a unit at a time. You'll want those extra vertices,
edges and faces later in this tutorial.
Note:
If the mesh gets too big for your view, you can zoom out using SCROLL or NUM-
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28.3.3. Extruding the Pelvis

Figure 170

frame

1. Press A until all vertices are deselected.
2. Rotate the view (by dragging MMB ) so you can see all four vertices on the right
face of the top cube.
3. Select those four vertices.
4. Extrude twice to the right.

28.3.4. Extruding the Rest of the Body
The same trick is repeated over and over to build the rest of our simple body.
Note:
To speed things up, you may want to switch to Face select mode. In Face select mode,
you can select a face with a single click.
1. Create a second leg by extruding down four times from the last cube of the pelvis.
2. Create the torso by extruding up ﬁve times from the middle cube of the pelvis.
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3. Extrude to each side from the next-to-top cube of the torso to create arms. (Making
sure there are ﬁve on each side. Refer to the picture on the top of the page)
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Figure 171

Legs and Pelvis

Figure 172

Torso

Extruding Limbs

Figure 173

Arms

To be safe, remove any double vertices you may have inadvertently created:
1. In Vertex select mode, press A until all vertices are selected.
2. With a 3D View window active, press W to bring up the Specials menu.
3. Choose Remove Doubles.
Now check your work:
1. Return to Object Mode by pressing TAB .
2. Make sure the viewport draw type is Solid. (Press Z if it isn't.)
3. Rotate the viewpoint and examine the body from every side (it might be useful to
return to perspective view for this).
This is easily ﬁxed. To create a face:
1. Press TAB to go back into Edit Mode.
2. Select four vertices.
3. Press F (or choose Mesh → Faces → Make Edge/Face from the 3D View header).
• Note that you can also make edges with this tool if you select two vertices.
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28.4. Adding the Head

Figure 174

frame

1. Move the 3D cursor to a point above the neck by clicking with the LMB .
2. Adjust the cursor position in orthographic top, front and side views ( NUM7 , NUM1
, and NUM3 respectively) until the 3D cursor is about where the center of the head
should be. It may help to use SHIFT + S → Snap → Cursor to Grid.
3. Make sure you're in Edit Mode with a 3D View window active. (If you create the
head in Object Mode, it will be a separate object from the body, and changes to the
body later in this tutorial won't aﬀect the head.)
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4. Create a sphere using SHIFT + A → Mesh → Icosphere.
5. Leave the default settings for subdivisions and size in the bottom left of the screen.
(Note: Your computer may slow down if you set subdivisions above 6)
You should now have a small sphere at the top of the body. To make it more proportional
to the body, resize it using the scale tool:
1. Make sure you're still in Edit Mode, with a 3D View window active and the head
selected.
2. If necessary change the pivot point to Median Point.
3. Activate the scale tool by pressing S (or Mesh → Transform → Scale).
4. Move the mouse pointer until the head is the size you want.
You may also adjust its position using the grab tool:
1. Make sure you're still in Edit Mode, with a 3D View window active and the head
selected.
2. Activate the grab tool by pressing G (or Mesh → Transform → Grab/Move).
3. Move the mouse pointer until the center of the head is where you want it.
Note:
If you deselect the head and then decide that you want to select it again:
1. Hover the mouse pointer over any vertex/edge/face.
2. Press L . In Edit Mode this will select all vertices that are linked to the vertex
nearest the mouse pointer.
Now check your work:

243

Extruding a Simple Person

Figure 175

frame

1. Return to Object Mode by pressing TAB .
2. Make sure the viewport draw type is Solid. (Press Z if it isn't.)
3. Rotate the viewpoint and examine the body from every side. Make sure that the head
connects properly to the neck.

28.5. Save Your Work
You will continue working on your simple person model in the next module.
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To save the scene in a .blend ﬁle:
1.
2.
3.
4.

Press CTRL + S (or select File → Save).
Navigate to the directory (folder) where you want to write the ﬁle.
Type a ﬁlename in the text box to the left of the ”Cancel” button.
Click LMB on the ”Save Blender File” button.
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29. Smoothing Your Simple Person
i Information
Applicable Blender version: 2.57

Figure 176

Your goal.

Few real-life objects have perfectly sharp edges. People, in particular, consist of mainly
smooth surfaces. How does one model a smooth object using ﬂat faces and sharp edges?
In this module, you'll learn how to smooth a mesh by using subsurfaces and smooth shading.
You'll need the simple person model from the previous module. If you haven't done it,
either go back and do it now or download the pre-made model from Yosun Chang's website
at .
If the model doesn't look solid, your Viewport Shading setting may be set to Wireframe.
To switch to Solid shading:
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1. Activate the 3D View window.
2. Press Z .

29.1. Subsurfaces

Figure 177

The sub surface modiﬁer.

So far, all the meshes you've created have had sharp edges, giving them a faceted appearance
like that of a cut diamond. To model a smooth object (like a human body) you might think
you need a huge number of vertices and faces. Subsurfaces partly solves this problem by
automatically subdividing a mesh into a ﬁner mesh suitable for smooth rendering.
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You subsurface in Blender by adding a subsurf modiﬁer to an existing mesh object. A
modiﬁer is simply an algorithm (automatic process) which can be added to an object.
(Blender modiﬁers are analogous to Photoshop adjustment layers.)
To get started, make sure Blender is in Object Mode, with only the simple person object
selected:
1. If Blender is in Edit Mode, press TAB .
2. To select the simple person, RMB on it.
To add a subsurf modiﬁer to the selected object:
1. Click on the modiﬁers tab (wrench icon) in the Properties window.
2. Add Modiﬁer → Subdivision Surface.
You could also add subsurf modiﬁer by pressing CTRL + 1KEY .
The object's appearance should immediately become more faceted and more rounded. In
addition, several subsurface controls will appear in the Modiﬁers tab.
Note:
The modiﬁer has been added, but it hasn't actually been ”applied” yet. (Applying a
Blender modiﬁer is analogous to ﬂattening a Photoshop adjustment layer.)
The model may include some double vertices. To get rid of these:
1.
2.
3.
4.

Edit the model in Vertex select mode.
Select all vertices.
Mesh → Vertices → Remove Double
Try again.

You need to look in to upgrading (or possibly even downgrading) your graphics drivers.
Having the right graphics driver can avert many problems.
What just happened? The default subsurf modiﬁer (one level of Catmull-Clark) subdivided
each face of the object into four smaller faces that are progressively angled. This softened
the sharp edges of the original model where faces met at 90-degree angles.

29.1.1. Controls
For this model, one level of subsurf isn't quite enough. To increase the number of levels
to two, just increase the number in the text box directly underneath Subdivisions. The
View setting controls the number of subdivision levels visible in the viewport. This is very
useful when you have a high-poly scene, just decrease the number of visible subdivisions to
speed up viewport action.
You can specify additional levels of subsurﬁng to be used during renders. For extra smooth
renders, you might want three levels of subsurﬁng. Set this with the Render control immediately below the View control.
The Apply button applies the modiﬁer to the mesh. Do not click it yet. We'll be playing
with the model a bit longer before we apply the changes. While useful with some modiﬁers,
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applying a subsurf modiﬁer produces a very complex mesh, and there's no need to do so
here.
Remember that you can undo any accidental modiﬁcations with CTRL + Z .
Blender can combine a series of modiﬁers by stacking them. For this reason, the Modiﬁer
tab includes buttons for arranging and removing modiﬁers.
You can hide edges created by the modiﬁer by activating the Optimal Display toggle button.
The eﬀect is especially clear with the Wireframe draw type.
You can edit the mesh in modiﬁed form (without actually applying the modiﬁer) by activating the Adjust edit cage to modiﬁer toggle button, a small button with a triangle and
vertices, to the left of the Up/Down arrows (the arrows are for changing the position of the
modiﬁer in the stack) in the Modiﬁer panel.

Figure 178

Try this out:
1. Press TAB to enter Edit mode.
2. Make sure Blender is in Vertex select mode.
Note that the vertices no longer lie on the surface of the object.
3. Activate the Adjust edit cage to modiﬁer button.
Now all vertices lie on the surface of the object, and you can adjust the (modiﬁed)
vertices directly. However, any additional vertices created by the modiﬁer cannot be
directly edited without applying the modiﬁer.
You will be editing the boxy version of the simple person awhile longer, so before continuing,
deactivate the Apply modiﬁer to editing cage during Editmode button.
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29.2. Smooth Shading

Figure 179

Your simple person after setting smooth.

Subsurfaces do a good job of smoothing out corners in meshes. Even with two levels of
subsurfaces, however, the simple person does not look completely smooth; when viewed
close up, it has a scaly appearance. This is because each face is ﬂat shaded—shaded to
resemble a ﬂat surface—resulting in sudden changes in brightness at most edges. For a
smooth object, you want smooth shading, which smooths out the changes in brightness.
1.
2.
3.
4.

Go to Object Mode.
Set the draw type of a 3D View window to ”Solid”.
Select your subsurfed object.
In the Toolshelf on the left, look for a caption called Shading. Under it should be a
button called Smooth.
All the mesh edges will be smoothed out, leaving no sudden changes in brightness.
The faces blend smoothly into one another, making the edges nearly invisible. If the
icosphere has not smoothed properly and is dimpled, enter Edit Mode by pressing
TAB , select all vertices (A) and recalculate the normal direction (CTRL+N). This
is also available in the Toolshelf under Normals.
5. Click the other button under Shading in the Toolshelf, named 'Flat'.
The edges will reappear. Now you know the diﬀerence between Flat and Smooth.
6. Since the model looks better with smooth shading, click LMB on the ”Smooth”
button again.
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Note that if you didn't have subsurf enabled, then the mesh wouldn't look much diﬀerent.
This is because smooth shading doesn't aﬀect the mesh shape, it just changes how the
computer draws the triangles.
Smooth shading also removes a lot of deﬁnition. A good way to get rid of this is simply to
add a subsurf modiﬁer like you just did. The modiﬁer will not only require fewer vertices,
but add deﬁnition.
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Figure 180

Flat Shading

Figure 181

Smooth Shading

Smooth Shading
Save your work. You will continue reﬁning this model in the next module.

29.2.1. Additional Resources
w:Flat shading1 w:Gouraud shading2 w:Phong shading3 w:Subdivision surface4
• For more about modiﬁers, see The Blender Manual page on The Stack at http://wiki.
blender.org/index.php/Doc:Manual/TheStack
• For more about Blender subsurfaces, see The Blender Manual page on Subdivision Surfaces at http://wiki.blender.org/index.php/Doc:Manual/SubdivisionSurfaces.

1
2
3
4

https://en.wikipedia.org/wiki/Flat%20shading
https://en.wikipedia.org/wiki/Gouraud%20shading
https://en.wikipedia.org/wiki/Phong%20shading
https://en.wikipedia.org/wiki/Subdivision%20surface
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30. Improving Your Simple Person
i Information
Applicable Blender version: 2.57
In this module, you'll edit a subsurfed mesh using the scale and grab tools, all the while
improving your character.
You'll need the simple person model from the previous module. If you haven't done it,
either go back and do it now or else download the pre-made model from Yosun Chang's
website at .

30.1. Widening the Torso
To be realistic, the simple person's torso needs to be three times wider. In order to keep
the torso symmetrical, you'll expand it by scaling both sides from a central point.
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Figure 182

Select the sides of the torso:
1.
2.
3.
4.
5.
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Enter edit mode on the simple person.
In the 3D View header, set Face select mode.
From the 3D View header, choose Pivot → Median Point.
In the 3D View header, make sure Proportional Edit button is oﬀ.
Select the two faces on both the left and right sides of the torso, between the armpits
and the waist.

Widening the Torso

Note:

Figure 183 The cube icon
toggles the visibility of certain
components.
When editing in solid mode, the vertices, edges and faces on the back side of the model
are, by default, invisible. This feature can be toggled by clicking LMB on the Limit
selection to visible (called in older versions, ”Occlude Background Geometry”) button in
the 3D View header. Toggle it on and oﬀ a few times and observe how the back faces
appear and disappear.
We will now scale the torso with the scaling tool:
1. Activate the 3D View window and press S , X .
2. Adjust the amount of scaling. Either:
• Move the mouse pointer until the torso is the width you want.
or
• Press 3
3. Conﬁrm and exit by pressing ENTER or clicking LMB .
Note:
Scaling faces causes adjacent edges and faces to move, due to their shared vertices. You
cannot separate a face or edge from its vertices.
Continue selecting diﬀerent parts of the torso and scaling them to get more practice using
the above scaling methods.

257

Improving Your Simple Person

30.2. Bending the Arms

Figure 184

Removing the forearm

When you've got the basic shape of the torso, make the person hold up his hands. You'll
do this by deleting the forearms and then extruding upward from the elbows.
Select both forearms:
1.
2.
3.
4.

Enter edit mode on the simple person.
In the 3D View header, set Face select mode.
With the 3D View window active, press A until all vertices are deselected.
Select the ﬁve faces at the end of the forearm.

Now erase them:
1. Press X to open the Delete menu.
2. Choose Faces.
The forearm will disappear, leaving a hole. Don't panic; we'll ﬁx it later. Now to make the
arm point upwards:
1. Select the top face of the last remaining ”arm cube”.
2. Extrude the region upward by two Blender units E , 2
or ENTER .

and conﬁrm with LMB

Note:
In versions of blender before 2.7, the combination should be E , Z , 2 .
The hole in the elbow is caused by a missing face. To ﬁll in the missing face:
1. Deselect all vertices.
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2. Select the four vertices surrounding the missing face.
3. With the 3D View window active, create the face using either
• Mesh → Faces → Make Edge/Face
or
• F
Note:
If a Make Faces menu appears when you try to ﬁll the hole, it may be that you have
some doubled vertices. You can remove doubles by selecting the whole mesh in edit
mode, then pressing W and in the appearing menu ”Remove Doubles” and try again.
The new face should be smooth. If it isn't, make it so, using Mesh → Faces → Shade
Smooth.
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Figure 185

Repeat on the other side

Go through the same steps (erase, extrude, and ﬁll) on the other arm. Be sure to deselect
all vertices in the ﬁrst arm before selecting any in the other arm. If you have diﬃculty
making the arms symmetrical, undo your work and go through the steps simultaneously on
both arms.

30.3. Making Feet
To make feet for your simple person, you subdivide the ends of the legs and pull the front
edges forward.

260

Reshaping the Head
1. Edit the simple person in Face select mode.
2. Select the two bottom faces of the legs (front of the feet) by clicking
ﬁrst and then SHIFT + RMB on the other.
3. Subdivide both faces, either with:
• W Subdivide
or
• Mesh → Edges → Subdivide

RMB

on the

Each face gets subdivided into four smaller faces.
Now select the front edges and pull them forward:
1. Switch to Edge select mode.
2. Press A until no edges are selected.
3. Select the four bottom front edges of the soles (two for each feet) (where the toes
should be).
4. Press G and limit movement to the Y axis.
5. Move the mouse pointer until the feet are the length you want.
6. Conﬁrm and exit by pressing ENTER or SPACE or clicking LMB .

Figure 186 Congratulations!
You now have feet.

30.4. Reshaping the Head
When you're satisﬁed with the torso and limbs, you should do something about that head.
A bit too spherical, isn't it? You can elongate it by scaling along the Z axis.
When scaling the head, you want to make sure that it stays connected to the neck.
First, place the 3D Cursor at the base of the head, where it meets the neck. An easy way
to do this is as follows:
1.
2.
3.
4.

Go into Vertex select mode.
Make sure the Limit selection to visible option is ”oﬀ”.
Select the vertex at the base of the head using RMB .
Snap the cursor to this vertex using SHIFT + S Cursor to Selected

Now select the entire head:
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1. Hover the mouse over a vertex/edge/face of the head
2. Press L to select all parts linked to that part.
Note:
This works even when the head and body meshes overlap, so long as they aren't linked
together anywhere.
Tell Blender that you want to pivot around the 3D Cursor by changing the pivot point to
3D Cursor on the Pivot menu (the small button located to the left of the 3D Manipulator
button).
Now scale the head along the Z-axis, using the scale tool ( S , scaling by 1.5 should be
about right).

Figure 187
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Reshaping the Head
You'll need this simple person later, so remember to save your work!
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31. Spinning a Simple Hat
i Information
Applicable Blender version: 2.57
In this module, you'll create a hat for your simple person. Along the way, you'll learn how
to use the Spin tool and use layers.

31.1. Creating a Generatrix
For future convenience, you'll create the hat as a new object in the scene containing the
simple person. If you haven't created the simple person, either go back and do it now or
else download the pre-made model from Yosun Chang's website at .
Start by changing layers to layer two, then add the basis for your hat:

Figure 188

1. Make sure you're in Object Mode (so that a new object will be created).
2. Click LMB on the second little square, this will make the viewport display layer two.
(The top row is for layers 1 to 10, the bottom for 11 to 20, so layer 2 is immediately
to the right of layer 1; layer 6 is across the space from layer 5.)
3. Go to orthographic front view by pressing NUM1 .
4. Create a mesh circle at the cursor, by activating the 3D View window, pressing SHIFT
+ A and choosing Mesh → Circle.
Note:
The new circle will probably look more like a line segment than a circle. If so, it's
because you're viewing the circle edge-on.
The new mesh object doesn't actually have to be a circle. You could use any sort of mesh
object here because you're about to reshape it into a custom 2D mesh (called a generatrix)
that describes the proﬁle of your hat. More precisely, the generatrix describes one side of a
vertical cross-section through the hat. You'll want your generatrix to have a slope; it should
be higher on one side (which will become the top of the crown) than on the other (which
will become the brim).
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1. The newly-created mesh should be selected. If it isn't, select it by clicking RMB on
it.
2. Press TAB to edit the mesh.
3. Activate Vertex select mode.
4. Press A until all vertices are selected.
5. Press X to erase all vertices.
Note:
Some users are confused as to the purpose of creating the mesh only to delete it afterwards. The point of this process is to create a new ”blank” object which you can then
shape into a hat.

Figure 189

Now draw your generatrix, starting with the brim and sloping upwards toward the top of
the crown:
1. Make sure you're still in orthographic front view.
2. Press CTRL + LMB to create the ﬁrst vertex.
3. Press CTRL + LMB to one side of that vertex to extrude another vertex, connected
to the ﬁrst by an edge.
(If this doesn't work, make sure you are in vertex select mode.)
Keep adding vertices until you're satisﬁed with the shape of your generatrix. You can always
undo using CTRL + Z or go back and adjust the positions of particular vertices using
the grab tool.
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The mesh is then spun around an axis perpendicular to the viewplane. You want to spin
around a vertical axis, so press NUM7 to switch to top view.

31.2. Spinning the Hat

Figure 190

The spun hat, drawn as wireframe in orthographic front view.

Now, let's actually spin the hat:
1. Move the 3D cursor to the vertex you want to spin around by pressing LMB on
it. You can also use the snapping tool for positioning the cursor more precisely by
pressing SHIFT+S after selecting that speciﬁc vertex. Cursor to selected positions
the cursor.
2. Press A to select all the vertices. The Spin control only spins vertices that are
selected.
3. Press ALT+R to activate the Spin tool.
• The Spin tool is also available in the Tool Shelf under Add
If you spin the hat in front view, your hat will be ﬂat. You have to spin the hat in
top view.
You should now see 90° of a generatrix! To spin your hat all the way round, press F6
or look in the Operator Panel just below the Tool Shelf. There should be an input slider
named Angle, change this value from 90 to 360. There should also be a slider called Steps,
increase the value from 9 to 15.
If your hat has a large hole in the center, you must have accidentally moved the 3D cursor
away from the vertex you picked in step 1. Try again.
Remember that if you spin an object 360° there will be a double row of vertices at the row
of vertices you spun. To ﬁx this, press A to select all vertices, press W and select
Remove Doubles. Note that this will only work in vertex select mode.
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You may also want to merge the vertices at the top of the hat. Do this by selecting all the
vertices at the top with C and pressing ALT + M → At Center. You may have to do
this twice as some vertices might be beneath each other.
Note for AMD windows users that ”Radeon Software” using ALT+R as default key for
”Overlay Hotkey” which blocks key in Blender. You can change hotkey in ”Radeon Software”
preferences.
You have more than one 3D View window, so Blender is asking which window to perform
the spin in. Click LMB on the window that is showing top view.

31.3. Smoothing Your Hat

Figure 191

The ﬁnished product!

You'll probably have noticed that normal hats aren't usually as faceted as yours! To
change this, ﬁrst press TAB to go back to Object mode then change the shading to
Smooth (available on the Tool Shelf). If there are unexpected black marks, try recalculating the normals.
1. Switch to Edit mode and open the Mesh menu in the 3D View Header.
2. Normals → Recalculate Outside.
Next, add a Subsurf modiﬁer to the hat and set the subdivisions to two, as you did in the
”Detailing Your Simple Person 1” module .
1. Click on the modiﬁers tab (wrench icon) in a Properties window.
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2. Add Modiﬁer → Subdivision Surface.
Save your work. You'll need this scene for the next module.

31.4. Additional Resources
w:Surface of revolution1
• http://www.youtube.com/watch?v=-mPtxa_MEPA Ira Krakow's Hat Creation Video Tutorial, based on this page.

1

https://en.wikipedia.org/wiki/Surface%20of%20revolution
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32. Putting the Hat on the Person
i Information
Applicable Blender version: 2.70
Once you're satisﬁed with the shapes of individual objects, you'll want to combine them
into a coherent scene. You do this in Object Mode.
In this module, you'll learn how to move objects to and from layers. You'll also learn how
to rename and parent objects, and you'll get an introduction to Outliner Windows.
You'll need the person-and-hat scene from the previous module. If you haven't done it,
either go back and do it now or else download the pre-made model from Yosun Chang's
website at .
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32.1. Adjusting an Object's Median Point

Figure 192
center.

The person that you (yeah you!) made with the origin in his geometric

1. Load the person-and-hat scene.
2. Make sure Blender is in Object Mode.
3. Switch to Layer 2, select the hat and press M . A dialog box will pop up for you to
choose which layer to move it to. Either press 1 (the number on top of the keyboard,
not the numberpad) or select the ﬁrst box in the popup.
4. Select the person you made earlier.
Just as you did in Edit Mode, you can specify the pivot for rotating and scaling objects
in Object Mode. If you just ﬁnished the previous module, the pivot is probably set to ”3D
Cursor”. If so, change it back to ”Median Point”.
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In Edit Mode, the ”Median Point” for pivoting is the geometric center of all selected vertices,
edges, or faces. In Object Mode, however, it's the origin of the selected object's local
coordinates, indicated by an orange dot. In other words, the origin might lie far from the
object's geometric center.
You can use buttons in the Tools Shelf to reunify an object's origin with its geometric
center:
1. With Blender in Object Mode, click LMB on Set Origin in the Tool Shelf (under
the ”Edit” sub menu of Tools) and select Origin To Geometry (Blender 2.70: ”Object”
-> ”Transform” -> ”Origin to Geometry”) to move the selected object's origin to its
geometric center (without changing the object's appearance).
Note:
When more than one object is selected, Blender uses the average of their median points
as the median point for pivoting.
This can be useful when you want a better picture of your object. With the origin set to the
person's geometric center, you can now snap the object with SHIFT+S to the 3D cursor.
This will let you view more of the model at one time and make for a faster editing workﬂow.

32.2. Positioning the Hat

Figure 193

Positioning the hat
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Once you have the hat properly oriented, move it into position on the person's head. The
grab tool enables you to position objects in Object Mode in the same way you positioned
vertices, edges, and faces in Edit Mode.
1. Make sure Blender is in Object Mode.
2. Click RMB on the hat object to select it.
3. Activate the grab tool by pressing G .
As you move the mouse pointer, the hat will move around in the viewport. By default, the
movement plane is perpendicular to the view axis, so the hat will move diﬀerently depending
on which viewpoint you're working in.
Just as in the Edit Mode grab tool, you can:
• Restrict the direction of motion by pressing X , Y , or Z . Press once to move
parallel to a global axis, twice to use a local axis. (Press the same key a third time to
return to view-plane motion.)
• To restrict motion to the global X-Y plane, lock the global Z by pressing SHIFT + Z .
• Hold down CTRL to restrict motion to discrete steps (typically one Blender unit).
• Hold down SHIFT to get ﬁner control over the motion.
• Click LMB or press ENTER to ﬁnalize the position and exit the tool.
• Click RMB or press ESC to return the object to its previous position and exit.
Use two diﬀerent orthographic views to position the hat on the person's head. You will
probably want to scale the hat to make it ﬁt the person's head better. When you are doing
this along the X or Y axis, make the changes symmetrical by specifying the axes you want
scaling to be constrained to. This option is available in the Operator panel (just below the
Tool Shelf) and also by pressing F6.
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Parenting the Hat to the Person

32.3. Parenting the Hat to the Person

Figure 194

The parenting menu.

Once you have the hat properly sized and positioned on the person's head, you'll want it to
stay there. In order to maintain such a cozy relationship between two objects, you'd have
to remember to select them both before rotating, moving, or scaling. A drastic solution
might be to join them into a single object using CTRL + J .
A better compromise is to Parent the hat to the person. Parenting creates a relationship
between two objects, such that certain changes to one object (called the Parent object)
automatically aﬀect the other (called the Child object). Changes to the child, however,
do not aﬀect the parent.
Note that an object can have many children, but only one parent.
Since the person is bigger than the hat, it's logical to parent the hat to the person (meaning:
parent = person, child = hat) instead of vice versa.
1. Make sure Blender is in Object Mode.
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2. Click RMB on the hat object to select it.
3. Click SHIFT + RMB on the person object.
Both the person and the hat should now be selected. The order of selection is
important here.
4. Press CTRL + P to parent the hat to the person.
5. Select Object. The most recently selected object becomes the parent of all other
selected objects.
Note:
Pressing P in the object mode instead of CTRL + P
engine. To stop the game engine, press ESC .

will start the Blender game

Now when you move the hat you will see a line from the hat to the person, indicating that
the person is the hat's parent. And if you move the person, the hat will move with it.
You may get an error saying something like Loop to Parents, ﬁx this by clearing all previous
parents with ALT + P .

32.4. Renaming Objects

Figure 195

The renaming dialog

When you have multiple objects in a scene, it helps to give each one a name.
Click on the Objects tab in the Properties panel (the one with a box icon).
1. Now select the hat by clicking RMB on it.
2. At the very top of the tab you should see a dialog box with the name of your object
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• The hat's name might be something like ”Circle” depending on which mesh primitive
you ﬁrst built the hat from.
3. Click LMB on the dialog box and type in a more descriptive name like ”Hat”.
You have now changed the name of the hat's object datablock. This name change will be
reﬂected in the Outliner, which we will look at shortly.
Now select your person by clicking RMB on it and repeat the process, changing the name
to something like ”Person”.

32.5. Outliner Windows

Figure 196

The Outliner window.
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Putting the Hat on the Person
Once you give objects names, it helps to have a way to ﬁnd objects by their name and
parent. This is exactly what the Outliner is for and it comes in very handy when you are
working with a large scene. The Outliner is usually just above the Properties panel. You
may want to pull it down a bit to see it more clearly.
You'll notice that all the objects in your scene (Person, camera etc) are listed and that you
can select these objects by clicking LMB on them. And if you click RMB on an object,
a menu will pop up with options like Select, Deselect, Delete etc. If you select the Person
and then click the ”+” sign to its left, you will see that the Hat is listed below the person.
This is because Blender lists all children objects beneath their parents.
On the right of each object there are a series of icons which represent the state of the object.
For example, the eye icon means that your object is visible in the 3D viewport. You can
turn oﬀ its visibility by clicking LMB on the eye, which will turn grey; click again on the
eye to make it visible. If you hover the mouse over the icons a text box will pop up with a
description of what that particular icon does.

32.6. Good on ya' mate!
Congratulations!! You have now ﬁnished your simple character. Pat yourself on the back,
and have a celebratory coﬀee! (Or pop!)

32.7. Additional Resources
• Outliner at
• Gestures at
• Parents at
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33. Overview
i Information
Applicable Blender version: 2.57
In 3D graphics, materials and textures are nearly as important as shapes. Scenes would be
boring if all the objects were gray.
The material system in Blender allows you to model a wide variety of materials and how
they interact with light. The next few modules will introduce the available options.
Note:
Note that material and texture settings are renderer-speciﬁc. This page and the
following ones describe settings appropriate to the Blender Internal renderer, which
is the one selected by default when you open a new Blender document. Other renderers
(both built into Blender and external) are available; you will learn about these later, in
Advanced Renderinga .
a

Chapter 153 on page 1345

33.1. Material versus Texture
A material deﬁnes the optical properties of an object: its color and whether it is dull or
shiny. A texture is a pattern that breaks up the uniform appearance of the material. Very
few objects in the real world have completely uniform surfaces. Instead most of them have
patterning or variation in color: consider the grain in a piece of wood, the pile in a carpet,
or the mortar in a brick wall.
Blender allows textures to inﬂuence materials in various ways, such as altering their colors.
Multiple textures can interact with each other to produce interesting eﬀects.
Note that textures have to be attached to materials to aﬀect objects, you cannot apply a
texture to an object without a material.

33.2. Other Material Settings
Additional settings you can specify for a material include shaders, ray-tracing and halo.
Shaders determine how the appearance of a material varies with the angle of the light:
diﬀuse shaders give a non-shiny look, while specular shaders give a mirror-like ﬁnish.
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Blender's material settings always involve both kinds of shaders, but you can adjust a
material's diﬀuse and specular colours separately to control their respective eﬀects; if you
set the specular colour to black, the surface will no longer produce reﬂections.
Ray-tracing is a technique for modeling the physical path of light through the scene. It is
capable of producing exquisite reﬂection and refraction eﬀects, including diﬀerent degrees
of reﬂectivity, translucency and transparency, and representing materials with diﬀerent
indexes of refraction. Blender provides two separate groups of ray-tracing settings, one for
reﬂection of light and the other for its transmission through the material. You can control
these settings on a per-material basis.
Halo rendering means an object no longer looks like solid matter, instead it appears to be
made of bits of light. This can be used for real-world eﬀects like ﬁre, smoke and plasma, or
to create fantasy eﬀects with no connection to reality.
Note that reﬂections produced by ray-tracing are separate from that produced by the specular shader: the former are controlled by the material's mirror colour, while the latter is
controlled by its specular colour.
Reﬂection is done in two diﬀerent ways because, while ray-tracing produces the most realistic
renders, it is also very CPU-intensive. It is therefore best to apply the ray-tracing eﬀects
when you're completely done with your modelling to help reduce high CPU usage. Enough
practice with ray-tracing can also help you get stunning eﬀects with just few clicks without
you having to do much trial and error. You would do well to dedicate at least a few hours
of your time to experimenting with it, so that in a future real production situation, you will
be spared all that hassle.

33.3. Types of Textures
When you create a texture in Blender, you will see a popup menu listing a whole lot of
diﬀerent types for the texture. The Image or Movie texture type lets you use a scanned
image to texture your object: for example, you can scan an actual piece of metal and use
that to give your object a realistic metallic appearance, or use a photograph of an actual
brick wall to texture the wall of a building model, and so on. You could even use a movie,
which plays during the animation of the scene.
The other texture types are called procedural, which means the textures are generated
according to algorithms built into Blender itself. These can be useful for simulating various
eﬀects when you don’t have an image of the real material handy; they can also be applied
to augment the appearance in various ways. For example:
• using a “cloud” texture to “dirty-up” a material
or
• using one texture as a stencil to create an amalgam of two other textures.
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33.4. Additional Resources
w:Diﬀuse reﬂection1 w:Ray tracing (graphics)2 w:Specular reﬂection3 w:Texture mapping4

1
2
3
4

https://en.wikipedia.org/wiki/Diffuse%20reflection
https://en.wikipedia.org/wiki/Ray%20tracing%20%28graphics%29
https://en.wikipedia.org/wiki/Specular%20reflection
https://en.wikipedia.org/wiki/Texture%20mapping
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34. Quickie Material
i Information
Applicable Blender version: 2.59
In this module, you will create a new material called ”Green Ooze”. Along the way, you will
learn how to alter the diﬀuse, specular, and mirror colors of a material.
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34.1. Your First Material

Figure 197 Figure 1: The Materials
context in the Properties window.
The cube in the default scene (which you get from File → Load Factory Settings) has a
simple grey color. Now click on the Materials context
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Your First Material

Figure 198

in the Properties
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Figure 199

window.
The materials context contains various menus, but for now you only need diﬀuse, specular
and mirror. The material is named and linked in the panel above the preview window.
(Linking is a feature that allows materials to be shared between multiple objects (or datablocks). Changing a material aﬀects the appearance of everything it is linked to.)
The ﬁrst row of the window above the preview window indicates that:
• there is one material assigned to this object and its name is ”Material”.
The second row of controls indicates that:
• The current selected material's name is ”Material”.
• This material will only be saved if it's in use.
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• It is not a ”Nodes” material.
• Instead of being linked directly to an object, the current material is linked to a datablock.
To rename the material, click LMB on the name and enter the name you want.
To unlink the material, click LMB on the X button to the right of the material name
(”Material”). Do this now. This deletes the link to the datablock, removing the material
from the mesh. As a side-eﬀect, most of the panels in the Material context disappear. You
will see in a moment, however, that the material still exists. It hasn't been deleted; it is
simply no longer in use.
At this point, you could click LMB the ”New” button to create a new material, but instead
we are going to reapply the old material:
1. Click LMB on the

Figure 200
button to the left of the ”New” button.
2. You'll see a nifty drop-down list containing all materials you've created so far. Choose
0 Material.
Materials whose names are preceded by ”0” in this list are not in use. By default, Blender
doesn't save such materials when it saves the scene. Thus, you can delete a material from
the list by saving the scene and then reopening it. You can override this behavior by toggling
the ”F” button ”on” for unused materials you want saved.
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Your materials will be much easier to ﬁnd and manage if you give them brief, descriptive
names you can recognize at a glance. Change this one's name to ”Green Ooze”. In addition,
naming of your materials and other objects in your scene is useful when such components
of your scene will be appended in another scene of a diﬀerent Blender ﬁle. Naming your
materials and other stuﬀ in the scene will enable you to choose the right objects and
materials you need whenever you wish to append just a portion of a whole bunch of work
you did. For instance, you're working on a new Blender project, but felt the material you
used in this Blender ﬁle is worth it. Instead of going through the pain of creating a new
material (of course you guessed in the initial one in getting the right material appearance),
you just append the material to your new work. Pretty simple! Make naming a habit, as
it's much used in a production environment.

34.2. Specifying Colors
Simple materials are speciﬁed by three colors: diﬀuse, specular and mirror. Rectangular
patches (swatches) of the colour in their own panel in the Material context allow you to
see and change each of these. Diﬀuse color is the basic underlying color of the material,
rendered by the diﬀuse shader. Specular color is for highlights (small bright spots on
a shiny surface) as rendered by the specular shader. Mirror color is for true reﬂections
rendered using ray-tracing.
There are many ways to deﬁne colours. Blender supports three:
• RGB: By specifying relative amounts of red, green and blue primary colours, by giving a
number from 0.0 to 1.0 for each component. For example, (R, G, B) = (0, 0, 0) speciﬁes
black (no colour at all); (0, 1, 0) is full green; (1, 1, 0) (full red + full green) is yellow; (0.5,
0.5, 0.5) is 50% grey, and (1, 1, 1) is full white (maximum intensity of all components).
Note that this is additive mixing of colours, which is what happens when you shine lights
of diﬀerent colours onto a white screen, not the subtractive mixing that takes place when
you mix diﬀerent-coloured paints or inks on paper or canvas.
• HSV: By specifying a hue (colour position on the rainbow) together with a
saturation (strength of colour, from garish down to pastel, with zero giving shades of
grey) and value (brightness). This is generally considered to be easier to use than RGB
notation when you are trying to create new colours (as opposed to copying a colour spec
from somewhere else), since it is easier to predict what the likely result will be. HSV is
commonly represented on a colour wheel, where the hue is the angle around the circle,
saturation the distance from the centre, and value controlled by a separate brightness
slider (as shown below).
• By specifying a 6-digit hexadecimal number. This is just an alternative form of RGB
notation, commonly used for colour speciﬁcations in Web pages.
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Figure 201

Figure 2: Blender’s colour picker popup

If you click on any colour swatch, the colour picker will pop up, allowing you to change the
values. This is the most intuitive way. The window that appears will look like this and will
include the following (Figure 2):
1. A color wheel to change the color as you want. In HSV mode, H corresponds to angle
around this wheel, while S corresponds to distance from the centre.
2. Three color sliders that will change if you change the color in the colorwheel. You can
also change the values with the sliders.
3. A slider that controls the intensity of the color. This corresponds to the V in HSV.
4. A pipette capable of sampling colors from any Blender window or render window.
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5. Buttons that can change it to ”HSV” or ”HEX” mode.
• Alternatively you can specify hue, saturation and value components by clicking
on the ”HSV” button and pushing the sliders around accordingly.

LMB

• You can also press the last button and enter the hexadecimal (or HEX) code. This is
simply a diﬀerent representation for RGB, where the hex digits represent rrggbb.
HSV is probably the most easily understandable way of specifying and experimenting with
colours. However, as is common with most computer systems, all colours in Blender are
represented internally as RGB.
If you want to get rid of the window just click LMB anywhere else.
Note:
Duplicate intensity sliders?There are two ways to control the intensity of the colour:
there is the vertical intensity slider at the right of the colour picker popup, and there
are also the intensity ﬁelds at the bottom of the Diﬀuse and Specular panels (above),
the ﬁnal intensity being the combination of both values. Why two diﬀerent ways?
Partly this is to allow a quick way to moderate or intensify the diﬀuse or specular components, without having to change the actual colour speciﬁcation. But more importantly,
this is to ensure that intensities are never set to 100%. The reason is that this can cause
rendering calculation problems, leading to total light intensities accumulating to inﬁnity
instead of converging to a ﬁnite value. This is probably not a big issue with the Blender
Internal renderer, but can become a problem with more advanced renderersa .
a

Chapter 153 on page 1345

The most used method of creating a color of your own is using the color wheel, but because
we want to be sure you will get the exact same color as us we will use the sliders. Use the
above methods to set the diﬀuse color to R=0.149, G=1.000, B=0.446 (or use the HEX
code: 6CFFB2). If you look in the ”Preview” panel, you will see that the material is now
bright green.
Most real-life materials (other than metals) don't alter the color of specular light. For this
reason, Specular and Mirror are usually left at their default values (white). For green ooze,
however, you'll disregard this rule-of-thumb:
1. Click LMB the sample rectangle below the Specular window.
2. Use the color selection dialog to adjust the specular color and watch the Preview panel
to see how this color aﬀects the sample sphere's highlight.
3. Set the specular color to R=0.640, G=0.990, B=0.566 (or use the HEX code:
D1FEC6).
With these values for Color and Specular, you should be able to get a good ooze later on.
The Preview, Diﬀuse and Specular panel should now look like this:
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Figure 202

Figure 203
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As you can see, there are many other material buttons. Many of these will be explained
in later modules. Suggestions for creating speciﬁc materials may be found in the ”Every
Material Known to Man” module .
Save this scene before proceeding. You will need it for the ”Quickie Texture” module , in
which you will perfect your ooze.
Note:
Copying/Pasting Colours: Quite often, you will want to duplicate or move a colour
speciﬁed in one place to another. If the two colour swatches are simultaneously visible,
you can use the eyedropper button in the colour picker. But if they are not, then the
easiest way is to bring up the colour picker for the colour you want to copy, switch to
the hex display, select the 6 hex digits, and copy them with CTRL + C . Then go to
the colour you want to make the same, bring up its picker in hex mode, select the hex
digits, and replace them with what you copied using CTRL + V .

34.3. Additional Resources
• w:HSL and HSV1
• w:RGB color model2
• How to Assign a Diﬀerent Material to Each Face of a Cube at www.youtube.com/watch?
v=hCYViRJFf5w

1
2
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https://en.wikipedia.org/wiki/HSL%20and%20HSV
https://en.wikipedia.org/wiki/RGB%20color%20model

35. Multiple Materials per Object
i Information
Applicable Blender version: 2.74

Figure 204

The ﬁnished render.
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Multiple Materials per Object
In this module, you'll create a beach ball with two alternating colours. Along the way, you'll
learn how to apply multiple materials to a single object.
Many real-life objects have parts which are diﬀerent colours, or are even made of diﬀerent
materials. One way to model such objects is to make each part a separate Blender object.
However, Blender also allows you to assign diﬀerent materials to parts of a single object.

35.1. Set the Scene
Begin by opening Blender and removing the default cube. Then select the lamp and change
its type from 'Point' to 'Hemi' in the Light settings in the properties window (object data
button), this has the advantage of it giving more light.

Figure 205

The options for changing lamp type in the properties window

Now create a mesh for the beach ball:
1. With the 3D View window active, press SHIFT + A ) and choose Add → Mesh →
UV Sphere.
2. In the ”Add UV Sphere” panel in the bottom of the tool shelf, specify 8 segments and
4 rings.
The initial result will be crude, but meshes with fewer vertices are easier to edit.
Make the mesh rounder and more organic using automatic subdivision:
1. In the ”Properties” editor, select the ”Modiﬁers” context (wrench icon).
2. Select ”Add Modiﬁer” and click Generate → Subdivision Surface.
3. For the number of subdivisions, set both the 'View' and 'Render' count to 2.
Get rid of that blocky look:
1. Ensure you're in Object Mode1 .
2. In the tool shelf, select the ”Tools” tab.
3. In the ”Edit” panel of that tab, set the shading to Smooth.

1
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Colorize Time
The ball is now round, but a bit prolate. To make it more spherical, scale it by about
1.1 along the X and Y axes. To select the X-Y plane, you select ′not Z′, by using the key
combination SHIFT + Z . The complete sequence is, then, S , SHIFT + Z , 1.1 .

35.2. Colorize Time
Now you're ready to begin adding colors to the object:
1. Press TAB to put Blender into Edit mode.
2. In the Properties editor, select the ”Material” button

Figure 206
.
3. Press ”+ New”.
A new material appears in the material slot list, and several additional panels appear
below to edit the created material.
4. In the ”Diﬀuse” panel, click on the default white diﬀuse color and change it to a nice
yellow.
At this point, the entire ball is yellow.
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Figure 207

In the ”Materials” panel click the ”+” button (indicated by the red box in the picture, below)
next to the material slot list to create a new blank slot. The ”+ New” button will reappear
(indicated by the blue box, in the picture below).
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Figure 208

Click the ”+ New” button and a new material will be created and assigned the empty slot
in the materials slot list. Ensure that the new material is selected, then change the diﬀuse
color to blue. Nothing will happen to the beach ball, yet.
Now make a single blue stripe on the ball:
1. All the vertices should still be selected from before; make sure the 3D view is active,
then hit A to deselect them.
2. Switch to front view with NUM1 , and to ”Face Select” mode with CTRL + TAB
then F .
3. To avoid accidents, make sure that the ”Limit selection to visible” option is enabled
in the 3D View header bar.
4. Select a column of four faces that will make up one stripe of the beach ball (using
SHIFT + RMB on each face):
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Figure 209
5. In the ”Material” property window, select the blue material slot in the list, then click
the ”Assign” button.
Rotate the view (e.g. NUM6 ) so you can skip past a yellow stripe adjacent to the blue
stripe, and select the second column that will become a blue stripe. Work your way around
the ball to do this three more times. (Remember we made the sphere with 8 segments; four
of these are yellow, and four are blue).
Now you see the beneﬁt of making a sphere with only 4 rings: more rings would have meant
more faces in each stripe, and more clicking to select them.
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36. Metal Versus Plastic
i Information
Applicable Blender version: 2.67
There are diﬀerent kinds of shiny materials. Consider the diﬀerence between a shiny metallic
object, and one made out of a glossy nonmetallic material (like plastic or ceramic). This
page will explain some simple techniques for (approximately) mimicking the appearances
of these materials using shader settings in the Blender Internal renderer.
For all the following manipulations, start a new Blender document, get rid of the default
cube, and replace it with a UV sphere. Set it to be smooth-shaded. Change the lamp
falloﬀ to be inverse linear, just to make the scene brighter. Assign the sphere a new default
material. It is the settings of this material we will now proceed to play around with.
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36.1. Making It Plastic

Figure 210

For a plastic or glossy eﬀect, give the material a diﬀuse colour, but leave the specular colour
at white. Increase the specular intensity to something like 0.9.
(In this and the following examples, I used a diﬀuse colour of #E7398B.)
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36.2. Making It Metal

Figure 211

Now change the specular colour to be the same as the diﬀuse colour. (The easy way to
do this is to bring up the specular colour picker, click on its eyedropper icon, and use the
eyedropper tool to click on the swatch showing the diﬀuse colour.) Also lower the specular
hardness from its default value of 50, to something like 25 or even 12. This will spread out
the specular highlight, giving the impression of a surface that is shiny, but not perfectly
smooth. Also lower the diﬀuse intensity, to something like 0.05.
To make the metal more convincing, you may want to choose a more typical metal colour,
like grey, copper or bronze.
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36.3. Making It Ceramic

Figure 212

Let’s try for a glazed-ceramic look, or perhaps some dark, shiny stone like obsidian. Set the
specular colour back to white (the easiest way to do this is to switch to HSV view in the
colour picker and set the S(aturation) value to 0). Increase the hardness to something like
200 to narrow and intensify the specular highlight. Leave the specular intensity high and
the diﬀuse intensity low.
To get an even more sharply-focused highlight, change the specular shader model from its
“CookTorr” default to “WardIso”. The “Hardness” parameter gets replaced with a “Slope”
instead; leave this at the default 0.1.
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37. Texture Settings
i Information
Applicable Blender version: 2.68

Figure 213

Material texture settings
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In the Properties

Figure 214

window, you will ﬁnd the Texture
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Figure 215

context, which looks like at right.
At the top you will see a row of three icons
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Figure 216

, which indicate texture settings to view and change:

•

Figure 217
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World Texture — a texture to use for the sky backdrop

•

Figure 218
Material Texture — a texture associated with the currently-selected material
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•

Figure 219
Brush Texture — a texture used for some other purpose.
There are two main types of textures in Blender:
• Image/Movie textures
• Procedural textures (all other types in the Type menu).
An image/movie texture allows a two-dimensional image (which might be static or moving)
to be wrapped around the surface of a three-dimensional object in some way. Alternatively,
a procedural texture directly maps a predeﬁned three-dimensional mathematical function
to the surface coordinates of the object.
The “Coordinates:” popup menu deﬁnes how positions on the object surface are mapped
to positions within the texture coordinate space. All of these options specify automatic
mapping algorithms, except one: the “UV” option. This one lets you work within the
UV/Image Editor, where you unwrap the surface of the mesh onto a ﬂat rectangle showing
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the texture image (this really only works with Image/Movie textures), and then move
sections of the mesh around to make them show corresponding parts of the texture.
The “Projection:” popup menu further controls how the two-dimensional surface of the
object is mapped to a two-dimensional Image/Movie texture. It seems to have no eﬀect for
procedural textures.
The “Oﬀset:” and “Size:” X, Y and Z values allow simple adjustments of the position and
scaling of the texture. Note that the size values work the opposite way to what you might
expect: larger values here make the texture smaller along the corresponding dimension.
The image at right shows the common settings panels for all material texture types. Additional panels will appear depending on the chosen texture type; the settings shown are for
the “None” texture, which is the same as having no texture at all.

37.1. Material Textures
A material may have more than one texture associated with it. At the top of the material
texture settings (see above), is a list of the texture slots associated with the material. Slots
may be empty (unused), and slots containing a texture may be enabled or disabled, by
checking or unchecking the box at the right of the list item. Disabling a texture slot stops
it having an eﬀect on the material, which is the same as deleting the texture from the slot
altogether, except it is easier to revert. This can be useful when trying to debug the eﬀect
of a combination of textures on the material.
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37.2. World Textures

Figure 220

upright

You previously saw how to set up colours for the sky in the World Settings1 ; you can also
add a sky texture as well.
World texture settings look similar to texture settings: again there are a number of slots, and
there are mapping and inﬂuence options. But the mapping coordinates types are diﬀerent
(and there is no UV option), and the inﬂuence types are more limited.
1
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Note:
Note that the only Inﬂuence checkbox checked by default is “Blend”.
If you’re wondering why your texture deﬁnition here is making no diﬀerence to your sky,
either make sure the “Blend” checkbox is checked in your World

Figure 221

settings, or check the “Horizon” Inﬂuence box here if you don’t want a sky gradation.
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38. Image Textures
i Information
Applicable Blender version: 2.70

38.1. Image Texture Settings

Figure 222 Simple
checkerboard
To understand how the texture settings apply to image/movie textures, start with an example texture. A nice simple one is this checkerboard at right—don’t forget to download
it in (or convert it to) PNG format, as Blender cannot use an SVG ﬁle as a texture.
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Figure 223

upright

Start a new Blender document. Note the default cube already has a a default grey material,
called “Material”, and this already has a single texture, called “Tex”, of type “None”, which
means it has no eﬀect.

314

Image Texture Settings

Note:
Before proceeding, go to the World

Figure 224
context and turn on Environment Lighting (you can leave its default energy at 1.0).
This will ensure the cube is more evenly lit, for easier visibility of the texture eﬀect.

Figure 225

Under the Texture
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Figure 226

context of the Properties window, with Material Texture
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Figure 227

selected, change the texture type to “Image or Movie”. You will immediately see some new
panels pop up in the texture context. Look for the Image panel, as at right. This initially
contains a popup menu icon for selecting from any previously-loaded images (this will start
out empty), a “New” button for using one of Blender’s predeﬁned test textures, and an
“Open” button for loading an image from a ﬁle.
Click the “Open” button, and select your previously-downloaded or converted PNG version
of the example checkerboard texture.
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Figure 228

upright

Now a whole lot more settings will become visible. From the top, the panels are:
• Preview — gives you a simple display of how the texture looks.
• Colors — lets you make simple adjustments to the image brightness, contrast etc.
• Image — lets you choose from any already-loaded images, and shows you the pathname
of the ﬁle the image was loaded from. Note the two arrows in a circle to the right of the
pathname display: clicking this will tell Blender to reload the image from the ﬁle, which
is useful if you make changes to it in an external image editor.
• Image Sampling — controls how the image can be interpreted in a diﬀerent way from
straight pixel values.
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• Image Mapping — lets you crop the input image, and apply ﬁxed numbers of repetitions to
it along each axis, even before it goes through the usual texture-tiling repetition process.
• Mapping, Inﬂuence — these are more general panels that apply to all types of textures.
They will be discussed in more detail shortly.
Note:
Image packing: the icon to the left of the image pathname lets you pack a complete copy
of the image into the .blend ﬁle, so it no longer keeps reading the original image ﬁle.
This can be useful if you want your .blend ﬁle to be self-contained, particularly if you
want to send it to others. On the other hand, if your workﬂow depends on coordinating
with someone else doing the image editing, it may be more convenient to leave it linking
to a separate image ﬁle.

Figure 229

Projection: ﬂat; axes: X→X, Y→Y, Z→Z
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If you render F12 now, you should end up with an image like this. Notice in the Projection
menu (Texture → Mapping) the initial selection is “Flat”: this means that the texture X and
Y coordinates go straight to object X and Y coordinates. Thus, the texture only appears
on the top (and also bottom) of the cube, not on its sides. See also the three little popup
menus just below the Projection menu, each containing the items X, Y and Z. These let
you rearrange the object coordinates that the texture coordinates map to. If you change
the ﬁrst two, you can get the texture to appear on other pairs of sides of the cube, other
than the top and bottom. The third menu (corresponding to the Z axis of the texture) has
no eﬀect (yet), because a ﬂat image texture is only two-dimensional.

Figure 230

Texture size increased to 3.

Now try changing the three “Size” ﬁelds in the Mapping panel: give them all a value of
3. This will uniformly shrink the texture pattern to one-third of its original size. Or
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alternatively, it will require three times the number of texture repetitions to span the same
distance as the original.

Figure 231

Texture projection set to Sphere

Now let’s try the other Projection types. Here’s what “Sphere” looks like. Imagine the
texture pattern as a ﬂat sheet stretched and curved around, and its edges joined to form
a sphere surrounding the actual object; then the sphere is shrinkwrapped down onto the
object.
Note the top and bottom edges of the sheet shrink down to single points at the north and
south poles; this is why the squares of the checkerboard pattern turn into triangles next to
these points.
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Note:
Z-axis now works: because these projection types other than “Flat” turn the texture
into a 3-dimensional object, you can now use all 3 of the axis-rearrangement menus to
reorient the texture in interesting, not to say confusing, ways. What happens when you
assign the same texture axis to more than one object axis?

Figure 232

Texture projection set to Tube

Here’s a Tube mapping. Here the texture pattern sheet is rolled round into a cylinder, with
only one pair of edges joined together, the top and bottom left open.
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Figure 233

Texture projection set to Cube

And lastly, here is a Cube mapping. Here 6 copies of the texture pattern are arranged
parallel to the faces of a cube, before being shrinkwrapped onto the actual object. Which
in this case, happens to be a cube.
Cube mappings are very commonly used in game engines, because they are just about the
simplest way to wrap a texture around an entire object.
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Figure 234

“Mapping” versus “Image Mapping”

38.2. Making Your Own Texture
Procedural texturing is very powerful; however, sometimes it is diﬃcult or impossible to
generate the desired realism with them. Image texturing is there for you when you need
it. To review, the basic idea is to take an outside image and wrap it around your model.
You can use any texture, or a seamless one if you want it to repeat to get a tiled eﬀect.
The following shows how you create a seamless texture, and then how to apply any texture
(seamless or otherwise) to an object.
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38.2.1. The diﬀerence between 'tiled' and 'seamless'
In many cases a simple material will just not cut it for an object, and you will want to apply
a texture to it. However, depending on the object, you may want to apply either a seamless
or tileable texture. A seamless texture is an image that will, when applied to an object,
spread evenly across the surface of the object without any visible borders or 'seams' even
if the object is many times larger than the resolution of the image (also called 'procedural
textures' in Blender). These can be useful in many situations; such as when you want a
texture for a carpet to seamlessly repeat itself without having a huge resolution.
A tileable texture on the other hand, is an image that will repeat itself across an object,
but with noticeable seams. Any image can be used as a tileable texture, but often they will
only be used in speciﬁc instances such as a vinyl ﬂoor with a tiled pattern on it.
See Using Textures1 for more details on applying images as textures, and using them to aﬀect
many other surface attributes such as luminosity, reﬂectivity, translucency, displacement etc.

38.2.2. How to make a tileable texture with the GIMP

Figure 235

1

Chapter 79 on page 775
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It is easy to create a tiling texture image with the GIMP2 . Start with the photo you want
to use. Crop out any part you don’t want. Here’s an example random photo of some plants
in my garden:

Figure 236

Go to Gimp’s “Filters” menu, and ﬁnd the “Map” submenu. In here you will ﬁnd the entry
“Make Seamless”. Select it. That’s it:

2
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Figure 237

Just to prove it works, here’s a (scaled-down) use of the result as a tiled ﬁll pattern:

38.2.3. Other Image Texture Editors
• Wood Workshop3 A free utility (Requires Operating System: Windows 2000/XP) that
generates surprisingly high quality tiling wood texture images. These textures can be
exported as standard image ﬁles for use within Blender.
• MapZone4 A free utility for Windows (works perfectly in Wine5 ) that generates node
based procedural texture maps. Mapzone can export diﬀuse, normal and alpha texture
maps as standard image ﬁles. It can also import SVG regions created with Blender's UV
mapping tools.

3
4
5

http://www.spiralgraphics.biz/ww_overview.htm
http://www.mapzoneeditor.com/
http://winehq.org/
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39. Procedural Textures
i Information
Applicable Blender version: 2.70
Procedural Textures
Texturing objects can be broken down into two categories: procedural and image texturing.
Procedural texturing makes use of mathematical formulas to generate textures. This is
nice because it can be used to make relatively nice looking textures without external images
which are very temperamental where you put them. Procedural Textures are all stored in the
.blend ﬁle. These textures are obviously generated within Blender itself. Image texturing
uses images created or captured outside of Blender, either from an image manipulation
program such as the Paint.NET, GIMP or Photoshop, or captured on a camera. We have
already learned about image texturing, so let's move on to procedural texturing.
Current Procedural Textures
Blender currently supports many procedural textures, including: Clouds, Marble, Stucci,
Wood, Magic, Blend, Noise, Musgrave, Voronoi and DistortedNoise.

39.1. A Simple Wood Texture
Let's deﬁne a simple wood texture:
• Start a new Blender document containing the default cube.
• Select the cube (and nothing else).
• In the Properties window, go to the World tab
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Figure 238
and turn on Environment Lighting (you can leave its default energy at 1.0).
• Go to the Materials tab
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Figure 239
, and rename the default ”Material” to ”Wood Material”. Alternatively, delete the default
material using the X to the right of the name ﬁeld and add a new material.
Let's add some color and texture. You can see the results at any time by pressing F12 to
re-render the scene.
Start by painting the cube a base color using the Wood Material's ”diﬀuse” color:
• In the “Material” tab,
• Scroll down to the “Diﬀuse” properties panel and choose a darker brown color e.g.
#A57E3F.
See http://en.wikipedia.org/wiki/HSL_and_HSV for where brown ﬁts in the color wheel.
Next, let's add a texture to give the material some highlights.
• Switch to the “Texture” properties tab
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Figure 240
, and again rename the default ”Tex” to ”Wood Texture” or create a new texture. Notice
at the very top of the ”Texture” tab ”Cube > Wood Material > Wood Texture”
• Change the Type of the material to “Wood” using the pop-up menu.
The texture sample will show parallel alternating black and white bars that don’t look very
woody at all. Never fear! The black regions will be the material's base ”diﬀuse” color. The
white regions are like ”highlights” that will be painted over the base.
Let's make some improvements to the texture:
• While still in the “Textures” tab,
• Scroll to the “Wood” properties panel that appears, change the waveform from “Sine” to
“Saw”.
• In the next row of buttons down, change the type from the default “Bands” to “Ring
Noise”.
• Increase the Noise Size to 1.0.
Now the texture sample should show something resembling wavy tree-rings. If you hit F12
to render now, you will see these rings covering your cube, except a) the colour is wrong,
and b) normal wood patterns aren't so nearly circular.
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To make the pattern more elongated:
• Scroll to the “Mapping” properties panel,
• Change the Size X value to 2.0 and Y to 0.4. This squishes the pattern down along the
X-axis, and stretches it out along the Y-axis, giving the elliptical tree-ring shapes you
commonly see on wood planks and boards.
Hit F12 to render again, and the shape of the texture should be looking a lot more woody
now.
The ﬁnal step is to color the highlights in the texture:
• In the “Textures” tab,
• Scroll to the “Inﬂuence” properties panel further down,
• Click on the color swatch, and choose a nice brown colour.
For a nicer eﬀect, I chose a very light brown e.g. #DEB887.
The result should look very woody indeed!
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Figure 241

• Remember that you need to Render to see the wood grain on your object.
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41. Halo Materials
i Information
Applicable Blender version: 2.76

B

Warning

Due to a bug with ﬂare in blender 2.75, this tutorial will not work in blender 2.75;
Blender 2.76 will work instead.

41.1. Introduction
Halos are a neat eﬀect. Instead of giving a colour/texture to the faces of a mesh, like normal
Surface materials do, the Halo material ignores the faces and renders representations of the
vertices instead. This can produce all kinds of ethereal, even ghostly, fantasy eﬀects, of
objects that look like they’re made out of light rather than ordinary solid matter.
A halo material can also produce a ﬂare eﬀect. This is the “lens ﬂare” that happens when a
physical camera is aimed at a very bright light source; the spillage of light bouncing around
inside the optics produces coloured rings and other interesting artifacts on top of the image.
This has become such an accepted part of photography that computer graphics programs
like Blender, which do not suﬀer the imperfections of physical lenses, go to a great deal of
trouble to oﬀer a realistic ﬂare eﬀect.
Flare eﬀects can also be achieved using compositing node and a material with an ”emit”
value, such ﬂares may in some circumstances render faster and be simpler to control. This
works for the Blender internal render engine, as do ﬂares generated with halos. This is done
by opening the node editor (switching the 3d viewer tab to one of these for example) then
clicking ”compositing nodes” and ”use nodes”, ”ﬁlters” can then be added to produce these
eﬀects.
This tutorial will show you how to create an image representing a ﬂare eﬀect in a picture
of the Sun.

41.2. Setting The Scene
Open a new default Blender document. Get rid of the default cube. Insert a new UV
Sphere mesh in its place, and set the number of segments and rings to 24 each. Also set
Smooth shading. This will be your Sun. Create a new material for it, set the Diﬀuse colour
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to a suitable yellow. Under the Shading panel in the material settings, look for the “Emit:”
slider and give it a value of 1.0 to make it look bright. Since the Sun emits its own light,
you don’t need the separate default light, so get rid of that.
Go to the World properties tab

Figure 242

. In the “World” sub-header, click on the colour swatch labelled “Horizon Color” and assign
a nice deep blue colour for your sky.
If you do a render now, you should see your bright yellow orb, but without any ﬂare eﬀect.
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41.3. Adding The Flare
Now add a new Circle mesh; the default 32 vertices should be enough. By default it lies in
the X-Y plane, which again is ﬁne. Move it along the Y-axis a little closer to the camera
(negative-Y direction), until it lies outside your Sun sphere, but still close to it. Scale its
size down by 0.5. (It will probably be invisible when ﬁrst created, because it is initially
inside your Sun sphere, but it will be initially selected, so you can immediately press G
Y and start moving the mouse without pressing any buttons, and make it appear from
inside the Sun). Create a new material for it, and set the type to Halo.
In the Halo panel in the Material settings, increase the size to 3.0—this is the size of the
fuzzy image that is rendered around each vertex, and this value is suﬃcient for them all to
run together into a continuous ring. Reduce the Alpha to 0.05 to avoid overpowering the
image with the halo eﬀect.
Go further down the halo Material settings, and ﬁnd the Flare panel (in Blender 2.75 you
can check ”Flare” but what settings you do, nothing will work). Check the title box to
enable this. Set the number of Subﬂares to, say, 8 (this controls the number of separate
halo reﬂections that will be generated, though you probably won’t be able to distinguish
that many). Set the Boost to 10 to make the subhalos brighter than the original parent
halo.
The Seed value in the Flare panel controls the particular ﬂare pattern that you see; each
number produces a diﬀerent eﬀect. I chose the value 3 for this example.
Where did the circle go? Like any object with a halo material, the circle object can be
quite hard to see when it’s not selected. If you lose track of it, there are a couple of ways
to ﬁnd it again:
• Select everything with A . Now you can look for the ring of dots and RMB on it to
select it exclusively.
• Use the outliner window at the upper right. You should see it listed here under its
default name of “Circle”; click with LMB to select it, and you should see the ring of dots
appear in the 3D view.
If the circle object is still inside the Sun, then wireframe Z
may be helpful to ﬁnd it again.

or bounding-box view modes

41.4. The Final Result
Now hit F12 to render, and you should see something like this (the ﬂare eﬀect may not
appear immediately with the rest of the image, give it a few more seconds to appear):
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Figure 243

Exercises: Try diﬀerent positions for the circle mesh; move it near to the Sun (even partly
in it), far from it, move it around to diﬀerent sides. How does this aﬀect the ﬂare pattern?
Also try changing the size of the circle mesh.
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42. Blender Memory Management
Note:
This section may be a bit bewildering on ﬁrst reading. If you don’t understand it right
away, don’t worry too much; but as you work more and more with Blender, making
copies of objects, or sharing settings between objects, feel free to come back and re-read
this and hopefully it will make some subtleties of Blender’s behaviour clearer.

42.1. Datablocks And Users
It is helpful to understand how Blender manages memory. Just about everything in a
Blender document—objects in scenes, scenes themselves, materials, textures, whatever—is
stored in a datablock. Each datablock has a name, which must be unique among datablocks
of the same type. Each datablock may be referenced from one or more places, mostly
in other datablocks—in Blender parlance, it has one or more users. For example, several
diﬀerent objects might share the same material, so when you change the characteristics of
the material, it automatically changes the appearance of all those objects.
If the number of users of a datablock drops to zero, it still stays around in memory, but it
will not be saved when the document is saved. Thus, if you save and reload the document,
all the datablocks with zero users will disappear. (In some cases you may need to save and
reload a couple of times before all zero-user datablocks disappear.)
But up until that point, the datablock will continue to appear in the relevant popup menus,
so you can reassign it to more users.
You can also assign a fake user to a datablock; this is what the “F” button is for in the
popup menus that list datablocks of that type. This ensures that the user count never goes
to zero, so the datablock always gets saved in the document even if it has no real users.
This is useful for “library” documents, which can contain collections of useful materials and
textures, say, that can be linked or imported into other documents, without also having to
include dummy objects in the library just to ensure those materials and textures get saved.
For example, here is the widget that lets you choose the material for an object:

Figure 244
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The main part shows the name of the current material, which is editable. The X button
breaks the link to this material and decrements its number of users by one, while the
F button assigns a fake user to this material. The + button lets you create a new material.
The material symbol on the left pops up a list of existing materials to choose from, plus a
search box to search all existing materials:

Figure 245

Note the entry with the 0 symbol next to it; that currently has a user count of zero, and
will disappear when the document is saved and reloaded, if it is not further used.
The widget also displays the current user count if it is greater than 1:
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Figure 246

In this case the count was incremented because the F button was selected.
Note:
Clicking the number (if it’s greater than 1) makes a copy of the Material, attached only
to this particular user. The copy has a user count of 1, while the original has its user
count decremented by 1.
This is the basis of the (slightly confusing) distinction in Blender between object
datablocks and object data datablocks. Object datablocks contain the information common to all the types of objects in the 3D scene, regardless of whether they’re mesh objects,
lamp objects, camera objects or whatever; whereas the object data datablocks contain the
information speciﬁc to that instance of the type of object, e.g. the vertex, edge and face
deﬁnitions for this particular mesh you might be using, or the colour and energy of a lamp
you've set up for your project, or the ﬁeld of view of a camera you have.
That leads us to the diﬀerence between the two object duplication commands, SHIFT +
D and ALT + D : the former duplicates both the object datablocks and the object
data datablocks (though this can be controlled in your User Preferences), while the latter
only duplicates the object datablock. That means that in the ﬁrst case the two objects are
truly independent, but in the second case the new object continues to share the same object
data datablock so a change in one will result in a change in both of them. So, for instance,
if you use ALT + D on a mesh object and edit the vertices, edges or faces on one copy,
the other copy will also be aﬀected.
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43. A Common Pitfall in Older Tutorials
(Align to View Issue)
For fast reference, Just Click after every new created mesh on ”align to view”
in the tool shelf.
After much struggling to follow many tutorials based on older versions of Blender, I have
downloaded multiple versions to discover why the tutorials based on versions such as 2.43
don't work when attempted on updated versions such as Blender 2.48a and above. Newer
versions such as 2.48 have added a new option to /not/ have added objects rotated to the
current viewpoint. With older versions, being in top, front or side view would cause any
newly added objects to face diﬀerent directions on creation.

Figure 247
orientation

The location of the button to make the circle show up in the correct

Newer versions of Blender introduced the ability to force all objects into the same global
orientation; even worse, they set it up that way BY DEFAULT! This means that unless
the user deliberately changes the settings in the new versions, many older tutorials will act
as if they are broken.
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Newer versions of Blender (such as version 2.48, or 2.49b ) can be set to act in the
same way as the older versions, by setting the Align to view on the (i):
USER
PREFERENCES menu in the right way.
Making this simple changes will ”unbreak” tutorials written under Blender version 2.43, by
allowing new objects to be automatically oriented to whatever viewscreen orientation is
selected in the active viewscreen.
Any time object rotations, lattices or whatever else end up completely out of alignment
with what older tutorials say should happen, these steps are your ﬁrst best ﬁx for almost
every such situation.
In 2.58 and 2.61
The settings mentioned above are found in ”File->User Preferences” (shortcut:
Ctrl+Alt+U) under the ”Editing” tab. There's a drop-down called ”Align To” where you
can set ”View” or ”World”.
Noob Note: What actually happens by default on newer versions of Blender is that the
axis of rotation is perpendicular to the screen. It means that, instead of revolving around
the vertical axis, the object will revolve in the plane of the screen. Another way to deal
with this is to change the view just before performing the rotation (I used NUM1 view)
and come back to NUM7 once done.
Noob Note: In version, 2.63 for Linux, after changing ”Align To” to ”View”, when adding
through ”Add” menu, the mesh will still be aligned to ”World”. To get it aligned to ”View”
You have to add it with SHIFT-A.
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Figure 248

Align to view

Noob Note: In version 2.68a (unknown for older versions) there is a option to Align newly
created mesh individually. When you create a mesh, (for ex. cylinder) there is a panel
beneath the toolbox panel(left side of the 3D view) that shows up: Add ”Mesh Name” (ex.
Cylinder). Scroll down a bit and you'll see a check-box to enable ”align to view”. Checking
it will align the mesh you added to the current view. Re-checking it after rotating the view
around will align the mesh to new view.
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44. Using Bones
i Information
Applicable Blender version: 2.70
Bones are used for shifting models and making them posable. If you are not
ready for this yet and wish to continue simply modeling, please skip this
tutorial to the next section.
Bones are a modeling tool that are especially important for animating characters. Bones
allow you to move characters' limbs in a way that is much simpler than trying to re-arrange
the vertices every time.
It works by associating a bone with particular vertices, causing them to move along with
the bone when the position is changed in pose mode. Using bones is fairly simple once you
get the hang of it, but, like many things in Blender, can be a little daunting at ﬁrst sight.
Bones don't do much on their own; in fact, they turn invisible at render time. For this
following module we'll use the character that we had made by the end of the module
Putting Hat on Person1 . You will have to have completed all the modules in Section 2B2 .
Note that while we will be using bones on a simple person, the process can be used with
any creature or body type you imagine!

1
2

Chapter 32 on page 271
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%23Unit%202%3A%
20Basic%20Modeling%20and%20Shading
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44.1. Laying down bones

Figure 249

Note: This just shows the basics of adding bones to an object. Go to the advanced animation3
page for a more comprehensive guide on this.
First of all, we'll need a model to put some bones on! For this tutorial, we're going to use
a humanoid model. Open the model that you had created by the end of the Putting Hat
on Person4 tutorial, or download a pre-made model from here5 .
Here's our setup, with Block Dude standing on a plane. You can add a plane by pressing
SHIFT + A → Mesh → Plane. Scale the plane to an appropriate size and move it so that
it is approximately underneath the person.
Noob note: You will be placing armatures (”bones”) inside your humanoid, so you must
work in ”wireframe mode”, not ”solid mode”. Otherwise, you will not be able to see the
armatures when you place them. To toggle between ”solid” and ”wireframe”, press Z .
You may ﬁnd it helpful to make the wireframe less complex by hiding the subsurface mesh.
You can do this by going to the Modiﬁer context panel

3
4
5
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Chapter 165 on page 1451
Chapter 32 on page 271
http://www.nusoy.com/blender

Laying down bones

Figure 250

of the Properties window
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Figure 251

and deselecting the eye button.
Note: An alternative to working in ”wireframe mode” is to turn ”X-Ray” on for the armature.
To do this, select the armature. In the properties panel under object data there is a display
menu. Click ”X-Ray” in the second ﬁeld of buttons. This will allow the armature to show
through other objects.
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44.2. Add a bone

Figure 252
Now, let's put some bones on Block Dude! In Object Mode press SHIFT + A → Armature
→ Single Bone.
What we are looking at is an armature. This is a single bone. Now, we need to put the
bone in Block Dude! Move and rotate the bone so that it's in the middle of Block Dude's
chest. If your bone does not have the correct length, then change the size of the bone by
moving one of the ends of the bone: switch to Edit Mode, select one of the ends of the
bone, then move it using G . Alternatively, you can scale it using S
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44.3. Extrude a second Bone

Figure 253

To create a second bone starting from one of the ends of the ﬁrst bone, switch to Edit Mode
with the bone selected, select the end of the bone, then extrude E the end. A second
bone appears, with its start point on the selected end of the ﬁrst bone. Move the mouse to
position the end point, then press LMB , ENTER , or SPACE . Scale the bone as needed
to ﬁt it in his body, and continue adding bones by extruding the end points. These operate
much the same way as vertices: you can extrude, rotate, move, and even subdivide. Your
ﬁnished result should look something like this:
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44.4. Name the bones

Figure 254

Now, just to make things easier, we're going to name the bones. For example, my bones
are named ”Right Forearm”, ”Left Forearm”, ”Right Upper Arm”, etc. While in Edit mode,
select the bone you want to rename. In the Outliner

Figure 255
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, the bone you have selected will be visible with a circle around it

Figure 256

. You may need to expand the Armature Object
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Figure 257

, Armature Data Object
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Figure 258

and any parent bones before being able to view the selected bone. In the Bone context
panel
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Figure 259

of the Properties window click the name ﬁeld to edit the name.
Noob Note: When you are naming the bones remember that if you are looking at the
person from the front, your left is the person's right. To make the naming easier switch to
viewing the person from behind using CTRL + NUM1 .)

44.5. Parent the bones
Now, we need to parent the bones to the mesh. Go back into Object Mode and select Block
Dude (and the Hat, assuming you made one). Now, select the Armature as well, so that it
is the last object selected, and press CTRL + P . The Parenting Menu will pop up. Select
Armature Deform → With Automatic Weights. The person (and hat) are now children of
the armature.
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Noob Note: The selection order is important in deﬁning which object is the parent, so you
cannot select both objects at the same time. You must select the armature last to make it
the parent.

44.6. Moving the Bones

Figure 260

To move individual bones, you have to go into Pose Mode. Select the Armature in Object
Mode and switch to Pose Mode by pressing CTRL + TAB or selecting the mode in the
mode selection menu of the 3D Viewer. Try moving a bone around by pressing RMB to
select it, and then hitting G or R to move it.
If you've done everything correctly, your mesh should move when you move the bones! If
this doesn't happen, scale the bones up so that they ﬁt better in the mesh, and scale up
the bones until they do what you want (read comment in the parenting section above on
adjusting the bones envelopes if you do not get an eﬀect while moving/rotating the bones).
With the bones now, you can put Block Dude into a lot of diﬀerent positions without moving
individual vertices.
To the right is an example of how you can move Block Dude with the bones.
Also while in pose mode if after a RMB click you can't move bones with G or R
, check the ”Move Object Centers Only” button (just to the right of the Rotation/Scaling
Pivot button).
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44.7. In-Depth Info on Selected Bone Topics
44.7.1. Add/remove mesh from bone control

Figure 261

Noob Note: If you've been adding bones to your simple person from the previous lessons,
you will have likely noticed that the hat seems to stretch when you move the arms in pose
mode. To ﬁx this, you will need to remove the hat from the forearm vertex groups created
in the Parenting step.
To manually change the mesh areas that the bones control, go to Object Mode and select
the object you want to add/remove (if the mesh is inside the same object, then select only
the areas of the mesh you want to work with in Edit Mode).
In this case, select the Hat.
Switch to the Object Data context panel in the Properties window and scroll to the ”Vertex
Groups” submenu.
Now pick the bone group from the dropdown above the Assign/Remove buttons, and then
hit Assign (or Remove) as necessary. Usually vertices will be assigned to one group, but can
be assigned to multiple groups. In this case, we want to remove the Hat from the Forearm
vertex groups. Select the Forearm vertex groups and press the remove button, as pictured.
With both of the Forearm vertex groups removed from the hat, it should be able to move
properly with the rest of the armature.
Mesh deforms like it's far away from the bones
If the mesh is properly assigned to the bones they will move regardless of whether the bones
are inside the volume of the mesh or not (HOW they deform WILL be aﬀected however).
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The most common mistake in this step is creating and (more importantly) parenting the
mesh to the armature while the armature is outside the mesh, which causes Blender not to
assign vertices to any bone groups at all.
You can check this by editing the object (i.e. select the mesh and switch to Edit Mode, then
un-select all vertices by pressing A until nothing is selected). Pick the Object data context
then select a vertex group in the Object data tab, pressSelect. This will select the
vertices associated with the bone group. If the wrong vertices appear selected,
you need to assign them manually as explained above.
If there is no eﬀect, in Edit mode select that bone (or bones) and choose Envelope display
mode (Properties window

Figure 262
, Armature context panel → Display → Envelope), then press CTRL + ALT + S and
increase its area of inﬂuence to cover all faces that should be inﬂuenced by the bone.
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45. Mountains out of Molehills
i Information
Applicable Blender version: 2.75
Now that we've created our simple person, it's time to give him somewhere to go. In this
tutorial we'll create a mountain range using a few simple, and handy tools.

45.1. Creating a simple plane

Figure 263

First we need a clean area to work with.
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• Start oﬀ with a new project, using File → New, or hit CTRL + N . If you have a default
cube or plane just delete them now (select them with RMB and press X ).
Our ﬁrst step is to create a large grid plane that we'll use for the ground and grow our
mountains out of.
• Press NUM7 to enter top view. This way our grid plane will be lying ﬂat when we create
it.
• Press SHIFT + C . This sets the 3D cursor to (0,0,0) which will be the center of the
grid we will add (or use - SHIFT + S → Cursor to Center).
• Now add the grid with SHIFT + A → Mesh → Grid. This will be our canvas.
• Now add more vertices to the grid. In the bottom of the toolbox window, change the
number of X and Y subdivisions somewhere from 15 to 20.
• Change to Edit Mode using TAB
• Scale the grid plane up by about 15
First put the mouse close to the center of the grid plane and press S and drag the
cursor away and watch the numbers in the bottom left of the 3D View. Hold CTRL while
dragging to increment by 0.1 for a more precise measurement. Alternatively, to enter the
exact amount yourself, press S , then simply type 15 and hit ENTER .

45.2. First mountain
Now that we have the ground, it's time to start growing our mountains.
• Make sure you have nothing selected A .
• Select a random vertex with RMB . I usually start at the one that is 4 down from the
top and 4 in from the left (the 4th vertex if you count the edges).
• Change to the side view with NUM3 .

Figure 264
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• Press O to change to proportional edit mode or use the button which shows a grey ring
on the header of the 3D View. The button will change its color to blue. You can also use
SPACE → Transform→Proportional Edit (By default this button is located just below
the 3D view).
• Once you've turned proportional edit mode on, another button appears to its right, the
falloﬀ button. Select Smooth Falloﬀ here. Alternatively you can use the menu on the
header of the 3D View (Mesh → Proportional Falloﬀ → Smooth) or, using SHIFT + O
will cycle through all of the diﬀerent falloﬀ types while using the Proportional editing
tool.
• Press G to grab the vertex. We should now have a circle surrounding the vertex, this
is our radius of inﬂuence. Basically any vertices inside this circle will be aﬀected by any
changes to the vertex itself.
Noob Note: If you're having trouble seeing or changing the radius of inﬂuence, try saving
your scene and restarting Blender.
• Use SCROLL or PGUP and PGDOWN to adjust the radius of inﬂuence to include
just over 2 vertices on each side of our selected vertex. (Depending on your version of
Blender, you may need to use LMB + SCROLL to adjust the radius of the inﬂuence.
On Mac, use FN + PGUP and FN + PGDOWN ).

Figure 265

• Move the vertex up about 8 units on the Z-Axis. Do this by dragging the cursor up a
little, and press the MMB ; this should restrain the movements along the Z-axis. Now
use CTRL to move it precisely. Alternatively you can use Z to restrain movements
to the Z-Axis, type 8 and hit ENTER . In older versions of Blender you may need to
hit N before typing 8 .
Congratulations, we just created our ﬁrst mountain. Now it's time to see what other things
we can accomplish with the proportional editing tool.
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45.3. Peaks vs. hills

Figure 266

The 2.37 and onward releases oﬀer at least 6 types and 2 modes of proportional editing.
The previous release only has 2 of these types: Smooth and Sharp Falloﬀ. We'll take a look
at the diﬀerence between these two now.
• Change to top view again with NUM7 . You'll notice that now your ”mountain” looks
like a few diﬀerently shaded squares in the grid; you're looking down on shaded tiles, but
in the Z axis, they're all still perfectly aligned with the original grid.
• Select another vertex away from the ﬁrst. Let's say 4 from the bottom 4 from the right
(counting the vertices on the edges).
• Change back to the side view with NUM3
• Select Sharp Falloﬀ from the menu on the bar of the 3D View. Alternatively, using SHIFT
+ O will switch from one to the next of the 6 proportional editing modes while using
the Proportional editing tool.
• As before, move the vertex up 8 units on the Z-Axis (Note: The radius of inﬂuence will
still be the same size as when we last used it).
• G
• Z
• Type NUM8 and hit ENTER
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Figure 267

Now we can see the diﬀerences between the sharp and smooth falloﬀ. The same number of
vertices are aﬀected in both cases; only the degree to which they are aﬀected is diﬀerent.
The diﬀerent proportional editing modes can be selected from the box immediately to the
left of the proportional editing type box. The mode box contains four options: Disabled,
Enabled, Connected, and Projected (2D). ”Disabled” means that proportional editing will
not be used. ”Connected” means that only vertices linked to the selected vertices will be
aﬀected by the radius of inﬂuence. ”Enabled” means that all vertices will be aﬀected.
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45.4. Shaping the world

Figure 268

Now that we've created a couple of Mountains, it's time to see how we can use proportional
editing to shape them.
• First make sure we're in side view ( NUM3 ).
• Then on the smooth falloﬀ mountain, the ﬁrst one we created, select the vertex that is
immediately down and left from the topmost point.
• Press R to rotate, scroll the MMB to change eﬀective radius so it includes other
points. Your screen should look like the photo to the right.
You can see the size of the proportional editing circle, and that there is only one vertex on
the mountainside selected.
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• Next hold CTRL and rotate everything by -90. Alternatively, use R , N , and type
-90 and press ENTER . Your mountain should now look like this:
Noob note: be careful about the range of aﬀected vertices. If the range is too small, then
rotating will aﬀect just the selected vertex. If the range is too large, it will rotate everything
together. You can adjust the range by using SCROLL .

Figure 269

Notice that the vertex itself did not move; since it is at the center of the circle it had no
eﬀect. The adjoining vertices within the edit circle were rotated around it in decreasing
amounts the further from the center they are. Try doing it again with a larger proportional
editing circle. Feel free to play around with scaling or rotating from diﬀerent view points
(don't forget that you can also use G to move vertices vertically or horizontally).
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Try viewing your world from top view while rotating with a large eﬀective radius. You will
see the nearby vertices move close to the full amount while vertices further away move less.

45.5. Smoothing things out

Figure 270

Now that we have a couple of budding mountains, you probably think they look kind of
choppy. Sure they would be good if we were making an 8-bit console game, but we're
working with 3D here, we want things to look sharper (or maybe smoother) than that.
There are a couple of approaches to this. The ﬁrst is to use more vertices when we create
our plane. And I won't lie, it works. But it's also a HUGE resource hog. It would take your
home computer hours of work just to keep things updated, let alone run it. So instead, we
fake it. The easiest way to do this is to turn on SubSurfaces (we saw this in Detailing Your
Simple Person 11 .) For our purposes, let's set the subdivision (Levels) to 2. Also, ensure
our SubSurf algorithm is set to Catmull-Clark (this is the default setting).
Now, you'll notice that with SubSurf on, we lose a lot of hard edges that we had, essentially
we have no sharp corners any more. I don't know about you, but to me that doesn't make for
a very interesting mountain range. So to restore our corners, we are going to use Weighted
Creases for Subsurfs.
• First turn oﬀ proportional editing with O , and ensure we're in side view with NUM3
• Next, while still in edit mode, change to Edge Select mode with CTRL + TAB and
select Edges. Alternatively press Edge Select Mode button at the bottom of the object
window.
• In the Tool Shelf at left, select the Options tab, then under Edge Select Mode, choose
Tag Crease.
• On our Sharp Falloﬀ mountain, the second one we did, select the two edges on the right.
(see image below)

1

370

Chapter 29 on page 247

Naturalness

Figure 271

right

• Press SHIFT + E or SPACE → Edit → Edges → Crease SubSurf, then move the
mouse away from the edge until the edge Crease reads 1.000 in the 3D viewport header.
If moving the cursor there seems to be impossible, just hit 1 and enter.
As you move the cursor away from the edge you will notice two things. The ﬁrst is that
the edge becomes thicker as we move from it; this is showing how much of a crease we
have (with Draw Creases turned on). The second is that you will notice the subsurfed mesh
moving closer to the edge as the sharpness increases.

45.6. Naturalness
Press

CTRL + TAB to enter Edit Mode and select vertices. Then go into front view
. Select the second vertex from the top in the centre of our Sharp Falloﬀ mountain,
then go into side view NUM3 . Hold G and drag the vertex inwards, not too far or your
mountain will come out of itself on the other side. Just bring it in enough to make a small
indent.
NUM1

Then grab the top vertex and pull it down a small amount. You will notice that there is a
small ”crunch” in your mountain.
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Don't forget to select all with A , then W Shade Smooth button to smooth everything
out.
OK, so your mountains are starting to shape up. But they still look a bit too neat. You
could spend time moving each individual vertex but the chances are your model will still
lack the natural feel. What we need is some chaos. Thankfully this is quite easy to accomplish. Firstly select the vertices that make up your mountains, all of them and a few
around the base (box and circle select will make this easier). Select a few vertices between
the mountains too. Next we use something called fractals. Fractals are chaotically (i.e.
randomly) generated variables. In short you can use these variables to give your mountains
a ”wobbly” look.

Figure 272
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Naturalness
In the Tools tab of the Tool Shelf, press Subdivide (under Mesh Tools), then look at the
Subdivide submenu below. The value in the Fractal box is the strength of the fractal. 1 is
very low and will barely change your model. 10 is very high and will twist your models into
very odd shapes indeed. Have a play with diﬀerent values until you ﬁnd one that you like.
Around about 4.0 should do it. Hit OK and presto, your mountains have been transformed
from clinical neatness, to lumpy chaos.
• If you make too many fractals, your computer will slow down. However, the more you
add, the more bumpy and realistic it looks!
Repeatedly using the fractal tool seems to rapidly multiply the amount of vertices on your
canvas. I suggest using the tool once, and if the result isn't satisfying, undo the result (
CTRL + Z ) and try it again with a diﬀerent fractal strength. Helpfully, even after undo,
your selected vertices remain selected.
Now go back into Object mode and view the result.
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46. Modeling a Volcano
i Information
Applicable Blender version: 2.75
In this module, you will create a volcano using the proportional edit fall-oﬀ tool. You should
be comfortable with deleting and adding meshes.

46.1. Adding a Plane
Delete the basic cube. Add a plane, and S cale it up by 10. Rotate it so you see it in
top-view (make sure it's in Orthographic view too).
Enter Edit mode and subdivide (with W ) 5 or 6 times. More subdividing will give you a
”smoother” volcano, but it also needs more CPU power.
”Subdivide” divides every square in the plane into four new squares. So every time you
press ”Subdivide” you will have four times as many squares as before. ”Subidivide Multi”
will make x horizontal and x vertical lines through your existing squares, so the new number
of squares is: (squares_old)*(x+1)2 , where x is the number you enter.

46.2. Making the Mountain
In top view, select one of the points in the middle of the plane. With this point selected
change to side view. Press the O , which enables the ”Proportional Edit Falloﬀ” tool in the
Menu-Panel beneath the 3-D-Window. As seen in the previous tutorial Blender 3D: Noob
to Pro/Mountains Out Of Molehills1 when you move a vertex while edit falloﬀ is enabled,
all vertices in a deﬁned radius of the selected vertex will align with the selected vertex when
its position is altered. How they are adjusted can be chosen in the tab on the right of the
yellow dot. I propose using ”smooth falloﬀ”.

1

Chapter 45 on page 363
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Figure 273

Now grab the vertex with G . You will now see a gray circle. You can change its size with
the mouse wheel. Every vertex inside this radius will be aﬀected by the falloﬀ. Change the
size of the circle so almost the whole plane is in it.

Figure 274
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Now move the vertex a bit upwards, as seen in the picture. Optionally you can lock the
z-axis to make the volcano go straight up by pressing Z .

Figure 275

As you can see all the other vertices will shift upward. We could keep moving this vertex at
the same rate, but that would cause the plane itself to rise and bend, and that's not very
good. So press LMB to apply the changes, grab the same vertex a second time and repeat
the previous exercise as before, except now choose a smaller radius for the circle, about half
the diameter of the plane ( G → Z → scroll MMB ).
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Figure 276

Repeat this two or three more times and you will get something like this:

Figure 277
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46.3. Forming the Crater
Now we're going to create the ”hole” on the volcano. First change the falloﬀ to ”root”. Grab
the vertex one more time, change the size of the circle so it's more or less as seen in the
picture.

Figure 278

Grab this vertex down a bit, apply, grab it one more time with a smaller circle. You now
should have something like this:
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Figure 279

Just leave the border jagged and just smooth (Subdivision Surface) the whole volcano cause
it is much more realistic. Go to Object mode, select the volcano, go to the ”Modiﬁer” menu
in the ”Properties” Header and just click on ”Add Modiﬁer” -> Subdivision surface (you can
leave ”view” on 1). Do not apply these settings yet.
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Figure 280

First we'll do a test-render. Still in ”Object mode” Delete the default Lamp point with ”X”
or ”Delete” and place your 3D cursor behind the camera and press SHIFT + A -> ”Lamp”
-> ”Point”. With the Lamp Point still selected Click on The Lamp point Properties (”Data”)
in the ”Properties” Header then change ”Energy” to ”10”. Press F12 to enter Render, after
adjusting the camera.
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Figure 281

46.4. Finishing the crater
You can very easily make a nice looking crater. Just go into ”Edit Mode”, touch ”Num1”.
Make sure ”limit selection to visible” is oﬀ and ”proportional editing” is on and set it to
”sharp” falloﬀ. Select about the upper vertices with ”border select” (Press ”B key”).

382

Finishing the crater

Figure 282

After that, scale (press ”S key”) it 'till it's a nice crater with a circle as large as mine.
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Figure 283

And that's it, you just created a nicer looking crater.
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Figure 284

385

Modeling a Volcano

Figure 285

46.5. Adding Magma
Let's add some ”magma” using lighting.
1.
2.
3.
4.
5.

Make sure you're in ”Object Mode”
Press SHIFT + S and choose Cursor to Center.
Press SHIFT + A and choose Lamp → Point.
In the Properties window, click the Data tab.
In the colour box (white by default) in the Lamp section, change the color to reddishorange. (Red: 1, Green: 0.1, Blue: 0)
6. Set the Energy to around 7.
7. Raise the light until it's just above the bottom of the crater ( G rab along the Z
axis).
8. If the ground level of your plane is reﬂecting light from the lava lamp this is because
the bottom of your crater is above ground level of the plane you created; you'll need
to turn on ray-tracing. in the object data menu for the light, open the Shadow menu
and click ”Ray Shadow”
• Alternate 1: Spot Lamp
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1. Change the light's type to Spot.
2. Raise the light until it's covering most of the crater. If the light is not pointing down,
R otate and angle it downwards.You can also scale the radius of the light by press
S to ﬁt the rim of the crater.
• Alternate 2: Area Lamp
1. Change the light's type to Area.
2. R otate along the Y axis: 180 degrees.
3. Set Gamma to 2.
4. Set Distance to around 5.
Experiment with the values and positioning to get something that works with your volcano.
It should now look like this:

Figure 286

46.6. Varying the Terrain
Next, let's set the volcano's material.
1. RMB on the volcano plane.
2. Select the ”Material” button
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Figure 287

3.
4.
5.
6.

and press New.
Change the Diﬀuse color to ashen gray. (Red: 0.260, Green: 0.230, Blue: 0.230)
Select the ”Texture” button and press New.
Change the Type to Stucci.
In the Inﬂuence panel, uncheck Color, and check Normal. Set the Normal slider to
0.5. This will render the texture as a bump-map.

(Note: In version 2.77 you may need to change the texture Mapping -> Coordinates option
from UV to Generated before you see bumps appear.)
(Note: In version 2.78c you may need to change the texture Mapping -> Coordinates option
from UV to Global or Object before you see bumps appear.)
Older versions:
Select the volcano and press F5. Keep Pressing F5 until the Materials Buttons (symbolized
by a red ball) is highlighted. Then add a new material. You do this by clicking the Add
New button in the Links and Pipeline Panel. Once you've done that, set the settings similar
to the picture below. Now press F6, then add a new texture to the material. Choose a
stucci texture, set the noise size to 0.15. Now switch back to the materials-window (F5)
and click on the ”map to” tab. Deselect the ”col” button and select the ”nor” button. This
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will render the texture as a bump-map on the volcano. Set the ”nor slider” to 0.5, which
should be the default. Switch to the ”map input” tab and choose ”tube”.

Figure 288

If you now render you should get something like this:

Figure 289

This looks really smooth, like clay pottery. To get a more rough-looking volcano, try out
these options:
• Option 1: Subdivide and increase the fractal. 5 should do the trick.
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Figure 290

• Option 2: Decrease the texture's basis size (in the ”Stucci” panel when you select the
”Texture” button).
• Option 3: Proportional edit tool.
1. Press O to turn on Proportional Editing mode. Select Random fallout.
2. G rab the center vertex, and raise it along the Z axis.
Older versions:
Go into Edit mode, select all Vertices, and use the fractal (set from 15 to 30) to really get
things looking rocky and mountainous. TAB (Edit mode) → F9 → AKEY to select all
→ Mesh Tools → Fractal → 15 - 30 (15-low, 30-high) → OK → TAB (Object mode) In
Blender 2.5 you can use the random proportional edit tool: use NUM7 to switch into top
view, grab the central vertex of your volcano using a large-radius random proportional edit,
and pull it slightly into Z-direction.
(A note: Seems there is no need in subsurf at all since fractal tool will dramatically increase
vertex quantity.)
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47. Penguins from Spheres
i Information
Applicable Blender version: 2.75
Note: Some Pictures are outdated.

47.1. Setup
Start with the default scene1 : it should contain a selected cube. Delete this cube by pressing
X → Delete.

1

https://en.wikibooks.org/wiki/Blender_3D%3A_Noob_to_Pro%2FBeginning%20Tips
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Figure 291

Put the 3D cursor at the scene center by pressing SHIFT + C .
Note: after deleting the cube you must be inObject Mode. If not, Press CTRL-Z and
switch with TAB and redo the operation.
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47.2. Creating the body

Figure 292

Z-scaled sphere

Noob note: to ensure that you don't become confused, make sure that your viewport is
set up in the same direction you see in these pictures. The colored arrows are red, green,
and blue and they control the x, y, and z axes, respectively.)
• We start by creating our main body from a sphere. Press
UVSphere, then choose 16 segments and 16 rings.

SHIFT

+ A

→ Mesh →

We're going to make it look like a penguin body:
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•
•
•
•
•

Press TAB to enter Edit mode
press NUM1 to switch to the front view,
with all the vertices selected (if not, A ), choose the scale tool ( S ),
restrict scaling to the Z-axis ( Z ),
and move the mouse away from the 3D cursor while holding down the CTRL key (this
snaps the scale values to whole numbers),
• Note: Make sure the mouse cursor is not too far away from the sphere when hitting
the S or else you may not be able to reach a 2.000 scale value. The scaling steps are
proportional to the distance from the 3D cursor when calling the scale tool.
• the current scale shows in the lower left corner of the viewport, click when you've reached
2.000 LMB ).
• Note: You can also do this by typing in 2 after starting the scale and restricting
movement to the Z-axis: S -> Z -> 2
This is our main body!

47.3. Shaping the head
We’re going to shape the penguin head from the top of the sphere.

Figure 293

Start by selecting the top-most single vertex as well as the top two smallest circle segments.
Note: Selection has been explained in a previous tutorial2 . Here, the easiest methods are
either box selection B ) in the front view NUM1 ) andLimit selection to visible oﬀ, or
lasso selection ( CTRL + LMB ) in the top view ( NUM7 ) andLimit selection to visible on.
You can also switch to top view, center your mouse on the topmost vertex and use the
circle tool. Don't forget to deselect all ﬁrst ( A )
Noob note: You can also select the top vertex and press CTRL + NUM+ twice to select
the circle segments.
Noob note: Make sure the Limit selection to visible/Occlude background geometry button
is in the right state each time you select vertices, edges or faces. When it's oﬀ, selection
aﬀects any item, visible or not.

47.3.1. Building the neck with the 3D transform manipulators
To turn on the 3D transform manipulator, either push down its button

2
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Shaping the head

Figure 294

or use CTRL + SPACE and choose Enable/Disable.
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Moving the two selected circles up

Figure 295

Go to the front view ( NUM1 ). Drag the blue arrow while holding the CTRL key down
to move the selected vertices 0.3 units up.
Noob note: you may not be able to snap the extrusion lengths to tenths of units. CTRL
snaps to the grid size by default: if you can only translate by one unit (1.0), zoom in until
the grid divides itself into tenths (SCROLL). Some Blender versions allow to snap to one
tenth of the current step by holding both the SHIFT and CTRL keys while moving the
mouse.
Noob note: instead of the Transform manipulator, you can use the G
the movement to the Z axis ( Z ).
Rotating the neck

Figure 296
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Now switch to the side view ( NUM3 ) and make sure that the rotation/pivot point is set
to ”median point” either by selecting it from the third drop down menu right of the ”Mesh”
menu, or by pressing CTRL + , . Choose the Rotate tool ( R ). Move the mouse with
the CTRL key down to rotate the selection 30 degrees counter-clockwise. Use LMB to
validate the rotation.

Figure 297

Select an additional ring of vertices by expanding the selection ( CTRL + NUM+
(Note:NUM+ Refers to the addition symbol on the NUM Pad,KEY+ will not do.). You
can contract the selection by pressing CTRL + NUM- . Move these vertices an additional
0.3 units up, then rotate them as previously 30 degrees counter-clockwise in the side view.

Figure 298
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Repeat those steps (selection expansion, translation and rotation) two more times and you'll
end up with the body seen in the below.
That doesn’t really look like a penguin, yet!

Figure 299

Now move all of the selected vertices to the left 0.4 units by pulling the manipulator's green
arrow (and of course holding the CTRL key down). This straightens out the neck as seen
in the next picture.
Noob note: you can also use the G and translate the selection by -0.4 as displayed in
the bottom left corner of the viewport. Still do this in the side view ( NUM3 ).
Noob note if you had to pull the red arrow, not the green one, then you probably didn't
switch to side view, and modeled the neck in front view. If you realize here that you
have this done from another view then press AKEY twice, then NUM7, then Space ->
Transform -> Rotate and type 90 or 270
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Creating the beak

Figure 300

Switch to the front view ( NUM1 ), and select the frontmost vertex (the one that originally
was the top vertex of the sphere) with the RMB . Then switch to the side view ( NUM3
) and translate this vertex to the left by 1.2 units using the manipulator's green arrow or
the translate tool.
Note: some Blender versions allow moving the vertices from the keyboard with the
following sequence: G , Y , -1.2, ENTER .
The main body of the penguin is now ﬁnished. The next step is to create some ﬂappers for
the poor little guy.

47.4. Extruding the wings
We are going to create the wings by extruding faces on each side of the penguin.
Noob Note: You can rotate the whole object by pressing A to select all of its vertex and
then rotate it pressing R or using the Rotate Manipulator until the axis on your screen
matches the axis on the example image. That way, also, you can practice a little more
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Figure 301

Choose the side view ( NUM3 ) and switch to the Face select mode ( CTRL + TAB
Faces, or click on the orange-sided cube icon in the toolbar).
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Extruding the wings

Figure 302

Now, select two faces that will make up the penguin’s shoulder as shown on the right (either
select the ﬁrst one with RMB and the second one holding SHIFT , or use box selection (
B ) to select them both in a single operation).

Figure 303

Wing extrusion

Then switch to front view ( NUM1 ) and extrude the selection:
• choose E

→ Region,
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• constrain to the X axis ( X ),
• hold CTRL to snap,
• and move the mouse to extrude the shoulder by 0.2 to 0.3 units.

Figure 304

Bottom face selection

We'll now extrude the bottom face of this new extrusion. Rotate the view to show it with:
• a MMB drag,
• or several presses on NUM2 ,
• or CTRL + NUM7 (bottom view).
Press the A to deselect all, and select the bottom face ( RMB ), switch to front view (
NUM1 ), extrude by 1.4 units down ( E and CTRL ).
Now do the same on the penguin's other side: use CTRL + NUM3
(you can also rotate with MMB , or press NUM4 several times).

to view the left side

47.5. Smoothing the wings
We’re going to smooth out the shoulders and improve the wings. Though this can be done
in many ways, we'll only use the merge tool.

Figure 305

Rotate your penguin so that you can see one shoulder from above. Then switch to Vertex
select mode ( CTRL + TAB → Vertices). Press A to deselect all, then select the two
shoulder vertices with RMB and SHIFT .
Press ALT + M , choose At Center from the popup in order to merge the two vertices at
their center. Finally dismiss the message saying Removed 1 Vertices.

402

Smoothing the wings

Figure 306

Edges to smooth

Repeat the steps with the two other vertex pairs shown on the right picture, and smooth
the other wing. I’m leaving the middle segments for now, else the wing tips will be too
pointy.
Note: if you have troubles merging vertices, it comes from vertex duplicates in your mesh.
You probably choseIndividual Faces instead ofRegion when extruding the wings, which creates duplicate vertices and neighbouring faces. To clean up your model: select all vertices
( A ) and choose W →Remove Doubles.
You must do them one by one!
Or, Alternatively, change into Edge select mode ( CTRL + TAB → Edge), select the edges
to smooth ( CTRL + LMB ), press ALT + M , choose Collapse
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Figure 307

Finish oﬀ the wings by selecting the two backmost vertices of the wings, and moving them
up using the blue arrow by 0.1 unit.
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Figure 308

Wings complete

You should now have something like this:

47.6. Cutting the underside

Figure 309
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Figure 310

We're going to cut the penguin's lower end, for it to stand up! Select the bottom vertices
(bottom vertex and the ﬁrst ring above it) as shown in the picture. There are many ways,
this is left as an exercise.
Once they're selected, delete them ( X → Vertices). Now our penguin is hollow: select all
the vertices around the hole, and ﬁll it using ALT + F .
Noob note: To quickly select all the vertices around the hole, you can enter edge mode
CTRL + TAB -> ”Edges”, and then select one edge that goes around the hole. Now press
CTRL+E -> ”Edge Loop Select”, which should select all edges around the hole. Now go
back to Vertex select mode and continue with ALT + F .
Noob note: For Blender 2.56 In vertex select mode and occlude on hold down ALT and
select one of the vertices all the vertices in the ring will be selected.
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47.7. Adding the feet

Figure 311

The next step is to provide the little guy with feet. To do this, we’re going to extrude two
of the front faces:
•
•
•
•

choose the front view ( NUM1 ),
switch to Face select mode,
turn on Limit selection to visible,
and select the face to the left and right of the middle two faces of the penguin.

407

Penguins from Spheres

Figure 312

Then switch to the side view ( NUM3 ) and extrude the selection by -0.6 units ( E
Region, restrict to the Y axis: Y ).

→

Figure 313

Keep the selection and look for the Mesh Tools in the Tool Shelf. If you can’t see it, press
T to make the Tool Shelf visible. Then click on the Subdivide button (under Add in the
Tools tab). Or press W and choose Subdivide.
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Figure 314

Switch to ”Vertex Select Mode”, Now select the three middle vertices (or two edges) vertically
at the tip of each foot, and drag them along the Y axis by 0.3 units towards the penguin
Note: if something goes wrong here, you may need to remove double ﬁrst. As always, to
move the vertices, either use the manipulator or G and Y sequence.

Figure 315

You should end up with what's shown in the right picture (minus the selection).

Figure 316

The feet look too thick, let's ﬂatten them a bit. Switch to the front view ( NUM1 ) and
select the two bottom vertex rows (Limit selection to visible oﬀ, use either the lasso or box
selection).
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Figure 317

Then choose the scale tool ( S ), limit its action to the Z axis ( Z ) and scale down by a
factor of 0.4.
The feet still look rather peculiar, so please go ahead and move the vertices around on your
own as you like.
Reminder: you can use the G and restrict movements to the X or Y axis using the X
or Y . Try not to move vertices along the Z axis to keep the penguin's bottom ﬂat.

47.8. Extruding a tail

Figure 318

Figure 319

Figure 320

To complete the penguin, we have to add a tail (the end of the tuxedo):
• go to the back view ( CTRL + NUM1 ),
• make sure you're still in Vertex select mode,
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• and that Limit selection to visible/Occlude background geometry is on.
Select the three middle vertices in the second row up from the bottom. Then, switch to the
side view ( NUM3 ) and extrude the edges 0.3 units away from the penguin and 0.08 units
down ( E → Edges), so that the end of the tail is at the same level as the bottom of the
penguin.
Noob Note: Or you can extrude the edges 0.3 units away from the penguin, then G
-0.08, LMB or ENTER .
Press CTRL + S

Z

to save your work!
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47.9. Subsurﬁng

Figure 321 Now that's what I call a penguin. But then again, there are no penguins
where I live, so I might be wrong.

Go to Object Mode ( TAB ), and make sure the penguin is selected. Then check for the
Modiﬁers toolkit in the Buttons panel. Press Add Modiﬁer → Subsurf (or Press SHIFT +
O ).
Look at the penguin now, he’s much smoother. You can alter the levels of the subsurﬁng if
you like, but I’ll settle for level one. Under the Links and Materials toolkit, you can press
the Set Smooth button as well, which makes the penguin really slick.
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Note: you may see some weird eﬀects at the bottom and the tail after subsurﬁng the
penguin. If so, there is an issue with normals: they have to be all pointing outwards. This
can be achieved by selecting all vertices inEdit Mode and recalculating the normals outside
( CTRL + N ). Click on the message to conﬁrm. Note that CTRL + SHIFT + N will
turn the normals inwards and that W →Flip Normals ﬂips them.
Question: The ﬁnished penguin looks ﬁne in Object Mode, but when I render it, it looks
odd. Quite patchy.
Answer: Make sure you adjust the ”Render Levels” parameter (directly under ”Levels”) to
be greater-or-equal than ”Levels”.

47.10. Extra
The penguin can be colored or textured, but that will be part of later tutorials!

Figure 322 This is what the penguin
(sans tail) looks like, textured and ready.
Orbisonitruma
a

https://en.wikibooks.org/wiki/User%3AOrbisonitrum
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Figure 323 The eyes are there, just not
easily visible in the thumb. At the top of the
white part, two faces on the chest were
subdivided to give the white more of a curve
at the top. The faces were selected that were
going to be white, and the I used separate
(P) to make them a diﬀerent mesh. I used a
white material for the chest, black for the
body, and grey uvspheres for the eyes.
Apparently, an easier way to colour the chest
can be found at Multiple Materialsa please
feel free to replace this with your own image
of the penguin you made, with comments on
how you put your own style into it
a
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Figure 324 A pretty basic picture of a
penguin. I subdivided the stomach and eyes,
but then I also added some eyeballs by
making a UVSphere, cutting the top of it
oﬀ, and then placing it inside of my
penguin's head. All the colors have specular
colors, giving the penguin a slight blue glow
under the black.
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48. Dicing With Depth (Dice Modeling)
i Information
Applicable Blender version: 2.67

Figure 325
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Dice1 are objects which are familiar to us all, used in countless games. Here we will model
how to make a single die (or a single dice, if you prefer).
The end result should look something like at right. Notice the following features:
• diﬀerent colours for the pips versus the body of the die
• rounded edges and corners, while the faces are (mostly) ﬂat
• round, recessed pips.
Achieving all these eﬀects will be a good exercise of your mesh-modelling skills.

48.0.1. Characteristics of the Die

Figure 326

The number of pips on each face of a die ranges from 1 to 6. However, in order to space
them correctly, there needs to be 9 positions for a pip on each face, even though not all of
them will be ﬁlled on any face.

1
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Figure 327

We will also proportion our die so that the diameter of each pip will be twice the horizontal
or vertical distance between pips, even though if you look at the illustration the pips on the
ﬁnished die look smaller because they eventually do not occupy this full diameter. As you
will see, this makes it easy to get the proportions uniform with a relatively small number
of loop cuts.
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Figure 328

Also note one of the characteristics of real dice is that the number of pips on opposite sides
adds up to 7 as depicted in the Standard Die Layout.

48.1. The Basic Mesh
Open a new Blender document. Select RMB the default cube, and TAB into Edit mode.

420

The Basic Mesh

Figure 329

First of all, let’s apply a small amount of bevel to the corners and edges: with all the vertices
selected, press CTRL + B to start bevelling—not too much, press LMB when you see
something like at right.

421

Dicing With Depth (Dice Modeling)

Figure 330

The ﬁrst cut is the deepest

Now, we need to make a bunch of loop cuts to mark out the areas where the pips will
go. To simplify things, we will do cuts through the middle of each pip, as well as between
pips—a total of 9 loops each way—then go back and remove the unneeded cuts. That way
we get the 2:1 proportions correct with a minimum of eﬀort. Who says it doesn’t pay to
plan ahead?
To make a loop cut, press CTRL + R , then move the cursor over the edge you wish to
subdivide: you should see a single magenta loop appear. Now press 9KEY , and you should
see this change to 9 loops. Next, click LMB to change the lines to yellow and really start
cutting, then immediately press RMB to ﬁnish the cut without moving the cuts from their
initial positions.
You will need to do this 3 times, between the 3 pairs of opposing faces.
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Figure 331

First loop to remove selected
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Figure 332

First loop gone

Now look at each face of your cube: you will see an 11×11 grid of vertices, with the corner
vertices each adjoining a triangle at the corner. Make sure nothing is initially selected.
Count the third vertex in from a corner, and move the mouse slightly so it is over the edge
leading from this vertex into the interior of the face, just to avoid confusion; now SHIFT
+ ALT + RMB , and you should select a loop like at right.
If you get the wrong selection, just A to clear it, and try again. Remember to click over
an edge that is running the right way, rather than a vertex, otherwise Blender is liable to
select a loop running the wrong way.
Press DEL or X , and in the deletion menu that appears, select “Edge Loops”. The
selected loop should disappear.
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Figure 333

Middle loop selected
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Figure 334

Middle loop gone

Going in from the edge of the face, skip over one loop, and remove the middle one.
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Figure 335

Third loop selected
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Figure 336

Third loop gone

Then ﬁnally remove the third one in from the opposite edge.
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Figure 337

You need to do this deletion of loops on every face that has the original 11 X 11 grid of
vertices. When you are ﬁnished, the resulting mesh should look like at right.
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48.2. Making the Pips

Figure 338

Now we will hollow out the spots or pips. The idea is to extrude selected ones of the large
squares on each face inwards into the cube (“intrude” rather than “extrude”, perhaps?), then
split the bottom of each resulting pit into four triangles each by adding an extra vertex in
the middle; then pushing in this vertex will give us the hollow for the pip (as at right).
We will show three methods for doing this.
Do this individually for each face that is to be made into a pip.
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48.2.1. Method 1 (Slowest)
Select all the large squares to be made into pips (perhaps do one entire face at a time).
Press CTRL + T to triangulate these faces. Now switch to edge-select mode, and select
the new diagonal edge that has appeared in the middle of the original squares; bring up
CTRL + E for edge Specials and select Subdivide (leave the number of subdivisions at
the default 1). Things won’t look any diﬀerent, but each triangle is now a quad, with an
extra vertex added to the middle of each of those diagonals.
Now switch back to face-select mode, select those subdivided halves of all the squares, and
CTRL + T to triangulate again.

48.2.2. Method 2 (Faster)
Switch to face-select mode. Select all the large squares to be made into pips (perhaps do
one entire face at a time). Do E to extrude, and immediately press ESC to leave the
new extruded vertices in the same positions as the old ones; now do ALT + M to merge
and select the “Collapse” option.

48.2.3. Method 3 (Fastest)
Select the relevant large squares on each side to make the required numbers for each face
of a real die. From CTRL + F for face Specials, select “Poke Faces” (or more directly, do
ALT + P ). Leave the settings at their defaults (in particular, leave the Poke Oﬀset at 0).

48.2.4. Digging The Holes
Now that you have crossed the faces of your pips, select the middle vertices one side at a
time, and G rab inwards by a distance of 0.17 (make sure you do it at the appropriate
axis, pres Z , X , Y ) along the appropriate axis.
Noob Note: Do this side after side, otherwise you will translate all your vertices to one
side and not all inside.
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48.3. Rounding Things Oﬀ

Figure 339

Now apply a subsurf modiﬁer and set the shading to smooth, the result should look something like this.
The trouble is, the pips look too much like dimples rather than proper holes. To ﬁx this,
we can apply a crease to sharpen up the edges.
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Figure 340

In edge-select mode, select the four edges around the opening of each pip. Press SHIFT +
E , and move the mouse until the edges take on the darkest magenta tint. That should
ﬁrm up the edges of the holes a bit.

48.4. Colouring Your Die
First, go to the Materials Context
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Figure 341

and set up the colour for the main part of the die (say, make it red as in the illustration
above). This can be done in Object or Edit modes.
Next, click the “+” button to add a second, initially empty, material slot, then click the
“+New” button that appears below it to create a new material for this slot. Make this
material white, for the pips. Then, select the pips themselves, and use the “Assign” button
to colour them with this material as detailed below.

48.4.1. Quickly Selecting The Pips, Method 1
Go to the Select menu, and select the option “Select Faces by Sides”. A panel will appear
at the bottom of the Tool Shelf (use T to toggle the visibility of this), with a ﬁeld titled
“Number of Vertices”, initially showing 4; change this to 3, and it should select all the
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triangles, which includes the pips as well as the corners of the cube. You can deselect the
latter one by one by SHIFT + RMB ing them.

48.4.2. Quickly Selecting The Pips, Method 2
Alternatively, you can do just select the faces of each pip.

48.4.3. Quickly Selecting The Pips, Method 3 (Fastest)
(Works in blender 2.6, not sure about earlier versions.) In face select mode select one of the
triangular faces of one the pips. Hit space and type ”select similar” then choose ”area.” If
this selects too many faces along the edge of the die, cancel and try again with ”perimeter.”
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49. Model a Goblet
i Information
Applicable Blender version: 2.75
Why a goblet? After all, goblets (fancy containers for consumable liquids) are not really all
that important in the real world. However, they represent a very large class of interesting
objects: those that are radially symmetric. Also, they are fun to play with.
To model a goblet and actually see the result, we do the following steps:
•
•
•
•

create the actual mesh of the object.
apply a material to the object.
create and light a scene to display the goblet
render the scene.

The following tutorials demonstrate three diﬀerent approaches to creating the mesh model,
and then show two diﬀerent materials (glass and silver) that may be applied to the goblet.
Finally, we add the minimal elements to the scene to permit an ”interesting” rendering.

49.1. Three ways to build the mesh
As a beginner, you may wonder why we describe three diﬀerent ways to build the mesh.
After all, surely the Pros know of a ”best” method?! The answer is that there is not really
a best method. Blender provides a sophisticated toolkit, and diﬀerent blender artists will
become familiar with diﬀerent tools. If, after you gain experience, you become comfortable
with cube extrusion, then this may become your preferred tool. If you need more than
four vertices per ”circle” you may ﬁnd that cylinder extrusion is better for some particular
object. If you are comfortable with ”spinning” an object, then spinning may be right for
you. All three techniques generate an object that is deﬁned by a set of vertices on a set of
circles that are ”stacked” on a common axis.
After we build the mesh using one of the three methods, we can apply any number of fancy
techniques for texture and rendering. We provide two simple ”cookbook” approaches in this
section so you can see the result, but materials are treated much more extensively in other
sections of the book.
In the next three sections of the book we describe the ”cube extrusion” approach, the
”cylinder” approach, and the ”spin” approach. Following sections describe three textures
that can be applied to objects that are created with any of the approaches, and the ﬁnal
tutorial provides a simple way to render the result.
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The ”cube extrusion” approach is a basic technique that all blender artists will become
familiar with, to model most types of objects. Since it is such a basic technique, it may
become the most eﬃcient way for you to create objects, and you may choose to use it
wherever possible rather than switching to a less familiar technique. You can see from the
tutorial that this technique is perfectly acceptable for goblets, and by extension it will work
for similar objects.
You may prefer the ”cylinder extrusion” technique when you need more than four vertices per
circle, because cylinder extrusion is very similar to cube extrusion. Thus your proﬁciency
with cube extrusion will directly carry over to cylinder extrusion.
”Spinning” is conceptually diﬀerent, even though it creates the same mesh as cylinder extrusion. Spinning is the easiest way to create a radially symmetric model from a twodimensional description of the cross-section of an object.

49.2. How many circles?

Figure 342
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How many circles?

Figure 343

Each of the three methods deﬁnes a set of stacked circles, with vertices equidistant around
each circle. The ”cube extrusion” technique has four vertices on each circle, while the
cylinder and spin techniques have a user-speciﬁed number of vertices per circle. But how
did we pick the number of circles and the spacing between them?
The answer is that we know in advance that we intend to use a technique called ”subsurf”. Subsurf interpolates additional vertices between those we explicitly specify, and this
”smooths out” the proﬁle of our goblet.
This will cause problems where we need a fairly sharp ”bend” in the proﬁle, as between
the base and the stem and between the stem and the ”bulb” of the goblet. At each point
in the proﬁle that has a (fairly) sharp bend, we need for the vertical circles to be close
to each other. The two images illustrate this eﬀect. Each image shows an outline of the
object, the spun object, and the result after subsurf (level 2) has been applied. The outlines
and the spun images are nearly identical, but the subsurfed result is very diﬀerent, because
there are three extra vertices in the second outline: one just above the bottom of the base,
one at the top of the base, and one below the bulb: these are the three locations where
we need relatively sharp changes in contour. When we spin the outline, the ﬁrst outline
generates seven circles and two degenerate circles, while the second outline generates ten
circles and two degenerate circles. Those extra three circles make all the diﬀerence. The
same phenomenon occurs with the other two modelling techniques.
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i Information
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50.1. Basic Shape

Figure 344

At ﬁrst glance, the goblet looks like it is composed of cylinders. However, while it is possible
to model the goblet with a cylinder mesh, it is easier to make a goblet by using cubes. Cubes
make the goblet faster to make and it makes fewer vertices to track. Now, lets start making
the basic shape of the goblet.
Start with the default cube and go to Edit Mode ( TAB ). Toggle oﬀ ”limit selection to
visible”. Move to the side view ( NUM3 ). Toggle to ortho view. Box select ( B ) the
top edges of the cube. Extrude ( E ) upward about one grid square. Hold down CTRL
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while extruding for incremental movement; by default movement should be restricted to the
Z-axis (normal to the selection); if necessary, press Z to toggle this eﬀect. This extrusion
is called E1. Repeat 2 more times for extrusion 2 and 3 (E2 and E3).
Now Extrude a longer piece upwards, for the Goblet's stem, of 10 grid squares (E4). Next
we will deﬁne the area for the 2 top knobs and the bottom of the glass by Extruding upwards
5 more times at 1 grid square each (E5-E9). Next do another upward Extrusion of about
10 grid squares (E10). This is the actual glass itself.

50.1.1. Inﬂate the Glass

Figure 345

Sizing the ﬁrst knob

Now, let's begin to inﬂate the glass. First, clear all selections by hitting the A . Make
sure you are still in the side view ( NUM3 ). Box select ( B ) the bottom most cube (all 8
vertices, not just the bottom 4). Then expand it outward by scaling ( S ), then pressing
SHIFT + Z to lock/prevent any scaling in height along the Z-axis and ﬁnally pressing 4
to quadruple its size. Next, deselect all vertices ( A ), select ( B ) the 4th pair of vertices
(E2), scale them ( S ), lock scaling ( SHIFT + Z ) and triple the vertices in size ( S
and 3 ).
Do the same for E5 and E7 (the 7th and 9th pairs of vertices, respectively). Then expand (
S and SHIFT + Z ) the top, Goblet rectangle (E9 and E10) to 6 times its current size
( 6 ).
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50.1.2. Make the cup's interior

Figure 346
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Figure 347

Last is the cup's interior. Once again, you should still be in the side view ( NUM3 ). Box
select ( B ) the very top most vertices of the Goblet (E10). Once selected, get a better view
by changing to 'Orbit Up' ( NUM8 ). With the top surface selected, initiate an Extrusion
( E ), followed by a termination with the ESCAPE . It will appear as if nothing has
happened, but new, overlapping edges have been created and are now selected (this also
creates E11). Next Scale ( S ) the selected vertices to 90% of the original size ( .9 ).
This creates the inside lip of the cup. Now, Extrude ( E ) the interior lip, along the Z-axis
downward ( -10 ) to create the bottom interior of the Goblet (E12). Finish oﬀ by selecting
all, and then a 'Remove Doubles' ( W → Remove Doubles), for good measure. It should
look something like this.
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50.2. Smoothing and Deﬁning
Time to take the mesh and turn it into a proper goblet. Add a subsurf modiﬁer with 3 view
subdivisions to the mesh. Change to Object Mode ( TAB ) and select smooth shading. The
cube-looking mesh will now look like an object that was created from a cylinder. This has
removed all our crisp edges, but our globlet is looking very unstable! Let's rectify things by
ﬂattening the bottom.
Noob Note: If your goblet has a bulge in it after applying the subsurf, go to Edit mode (
TAB ), select all ( A ), press W , and select ”Remove doubles”. (If a menu for boolean
operations appears when you hit the W , then you're not in Edit mode; change immediately
to Edit mode and try the W again.)
Select the four edges that surround the small circle at the very bottom (the very lowest set
of edges) and press SHIFT + E to enable creasing. Now drag the mouse up and down
to select the level of the crease. When you're satisﬁed, hit LMB . Repeat the process
for other edges you want to be sharp. I've turned on Draw Creases under Mesh Tools 1 to
illustrate which edges have been creased (highlighted yellow) in this example.
That concludes the creation of the goblet. Save the scene for use in the lighting tutorial.
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Figure 348

Applied subsurf modiﬁer

447

Model a Silver Goblet

Figure 349

Crease edges

50.3. Quick links for the impatient
To jump to the relevant lighting section, go to Blender 3D: Noob to Pro/Light a Silver
Goblet1 .

1
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Quick links for the impatient
What about applying glass look already? Take a sneak peek at Blender 3D: Noob to
Pro/Spin a goblet#Material2 .

2

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FSpin%20a%20goblet%
23Material
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51. Model a Silver Goblet Another Way
i Information
Applicable Blender version: 2.75

51.1. Preliminaries
This is a version of ”Model a Silver Goblet” but starting from a cylinder rather than a cube.
Start Blender or start a new scene ( CTRL + X ) and delete the default cube.
Change to Top view ( NUM7 ), make sure you're in Object mode and add a cylinder (
SHIFT + A Mesh > Cylinder): in the popup menu, change the number of vertices from
32 to 16, the Radius from 1.000 to 1.800, the Depth from 2.000 to 0.100 and leave ”Cap
Ends” as it is.
Change to Front view ( NUM1 ).

51.2. Description of the modeling steps
The steps in this tutorial are almost all made up of ”extrude” and ”scale”: so, to avoid
repeating key sequences every time,
extrude
means
1. make sure ”Limit selection to visible” is oﬀ

Figure 350

Shows ”Limit selection to visible” icon

2. box select the top vertices of the cylinder: press B , click and drag LMB to make
a rectangle around the top vertices
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3. press E , press Z and type in the amount of the extrusion and press ENTER ;
you can move the mouse instead but it is quicker and easier to type it in.
For example, the following keystroke sequence extrudes by 1.5:
, click and drag LMB to make a rectangle around the top vertices; E
ENTER .

B
5

Z

1

.

scale
scaling is by default restricted to the X-Y plane; although the numbers in the bottom left
corner of the 3Dview show Z changing, in fact only X and Y change, and by equal amounts.
1. press S , type in the value and press ENTER — you can use the mouse instead
but it is quicker and easier to type in the number.
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51.3. Creating the Goblet

Figure 351

E-numbers and construction steps

This diagram shows the connection between the E-numbers and the goblet construction.
• E1: Deselect all vertices ( A ), Box-select the top vertices (B-key), and extrude by 0.2:
you may need to zoom in ( SCROLL ) to do this as it's quite thin. Scale to 0.1.
• E2: Extrude by 0.2, scale by 2.
• E3: Extrude by 0.2, scale by 0.5 to make the lower knob.
• E4: Extrude by 4 to make the stem.
• E5: Extrude by 0.2, scale by 2.
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•
•
•
•

E6: Extrude by 0.2, scale by 0.5 to make the upper knob.
E7: Extrude by 0.2, scale by 8 to make the base of the cup.
E8: Extrude by 4, if you wish to make a ﬂared cup, you can scale by 1.5.
E9: Extrude by 0.0, scale by 0.9 to make the rim of the cup. (This will create a new ring
of vertices and then move them in towards the centre.)
Now go into Wireframe mode ( Z ) so you can see inside to guide the next few steps.
• E10: Extrude by -3.9, that is, downwards. and scale by 0.69: you can do this last scaling
with the mouse, if you like, to get the edges of the inside of the cup and the outside
parallel.
• E11: Extrude by 0.0, scale by 0.0 to make the inside of the cup. Press W Remove
Doubles to merge the centre vertexes.
You now have a goblet, the base of the inside of the cup is the face of the last extrusion, is
circular and ﬂat as it derives from a cylinder.
If you haven't already saved your work-in-progress, now would be a good time.

51.4. Subsurﬁng and smoothing the goblet
The last step is to subsurf and smooth: go into Object mode and enable Solid mode again
( Z ).
Select the Editing panel from the Buttons window ( F9 ) and, in the ”Modiﬁers” panel, click
on ”Add Modiﬁer”, select ”Subdivision Surface” from the popup menu and, in the Subsurf
display, increase ”View subdivisions” from 1 to 2.

Figure 352

Shows the Editing panel icon and the Modiﬁer panel

At the bottom right of the ”Links and Materials” panel, click on the ”Shading: Smooth”
button. At the bottom of the cup you will see ﬂuting — this is an artifact caused by
smoothing and subsurﬁng triangles on a curved surface. Here it adds to the appearance,
don't you think?
In Blender v2.78, the ”Smooth” button is located in the ”Tools” menu under the ”Edit” tab.
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Flattening the base of the goblet

Figure 353

Tools shading

51.5. Flattening the base of the goblet
The base of the goblet is curved due to the subsurﬁng, so needs to be ﬂattened.
Go into Edit mode, deselect all, box-select the lowest set of vertices, then crease (remove
ENTER .
the subsurﬁng) by pressing SHIFT + E then 1
The ﬁnal result should look something like this:

Figure 354
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Figure 355

Save the scene for use in the lighting tutorial. To jump to the relevant lighting section, go
to Blender 3D: Noob to Pro/Light a Silver Goblet1

1
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52. Spin a goblet
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53. Light a Silver Goblet (Early look at
lighting)
i Information
Applicable Blender version: 2.75
Note that the images are outdated.

53.1. Techniques
You should know how to:
• Perform actions discussed previously in the tutorial.
This section will recap or introduce:
• Reﬂective material
• Positioning camera and light
• Editing the World colors

53.2. Objects in the Scene
Create the goblet discussed in Model a Silver Goblet1 or load it if previously made. If you
haven't already made the goblet, feel free to try the tutorial using a sphere or something
else instead and you will still get a good outcome. In Object Mode with NUM 7 view,
add a plane mesh. Scale the plane to a very large size and make sure the goblet is sitting
comfortably on top of it.
Select the camera and move it so that the goblet, and its reﬂection in the plane will be seen
or else if you want. You can see the numerical location of the camera by bringing up the
Transform Properties window by pressing NKEY in the viewport. In my example where
0,0,0 is the bottom center of the goblet, the camera is located at 27, -21, 19 XYZ with a
rotation of 63.5, 0.62, 46.7.
Create a Sun with Shift+A → Lamp → Sun. And (in the lamp properties ”Object Data”)
set ”energy” to ”0.5”, and place it above the goblet. Move it at around 80 points on the
Z-axis. It is very important that you place the lamp on the right spot cause it will give your
1
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goblet anon 100 times more true to nature when you will give your goblet a silver texture.
You can try placing a point or another lamp but it's very diﬃcult to get an realistic image
then. If you choose a diﬀerent lamp click on the World button in the ”Properties” header
(the section where you can edit the sky). Check the Environmental Lighting box. Set
energy to ”0.800”.
The rendering of this scene yields:

Figure 356

Current render

Old Picture.

53.3. Adding the Atmosphere
In Object Mode, select the goblet and go to the ”Material Properties”. If no material is
linked to the goblet, add new material. Rename the material 'cup' or something similar.
The area of interest is the Mirror window. Highlighted below are the mirror options we'll
be playing with. Press the Mirror button to make the material act like a mirror and reﬂect
light.
Move the ”Reﬂectivity” slide to 0.85 or type it in after LMB on the number. This is how
reﬂective the surface will be. A low number of 0.00 means that it reﬂects little while a high
number of 1.00 reﬂects everything.
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Also change the Fresnel slide from 0.0 to 1.4. This will increase the power of the Fresnel
function. What this means is the color of the material will be strong because the light
source is taken into consideration. If the Fresnel wasn't used, the object would appear dark
because the light source isn't directly calculated in the mirror. Also, change the color of
the goblet to white. Using a light color will give your goblet an interesting patina if you so
choose.

Figure 357

No material linked

Figure 358

Make the goblet reﬂective

Next, select the plane and modify the material, add if it is not there. We want the plane
to be dark and shiny. Set Diﬀuse and Specular to near black for the color. For reﬂectivity,
turn on Mirror to about 0.15 Reﬂective and ignore Fresnel this time.

461

Light a Silver Goblet (Early look at lighting)

Figure 359

Edit the materials of the plane

There is only one more thing to do before rendering the scene: change the world. Under the
”Properties” Header is the ”World” panel. Here you have Paper Sky, Blend Sky, and Real
Sky buttons. There are also options for changing the color of the horizon (Horizon color),
zenith (Zenith color), and ambient (Ambient color). We're interested in these two windows
at the moment.
Using Real sky and Blend sky will aﬀect the way the horizon and zenith interact. Experiment
with them to see what they do in the preview. In this example, Real and Blend are turned
on.
The Paper button works a little diﬀerently in that what you see in the preview will essentially
be the background of your render. This eﬀect is most noticeable when your camera is
rotated. Despite the camera rotation, the preview would still be 'wallpapered' on the
render.
For our world, set the color close to black for the horizon, zenith, and ambient.

Figure 360

World shading

That was the last step! Make sure the camera is in the right spot and render the scene.
Here is the output of this example
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Figure 361

Final rendering

53.4. Creating a metallic texture for the goblet:
The metallic look can be achieved by these steps:
1. Materials > Diﬀuse. Set color Hex value to: C7C8CB or you can set it completely
black for dark metal. Set intensity to ”0.8”.
2. Materials > Specular. Set color to white(Hex: FFFFFF). Change Intensity to
”1.000”, left of the color-swatch, set the specular shader to CookTorr. Also change
the Hardness to value around ”16”.
3. Materials > Mirror.
Make sure the Mirror check-box is checked.
Set
Reﬂectivity to 1.000 and color to white(Hex: FFFFFF). Make sure that under
”Gloss” the ”Amount” is set to ”1.000”.
4. (not compulsory but it may be required) Use the texture from this earlier tutorial:
Procedural Wood Texture2 on the planes that are below and behind the goblet as in
the picture below. It will give you a much better contrast.

2

https://en.wikibooks.org/wiki/en.wikibooks.org%2Fwiki%2FBlender_3D%3A_Noob_to_Pro%
2FProcedural_Textures
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Figure 362

Notes:
Problem: When I render I see brown where I have used ”Shift-E” and ”G” and I followed
everything. Answer: Please remember, the author did say play with the settings a bit, this
tutorial should be used as a guide. We are learning how to use all the tools that Blender has
to oﬀer, that is the important thing. It is up to us to experiment more with the settings set
forth in these tutorials. If the settings in these tutorials do not give us the same results, that
is OK, we should be changing them anyway to express ourselves! Also remember, NEVER
strive for PERFECTION, but ALWAYS strive for EXCELLENCE. Perfection only leads
to frustration, and it is frustrating enough, at times, to learn something new. Have fun
learning, I know I am.
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Noob Question: I managed to get it looking like the ﬁrst picture above. How do I get it to
look like the second?
Pro Answer: Change the reﬂection settings. a higher depth and a larger raymir value will
make the goblet more ”mirror” like as in the 2nd picture. the other settings should be left
alone, or you can experiment with them to achieve the eﬀect that you want. lighting is also
important. the object that is to be reﬂected has to be illuminated as well as the object that
is doing the illuminating. Diﬀerent lights (don't use a hemi if you want it to be realistic)
at diﬀerent angles will give you a more realistic eﬀect.
Noob Note: On the answer above, I didn't manage to do it with any of the things the pro
said in the answer here, I found out that the key is to change the color of the material which
is white (or close to white) in the upper picture. In the lower picture the color is set to
black (or close to black). This eliminates the ”un-metallic” whitish sheen that the goblet in
the upper picture has.
Noob Note: I don't know about those using lower versions but those using v2.5x have a
choice of diﬀerent shaders both for diﬀuse and specular colours. I strongly suggest that for
the same object one should try playing around with the shaders. They can create diﬀerent
eﬀects. for eg. here if you change the diﬀuse shader type to oren-nayar and the specular
shader type to wardiso, the goblet will have a glossy , ﬁnished look.

Figure 363
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Figure 364
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54. Simple Vehicle

Figure 365

Let's make this jeep.

The idea of this tutorial is to learn to face a complex project. A vehicle is a nice object to
use to test yourself and ﬁnd new problems.
First, we must understand that a project does not reproduce the real world; a project shows
an idea or thought and will result in a ﬁnal image or video. Whatever does not appear in
the ﬁnal result is unnecessary to include in the model.
What vehicle should we make? Let's go with the classic jeep. This will allow for a lot of
doodads.
Let's decide what objects of the jeep model will need to be made - body, wheels, seats,
and a rocket launcher for good measure. Objects we can ignore include the engine, which
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remains hidden under the hood. There are many additional objects you can make such as
a steering wheel to customize your jeep.
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55. Simple Vehicle: Wheel
1. REDIRECT Blender 3D: Noob to Pro/Simple Vehicle: Wheel tutorial 11

1

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FSimple%20Vehicle%
3A%20Wheel%20tutorial%201
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56. Simple Vehicle: MudTires
1. REDIRECT Blender 3D: Noob to Pro/Simple Vehicle: Wheel tutorial 21

1

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FSimple%20Vehicle%
3A%20Wheel%20tutorial%202
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57. Simple Vehicle: Seat
i Information
Applicable Blender version: 2.75

57.1. Techniques
You should already know how to:
•
•
•
•
•

Make a mesh
Navigate the viewport
Extrusion
Subsurf
Crease edges

This section will recap and introduce:
• Loop Cut and Slide (Loop Subdivide)
• Small, consistent vertex movement
The design will be an all-terrain bucket-type seat.
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57.2. Extrude the Seat

Figure 366

Basic setup of shapes.

Start in NUM1 view of the default cube and rename it.
Extrude the cube multiple times to make your basic shape. In this example a 3x3x1 block
composes the body with one cube coming out the top for the headrest, and the bottom
cube's front faces extruded out to create the seat.
Noob Note: best practice is use ”Face” selection mode, select the face, or faces you want
to extrude with the RMB , then hit E , select an axis to move on by pressing the X ,
Y , or Z keys, and pull with CTRL held down.
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57.3. Add cushion seams

Figure 367

Multiple Loop Cut and Slide.

Noob Note: Before starting on this, you'll need to make sure you don't have any unnecessary faces inside the seat, or else you'll get strange cushion seams.
To add a little texture to the mesh, we'll add some cushion seams. Use Loop Cut and Slide
( CTRL + R and you'll see the pink selection loop. You can use the NUM+ key to
increase the number of loops made at the same time. Use mouse wheel or press NUM+ 3
times to form 4 loops and LMB the center column of blocks. You may also ﬁnd it easier
to add them one at a time in the correct place, than inserting them and then moving them.
(To get multiple Loops instead of pressing NUM+ just press the number of loops you want
in this case NUM4 , this is a fast easy way to achieve this.) You can use a mouse-wheel as
well. Finally pres ”Enter” 2 times.
Noob note: If the loop comes up with green lines rather than purple you have gone one
step too far, just press ESC and try again. When you see the purple lines use your MWH
or the NUM+ button.
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57.4. Position the cushion seams

Figure 368 Where the 3D cursor should
be placed and what to select

Go into ZX view ( NUM1 ) and make sure the view is orthographic ( NUM5 to activate/deactivate orthographic view). Place the 3D cursor on one of the sides of the head
rest ( LMB , or SHIFT + S to move cursor).
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Figure 369

Positioning the seams.

The idea is to move the 4 loop cuts just created away from center to the sides. Set the
pivot to 3D cursor and select the two closest loop cuts. Scale ( S ) it down on the X axis
( X ) to 0.3. The goal will be to have the loop closer to the cursor to go into the cushion
to become a seam. Now, do the same thing for the other side of the head rest.
Noob note: The easiest way to select the two closest loop cuts is to ﬁrst select ( RMB
, SHIFT + RMB ) one edge of each loop, and then go to Select Edge Loop ( SPACE ->
Select -> Edge Loop). Or hold down ALT when selecting one of the loop's edges. This
should select the entire loop. In order to select more than one loop, hold down SHIFT as
well.
Noob2 note: in Ortho view with 'Limit selection to visible' disabled, just box-selected
with one drag of the mouse.

57.5. Add Depth to the seams

Figure 370

Vertical seam creation.
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In overhead view ( NUM7 ), select the vertices in vertical parts of the two front facing
seams of the seat back, grab them ( G ), move only along the Y axis ( Y ), and type in -0.05

CMUNRM.TTF[PATH=/USR/SHARE/FONTS/TRUETYPE/CMU/,UPRIGHTFONT=CMUNRM,BOLDFONT=CMUNBX,ITALIC

.

Figure 371

Horizontal seam creation.

Switch to NUM3 view and move the vertices in the horizontal parts of the same two seams,
grab them and move them down by moving them -0.05 along the Z-axis.
Noob Note: I've found that an easier way to do this is selecting each loop of the seam one
by one and scaling to .95 (make sure the pivot is set to ”Bounding Box Center)
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57.6. Subsurf the seat

Figure 372

Subsurfed seat

Add a ”Subdivison Surface” Modiﬁer to the object. Hit in the Tool shelf: ”Smooth” under
”Shading” Not Necessary: Select the edges between the back and seat and crease (' SHIFT
+ E ) them. Crease any edges you feel like to create your perfect jeep seat. Noob note: it's
best to be in Edge select mode when creasing
A subsurf level of 2 or 3 looks best, and don't forget to change the render level to 3 or 4.
Select all ( A ) then either hit the ”Set Smooth” button at the bottom of links and materials,
or hit W and select ”Set Smooth” for a much smother subsurf.
Noob note: If your seat is noticeably misshapen after adding the subsurf modiﬁer, you
may just have to delete internal faces in your model. TAB into edit mode, and hit Z
to get into wireframe mode. Click the face select button and look for faces that are totally
inside the model. There will probably be a couple vertical faces (in YZ-plane) under the
seams in the seat. I found a few elsewhere, also. Deleting all these cleared everything up.
Noob note 2: Another way to remove the extra faces (which can cause the ”seams” to be
very deep) is to go into edit mode, select your whole seat ( A ), then hit ( W ) and select
”Remove doubles” from the menu. This is much quicker than ﬁnding them individually, and
should solve the problem.
Noob note 3: The problem may also be solved by going into edit mode, using A to
select all, and using SPACE > Edit > Normals > Recalculate Outside ( CTRL + N ).
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57.7. Resize the seat

Figure 373

Change the widths.

Next, resize the seat's height and width.
Note: Be sure to change the rotation/scaling pivot back to center point!
To make the whole seat narrower in width, select all A
X then type 0.8 and press ENTER .
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twice, then hit S , followed by

Final touches

Figure 374

To make the seat back a bit narrower in thickness, select around the seat back (in vertex
mode) with the circle select C . Once you have it completely selected on all of the sides,
hit S , lock axis with Y , and type 0.75, and hit ENTER .

57.8. Final touches
This ﬁnal seat renders to:
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Figure 375

Rendered seat.

57.8.1. Leathery look
To give the seams a leathery cord look, Hit A twice to select all, then W and choose
Subdivide Fractal on the popup menu (in 2.6x select Subdivide and then press F6 and
choose 1 for fractals); just keep the defaults and the seams will look like a bunch of vines
until you render it and they look like leather seams, and set in ”Material” in the ”Properties
header” diﬀuse color to deep black.
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Final touches

57.8.2. More concave

Figure 376

Making it concave.

Also the seat can also be made slightly more concave to look like it would hold a person
better.
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58. Simple Vehicle: Rocket Launcher
i Information
Applicable Blender version: 2.75

58.1. Techniques
You should already know how to do:
• Previous Simple Vehicle techniques
This section will recap and introduce:
• UVspheres
• Changing object's center

58.2. Overview
Two assumptions are going to be made here. One is that the rocket will not be launched in
the future (use separate objects if you want to do that). The other is this is going to be a
simple, simple design.
If you want to add options to your gun (think sight, trigger), go for it!

58.3. Create the Launcher
Start a new ﬁle and delete the default cube.

58.3.1. Add a cylinder
In NUM1 view, add a cylinder mesh with 24 vertices with ”Cap Fill Type” at ”Triangle
Fan” and set it to ”align to view”. We'll use 24 because the default 32 is overkill and will
only increase rendering time. Rename and elongate the cylinder along the Y axis(”S key”
then ”Y key” then ”6key” ). This will be the length of the launcher (minus the rocket).
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Figure 377

Elongated cylinder

58.3.2. Hollow the cylinder

Figure 378

Circle Select ( C ) the vertices at one side, then extrude (' E ) them, and press ESC
to create a copy of the vertices.
Scale ( S ) them by 0.7.
Do the same at the other side.
Extrude at one side the inner circle vertices ( E ) then ”Enter”, then press ”N key” and
change the value at ”Z” in 1.2 or -1.2 dependent on what side you take. Then press hit ”A
key” 'till you have the whole cylinder selected then press ”W key” and say ”Remove doubles”.

58.4. Create the rocket
For the purposes of this tutorial we will add the rocket on the left end of the launcher.
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Create the rocket

Figure 379

Finishing the rocket head

58.4.1. For a one piece rocket + launcher

Figure 380

Select the inner ring of vertices using circle select ( C )
Extrude ( E ) the ”edge” along the Y axis ( Y ) press ”Num1” then ”S key” then ”0.95”
select the all the faces second from the outside and press ”X” then ”Only Faces”. Select the
inner ring vertices then ”E key” ”Y key” then ”0.5”.
Extrude the ”edge” along the Y axis with 1.5, and scale the new edge by 1.5.
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Extrude the ”edge” along the Y axis with 1.
Extrude the ”edge” along the Y axis with 3, and scale the new edge by 0.2.
Extrude the ”edge”, hit ESC , and merge ( ALT + M ) at the center to form the face for
the nose
For fun you could extrude the left end of the rocket with -11 in the cylinder and then ”F
key”. you can separate the objects by pressing ”P key” after selecting the objects you want
to separate. you can manually delete the edges that stayed at the cylinder.

58.4.2. For a two piece rocket and launcher
• Method 1: create a cone, rotate it, then extrude and scale to get the rocket shape.
• Method 2: create a cylinder, scale it along the Y-axis, then extrude one side, scale
to about 1.3, then extrude two more faces, scaling the ﬁrst about 0.3 and merging the
vertices of the second at center.
• Method 3: Create a UV sphere with 4 rings, and model it - much in the same way as
the penguin - into a rocket.

58.5. Create the mount
Having a launcher is nice, but we'll need to aﬃx it to the jeep somehow. Let's add a mount
to the tube.
Make sure you're in edit mode, not object mode!

58.5.1. Add a cylinder

Figure 381

Mount arm

Add a cylinder with 24 vertices with ”Cap Fill Type” at ”Nothing”, since we won't be seeing
the ends.
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Scale to about 0.55, then move it to the bottom of the tube.

58.5.2. Add a UVsphere

Figure 382

Place the sphere

The easiest way to have a wide range of motion for the launcher is to use a ball joint. We
can simulate one by just adding a UVsphere. The default 32 segments and 12 rings will be
ﬁne. This creates a smooth sphere.
You can think of the number of segments as being the wedges visible when the sphere is
viewed as you added it. The number of rings then could be described as the depth of the
sphere from that same view.
Resize and place the sphere at the new cylinder arm.

58.5.3. Reposition the center point
This next step will be important for continuing the tutorial. Get the 3D cursor to as close
to the center of the sphere as possible. While the sphere is still selected after creation, you
can press SHIFT + S and snap cursor to selection, putting it in the exact center of the
UV Sphere.
Switch to Object Mode. In the ”Tool shelf” under ”Tools” you'll ﬁnd the button ”Set origin”,
click this and click on ”Origin To 3D cursor” This should move the large pink dot where the
cursor is located. This will give it a new center of gravity around the ball joint, making it
easy to manipulate later.
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Figure 383

Change the center of the object

58.6. Subsurf
Be in edit mode!
Apply subsurf, level 2
Select everything ( A twice), and hit the set smooth button ( at the bottom of the links
and materials panel).
This makes the ends of the rocket launcher tube too rounded, as real ones are squared up.

58.6.1. Square up the tube edges on the right side
On the right side (without the rocket sticking out) be in Face select mode

Figure 384
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Subsurf
on one of the faces in the outer ring, then circle select ( C ), and select all the faces
at the end of the launcher tube. You can also do a lasso selection by CTRL + RMB in
face selection mode.
RMB

Crease the edges of the faces by hitting SHIFT + E

and set it to 1.0.

58.6.2. Squaring up the tube edges on the left side

Figure 385

Now do the left side exactly like the right side.
Noob Note Be sure to deselect everything on the other side ﬁrst ( A

)!!
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58.6.3. Squaring up the rocket

Figure 386

RMB on one of the faces in the middle surface, then circle select ( C ), and select the
faces all the way around
Crease the edges of the faces by hitting SHIFT + E

and set it to 1.0.

58.7. Final touches
Apply materials or additional items to the object and save for later use.
Do not forget to name the rocket for later use.
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59. Simple Vehicle: Body
i Information
Applicable Blender version: 2.75

59.1. Techniques
You should already know how to:
•
•
•
•
•

Make a mesh
Navigate the viewport
Extrusion
Form faces
Name objects

This section will recap and introduce:
•
•
•
•
•

Deleting and creating edges
Subdividing
Merging vertices
Loop subdivide
Adding unconnected vertices in one object

59.2. Planning
The jeep is being designed to include the back, ﬂatbed, door holes, dashboard, window, and
hood. The window is extruded straight up (older jeeps' windshields aren't slanted), and I
decided to add a lower back to later hold the bumper/lights if you wanted to add them.

59.3. Building the Jeep
59.3.1. Extrude the Chassis
Start a new ﬁle.
Change to front view ( NUM1 ), switch to EDIT mode, and deselect all ( A ).
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Figure 387

Main sections are made.

Be in Face select mode
Starting from the default cube (#1), box select ( B ) on the right edge to select the right
face, and extrude ( E ) 2 units (#2) to the right along the X axis (should default, otherwise
X ). Continue with three more extrusions to the right along the X axis of 1 unit (#3), 1
unit (#4), and 2 units (#5).
deselect all ( A ).
Now starting again from the default cube (#1), box select ( B ) on the left edge to select
the left side face, and extrude 1 unit (#6) to the left in the X axis
deselect all ( A ).
box select ( B ) on the bottom edge of block #6 to select the bottom face, and extrude 1
unit (#7) down in the Z axis.
deselect all ( A ).
Finally box select ( B ) on the top edge of #4 the second block from the right to select
the top face, and extrude up 2 units (#8) in the Z direction.
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59.3.2. Widen the chassis

Figure 388

Now to widen the jeep body.
Switch to top view ( NUM7 ).
deselect all ( A ).
set ”Limit selection to visible” oﬀ Increase the width of the existing boxes (#1) with one
square (#2) by box selecting ( B ) everything (since you're in face select mode it will
select all the faces of the starting chassis), now Scale ( S ) 2 times on the Y axis ( Y )
And select all faces on one side and extrude along the Y Axis 1 unit. do the same on the
other side
This should give you the ﬁgure that is shown to the right.
Noob note: holding CTRL as you do the above moves and extrusions will lock it to grid
steps
Noob note: You might want to save your job here and rename it before carrying on as the
options below are easier if you can revisit this stage.
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Figure 389

Widening along the Y axis

59.3.3. Flatbed and Doors
Our jeep design will have somewhat of a cheat - no actual door.
There are now a few diﬀerent ways of doing this (thanks to reader submissions)! Try each
one and study the results, as they will teach you about the issues you will encounter when
you start making models of your own design;
Method 1 is the simplest of them, but teaches you the least in dealing with mesh trouble.
Method 1
Make the jeep bed

Figure 390

In NUM7 view
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Be in Face select mode
Turn occlude background geometry (now called Limit selection to visible) on. It's
the button with the spotty-box icon to the right of vertex, edge, and face select buttons.
Select ( RMB , then SHIFT + RMB ) the top faces where the ﬂatbed and then doors
should go. You should now have four faces selected, two large ones for the bed, and two
small ones for the doors.

Figure 391

Extrude ( E ) the ”region” -2, on the Z axis ( Z ).
Make the no-door holes

Figure 392
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Figure 393

Now in front view ( NUM1 )
Be in Edge select mode
Select ( RMB ) the top edge of the door face, and delete ( X ) the ”edge”. Next, do the
same to the corresponding door edge on the other side.

Figure 394

Be in Face select mode
Select the faces in the bottom of the door wells, and extrude them up 0.5 along the Z axis.
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Figure 395

Select the bed panels, and extrude them up .1 along the Z axis ( leaving them on top of
each other will cause problems with rendering engines down the road )

Figure 396

Noob Note: Be very careful as you extrude the parts up, since they are on top of each
other, it's easy to select the face on the outside, rather than the one on the inside. Once
you've done the extrusion, check the normal lines by hitting the draw normals button in
the mesh tools more panel (if you can't see it, hover and scroll with the MMB). If you don't
get good normals, then hit undo, then reselect the faces, and try again until you get the
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correct face being extruded (50% chance of getting the wrong face pulled up). Or select the
faces with a wrong normal and hit the Flip Normals button in the Mesh Tools tab.
Finally, select the whole body and remove doubles, ( A ) to select all then ( W ) to bring
up the specials menu. On the special's menu, hit ”remove doubles”.
Note: removing doubles every couple of steps is a good habit to get into, and will save you
time down the road.
Method 2
Make the jeep bed

Figure 397

Deleting faces

be in Top view ( NUM7 ), and Face select Mode.
Select the two faces in between the bumpers and windshield ( RMB , then SHIFT + RMB
).
Now delete both faces ( X ->”faces”).
Note: you could also be in edge select mode, and delete (xkey) the edge between the two
faces, for the same end result.
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Figure 398

Selecting vertices

You will now add outer faces around the hole we just opened in the model, by selecting two
vertices at the top of the model, and two from the bottom of the model.
Be in vertex mode
Deselect all ( A

twice)

Starting at vertex A, circle select ( C ) vertex B, C, and D,

Figure 399

Creating faces

Next create a face ( F ); do this same procedure 5 more times at the vertx groups show in
the pictures.
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Figure 400

Figure 401

Issues with exposed inside faces (Normals)

Figure 402
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Now that we have gotten the new outer faces in place we can't see into the model any more
but we still have a big problem, the ﬂoor is actually the outside face of the bottom of the
model, this is not good because you should never leave exposed inside faces (the other side
of outer faces) on a model.
Exposed inside faces are invisible when looking through them when you apply textures and
render it, since nearly all rendering engines completely ignore inside faces ( A common
problem with many sketchup models, ah the irony! ).
You can tell a face is an inside face, by the fact that if you turn on show normals, and show
vnormals, on the mesh tools more panel, the outside faces and vertices will have blue lines
shooting out of them, while inside faces will not.
Understanding this now will save you lots of wasted hours in the future trying to ﬁx your
normals.
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Figure 403

Click the button within the red circle to display face normals

Press NKEY and go to ”mesh display” and click on the cube with the face highlighted.
Look closely at the exposed interior faces in the ﬂoor of the truck bed, they don't have blue
lines poping out in the inside, only on the outsides.
Now select textured from the box where you pick wireframe, or shaded, and the exposed
inside faces will become invisible when viewed from the inside, but look great when looked at
from the outside.
In newer versions it is no longer invisible, and it seems to work but it still has no normals,
and it is still important to know.
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Add the ﬂoor of the bed
Lets make a ﬂoor for the bed now.

Figure 404

Be in Face select mode
Select ( RMB ) both faces of the truck bed,
Extrude ( E ) pick ”region” from the popup, and move up along the Z axis ( Z ), by about
0.2.
With the two faces selected, hit mesh -> normals -> ﬂip to make their normals correct for
their new position
Now rotate the model till you're looking at it from the bottom, as you can see there is now
a hole that needs some extra inside faces removed, and new faces added to compete the
bottom.
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Figure 405

Select each extra face on the sides, and delete ( X ) the ”faces” as shown in the photos.

Figure 406

Change to Vertex select mode
Select ( RMB ) corners a, b, c, d, and create a face F , then do the same for c, d, e, and f.
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Figure 407

Recheck the normals, and make sure you only have outer faces on the outside of your model.
Make the door holes
Method 2.2 is easier!
Method 2.1 Subdivision

Figure 408

To cut out one door, select the four vertical edges where the door will go.

507

Simple Vehicle: Body

Figure 409

Split the area where the door will go.

Use the subdivide command ( W ) to cut the edges in half. You'll notice that the subdividing will also aﬀect the adjoining faces.

Figure 410

Delete edges for door opening.

Select the two edges at the top of the door panel and delete them, removing the top half of
it.
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Figure 411

Change to Vertex select mode
Now build up faces by selecting the groups of vertex's as shown in the photo, and creating
a face ( F ). Do the same thing for the other side, removing/adding edges and creating
new faces.

Figure 412

Merging faces.

If you want to clean up the look of the sub divided faces in the model
Change to Face select mode, and select the faces that are going to be combined.
Press F and a little window will appear titled 'Make Faces'. Click on 'Make FGon' to
merge the faces. (As you may have guessed, if an FGon face is created and you want to
later undo it, select the 'clear FGon' option in the Make Faces window.)
Note: to merge an Fgon to a ﬂat face, select it and hit CTRL + J
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Pro Note: You don't even have to make an FGon. Just select the door-to-be, Tris and
Quads both, and hit CTRL + J .
Noob Note: Q. What is an FGon??
A. It is a fake polygon, a way to hide triangles and quads on ﬂat faces.
Method 2.2 Multicut

Figure 413

Be in frontview (NUM1).
Select the top edges where you want the doors
Multicut (KKEY), enter two in the popup, draw a line along the axis of the cut, as shown
in the photo, and hit ENTER .

Figure 414

Then move the newly created edges down and towards the sides.
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method 2.3 (Noobie)
Select top face of where door is going to be
E
Z

to extrude, pick "Region" from the popup menu

to lock in Z direction
hold CTRL to snap to whole BUs and move down one BU

Select 2 top edges that look like they have no widths
X

to erase, pick "Edges" from the popup menu

Two faces will be missing. For each individual missing face, Select top and bottom edges
F

to fill in the missing face.

59.3.4. Resizing the bed and windshield
Go ahead and resize the widths of the bed and windshield.
As a precaution, Remove doubles before starting!

Figure 415
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To narrow the width of the window, change to Edge mode and select the edges shown in
the picture, then move ( G ) along the X axis.

Figure 416

To narrow the width of the side, change to Edge mode and select the edges shown in the
picture, then move ( G ) along the Y axis.
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Figure 417

Adjusting the widths.

Always move as many vertices or edges at the same time to not only work faster but to
make sure they are moved equally. The use of circle select, loop select, and SHIFT while
moving vertices is very helpful in ﬁne movements.

Figure 418

Bringing the back to a point.

If you want an object to come to a point such as a wedge from a cube, merge vertices.
In this example, the lower back area will be modiﬁed. Select two vertices to join together
and press ALT + M . Select the option for your merging. 'At First' or 'At Last' will
probably be the option that will work here.
Play around to see what each merge option does. After the merging, Blender will tell you
how many vertices were removed.
Be certain to ”remove doubles” ( W ), as merging creates lots of them. ( You can also ﬁnd
it on the menu Mesh ==> Vertices ==> Remove doubles)
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Figure 419

Raise the ﬂatbed.

Extrude the bed surface upward. This is only useful in hiding the tires that we'll add later
in the tutorial. Alternatively, you could make two boxes to hide them.

59.4. A Touch of Detail
59.4.1. Adding an Engine Hood
Method 1

Figure 420
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Loop Subdivide select.

A Touch of Detail
Let's add some detail to the model - how about the hood? First thing to do is add some
edges to the front of the jeep. Press CTRL + R to enter Loop Subdivide. A pink loop
will appear around the mesh. Put the cursor over the area to get the example picture to
appear.

Figure 421

Aligning the hood.

When the loop is in the right place, LMB click. The place to put the actual cut can now
be selected. Do this twice - once for each side. Move and align the resulting edges to form
an angle to the front and bring the window vertices in.
Extrude the hood surface up a small amount. We don't want it too high, just high enough
to catch the light.
Zoom in and select the top-front hood edge created from the extrusion. Drag it out along
the X axis. Select the now diagonal face of the hood extrusion. Extrude from it. The
result will come out of the surface at a diagonal angle. Take the resulting vertices and
move them close to the front of the jeep.
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Figure 422

Formatting the window.

Using the additional lines from the loop subdivide you can improve the shape of the window
Method 2
Another way to raise the Jeep hood. It doesn’t require loop cuts, so is a bit simpler.

Figure 423

Hood extrusion.

Step 1. Make Inner Square.
Switch to Top-view ( NUM7 ), or slightly rotated oﬀ for easier viewing. Face-select the top
square of the hood.
Do E -xtrude, then hit <esc>. NOTE: this WILL make a new surface, hitting
doesn’t cancel the extrude, just makes its location to be exactly on the old surface.
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A Touch of Detail
Do S -cale and type 0.9 and hit <return>. Now you will see the new surface as a smaller
square (or really rectangle) on top of the jeep hood square.
Noob Note: What I had to do is S -cale on Z and type 0.9, otherwise the New
Surface For the hood would end up shooting through the Windshield.

Figure 424

Bring out the top front edge.

Step 2. Shape Hood.
Still in Top-view NUM 7, deselect all.
Box-select the right two vertices of the new square, towards the front of the jeep.
Do S -cale on Y, and type 0.8 and hit <return>. Leave the two vertices still selected.
Do G -rab on X, and type 0.2 and hit <return>.
Face-select the resulting quadrilateral.
Switch to Side-view NUM 3.
Do E -xtrude on Z and type 0.2 and hit <return>. I used 0.2 to exaggerate the screenshot
a bit, you probably want 0.1 instead.
Now you should have a raised hood on the front of the jeep.
method 3
Another way to extruding the Hood of the jeep including a lip that comes over the front.
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Figure 425

Step 1: In face select mode ( CTRL + TAB ->faces), select the top of the hood and press
E to extrude it. Only extrude it a small amount.

Figure 426

Step 2: Staying in Face select mode, here is the tricky part. Select the small face on the
front of the hood you just extruded. Then, hit E then ESC . This creates a duplicated
face on top of the one you selected. Do not click or move the mouse between these two
keystrokes.

518

A Touch of Detail

Figure 427

Step 3: Now deselect the selected face by hitting AKEY. Then enter Edge select mode (
CTRL + TAB ->edges) and select the top edge of the face you just deselected.

Figure 428

Step 4: Hit NUM1 to go to the side view. Now using the red X arrow pull the edge out a
little further than you pulled up the hood itself then hit LMB .

519

Simple Vehicle: Body

Figure 429

Step 5: Now rotate just enough so you can see under the wedge you just made. Go back
into Face select mode ( CTRL + TAB ->faces) and select the face on the underside of it.

Figure 430

Step 6: Go back into side view with NUM1 . Now hit E
the mouse. When it's a good size hit LMB .
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A Touch of Detail

Figure 431

Step 7: Now make sure the ”Select only visible” button is turned oﬀ (”Occlude background
geometry” in later versions) and go into Vertex select mode ( CTRL + TAB ->vertices).
Play around with the vertices pulling them a little closer to the front of the jeep. It's best
to select using the box select ( B ) or the Lasso ( CTRL + LMB ).

Figure 432

The end result should be an extruded hood with a lip.
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59.4.2. Add a Fender

Figure 433

Starting the fender.

In the topdown view ( NUM7 ), add a plane. Extrude an edge twice to result in three
connected planes.

Figure 434

Bend the fender.

Pull the sides down to form a trapezoid shape and reduce the width.
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Figure 435

Model with fenders.

Once it is in the desired shape, select the three faces and duplicate it. Press SHIFT + D
and all selected vertices, edges, and/or faces will be duplicated. The copy will
automatically be grabbed for moving.
Move the duplicate to the jeep body and repeat the duplication two more times for a total
of four fenders.
Noob note: A good idea is to ﬁrst position one fender, then copy it and restrict movement
to x or y-axis. Then copy both fenders and move the two new copies along x or y-axis.
Much simpler than trying to position four fenders individually.
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59.4.3. Add a rocket launcher mount

Figure 436

Setting up the tripod in NUM1 view.

We'll move on to making a tripod support for the rocket launcher.
Add a cylinder mesh with 12 vertices then scale and size it so that it looks like a tube. Once
you have it to a size you like,
Duplicate it twice for a total of 3 cylinders.
Rotate two of the cylinders in the NUM1 view by LMB clicking on the white circle that
appears when the cylinder is selected in rotate mode.
The picture on the left is an example of the end result.
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Figure 437
view.

Setting up the tripod in NUM7

Change to overhead view ( NUM7 ) and put together the three cylinders so the tops come
close together. Now all three can be selected and moved or rotated accordingly.

Figure 438

Putting in the tripod.

Move the tripod onto the jeep ﬂat bed. The ﬁnal steps are to select your materials and
rename the object (described in the wheel section). This will complete our simple jeep
model.
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59.5. Subsurf
Since we expect a jeep body to have squared up edges, we won't subsurf this part of the
model.

59.6. Optional Activities
Feel free to add anything you see ﬁt such as bumpers, guard rails, doors, steering wheel,
lights, etc. You can either have them on the same object or separate objects (useful if you
want to move them around).
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60. Simple Vehicle: Some Assembly
Required
i Information
Applicable Blender version: 2.75

60.1. Techniques
You should know how to:
• Do everything discussed in previous tutorials
This section will recap and introduce:
• Append a ﬁle
• Duplicate an object

60.2. Overview
The objects for the simple vehicle have been made if you have followed all the previous
Simple Vehicle tutorials. Putting it all together will come very easy now.

60.3. Appending the File

Figure 439

If you have the jeep body ﬁle open, keep it open. Otherwise, open the ﬁle for the jeep
body.
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In Object Mode, go up to File > Append (Append or Link in later versions), about 3/4
of the way down the menu. The Find ﬁle window will appear. Go to the location where the
jeep seat was saved. When the .blend ﬁle is clicked, you'll go into it as if it is a directory.
Here we have the categories of Camera, Lamp, Material, Mesh, Object, Scene, Text, and
World. We are interested in the seat object, so click on Object. Now there are three items:
Camera, Lamp, and Seat. That is, it will say Seat if you named your object Seat. This is
why it is useful to rename your objects, materials, etc. If you forgot to rename the object,
it will be called Cube (default for our starting mesh).
Noob note: You must be sure you're appending, and not linking! If you try to duplicate
it, and you get an error, then it's probably linked, there will also be ”li” to the right of the
ME: object name button. Ways to be certain you're appending are: when selecting the
ﬁle, look at the bottom for the append/link options and make sure ”Append” is selected; In
the ﬁle menu, don't choose ”Append or Link (Image Browser)”, you need to use the option
above it.

Figure 440

What should happen after selecting Seat and the button 'Load Library' is the seat will pop
into our ﬁle where the 3D cursor was.

528

Appending the File

Figure 441

It will deﬁnitely need to be scaled, rotated, and/or moved to the right position. One way
to do this is to rotate the seat about the Z axis -90 degrees by pressing R
Z
9
0
NUM- .

Figure 442

After placing the seat in the jeep body, let's make another so we have a seat for the driver
and passenger. Still in Object Mode with the seat selected, duplicate it ( SHIFT + D )
and slide it over. After duplicating it, it will automatically go into grab mode. If you RMB
or ESC , it will still be duplicated - just sitting on top of the original.
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Noob note: Duplicate appended objects in object mode, not edit mode, as they are separate objects and do not share the same edit mode space (each appended object has its own
edit world, unless you join them together)

60.4. Rinse and Repeat
Append the ﬁle again to place the wheel object and rocket launcher in the ﬁle. Scale, rotate,
move, and duplicate each object accordingly. Depending on the position of your camera,
you may or may not have to make all four tires. Remember that the only important parts
to draw are those that will be seen!
Set the ball over the tripod. The fun part is rotating the rocket launcher since the center
of it has been moved to the ball joint.

Figure 443

All objects

60.5. Parenting
Be sure to parent each item to the jeep chassis, by selecting the item, lets say the tire, then
also selecting the chasis ( RMB then SHIFT + RMB ) and then CTRL + P , and select
”make parent” from the popup menu.
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60.6. Final things

Figure 444

Rendered jeep

The last thing is to apply materials to your objects!
You can apply material in either object, or edit mode. As you might have noticed when
you select something in object mode the entire object is selected, in edit mode on the other
hand individual faces can be selected, and painted.

60.6.1. Make the windshield look like glass
You have to create a new material and assign it to the appropriate faces.
In edit mode, select the faces you want (make sure you select both sides of the windshield
including: front face, back face, and top face).
On the Editing section F9, under Links and Materials, click the 'New' button under Materials then click the 'Assign' button. This assigns the new material to the selected faces.
You can then go into the Shading section F5 and adjust the material to be glass, by setting
the alpha to .20, and hitting the ray transparency button. Three more ways of making a
material that looks more like glass are shown in Material Glass1 .
Make sure you are editing the correct material (if you have just the one texture on the jeep,
the default name for the new material should be something like ”2 Mat 2”).

1

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FEvery%20Material%
20Known%20to%20Man%2FGlass
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Noob note: Glass is only transparent when you render it. in order to render it you will
need to position a few lamps around the jeep, and move the camera around so that it can
see the jeep (view->camera).

60.7. Extra

Figure 445

Other possible ideas
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Extra

Figure 446

Figure 447
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Figure 448

Figure 449
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Created by following the great tutorial!

Additional Tutorials

Figure 450

Make LOVE not war!

Jeep | Render | Version 52

60.8. Additional Tutorials
Append and Link Video Tutorial: http://www.youtube.com/watch?v=69ZBlDrOlIY

2

https://www.evernote.com/shard/s26/sh/15983b0c-1b25-463c-a7db-dd81e4a1c26a/
e8f928db6a4a945bed69490dbb6749f3/deep/0/mod_simple_vehicle_jeep_ALL05.blend.png
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61. Modeling a 3D Parachute in Blender
i Information
Applicable Blender version: 2.67

61.1. Remove the default cube

Figure 451

When you ﬁrst open blender you will see the default Blender user interface (UI) layout and
the default cube.
Delete the cube by selecting it with RMB and then pressing X .
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61.2. Add a cylinder

Figure 452

Switch to Side view ( NUM3 ).
Add a Cylinder with SHIFT + A → Add→ Mesh→ Cylinder. At the bottom of the Tool
Shelf change “Cap Fill Type” to “Triangle Fan”.
Press TAB to switch to Edit mode. The cylinder should now look like the picture at right.
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Remove the bottom row of vertices

61.3. Remove the bottom row of vertices

Figure 453

Next you will want to delete the bottom row of vertices. To accomplish this go into side
view by pressing NUM3 .
Ensure that you are in Vertex select mode (that the leftmost of the group of 3 icons
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Figure 454

is selected; click on it if not).
Press A

twice to deselect everything.

Press B , and box select the bottom row of vertices, and press
conﬁrm.

X

to delete and then

Note: you must have limit selection to visible oﬀ, the button to the right of the group of
three icons for selection. If you wish to do the selection with it ON, you will have to change
your perspective so as to be able to select all lower vertices.
Note: Instead of all of the above, you can also just add a circle with ﬁll type 'triangle fan'

61.4. Extrude and scale to shape

Figure 455
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Extrude and scale to shape
Be in Vertex-select mode (as above).
Select all the vertices around the outside of the circle. The centre vertex must not be
selected. You can do this conveniently in a number of ways; why not practise them all:
• Starting with no vertices selected, use A to select all vertices, then SHIFT + RMB
on the centre vertex to deselect it. Or
• Starting with no vertices selected, ALT + SHIFT + RMB (loop select) on one of the
outside edges or vertices to select the entire loop of them. Or
• RMB on the centre vertex to select only it, then use CTRL + I to invert the selection.
Now switch to edge-select mode by CTRL + TAB and selecting Edges.

Figure 456

Press E

to extrude (”region”) the selection and Z

to constrain to the Z axis.

Drag the edges a small ways down then click LMB to release.
As this makes a right-angle at the sides and parachutes don’t have straight edges, we need
to scale the selection outward.
Press S and move the mouse away from the model, you will see that the edges get smaller
and bigger.
Scale them out a small ways then left click to release. You will want to practice a little with
the scale amounts till you can make a realistic parachute shape.

Figure 457

Continue extruding and scaling till you have a shape like the one shown on the right.
When you're done making a nice shape, be sure to select all ( A
pick “Remove Doubles”.

twice), then

W

and
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61.5. Make the top more rounded

Figure 458

Be in Vertex mode.
Select the center vertex in the middle of the original top half of the cylinder, use circle select
to get it, otherise you will be RMB a number of times to ﬁnd it, and move G it up
along the Z axis.
Select all A , and then W and Remove Doubles, in case any were created.

61.6. Extrude the parachute straps

Figure 459
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Merge it together
Now go into top-view by pressing NUM7 . Here you will select ~4 edges at opposite sides
of each other.

Figure 460

Go back into side-view NUM3 and extrude downward by pressing E

and then Z .

61.7. Merge it together

Figure 461
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All that remains to ﬁnish your parachute is to press ALT + M then choose “At Center”
which will merge all selected vertices.
A alternate way to make the parachute top is to create a UV sphere, and cut it in half.
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62. Model a Low Poly Head
i Information
Applicable Blender version: 2.75

62.1. Overview
This tutorial is designed to teach users to make a low-poly animesque head in Blender.
What you need to know:
• Basic Blender controls

62.2. Add a plane
Noob Note: Using triangles on a subsurfed model may result in ”peaks” appearing in some
areas. To reduce this problem, merge as many triangles into quads as possible.

Figure 462

Add a plane

Start with a new ﬁle, and delete ( X ) the default cube.
Be in Front view ( NUM1 )
Add a plane ( SHIFT + A -> add-> mesh-> plane)
Click on ”Align to view” in the settings at the bottom left side.
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62.3. Make a pointed chin

Figure 463

Merge the vertices

Switch to Edit mode
Be in Vertex select mode
Select the bottom two vertices ( SHIFT + RMB ) and press W to bring up the vertex menu.
”Select Merge”, then ”At Center”, or just hit ALT + M and choose ”At Center”.

Figure 464

A pointed chin!

Now you have a pointed chin.
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Figure 465

A pointed chin!

Select the top two vertices (use the B )

Figure 466

Select the top 2 vertices

Re-arrange them so they make more of a chin shape by pressing the G
to constrain the movement to the Z-Axis.

to move and Z

Noob Note: Move it down; don't scale it out.
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62.4. Extrude the face

Figure 467

Extrude along the Z-Axis

Now extrude ( E ) ”edges only”, along the Z-Axis ( Z ) so that you have another area.

Figure 468

Scale it

As a precaution, remove doubles. (WKEY)
Scale it ( S ) so that it's not so cubic.
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Extrude the face

Figure 469
again

Extrude along the Z-Axis

Now extrude along the Z-Axis again ( E

Figure 470
again

then Z ) and scale ( S ) it down a bit.

Extrude along the Z-Axis

One last time... (E) (Z) (S)
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62.5. Make the facial features

Figure 471

Select the middle vertices

Select the middle vertices (BKEY) or (RMB) and press (WKEY) to bring up the specials
menu. Subdivide it once.
Note: In newer versions you have to check the checkbox: ”Quad/Tri Mode” in the lower
left corner.

Figure 472

Select the vertices

Now select at ﬁrst the pair of vertices above and subdivide once.
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Figure 473

Subdivide!

Now subdivide 2 times with the pair of vertices below the center line.

Figure 474

There!

Yours should now look like this one on the right.
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62.5.1. Eyes

Figure 475

Subdivide some more

Select and subdivide here, so you can make the eyes.

Figure 476

Make some eyes

And rearrange the vertices so they make eye shapes.
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62.5.2. Nose

Figure 477

Select these

Now select the middle vertex here (right mouse button).
Extrude it along the Y-Axis (EKEY) (YKEY) and move your mouse around to change
how far it moves.
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Figure 478

Let's make a nose!

Select these three vertices (SHIFT+RMB) and press (F) tomake a face.

554

Make the facial features

Figure 479

Do the same to the other side

Now do the same to the other side, and you will have the nose's base.

Figure 480

Make a face

Select these vertices (SHIFT+RMB) and make a face (F).
Do this to the other side.
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Figure 481

You have a nose!

Now you have a nose.

62.5.3. Remove interior nose faces

Figure 482

Rotate the camera

Rotate the camera (CTRL+NUM1) so you are seeing the back.
Be in Face select mode.
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Smooth the mouth region

Figure 483

Get rid of these

Select (SHIFT+RMB) the faces behind the nose.
Delete (XKEY) them (on the popup pick ”Faces”).

62.6. Smooth the mouth region

Figure 484

Select these

Be in Vertex select mode
Select the vertex at the bottom of the chin, and the one at the bottom of the nose.
Subdivide them.
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62.7. Make the head

Figure 485

Select edges on the outside

Be in Edge select mode
Select all the edges on the outside (shown with blue lines in the photo).

Figure 486
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Give the face more smoothness

Make the head
Move (GKEY) the vertices back, along the Y axis (YKEY), a bit to give the face more
smoothness

Figure 487 Select the vertices
at the back of the head
Be in Vertex select mode
Rearrange the chin, by moving (GKEY) the bottom vertice along the Y axis (YKEY) till
it looks right.
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62.8. Make the back of the head

Figure 488
Y-Aixis

Extrude along

Be in Edge select mode
Now select the edges all around the back of the head, using (BKEY).
Extrude these along the y axis (EKEY) (YKEY)

Figure 489

Ta da!
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Ta da!

Make the back of the head

Figure 490

Make a face

Now select a set of 4 back vertices that form sort of a rectangle and press (FKEY) to make
a face.

Figure 491

and so on...

and so on....
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Figure 492

and so on...

and so on....

Figure 493

Subdivide these

now select and subdivide these once (W)
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Figure 494

Subdivide these as well

and these points too.

Figure 495

Move the middle back

Now select the middle and move it back (G) (Y).
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62.9. Finishing it up

Figure 496

With subsurﬁng

And here it is with sub-surfacing. You have ﬁnished. Hit (F12) to see the ﬁnal render.
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63. Building a House
i Information
Applicable Blender version: 2.67
In this tutorial, you will learn how to make a simple toy-like house with a fence around it.
You will learn how to use array modiﬁers to replicate the palings of the fence, saving you
from duplicating them one by one.
This tutorial is based on Bart Veldhuizen's ”Building a House” from Tutorial
#01 published by NaN in 1999 which is also available in a PDF at http://
download.blender.org/documentation/BlenderTutorialGuide1.tar.gz (a tar.gz containing BlenderTutorialGuide1.pdf) or http://download.blender.org/documentation/
BlenderTutorialGuide1.zip (a ZIP ﬁle containing the same PDF).
Permission was asked to use it and Ton Roosendaal said ”Be assured that everything that
was produced by NaN now is open and free content for everyone to reuse, including the
tutorial “Building a House”.”
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63.1. Setting the Scene

Figure 497

Start a new document ( CTRL + N ). Split the view into four views as at right, by pressing
ALT + CTRL + Q . This gives you a standard set of views: top, front, side and camera,
the ﬁrst three orthographic and the last one in perspective. You can switch back to the
single 3D view at any time by pressing ALT + CTRL + Q again.
Leave the default cube, it will be the walls of the house.
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63.2. Make the Roof

Figure 498

Ensure you are in object mode ( TAB switches between object and edit mode)
Now, in the Front view window (lower left)
Press SHIFT + D to duplicate the cube, grab mode is automatically selected, press Z
to restrict the move to the up-down axis and move the cube to rest on top of the original
(pressing CTRL while moving will snap it to the grid and make it easier to position
accurately.) Press ENTER when it is in place.
You can see how useful this four-paned window is; it shows you exactly what's going on.
Note: It helps to simply grab one of the arrows, press Z and then press 2 on the key pad,
this will move the block 2 units in the z direction. the standard starting cube is 2 units tall.
Note:
Make sure you are duplicating the cube in Object mode, not Edit mode, so the roof ends
up as a separate object.
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Figure 499

The top cube is going to become the roof and needs to be given a triangular cross-section.
Select the top cube (if it is not already selected) by clicking RMB on it
Press TAB to go into Edit Mode (check the box in the middle of the 3D window header)
Press A

to deselect all the vertices.

In the top view, select the top four ( RMB the ﬁrst one and SHIFT + RMB
You can check in the other views that only those four are selected.

the rest).

Note: another way to do this is to have ”limit selection to visible” turned oﬀ, and then press
the B for, border select, and make a box around the top vertices. (it helps to view it
from one of the sides, by pressing either the 1 or 3 keys)
Another Note: Or, with 'limit selection to visible” turned on, press C for circle select and
turn the mouse key to make the circle large enough to enclose all four vertices before you
press LMB .
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63.2.1. Make the Apex of the Roof

Figure 500

Now press
could try to
have a hard
by ENTER

S for scaling and X to limit the scaling to the X-axis (left to right). You
move the mouse back and forth to bring the top vertices together, but you will
time lining them up exactly, so it's best to just type in 0KEY (zero) followed
to set scaling to zero.

Now it looks like there are only 2 vertices where there were 4, but in fact there are still 4,
even though 2 of them are occupying exactly the same positions as the other 2. With these
4 still selected, bring up the vertex specials menu with W and select “Remove Doubles”.
You should see a message brieﬂy ﬂash up at the top right saying “Removed 2 vertices”. Now
there really are only 2 vertices where there previously were 4.
Note:
“Remove Doubles” is a handy function to use after complicated mesh edits. It helps
reduce complexity in your mesh structure.
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63.2.2. Form the Eaves

Figure 501

The roof needs to project over the walls of the house to form the eaves. To do this, we will
scale it, but only along the X- and Y-axes, not the Z, so it doesn’t become taller.
Select all the vertices in the roof object by pressing A

once or twice.

Press S to scale, followed by SHIFT + Z to scale uniformly along all axes except Z,
and scale to about 1.1. Conﬁrm the operation with LMB or ENTER in the usual way.

63.3. Naming the Roof and House Objects
In a complex project with lots of objects, it can be helpful to keep them straight by giving
them names. This is less of an issue in a simple tutorial like this one, but for practice, let’s
give names to your objects anyway.
Go to the Object context
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Figure 502

in the Properties window, and at the top you should see an editable ﬁeld containing the
name of the currently-selected object. The walls of the house should be called “Cube”, and
the roof should be called “Cube.001” (note the automatic addition of a numeric suﬃx to
keep the names unique). Try changing these to, say, “House” and “Roof” respectively.

63.3.1. Object Name Versus Mesh Name
If you look in the Mesh Data context

571

Building a House

Figure 503

, you will also see a name like “Cube” or “Cube.001”. This is a separate name for the objecttype-speciﬁc data (the mesh data, in this case), quite independent of the object name. Don’t
worry about this name for now; you will learn about its signiﬁcance later1 .

63.4. Colouring the House
The roof now needs to be given a diﬀerent colour to the default grey. Select the Materials
Context

1
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Chapter 42 on page 341

Colouring the House

Figure 504

in the Object Properties window. In the list at the top, you should see a single entry,
called “Material” (the name of the initial default material). Below that is an editable ﬁeld
containing the name, and immediately to its right should be a small box with the number
“2” in it. This number indicates that the same material is being used in two places—in
this case, we know the other place is the object representing the walls of the house. Click
on this “2”, and that will force a new copy of the material to be made (leaving the house
walls with the original); the number will disappear, and the material name will change to
“Material.001” to be diﬀerent from the original.
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Figure 505

Change this material name to “RoofRed”, to make it clearer what it is for. Next, ﬁnd the
panel “Diﬀuse” further down, showing a swatch of the diﬀuse (non-reﬂective) colour, which
is initially white. Click on this to bring up a colour picker, and choose some suitable shade
of red for the roof. (Notice that when using shades of red, the white to black slider on the
right actually creates shades of brown from the red.) As you do this, the 3D view should
instantly update to show your new colour being applied to the roof of the house. If you
want to exit the colour picker and leave the colour unchanged, press ESC ; otherwise, to
conﬁrm your choice, simply move the mouse outside the picker window, and it will close,
leaving your last-chosen colour in eﬀect.
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Figure 506

Follow a similar procedure to choose the colour for the house walls: click the “House” object
with RMB in one of the 3D views, go to the Materials Context
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Figure 507

in Object Properties, change the material name from “Material” to something more appropriate (here I’m choosing “HouseSandy” because I’m going to give the house walls a
sandy-yellow colour), click on the colour swatch in the “Diﬀuse” panel and choose a suitable
colour for this material. Noob Note: I have found it very useful, when I re-name anything,
to type my new name in ALL CAPS. This makes it easier for me to pick out what I have
done.
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Figure 508

Your house should look like this now.
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63.5. Make a Chimney

Figure 509

Go into Object mode, if you're not already in it. ( TAB
mode.)

ﬂips between object and edit

Go to the Front view (lower left window).
Click LMB to position the 3D cursor on the right-hand side of the roof, this will select
the spot where the chimney will be created.
Press SHIFT + A

to Add → Mesh → Cube from the popup menu — a bit large, isn't it?

Scale it along the X and Y ( S , SHIFT + Z ) to about 0.2.
Now grab it ( G , X ) and move it into position looking at the front view (lower left
window). (Feel free to use the mouse wheel to zoom in the view to make things easier to
see.)
When this is correct, move it into position along the Y axis ( G , Y ) looking at the top
view (upper left window).
You can check the side view (lower right window) and the camera view (upper right window)
to see that it looks OK.
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63.5.1. Name and Colour the Chimney
In the Object context

Figure 510

in the Object Properties window, change the name of the chimney object to ”Chimney”.
Next in the Materials Context
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Figure 511

in the Object Properties window, you will notice there are no buttons, and there is an icon
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Figure 512

, and next to that a button with the word ”New” in it. You can now choose to have the
chimney a diﬀerent colour to the roof or the house or reuse one of these colours.
If you want a new colour, the ”New” button, and it will create a new material with a default
name and settings. You can rename this and give it an appropriate colour.
If you want to reuse the same colour, you can click on the icon
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Figure 513

and select from the available materials, namely ”RoofRed” and ”HouseSandy”.
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63.6. Adding a Window
63.6.1. Make the Window Frame

Figure 514

Be in Object mode.
Using the front and top views, click LMB to place the 3D cursor where you want the
window to go: use the top view to place it against the front wall, and the front view to
place it a little to the left and up from the centre of the wall. (Of course, it’s easy enough
to reposition the window after you’ve created it, so exact initial placement is not critical.)
In the front view (lower left) add a plane: SHIFT + A Mesh → Plane). This will initially
be laying ﬂat, facing upwards instead of forwards; to ﬁx this, just rotate it 90° about the
X-axis: R
X
9KEY
0KEY
ENTER .
Scale S

it down to 0.4, and press ENTER

To give it a rectangular shape, scale the plane by about 0.8 along the X-axis S
.KEY 8KEY .

X

0KEY

Move it into position ( G ), using the top and front view, on the left hand side of the house
a little higher than midway.
Be in the Side View window (lower right).
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Move the plane along the Y-axis ( G , Y ) until it is just in front of the house. You may
want to zoom in ( MW ) to see better.
Now, still in Side View,
Switch to Edit mode ( TAB )
Extrude the plane towards the house ( E , -0.07) until it is embedded in the wall.

63.6.2. Make the Window Sill

Figure 515
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Box-select in progress

Adding a Window
To make this box into a window frame will require a larger view: move the mouse into the
Side View window and zoom in with the mouse wheel.
Deselect all ( A ) and select the outer (leftmost in the right view) vertices using box select
( B ).

Figure 516

Press E and immediately (without moving the mouse) press ESC . This will extrude,
but leave the newly-created vertices on top of the previous ones.
Scale the newly created vertices by 0.9 ( S

0KEY

.KEY

9KEY

ENTER

).
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Figure 517

Extrude again inwards to most of the depth of the box about -.03 to -.05 along the Y axis,
depending on how you have your window into the wall( E , Y , -.03, ENTER ).
This screenshot shows a side view in wireframe mode (use Z
on and oﬀ).

to switch wireframe mode

Note:
The outer panel of the window that you just made cannot be inside the wall, you will
see this best on the side view. (if the outer face of the window pane is inside the wall
you either won't see any paint/texture you apply, or it will half show up.)
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63.6.3. Name and Colour the Window Frame Object
Change the name of the window object, as you previously did for the rest of the house pieces.
It will be initially called “Plane” (because that is the kind of mesh object you started with);
change it to “WindowFrame”. Also give it a new material, and make it white. Change the
material name to “WindowFrame”.

63.6.4. Make the Window Glass
The glass of the window has to have a diﬀerent material from the frame. There are two
ways to achieve this: make them separate objects, or make them the same object, with
diﬀerent materials assigned to diﬀerent faces. We will do the latter.
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Figure 518

Deselect all ( A )
Be in Edit mode .
Switch into Face select mode ( CTRL + TAB
Vertex select mode up to now)
RMB

-> faces) select mode (you've been in

on the face in the center of the window frame, to select it.

In the Materials Context, click the ”+” button next to the list of materials, and where that
was previously showing just the “WindowFrame” material, you should see a new blank item
appear. The rest of the window will go blank, but the “New” button will appear; click this
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to create a new material. Give it a colour reminiscent of glass; I chose to colour it light blue
(“87ceeb” SkyBlue).
Now to connect the new material to just that one face, press the Assign button just under
the material list.
Note:
The material Assign, Select and Deselect buttons only appear in Edit mode.

Figure 519
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Note:
Patience, Grasshopper. A simple blue rectangle may not look very much like glass.
But don’t worry: in later lessons, as your skills improve, you will learn how to make a
material that looks like real glass.
Note: If you do decide to make the windows with real glass material, as explained in previous
lessons, make sure you use the materials on both faces in the front and back of the window.
Also use loop cuts or knife to cut out a hole in the wall in place of the window. And add a
point light inside the house.

63.7. Adding a Door

Figure 520

Add the door using the same method:
Be in Object mode
Deselect all,
Create a plane, rotating it to face forward as necessary ( R
) to align it with the front wall of the house.

X

Scale the plane down by .7 and then again by .5 along the X axis.
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0KEY

ENTER

Building the Fence
Move it into position using Front view and then move it against the wall of the house in
Side view.
Change the Object name to “Door”. Create a new material for it; change the material’s
name to “Door” and choose an appropriate colour for it.

63.8. Building the Fence
The fence will consist of long sequences of identical palings. Creating them one by one
would be a long, tedious process—which is something the computer, not a human, should
do, right? In fact, even creating just one paling and making duplicate copies would be a
long, tedious process. Which is where the magic of modiﬁers comes in.
Blender’s array modiﬁer lets you make any number of copies of a single object, all neatly
arranged in a row or in various other ways. Being a modiﬁer, the copying only happens at
render time, so there is still only a single object to edit while modelling: change that, and
the change is automatically propagated to all the copies.

63.8.1. Make a Paling

Figure 521

Be in object mode, with nothing else selected.
Add a plane, orient it vertically ( R
the X axis in Front view.

X

90 ENTER ), scaled to 0.4 and then 0.1 along
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Figure 522

Switch to edit mode. Ensure you are in vertex select mode ( CTRL + TAB -> ”vertex”),
in case you were still in face-select mode from making the window (above).
To give it some thickness, go into Side view and extrude it to 0.05.

Figure 523

The pointed top is made by going back into Front view,
Selecting the top vertices and extruding them by 0.07 (along the Z axis is selected automatically),
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Figure 524

Scaling them to 0 along the X axis and then removing the doubled vertices ( W , ”Remove
Doubles”: it should say ”Removed 2 vertices”).
In Top view move the paling to the intersection of two grid lines at a suitable distance from
the house.
In Front view again, check that the bottom of the paling is level with the bottom of the
house.
Change the name of the object and the mesh to ”Paling”, create a new material for it called
”Paling” and make the colour white.

63.8.2. Duplicate the Paling

Figure 525
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Be in Front view, as the ﬂat face of the paling is along the X axis and it is easier to create
the front fence ﬁrst.
Change to Object mode. Select the paling. Find the Modiﬁers Context

Figure 526

in the Object Properties window. Click the “Add Modiﬁer” button, and in the menu that
pops up, select “Array”. You should see a second copy of the paling appear next to the ﬁrst.
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Figure 527

Look at the checkboxes: “Relative Oﬀset” should be checked, “Constant Oﬀset” and “Object
Oﬀset” should not be checked. Under “Relative Oﬀset”, there are values for X, Y and Z;
these are the distances between copies, relative to the dimensions of the object. Change the
X value to something like -2 (the negative value causes the duplicated paling to appear on
the other side, away from the gap we want to leave in front of the door). Now increase the
number under the popup that says “Fixed Count”, and watch the line of duplicates lengthen
until it reaches the point that you want to be the corner of the fence line—a count of about
12 did it for me.
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Figure 528

Now type ALT + D to make a duplicate of the row of palings, followed by X to
constrain its movement to the X-axis (parallel to the row of palings). Move the duplicate
row to the end of the existing row so it looks like a continuation of it. Now type R
Z
-90 ENTER to rotate it so it lies parallel to the side of the house. Increase the array count
for this row to something like 24 so it extends all the way past the side of the house to a
suitable corner point.
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Figure 529

Again, type ALT + D to duplicate this second row, this time followed by Y to
constrain its movement parallel to the side of the house. Move the duplicate so its looks
like a continuation of the same row. Rotate it parallel to the back of the house by typing
R
Z -90 ENTER . Adjust its array count as necessary to get the right length.
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Figure 530

Once more, type ALT + D to duplicate this third row, followed by X to constrain its
movement parallel to the back of the house. Move the duplicate to the end of the row, and
rotate it to be parallel to the side of the house with R
Z -90 ENTER . Give it the
same count you did to the array on the other side, so its length will be the same.
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Figure 531

One last time: ALT + D to duplicate, Y to ensure it only moves parallel to the side
of the house, move to the end of the row, rotate into position with R
Z -90 ENTER .
You’ll probably ﬁnd it’s so long it runs into the original row of palings you started with on
the other side of the front of the house; reduce its array count to something like 8 and you
should end up with a nice gap in front of the door.
Noob Note: I encountered a problem when rendering the fence. It became grainy, and
when I say grainy, there are random clusters of black all over every rendered post. Some
had few of this 'grain' while others were almost black. I have environment lighting at 1 and
it's still goofed up. Would this be due to hand-sizing them instead of putting in all of the
above values? I was unable to upload a picture of this to the site, so I used my Dropbox to
share the link, here2 .
Noob Answer: I don't think hand sizing would make any diﬀerence. The ﬁrst thing I
would do is go back into edit mode on the original paling and select all vertices. Then I
would hit 'W' and click remove doubles. After that, recalculate the normals by holding
'Ctrl' and hitting 'N'. Those operations typically ﬁx common rendering issues for me,
hopefully it will work for you too.
Alternate Noob Solution: I encountered this problem and it turns out it is caused by having more than
one copy of the fence in the exact same place. Try moving the aﬀected fence

2

https://www.dropbox.com/s/ml2jbfc6kfmqs01/untitled.png
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pieces, to ﬁnd the duplicate then delete it. Remove doubles did not work for my
instance of the problem.

63.8.3. Make the Horizontal Bars (Left Side)

Figure 532

The fence needs horizontal bars to hold the palings in place: be in Front view
LMB

below the middle of the left-hand fence.

Create a plane, rotating it to the vertical as necessary ( R
to the length of the fence.

X

90 ENTER ) and scale it

Scale it again to 0.05 along the Z axis and move it into position. ( if you keep
pressed while you move it, it will snap to the grid.)

CTRL

Go into Edit mode ( TAB )
In Side view move it so it is against the back of the fence and extrude it by -0.04 along the
Y axis.
Go into Object mode ( TAB ). Give the horizontal bar the same material you previously
created for the palings.
Duplicate it ( ALT + D ) and move it (keeping CTRL pressed) along the Z axis ( Z )
to make the bottom bar.
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63.8.4. Make the Horizontal Bars (Right Side)

Figure 533

To make the bars on the right-hand part of the fence: In Front view, select both the horizontal bars you just created: RMB on one, then SHIFT + RMB on the other (you
may need to zoom in to be able to select them without accidentally including the rest of
the fence). Duplicate them with ALT + D . Move your duplicates along the X-axis X
until they are horizontally centred around middle of the right-hand fence; now scale them
horizontally S
X until they are the right size.
You could have done the bars one by one, but it’s quicker to do them both at once, don’t
you think?

63.8.5. Put the Horizontal Bars Around The House
Select the two horizontal bars you created above for the front fence (make sure you don’t
select anything else, like the palings). Press ALT + D to make a duplicate, then R
Z
to rotate the duplicate about the Z-axis, type 90 for the angle and press ENTER to conﬁrm
the rotation. In the top view, move the duplicate ( G ) you just made so it’s against the
side fence. Keep scaling it along the Y-axis ( S
Y ) and/or moving it along the Y-axis
( G
Y ) until it’s the right length and position.
Having done the side of the house, press ALT + D to make another duplicate of the
horizontal bars, and R
Z 90 ENTER to rotate it into the right alignment for the back
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fence. In the top view, move ( G ) it against the palings. Now keep scaling and moving it
along the X-axis until it has the right length and position.
Having done the back of the house, do the other side: another duplicate of the bars, rotate
90° around the Z-axis, move against the palings, move and scale until they’re the proper
length in the right position.
Again, another duplicate, rotate and move/scale into position against the palings on the
other side of the front of the house.

Figure 534

Your house should now look like this.

602

The Ground Plane and a Path

63.9. The Ground Plane and a Path

Figure 535

63.9.1. Make the Ground
In Top view put the 3D cursor somewhere near the middle of the plot, (click LMB )
Create a plane
Be in camera view (bottom right-hand window)
Scale it to extend just past the boundaries of what the camera sees (10.0 seems a good
number).
Go back into Object mode and change its (object, mesh) name to ”Ground”,
create a new material for it, rename it ”Grass” and select a suitable green from the colour
selector (”00cd00” green3).
Check in Front view that it is level with the bottom of the house and fence and move it
(along the Z axis) if necessary.
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63.9.2. Make the Path

Figure 536

For the path: Go into Top view, create a plane.
Scale it to ﬁt the gap in the front fence with some space on either side and position it just
outside the fence.
Check, in Front view, that it lines up with the door and is level with the bottom of the
house.
Scale it along the X axis to the same width as the door.
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Figure 537

Be in Top view, Select the two vertices closest to the fence, and extrude E
the house Y to make a suitable width for the footpath outside the fence.

away from

Figure 538
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Of those four vertices just outside the fence, select the left two and extrude a suitable
distance to the left, and then the right two and extrude a suitable distance to the right, to
make the path passing the house.

63.9.3. Give the Path Some Thickness
The path is still just a ﬂat plane. Let’s give it some thickness, so it rises slightly above the
ground.
Go to Object mode. Make sure the path is still selected. Go to the Modiﬁers Context

Figure 539

, click Add Modiﬁers, and look for Solidify. The default thickness (the top-left editable
ﬁeld) is 0.01; change this to -0.01 so the path protrudes above the ground rather than into
it.
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63.10. Improve the Lighting

Figure 540

If you were to try to render now, you will probably ﬁnd that most of your beautiful house
is lost in gloomy shadow. To ﬁx this, let’s add a bit more light to the scene.
In the top view, ﬁnd the existing default Lamp object. Duplicate it a couple of times, and
position your copies around the house to give it a more even lighting.
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63.11. Check the Camera View

Figure 541

Before doing the render, check your camera is properly positioned to capture the beauty
of your work. In the camera view (top-right quadrant of the split view), you should see
something like this; note the passepartout (darkened area) outside the rectangle denoting
the visible area of the scene that will be rendered. If you RMB on the rectangle, you can
reposition the camera from side to side or up and down with G , or do G
Z
Z to
move it closer to or further away from the scene.

63.12. Final Render
Now hit F12 , and hopefully you should see something like this!
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Figure 542
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64. Pipe joints
i Information
Applicable Blender version: 2.75
How to model pipe joints.

64.1. T joint
Start in top view, and delete the cube.
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Figure 543 Figure
1: Modeling a simple T joint.

• Add a cylinder object (Add->Mesh->Cylinder)
• 16 Vertices, Depth 4, Cap Fill Type Nothing (For recent versions of Blender create the
cylinder then press F6 to get these options)
• Switch to front view (View->Front or NUM1 ).
The X axis now points to the right. We will work along the X axis from now on.
• Change to Edit mode ( TAB ).
• Create a Loop Cut in the middle of the cylinder ( CTRL + R ).
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Make sure that the 3D cursor is placed in the middle of the cylinder ( SHIFT + S )
• Switch to right view ( NUM3 )
• Box select ( B ) the 7 vertices at the front
• Rip the mesh with V .
Tap on Proportional editing and set it to connected O , and select Falloﬀ Type to inverse
square SHIFT + O .
• There will be 7 overlapping vertex pairs: 7 vertices linked to the top half of the tube, and
7 vertices linked to the bottom half of the tube.
• Either the upper middle vertex or the lower middle vertex should be selected. Depending
on which set of vertices is now selected you will need to grab at the Z-axis by 1 (upper)
or -1 (lower) G Z NUM1 make the circle that indicates how round your hole will be
larger 'till you get a beautiful half circle.
• Once you have grabbed the ﬁrst, deselect ( A ), then select the other middle vertex
• grab at the Z-axis the selected vertex by +/- 1 BU. The pipe should now be straight
again thanks to the rotations.
Set ”proportional editing” oﬀ
• Box select B

the vertices of the gap and extrude ”edges” E

• Pivot -> Median Point (CTRL+,KEY)
• To ﬂatten the front: scale at the X axis by factor 0. ( S

X

along the X axis.
NUM0

).

• Add the Subsurf modiﬁer in combination with Set Smooth, LoopCuts,
• Use Edge Crease to get a nice transition. In Edge Select Mode select the edges around
press SHIFT + E and move the mouse until you're done.
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64.2. Six-cylinder joint

Figure 544

Figure 2: 6 cylinder joint

Be in Object mode (have nothing else selected)
Add a cube.
Switch to Edit mode
• (1)
Select all A , then Subdivide the cube once ( W , NUM1 ),
Select the 12 vertices in the middle of the cube's edges.
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• (2)
Scale by factor 1.4142 (press S

and type in the factor with the keypad) .

• (3)
Select all vertices, and Extrude ”Individual Faces” ( ALT + E
Select all vertices, W and Remove Doubles.

-> individual faces),

• (4)
Select the center vertex of each tube, and delete them ( X ) to open the ends.
• (5)
Select the original vertices in the middle of the object and delete them.
• (6)
Clean your mesh as described above.
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64.3. Three-cylinder joint

Figure 545

Figure 3: 3 cylinder joint

This is very similar to above, only the selection for scaling is diﬀerent.
• Select the middle vertices at the edges where the cylinders shall come from. Additionally
select the middle vertices at the faces that shall be kept free. You have to select 12+3=15
vertices.
• Scale your selection by 1.4142.
• Select the faces that shall be extruded.
• Extrude->Individual Faces (5)
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• Select all, then Remove Doubles.
• Delete the inner vertices (6, 7).
• Select 3 vertices (which were middle of faces that were kept free) and 1 corner vertex in
middle of the free faces (8).
• Make sure your 3D cursor is at the origin (and that you added the cube at the origin)
and switch to 3D Cursor Pivot (.KEY in v2.49b), then scale (SKEY), and type in 0.7071
(inverse of square root of 2, or Sin(45 degrees) or Cos(45 degrees)) and ENTER(9).
• Make sure you switch back to Median Point Pivot (SHIFT+,KEY) to straighten out
pipe ends (10).
Clean your mesh as described above.
If your joint looks odd, it might be because of some edges in the mesh. Delete those by
selecting it and delete (XKEY) edges (not vertices).
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64.4. T-joint with smaller diameter

Figure 546
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Figure 4a: Basic structure for a T joint with a smaller diameter

T-joint with smaller diameter

Figure 547

Figure 4b: The result

We're going to create a structure like in Fig. 4a and extrude the inner circle. To do that we
place a circle with Retopo (”Snap during transform”) on the cylinder and join both objects
afterwards.
• Add->Mesh->Cylinder
• 8 vertices (of course you can use more vertices if you like)
• No Caps
• Depth 4
• Noob note: More vertices in your cylinder will mean more intuitive work and ﬁguring
[more loop cuts, face making, etc.] later on when retopo-ing. First, follow the tutorial,
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•

•
•
•
•

then try to do a more advanced model with more faces / vertices when you understand
the tool. If you have trouble getting really nice geometry, do a search for some tutorial
videos. There are many really helpful ones.
Add->Mesh->Circle (Noob note: To make sure you create these as separate objects, be
in Object Mode (not Edit Mode).)
• 8 vertices
• No ﬁll
Rotate the circle by 90° at the Y axis (R->Y->90).
Move the circle in front of the cylinder(G->X->2).
Switch to side view (Num-3).
Scale the circle to the diameter of the smaller cylinder.

(Noob note: I felt this was a little unclear. What the author means is, scale the circle
down until it is the size of the diameter of the smaller cylinder you are going to create from
it later by extrusion. Scale it so it ﬁts (straight backwards from view) inside the two closest
faces of the cylinder as per Fig. 4a if you wish to follow the tutorial.)
• Switch to edit mode, select all vertices of the circle.
(Noob note: To recap: you should be in edit mode for the circle, with the all of it selected,
with the cylinder object directly behind it in from your viewpoint in orthographic mode.)Make
sure that you don't work in Wireframe view.
• Click on Snap during transform, that is the icon of the magnet in the 3D view header,
select ”Face” and after that a third box will appear, select there ”closest”. After that,
push: ”num3” and then ”G key” and reposition it a little. After that you will see it lies
perfectly around the cylinder.
(Noob note: What ”retopo” (Snap during transform) does [in this case]; is project the
selected topography of an object in edit mode directly backwards from your selected view
point onto the topography of another [separate] object. So you must be lined up view-wise
for this to work. It is necessary to press the Enter key for the ”Snap during transform” to
take eﬀect even if I've selected it with the LMB .)
If the vertices of the circle are not adjacent to the cylinder but have jumped to wrong places
undo the last step (Ctrl-Z), deselect and reselect all vertices and try again. This does help
(strangely). Snap during transform works with limited accuracy, if the vertices don't ﬁt
perfectly you have to move them by hand.
• Change to object mode, select additionally the cylinder and join both objects (Ctrl-J).
Now you work best in Wireframe view.
•
•
•
•
•

Add three loop cuts (Ctrl-R->3)
Delete the middle vertex.
Connect the free vertices (F).
Select the circle.
Extrude and clean up.
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65. Lighting Suzanne: Introductory one
lamp lighting
i Information
Applicable Blender version: 2.69
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66. Lighting Suzanne: Introductory one
lamp lighting
If you have followed all these tutorials you now have quite a library of images: A simple
ﬁgure with a hat, a penguin, a volcano, a jeep and several goblets, not to mention dice, a
head and a house! To show them oﬀ to best eﬀect, you need to experiment with lighting.
Lighting is a complex subject, as any photographer can tell you. Blender allows many
diﬀerent arrangements and numbers of lamps to be used in combination to light your image.
For this introductory tutorial, let us consider single lamp lighting and do some experiments
to see how it works. (In later sections more complicated lighting is covered: Lighting Rigs1 .)

66.1. Suzanne, Our Star
We need an object to light. Who better than Blender's favorite resident simian, Suzanne!
Open the default startup page. Delete X the default cube. Be sure the 3D cursor is at
the origin. Add a plane. Add>Mesh>Plane, scale it up nice and large S 2KEY 0KEY ,
and in the Properties panel (which by default is the lower right panel) add a material

1

Chapter 97 on page 937
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Figure 548

color such as light blue that will render well. In that same panel be sure that under
SHADOW the Receive box is checked.
Now Add Suzanne, the famous monkey. Add>Mesh>Monkey. Move her up about 1.5
Blender units so she is above the plane but close to it. G Z
1KEY
.KEY
5KEY .
Rotate her around the Z axis so she is facing the Right View. R Z 9KEY 0KEY . Add
a material
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Suzanne, Our Star

Figure 549

color such as red (red is my favorite color).
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66.2. The default light

Figure 550

Default Quad view

Figure 551

First Render

Now lets change to the Quad view, which you should refer to extensively throughout this
tutorial. Press CTRL ALT Q to bring up this view. You now have the TOP, FRONT
and RIGHT ORTHO views. In the top right you will see your camera view. Suzanne should
be seen in 3/4 proﬁle just above the plane. If not, rotate and scroll in or out until she is.
Then I suggest you bring up the object panel N , scroll down to View and put a check
next to Lock Camera To View.
In the outline panel, select Lamp. You will see the default lamp position. In Ortho Quad
view, we can see that the default lamp is up, in front of and slightly to the right of Suzanne
as she now faces. If you don't see it, scroll out in each view window until the lamp shows
up as a point with a double dashed circle around it.
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When your screen looks like the screenshot, render for the ﬁrst time to get a good image of
Suzanne and her shadow.

66.3. Types of lamps
Lamp should still be selected in the Outline panel. In the Properties panel, click the

Figure 552

button to see the properties of the light. The default lamp is a POINT lamp with ENERGY
1.000. Let's experiment with those settings. First, click in turn each of the diﬀerent kinds
of lamp, SUN, SPOT, HEMI and AREA, and render after each one. You can see that each
of the light types has its own characteristics. With the light in the default position, your
images should look like this:
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Figure 553

Comparison of light types.

66.3.1. Point lamp
This is the default type. The light rays are assumed to originate in a single point and spread
from there. At the default value of ENERGY 1.000 is not very bright and covers a limited
area. It casts a good sharp shadow. Point is the basic general purpose lighting in Blender.
Advanced lighting rigs will frequently use several point lights with diﬀerent settings.

66.3.2. Sun
The sun is assumed to be inﬁnitly high in the sky so its rays are all parallel. It puts out
a bright light and casts heavy shadows. It is the lighting type of choice for outdoor scenes
but can also be used to good eﬀect indoor.

66.3.3. Spot
The Spot lamp behaves very much like a theatrical spotlight (DUH). It casts a limited circle
of light. Within the circle it is bright and casts a heavy shadow, but outside the circle all is
dark. (Note: Under the Shadow setting, the Spot lamp is the only one that can cast a Buﬀer
shadow. The distinction is subtle but important in some more advanced applications.)

66.3.4. Hemi
The Hemi lamp resembles lights photographers choose for indoor shots. It is the only kind
of light that does not cast shadows. It gives a very bright lighting that is relatively even
over the entire picture.

66.3.5. Area
This light behaves more like a ﬂood light, as if the area is ﬂooded with it. It is extremely
bright and casts a very heavy shadow.
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66.4. Light Energy
Each type of light has its own brightness. This is controlled mostly by the ENERGY setting
of the light. Obviously less energy reduces the amount of light, more energy increases it.
Still in the Properties panel, try diﬀerent settings for ENERGY and see how it aﬀects the
image.
Begin with energy increased to 2.000. Render each type of lamp. We can see that reacts
diﬀerently to the energy settings. Area is almost too bright at Energy 2.000, while Point
and Spot are just reaching nice bright levels. Sun is ... Sun. Remember that it is inﬁnitely
far away and its rays are parallel. Little changes with the Sun. Now reduce energy to 0.300
and render each type of lamp. Point and spot at these settings are way too dim, while Area
becomes a very useable setting.

Figure 554

Lighting varying energy settings

66.5. Distance and Height
The distance of the lamp also aﬀects brightness and its position aﬀects several things,
particularly including the shadows. In the quad view, grab the default lamp and raise it
up quite high, say to Z=25. The light falls oﬀ with distance, so point becomes very dark.
The spot area increases with distance so the circle in the spot example is now quite large.
The Sun ... well, the sun was inﬁnitely far away already, remember? The shadow cast by
the sun does not change, and hemi still casts no shadow. But the shadow cast by the other
three lights moves considerably and is now almost directly under Suzanne.
Lower the lamp to Z=3, placing it almost directly at a level with the subject. Both the
distance and the angle of light change. The brightness increases, the size of the spot circle
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shrinks, and now the shadow is long and far behind the subject, except, of course, for the
Sun which remains inﬁnitely far away and casts parallel rays.

Figure 555
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Eﬀects of height on lighting

Rotation

66.6. Rotation

Figure 556

Eﬀects of Rotation on lighting

The last setting we will consider in this lesson is Rotation. The Point light cannot be rotated
since it is equal in all directions. Each of the others reacts diﬀerently to being rotated.
The Sun ﬁnally shows a diﬀerent eﬀect when rotated. I am not sure how Blender interprets
the diﬀerence between location and rotation for the Sun. It seems rather counter intuitive.
The sun when rotated seems to me to behave as if it has been moved. But in any case you
can see that the shadow and the lighting show a distinct diﬀerence.
The Spot behaves very much like a real spotlight. Its circle of light moves with the rotation
and frames whatever it is pointed at.
The Hemi lamp also ﬁnally shows a bit of diﬀerence. Even pointing it entirely way from
the subject still lets light leak through it and give that same shadowless ﬂat lighting.
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The Area lamp has its characteristic brightness over a large ﬁeld, and then suddenly cuts
oﬀ in to total blackness. The contrast is very striking.

66.7. Experiment!
You can experiment with other placements of the light, and see the eﬀects on the illumination and the shadow. There is an almost inﬁnite variety of ways to light a Blender image,
and this is just with a single lamp. Multiple lamp setups increase the variety many fold as
will be seen in the Advanced portion of this tutorial.

66.8. Note on Transparency

Figure 557

Where does that shadow come from?

Figure 558

Plane Shadows set to Receive Transparency
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Note on Transparency
A special case of lighting is transparent objects. What sort of a shadow do transparent
objects cast? You can try an experiment. Click on Suzanne to select her. Now in the
Material panel

Figure 559

scroll down to Transparency and put a check in the box. Just below that is the Alpha
setting, which controls the amount of transparency, with 1.000 being fully opaque and
0.000 being completely transparent to the point of invisibility. Lets try setting it to 0.200
for an almost glassy eﬀect. Render your view, and then ask yourself, why does this glassy
object still cast a thick black shadow in the render?
The answer is not in Suzanne, but in the settings for the plane which is her background.
Recall that we checked Receive under shadows for that plane. But go back to the properties
panel for the plane, and notice that there is another check box under Shadows that says
Receive Transparent. By default, to save rendering time, Blender assumes that all objects
block light equally. Only if that box is checked does it make a check for transparency in
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the object casting the shadow. Now render your view and you will see that the shadow is
suitably glassy.
Experiment with this one. Try diﬀerent types of lamp (Area is so strong that transparent
objects eﬀectively disappear) and diﬀerent values for the alpha setting. You might want to
remove the color material from Suzanne and see what eﬀect that has.

66.9. Note on World Lighting
It is not absolutely necessary to use any lamp source. In the World panel

Figure 560

you will ﬁnd several lighting settings that simply produce light throughout the scene without
any particular source. Experiment with Environment Lighting and Indirect Lighting and
see the eﬀects they produce.
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67. Overview
67.1. Why Use Curves?
You’ve learned how versatile mesh objects can be, and how they can easily produce ﬂat
surfaces with sharp edges and even give a convincing representation of curved surfaces with
rounder edges. So why do we need a separate kind of curve object at all?
There are important reasons.
• The various kinds of curves and surfaces/patches (Bézier, NURBS etc) were used in
computer graphics before meshes were developed. In the days when memory was more
expensive, they oﬀered a more compact way to represent complex shapes. Even now, they
are still common in CAD and other technically-oriented graphics applications, where they
make it easy to precisely specify the shape of a curve. Thus, if you are importing data
from such applications, you will need the ability to represent such curves—even if you
end up converting them to meshes before applying materials and textures for rendering.
• You can use curves as guides for shaping meshes. This makes it easier to construct certain
kinds of complicated curved shapes. Particularly since it is simpler to make changes to
the curve (with fewer control points), than after it has been converted to a mesh. To this
end, Blender deﬁnes scaling radius and tilt angle settings for curve control points, which
make no diﬀerence to the appearance of the curve itself, but have an eﬀect when it is
used to deform another shape.

67.2. Bézier Versus NURBS
In the following pages, you will come across two kinds of curves/patches.
Note:
If we consider that a surface needs always be two-dimensional or more. A curve, that
in one dimension is simply a line, needs at least be two dimensional when represented
in a surface for the curvature to be expressed. What Blender calls a two dimensional
“surface” is elsewhere in computer graphics commonly referred to as a patch.
Bézier objects only occur in Blender as curves, while NURBS (“Non-Uniform Rational BSpline) objects can be curves or surfaces. If you’ve used 2D drawing programs like Inkscape
or Adobe Illustrator, you would have come across Bézier curves before. NURBS curves are
a mathematical generalization of these, which are heavily used in CAD applications. Unlike
Bézier curves, NURBS curves allow the speciﬁcation of a variable weight for each control
point, which governs how closely the curve passes to that point.
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Note:
That‘s right, “NURBS” is singular, not plural. You will often hear people say “one
NURB, many NURBs”, but really it should be “one NURBS, many NURBSes”. Or
alternatively, you can ﬁnesse the issue by only using “NURBS” as an adjective: “one
NURBS curve/surface/object, many NURBS curves/surfaces/objects”.

67.3. More Than You Wanted To Know About Curves
As usual, Wikipedia has the lowdown on all the interesting trivia about
• Bézier curves1
• NURBS curves2

1
2
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https://en.wikipedia.org/wiki/B%25C3%25A9zier_curve
https://en.wikipedia.org/wiki/Nurbs

68. Intro to Bézier Curves
i Information
Applicable Blender version: 2.75
Note: Some pictures are outdated.

68.1. Bézier Curves

Figure 561

It should look like this.

• First start a new Blender project, and delete the default cube.
• Press: SHIFT + A → Curve → Bezier to create a new curve. Switch to top view
NUM7 for a clearer look. You may want to zoom in a bit as well. TAB into Edit mode.
The black line with the extra angled lines like centipede legs coming oﬀ it is the Bézier
curve. The white or orange dots are the control points, with the ones in the middles of the
pink handle lines deﬁning the endpoints of the curve segment.
Press A to deselect the selection, so that all the control points turn black, and the lines
connecting them turn red. You can RMB on any point to select it; however, selecting a
curve endpoint selects the entire handle line passing through it.
You can move a selected point in the usual way, with G : note how moving an endpoint
causes the curve to bend so it always connects to the endpoint. Moving just a point at
the end of a control handle aﬀects the inner part of the curve, making it bend more or
less sharply away from the endpoint: try moving one of these points around, and note how
the handle gets longer or shorter, and automatically rotates as necessary to remain a single
straight line.
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Alternatively, you can select an endpoint (which selects the entire control handle, remember)
and use R to rotate the handle, and S to make it longer or shorter.

68.1.1. Resolution

Figure 562

In the Curve Context
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Figure 563

in the Properties window, further down you will see the Active Spline panel. (This is only
visible in Edit mode.) Note the editable ﬁeld next to the label “Resolution:”, probably
showing “U: 12”. That number governs the number of straight-line segments that the curve
is converted into for rendering purposes; the more of these, the smoother the result, but it
will add a bit to the render time.
Note:
That’s right. As embarrassing as it may sound, Blender cannot actually
render curves. It has to approximate each curve by a series of straight-line segments
before rendering.
This resolution setting is also used when converting the curve to a mesh ( ALT + C ).
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68.1.2. Extending Your Curve
So far your Bézier curve only has one segment. You can add segments in several diﬀerent
ways:
• Back in EDIT mode, RMB on an endpoint at either end of the whole curve, and use E
to extend a new curve segment connected to the same endpoint. (We won’t say “extrude”,
to avoid confusion with a diﬀerent extrusion function discussed further down.)
• RMB on an endpoint at either end of the whole curve, and CTRL + LMB where the
endpoint of the new segment will go; the new segment will immediately be added between
the previous endpoint and the new one.
• Select the endpoints of a single curve segment, press W and choose “Subdivide” from
the menu. This splits the curve segment into two new connected segments.
Note that if you CTRL + LMB when the selection is not precisely one endpoint of the
whole curve, it will add a new handle that is not connected to any part of the existing
curve. You can extend from this handle to create a whole set of new curve segments that
are still part of the same curve object, even though there are no lines running between this
piece of curve and the previous one. You can join two separate pieces of the curve with a
new segment by selecting an endpoint of each and pressing F .
You can also add new pieces with SHIFT + A

in Edit mode.

Note:
Curves cannot have branches. However, depending on your purposes, you could
simulate the appearance of a branch by overlapping the end of one piece on top of
another one.

68.1.3. Removing Points and Segments
You can delete any control points by selecting them and using the familiar DEL or X .
The menu that pops up asks you if you want to remove the “Selected” points, the “Segment”,
or “All”.
• “Selected” removes all points that are part of the same handle(s) as the selected point(s).
Removing an endpoint of a curve piece removes the connected segment. Removing an
interior endpoint causes the replacement of the curve segments on either side of it with
a new one running directly between their remaining endpoints. Thus, the curve piece of
which that segment was a part remains a single curve piece afterwards.
• “Segment” removes a segment between two connected endpoints. If neither endpoint was
an endpoint of the curve piece, then the remainder of that piece of the curve becomes
two disconnected pieces.
• “All” removes all of the control points, leaving an empty curve object!
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68.1.4. Handle Types
So far, all the handles on your curve have been aligned. This means that adjacent curve
segments are guaranteed to join smoothly. If you select a control point and press V , you
will get a menu allowing you to set other types for the handle:
• Free means the two parts of the handle on either side of the endpoint are free to rotate
independently, so the two curve segments can now meet at a corner.
• Vector means the selected part of the handle points at the other endpoint of the same
curve segment, and will keep pointing that way even if you move either endpoint. If you
set the part of the handle from the other endpoint pointing back this way to “Vector” as
well, then the curve segment becomes a straight line. However, as soon as you explicitly
move the handle itself, it reverts to being “free”.
• Automatic is like “aligned”, except Blender will automatically adjust the orientation of
the handles as you move the endpoints, to try to keep the curve smooth. Moving either
end of the handle will change it back to “aligned” type.

68.1.5. 2D Versus 3D
At the top of the Shape panel in the Curve Context
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Figure 564

in the Properties window, you will see buttons labelled “2D” and “3D”. “2D” means the
points of the curve are constrained to lie in a single plane, while “3D” means they are free
to be located anywhere in 3D space relative to each other. Initially “3D” should be selected.
Try moving one point along the Z axis. Now click the “2D” button, and you should see all
the points you moved snap back into the same plane as the rest. Also the “centipede legs”
along the curve should have disappeared (their presence indicates a 3D curve). You can
alter the orientation of this plane by TAB bing into Object mode and then rotating R
the whole curve about any desired axis.

68.1.6. Closing, Filling and Extruding
Each curve piece can be individually closed, meaning that an extra curve segment is automatically added between the two endpoints of the piece. This is governed by the “Cyclic:
U” checkbox in the Active Spline panel in the Curve Context
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Figure 565

. Each closed piece of a 2D curve is automatically ﬁlled to form a ﬂat surface.
Note:
What happens if two ﬁlled pieces of a 2D curve cross? If you try this, you will
see that the overlapping parts are subtracted from the ﬁlled areas, leaving holes. Those
familiar with the various options for ﬁlling Bézier curves in 2D drawing programs will
recognize this as the even-odd ﬁll rule.
The curve can also be extruded into the third dimension, eﬀectively turning it into a ribbonlike shape. Look for the “Extrude:” editable ﬁeld in the Geometry panel, and put a nonzero
value into that to specify the extrude width.
If you extrude a 2D closed curve, the ﬂat surface becomes a solid object, and the result is
a prism—a solid shape with a uniform, but arbitrarily complicated, cross-section.
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68.1.7. Scaling and Tilting
Turn your curve into a ribbon by specifying a nonzero Extrude value. Change your view
so it is not exactly from the top or bottom, but at some angle. Notice how the ribbon is of
constant width and always perpendicular to the plane of your curve.
Select an endpoint, and press ALT + S . As you move the mouse, you are changing
the radius of the endpoint from its default 1.0 value, and this causes a corresponding scale
factor to be applied to the width of the ribbon at that point. You can see (and also edit)
this radius value in the Properties Shelf N , in the Transform panel at the top.
With an endpoint selected, now try CTRL + T (Note: This only has an eﬀect with 3D
curves, not 2D ones). Now as you move the mouse, you are applying a tilt angle, which
correspondingly alters the angle of the ribbon at that point. This value is also accessible in
the Transform panel in the Properties Shelf.
The scale radius and tilt become particularly useful when you apply a bevel shape to the
curve—then you will start to get much more complicated shapes than simple ribbons.
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68.2. NURBS Curves

Figure 566

Start a new Blender document, and get rid of the default cube.
This time, do SHIFT + A → Curve → Nurbs Curve, and TAB into Edit mode. The
result looks a bit similar to a Bézier, except there are no control handles, only the segment
endpoints. Instead of dragging handles, you can adjust a weighting assigned to each control
point. Bring up the Properties Shelf with N if it is not already visible. If you have a
single point selected, in the Transform panel at the top, you should see four editable ﬁelds
under the heading “Control Point:”, labelled “X:”, “Y:”, “Z:”, and “W:”. The ﬁrst three are
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of course the position of the point; the “W” value is like a gravitational ﬁeld strength that
attracts the curve to the point. Try adjusting this, and see how it inﬂuences the shape of
the curve near that point.
Note:
Ignore the “Weight:” ﬁeld further down. That has a diﬀerent purpose we won’t
discuss here.
You can move endpoints in the usual way, but there are no handles to rotate. All the
other options for add and deleting endpoints apply as for Bézier curves: CTRL + LMB
or E xtend, W →Subdivide, DEL eting Select/Segment/All. The curve can be 2D/3D,
extruded and cyclic, and each endpoint has a ALT + S cale radius and a CTRL + T ilt
angle. In the “Active Spline” panel in Object Properties, there is an additional “Endpoint:
U” checkbox which forces the curve to pass through the endpoints (this is ignored if Cyclic
is enabled).
Note:
You can mix Bézier and NURBS curve pieces in the same curve object. Just use SHIFT
+ A to start a new piece of the desired type in Edit mode.
SHIFT + A →Curve→Nurbs Circle inserts a NURBS curve with eight control points
arranged in a square, “Cyclic: U” enabled, and the weights of the corner points adjusted so
the curve is an exact circle.
SHIFT + A →Curve→Path inserts a NURBS curve with ﬁve control points in a straight
line, and the “Endpoint: U” option already checked.

68.3. Which Curves To Use?
As mentioned earlier, NURBS curves are heavily used in CAD applications, while Béziers
are popular in 2D drawing applications. If you are importing data from these applications,
then you won’t have any choice about which one you end up with.
But if you are creating your own curves, then you have a choice. If you have done drawing
with Bézier curves a lot, then you should feel at home with them. If you just want simple
curves to deform a shape or guide an animation, NURBS curves could very well do the
trick—you could even leave the W values at the default, and just add, delete and position
points to get a suitable curve.

68.4. Extruding from 2D to 3D
You may have noticed you can only modify the curve in two dimensions, and now it's time
to explore the third dimension! Extruding is where you deﬁne a two dimensional 'proﬁle'
shape, and it is 'swept' through space to create a volume.
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Noob note Bézier circles are not true circles, they are approximations. For artistic purposes, this may not really matter, but for precision modelling only NURBS circles should
be used. This is due to the math used to describe the Bézier and NURBS curves.

68.5. Make a Simple Face of Bézier Curves
• Make a curve and ﬁll it: Being sure you are in 2D mode, Use the steps above to create
something simple, and ﬁll it in using
ALT

+ C .

Noob note: you may ﬁnd it easier to use Bézier circles, instead of ﬁlling discrete curves.

Figure 567

Note that the eyes and mouth of the face above are parts of the same curve object. Blender
can only identify holes in a ﬁlled curve if the holes are part of the same object as the
outer curve. If you had created four separate curves then ﬁlling the outer curve would have
covered the eyes and mouth. To create a detached section of a curve, be in edit mode and
deselect all the points ( A ). Then create new points (you will need two or three) with
CTRL + LMB . Alternatively you can create the pieces as separate curve objects and join
them later with CTRL + J in object mode. You might prefer the alternative way if you
don't want a lot of control handles and ”centipede legs” to distract you.
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68.5.1. Extrude the Simple Face

Figure 568

Set the extrude depth: Click on the Object Data button and ﬁnd the Geometry panel.
(Older versions: ﬁnd the 'Curve and Surface' box in the Editing tab of the Buttons window.)
There is a slider called Extrude. Set the Extrude depth to something other than 0, and
probably less than 1.
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Figure 569

Behold, your 2d curve has transformed into a neat 3d structure. The great thing is, you
can still edit the curve as if it were just 2d, and the changes will update in real time.

68.5.2. Bevel the Simple Face
Now you have an extruded shape, you should start playing around with some of the other
curve settings on oﬀer, so here is a description of how the Bevel depth and Bevel resolution
sliders work.
Try setting the Bevel depth to a small value, say 0.02. This will cut oﬀ all of the sharp
edges, and give a bevelled eﬀect all around the shape.
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Figure 570

As you may guess, Bevel resolution decides how many times the algorithm divides up an
edge. Higher values than 0 result in smooth curves rather than sharp edges, but dramatically
increase the number of vertices in the shape.
Try setting the resolution to 3 or 4, you should see an eﬀect like this:
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Figure 571
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69. Bevelling a Curve
i Information
Applicable Blender version: 2.67
A simple, non-extruded curved line on its own will not be visible when rendered in Blender.
Things are diﬀerent, however, when you bevel the curve—that is, use some two-dimensional
shape as a cross-section, and the line curve becomes a guide for extruding the shape into
the third dimension.

69.1. Built-In Bevel

Figure 572

Bézier curve with default settings

Start with a curve object—any curve will do. Here we use a Bézier curve.
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Figure 573

upright

Look in the Curve Context
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Figure 574

in the Properties window, for the Geometry panel. There you should see two editable ﬁelds
with the title “Bevel:” above them, one labelled “Depth:” and the other “Resolution:”. Try
setting the depth to something like 0.1.
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Figure 575

Bëzier curve with bevel = 0.1, ﬁll = half, resolution = 0

Now your curve is no longer a simple line. It should have a V-shaped cross section, perhaps
like a piece of bent angle iron.

Figure 576

Bëzier curve with bevel = 0.1, ﬁll = half, resolution = 3

Now try increasing the “Resolution:” value, and you should see the V cross section start to
smooth out, until at about a resolution of 2 or 3, it looks like a curved half pipe.
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Now look further up, in the Shape panel. There should be a popup menu with the title
“Fill:” above it; for a 3D curve, by default the item selected is “Half”. Try the “Front” and
“Back” items, and you should see that these give you just halves of your half pipe.

Figure 577

Bézier curve with bevel = 0.1, ﬁll = full, resolution = 0

Figure 578

Bézier curve with bevel = 0.1, ﬁll = full, resolution = 3

Now try “Full”, and your half pipe should now be a complete pipe.
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Figure 579

Bëzier curve with bevel = 0.1, ﬁll = full, resolution = 3, cyclic

You can also join the ends together by checking the “Cyclic: U” box under the Active Spline
panel.
Start and End Bevel Factors: These reduce the extent of the bevel shape, so that instead
of extending the full length of the curve, they go from and to the speciﬁed fractions of the
length. These become more useful when the cross section of the shape is no longer uniform,
when you apply a custom taper (below).

Figure 580
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Bézier curve, 2D, cyclic

Built-In Bevel
Now change the curve to 2D. The Fill options now become “Both”, “Front”, “Back” and
“None”, where “Both” is like the “Half” setting for 3D curves. Note there is no equivalent of
“Full”. But there is a new feature: if you check the “Cyclic: U” box, it will ﬁll in the entire
interior of the curve!

Figure 581

Bézier curve, 2D, cyclic, extrude = 0.1

Try this with a Bézier circle or a NURBS circle, and you should get a pancake-like object.
For added ﬂavour, give it a nonzero Extrude value, and this will make the shape even
thicker.
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Figure 582

660

Bézier curve, 2D, cyclic, extrude = 0.1, bevel = 0.1, resolution = 3

Custom Bevel

69.2. Custom Bevel

Figure 583

selecting just the end points of the handles

Now we will try using another curve to supply the cross section. Add a Bézier circle shape.
TAB into Edit mode. Now, select just the end points of the handles (not the control points
themselves). In the Pivot Point menu, select “Individual Origins”. Now S cale down to
0.4.
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Figure 584

662

if they highlight like this, you’re doing it wrong

Custom Bevel

Figure 585

handles scaled to 0.4

The result should be something close to a square, but with rounded corners.
Go back to your ﬁrst curve, and ﬁnd the ﬁeld titled “Bevel Object:” in the Geometry panel
in the Curve Context
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Figure 586

properties. Click on it, and a popup menu should appear, and you should see the name of
the second curve (e.g. ”BezierCircle”). Select that name, and you should see your bevelled
curve immediately take on the cross-section of the new curve.
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Figure 587

In fact, you may ﬁnd the bevel object is a bit large; select it and, while still in Object mode,
S cale it by a factor of 0.1. The result should appear something like this.
Note:
Only a curve can be used as a bevel. In particular, meshes won’t work, but if
necessary you can convert a mesh to a curve and then use that as the bevel shape.
Select the second curve again, go into Edit mode, and try messing around with the control
points: you should see your changes immediately get reﬂected in the shape of the bevelled
curve. You may ﬁnd that the orientation of the second curve doesn’t coincide with the
orientation of the bevel cross-section. This is easy to ﬁx, because any change you make to
the rotation and position of the second curve in object mode will have no eﬀect on its use
as a bevel, so you can freely reorient and reposition it to make it easier to match its shape
up with the bevel cross section. (Scaling does, however, have an eﬀect.)
Note:
Tilt and Radius: Go back to the ﬁrst curve, and try the radius-scaling ALT + S
and tilting CTRL + T functions you previously learned about. You will see that they
aﬀect the scaling and orientation of the bevel cross-section along the curve.

69.3. Custom Taper
Now try adding a third curve object. (As with custom bevels, only curve objects will work.)
Go back to your ﬁrst curve, ﬁnd the “Taper Object:” ﬁeld (it should be next to the “Bevel
Object:” ﬁeld you’ve already used), and select the name of your newly-added curve. The
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bevelled shape will now most likely squish down in a most peculiar way. Select your third
curve, that you are using as a taper, and go into Edit mode. Now try adjust control points,
and observe the eﬀect on the bevelled shape: what you should ﬁnd is that the objectlocal Y-coordinate of each control point governs the thickness of the bevelled shape at the
corresponding position along the shape given by its X-coordinate, while the object-local
Z-coordinate doesn’t have any eﬀect.
As with the bevel shape, you can freely rotate and reposition (and this time, even rescale) the
taper shape in object mode, and it will have no eﬀect on its taper function: only alterations
of the control points in edit mode have an eﬀect.
Note:
Tilt still works. Try ALT + S and CTRL + T on the ﬁrst curve as before; you
should ﬁnd that the former is now ignored (the size of the cross section being completely
governed by the taper shape), but the latter still works.
Note:
The taper object should not have its own nonzero bevel or extrude
settings. This only confuses the issue.
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70. NURBS Patches
i Information
Applicable Blender version: 2.67
What Blender calls surfaces are more commonly referred to in computer graphics as patches.
It makes sense to stick to the commonly-accepted terminology, particularly when talking
with users of other software.
You previously saw how a NURBS curve consisted of a single row of any number of control
points. A NURBS patch consists of an n-by-m grid of points, where n and m can be any
positive integer (and not necessarily equal). The grid has a rectangular topology, but of
course the points may be positioned anywhere in space, to shape the curve accordingly. The
resulting object can look a bit like a mesh in edit mode, but it behaves very diﬀerently.
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70.1. Your First NURBS Patch

Figure 588

Start a new document, delete the default cube, bla-bla-bla, but stay in Object mode. Add
a new NURBS surface: SHIFT + A →Surface→NURBS Surface. Switch to Edit mode,
and ﬁnd the Surface Context
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Figure 589

in the Properties window.
For NURBS curves, you previously had the “Cyclic: U” and “Endpoint: U” options for
making the curve open or closed, and extending all the way to the endpoints or not. Now
you also have “Cyclic: V” and “Endpoint: V”, because the surface has two dimensions, and
you can control these settings independently along each dimension. Try checking just one
Cyclic box at a time, and the patch turns into a closed ribbon shape along the corresponding
dimension; check both, and it forms a solid object, shaped perhaps reminiscent of a pillow
or an unusual loaf of bread.
As with the curve case, you can move selected points around to alter the shape of the
curve, and adjust the “W” value of each point to control how strongly it attracts the curve.
Radius-scaling and tilt settings are still adjustable, but don’t seem to achieve anything,
since you can’t apply a bevel to a surface.

669

NURBS Patches

70.1.1. Adding and Removing Control Points
Adding and deleting points in a NURBS surface need to follow some rules. The irritating
thing is, if you try to do things not in accordance with these rules, Blender will simply
ignore you, with no error message.
Remember how I said that the control points form a n-by-m rectangular grid? Any addition
or deletion of points must preserve this characteristic. Thus, you can only add or remove
points an entire row or column at a time. For example, to extend the patch, you select all
the points along one outermost edge of it, and press E to add the same number of new
points.
UNKNOWN TEMPLATE multiple image
center
Select a complete row of points
Extrude the selected row of
points
Select a complete row of points...
...Extrude the selected row
of points.
horizontal
Blender267NURBSPatchSelectRowOfPoints.png
Blender267NURBSPatchExtrudeRowOfPoints.png 250
Or you can select all the points in two adjacent rows or columns, and use W →Subdivide
to add a new row/column of points in-between. Similarly, you can only delete points by
selecting an entire row or column of them at a time.
UNKNOWN TEMPLATE multiple image
center
Select two complete rows of points
Subdivide by adding a new row
of points
Select two complete rows of points...
...Subdivide by adding a
new row of points.
horizontal Blender267NURBSPatchSelectRowOfPoints.png
Blender267NURBSPatchSubdivideRowsOfPoints.png 250

70.1.2. NURBS Curve, NURBS Circle?
The ﬁrst two options in the SHIFT + A →Surface menu are “NURBS Curve” and “NURBS
Circle”. Try adding these objects; at ﬁrst glance, they look exactly like the “Nurbs Curve”
and “Nurbs Circle” entries in the SHIFT + A →Curve menu. However, regardless of
appearances, these really are surfaces, not curves.
To observe the diﬀerence, ensure all points are selected, and now use E to extend the
curve: this will create a whole row of new control points, instead of just one! As with the
diﬀerent options in the SHIFT + A →Curve menu, the ones in SHIFT + A →Surface
oﬀer premade objects for you to choose whichever is the most convenient starting point for
the shape you actually want to create.
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71. Deforming Meshes using the Curve
Modiﬁer
i Information
Applicable Blender version: 2.75

71.1. Understanding the Curve Modiﬁer
The curve modiﬁer lets you use a curve shape to deform a mesh. The mesh will follow
every twist and turn of the curve as far as it can bend, depending on how many vertices it
has—clearly, the more vertices there are, the more faithfully it can follow the curve.
The curve modiﬁer is also very easy to confuse yourself with if you’re not careful in how
you set it up. A common situation is you try to move the deformed object in one direction,
but it ends up moving in a completely diﬀerent direction! This happens when you choose
a deformation axis that doesn’t correspond to the predominant orientation of the points in
the curve.
There are in fact some predictable rules that govern the behaviour of the curve modiﬁer.
Once you understand these rules, you shouldn’t need to keep trying diﬀerent things at
random to try to achieve the eﬀect you want, you should be able to go straight for it.
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71.1.1. A Simple Example

Figure 590

Grid plus path objects, ready for action

Let’s do an illustrative example to clarify things. Start a new Blender document; delete the
default cube, and add a grid object instead, with the default 10×10 subdivision to give it
plenty of vertices that can be deformed. Also add a path curve on top of it—this will give
you a NURBS curve with 5 points, initially in a straight line. The result should look like
at right.

Figure 591
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Grid deformed by path, default settings

Understanding the Curve Modiﬁer
Now RMB on the grid, go to the Modiﬁers Context

Figure 592

in the Properties window, and add a new Curve modiﬁer which you will ﬁnd in the ”Deform”
column. Click under ”object” in the empty box and choose ”NurbsPath”.
The grid object should immediately jump a little way in the direction of the negative X-axis.
Why?
Note:
Rule One: The oﬀset of the ﬁrst point on the curve in its local coordinate system is
also used to oﬀset the origin of the deformed shape.
If you select the curve and TAB into Edit mode, you should see that, while the origin
of the curve’s local coordinate system (the fat orange dot) is in the middle of the curve,
the ﬁrst point (the one at the end of curve in the same direction that the “centipede legs”
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are pointing) has a negative X-coordinate. Select just that point, and from the Snap menu
SHIFT + S , do “Cursor to Selected”. Now TAB back into Object mode, and from
Object→Transform do “Origin to 3D Cursor”. This will adjust the origin of the curve’s
local coordinate system to that ﬁrst point (keeping the curve itself in the same place),
whereupon the grid object should jump back to its original location.
Note:
Corollary to Rule One: You will make things a lot simpler for yourself if you change
the origin of the deforming curve to coincide with its start point.
You can of course freely move around, add and delete the other points. Just be sure to keep
that ﬁrst point always at the origin of the curve.

Figure 593
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Now look at the settings for the Curve modiﬁer. Notice those six buttons under “Deformation Axis:”?
Note:
Rule Two: The Deformation Axis is interpreted according to the local coordinate
system of the deforming curve.
When a path curve is created, all its points initially lie along its local X-axis. Since the
default for the Deformation Axis is “X”, all works pretty much as you expect. If the two do
not coincide, then weird things happen when you try moving things around.
If you really want to mess around, you could go into Edit mode on the curve, select all its
points, rotate them to, say, orient them along the local Y-axis, then get out of Edit mode,
select the deformed mesh, and change the Deformation Axis on its modiﬁer to Y, and things
should still work consistently. But why bother?
Note:
Corollary to Rule Two: For simplicity, ensure that the Deformation Axis corresponds
to the primary orientation of the points of the deforming curve in its local coordinate
system. Otherwise, the deformed mesh will be rotated from its undeformed orientation,
and will go oﬀ at a completely diﬀerent angle when you try to move it.
So long as you obey the above rules, you can move, rotate and scale the deforming curve in
object mode only as much as you like, and the deformation will still behave in a reasonable
fashion. Of course, you can do what you like to the deformed mesh in object or edit modes,
and this will still be true.
Note:
Rule Three: The eﬀect of the deformation corresponds to the relative positions of
deforming curve and deformed mesh in world coordinates.
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Figure 594

Fiddling with the deforming path

Select the curve, TAB into Edit mode, select the middle point, and move it a little to one
side, as at right. You should see the grid mesh immediately bend in a corresponding way.
Now TAB into Object mode, select the mesh, and move G it around: notice how it
tries to follow the shape of whatever part of the curve lies nearest to it. What shape does
it take when you move it oﬀ an end of the curve? How about to one side?
Alternatively, you can similarly drag the curve instead of the mesh, and the same thing will
happen: it is only their relative positions that governs the actual deformation.
Also try changing the scaling radius ALT + S and tilt angle CTRL + T on particular
curve points: note how the former causes the deformed mesh to get wider and narrow at
those points, while the latter makes it tilt from side to side.

71.2. Another Example
71.2.1. Setting up your Mesh
While this example will be done with a cone primitive, you can use the default cube or
another shape of your choosing so long as it can be loop subdivided along the axis you wish
to curve. Delete the default cube if you're not going to use it as your base mesh, and add
your chosen primitive. In this example, we'll be using a Cone.
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Figure 595

A basic cone in Edit Mode

Do everything with the 3D cursor at the center.
• Set your view to the X-Y Axis (Top View) by pressing NUM7, the 7 on the keypad.
• Press Shift+A > Mesh > Cone
• A smaller number of vertices are needed, since this cone will become just the tip of the
ﬁnished shape.
• Reduce the number of vertices to 12.
• Press TAB to enter Edit Mode, or choose Edit Mode from the bottom of the 3D viewport.
• Switch views to the Z-X Axis by pressing NUM1 (1 on the keypad). Your screen should
now look something like the picture at left.
• If your cone is selected (one or more vertices are yellow) press AKEY (Select/Deselect
All) until they are deselected.
• Select the point of your Cone with the RMB and drag it upwards with the blue arrow.
You can hold down the CONTROL key if you want to constrain the scaling to set units.
For this example, 5 squares of height were added to the cone.
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71.2.2. Subdividing the Cone

Figure 596
Extruded cone
• Go to front view by pressing NUM1
The best way to do it is by selecting the side edges and subdivide them by pressing
WKEY then clicking on Subdivide, after that you can select the number of cuts you want.
You need at least ”5” segments. The more segments you have, the smoother your curved
cone will be. be sure you have ”Limit selection to visible oﬀ” and to ﬁrst deselect all ”A key”
and you are in ”edge select” mode
• You can also do: still in Edit Mode, press the NUM8 repeatedly to rotate your view
to the underside of your cone. Select the center vertex of the circle, and hold down
CONTROL, then press the +KEY on the keypad. This will select all of the adjacent
vertices of the base. Then extrude using the EKEY Pull the new vertices away from
the cone a distance at the Z-axis and click the LMB to set them in place. Press the
SKEY and widen the new base of the cone a bit.
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71.2.3. Making a Curve

Figure 597

• In Object Mode, Z-X orientation (NUM1'), make sure you have nothing selected and
press Shift+A >Curve >Bezier Curve
• Rotate your curve 90° (holding down the CONTROL key to make it rotate in 5° intervals) Note- or just R-KEY and then type 90, so that it lines up with your cone. Move it
oﬀ to one side so that its not hidden by your cone.
• Go into ”wireframe”
• Grab the center vertex of each end and adjust its rotation (RKEY) until you have a nice
shallow dome shape.
• Scale the curve in size (SKEY) until it is larger than your cone.
• The name is highlighted in the ”Outliner” Window: ”BezierCurve”
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71.2.4. Applying the Curve to the Mesh

Figure 598
cone

Modiﬁed

• Select the cone in Object Mode. Choose in the ”Properties” Header the ”modiﬁers” tab
and click ”Add Modiﬁer”
• Click the Add Modiﬁer button and choose Curve from the popup list.
• Under Object tck the empty box, and select the name of the ”Bézier Curve” (it will be
”BezierCurve” without the quotations if you left it as the default.)
• Notice the six buttons underneath, They are X, Y, Z, -X, -Y, -Z. They aﬀect which
plane the curve deforms. For this example, you'll need to select the X button.
• Move your Cone so that it overlays the curve in the '3D View” windows, and notice how
it follows the Bézier Curve.
• You can modify the Bézier Curve as well as the cone repeatedly until you are happy with
the design.
• If you switch to Edit Mode, notice that the cone returns to its straight orientation.
• To apply the deformation to the mesh permanently, in the Modiﬁers panel, click the
Apply button next to your Curve modiﬁer.
• Move the curve up 'till the cone is around the curve
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72. The Empty Object
i Information
Applicable Blender version: 2.68

Figure 599

Every object in a scene has common settings in the Object
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Figure 600

Context. This includes the common transform settings shown at right: location in the
scene, overall rotation and overall scaling. Most objects also have additional properties,
such as the geometry of a mesh and the materials that govern how it appears in the render.
The Empty object has none of these additional properties. It has the overall transform
settings, and not much else. And it has no appearance in the ﬁnal render. So what is the
point of having such a thing?
In fact, it has many uses, such as:
• In the Physics
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Figure 601
Context, it can be set as the source of a force ﬁeld (e.g. wind).
• It can be used as the parent1 for multiple other objects. That way they can be moved
together just by moving the Empty, rather than each child object individually.
• It can be used as a target object in an array modiﬁer, where it adds its transformation
to the copies of the object being modiﬁed by the array.
• It is a handy marker and place holder if you are moving things around. You can mark
an object's original position, and then put it back easily where the empty object is.
In these situations, the invisibility of the Empty in the render is an advantage, because
it can be placed wherever necessary, without introducing unwanted clutter into the ﬁnal
image.

1

Chapter 99 on page 949
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72.1. Using an Empty With the Array Modiﬁer

Figure 602

The types of Empties

Open a new default Blender document, complete with default cube. Add a new Empty
object to the scene. It doesn’t matter what type of Empty you choose; the options just
control its appearance in the 3D view, not the actual behaviour of the Empty. Besides, you
can change your mind about this later anyway.
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Figure 603

Now select the default cube, go to the Modiﬁers
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Figure 604

Context and add an Array modiﬁer. In the properties header, there are three diﬀerent ways
the modiﬁer can produce its copies of the original object: via a Constant Oﬀset, Relative
Oﬀset, or Object Oﬀset. The Constant and Relative oﬀsets only allow a simple displacement
for the copies, but the Object Oﬀset looks at the full transformation of the speciﬁed object,
which can include rotation and scaling.
Here I have unchecked the default Relative Oﬀset, checked Object Oﬀset, and from the
popup menu for selecting the target object, I have selected my Empty (which by default
would have been called “Empty”).
But if you look at your 3D view, nothing seems to have happened: the cube is still sitting,
unmoved, in its original position. In fact, it might be hard to see the Empty, because it
would have been inserted in the same position as the cube, so it ends up within it. If you
switch to Wireframe Z view, you should be able to see the Empty sitting within the cube.
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Before doing anything further, increase the Count ﬁeld in the cube’s array modiﬁer to 3.
This will give you a clearer idea of the eﬀect of subsequent manipulations. Doing so will
not have any noticeable eﬀect to start with, because all the copies will be lying right on top
of each other.
Now select the Empty, and move it to one side: you will immediately see a second copy
of the cube follow the empty, and the third copy move by the same amount in the same
direction, so it ends up beyond that.
Return the Empty to its original location, and this time try moving the cube. As the
original cube moves, you will see the second copy stay with the Empty at the centre of
the scene, while the third copy moves beyond that, by the same distance and in the same
direction as the second copy is removed from the original cube.
Now if you return the cube to the same location as the Empty, select both and try moving
them together, you will see no additional copies of the cube appear, because they remain
exactly on top of the original cube.
The rule for using an Object Oﬀset with the Array modiﬁer is this:
Note:
The transformation applied to copies of the modiﬁed object is the diﬀerence between
the transformations of the target object and the modiﬁed object.
In other words:
• the translation applied is the diﬀerence between their origins.
• the rotation applied is the diﬀerence between their object rotations.
• the scaling applied is the ratio between their object scaling factors.
Try moving the Empty to one side, as before; this time leave it there, so the three copies
of the cube are nicely spread out. Now try applying a rotation to the Empty; see how this
applies the corresponding rotation to the second copy (the one located where the Empty
is), while the third copy gets twice that rotation.
Return the Empty to its unrotated state, and this time try rotating the cube: see how the
second copy (where the Empty is) stays unmoved, while the third copy gets the opposite
rotation.
Undo the rotations, and now try scaling: shrinking/enlarging the Empty correspondingly
shrinks/enlarges the second copy, while the third copy gets transformed by the square of the
shrink/enlarge ratio (the ratio multiplied by itself, or alternatively the ratio raised to the
second power). Or shrink/enlarge the original cube, and see the second copy stay unchanged
(as before), while the third copy enlarges/shrinks by the inverse ratio.
When you change the transformation of the original cube, the second copy always stays
unchanged because the Object Oﬀset transformation is the inverse of the transformation
you are applying to the original; hence it always cancels out for the second copy, but you
can see corresponding increasing powers of it applied to subsequent copies.
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72.1.1. Editing the Modiﬁed Object
Make sure the Empty is positioned so the array instances are well separated. Select the
cube, TAB into Edit mode, select all the vertices, and try transforming them: moving,
rotating or scaling.
Note the diﬀerence in behaviour from doing this to the cube in Object mode: this time all
the copies of the cube transform along in unison. This is because we are not aﬀecting the
object transformation, which is what controls the behaviour of the array modiﬁer.

72.1.2. Arranging Object Copies in a Circle
Which brings us to a convenient trick for a common need: arranging copies of an object in
a neat circle.
The easiest way to do this is start with the cube and the Empty in their original central
positions. Suppose you want 8 copies of the cube in your circle; the angle between them
then needs to be 360° ÷ 8 = 45°. So rotate the Empty by 45°. Now select the cube. Set
the Fixed Count ﬁeld of its Array modiﬁer to 8. TAB into Edit mode, and move all the
vertices to one side. You should see the other 7 copies of the cube correspondingly move
away from the centre in diﬀerent directions, maintaining a nice neat circle arrangement.
Your cube mesh is simply being rotated about its origin, which is not where the vertices
are, but where the Empty is!
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73. Background Images
i Information
Applicable Blender version: 2.70
You will often need to use reference photos to guide your modeling. Among the many
things you can do with photos and other images in Blender, it is possible to use them just
as guides in the 3D view, such that they do not appear in the ﬁnal render. Furthermore
these images will only be visible when the view is orthographic and exactly aligned to one of
the X, Y or Z axes (or the camera view). This way, they can be used as a precise reference
for positioning elements of the model.

Figure 605

In the 3D view, make sure the Properties Shelf N is visible. Look for the Background
Images panel; it will most likely be collapsed, so expand it. Initially it will look like at right,
with no background images in your view.
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Figure 606

Check the box at the top. Click the “Add Image” button once, and this will add one entry
to the list of background images, as at right. Initially there is no image opened in this entry;
you will need to click the “Open” button and select an image ﬁle.
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Figure 607

Once you have chosen an image ﬁle, the list entry expands with additional options.
Clicking on the eye icon lets you temporarily hide a reference image, without actually
removing it from the document. Or you can uncheck the box at the top of the Background
Images panel to temporarily hide all reference images; just check it to make them visible
again. Click the X to delete an entry from the list of background images.
If you have multiple scenes in your document, the document’s background image settings
apply to all of them.
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Figure 608

If you don’t have an image handy to experiment with, how about downloading this simple
2D one from Wikimedia Commons. Flat images with no perspective work best for use as a
precise modelling reference.
Having loaded your image, it might not immediately appear in the 3D view. For it to show,
you must be in a perfect (axis-aligned) view (i.e. one of NUM1 , NUM3 , NUM7 , CTRL
+ NUM1 , CTRL + NUM3 or CTRL + NUM7 ) which is in orthographic, not perspective,
mode (use NUM5 to toggle between these), or alternatively it will show in NUM0 the
camera view.

Figure 609

You may not want the same reference image visible in all views. For example, you might
have one reference image for top view, another for a side view, and so on. The Axis menu
lets you choose which view this image is visible in.
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73.1. Other Ways To Bring In Reference Images
Maybe you don’t want to use a reference image for precise, axis-aligned modelling, but only
as a rough guide. There is a standard Blender addon called “Import Images As Planes1 ”,
which will create a plane object and apply an imported image to it as a texture. This can
then be aligned whichever way you want in the scene.

Figure 610

In Blender 2.58 or later, an empty with the type of image can be created. In the object
data pane an image can be selected. Like the image plane, the image will be present in the
3D view and can be aligned in any orientation.

1

https://en.blender.org/index.php/Extensions:2.6/Py/Scripts/Add_Mesh/Planes_from_
Images
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74. Aligning Vertices with a Guide Image
i Information
Applicable Blender version: 2.75
Note: Some pictures are outdated.
This tutorial is about using guide images to place vertices in their proper places in 3D space.
The second tutorial is on how to take good reference pictures. This tutorial assumes that
you have completed all previous tutorials.
This tutorial describes the use of the background image feature of Blender to assist in creating models of 3D objects. The background image provides a reference for the dimensions of
the object, similar to the way the ﬂoor plan and elevation views of a house provide dimension information for the actual house. Guide images are not rendered, and may be removed
after the model is completed, or they may be retained as part of the internal documentation
of the model. Background images are not generally useful for other ”image” purposes such
as materials, textures, and actual background images in a scene, just as a ﬂoor plan is not
actually visible after a house is constructed.
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74.1. Background: orthographic projection

Figure 611

orthographic projections in six directions

orthographic projection1 is a technique used by architects and engineers to describe a
three-dimensional object by the use of several two-dimensional images, or ”projections.” In
architecture, the projection as seen from above is called the ”plan view” or ”ﬂoor plan,” the
projection as seen from the front is called the ”front elevation,” and the projection as seen
from the right side is called the ”right elevation.” Orthographic projections are intended to
assist builders in creating an actual 3D object.
A Blender user also wants to create a 3D object, in this case a model. Blender provides
a way to use a set of one or more orthographic projections as a guide for object creation.
Because the images are conceptually ”behind” the object from the appropriate point of view,
Blender calls these 2D images background images.
Each background image is located ”at inﬁnity” in an orthographic view, and there may be
one image in each direction: back, front, top, bottom, left, and right. we can use one or
more background images to assist our modeling eﬀort.
For example, to model a house, we can put the ”ﬂoor plan” on the bottom, and build the
house above it. We put the front elevation image on the back background, and build the
house in front of it. We put the right elevation image on the left background, and build the
house to the right of it. The background images can be diagrams such as ﬂoor plans, or

1
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https://en.wikipedia.org/wiki/Multiview%20orthographic%20projection

Making a Simple Pyramid
they can be photographs of an object taken from suﬃciently far away to provide undistorted
dimensional information.
Reasonably enough, an orthographic projection is only useful in Blender when in orthographic mode. Blender enforces this to prevent you from making mistakes: the orthographic
image is only displayed in the background when you are in the orthographic view mode.

74.2. Making a Simple Pyramid

Figure 612

First we are going to create a pyramid the easy way. Then we are going to show how to use
diﬀerent viewpoints and images as a guide to place vertices correctly in 3D space.
Get rid of the default cube. Press SHIFT+A and select Mesh→Cone. Set the number of
vertices to 4, and Set ”Capp ﬁll Type” to ”Nothing”. Click OK. There’s your pyramid.
Note: Do not render this looking up from the bottom, as it will appear invisible, as the
interior faces of models are ignored by most rendering engines.

697

Aligning Vertices with a Guide Image

74.2.1. Save the top vertex for later steps
Enter Edit mode ( TAB ). First, unselect all the vertices by pressing A . Next, select the
bottom four vertices of the pyramid and delete them with DEL or X . The only vertex
left will be the vertex which makes the tip of the pyramid. This will be used later.

74.3. Using the guide images
Now that we have the pyramid the easy way, let's learn how to use guide images as references
to build models.

74.3.1. Window Layout

Figure 613

Split the Main 3D view window in to 4 windows (2 x 2).
Reminder: to split windows, move the mouse to the border of the view, when the cursor
transforms into arrow, right-click and choose ”Split Area”. (Explained in the guide: Noob
to Pro/Blender Windowing System2 .)
The point of view in each window are like this:
NUM7
NUM1

NUM0
NUM3

And if you click on View, you can see that these windows are respectively:
Top
2
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User

Using the guide images
Front

Right

By knowing which view you are looking at you may ﬁnd that you quickly get the idea
of what you are doing and can proceed somewhat intuitively in this section on your own
without following all of the step by step instructions.
Note: The quick way to achieve this layout is to go into Quad-View (CTRL-ALT-Q)

74.3.2. Guide images
Now, we need some images. These come from a source outside of blender. For this tutorial,
we need a ﬂoor plan of our pyramid, a front elevation view, and a side elevation view. The
ﬂoor plan of our pyramid is a square, and the front elevation view is a triangle, as is the
side elevation. We will cheat and use the same source image for both the front and side
elevation. We can make a picture of a white square and of a white triangle in the GIMP,
Paint :) , or some other image editor. Or we can ﬁnd appropriate images somewhere.
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Method 1 download and use

Figure 614

Save the triangle with a black background

Download the black and white triangle image on the right of the screen and use that. This
image is, minus the checker pattern at the border, 198 x 198. (click it once to get the larger
version, right click on the larger one, and save)
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Method 2 roll your own

Figure 615

The square and triangle relationship

You want to make a triangle, for the ground plane you don't need a picture.
Noob note Make sure that the drawing of the square is square and not just rectangular.
Make the triangle the same width and height as the square. Make sure the apex of the
triangle is directly above the midpoint of its baseline.
Speciﬁc instructions for Photoshop
Make a square selection of ”n by n” size, remember the value of ”n”. Fill it with white color
and save. To create a triangle of needed properties make a rectangular selection of same
(n by n) size, on a new layer, click RMB on your document, choose ”Transform selection”
option in the pop-up menu. Once you are in ”Transform selection” mode, right-click the
blank image again. This time the pop-up menu would be diﬀerent. Choose ”Perspective”
from it, and with LMB drag one of the two top vertices toward the other. Once the vertices
meet (in the top-center of the image), exit the transformation mode, and ﬁll the resulting
triangular selection with white.
Save the ﬁles to a place that is easy to access. Blender only supports the TGA, PNG, and
JPG image formats.
Speciﬁc instructions for Gimp
Turn on the grid (View->Show Grid, View->Snap to Grid), use the rectangle select with
a ﬁxed aspect ratio of 1:1 (in the tool options panel) to select a square that you can ﬂood
ﬁll. For the triangle, use the node tool to draw a triangular path, convert to selection
(Select->From Path) and ﬁll it. Or you could just use Inkscape...
Save the ﬁles to a place that is easy to access. Blender only supports the TGA, PNG, and
JPG image formats.
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74.3.3. Background Images

Figure 616

Load the images (as described in the previous module) like this: In the 3D view, make sure
the Properties Shelf (N) is visible. Look for the Background Images panel; it will most
likely be collapsed, so expand it. Initially it will have no background images to view. Check
the box at the top. Click the “Add Image” button once, and this will add one entry to the
list of background images. Then, with 'Image' selected, use the Open button to navigate
to your image ﬁle.
Load the white triangle (the front elevation view): this places it inﬁnitely far ”behind”
the model. You can see the image in the front view. Similarly, load the right elevation
(coincidentally, you can see the same triangle image in the right view window, to place it
inﬁnitely far to the left.
If necessary, zoom out so that you can see the whole background image in each view.
Now you have now placed your guide images for making your pyramid.
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74.3.4. Sides

Figure 617

thumbnail

Make sure you're in Toggle Quad Mode. The vertex that is left will be the topmost point of
the pyramid. Use the GKEY to move the vertex around. To get it in the right spot, line it
up at the top most point in the front and right windows. If you look in the top window
the vertex should appear to be in the center. Make sure to keep the vertex highlighted for
the next step.
Now you can begin to create individual vertices with CTRL + LMB. Be sure you don't
create vertices in the Top view cause that will confuse you completely.
First line in the pyramid in front view then place a new edge between the last made vertex
and the top vertex by selecting them and hit ”F”. Then do the right side, after selecting the
top vertex, exactly the same way. (Don't do the bottom side)
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74.3.5. Make Faces

Figure 618

thumbnail

Select the side vertices of the corners were you want a Face and Tick ”F” Do this for every
Face you want to make.

704

Using the guide images

Figure 619

thumbnail

Figure 620

thumbnail

705

75. Modeling a Fox from Guide Images
1. REDIRECT Blender 3D: Noob to Pro/Modeling a Wolf from Guide Images1

1

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FModeling%20a%
20Wolf%20from%20Guide%20Images
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76. Using Bézier Curve to Model a 3D
logo from a 2D logo
i Information
Applicable Blender version: 2.49

76.1. Overview

Figure 621

We will be using this graphic as a template for a 3d logo, tracing it, then discarding the 2d
image. (Click thru to get the larger sized version, for you to follow along with)

76.2. Load the background image into blender
76.2.1. Basics of the background image panel
If you haven't already done so, open blender and select one of the orthogonal view angles
by pressing NUM7 (top), NUM3 (side), or NUM1. (front). At the bottom of the 3D
viewport on the left, there are some menus, click View -> Background Image
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Figure 622

A small window will appear containing just one button marked use background image;
click this button. A few more buttons will appear. One of them says image: and has a
small button with a picture of a folder on it; click this button. You are now presented with
a ﬁle selection screen. Using the navigation techniques from the previous tutorials, ﬁnd
your 2D jpeg image on your computer, click the ﬁle in the list once then click the Select
Image button at the top right of the screen.
Noob note: The image is only displayed in orthogonal view. If perspective view is enabled,
toggle to orthogonal view by pressing NUM5. (The image will not be rendered as it is not
part of your scene.)

Figure 623

Once a background is selected you'll have a dialog like this one. (Note: This tutorial was
originally generated from Blender v2.37. v2.43 has been added - older versions may diﬀer.)
The background dialog buttons are described below:

76.2.2. Details of the background image panel
The
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Figure 624

Use Background Image Button v2.37

is a toggle button that turns display of the image on or oﬀ. Turning the button oﬀ will
not clear the settings; it just hides the image. When you turn the button on again, your
previous settings are back. Try it - click the button a few times. In v2.43 the equivalent
button is the

Figure 625

Use Background Image Button v2.43

button.
Image selection is controlled on the row labeled

Figure 626

Blender_Image Select v2.37

. There are 2 buttons, a text box, and a ﬁnal button. The ﬁrst button
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Figure 627

Browsing Image Select v2.37

is used for browsing for an image. The 2nd button

712

Load the background image into blender

Figure 628

Image Select History v2.27

is for selecting an image from a history list. (This will be empty for the ﬁrst time. Selecting
it now will display the image you currently have selected.) The text box

Figure 629

Image Select Textbox v2.37

allows typing in the ﬁle directly. The
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Figure 630

Image Remove

button removes the current background image. Version 2.43 is the same with the addition
of the
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Figure 631

Image Refresh

button that refreshes the image or movie, and the

Figure 632

Image Users Count

button which shows the number of users of the image block.
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The third row is called Texture and will not be used for this tutorial.
The fourth line, labeled blend controls the transparency of the background image with a
slider. A setting of 0 is completely solid and 1 is completely transparent. You can adjust it
by clicking left or right of the knob for gradual changes, clicking and dragging on the slider
for rough settings or clicking directly on the blend text for numeric entry.
The use of the blend function will become obvious once we start tracing our logo. For now,
play around with it, see how it changes the image, and put it back to the 0.500 default.
The ﬁfth line, size, controls the size of the image. This size setting is independent of the
zoom for the 3D view window. To see how the size works move the default cube oﬀ to the
side so that you can see both the cube, the background dialog and the background image.
Now watch both the cube and image as you change the size. Notice how the image changes
size but the cube doesn't? Now press NUM+ and NUM- to change the view's zoom.
Now both the cube and image change size.
The ﬁnal row controls the X and Y oﬀset for the image. These controls move the image up
and down (Y) or left and right (X). These settings can be useful if you need to reposition
the image from the default position. Like the size, these oﬀset values are independent of the
view. As you change the oﬀset values the cube you added earlier won't move. Now scroll
the view using by clicking and dragging the SHIFT MMB and notice how the cube and
image move together?
Once you start tracing the image you won't be using the size or oﬀset setting.

76.2.3. Details for version 2.6X
the check box left to the title indicate if you can see the image or not. the Axis menu
indicate in what views you could see the image.
the button Image and Movie Clip indicate of course if you use a Image or a Movie.
the button to left of the text box allows to choose the image from the exist, the text box
say the name of the image, the F botton make the image a fake user, the folder sign allow
to upload a image, and the X sign delete the link to the picture.
The blend slider mentioned above is now called Opacity. The image will be completely
transparent when the opacity value is zero, and fully opaque when the value is one.

76.3. Delete the cube
Delete the cube (select it, press XKEY and select All from the Erase menu), and set the
size so that the entire image is viewable. Then set both the X and Y oﬀsets to 0.
Set the view to top view (NUM7) for the rest of the tutorial!
Finally minimize the Background Image dialog. You'll only need it to adjust the blend
setting until you ﬁnish tracing.
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76.4. Introducing the Bezier Curve
The Bézier Curve1 allows drawing graceful, complex curves and only requires a few points.
Speciﬁcally, it only requires 4 points for a curve: two end points and two control points.
For the moment set the blend to 1 on the Background Image dialog. With the center of the
3D view still selected, press SPACE -> Add -> Curve -> Bézier Curve. Alternatively
you can use the Add menu at the top of the screen or press SHIFT -> AKEY to jump
directly to the add menu. Be sure to be in EDIT MODE not OBJECT MODE.

Figure 633

The Curve you added.

Unlike the traditional Bézier Curve each Bézier vertex has 3 points. I've labeled the 3 points
for the left vector: A, B and C.
Just like any other vertex you select the control points and the end points with RMB and
move them with standard commands like GKEY, SKEY, EKEY or RKEY. if you wish
to rotate, scale, or move the whole curve, then select all the vertices on the curve using one
of the various selection methods, and then use the GKEY, SKEY, or RKEY
Point A is an end point. The curve will always go through this point. Points B and
C are control points. These points inﬂuence the path of the curve as it leaves Point A.
Because the path stops at A, Point B has no real eﬀect on the path. Instead B is currently
locked with C. (If you move either B or C, the other will move.) We will ﬁx Point B to
move independently a little later.

1

https://en.wikipedia.org/wiki/B%C3%A9zier%20curve
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The control points have 2 eﬀects on the path exiting the end point: direction and distance
(these are termed slope and magnitude in math circles) from Point A. The direction
will provide the direction that the path will follow when it leaves A and the distance will
determine how long the path follows that direction before it starts making its way to the
curve's next point.
<!-- these images never seems to have been uploaded
Figure 634

N.B. To easily make sharp turns; take B point and move it really close to A.

Figure 635

Take C point and move it in the exact direction you want to turn

Figure 636 (with C selected) Press EKEY to extend the Bezier, and drag it out; you will ﬁnd it goes where you
pointed C! --Jawboota 01:30, 30 April 2006 (UTC)

a

-->
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Figure 637

The example to the right shows how the control points inﬂuence the path of the curve.
In the top picture, we see three curves. The top curve is the default curve. In the next
curve down, C has been moved to give a drastically diﬀerent direction. Notice how the
path leaving A moves away from the other end point. The third curve, the distance was
changed dramatically. Watch the path move much higher than the other two curves.
In the bottom example, I've built a heart shape using just the points shown. Dragging the
bottom end point down will make the shape closer to a leaf. You'll be able to do the same at
the end of this tutorial. Go ahead move around the points for the curve and see how they
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all interact. Get a good feel working with the curve and when you're ready we'll move on
to tracing.
Now that you know how to work with a bezier curve set blend back to 0.5 on the Background
Image dialog so we can start tracing.

76.5. Modeling the lighting bolt
76.5.1. Rough Tracing
If you don't already have a curve add one now. It will help to move the curve to the center
of the yellow lightning bolt.

Figure 638
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Curve Tools for Blender 3D version 2.37

Modeling the lighting bolt
The ﬁrst step in tracing is to click the Polygon convert button on the curve tools panel.
You'll ﬁnd this in button on the Buttons Window. You may need to select the Edit
Panel. Press F9 if this panel isn't visible. In Blender 2.59, the 3D View panel's Tool Shelf
(T) houses the Curve Tools, including Set Spline Type, from which you should select Poly.
You must be in Edit Mode to reach the Curve Tools.
Noob Note: The 'Curve Tool' panel will not appear if you don't have a bezier curve already
placed. I learned this the hard way.

Figure 639

Next, move the vertices of the curve to the points shown in the image to the left. This is
called Rough Tracing because you don't need to exactly trace the image.
You only need to approximate the image. Moving the vertices should be done using the
instructions from the Creating a Simple Hat2 tutorial.
Note: Selecting the best place to put a vertex is a bit of an art that you'll acquire as you
work with curves. For now follow the arrows along the cutouts and place each of the vertices
as shown.
This tracing uses all the vertices of the polygon. Other cases, you'll need add or remove
extra vertices by selecting the end point of your curve press CTRL and click LMB. At the
place you clicked a new vertex will appear connected to your curve.

2

Chapter 31 on page 265
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Figure 640

After moving the last vertex, we ﬁnish the rough tracing by pressing the Alt+CKEY to
close the polygon. You should see an image similar to the one on the right. (If you only
have an outline switch your view port shading to solid by pressing the ZKEY for now.)
Question: how do you close the polygon in blender 2.61? Answer_ ALT + CKEY
pressing c key alone brings up circle select.
Note: In Blender 2.63 and certain prior versions, the curve needs to be changed from 3D to
2D shape in order for the polygon to show up, else you get an error. This can be changed by
going into Object Data and, under the Shape heading, switching the curve from 3D to 2D.
Notice how the polygon doesn't cover all of the yellow of the bolt and how in some places
the polygon fails to conform to the shape of the bolt. This is expected and should not be
a cause for concern. We correct this in the next section.
Once you've ﬁnished several logos you should begin to get a feel for the required placement
of vertices. Until then, here are some general guidelines to keep in mind:
• A gradual curve may only require a single vertex.
• Tight curves will likely require two closely placed vertices.
• Curves may not require a vertex at all - you can deﬁne some curves using the control
points of the adjacent vertices. We did this for both of the inside curves of the bolt above.
• Corners require a single vertex placed where the curve bends. A square, for instance,
requires four vertices - one at each corner - to be modeled properly.
• The end point of a curve will always be on the curve. So should all of the vertices you
place.
We are now ready to move onto the next step modeling the logo.
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76.5.2. Polishing the Tracing
Press ZKEY to return to wire frame mode, then Press the Bézier convert button to convert
the polygon back to a curve.
This will convert your polygon back into a curve. Nothing obvious will happen. If you look
close, you should notice the number of points on the curve tripled. When you converted
the curve back to a Bézier curve, Blender changed all of the polygon vertices to Bézier
vertices. While the polygon vertex is a single point the Bézier vertex is made of an end
point and 2 control points. So the extra points are the control points of the Bézier vertices.
These control points are placed along the curve to produce the same shape as the converted
polygon.

Figure 641

Our job is to move the control and end points so that the curve follows the edge of the bolt.
The trick is to move the 2 control points between adjacent end points to bend the curve to
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the edge of bolt. First, move the right control point of the top-left vertex. This should pull
the curve from its end point to more closely match the line of our bolt. After placing this
point, we move to the next control point following a clockwise direction around the bolt.
Use the RMB to select the point you want to change and move it with GKEY to place it.
Noob Note: if you wind up with pink lines when you select the contral handels, that means
you hit HKEY by accident, and have put the control point in manual. to correct this hit
HKEY again to put it back into ”easy” or auto mode.
As you move the second point notice how the curve exiting the ﬁrst end point is drawn
away from the edge of the bolt being traced. We now have to adjust the ﬁrst control point
again to get that line back on track. This quickly turns into a balancing act adjusting
each set of control points. The trick is to make smaller movements for each iteration of
adjustments. Make a game of it and move the control points all along the bolt. Always
move along the clockwise direction. This practice is not just for consistency, it keeps your
place and ensures that moving a control point doesn't change a portion of the curve that
you've already completed. In time you learn to move the ﬁrst point only part of the way.
Then moving the second brings the curve for the ﬁrst into correct alignment.
If you have some trouble aligning the curve to the edge of the bolt, consider adding a new
point. There are two (at least) ways to accomplish this:
• Select 2 points that surround the problem spot where you want a new vertex and click
the Subdivide button on the Curve Tools 1 tool panel.
• If near an end point, Select it, press the CKEY to open the curve, then
Control+LMB click to add a new point beyond the end of the selected ﬁnal vertex.
Press the CKEY to reclose the curve.

Figure 642

Adding a new end point

The new end point should be positioned and then you have to adjust the curve on both
sides of the end point you move. Any time you move an end point be sure that the curve
going into both adjacent (clockwise and counter-clockwise) end points still aligns with the
edge of the bolt.
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Figure 643

Finding trace defects

Once you've made the complete circuit around the bolt, you're ready for the ﬁnal polishing
of the edge of the curve. Press the TAB to switch to the object mode. This makes the
polishing easier as Blender hides the points and lines for editing the curve. Now zoom in on
the bolt's edge using the NUM+ or Control+LMB drag. Use Shift+MMB drag the
screen so that you closely observe the entire edge of the bolt while zoomed in closely. Look
for places where the curve pulls away from the edge.
Also look for sharp bends at each of the end points that should be smooth. You can see
several defects that I found in my project after tracing the bolt. Switch back into edit mode
to ﬁx the curve and then go back into object mode to look for more defects.
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Figure 644

Correcting poorly shaped curve

Sharp end points are adjusted by decreasing the angle between end point and the control
points. Many times that is impossible to do, without messing up what you're trying to
draw, so the other way is to add more curves by subdividing ( WKEY -> subdivide )the
existing curve between two end points, and playing with the control points to get a nice
smooth curve,
Places where the curve pulls away from the edge can be resolved by moving the control
point closer to the edge. In the above image the curve was found to have been pulled away
from the edge. This was ﬁxed by moving the control point a little to the left.

726

Modeling the lighting bolt

Figure 645

Final Polished Curve

Here's the ﬁnal polished curve for my project. It is shown in both edit mode and object
mode so you can clearly see both the control and end points on the left and the curve to
the right.
Noob note: In blender 2.37 and later (not sure of earlier versions) pressing the
HKEY toggles the control points between free and aligned (Edit Mode). Free Control
Points are good for sharp angles, and aligned are good for smooth curves. This shortcut is
in the Space -> Edit -> Control Points menu.
This concludes the tracing of the bolt. All that remains is making the curve 3 dimensional,
applying a material and positioning the ﬁnal object. Before doing that, we will trace the
circle in the next part of the tutorial. Save this project if you want to take a break before
continuing. You'll need it on the next turorial.
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76.5.3. Adding a Third Dimension

Figure 646

First, give the object some depth. if you are in wirefame, hit ZKEY to go in to solid mode,
then down on the editbuttons screen, locate the ”Curve and Surface” panel, and set the
following values:
•
•
•
•

Back and front buttons are selected (depressed), otherwise it will be see through.
Extrude: 0.2 (the height of the extrusion on either side)
Bevel Depth: 0.02 (the radius of the round bevel applied to the exruded edge)
BevResol: 4 (the number of subdivisions on the bevel curve)

Noob note: In previous versions, Extrude and Bevel Depth were Ext1 and Ext2.)
Noob note: In versions 2.6x(possibly also 2.5x), go to Properties panel --> Object Data
--> Geometry for these settings.
Now you can use your knowledge from earlier in this book to change the material and/or
add texture to your logo. Feel free to rotate, add lighting, or whatever ﬂoats your boat.
Don't forget to press ZKEY to toggle wireframe mode.
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Figure 647

You should now have something that looks like the photo on the left.

76.6. Modeling the red circle
It will be helpful to make the lightning bolt distinct from the circle part of the logo, by
applying a yellow material to it before continuing.
Method one is the easiest, so try it that way ﬁrst.
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76.6.1. Method 1 - using bezier circle
Outer circle

Figure 648

Bézier Circle

Switch to object mode by hitting TAB if you aren't already there. LMB somewhere near
the center of the background photo. Press space -> Add -> Curve -> Bézier Circle to
add a closed bezier curve with four points forming a circle. If you are in solid draw type,
switch to wireframe with ZKEY so you can see the underlying image better. Hit SKEY to
scale the bezier circle to ﬁt over the circle in the image. Again, if you are using one of the
newer versions, you will have to switch the circle from 3D to 2D in the object panel.
Noob note: You should stay in object mode for now, as it's easier to scale and move the
bezier circle without having to keep track of which end points are selected.
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Figure 649

Match up left and right sides

You will probably ﬁnd that the bezier circle is not dead center on the sample logo so you
will need to move it with GKEY to center it. You may need to scale it and move it several
times to get it right. You will also ﬁnd that the circle in the sample image is actually a
slight oval, so scale and position the bezier circle, along the X axis, and Y axis, so that it
touches the circle in the image on the left and right sides.

Figure 650

Move top and bottom points

Normally, you could then scale the circle and constrain it on the X and Y axis by using
SKEY, but it turns out that the oval isn't regular anyway, so just select the point on the
top and hit GKEY and then XKEY, or YKEY to move it around until it touches the top
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of the oval in the image. Then do the same for the bottom point and you should have a
pretty good ﬁt.
Inner half circle 1

Figure 651

Circle in circle

Just to understand what's happening in the next steps, switch to solid view with ZKEY.
As you can see, you now have a circle, but it's ﬁlled in the middle where you want to be able
to see through it. To cut a hole out of the circle, be sure that the circle is selected, then hit
Shift+S -> ”cursor to selection, to put the cursor in the middle, switch into edit mode,
if you're not already in it, and then Space -> Add -> Bézier Circle. A new circle will
appear inside the larger circle. As you can see in solid mode, the new circle actually cuts
its shape out of the larger circle surrounding it.
Noob note: make sure you are in Edit Mode or it will add the new Bézier circle without
cutting it out of the existing one.
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Figure 652
of the bar

Place two points at either end

Switch to wireframe mode with ZKEY so that you can see the underlying image again.
Scale up the smaller circle so that it approximately ﬁts the inner part of the circle in the
image. Don't worry about getting it exact since you'll be manually moving all four points
anyway. Move the bottom point of the bezier circle to the top left corner of the bar that
crosses the circle.
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Figure 653
of the bar

Place two points at either end

Move the right point of the circle to the other corner. When you create a Bézier Circle,
Blender by default sets the alignment of all the control points to aligned. To make the
diagonal bottom edge you need to break the alignment on the two lower sets of control
points. Hitting the HKEY will toggle between free control points and aligned. Once
you've selected the two lower bezier points and hit the HKEY to make them free you can
move each of the inner control points to create a nice straight edge. Then move the other
two points and adjust their control points until you have a pretty good approximation of
the rest of the inside curve.
In Blender 2.63 and others, pressing the H key seems to hide vertices instead. To set control
points to free, select the vertice, then in the curve tools under Handles, select Free. (can
also be set via the menu at Curve-control points-set handle type-Free)
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Inner half circle 2

Figure 654

Wider bevel has a nice look

Next step is to press space -> Add -> Bézier Circle again and repeat the same steps,
but for the lower opening in the logo. Once you've completed both openings, switch back
to solid view with ZKEY and examine your work. Make any adjustments you need to by
switching the draw type back and forth as needed.
Make it 3d

Figure 655

The next step is to make this part three dimensional like you did with the lightning bolt.
Go to object mode with TAB, then select the editing buttons.
Under curve and surface, set:
Extrude/Ext1 to 0.05,
Bevel Depth/Ext2 to 0.02
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BevResol to 4.

Now that we have beveled it there will be a problem. Switch back to wireframe mode with
ZKEY and you'll see that the bevel has widened everything so that the circle no longer
matches the original image. This can be ﬁxed fairly easily by reducing the width parameter
under curve and surface to about 0.98.
Noob Note: I don't see an easy way to adjust the width parameter under curve and
surface in Blender 2.70. I was, however, able to adjust using WKEY, Width, and then
incrementing with the mouse.
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Figure 658

For ﬁnal steps, select the lightning bolt again and switch into sideview with NUM3 and
hit GKEY and then ZKEY to move both elements up or down until the bolt is inside the
circle.
Apply a red material to the circle and bar portion. Finally, you can go to view, then to
background image and hit the background image button to hide the image now that it is
no longer needed. At this point, you can add any ﬁnishing touches for lighting and camera
angles and render the logo.
After rendering you will have something like this:

737

Using Bézier Curve to Model a 3D logo from a 2D logo

Figure 659

Final render

76.6.2. Method 2 - using mesh circle and edges
Instead of using the Bézier Curve, you can use Circles.
There are two ways of doing this:
Easy way
Place two vertices (CTRL+LMB), one on the inner circle and one on the outer circle so
that they form a line. This line has to be perpendicular to the circle you are tracing. Then
place the cursor on the middle of the circle. Then just use the spin tool under the Mesh
tools tab (360 degrees and 32 steps). This creates a circle made of 32 adjacent squares.
Give it more steps to increase the quality of the circle.
Detailed way
Go to the top view (NUM7), and press SPACE -> Mesh -> Circle. Accept the 32 vertices,
you can make it less but it won't look as good.
Move it into the center of the circle, if you don't then I advise you have wireframe on for
the moment (press Z). Then press S, for scale, and make it the correct size for the inside of
the circle. Once you have that in the correct place, like so:

738

Modeling the red circle

Figure 660

Adding the ﬁrst circle

You may need to stretch it sideways a little, then press 'E' to extrude (choose Only Edges),
press 'S' to scale and another sized circle will appear, size this appropriately then click
LMB.
Deselect the second circle, then select four vertices that are near each other and that form
a square.

Figure 661

Selecting the four vertices

Now press F and a face will appear, i.e. the box will be ﬁlled (turn oﬀ Wireframe, press
z). Now do this right around the circle. To do this, hold down Shift and Ctrl, then draw a
circle around the two vertices you wish to deselect with the Left Mouse Button. Then draw
a circle around the next two vertices while holding down Ctrl and LMB, NOT SHIFT.
Shift changes the control from selecting, to deselecting.

739

Using Bézier Curve to Model a 3D logo from a 2D logo
Once you have gone all around the circle it's time to make the line through the middle. To
make the crossing line you need to move 4 of the vertices slightly; example below:

Figure 662

Moving the four vertices

Once you do this, highlight the 4 you moved, then press F.
Making the circle 3D
Highlight the full circle by pressing A either once or twice. Go to Side View, and press E
for extrude and drag it down so that it is the same thickness as the lightning bolt (you'll
see why).
Now look at what you have made... it looks nice enough but where the lightening bolt goes
through the circle it looks a bit odd so we will make it look like the circle is laying on top
of the bolt. Where the bolt goes through the circle, note the edges and the vertices. Move
them so that the lines are just either side of where the bolt goes through. Then make new
edges using CTRL+R on the outsides of these edges. Like so:
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Figure 663

Creating the overlap

Now you have squares where the lightning bolt hits the circle. Change to Wireframe (z) if
you are not already in it then highlight the 16 vertices of these boxes and raise them. Now
do the same for where the center line crosses the bolt but create 4 lines instead of two. To
explain why, I've created a diagram.

Figure 664
of 2

Why we use 4 points instead

Now we can make the ﬁnishing touches, add subsurf and set it to 2 or 3 and add color!
Then you are done :-) I won't go over subsurf and adding color because people have covered
that better than I could in previous 'Noob to Pro' pages. I think that's everything.
You should now be looking at something similar to:
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Figure 665

The ﬁnished article

76.6.3. Method 3 - using mesh circle and a cube
Tracing the No symbol is somewhat more complex than the lightning bolt. The reason
is this symbol is hollow and requires additional planning to trace than just following an
outline of an object.
I'll be back to explain the diﬃculties in the near future, so stay tuned.
One way to do this is outlined below:
• The ﬁrst thing to do is add a mesh circle. Hit SPACE and select 'Add -> Mesh ->
Circle'. (This circle is mostly for measuring purposes, and will ultimately be removed.)
• Scale (SKEY) and move (GKEY) the circle so that it's sides are even with the sides of
the logo circle, and the top and bottom are an even distance from the top and bottom of
the logo circle. (The logo circle is not perfectly round.)
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Figure 666

• Make sure you're in object mode (TAB), add a cube (SPACE, 'Add -> Mesh -> Cube')
and place it (GKEY) on the right edge of the circle so that it is centered on the right
edge.
• Scale (SKEY) the cube so that it is the same width as the wall of the circle and touching
each side of the wall.
• Now, we want the 3Dcursor at the center of the logo circle. To do this, go back to
object mode (TAB), and select the circle that we added earlier (RMB), then press
SHIFT+SKEY and choose 'Cursor -> Selection'. (This is the main reason why we
have this circle here.)
• Reselect the cube (RMB) and TAB to edit mode.
• Choose NUM7 for the top view, and use RMB to select only the front face of the cube.
(Before this you have to make sure that you are in 'Face select mode'.)
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• Press XKEY and choose Erase Vertices. This will reduce the cube to a square
• Press NUM7 to go to the top view then select the Editing panel (F9).
• Press AKEY to select all, and then make sure that the rotate settings are set to degr:360
, Steps:50 , Turns: 1. (Actually, Steps can be whatever number suits your fancy. You
may want to play with various values.) This is just like we did for creating the man's
hat.
• Click on 'Spin' to extrude the square into a ring.
Next we will create the bar.
• Staying in Edit mode, hit SPACE and select 'Add -> Cube'. If you haven't moved the
cursor since the ring extrusion, it should appear in the middle of the ring.
• Expand (SKEY) the cube so that it just encompasses the inside circle of the ring

Figure 667
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• Scale (SKEY) the square in the Y axis (YKEY) so that it is approximately the thickness
of the logo bar.
• Return to object mode (TAB), and rotate (RKEY) the ring together with the just
designed bar so that it is parallel to the logo bar.
• In Edit Mode (TAB), squash the ring in the Y direction (SKEY, YKEY) so that it ﬁts
the logo ring.

Figure 668

• In edit mode, reselect just the bar. To do this, choose 'Face select mode', and do
an area select of the face selectors near the center of the bar (use the BKEY, or
SHIFT+RMB methods).
• Re-rotate (RKEY) the bar (in Edit Mode) so that it is parallel to, and in the middle of,
the logo bar.
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Figure 669

• The next thing we need to do is scale the bar so that it is precisely the same width as
the logo bar.
• To do this, choose scale (SKEY), and press YKEY twice. This will go to local scale
mode (local to the object). This is why we were rotating the entire ring, since the ring
and bar are part of the same object.
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Figure 670

• We no longer need the original circle now, (it should be sticking out from the top and
bottom of the ring), so select it (RMB), and delete it (XKEY).
• If you hit NUM3 You'll see that the bar and the ring are at completely diﬀerent heights
than the lightning bolt. Select and scale them so that they are all roughly the same
height (the bar should be slightly higher than the bolt, and the bolt slightly higher than
the ring so that all the proper parts are covered.).
• You can use the trick above to select (RMB) only the bar, scale it in the Z axis (SKEY,
ZKEY) and then hit SPACE and choose 'Select -> Inverse' to select the ring (all but
the bar).
• When done rescaling, press NUM7 to look at your handiwork.
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Figure 671

• There is one last bit, which is to slightly rotate the whole ring around the X axis so that
it is below the top of the bolt and above the bottom.
• Once that's done, all that's left to do, is color in the ring.
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77. Subsurface Scattering
i Information
Applicable Blender version: 2.67
Real-life materials which may look opaque are often not perfectly opaque: light may penetrate a little way into the surface before bouncing oﬀ. This is noticeable as a subtle
softening and colouring of the edges of shadows on the object. This eﬀect is known as
subsurface scattering1 (commonly abbreviated “SSS”).

1

https://en.wikipedia.org/wiki/Subsurface%20scattering
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Subsurface Scattering

Figure 672

Open a new default Blender document. Select the default cube. Go to the Material
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Modeling the red circle

Figure 673

context in the Properties window. Look for the Subsurface Scattering panel. Check the box
at the top to enable it for the cube’s material.
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Figure 674

Subsurface scattering with default settings, before and after

Compare how the cube looks with and without SSS enabled: see how the edge of the shadow
becomes a little bit fuzzy? This is simulating the eﬀect when the light penetrates a little
way into the material, emerging just within the edges of the shadow, making them that
little bit lighter.
Note:
The edges (and general geometry) of the object themselves remain sharp. The fuzziness
applies purely to the shadows.
Note the following settings in the SSS panel:
• The Scale controls how the overall size of the eﬀect relates to the size of the object. If
you size your object so that 1 BU is equivalent to 1 metre, then the default scale of 0.1
should produce a realistic eﬀect.
• The colour swatch causes the scattered light to take on the speciﬁed colour.
• The RGB Radius values govern how far the red, green and blue components of the light
penetrate into the material before being scattered. These are relative values, all subject
to the overall Scale factor.
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Modeling the red circle

Figure 675

Higher red scattering radius

For example, this is what happens when the red radius is increased to 10, leaving the green
and blue radii and the actual scattering colour unchanged: this causes the red light to
travel further, tinting the interior of the shadow red and the adjacent area the opposite
colour—blue-green. This is similar to what happens with human skin, as the light scatters
through the blood vessels underneath.

753

Subsurface Scattering

Figure 676

Try the various options in the Presets menu: how convincing do they look? Of course,
they may look better if you apply them to a model that is supposed to look like the actual
material.

754

78. Ray Tracing
i Information
Applicable Blender version: 2.67
You previously learned1 about using diﬀuse and specular shaders to control the appearance
of a material. These settings only aﬀect how the material reﬂects direct light from lamps;
but in the real world, objects are also illuminated by indirect light bouncing oﬀ other lit
objects.

Figure 677
a

1

A particularly outstanding ray-tracing example, from the Wikipedia articlea

https://en.wikipedia.org/wiki/Ray%20tracing%20%28graphics%29

Chapter 33 on page 279
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In particular, there is the important case of light bouncing oﬀ mirrors and other glossy or polished surfaces before travelling to the camera, and also of light passing through transparent
objects and being refracted (bent).
In the real world, such light can illuminate other objects, and it can also do so after bouncing
oﬀ non-mirrorlike surfaces. The general problem of modelling such indirect lighting is
called global illumination, commonly abbreviated “GI”. Unfortunately, the Blender Internal
renderer, which is what we have been working with so far, cannot deal with GI in its full
generality; to cope with that, we would have to use the Cycles renderer, which is introduced
later2 . So for now we will conﬁne ourselves to mirrorlike reﬂections which do not illuminate
other objects.

2
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Chapter 153 on page 1345

Setting The Scene

78.1. Setting The Scene

Figure 678

upright

Let’s create a very basic model we can use to experiment with various ray-tracing eﬀects.
Open a new Blender document. Make sure the default cube is selected. Go to the Modiﬁers
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Ray Tracing

Figure 679

context in the Properties window, and add an Array modiﬁer to the cube.
The cube will immediately become two cubes, but so close together that they look like
a single cuboid. This is because the default settings for the Array modiﬁer are to use a
Relative oﬀset of (X, Y, Z) = (1.0, 0.0, 0.0). Change these oﬀsets to (1.5, 1.5, 1.5), so the
copies are more widely separated at a more interesting angle, and increase the repetition
count to 5.
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Figure 680

Now try rotating and repositioning the camera and the cubes to get them all in the view.
If you hit F12 to render now, you should see something like at right. So far not very
exciting. But since we are going to be dealing with reﬂections and refractions, it would be
nice to have something in the surroundings to be reﬂected and refracted.
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Figure 681

upright=0.5

One easy thing to add is a world texture. Go to the Texture

760

Setting The Scene

Figure 682

context in the Properties window. Make sure the World texture
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Figure 683

(the leftmost of the 3 buttons at the top of the topmost panel) is selected. Create a new
texture, and change its type to “Magic”, which has a nice variety of diﬀerent colours. Go
to the Inﬂuence panel; by default the top-left checkbox (aﬀect background progression) is
checked; but this does nothing, because the default sky setting is not to have a progression
at all. So uncheck that box, and check the second one on the left (aﬀect horizon colour)
instead.
Also under the “Size:” setting, set the X, Y and Z scaling all to 3.0; by shrinking the pattern,
this will bring more detail into the view.

762

Ray-Traced Transparency

Figure 684

Now if you hit F12 , you should get an image with a slightly more interesting background.
OK, we are ready to start playing with the material settings...

78.2. Ray-Traced Transparency

Figure 685 Left half of pool is ﬁlled with water material, right half is empty; ﬂoor is
not broken, it just looks that way because the path of the light is bent.
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In physics, refraction3 is what happens to light when it crosses the boundary from one
material (e.g. air) into another (e.g. water); it slows down when it enters the denser
material, and speeds back up when it leaves. The refractive index4 of a material is a
measure of how much the speed changes relative to a vacuum (where light travels at full
speed). As the speed changes, the light beam also changes direction, giving rise to wellknown “bending” eﬀects like you see when you put a teaspoon in a glass of water, or look
down into a swimming pool (as at right).

Figure 686

Anyway, back to our tutorial model. Make sure the cubes are selected. Go to the Materials

3
4
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https://en.wikipedia.org/wiki/Refraction
https://en.wikipedia.org/wiki/Refractive%20index

Ray-Traced Transparency

Figure 687

context in the Properties window. Find the Transparency panel, and check the box at the
top to enable transparency. In the row of buttons for selecting the type of transparency just
below that checkbox, titled “Mask”, “Z Transparency” and “Raytrace”, select “Raytrace”.
In the editable ﬁelds immediately below those transparency-type buttons, the one at the
top left is titled “Alpha:”; you will have to reduce it below its default value of 1.0 in order
to see any actual transparency eﬀect. Try reducing it to 0.5.
Just a bit further down from the Alpha ﬁeld, look for two more ﬁelds: “IOR:” (“Index Of
Refraction”) and “Filter:”.
To simulate glass, set the IOR to 1.5 (other useful values are 1.33 for water, 2.4 for diamond
etc5 ). The Filter value controls how much of the diﬀuse colour of the material the light

5

https://en.wikipedia.org/wiki/List_of_refractive_indices
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takes on as it passes through; set it to something like 0.5, though you probably won’t notice
much eﬀect from this unless you specify a strong colour in the diﬀuse shader settings.
The “Depth:” setting controls how many times the light passes across material boundaries
before the renderer gives up keeping track. Larger values give more realistic results, at the
usual cost of increased render times. In more complex scenes where you have transparent
objects in front of other transparent objects, this value will have a deﬁnite eﬀect; here it
probably doesn’t matter too much.

Figure 688

Semi-glassy...

Now if you hit F12 , you should see something like at right. The cubes still look a bit grey;
if you set the alpha to 0, they will look much more transparent.
Also try playing with the “Amount:” slider under “Gloss:”: the default value of 1.0 gives
perfectly smooth refraction, while values less than 1.0 give a “frosted glass” eﬀect, blurring
the light as it passes through the material.

78.3. The Fresnel Factor
Real-life materials are never perfectly opaque or perfectly absorbent; even with something
like a shiny metal which seems entirely opaque, light still manages to penetrate a little way
into the surface, and even with the blackest of black soot, there is still some (tiny) amount
of reﬂection going on.
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Ray-Traced Mirroring
The general behaviour is that a material is most transparent when its surface is viewed
directly-on, and it is most reﬂective when it is viewed almost parallel to the surface (as
usual, Wikipedia has all the gory details6 if you’re interested).
If you look back at that Transparency settings panel, you will see to the right of the Alpha
ﬁeld one labelled “Fresnel:”, and another one below that labelled “Blend:”, which comes to
life when the Fresnel value is set to something greater than its default of 0.
The Fresnel (pronounced “fray-nel7 ”) value is the power, which governs how sharply the
transparency of the surface changes with viewing angle; 0 means the transparency stays
unchanged at all angles, while higher values cause the transparency to fall oﬀ more rapidly
towards the edges. The maximum value you can set for this ﬁeld is 5.0.

78.4. Ray-Traced Mirroring

Figure 689

Just below the Transparency panel in the material settings, you will see the Mirror panel.
Check the box at the top to enable it. Note the “Reﬂectivity:” editable ﬁeld just below the
checkbox; you will need to set this to something other than its default of 0.0 in order to
actually observe any mirror eﬀect.

6
7

https://en.wikipedia.org/wiki/Fresnel%20equations
https://en.wikipedia.org/wiki/Augustin-Jean_Fresnel
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Figure 690

Is that glass, or is that glass?

If you render now, you should see something like this.
See also the colour swatch specifying the colour of reﬂections: the default white means
that reﬂections keep their colours unchanged, which is characteristic of reﬂections oﬀ glass,
plastic or ceramics. Reﬂections oﬀ metal tend to take on the colour of the metal.
The Gloss setting governs how mirrorlike the reﬂections are: reducing this from its default
of 1.0 adds blurring to the reﬂections, giving the eﬀect of less-polished surfaces.
Note the Mirror panel has its own Fresnel settings. Go back to the Transparency panel, and
set the Alpha to 0. That will disable the diﬀuse and specular shaders completely, giving us
a pure ray-traced material, and also render the transparency Fresnel ineﬀective. Instead,
we will control the Fresnel here in the Mirror panel. The behaviour for a nonzero Fresnel
power is similar to before; however, instead of fading from transparent in surfaces viewed
face-on to eﬀects from the shaders when viewed edge-on, it will fade from transparent to
mirrored.
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Ray-Traced Mirroring

Figure 691

Even more glassy?

Set the Fresnel value to something like 2.5. Compare the render to the previous one without
Fresnel:

Figure 692

Pure mirror

Finally, set the Reﬂectivity to 1.0, and the Fresnel to 0. Now if you render, you should get
a completely opaque, mirror-reﬂective set of cubes.
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78.5. Why Are My Shadows Black?

Figure 693

Consider the render at right: this is a default document with a plane added; the cube has
ray-trace transparency turned on with an IOR of 1.5, Filter of 0.5, Depth of 5 and Alpha
of 0, other settings left at their default. The plane has a material with all settings at their
default.
Light should be able to pass through the cube and illuminate the part of the plane directly
behind; so why is the shadow completely black?
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Why Are My Shadows Black?

Figure 694

The problem is, by default, the Blender Internal renderer doesn’t bother to compute transparent shadows. Instead, it assumes that anything that blocks the light does so completely,
presumably because it would slow things down too much to assume the opposite. To ﬁx
this, select the plane (not the cube), and in its Material
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Figure 695

settings, look for the Shadow panel. Note the two checkboxes at upper left: by default
the “Receive” one is checked, the “Receive Transparent” one is not. Check the latter as
well. Now any object surface with this material assigned will have proper non-transparent
shadows computed as appropriate.
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Why Are My Shadows Black?

Figure 696

Now when you re-render, you should see a more accurate-looking transparent shadow.
Imagine if you had a scene with lots of non-transparent objects with diﬀerent materials
receiving shadows from lots of transparent objects: you have to check this “Receive Transparent” option on every single one of those materials that might be receiving transparent
shadows! Yes, this can be a pain. Not to mention the issue of caustics8 , which the BI
renderer doesn’t handle at all. If you want to render realistic scenes like this, then you will
need to learn about Cycles9 ...

8
9

https://en.wikipedia.org/wiki/Caustic%20%28optics%29
Chapter 153 on page 1345
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79. Using Textures
i Information
Applicable Blender version: 2.49
Having said everything about Textures in Blender in the manual http://wiki.blender.
org/index.php/Doc:Manual/Textures, many people ﬁnd it still hard to grasp the concepts
behind the texturing system and applying Textures.
There are some brilliant tutorials about texturing on the net, I personally like Texturing
for Dummies1 , by Leigh Van Der Byl. It is free (as in free beer, not as in free speech like
this book), so you should download and read it now, to take the most advantage out of this
tutorial.
We're going to see how to apply the texturing concepts within the Blender texturing system.
I will explain it using an image texture and procedural textures, but be aware of the fact
that the texturing system is quite complex, and more advanced maps are created with the
use of a few combined textures.
If you're really into texturing you need to learn how to UV-Map2 , there's no way around it.

1
2

http://www.3dlinks.com/downloads/texturing.pdf
Chapter 92 on page 899
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79.1. Colormap

Figure 697 Image 1a: An image applied as a texture
to a plane. Download texturea
a

https://en.wikibooks.org/wiki/%3AFile%3AWales-Tenby-Die%20Stadt.jpg

This is the most basic mapping type. You can use an image or a procedural texture to
change the color of a material.
Noob Note: A simple Basic texturing Guide The Basics of texturing I.3

3
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http://blog.machinimatrix.org/the-basics-of-texturing-i

Colormap

Figure 698

Image 1b: The Map To Panel for a colormap.

Using an image texture:
• Add an Image texture in the Texture Buttons and load the image (this is necessary also
for UV mapped textures).
• The button Col in the Map To Panel uses the RGB information of the image to change
the color of the material.
• The slide number button Col governs the blending amount of the texture, Neg inverts the
colourvalues.
• If you use No RGB only the intensity information from the picture is used. The target
color is then taken from the RGB sliders in the Map To Panel.
Using a procedural texture:The result depends on the type of value the texture provides.
• If the value is of type intensity (e.g. Clouds), the color is taken from the RGB sliders in
the Map To Panel.
• If the value type is color (e.g. Magic), everything is handled as with image textures.
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Note:
Color and intensity? What the heck?
An image texture (and other textures as well) may provide two diﬀerent types of values:
1. RGB-Color information
2. Alpha information. Now we have to take a look at a few diﬀerent scenarios.
• If an image has no alpha channel and you
• don't activate Use Alpha or Calc Alpha everything is easy - the texture provides
only RGB-Color information. An intensity value is then calculated automatically if
necessary.
• activate Use Alpha the texture provides no intensity value and it is not calculated.
If you now activate No RGB the intensity value is again calculated from the color
information. So either you use Use Alpha and No RGB or neither of them.
• activate Calc Alpha the texture provides automatically calculated intensity values.
Now No RGB has no eﬀect.

79.2. Diﬀusemap

Figure 699

Image 2a: Diﬀusemap settings with a small range (0.2).

A Diﬀusemap changes the amount of diﬀuse light the material reﬂects/absorbs. This is
controlled by changing the reﬂectivity (Ref). A material with a rough surface may have the
color white, but absorbs light to a greater amount than a material with a smooth surface.
For more on diﬀuse reﬂection physics, see Diﬀuse reﬂection4 .
Noob note: Most of the settings described below will be found in the ”Inﬂuence” section
under the texture/material panel in blender 2.61
Let's test:
• In the Texture buttons (F6), in the Map Image panel, make sure UseAlpha is unchecked.
• In the Material buttons (F5), in the Map To panel, uncheck Col and check Ref.

4
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https://en.wikipedia.org/wiki/Diffuse%20reflection

Diﬀusemap
Noob note: In blender 2.6x ”Ref” has been changed to ”Intensity”
To understand the eﬀect of this and all other mappings, we have to discuss the meaning of
the NumButton DVar (Destination Value).
• White in a texture (or an intensity value of 1) will be mapped to the value of the
DVar Button. So if you set Dvar to 1, white will be mapped to 1, if you set DVar to 0,
white will be mapped to 0. The result is multiplied with the value of the Var number
button.
• Black on the other hand (or an intensity value of 0) does not change anything, so the
settings from the material will stay unchanged. The diﬀerence between the material
settings and the DVar button is the range for the texture.
Let's take a look at an example.

Figure 700 Image 2b: The image used for the
Colormap applied as a Diﬀusemap with a small range
(0.2).

If we use the default settings for the Diﬀusemap the range of the values is small.
• Ref is 0.8
• Dvar is 1.0
• White pixels in the texture change the Ref value to 1.0, black pixels in the texture don't
change the Ref value at all.
So the resulting range for Ref is 1.0 - 0.8 = 0.2.
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Figure 701
(1.0).

Image 2c: Diﬀusemap with full range

When we change the Ref parameter in the Shaders panel to 0, we'll get a much larger range
of Ref values from 0.0 (black pixels in the texture) to 1.0 (white pixels in the texture).
There are other ways to achieve a larger range, you could also set Ref to ”Inverted” (click it
twice, it will be painted in yellow), DVar to 0 and Ref in the Shaders panel to 1.
Note:
Why is this so complex?
Well, with complexity comes ﬂexibility. You can use an image (or procedural texture)
for a few mappings at once, e.g. Color, Diﬀuse, Alpha, Spec and the like.

79.3. Luminositymap
Luminosity is the property of self-illumination, i.e. of objects emitting light. So we change
the Emit value with this texture.
This light does not illuminate other objects - you would have to use Global Illumination
(e.g. Yafaray) to use an emitting object as a true light source. Radiosity rendering does
not work with Luminositymaps.
Everything that was said about the DVar value applies here exactly as for Diﬀusemaps.

79.4. Specularitymap
Specularity is the second most important material attribute. Specularity fakes the reﬂections of light sources. Of course you can modify the general specularity with a texture. In
Blender you can change three diﬀerent attributes related to specularity:
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Reﬂectionmap
1. Spec: The degree of specularity. You can't set values above 1.0 with Specularitymaps,
but you could invert the texture and set Spec on the Shaders panel to a higher value
and Dvar to the lowest value of your range. So the texture actually lowers the specularity in all areas, that shall have a low specularity.
2. Hard: The hardness of the specular reﬂections. Sometimes called ”Glossiness”. A
DVar of 1 is equivalent to a hardness of 130. Use the same method as described above
to achieve a greater range for the hardness.
3. Csp: The specularity color.
You will probably use some kind of ”Dirtmapping” (stenciling) to change the specularity
in certain regions of an object, like an often touched object, that is shinier on the used or
touched parts.
For more on specular reﬂection physics see Specular reﬂection5 .

79.5. Reﬂectionmap
A Reﬂectionmap would be used to fake real raytracing reﬂections, either because you don't
want to use raytracing, or you don't want to create a scene, or you need a special eﬀect
you don't get with raytraced reﬂections. A Reﬂectionmap would be a Colormap, typically
an Environment Map6 . Since you can use prerendered Environment Maps, you can fake a
surrounding for your object. Sometimes it is suﬃcient to use a simple Colormap that just
bears the right colours, e.g. if you want to create a stormy sea it is not necessary that the
clouds above are truly reﬂected in the water.
Environment Maps are a bit more complicated to create, see the respective section in the
manual.
A very diﬀerent kind of texture would be used to change the amount of raytracing reﬂections,
the RayMir value. This is useful for something like a stained or dirty mirror. Simply click
the RayMir button in the Map To panel and lower the DVar.

79.6. Transparencymap
Transparency- or Alphamaps change the (partial) visibility of an object. They don't have
to be transparent themselves (though it doesn't hurt, see Make a material partially transparent7 ). You will often use an image as Colormap and Transparencymap together. A nice
example for a Transparencymap is in the paragraph Translucencymap.
There's one catch though, you can't change Fresnel transparency with a Transparencymap.
So you have to use plain transparency, or fake the Fresnel eﬀect with the method described
in the section Map Input8 .

5
6
7
8

https://en.wikipedia.org/wiki/Specular_reflection
http://wiki.blender.org/index.php/Doc:Manual/Textures/Types/Environment_Maps
Chapter 80 on page 789
http://wiki.blender.org/index.php/Doc:Tutorials/Textures/Map_Input_Techniques
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79.7. Refractionmap
Well, there's no such thing as a Refractionmap. You can't change the IOR with a texture.
You may try and use Environment Maps to fake refraction, but the result is often not worth
the eﬀort (for stills, in an animation it might not be that noticeable).

79.8. Translucencymap
Translucency is a material property of all semitransparent materials, like frosted glass,
paper, plastic, cloth, skin, stained glass and the like. It allows objects to be lit from behind.
Totally clear glass does not show where the lightrays travel through it. But if the glass is
dirty or uneven you will see the path of the light. In the ﬁrst example (Translucency 1) the
glass material has a transparency of about 0.5 and a translucency of 0.78. So the glass is
brighter where the lightrays hit the surface from behind. Additionally a Transparencymap
- which sets Alpha to 1 - lets the surface appear to be stained. If we use the same map also
as a Translucencymap (Translucency 2), the stain appears to be lit - which it would be of
course also in reality.

Figure 702 Translucency 1: Material with Translucency and a Transparencymap, but without a Translucencymap. This is an example from the releasenotes of Blender v2.32.

Figure 704

Figure 703 Translucency 2: Material with Translucency and a Transparencymap and a Translucencymap.

Material settings for example Translucency 2 (blue glas).

The settings for the material (Z-Transp, but raytracing shadows):
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Bumpmap/Normalmap

Figure 705

Adjusted Clouds texture.

The texture itself is a Hard Noise Clouds texture, with modiﬁed Brightness and Contrast.
Note:
To get the shadow and those colors as in the example images set the light to use Ray
Shadow and the plane to recieve transparent shadows by enabling TraShadow in the
shaders tab in the Material buttons.

79.9. Bumpmap/Normalmap

Figure 706

Settings for a Bumpmap in the Map To panel.

783

Using Textures
Bumpmaps9 are a technique to create the illusion of geometry. They could be used for
something like a canvas or any small structures that are either diﬃcult to model, or are too
computationally expensive. As long as you don't get too close with the camera you won't
notice the diﬀerence.
They come in several diﬀerent ﬂavors:
• A Bumpmap texture in the nearer sense is a greyscale image or procedural texture mapped
to Nor. Don't activate the button Normal Map in the Texture Buttons for a Bumpmap.
• A Normalmap is an RGB image whose color information bears the information about the
direction of the surface normal, also mapped to Nor. For this you need to activate the
button Normal Map in the Texture Buttons.
See also the manual about the diﬀerences between Bump and Normal Maps10 .

Figure 707

The bumped image.

Figure 708

The Bumpmap, a simple greyscale image.

In the example the bump map was used additionally to the colormap. The Nor slider in
the Map To panel sets the depth of the bumping.

9
10
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Displacement Map

79.10. Displacement Map

Figure 709

A displacement map deformes the mesh

A Displacement Map creates real geometry, i.e. it moves the vertices of a mesh. Therefore
you need a lot of vertices. You can use it as a texture mapped to Disp, or even more ﬂexible
using the Displacement Modiﬁer11 .

79.11. Dirtmap

Figure 710

11

Our picture has seen some bad times.

http://wiki.blender.org/index.php/Doc:Manual/Modifiers/Mesh/Displace
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I will try to explain what a Dirtmap is and how you apply one. There are diﬀerent things
that people mean when they talk about dirtmapping.
• Sometimes a Diﬀusemap is meant.
• Dirtshading is often used as a term for Ambient Occlusion.
With a Dirtmap I simply mean any texture that breaks the clean, uniform, untouched look
of image or procedural textures. You may do this by simply combining some partially
transparent textures resp. textures that aﬀect only parts of the picture in a semirandom
way. You can also select parts of the object with a stencil12 texture. And of course you can
(and will) combine both of these methods.
As long as two textures don't aﬀect the same property you can simply apply one after the
other. To select only parts of your texture to apply another texture with the same properties
use stenciling. Or use stenciling as a convenient method to separate two diﬀerent sections
on your texture.
You need at least three textures for this.
1. The basic texture (e.g. color).
2. The selecting (stenciling) texture.
3. The Dirtmap aﬀecting the same or other properties then the ﬁrst texture.
The stenciling texture has to provide an intensity value, so if you want to use an image (or
other RGB) texture you must activate No RGB.

Figure 711

The stenciling texture.

The image texture used as a dirtmap for our example contains some semirandom noise.

12
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http://www.cgcookie.com/articles/2008/12/21/blender-intro-to-stencil-maps

Dirtmap

Figure 712

Settings for the stenciling texure.

Nor for the stenciling texture was not really necessary, but it adds a nice 3D eﬀect. Since
the stenciling texture is mostly white, I had to use Neg to use the black pixels as mask.
The third texture (”Dirt”) aﬀects Col, Nor and Spec.
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79.12. Use UV Coordinates for your Maps
It is often necessary to create UV coordinates for more complicated textures/objects. UV
coordinates only describe the geometry of the mapping, i.e. which pixels to map on what
face. You can use the UV coordinates to create any mapping you want.
1. Create an UV map for your object. This is beyond the scope of this tutorial, see UV
Map Basics13 and the section about UV Mapping in the manual.
2. Don't turn TexFace in the Material Panel in the Material buttons on. Though
TexFace is a very simple way to use UV textures, the normal texture mapping methods
are much more ﬂexible.
3. Load the image you used for UV-mapping (or any image with the same size) as an
image texture. Change Map Input to UV.
4. Now you can use this image - or multiple diﬀerent images - for your maps, including
color-mapping.
The advantage of this technique is that you have much better control over your texture.
Even if you just want to texture something like a cube shaped object, you're often better
oﬀ with UV mapped textures.

13
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80. Using a texture to make a material
partially transparent
i Information
Applicable Blender version: 2.49
To understand the collaboration of textures and material we will use the opacity of a material
- the alpha value - as an example. We will show how to set the opacity/transparency of a
material with diﬀerent types of textures.
The Alpha value of the material is set with the A(lpha) slider in the Material panel. This is
the basic Alpha value. If Alpha is 1, the material is fully opaque, if Alpha is 0, the material
is fully transparent.
Now you change that basic Alpha value with a texture.
1. If the basic Alpha value is 1 you can only lower it with a texture, because 1 is the
maximum value anyway.
2. If the basic Alpha value is 0 you can only increase it with a texture.
The target value of Alpha that can be achieved with the texture is set with the DVar button
in the Map To panel. If Alpha is 0 and DVar is 0 than nothing will happen. You can set
either:
1. Alpha to 1 and DVar to 0, then the texture will lower the Alpha value, or you can set
2. Alpha to 0 and DVar to 1, then the texture will increase the Alpha value.
Both methods are possible and equal in the result, but for clarity we will always use method
number 1. There are more combinations possible, so it may be that you ﬁnd tutorials with
diﬀerent settings.
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80.1. Using a greyscale texture - white for opaque

Figure 713
of leaf

Image 1a: Greyscale Image

In Img. 1a the black areas shall become transparent, the white areas shall become opaque.
•
•
•
•

Load the image as Image texture, turn oﬀ Use Alpha.
Set the Alpha value in the material buttons to 1. This is the default value anyway.
Activate ZTransp (or RayTransp if you need refraction)
The Map To panel:
• Turn oﬀ Col (or else the texture would also aﬀect the color of the material)
• Turn on Alpha inverse, you have to click it twice. We need inverse here, because the
texture shall aﬀect the material from its black parts. (Noob Note: On blender 2.63
you need to set a speciﬁc 'Alpha' value (the one located under 'inﬂuence->diﬀuse) to
-1, as the alpha button referenced in this step no longer exists in 2.63.)
• Turn on Spec inverse (you don't want your transparent sections to show specular highlights) (Noob Note: As far as I could tell, the equivalent to doing this on blender 2.63
is to set a speciﬁc 'Intensity' value (located under Inﬂuence->Specular) to -1.)
• Set the DVar value to 0. The default value is 1.

Figure 714

Image 1b: Material settings for the texture

Now let's take a look at the texture.
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• Where the texture has a value of 0 (e.g. black) it will aﬀect the Map To values fully
(because we have used inverse).
• Where the texture has a value of 1 (e.g. white) it will do nothing.
• Where the texture has a value in between 0 and 1 it will aﬀect the Map To values partially.

Figure 715 Image 1c: Result of applying
the Greyscale Image to a plane

The result is shown in Img. 1c, the texture applied to a plane rendered against a white
world background.
If your texture is inverted, i.e. black shall become opaque and white transparent, simply
use the normal Alpha and Spec setting in the Map To panel. (Noob Note If you don't see
the white 'shine' on the maple leaf, move the default point lamp (lighting source) closer to
the plane mesh to which the texture and material are assigned.)
That's it. It's basically the same for all settings, the only problem that remains is sometimes
to know which value a texture will give if you use transparent textures or colored textures.
For 2.7 blenderers out there: To obtain the results I had a hard time and ﬁnally came
across (almost accidentally) to uncheck the 'use alpha' button in the image sub panel of the
texture menu. Then, you can get the results as above.
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80.2. Using a partially transparent texture to make the
material transparent

Figure 716 Image 2a: Using a partially
transparent texture

Often we have a partially transparent texture, and want to directly use that transparency
of the texture to make the material transparent too. We have now to think a bit about
the values that are generated by the texture itself: If we load the image texture with Use
Alpha, the Alpha value of the image is used as input value for Alpha and Spec in the Map
To panel. So a fully transparent pixel in the image has an Alpha value of 0, a fully opaque
pixel has an Alpha value of 1. This is exactly the same situation as above, simply turning
on Use Alpha and Premul(tiply Alpha in Advance) will give use the same result as with the
greyscale image.
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Figure 717

Image 2b: Texture settings for a RGB/Alpha texture

So:
• Turn on Use Alpha in the Map Image panel of the texture buttons.
• Turn on Premul in the Image panel. This is necessary to get real partial transparent
borders.
• Turn on Col in the Map To panel additionally.
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Figure 718

Image 2c: The result

The rendering result is pretty similar to Img. 2a, only that it is aﬀected by lighting (and
casts shadows).
Don't forget to turn on TraShadow in the Shaders panel for the object that is receiving the
shadow. (Noob Note: In Blender 2.6x you also need to check the ”Receive Transparent”
box in the shadow section of the material for the object receiving shadows or you will get
a black square shadow.)
(Noob Note: In this case add a plane colored white just below the ”leaf.” This is the object
the you should turn on TraShadow with as this is the object that will receive the shadow.
This is also providing that you have a light source properly positioned.)
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81. Creating Basic Seawater
i Information
Applicable Blender version: 2.49
[ed. note: Need a much more basic introduction to what materials, textures, maps, and all
the accompanying terms are with illustrative examples before diving into a speciﬁc sea-water
example. Much more eﬀective learning when you know what you're changing.]
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Figure 719

Settings for the seawater material

75% of the Earth's surface is covered with water. In homage to this great fact, we will
develop your materials skills ﬁrst by creating basic seawater.

81.1. Create 3 linked planes
First we create a new ﬁle in Blender and delete the default cube by pressing XKEY and
conﬁrming the popup dialog. Now switch to top view with NUM7 and enter SPACE
> Add > Mesh > Plane to create a plane. Then scale it up to 20 its original size
with the SKEY the way you've already learned in one of the earlier tutorials. Go to the
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side view with NUM3 and duplicate this plane two more times using Alt-D (not Shift-D),
moving the plane down on the Z axis by two grid spaces each duplicate. This will make the
transparency of the water more realistic once we set it. Using Alt-D rather than Shift-D
makes a linked duplicate, so that the changes we make to one plane eﬀect the other two.

81.2. Create material
Now oﬀ to the actual texturing work. Select any one of the planes and press F5 to bring
up the Material Buttons in the Buttons Window. You will probably ﬁnd two new small
windows appearing here: one called Links and Pipelines and the other one Preview.
(Noob note: A new section has been added for Blender 2.63 users after this section.)
Click the 'Add New' button in the 'Links and Pipelines' tab to create a new material
named ‘Material.001' or so. To make life easier we'll rename it to something meaningful like
'Seawater' by simply clicking it and typing in the letters, as shown here (SHIFT+DELETE
in ﬁeld to clear):
Now, on the same tab, give the seawater material a color of RGB (0.100, 0.310, 0.435). Find
the tab that reads 'Mirror Transp' and click it. Click on 'Ray Mirror' and 'Ray Transp'.
For the ”Ray Mirror” box, move the 'RayMir' slider to 0.3, the 'Fresnel' slider to 2.5 and
the Depth to 5. For the 'Ray Transp' box, move the 'IOR' slider to 1.33, the 'Fresnel' slider
to 2.0 and the Depth to 5. This will give the water realistic transparency and reﬂection.
Also click the 'Shaders' tab, change 'CookTorr' to 'Blinn', move 'Spec' to 2.000, 'Hard' to
180 and 'Refr' to 10.000. This will make the water look more glossy.
Now we'll add a procedural texture to our seawater, which will give it a ”wavy” look. Click
the Texture button (looks like bricks) or press F6 to view the texture buttons subcontext.
Click on the knob to the left of the texture name and select the ”Add New” button. This
creates a new texture named ”Tex.001” or so. Click on the name and change it to ”Waves”.
Go to the Texture Type pull-down (F6) and select 'Clouds'. On the Clouds tab change
'NoiseSize' to 0.050. Our Waves texture is ready; next, we will reﬁne how it is applied to
our Seawater material.
Noise Size increases the size of the noise, in this case, the clouds. Soft Noise blends the
intensities and reduces the contrast. Makes a mellow eﬀect, like soft waves. Hard noise
creates a high contrast, and brings out individual 'shapes'.
If you want to add more detail to your water, add another texture and rename it to ”LargeWaves”. Make it a cloud texture like the previous one, but make it's 'NoiseSize' 0.300 and
use 'Hard noise'.
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Figure 720

The ﬁnal rendered image

Left click on the Materials button (looks like a red sphere) to return to the material buttons
subcontext. Look at the Texture panel, and you'll see that the ”Waves” texture has been
automatically associated with the Seawater material.
Select the 'Map To' tab. Click the 'Nor' and 'Spec' buttons so they're selected and have
white text (the white text indicates a positive mapping). Click the 'Hard' button twice so
it's selected and has yellow text (the yellow text indicates a negative mapping). Click the
'Col' button so it is not selected, this button will show any color in the texture which we
do not want. Find the 'Nor' Slider and move its value to about 5.00.
If you created the ”LargeWaves” texture, select the ”LargeWaves” texture under 'Texture
and Input', go to the 'MapTo' tab, deselect 'Col', select 'Nor' and move the 'Nor' slider to
7.00. Do not select 'Hard' or 'Spec' this time.
For lighting press Space > Add > Lamp > Sun. You shouldn't need to move the sun
or change any of its settings. Finally move the camera to the edge of the plain and move it
up towards the sky a bit.
Go to the Scene tab (F10), and look for the six buttons next to the big render button.
Deselect all these, leaving only the 'Ray' button selected. This will tell Blender not to
render some features in our scene that we really don't need. Go and press F12 to render
the water, it may take a while depending on your system.
Admire your water, and maybe drink a tall glass of something refreshing!
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81.3. Create Material / Textures (Blender 2.63)
Material
• Go to the properties window (Bottom right window by default) and click on the Material
tab
• Click of the + symbol to create a new material and name it Seawater
• Click on the diﬀuse color box and give it a seawater blue RGB (0.100, 0.310, 0.435)
• Enable the Mirror checkbox
• In the Mirror section, set Reﬂectivity: 0.3, Fresnel: 2.5 and Depth: 5
• Enable the Transparency checkbox
• In the Transparency section, click the Raytrace button
• Also in the Transparency section, set IOR: 1.33, Fresnel: 2 and Depth: 5
• In the Specular section, use the pull-down menu to change CookTorr to Blinn, then set
Intensity: 1, Hardness: 180 and IOR: 10
Textures
•
•
•
•
•

Still in the Properties window, click on the Textures tab
Click on the “+ New” button to create a new texture and name it Waves
Set the Type: Clouds using the pull-down menu
In the Clouds section, set Size: 0.05 to create soft noise
In the Inﬂuence section, uncheck Color under Diﬀuse, then under Specular, check the
”Specular” box and “Hardness” box then set the value to Hardness: -1. Under Geometry,
check the “Normal” box and set the value to Normal: 5

(Noob Note: V. 2.78 Under Mapping change coordinates to Generated.)
• Select the second line in the Textures list and create a second Texture using the “+ New”
button. Name it LargeWaves
• Set the Type to clouds again, but this time, set Size: 0.3 in the Clouds section and click
on the ”Hard” button for hard noise
• Deselect “Color” and under Geometry, select the “Normal” box and set the value to Normal: 7
(Noob Note: V. 2.78 Under Mapping change coordinates to Generated.)
Lighting
•
•
•
•
•

In object mode, select the default lamp (if present) and delete it
Create a new lamp by pressing ALT+A and selecting Lamp --> Sun
Place the Sun in the sky by moving it up the Z-axis. Press G, Z, 20 and hit ENTER
Go back to the Properties window and click on the World tab
Click on the box under Horizon Color and set the color to RGB (0.242, 0.617, 0.831) for
sky blue
• Position the camera to be looking over the water with some sky visible and render your
scene.
• How about using what we have learned in previous modules to add some dolphins swimming just below the surface?
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Figure 721

The ﬁnal rendered image

81.4. Extra Practice
This tutorial might also help you make even more realistic water: Link1

1
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http://forum.nystic.com/viewtopic.php?f=34&t=1445

82. Mountains Out Of Molehills 2
i Information
Applicable Blender version: 2.49
This tutorial shows you how to use displacement mapping to make a simple environment.
1. Make a grid. (Add/Mesh/Grid) 32x32 will do just ﬁne. Be sure to create a Grid
instead of a Plane, or you'll end up with just a ﬂat plane! This is because a Plane
only has four vertices to manipulate - one for each corner - while a Grid has many,
many more. A 32x32 Grid, for example, would have over 1000 vertices. The more
vertices there are to manipulate, the more eﬀect displacement mapping will have on
the ﬁnished product.
2. Set it smooth. (Editing/Link and Materials/Set Smooth)
3. Make a new material for it. (Shading/Material/Add New)
4. Make a new texture for the material. (Shading/Texture/Add New)
5. Go to Shading/Texture Buttons. You can see your newly created texture there now.
6. Change Texture Type to Clouds.
7. Change the name of the texture to be more descriptive. For example GroundDisp or
something similar.
8. Go back to Shading/Material buttons. You can see our cloud texture applied now,
but it's not applied correctly yet. Let's ﬁx this next.
9. Go to Shading/Map To. This deﬁnes how the selected texture is mapped on our
material. Uncheck Col, check Disp on, and set the Disp slider to a value like 0.200
10. Set camera and a few lights to the scene. (This is already done as part of the default
scene in recent versions of Blender, such as 2.49)
11. Render.
Noob Note It looks like from version 2.70 there is no shading as a main tool but rather
as a subtool for Material, so in version 2.70 to get the eﬀect described in here you have to
check third checkbox in Texture>Inﬂuence>Geometry and adjust the slider
Several individuals, when working through this tutorial, had trouble getting anything
more than a ﬂat plane. A few solutions were proposed (most are still visible on the Talk
page), and while each worked in its own way, the vast majority of the time the problem
stemmed from creating a Plane instead of a Grid. With version 2.79, it was necessary to
change Texture | Mapping | Coordinat in the Properties window to Generated, Object,
or Global rather than the default ”UV” to get anything but a plane. Be sure to follow
each step very carefully to ensure you don't miss anything or do a step incorrectly.
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Figure 722

You can tweak the environment easily by changing Nor value in the Shading/Map To. This
deﬁnes how strongly the displacement texture aﬀects the material.
You could also add subsurﬁng to the ground area to get smoother results. Also feel free to
tweak the texture and try out diﬀerent alternatives.
Once your mountain looks good, try adding some Mist.
1. Select the ”Mist” button on the ”Mist/Stars/Physics” Tab among the World buttons
2. Add a Cloud Texture to the World and make it blend from white to gray
The end result is something like this:
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Figure 723
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83. Basic Carpet Texture
i Information
Applicable Blender version: 2.49

83.1. Goal
I am using a basic scene that I quickly set up before I started to create the carpet material.
It shows a monkey (suzanne), a plane, camera, 3 area lamps and 1 spot lamp.

Figure 724

The basic scene setup

The purpose of this tutorial, is to highlight the power of blenders built in shaders and
procedural textures to create a carpet material to use in your scenes.
NOTE: For those of you needing help getting a similar scene to the one above, here are some axis positions,etc. to
help out:
(Spot-Lamp)-X=1.62,Y=0.86,Z=6.74;rotation-X=37.26,Y=3.16,Z=181.34;
(Area-Lamp-1)X=4,Y=3.27,Z=4.12;rotation-X=54.67,Y=-18.59,Z=-109.47;
(Area-Lamp-2)X=-2.07,Y=-2.08,Z=4.85;rotation-X=29.37,Y=-28.98,Z=355;
(Area-Lamp-3)X=0.315,Y=-2.89,Z=4.29;rotation-X=49.23,Y=-10.63,Z=6.68;
(Monkey)X=0.05,Y=0,Z=0.42;rotation-X=58.61,Y=-16.07,Z=23.245;DIM(dimensions)X=2.734,Y=1.969,Z=1.703;
(Plane)x=0,y=0,z=0;(no rotation);Dimensions: X&Y=14.30,z=0.
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Alternatively, you could also download a pre-made ﬁle1 in case that you're in a hurry.
Noob Note: Try adjusting each of the area lamps Dist(ance) value.
Noob Question: How does the above coordinates help me at all? I haven't found anything
that tells me were in 3D space object actually is or the objects dimensions little alone control
them. Nothing in the Tutorial up to now even gives a clue to this.
Noob Answer: Hit 'N' to bring up the Transform Properties window and enter the values
there.

83.2. The Basic Material and Shader Settings
For the basic material for the carpet set the color settings of your material as follows Col (R 0.714) (G 0.134) (B 0.134) Dark Red
Spe (R 0.590) (G 0.210) (B 0.084) Reddish Brown
Mir (R 1.000) (G 1.000) (B 1.000) White
Noob Note: Copy paste-able hex values: Dark Red (DC6666), Reddish Brown (CA7E52)
and White (FFFFFF)
Change the specular shader to ('phong') and leave the default lambert diﬀuse shader as
it is. Change the ('spec') to [0.13] and the ('hard') to [12]. Lastly click the ('Full Osa')
button to enable it. If you render now you will notice that the plane looks like an ugly
pastel color (if not, you have a diﬀerent lighting setup to mine and the shader will not look
the same as the images in this tutorial.) Don't worry about this ugly looking plane it will
soon be a beautiful carpet.

Figure 725

1
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Shader Screen-shot

http://www.mediafire.com/file/wwkzd9be907681g/basic-scene.blend

Cloud Texture 1

Figure 726

Base Shader

83.3. Cloud Texture 1
Press 'F6' on the keyboard to bring up the texture panel. Click the bottommost of the
long boxes to create a texture in the bottom channel. Create a new texture and rename it
something like 'Red Clouds 1'. From the ('Texture Type') pull down select clouds. In the
'Clouds' settings panel change ('NoiseSize') to [0.210] and ('NoiseDepth') to [4].
Now select the Colors tab which will bring up the ColorBand for the texture. Press the
orange ('Add') button to add a cursor on the colourband. Next make sure the 'Cur : 0'
is showing next to the add button and change the colours as follows - (R 0.770, G 0.168,
0.168). Now click on right side of the 'Cur : 0' so it shows 'Cur : 1'. Change 'Pos' to 0.6.
Set Alpha to 1 and change the colour to (R 0.732 G 0.243 B 0.243).

Figure 727

Texture 1 texture panel Screenshot

Now go back into the material settings and change the settings in the Map To tab as
follows. Click ('Spec') twice so the text becomes yellow do the same for ('Hard'). Now
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select 'Subtract' for the texture blending mode. Change ('Col') to [0.188].

Figure 728

Texture 1 materials panel Screenshot

At this stage if you render you might ﬁnd it hard to notice the diﬀerence, it is apparent
only where there is low light levels on the plane, don't worry about this at the moment. It
means if you render with Ambiant Occlusion you get a nice carpet eﬀect of slightly varying
colour.

83.4. Cloud Texture 2
Go back to the texture panel and create another texture, call it 'Clouds' and put it in
the channel above 'Red Clouds'. Change ('NoiseSize') to [0.054] and ('NoiseDepth') to
4. Select 'Improved Perlin' from the Noise Basis pull down. Finally change ('Nabla') to
[0.031]. Do not change any more settings here.

Figure 729

Texture 2 texture panel Screenshot

Now in the material panel, under the Map To tab change the following - Click ('Nor'). Click
('Spec') and ('Hard') twice so as they are yellow.
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Figure 730

Texture 2 material panel Screenshot

Figure 731

Render with the 2 textures so far

As you can see the material is starting to look a bit better, only 2 more textures to go.

83.5. The Final Cloud Texture
Switch to the texture panel once again and create a new Clouds texture in the next channel
up. Change ('NoiseSize') to [0.010] and ('NoiseDepth') to [6]. Now click on the 'Colors' tab
and change the colour of the left cursor ('Cur : 0') to (R 0.713 G 0.262 B 0.223) and Alpha
to 0. Switch to Cursor 1 ('Cur : 1') and its colour settings (R 1.000 G 0.363 B 0.000) and
Alpha to 1.
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Figure 732

Texture 3 texture panel Screenshot

Now in the materials panel under the 'Map To' tab Click ('Nor'). Click ('Spec') and ('Hard')
twice so as they are yellow. Leave the blending mode as 'Mix'. Change ('Col') to [0.464]
and ('Nor') to [1.00].

Figure 733

Texture 3 materials panel Screenshot

Figure 734

Render of the 3 textures so far
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83.6. The Last Texture
Finally, go to the textures panel one last time. Create a new Stucci texture in the next
channel up. Change ('NoiseSize') to [0.006] and ('Turbulence') to [10.94]. Click on the
'Colors' tab. The ﬁrst cursor 'Cur : 0' should be black with alpha 0. 'Cur : 1' should be
red (R 1.000 G 0.000 B 0.000) with alpha 1.

Figure 735

Texture 4 textures panel

Now go to the materials panel. Under the 'Map To' tab Click ('Nor'). Click ('Spec') and
('Hard') twice. Change the Blending type to 'Subtract'. Change ('Col') to [0.056] and
('Nor') to [0.50]. And that's it. When you render now, you should have a nice-looking
carpet material. By tweaking with the colours you can create any colour of carpet.

Figure 736

Texture 4 material panel
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Figure 737
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Final Render of Carpet Material

84. The Rusty Ball
i Information
Applicable Blender version: 2.75
Making objects with image textures is not really hard for simple objects like balls, cubes,
and tubes. I'll show you how to do this:

Figure 738
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1. Make a new scene in Blender and delete the default cube.
2. Add a sphere. Apply a Subsurf modiﬁer and Smooth as we have learned in previous
tutorials.
3. Find a ﬁle picture that you want to apply to your object. Check Flickr for something
like ”rust texture.” (If you are going to share it, be sure you check the license of the
texture you download.)
4. IMPORTANT: Sometimes you need a seamless texture. If you are not sure, use a
program such as GIMP. Use FILTERS > MAP > MAKE SEAMLESS. Usually this
works well but if your texture turns into gorp, try another one.
5. (Noob Note: Do http://lmgtfy.com/?t=i&q=rust+texturessearch for Rust
Textures 1 if you do not have one handy.)
6. In the Properties Panel, which by default is the bottom right panel, select the Material
icon

Figure 739
.

1
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7. Select NEW or if you already have a material in use, select the + sign to add a new
material. Give it a good name like rustyball.
8. Click on the Texture Icon

Figure 740
.
9. Click NEW or if you already have a texture loaded, click on the + to add a new one.
Give it a good name like RUST.
10. The default type is CLOUDS. Pull down the menu and change it to IMAGE OR
MOVIE.
11. Go to the IMAGE section, choose OPEN. New options will become available. (Note:
JPGs, PNGs or TGAs are recommended for Blender. Bitmaps tend to get all screwy.)
12. Under Source: Click the folder icon and navigate to your image.
13. Scroll down. In the Image Mapping area are some options that you may need to try.
If your image is small it may have to be repeated in the X or Y directions.
14. In the Mapping section (yes, one section is Image Mapping and the other is just
Mapping) after Projection, choose the shape closest to your object. If you are using
a sphere like the example, then choose ... you guessed it ... SPHERE.
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• The Preview often looks a bit odd and stripey, but render your project and it should look
very nice.
• This method works for all sorts of things. Try making a brick wall with a wooden gate
using Flickr textures or go back to the Jeep tutorial and put a pattern on your jeep.
• You can also render videos onto objects using this method. Just select a movie in the ”Load
image” dialog and enable the option ”Movie” at the textures buttons. NOTE: Blender
ONLY works with Full Resolution video, not video which has been compressed using
a codec. Most video software will allow you to export video as ”full frames” or ”no
compression”. Experiment a bit!

Figure 741
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The Last Texture

Figure 742

Textures used from Flicker under Creative Commons 2.0 license

Figure 743

Psychedelic Jeep, my own texture such as it may be
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85. Creating Pixar-looking eyes
i Information
Applicable Blender version: 2.49

Figure 744

The ﬁnal result, with a blue iris.
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Note: This tutorial uses the same modelling and texturing technique described in the wellknown MAX tutorial by Adam Baroody (http://www.3dluvr.com/rogueldr/tutorials/
eye/eyes.html). The sole purpose of my tutorial is to make this technique more popular
among the Blender users by explaining how to achieve the same result with Blender.
The goal of this tutorial is to make a Pixar-looking eye. One of the main reasons that
Pixar's characters really convey life is in their eyes. They have depth, you can see how the
eye not only shines but it ”collects” light. You may think that you can't achieve this eﬀect
without raytracing but you're wrong. The secret of this depth is in the modelling of the
eye. Let's see how it works!

85.1. Parts of the Eye
In this picture you can see the ”ingredients” of the eye model. The blue mesh at the left is
the cornea. Its shape allows for a small spot of specular light to appear on it even if the
light is in a far side position. The mesh next to it is the iris. Now notice how it's a bit
concave. That's the tricky part - the shape of the iris allows for a wide soft specular light
to appear at the opposite side of the lamp direction. This fakes refracted light from the
cornea and makes the illusion of ”collecting” light and creates depth. The next mesh is the
eye pupil - a simple circle.The pupil size is the same size as the iris hole. You can position
it close to the inner side of the iris. And ﬁnally - the eyeball. It's a simple sphere with a
hole in it.
I won't go deep into modelling of each element - it uses Blender's subdivision surfaces and
it's quite simple as you can see.

Figure 745
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85.2. Materials
Now let's look at the materials.

85.2.1. Sclera
To make the eye white, press NUM3 to go into side view and add a UVsphere with 8
segments and 8 rings. To create the hole at the front of the eyeball, delete the 8 triangular
faces that make up one end of the eyeball. Ctrl+Tab+3 to go into face select mode, B for
border mode and select the middle 8 triangles as shown below, press Delete or the X button
and LMB on Faces.

Figure 746

The resulting hole will be ringed by 8 vertices (which you could subsequently extrude and
use to help you model the sections below - just a suggestion for those who feel capable)

821

Creating Pixar-looking eyes
The eye white1 has white color and high values for Spec and Hard (depends on the lighting),
as well as a moderately high Ref value (0.700 - 0.800). Optionally you can use a reﬂection
map to make it look more wet but I usually don't do this.
(Noob note: Using a Phong specular shader turned to work quite well.)
(User: Make sure shadow buttons are oﬀ or it will black out the iris. Spec and Hard are
located in the Shaders tab.)

85.2.2. Iris
• Loop select the opening of the eye (ALT+RMB click edge of opening).
• Duplicate the loop (SHIFT+DKEY). Move the new loop away from the eye a bit perpendicular to the opening.
• With the loop still selected, extrude (EKEY). Without moving the extrusion, press ENTER.
• Resize by half (SKEY then .KEY then NUM5 then ENTER).
• Move the inner loop back toward the eye a bit to form the concave shape.
• Create a new material2 and create a new texture3 called iris. Then hit F6 or click the
spotty square icon

1
2
3
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Chapter 34 on page 283
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Materials

Figure 747
to open the texture panel, choose Image as the texture type and then press Load Image
button and use the image below.

Figure 748

Setting the iris color.
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Here is the eye texture taken from the picture above:

Figure 749

The iris

Alternatively, you can create an image like this procedurally, using the technique described
here4 .
All that is required now is a bit of tweaking of the texture size using the Xsize and Ysize
values in the Map Input tab, and scaling the pupil hole size in Edit mode. Also please
remember to change 'Projection' in the map input settings from 'ﬂat' to 'cube'. You can
tweak the RGB values and brightness/contrast of the image to achieve the appearance
4
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Lighting
you want. Use a smaller value for Hard (about 50) otherwise you'll have a too shiny look
instead of soft specular that fakes refracted light. The Spec value depends on the energy
and distance of the light that illuminates it. Generally you'll need to take care that the
refracted light on the iris should be no more than half as bright as the small specular spot
on the cornea - otherwise you'll achieve the bad eﬀect of two specular spots. Oh, another
important thing - join the four meshes before tweaking the texture coordinates. Otherwise
you'll have to do the job twice after you join them, because the texture space is changed.
And activate shadeless button.

85.2.3. Pupil
The material for the pupil is a simple black color with the ”shadeless” button on.

85.2.4. Cornea
The cornea uses a transparent material (alpha = 0.1) with Spec = .6, Hard = 255 and
SpecTra = 1. ”Ztransp” should also be turned on (found under Links and Pipelines tab).
The cornea is simply a piece that ﬁts exactly in the middle of the hole in the eye white.
Make sure that the 'Traceable' button, under Render Pipeline, in the Links and Pipelines
tab, is switched oﬀ.
Noob note: It may be helpful to turn oﬀ Shadebuﬀ since you don't generally want the
cornea to cast a shadow.

85.3. Lighting
The lighting is simple - move the eye to a new layer, create a new lamp and make the lamp
aﬀect only this layer. Position the lamp at a good angle so you have a small shiny spot of
specular light on one side of the iris and a soft spot of ”refracted” light on the other side.
You can use a backlight to prevent the eyeball from being too dark at the non-illuminated
part.
To move the newly created lamp to a new layer, press SHIFT+M and select the second
blue button and press OK.
Note though that it is not mandatory to create a new layer; it's just meant to prevent
cluttering in your main workspace. It's completely optional.
That's it! Now you're (almost) ready to start with character animation. You have a nice
eye, now you only need a character for it!

85.4. Changing the Eye Color
You can change the color of the eye by either changing the cornea color, or by changing the
iris color itself. Changing the cornea color might be like putting on colored contacts.
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85.4.1. Changing the Cornea Color
To change the cornea color, do the following:
1. In the mesh which is used to create Cornea set the value of the alpha slider to 0.2 (or
more if you desire)
2. Change the color of the mesh to whatever color you like
3. Turn oﬀ traceble

Figure 750
4. Render!
(and remember to smooth out everything by selecting the particular mesh going to edit
buttons and clicking on set smooth)

Figure 751
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Figure 752

Figure 753

85.4.2. Changing the Iris Color
To change the iris color you can either edit the iris image external from blender or you can
modify the RGB values of the image when imported into Blender.

827

Creating Pixar-looking eyes

Figure 754

Setting the iris color.

Figure 755

Figure 756
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Figure 757

85.5. Troubleshooting
85.5.1. I don't know where is the ”SpecTra” Value. I'm working on 2.46.
You can ﬁnd ”SpecTra” under ”Mirror Transp”

85.5.2. My cornea isn't transparent. I don't know where Traceable is
since I'm using 2.6x
This applies to 2.6. Something that doesn't seem to be mentioned in this tutorial (sorry if
it is and I missed it) is the cornea's shadow settings. If it casts a shadow, it will block out
everything inside the eye. So under the cornea's Material->Shadow settings uncheck the
cast box. Another option is to leave the cast box in your cornea on, and change to shadow
setting in your iris. Check the Receive Transparent, and that works just as well.

85.6. Useful Links
1. Ira Krakow's Blender 2.49 Pixar Eye Tutorial5
2. For rigging an eyeball, (making it stay in one place while turning to look at something)
and other eyeball stuﬀ, you can visit this site. This tutorial assumes you already have
the eyeball made above or one of your own. Click.6 5jun2009, the PDF shows no
rigging, only creating an eyeball. (May 10th 2011, the site no longer exists.)

5

http://www.youtube.com/watch?v=52KEN7NJkP0
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86. Procedural Eyeball
i Information
Applicable Blender version: 2.75
Level: intermediate
Building a better (procedural) eyeball!
Originally created by Jon McKay (Ammusionist) and posted on blenderartists.org/forum
http://blenderartists.org/forum/showthread.php?t=85722&highlight=eyeball
The end result of this tutorial is an eyeball that fulﬁlls the following requirements:
1. Single mesh
• I wanted to be able to append a single object into any project.
2. Procedural Textures
• I didn't want to have to rely on image maps that could get lost.
3. Versatile
• One single model to be used for any type of character, be it human, alien or whatever.
4. Easy
• Any eﬀects needed to be quickly accessible. I don't want to be wasting time faﬃng
around with colour-band settings at the texture level
5. Impressive
• This sucker needs to look good any way it goes.
6. One other thing I really wanted was the iris musculature to follow the pupil dilation!
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Figure 758

An old and diﬀerent Tutorial:
1. Very old video for making deep-looking eyes http://www.youtube.com/watch?v=
KKmHUZroaBA1 http://

86.1. Creating the Mesh
The objective here is to make a great looking eyeball. That means it may not be anatomically perfect, but there are some things we need to take into account: The eye should consist
of a white (white bit with veins); an iris (coloured bit); a pupil (black but in the centre of
the iris) and a cornea (clear bit surrounding the whole eye). These may not be absolutely
correct, but these are how I'm referring to the pieces of the eye.
1. Start with a ball: Go to a front view ( 1KEY ) and create a UV sphere. 32 Rings and
32 segments should be suﬃcient. It'll give us plenty of smoothness and enough verts
to work with when we create shapes.
2. Click on ”Align to view”
3. This sphere will become the coloured parts of the eye, but we also need a second
sphere for the cornea. Use the Z key to switch to a wireframe view (if you're not
already there). Hit the A key a couple of times to ensure all points are selected
then SHIFT + D to duplicate the sphere.

1

832

Chapter 1 on page 5

Creating the Mesh
4. Press S key to scale and scale the second sphere to slightly larger than the ﬁrst.
(Hint: Hold SHIFT while scaling for ﬁne adjustment) or you could also enter a value,
1.01.
5. Now that we have a nice confusing mesh, we're going to make our life easier. We're
going to hide the outer bit for the moment. Hit the H key.
6. Noob Note: Don't panic like I did the ﬁrst time I accidentally hit H , you can
bring it all back with ALT + H . (Note: In blender ALT + some key often reverses
the eﬀect of pressing the key in the ﬁrst place!)
• OK Now to create the basic mesh for the inner part. Basically, we need to make a concave
iris/pupil section.
1. Make sure you’re in Orthographic view.
2. Switch to a side view and use the Border Select ( B ) to select the ﬁrst 4 rings and
the tip. Now we're going to ﬂatten these. Press S for scale Y for Y axis only
and 0KEY for scale-to zero.
For more realistic eyes you can also grab the inner 3 rings + the tip a bit inwards the eye.
Noob Note: It is also possible to ﬂatten the rings in a way that leaves the last ring in
place and moving the rings later is not necessary. Before you ﬂatten those 4 rings and the
tip of the sphere place your 3D cursor in the plane where the last ring involved in scaling
operation lies (use border select to select only the fourth ring, press SHIFT + S , and
select ”Cursor to Selected”). Then set the pivot point to ”3D Cursor”. Finally proceed like
instructed above by selecting all rings to be ﬂattened and scaling them to 0 in Y direction.
This time the outermost ring will stay in place. Do not forget to set the pivot point back to
the default option ”Median Point”. You may return the 3D cursor to the center by pressing
SHIFT + C .
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Figure 759

1. Last, grab them along the Y-axis to the eye till it's round again.
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Figure 760

• Now for the cornea. It's not perfectly spherical; it bulges slightly at the front. We're
going to use the Proportional Editing tool.
1. First, we need to un-hide the cornea. Hit Alt-H to make it visible.
2. Click the O-Key, this will activate proportional editing, click on ”Connected” in the
3D view header at the settings for Proportional editing.
3. Select the type of falloﬀ: “Sphere Falloﬀ”
4. Press A-Key a couple of times again to make sure no points are selected, switch to a
side view (Keypad-3) and right click just to the left of the front-most point. We just
want to select the tip vertex.
5. Now comes some fun. We want to drag that point away from the eye in the y axis, so
press “G” for grab and “Y” for Y axis. As you move the vertex, you'll see a circle that
deﬁnes the inﬂuence of the proportional editing. Adjust it so it is as the height of the
whole iris and drag it out until it looks right.
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Figure 761

1. First, switch oﬀ Proportional editing.
2. Select from center the tip and the ﬁrst 4 Loops.
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Figure 762

1. Then Hit Ekey and Ykey then drag out a bit 'till it's good.
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Figure 763

• To clean the model up, we're going to apply a subdivision surface modiﬁer and some
smoothing.
1. Go to Modiﬁers in the Properties Header and hit new and choose ”Subdivision Surface”
choose view: 2.
2. Hit Tab to switch to Object mode and hit the ”Set Smooth” button in the Link and
Materials panel.
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Figure 764
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Figure 765

• Now would be a good time to save your work before we go on to textures.

86.2. Adding the Textures
You're going to need multiple materials on this mesh. It's possible to apply materials to
selected faces.
1. Press A a couple of times to ensure nothing is selected.
2. Press Z to switch oﬀ wireframe; this will be easier without it.
3. Place the mouse pointer in the centre of one of the faces on the outside layer of the eye
and press “L” to select linked faces. If you get a message saying “Nothing Indicated”
try positioning the pointer on a diﬀerent face and try again.
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Figure 766

1. Once the outside section is selected, go to “Materials” in the Properties Header, click
“+”. Click “Assign” to assign the outside faces to Material.001.
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Figure 767

• Now the inside.
1. Hide the outside faces (H-Key). We'll assign the rest from the eye. If a face is already
assigned to a material and you assign it to another, it just switches material.
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Figure 768

1. Press A to select all and, as above, click “+” then click “Assign” so it is assigned to
Material.002.
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Figure 769

• Now for the iris and pupil.
1. Hit A to deselect all.
2. Switch to a front view and zoom in. Hit “C” to enable circle select and select the
central faces plus one ring out. You can control the size of the selector by rotating
your mouse wheel.
3. Again, create a “+” material index and “Assign” the pupil faces to it.
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Figure 770

1. Finally, click Akey to deselect all and use circle select again to select the remaining
faces on the iris. Assign them to a new material.
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Figure 771

• Now we're ready to make the materials.

86.2.1. Cornea Material
1. Switch to object mode (Tab). Go to Material.001.
We'll start with the simplest texture ﬁrst. The cornea is basically just colourless and
transparent. This is because some lighting conditions make the eye under the cornea diﬃcult
to see. Go to the shading buttons (F5)
1. Locate the “Transparency” control. Set this on. This means as we go we'll be able to
see through the cornea. Note that we're using Z-Transparency instead of Raytrace.
And set Alpha to ”.2”
2. Diﬀuse at white and intensity is 0.1.
3. Under Specular CookTor is used 1 and Hardness is 333.
4. Under Mirror, Click on, and set to 0.4, Depth is 3
5. Unclick the 'Traceable' setting under Options
6. And Under Shadow unclick ”Cast”
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Figure 772
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Figure 773

86.2.2. White Material
The white of the eye's a little trickier. The material here includes some red veins that can
be seen at the side of the eye, but not from the front. This can be done with two textures,
but there's a cheat we can use.
First, the veins:
Switch to Material.002.
Go to the texture Properties aside of the from the Material:
Make a new texture.
Use a marble texture, and copy these settings.
1. Under color choose Ramp.
2. The ﬁrst point is ”0”: Pos=0; R=1, G=0.0, B=0.0; A=1;
3. Click on the second point, The second point is ”1”: Pos=0.340; R=1, G=1, B=1; A=1;
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4. Under the Marble tab: Sharper, Sin, and under ”noise”, hard are clicked;
5. Size=2; NoiseDepth=10; Turbulence=26.04;
6. And set under mapping ”Coordinates” to ”Generated”. And ”projection” to ”sphere”
or ”Flat”.
The two colour band items are shown here separately. This makes a nice marble texture
that will evenly cover the eyeball. So how to hide it from the front of the ball? Another
colour band trick, but this time in the material itself.
Here they are in all their glory.
1. Under the material tab, Diﬀuse is white and intensity is 1;
2. Check Ramp, 0: Pos=0.533; R=1, G=1, B=1; A=0; Input is Shader;
1. 1: Pos=0.544; R=1, G=1, B=1; A=1; Input is Normal;

Figure 774
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Figure 775
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Figure 776

The colour band items are both white with one alpha 0.0 and one alpha 1.0. As you can
see they are very close together to give a fairly clear line that the veins will stop at. The
input setting for the band is set to “Normal” this means the left hand side of the band refers
to faces that are parallel to the camera view and the right is faces that are facing directly
towards the camera.
There's also some colour band fun to be had with the pupil material.

86.2.3. Pupil Material
I wanted a nice black texture, but I also wanted to get a red-eye eﬀect if a light is shone
directly at it from behind the camera. Why? I guess just because I can, and now so can
you!
As before move to Material.003.
There are no textures in this one. It's basically black and a little reﬂective with a nice hard
specular.
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1. Diﬀuse is Black, presumably with an Intensity of 1
2. Specular is white with an Intensity of 0.6 and a Hardness of 300;
3. Under Mirror reﬂectivity is 0.1;

Figure 777

If you want to have the red-eye eﬀect, have a good look at the colour band settings though!
(Not Necessary, and maybe not wanted by everyone)
1. Check Ramp.
2. 0: Pos=0.970; R=0, G=0, B=0, A=0;
3. The second is fully red (with no blue or green). We want the red-eye to respond to
light not angle like the white of the eye.
4. 1: Pos=1; R=1, G=0, B=0, A=1; Input: Energy;
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Figure 778

Now the bit you've all been waiting for – the iris!

86.2.4. Iris UV Map
Save your work and grab a cup of coﬀee for this part. It's a little involved.
We need the texture to stay glued to the mesh irrespective of the shape of the mesh. This
gives the eﬀect of the muscles in the iris expanding and contracting. In a nutshell, we're
going to UV map a procedural texture to a single part of the mesh.
OK, here we go. Switch material.004. You'll need to be able to see both 3D view and
UV/Image editor. This can be achieved by splitting windows, if you don't know anymore
how to do this read the ”Blender Windowing System” module again. Noob note: If you
rendered the image of the eye you will see the rendered image, we want an empty grid. So
click the ”X” in the Datablock (Image) choose-section in the UV/Image editor Header.
Figure 779
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Figure 780

Make sure the window is displaying a front view (Keypad-1) this will be important when
we unwrap the bit we're going to use.
Change the 3D view to edit mode en Face select mode.
1. Hide the outside (cornea) as done before.
2. Go to Material.004 and click on ”Select” right of ”Assign”, this will select the to the
material assigned faces. We will unwrap the faces to place our texture.
• You can use these properties for the iris material:
1. Diﬀuse: black but with an intensity of 1
2. Specular: Intensity: 0
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Figure 781

Figure 782
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1. Now search in the tool shelf for the Shading/UV's tab, you will ﬁnd there the ”Unwrap”
button under ”UVs”.
2. Click it and select ”Unwrap”. The unwrap tool, is a tool which you can position a
texture. You can allocate the places in the texture to the mesh by positioning the
unwrapped faces in a grid. The texture can be an image or another texture and will
be used at the places, that are described in the unwrapped image in the ”UV/Image
editor”
3. Zoom in 'till it's placed exactly to the outer edge the ”UV/image editor” window.

Figure 783

1. The image window should now contain a nice even circle of dots. If they aren't
selected anymore, put the cursor in the ”UV/Image editor” and press “A” to select all
the points. Now select each ring in turn using Alt-Shift, starting from the innermost,
and scale them until they cover from the centre to the outside of the image grid as
shown. (This won't aﬀect the mesh)

Figure 784
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Now we've got a map, lets get a texture. In the 3D view ”Tab” to object mode for the next
part. If the UV/Image editor is in your way you can merge the two windows. If you don't
know anymore how to do this read the ”Blender Windowing System” module again.

86.2.5. Iris Texture
Firstly, a texture to control the colour blend across the iris. Generally it starts on the outer
edge dark and gets lighter as it moves to the centre. Sounds like a job for the blend texture.
1. Create a new texture for Material.004 at the Texture Properties in the Properties
Header. It will be called ”Texture.001”.
2. Change Type to Blend.
3. create a second texture with type: Clouds
The texture itself is fairly straight forward, but again, the colour band is where the magic
happens.
There are two stops in the colour band. Note the alpha values. This blend texture is meant
to tint the iris texture so it's lighter in the centre and darker in the outside.
We make a Blend texture and a clouds texture (yes clouds)
Now for that iris texture:
Blend texture:
The blend texture is applied to the UV map input. The green colour is used as a lighten
mix to tint the iris near the centre.
1.
2.
3.
4.
5.

Select Ramp,
(Blue) 0: pos: 0, play with the color settings and set alpha to 1
(Green) 1: pos: 0.009, play with the color settings and set alpha to 0.89
set progression to Spherical
Set mapping to Coordinates: UV, Projection: Flat
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Figure 785
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Figure 786

Now you've got color
Clouds texture:
The colour band points are black with alpha 0 and white with alpha 1.
1.
2.
3.
4.
5.

0: pos: 0, black with alpha: 0
1: pos: 0.737, black with alpha: 1
Under Clouds: Grayscale, Noise: Hard
size: 0.4, depth: 2
here is (together with the UV mapping) the magic of the lines: Mapping Coordinates:
UV, Projection: Flat
6. Important: Size X: 0.01, Y: 5
7. Under inﬂuence - Geometry - Normal: 1
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Figure 787

860

Pupil Dilation

Figure 788

This texture is applied to UV again and. This makes some small shadows in the iris when
the light is from the side. Add some lights and have a look at your eyeball so far.

86.3. Pupil Dilation
We're going to use shape keys to create the pupil eﬀects.
We're going to create a normal eye and a cat's eye. Fortunately, the fully dilated eye is the
same in both cases so that's going to be our shape key basis.
Noob Note: note that you can only set a ”Shape key” in object mode.
1. Go to Object Mode and go to the ”Shape Keys” properties in the ”Object data” (The
triangle one) context in the ”properties” header.
2. Click “Add Shape Key” to create the ”basis”.
3. Make 3 extra Shape keys. (Don't make a shape key after editing, because you will
change the previous keyframe and that is not the intention)
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Figure 789

1. Go to ”edit mode” and click on Shape Key 1.
2. Use circle select, Alt+Shift of de Select button in Material to select just the ﬁrst 2
loops en the tip (pupil) in vertex select mode.
3. Now scale this to the next loop, select the latter and scale to just before the edge of
the iris (This gives a very wide pupil). It has to be as wide as possible because you
can adjust how wide you want it in the shape key section. It is just a maximum so
you can simply make an animation.
4. Change the name to “Wide Pupil Contract”
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Figure 790

1. Just because you may also need it make a very little pupil (with shape key 2). Call it
(Little Pupil).

863

Procedural Eyeball

Figure 791

Use the value slider in ”Object mode”, also set Viewport shading to Rendered (so you can
see how it will be when rendered), To increase the shape of the pupil with ”Wide pupil
Contract” and make it smaller with ”Little pupil” you can use them at the same time also
(and much more if preferred).
Now switch back to object mode and try the shape key sliders out. Pretty neat huh?
1. Let's make a cat's eye now. Change the name of Shape Key 3 to -”Cat Pupil”.
2. Use the same method as before to scale the edge loops. As you scale, restrict your
scaling to the X axis (That is “S” then “X”). You should end up with a shape key tiny
but medium long.
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Figure 792

That's pretty much it. Try some other things to practise with this.
Set the Camera and lightning.
Note: Due to the settings you've done in the material of the white of the eye, you have to
position the camera in front of the eye. Because the white of the eye that overrules the
vein-texture is a white spot in the middle of the camera and that has to be placed in the
middle of the eye around the iris.
Don't forget to save – and enjoy!
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Figure 793
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87. Putting It All Together: A Dragon!
i Information
Applicable Blender version: 2.69
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88. Putting it all Together: A Dragon!
I downloaded Blender without knowing much about how to use it, probably like you. I
hunted around for a good tutorial and found this one. It is teaching me wonderful things! I
have diligently followed every lesson from the beginning, as I hope you have. Every lesson
seems to contain some valuable technique. So now it is time to put it all together into a
single project.
Hopefully, you now know
• How to add objects, move and rotate them, scale them in various dimensions, and change
their shape.
• How to use proportional editing to change them even more.
• How to parent, join and separate objects.
• How to use materials and textures.
• How to use images in materials.
• How to use basic lights.
• How to use modiﬁers including subsurf and array.
• Basic use of curves
• It will help if you know how to use a photo editor such as GIMP to produce seamless
textures
This project will build on all that background. Since all those things have been covered
before, this will not be a key-by-key tutorial but rather a description of the general steps
to take to make the ﬁnished scene.
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88.1. Modeling from the Image

Figure 794

Komodo Dragon

Figure 795

Using cubes to model the dragon
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Figure 796

The basic body smoothed.

It happens that the Komodo Dragon is one of my favorite creatures. Let us start with that
and let our imagination run wild. In the lesson on Modeling a Fox from Guide Images1
we learned how to make a beautiful 3 dimensional wolf from an image. (Yes, I know. The
fox turned into a wolf. If you did that lesson you understand.) Here is a nice picture of
a Komodo Dragon by wallygrom from Creative Commons2 with a proper license. We can
then set that picture as a background image and apply the technique of starting with a
cube and scaling it, extruding it, scaling again and so on. We only have one view, so our
imagination and application of other pictures has to help with the top and end views, and
we have to add a nice long tail. As you build your cubes keep in mind that you will have
to create faces and extrude the legs so place a well sized face at the proper spot.
We will use the techniques we learned to split faces and add the legs. Be sure to provide
a nice mouth to put teeth in later, and pay particular attention to modeling the claws. I
modeled one entire foot and then duplicated it three times to have them all, and joined
each one to the body at the appropriate spot.
Once you have outlined the dragon with the cubes, remember what we learned in Smoothing Your Simple Person3 and apply subsurf modiﬁer and smooth the entire thing. You
can then push and pull on vertices to help make it look as good as possible. I wanted to try
to maintain the look of an ordinary creature and stay close to my Komodo Dragon, rather
than a huge ﬁerce beast to take on St. George.

88.2. Setting the Body Materials and Textures
Use what we learned in Image Textures4 to give the dragon his scales. The most used
technique in this tutorial is:

1
2
3
4

Chapter 75 on page 707
https://commons.wikimedia.org/wiki/Main_Page
Chapter 29 on page 247
Chapter 38 on page 313
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• Search Flicker Creative Commons5 for a properly licensed picture that has a good material
in it. If you use Google or some other search, be sure that the picture you get is properly
licensed if you plan to share the image.
• If your image is NOT a single seamless texture, use photo editing software (such as GIMP)
to produce a usable seamless ﬁle.
• Load the image into GIMP. Crop it to a reasonable size showing a relatively uniform
texture.
• Choose Filters > Map > Make Seamless. Other photo editors will usually have a
similar operation.
• Save the image with a suitable ﬁle name.
• Add a material and a texture using the image. Adjust the settings as needed to look
good.
• If you are following my steps, I have put all the textures in this article for you to copy
if you wish. Click on the thumbnail image and go to the Wiki page from which you can
download.

Figure 797

Fantasy Dragon Skin seamless texture

You can just select a rectangular swatch of skin from the picture and use GIMP to make
it seamless. But Komodo Dragons are a depressing color. For a fantasy creature we need
a brighter skin! So you can play with GIMP Colorizer until you have a suitably colored
swatch. I used red and gold, but use your imagination! This becomes the ﬁrst material and
texture for the dragon's body. It will probably be necessary to repeat the image several
times in both the X and Y directions. I used X:6 and Y:2 in this particular case.

5
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http://www.flickr.com/creativecommons/by-sa-2.0/
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88.3. Adding the Eyes

Figure 798

The ﬁrst rendering.

The dragon needs suitably scary eyes. Hopefully you have already modeled eyes for the
Procedural Eyeball6 tutorial. I chose the cat's eye. In Some Assembly Required7 we
learned how to append a ﬁle. Append the Cat's Eye, and then work on the color textures
until you have a suitably scary dragon eye. Then duplicate it and put one eye on each side
of the dragon's head. I joined the eyes to the body, but you can also just parent them if
you are careful. You will notice in later renderings that I kept playing with the eye color
and position.

88.4. A Dragon Needs Teeth and Claws

Figure 799

6
7

Assigning texture to the claws

Chapter 86 on page 831
Chapter 60 on page 527
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Figure 800 Four
rows of Teeth
Using the technique from Multiple Materials per Object8 , isolate the claws and give
them a nice shiny black material. Too much Specularity will make the claws look like
plastic, too little will make them dull and uninteresting. I added just a little bit of Mirror
also. It will be something to experiment with until you get the look you like. Click on the
picture to enlarge it and see the setting I settled on. Remember that you have to select the
area of the mesh and ASSIGN it to the material or you will wind up with a dragon that is
black all over! (That is the voice of sad experience speaking).
A dragon needs teeth. A lot of teeth! Modeling all those teeth would be a big job. Fortunately we learned how to use array modiﬁers in Building a House9 . Add a cone, scale it
down very small, and extrude some more parts so you can shape it into a nice curve. When
you have a beautifully sharp tooth, add the Array modiﬁer and make it into a whole row of
sharp teeth. Then duplicate the whole thing three times, rotate it around as needed, and
you will have four rows of teeth, enough for both jaws. This is why we left the mouth open
when we made the original model.

8
9
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Chapter 35 on page 293
Chapter 63 on page 565
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88.5. Horns, a Crest, and Nostrils

Figure 801

Using the Curve Modiﬁer

Figure 802
horns

The color settings for the
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Figure 803

Nostrils

Lets give the beast some horns. Here we can use what we learned in Deforming Meshes
using the Curve Modiﬁer10 to make some gracefully curved horns. Just as in that lesson,
add a cone and extrude segments to give a lot of vertices. Then create your Bezier Curve
and set it as a modiﬁer to the horn mesh. Properly done your horn will mold itself to the
shape of the curve. Duplicate it and rotate it to ﬁt the other side of the head and put them
in place.
Animal horns are some of the most beautiful structures in nature. We should make a particularly pretty material for them. We can use the blending colorband as in the tutorial Basic
Carpet Texture11 , updating it a bit for 2.69, to give the horns a nice color appearance.
Then add Subsurface Scattering12 as taught in that tutorial, with a lot of experimenting,
until you get a really beautiful appearance. The settings I used are in the picture but it is
fun to try diﬀerent things.
An impressive crest should dominate the dragon's back. I found a picture of a basilisk lizard
and used it as a background model for the crest. The Crest texture was produced in GIMP
exactly the same way as the dragon skin texture.
Reptile nostrils are sort of nondescript, so lets make some nice nostrils like a snorting bull
might have. You can use the technique from Spin a goblet13 to model one nostril, then
duplicate it, rotate the pair until they look ﬁerce, and give them a nice color like the dark
red brown I picked. Then put them in place and parent them to the body.
Now you can render your dragon and see the basic body shape, but something is missing.
What is it?

10
11
12
13
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Chapter 71 on page 671
Chapter 83 on page 805
Chapter 77 on page 749
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FSpin%20a%20goblet

Giving the Dragon Wings

Figure 804

Teeth, Claws, Crest and Horns

88.6. Giving the Dragon Wings

Figure 805

An attempt at wings.

The wings were the hardest part, because we have not had many tutorials in this series that
dealt with the problems involved. I started with a cylinder object and went from there,
joining other cylinders to it, and then selecting edges and using F to create faces. There
may be other better ways to do it. I wanted the wing sail parts to be semi transparent and
give an appearance of shimmering colors. Experimenting with the transparency and the
materials as seen in the screenshot gave me some I liked pretty well. I am not completely
satisﬁed with it but perhaps it is the best that can be done with the tools we have so
far learned. Joining the wings to the body seemed to produce some distortions so I just
parented both of them to the body object.
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Now there is just one more thing that a perfect dragon needs.

88.7. FIRE!

Figure 806

Settings for ﬂames

Figure 807

Seamless ﬂame material
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Figure 808 Scaling
the cylinders

Figure 809
Distorting the
cylinders

Everybody knows that dragons breathe ﬁre. It seems that there are many diﬀerent ways
to do ﬂames in Blender. However, I am attempting to use methods covered so far in this
tutorial series, so I wanted to experiment and see what could be done with just what we have
learned. I came up with something reasonably close to ﬂame breath using basic techniques.
I started with a series of cylinder objects, scaled at one end until they are almost cones, and
then stacking them inside each other. I used the proportional editing that we learned about
in Mountains Out Of Molehills14 to pull and stretch into some more or less random
shapes. I found the ﬂame picture and turned it into a seamless material swatch. Then
I wrapped it around my cones and began playing with the settings for transparency, and
added an Emit setting just to see how it looked. (If you want to jump ahead refer to Making
Fire15 in the next section of this series.)

14
15

Chapter 45 on page 363
Chapter 113 on page 1065
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88.8. Ground to Stand on

Figure 810

seamless lava texture

Figure 811

seamless grass texture

Now it is time to complete the scene by giving him something to stand on. Since his front
feet are raised, put in a sort of lava ﬂow for him. That seems appropriate for a dragon.
Try Adding a series of cubes. Stack them up and pull them out of shape with proportional
editing. Add a subsurf modiﬁer, and then the set the lava rock as an image texture. Again
I made a seamless material out of a photo.
Then create a plane and again use the proportional editor to make some nice hills. A
seamless green grass texture repeated multiple times completed the ground.
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88.9. Lighting

Figure 812 The No
Shadow setting

So far the lighting has just been the default point light. I think it is a bit more dramatic to use the Sun style of lamp. As we learned in Light a Silver Goblet16 go to
Add>Lamp>Sun and place a sun type lamp rather high in the sky. You will notice that
now you get two overlapping shadows, one from the Sun and one from the default point
lamp. You could just delete the point lamp, but, to advance beyond what has already been
covered, it is useful as ﬁll lighting. You can select the point lamp, go to the properties panel
and click on the light icon

16

Chapter 53 on page 459
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Figure 813

. Scroll down to Shadow and click No Shadow and the point light becomes a ﬁll light.
Setting the horizon color in the world panel
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Lighting

Figure 814

is the last step to produce this scene.

883

89. THE FINAL RESULT

Figure 815

The Final Result

I think it nicely combines pretty much all I have learned about Blender so far in the tutorial!
If you want to try your hand at a project, it is not as hard as you might think. You and I
have really learned a lot by going through the ﬁrst two sections of Blender 3D:Noob to
Pro. I thank all the authors who have worked hard to bring us to this point.
I challenge you to show oﬀ what you can do with your newly acquired knowledge and put
your ﬁnished work up here. It will probably be a lot better than mine.
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90. Noob Project No.02 - Space Dragon
in Space
First oﬀ, thanks for creating this page! What a wonderful idea to include all the good
readers in a ﬁnal project! This is what openness is all about, and this wiki platform is the
perfect place to be doing it. Also, huge thanks to whoever originally wrote this tutorial.
Whoever you are, nameless stranger, you're doing excellent work.

Figure 816

A Quick Sketch

Moving on, I knew I wanted my dragon to live in space and shoot lasers, so the ﬁrst thing I
did was sketch him out so I had some sort of plan before beginning the tedious busy-work.
I think this is technically called a ”wyvern.” Anyway, with this general idea in mind, I began
extruding a cube to bound out the basic shape, keeping in mind how it's internal skeleton
would look and behave (if dragons were real of course) The wing hand and knuckle bits
were kind of tricky. For those, I extruded a long rectangle for the arm, and added a few
loop-cuts at the end, which i extruded into ﬁngers. Tricky and ﬁnicky.
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Figure 817

He looks like a chestburster with wings.

There's probably a better way to do this. While editing, I recommend using a mirror
modiﬁer, but be careful of vertices on the negative side of your mirror. Best thing to do
would be cut your model in half along its axis of symmetry and then apply the mirror.
Otherwise, vertices can show up on the positive side where you don't notice them until
you're almost done modeling. Have fun cleaning that up... I did. Select > Select All by
Trait > helps a lot with this, and as always, remember to remove doubles every now and
then! After several hours, here's the basic, blocky model of a wyvern I made.
Next I made some teeth. Cone with 3 verts > Curve modiﬁer > Array x 37

Figure 818

What a pretty smile!

Now, those teeth look a little small, and I suppose 37 rows of teeth is a little much for
anyone, even if their mouth is 4.76 meters long. Next time, I'll probably give him less teeth,
and just make them all a little bigger.
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Lighting
I wanted to make a U/V map and draw some real nice textures on this thing, but we hadn't
gotten there in the tutorial yet, and I ﬁgured I'd follow the precedent. Besides, I don't
properly know how to do one anyway. So I opened up the GIMP and drew some neat
looking scale textures. Actually, ﬁrst, I looked up scales on wikipedia (and learned that
scales grow from the epidermis and are weaker than scutes, which grow from the deeper
dermis, and so are more durable, among other diﬀerences. It's cool stuﬀ, for sure.) So I
pulled up some images of scutes from the internet, and I got to work. I made my textures
super low resolution (32x32 I think) cause I wanted that retro/late-90s rendering look.
Haven't you heard? It's all the rage these days! It also helps with rendering times on my
craptop computer. Just check out this YouTube playlist1 I was listening to while I made it.

Figure 819

Now with textures and materials! ...and 90% less sugar

Of course that strange position he's in looks uncomfortable, not to mention it would probably make for a unexciting rendering. So I gave him some bones for him to orient into a
more natural position with. The toughest thing about making an armature has got to be
symmetry. At its very best, it's tedious. At its worst, it's torture. I know there's a way
to edit armatures with a mirror modiﬁer in blender, but I couldn't ﬁnd it, and anyway, I
ﬁnished up alright. A thing to note: If you've gotten pretty far along and you ﬁnd you
need to delete a bone in the middle of your armature, you can rejoin the ends by selecting
them and hitting Ctrl + P > Connected To keep your armature in the same position,
reposition the ends with cursor to selected then selected to cursor.

1

https://www.youtube.com/playlist?list=PLtRmcNFoYX4ZtPC33StBR-vjnsqi1h8aK
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Figure 820

Now he's got some bones on that meat!

Next, I wanted him to shoot lasers out of his mouth instead of ﬁre, cause ya know... He's
in space. So I opened up the GIMP again and made a texture to wrap around a tube that
would be the beam.

Figure 821

That didn't come out right...

Lots of lightning and sparks everywhere... It was cool. The beam itself was a tube with a
blue material on it -- full emit, can't recieve shadows, slightly transparent, and full translucency. I slapped my texture on and put the tube in the beast's mouth. I duplicated that
tube with Alt + D and shrunk it a little on its local !Z axis (Shift + D) so it would shine
through. Inside the dragon's mouth and down the length of the tube i stuck a few point
lights with the energy turned up to 11.
Actually it only goes to 10. Maybe those guys at blender should ﬁx that.
To get the beautiful starﬁeld you see in the background I went into the GIMP, ﬁlters >
noise > hurl (what a great name for this thing btw), and desaturated the picture with
colors > desaturate. Yep. Simple as that. There's probably something you can do right
from Blender with procedural textures, but either way, sky texture! getting it to show up
in the view took me some searching. I didn't remember how we'd done it from earlier in
the tutorial. Anyway that sort of repetition helps the memory.
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Figure 822

AAAAAAHHHHH!!

AAAAAAAAAAHHHH!!!
90.0.1. Add your project below this line
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Unit 3: Broadening Horizons
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91. The UV/Image Editor
i Information
Applicable Blender version: 2.68
Blender’s UV/Image Editor window serves a number of related purposes:
• It is a place to view rendered images, and save them to ﬁles.
• It is a place to view and edit images being used as textures.
• It is a place to perform UV mapping of meshes to texture images.
In the window header, you will see “View” and “Image” menus, followed by a menu for
choosing which image to view. The rest of the window header varies depending on your
choice from this last menu.

91.1. Viewing Render Results

Figure 823

Here is what the variable part of the window header looks like when you choose the special
“Render Result” entry in the image-selection menu. The next menu, showing the word
“View”, serves no useful purpose in this case (it is only applicable to editable images, not
the render result). Next to that is a Slot menu, allowing you to select from any of 8 numbered
slots. Each slot can hold a separate Render Result image. This is handy for trying out
diﬀerent render settings (e.g. quality etc), and quickly ﬂip between them for comparison.
You can also use the keyboard shortcuts 1KEY .. 8KEY to switch slots. When you
perform a render, the generated image is put into the slot you are currently viewing in the
UV/Image Editor.
The next two menus, showing “RenderLayer” and “Combined” in the above screenshot, allow
you to view diﬀerent render layers and render passes, if you have more than one of these
conﬁgured in the render settings, as well as the ﬁnal compositor result.
The rightmost group of four icons make a further breakdown of the image into RGB channels
with/without alpha transparency layer, alpha on its own, and Z (depth) buﬀer on its own.
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The UV/Image Editor
Alpha transparency only matters if you are rendering a transparent background in place of
the sky, as discussed later1 .
Note:
What you see is what you save. When saving an image to a ﬁle, the saved image will
correspond—choice of slot, layer and pass—to what you are currently viewing on-screen.

91.2. Viewing/Editing Texture Images

Figure 824

Here is what the variable part of the window header looks like when you select some other
image, or create a new one. Now the editing-context menu

1
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Chapter 111 on page 1045

UV Mapping

Figure 825

becomes useful: selecting the “Paint” item lets you paint on the image.
Note the rightmost group of icons in the header has shrunk slightly: there is no more
Z-buﬀer option, though the alpha-related options still exist.

91.3. UV Mapping

Figure 826
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The UV/Image Editor
Here is what the variable part of the window header looks like when you select a texture
image, and go into Edit mode on a mesh in the 3D View window.
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92. UV Map Basics
i Information
Applicable Blender version: 2.75
UV mapping is a technique used to ”wrap” a 2D image texture onto a 3D mesh. ”U” and
”V” are the names of the axes of a plane, since ”X”, ”Y” and ”Z” are used for the coordinates
in the 3D space. For example: increasing your ”V” on a sphere might move you along a
latitude line (north or south), while increasing your ”U” might move you along a line of
longitude (east or west).
Another explanation can be gleaned from the Blender manual. Imagine a paper 3D model
of an object, e.g. a sphere, that is to be laid ﬂat on a table. Each of the 3D coordinates of
the sphere can be mapped to the 2D coordinate on the ﬂat piece of paper. Blender provides
another view of the vertices (coordinates) in the UV/Image Editor. You can select and edit
these 2D vertices just like in the 3D Editor window. The purpose of this unwrapping of the
coordinates is just to map these coordinates to images/pictures so that the 3D image can
have a realistic looking surface with textures derived from these images.

92.1. The Basics of UV Mapping
Add a sphere
We'll
use
tial cube (

a
A

sphere
).

for
this
demonstration.
Then,
create a new

Delete
model,
a

the
inisphere (

CMUNBX.TTF[PATH=/USR/SHARE/FONTS/TRUETYPE/CMU/,UPRIGHTFONT=CMUNRM,BOLDFONT=CMUNBX,ITALICFO

+ CMUNBX.TTF[PATH=/USR/SHARE/FONTS/TRUETYPE/CMU/,UPRIGHTFONT=CMUNRM,BOLDFONT=CMUNBX,ITALIC
→ Add → Mesh → UV Sphere). Leave the settings at default for now.
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Figure 827

Mark a UV seam
In edit mode, select a ring of vertices around the widest part of the sphere (the equator, if
you will). This can be done easily by holding down SHIFT + ALT and right-clicking on
the 'equator'.
Press CTRL + E and select Mark Seam, or select Mesh → Edges → Mark Seam. This
tells the UV unwrapper to cut the mesh along these edges.
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Figure 828

Unwrap the mesh
Next, create a window for the UV mapping: click and drag left the small lined area in the
top right corner of the 3D window, a new window will be created. Set its window type to
”UV/Image Editor” with the drop down box at the bottom left corner of the new window
or with SHIFT + F10 .
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Figure 829

In the 3D View window, select all your vertices by pressing A , and press U → Unwrap.
In the UV/Image editor you should see all the vertices/faces/edges of the model represented,
or 'mapped', in 2D space.
If you don't see anything, you need to select UV Editing from the Screen Layout dropdown
in the UV/Image editor window.

Figure 830
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Apply an image
Now we're going to actually use this UV map. Save the following image (click to view in
full high resolution (4,096 × 2,048 pixels)):

Figure 831

Load it in the UV/Image Editor window by clicking Image → Open Image or by pressing
ALT+O . Then with the grab, rotate and scale tools, adjust the UV islands (the UV groups
that aren't connected to each other) so that it ﬁts nicely on top of the image as shown. To
select a UV island, hover the mouse over the island and press a vertex and L .
Note: Since the aspect ratio of the image will warp the UV's, it may be easier to simply
re-unwrap the mesh exactly the same way you did before. You can then adjust the UV's as
needed.
If you have issues ﬁtting to the image use X and Y letters after pressing S. This will adjust
the shape to ﬁt the image.
[S]cale, [R]otate, [G]rab, [B]order selection, [A] Select/Deselect all
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Figure 832

Admire your new creation
Back in the 3D View window, go into Object mode. The next drop-down menu to the
right of the mode menu is the Viewport Shading (Draw Type) menu; use it to set the
Viewport Shading to Texture. Note that parts of the model will be shadowed and other
parts illuminated based on the location of the lights in your scene. Try adding more lights
and moving them around so you see the model more clearly, and try to use this lighting
preview to 'Rough' your lights. (you can add more lights Shift-A-Lamp and right click lamp
to move to where light is needed)
To make the texture visible in renderings, you also need to add the texture to the sphere as
a new material. In the Properties window, switch to the Material context by clicking the
small shaded-sphere button. Create a new material by pressing the New button, leave the
settings as they are for now; then switch to the Texture context. Create a new texture and
select the type to be 'Image or Movie'. Select the globe texture from the dropdown menu.
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Figure 833

Then go to the mapping menu and set the Coordinates to 'UV' and the 'Map' to 'UVMap',
leave the projection at 'Flat'. This will make use of the UV's we unwrapped earlier. To
make the globe a bit smoother, switch to the Modiﬁer context in the Properties window
and add a subsurf modiﬁer; set the number of subdivisions to 2. Then press T , if you
had no Tool-shelf, in the 3D viewport and select 'Smooth' under the shading options. This
will make the globe far smoother and more realistic.
Now, simply press F12 to render your scene!
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Figure 834

Note that in the above render I've changed the lighting and the camera position to make
the image more interesting. I also added a star background, you can ﬁnd the settings for
this in the World context (a pretty relevant coincidence) in the Properties window and the
texture settings for the World.
Go to the World properties and check both Blend Sky and Real Sky, set all 3 colours
(Horizon, Zenith, Ambient) to black. Go to Texture settings and if you weren't already
there, click on the World texture settings (upper left globe icon) and set the type to
Voronoi. Scroll down to Colors panel and check Ramp and give Color Stop 0 a white
color and an alpha of 1 and Color Stop 1 a black color and alpha of 0. Now some will happen
magic: set Distance Metric to Minkowski 1/2, in Noise section set size to .002 and
set 2 of Feature Weights at around .5. Finally, in Inﬂuence panel, check Horizon, Zenith
Up and Zenith Down. That will do the trick. In some older versions there was a standard
option for this but it has ”disappeared”.
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Figure 835
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Figure 836

92.2. Alternative method
If you looked around the textured globe we just made, you would have noticed that around
the 'equator' there were lines, or 'seams', where the two UV islands met. This is a common
problem with UV mapping and there are a couple of ways to avoid it. In our case, since
we're using a sphere, the best way to remove the seams is to use spherical mapping.
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Alternative method
First download one of the textures from this link: http://earthobservatory.nasa.gov/
Features/BlueMarble/BlueMarble_2002.php. Then use this texture for your globe instead of the one we ﬁrst downloaded.
Go into edit mode, and select all the vertices of sphere. Press U → Sphere Projection.
If you've got the UV/Image editor open you should see a very diﬀerent UV map, as shown
below. Note that only the 'Unwrap' option will use the seams we just made, all of the other
options completely ignore it.
You can also try, especially handy when you use a more detailed map in the place of the
seam: First unwrap with cube projection and then with sphere projection. It's now a square
like UV.

Figure 837

Now lets make the UVs ﬁt more evenly over the texture. In the UV/Image editor, press
UVs → Constrain to Image Bounds. This will make sure that during editing none of the
UVs will go over the bounds of the texture; if they did, it would cause the texture to repeat
itself in the area of the UVs outside the bounds.
Now select all the UVs with A and scale them up till it is stopped by the image bounds.
In my case, there is one vertex in the top-right corner, and a few in the bottom-right corner
that are quite distant from the rest of the UVs; to ﬁx this, I simply selected those vertices
and moved them closer to the rest of the UVs.
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Figure 838

Now simply scale all the UVs by the X axis until the UVs stretch over all of the image.
Doing this is exactly the same as scaling in the 3D viewport, press S and X , then drag
the mouse.
Now rerender your model, and you will see that there are no seams! You can also use an
image with clouds. if you render this you will see seams. you can fake this away a bit by
making the diﬀuse at material sea-blue by using the color picker after rendering the ﬁrst
render (If it looks good it is good).

Figure 839
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93. Realistic Eyes In Blender
i Information
Applicable Blender version: 2.75
Note: Some pictures are outdated.

93.1. Overview
NOTE: this tutorial is incomplete!
This tutorial will teach you how to eﬀectively utilize textures and materials in Blender to
create realistic eyes for characters. This tutorial will not teach you how to ﬁnish the eye.
Because you did already learn that in previous tutorials. This tutorial was inspired by a
great Maya tutorial in the Gnomon Workshop series by Alex Alvarez. My goal with this
tutorial is to teach you how to get those same stunning results using Blender. Please check
out Alex' tutorial as well, as it is very informative and covers more detail than I will be
covering here. This tutorial assumes you know your way around the Blender interface and
so I will not explain each key command as I go, but will instruct you in what steps to
take and point out details such as key commands only when it seems relevant to do so.
In addition, you will need some sort of image manipulation software, as this tutorial relies
heavily on image-based textures, which we will be preparing outside of Blender. I will be
using GIMP, but feel free to use Photoshop or whatever you're comfortable with.
1. The 4 original Maya tutorials in video format http://www.thegnomonworkshop.com/
store/category/167/Free-Maya-Tutorials1 http://
OK, let's dig in...

93.2. Reference Material
Let's Take a moment to familiarize ourselves with the anatomy of the human eye. Do a
Google image search and examine whichever diagram is to your liking. Now, you don't
have to pay attention to every single feature, but do take note of the cornea, the iris, the
pupil, and the sclera. These are the only parts that are visible to us when we look at a
person's eyes, and therefore the only parts we will actually need to create. Many of the
diagrams you ﬁnd out there will be disproportionate, and so in order to know how large to
1

Chapter 1 on page 5
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make our features in relation to one another, it is best to view a large number of diagrams,
a large number of eye photos, and also photos of plastic models of the eye, as plastic models
tend to be truer to scale than 2D drawings. I also found a photo of a guy popping his eyes
half-way out of his head. All of these together gave me a good feel for what the appropriate
proportions are for a human eyeball. To some extent though, cornea size and sclera shape
will vary on a person-to-person basis, so there is no precisely correct size, per se.

93.3. Building The Eye
Creating a UV sphere. 24 segments, 24 rings, and a radius of 1 is recommended. The
top of the UV sphere will become the cornea of the eye. So now let's go into side
view, in the orthographic view, and with the topmost vertex selected and proportional
falloﬀ enabled, grab and raise this vertex along the Z axis. Don't click to ﬁnalize the
edit just yet - ﬁrst we will use the mouse wheel to control how much falloﬀ is going to be
applied. This process can require some ﬁnesse and multiple adjustments until the bump of
the cornea is anatomically correct. You will want to set the falloﬀ shape to ”sphere”. You
can also make 2 balls, like in the Pocedural eyeball tutorial, and let the iris bend inwards
of the inner ball.
If you like you can use a Torus for the iris, this is diﬃcult but fun to play with.
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Figure 840

Below is a render of the curve I ended up going with. You can use it as a guide when
modeling if it helps you. This is with a SubSurf of 3 applied, so keep that in mind.
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Figure 841

Now, some people may prefer to use a NURBS sphere for the geometry of their eyeball. If
you are comfortable with NURBS modeling, and texturing NURBS models, go right ahead.
It will give you a smoother and more rounded eyeball. I prefer not to complicate things
with NURBS when polys will do just ﬁne, and am guessing most of you feel the same, so
I'm sticking with polys. This does however bring us to the topic of the SubSurface modiﬁer
and how it will aﬀect your eyeball. When SubSurf is applied to a UV sphere such as our
own, it causes the previously spherical shape to become slightly oblong. In other words,
the eye will become nearsighted. This is barely noticeable, but it does happen, as a result
of the way SubSurﬁng aﬀects a UV sphere. You could create a UV sphere with more rings
to ease this if it bothers you. It looks ﬁne for our purposes though, to be honest. See the
comparison in the animated GIF below.
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Figure 842

There is one last issue to address with regard to using a polygon-based eyeball. That is
the small triangles that persist on the poles of the eyeball. These stubborn tris will remain
and you will ﬁnd that they result in an ugly and unnatural pinched eﬀect when a specular
highlight appears over the center of the cornea. Adding a SubSurface modiﬁer will not make
them go away. This didn't become apparent until after I did some texturing work and test
renders, but I want to point it out to you now, before we get into all that. (See examples
below)
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Figure 843

Figure 844

Now repeat this process at the opposite pole of the eye (the optic nerve area).
We are now ready to begin texturing the eyeball.

93.4. UV Mapping
In Edit Mode, we will deﬁne the seams for our eye. Select the edges you want to mark as
seams and type Ctrl E, then choose Mark Seam from the menu.
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Figure 845

With all of your mesh selected, type U to unwrap. We can now see our unwrapped UV
layout in the UV/Image Editor window. (For older versions of Blender, you might need
to select UV Face Select mode to unwrap, but it's better if you download the latest.)

Figure 846

We will make the iris on another mesh so don't spent time on the cornea UV island.
Those two islands we see are the cornea and optic nerve area. We can move them out of
our way by selecting any vertex on them and typing L to select all linked vertices. Then
G to grab as usual.
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Figure 847

Figure 848

Grab and move your straightened column of verts over to the left.
Constraining to the X axis, by typing the ”X” key after you grab, is a good habit to get
into while straightening these out.
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Figure 849

Straightening out all of these vertices into a usable grid shape will take you some time so
we won't do it that way. Having a rectangular grid will prove very helpful when we are
texturing our eyeball. so we will use an Add-on for blender. You'll want to use Blender's
grid as a reference and just align the rows and columns to it exactly. Yes, you can get it
exactly aligned, since there is a snap-to-pixels feature, Click on snap-to-pixels in the drop-up
menu in the uv/image editor header. (Don't move the 2 circles when snap to pixels is on
cause that will ruin them.) You can scale the whole thing up later, once each row and column is evenly spaced. If you can, leave some space between your UV layout and the border
of the layout area, if you ”bleed” it to the edge, you may have texturing problems later. But
you can scale it down later, so no problem. we will download the UV Tool from Daniel Banasik. A wonderfull free tool which can smooth an align the vertex loops to a beautiful grid
with a little eﬀort. The old method was aligning every single vertex 1 by 1 :(. Page of the
tool
http://blenderaddonlist.blogspot.nl/2013/11/addon-smooth-selected-uv.
html?showComment=1442661338961#c20786997949345135332 http://
Installing an Addon is very simple. If you've like me not installed blender but use a standalone version it's done in no time. All you have to do is put a folder or ﬁle in a folder
blender is reading for add-ons.
Just download it and Unpack it. What you've unpacked is, most of the time, precisely what
you have to put in the add-on folder. In the blender standalone version folder (if you don't
use a standalone version of blender, it's Operating system speciﬁc how to place an Add-on.):
go to the folder with the name of the Version Number (at my version it is 2.75)-> scripts
-> add-ons. then put it here. Save your work and quit blender. Then restart blender and
open your work. Go to User Preferences under File in the blender program header (the
uppermost) and go to addons. Go completely down and open the details of: UV: uv_tool.
Then click the checkbox: most right and you're able to use it.

2
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Noob Note: Don't forget to save the user preferences.

Figure 850

If you, like me, love Disney-Pixar Movies you can recently download an Uncommercial
(you're not allowed to earn money with it) free version of Renderman, the program Disney
Pixar uses to render their movies. You can install it and use a third-party add-on (PR-man)
to implement it in blender. But that will come in later tutorials.
How to use:
select the loop on the right side and click on align, do the same for the left. You can't do
more than 1 loop at a time otherwise you'll go out of Edit Mode in the 3D View. Then go
to 3D view put back in Edit Mode and go back to UV/Image Editor. You'll Also notice
nothing has aligned. so do them loop for loop. Just select the loop and click on Align. It
will be automatically placed correctly. Just move on till they're all done.
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Figure 851

Figure 852
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It's important to pay attention to which way the UV layout is facing. Chances are the top
of the sclera region is actually what you will want to be the bottom. It doesn't technically
matter which way it's facing, but you will probably want it to look intuitive when you are
painting the textures.
You can check this by going to the 3D view (or having split windows so you can see the 3D
and UV views at the same time) and making sure everything is selected, then deselect 1
vertex close to the optic nerve or the cornea. Back in the UV/image editor the vertex will
disappear all connected edges and maybe more from your UV map, so you can work out
how the map corresponds to the actual mesh surface.
Once you're done, save your .blend ﬁle and then save your UV Face Layout. This is
done in the UV's: Export UV Layout.

93.5. Preparing A Template For Texturing
Now launch your image editor and open the UV face layout you just saved. (You probably
saved it as a .png ﬁle, since that is Blender's default format for UV layouts) So we are now
looking at a UV grid with the square and the 2 islands.
Open gimp and rescale the image to 4092 by 4092.
One other element that will be useful to have in our template is a layer of markers that
denote where the equator of the eye is, because what looks like the middle on the UV layout
is not actually the middle. To ﬁnd the middle, go back into Blender and count the rings
of your eye mesh, starting at the seam of the cornea. Once you get to the equator, take
note of how many rings it took to get there. Go back to your image editor and mark that
area. You can mark it with a guide, or mark it with a coloring of some sort - as long as it's
clear to you that it indicates the equator of the eye mesh. It may also be useful to mark
the point where the transparency of the cornea should begin.

Figure 853
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Now we will make the texture. To begin make the inside of UV square and islands white,
a neutral colour.
Do this by selecting (round or square) the UV island or square and then clicking 2 times on
the bucket and set the Aﬀected area to Fill whole selection then switch the black and the
white colour by clicking on the arrows in the toolbox (If you've no toolbox click on tools in
the program header and click: new toolbox) and click with the bucket on the selected area
and do this for every part of the eye.
an eye is reddish at the back so make the back point directly reddish, I use FB2F05.
Select the back point so you can ﬁll it with this beautiful colour.
Select the square so you cannot ”Spill” over the corners. We will paint the back with the
same colour of the back point 'till over the middle of the eye. click the airbrush tool and
increase the value of the size and also the ﬂow if its a very transparent at the end it has to
be very transparent.
Noob Note: make the selection a little bit bigger then the square or the UV island to prevent
seams.
Search for a nice iris texture:
1. Google:
iris
texture
https://www.google.nl/search?q=eye+texture&
client=ubuntu&hs=Nf0&channel=fs&source=lnms&tbm=isch&sa=X&ved=0CAcQ_
AUoAWoVChMInOGCgKmDyAIVBw8aCh1gdQ4_&biw=1215&bih=897#channel=fs&tbm=
isch&q=iris+texture3 https://
Make sure you have around 1024 by 1024 pixels.
Open with gimp and crop it out by pressing image -> Crop to selection save it as .png and
use it later. If it's a little bit to small, don't worry you won't render it that big.
If you like you can make blood vessels in the cornea with the pencil tool and the colour
FF0000. Make sure you shrink the to about 10. Only don't try to copy my vessels cause
they are to bad.

3
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Figure 854

You can design your own texture to apply.
Save your texture as .png.

93.6. Bump Map - The Sclera
If you want to use a bump map in your eye.
Create a material for your eyeball. Then within that material create a texture. Name
this texture something like ”BumpMap(Procedural)”. Set the texture type to clouds. A
noise size of 0.25 with a noise depth of 2 or 3 is ﬁne, and you can experiment with other
values if you like. The other texture settings can be left at their defaults.
Now we are going to bake this procedural texture to get an image-based UV texture that
we can edit in our paint program. Why? Because there is not an even level of bumpiness
around the eyeball. The sclera has bumps, while the cornea doesn't. If your cornea was
bumpy, your vision would be distorted. We want our 3D eyeball to accurately convey this
subtle diﬀerence when light is reﬂected from the surface.

924

Bump Map - The Sclera
Before baking the texture, there are some parameters we must specify. In the materials
panel click the Map To tab. The Color button is depressed by default, so you can leave it
as is. Make sure this is the only depressed button. Then change the color to black.

Figure 855

Now go to the Material properties. Change the diﬀuse color to white and click the
Shadeless checkbox.
Note: In this particular case it doesn't actually matter which of these colors is set to white
and which is set to black. The end result is basically the same, and you can always invert
the image later.
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Figure 856

Check the Material Preview window to make sure it looks right.
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Figure 857

Time to bake your eye. Make sure your eyeball object is selected and go into UV Face
Select Mode. Then split your screen and set one viewport to the UV/Image Editor.
From the menu at the bottom of the UV/Image Editor, choose Image > New. Enter a
name like ”ScleraBumpBake” and set both the Width and Height to 2048 (to match your
UV guide). Click ”OK” and a new all-black image will appear behind the UV grid.
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Figure 858

Go to 3D view then in the render properties to Bake and clickTextures at
the Bake-mode drop down menu .
Then set the margin to10 and click
theBAKE button. You will see the black image in theUV/Image Editor ﬁll in
with your bump texture. From the menu chooseImage > Save As Image.

Figure 859

Now save your .blend ﬁle. You are able to make the rest of the eye yourself and if you
forgot, read to previous tutorials.
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94. Beginning Lighting
Lighting, you say? Psshh. Just throw up one light source and let her run, right?
Lighting is probably the most underestimated part of a scene by new 3D artists. Unlike real
life, it’s actually quite easy to produce a uniformly well-lit, shadowless scene in Blender.
But such scenes are usually pretty dull and boring.
Far more interesting are ones with highlights drawing attention to some areas, and shadows
in other areas, leading the viewer to wonder what they might conceal. If a picture tells a
story, and a picture is worth a thousand words, then lighting is like the punctuation for
those words, the pauses between sentences and the sudden dramatic changes of tone.
Extremely uniform lighting can even give the picture a “photoshopped” look, as though the
artist took part of one picture and stuck it on top of another. Whereas even a little bit of
shadowing of one object by another can reinforce the impression that they are very much
three-dimensional objects with a deﬁnite spatial relationship to each other, located in the
same scene.
The following tutorials will help you gain knowledge of the technical use of lights in your
scenes.
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95. Understanding Real Lights
In order to learn how to light a scene properly it is helpful to ﬁrst learn a few things
about real lights. When you add a light to your scene you need to understand how to go
about emulating the properties of the real light source that you want your Blender light to
replicate.

95.1. The Properties of Real Lights
95.1.1. Color
Every light source always has a distinctive color of its own. A photograph taken at sunrise
or sunset is very easy to distinguish from one that is taken at noon just by looking at the
color of the light. Incandescent light bulbs emit a light of a color that is diﬀerent from that
of ﬂuorescent light bulb. So a scene lit with one of the two will have a diﬀerent color cast
when compared to the other.

95.1.2. Angle
Light always streams in from a particular direction. The angle or direction of light has a
particular inﬂuence on which planes of an object receive light and the shape and direction
of the shadows that are cast by objects receiving light from that particular source.

95.1.3. Brightness and Decay
As light travels through space it decays or grows dimmer with distance. Think of a ﬁrework
bursting in the night sky. When the ﬁrework ﬁrst bursts the sparks are bunched close to
each other. Over a short period of time they quickly spread out from each other. If you
replace sparks with photons of light and the ﬁrework with your light source than you have
a very rough analogy to how and why light decays. All real lights decay with distance
according to the inverse-square law. At times when lighting a Blender scene it becomes
necessary to cheat this law.

95.1.4. Shadows
Real lights will always cast a shadow of some sort. Real scenes also typically include multiple
sources of light (even if these are only indirect lighting as a result of light bouncing oﬀ other
objects). Thus, even in an area shadowed by one light source, there will typically be light
coming from other directions, to soften the shadow so it is not completely inky black.
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95.1.5. Size
Real light sources rarely take the form of tiny points; the light usually comes from an area
of discernible size. This manifests itself in the form of a softness to the edge of the shadows,
or penumbra1 : areas behind an object where the light is partially obscured are less dark
than the inner parts of the shadow where the light is completely blocked.

95.2.
These are not all the properties of real lights, but as far as CGI lighting is concerned they
are the most important. As we will see later on, Blender oﬀers enough controls for you to
tweak and adjust each of these key properties of light.

1
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96. Understanding Blender Lights
i Information
Applicable Blender version: 2.68
Blender provides several diﬀerent kinds of lights:
• Point: Single point light source. Useful to provide very localized light. The shadows can
be sharp, or you can set its size to something nonzero to make the shadows fuzzy. Can
represent light sources within the scene; e.g. if there is a lightbulb or candle or something
in the scene, position one of these within it to give the impression of light coming from
that object.
• Sun: A light with parallel rays that will illuminate the scene with an even light. Because
the sun is (eﬀectively) inﬁnitely far away, the position of this lamp does not matter, only
its direction. Good to use in brightly-lit outdoor scenes (i.e. a sunny day).
• Spot: Spot lights produce light constrained to a cone-shaped beam, and have some
special features. They are the only light source that can be made visible with the 'halo'
option, to simulate light in a fog. They are also the only light source that can cast buﬀer
shadows (see below).
• Hemi: 180°-wide uniform, shadowless light source. Great for use as a ﬁll light, or as a
back light, or to represent light from the sky. Similar to Sun, its position does not matter,
only its direction.
• Area: These are similar to point lamps, except that they are rectangular. As a result
they can cast accurate raytraced soft shadows, at the expense of additional render time.
There are two diﬀerent kinds of shadows that lights may cast: buﬀered and ray-traced.
The main diﬀerence is that buﬀered shadows are much quicker to calculate, but take more
memory, and can be of lower quality without some ﬁddling. Also strand-rendered materials
(as can be used for hair or fur) cannot cast ray shadows with the Blender Internal renderer,
so you have to use buﬀer shadows for them so their shadows look realistic.
Only spot lamps can cast buﬀered shadows. Hemi lamps cannot cast shadows at all.
Lamp Type
Point
Sun
Spot
Hemi
Area

Buﬀer Shadow
no
no
yes
no
no

Ray Shadow
yes
yes
yes
no
yes
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96.1. Light Settings
Blender’s lights oﬀer many settings you can mess with to adjust their eﬀect, such as:
• Energy — the strength of the light.
• Colour — real lights often have a colour, rather than being pure white. It is common
in photography to talk about lights adding “warm” (reddish/yellowish) or “cool” (bluish)
tints to a scene.
• Falloﬀ — real lights get weaker with distance according to the well-known inverse-square
law1 . But Blender doesn’t force you to conform to reality: point and spot lamps also
allow for other options, like inverse-linear or even a custom curve.
• Distance — even with inverse-square falloﬀ, the intensity of real lights never quite goes
to zero at any distance, though it may become too low to measure. Blender’s distance
speciﬁcation allows you to limit the eﬀect of the light to a ﬁnite maximum distance.
This can be useful for having multiple lights illuminating diﬀerent parts of a scene, while
minimizing unwanted interactions between them—a headache that real photographers
and lighting technicians cannot avoid!
• Negative — instead of adding light to a scene, this light source can actually darken the
scene. Again, not possible with real lights, but useful for certain kinds of eﬀects. In live
action black cards are sometimes used to reduce reﬂection on the subject by absorbing
reﬂected light. This light could serve to provide a similar function.
• This Layer Only — this light only illuminates objects on the same layer(s). Another
useful way to minimize unwanted interactions between diﬀerent lights.
• Specular — uncheck this box to prevent this light illuminating specular parts of materials.
• Diﬀuse — uncheck this box to prevent this light illuminating diﬀuse parts of materials.

96.1.1. Lighting Without Lamps
It is possible to light a scene without lamps, or with fewer lamps. In the World Context

1
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Light Settings

Figure 860

of the Properties Window, there are three options, for “Environment Lighting”, “Ambient
Occlusion” and “Indirect Lighting”.
Environment Lighting adds a shadowless light that seems to come from all directions and
ﬁll all parts of the scene.
Ambient Occlusion (“AO” for short) is supposed to mimic the eﬀect of shadows darkening
corners and crevices of real-world objects (in theory this should naturally fall out of accurate
lighting calculations, but it is easier to compute it separately); Blender also allows you to
use AO to brighten parts of the scene outside those corners and crevices.
Indirect Lighting tries to mimic light bouncing oﬀ diﬀuse surfaces and illuminating other
diﬀuse surfaces. It only works when the “Gather” option (next panel down) is set to “Approximate”.
• Ambient Occlusion Video Tutorial: http://www.youtube.com/watch?v=rKUAemD7oo4
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i Information
Applicable Blender version: 2.68

Figure 861

Blecch

Open a new Blender document. Delete the default cube, and insert the Monkey (Suzanne)
instead. Hit F12 to render. You should get something like this.
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See how the character’s face—arguably the most important part you usually want to look
at—is in shadow? That is absolutely terrible lighting.
In this section, we will look at how to improve the lighting of this scene. The object of
the game is not to get rid of all shadows, because ﬂat-lit scenes tend to look pretty boring,
too. Instead, we will look at how to make imaginative use of the placement and strength
of highlights and shadows, to add interest and realism to the scene.
Note:
If you have any experience with photography, a lot of this material should be
familiar to you. Lighting in 3D rendering borrows a lot from the accumulated experience
that photographers have had with lighting real-world scenes. However, because computer
graphics cannot be 100% faithful to the laws of physics, some limitations apply. And
also some tricks become possible that are simply not achievable in the real world.
In photography, there are basically two kinds of lighting setups: outdoor and indoor. In the
real world, outdoor lighting (at least in daylight) is dominated by the Sun. This is a single,
extremely strong light source. But there is also indirect sunlight reﬂected oﬀ other objects,
including the sky, and these tend to soften the shadows and even add some colour to them.
Outdoor close-up model photo shoots also frequently make use of metal sheets, held up by
support crew, to deliberately add more of this indirect reﬂection and make the lighting of
a model more even.
Indoor (studio) lighting setups are commonly described in terms of the number of lights
employed, commonly “one-point”, “two-point” or “three-point” for 1, 2 or 3 lights.
In 3D graphics, you can cheat over this outdoor/indoor distinction. After all, the Sun is
just another light source you can choose to place in a scene. Instead of metal reﬂectors, it
is usually simpler to just add more lights, even if it is meant to be an outdoor scene. In
Blender, the lights themselves need not show up in the render, only their illumination of
the scene.
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97.1. One-Point Lighting

Figure 862

Ho-hum

Continuing on from the above example, move the default lamp so it is roughly in the same
location as the camera. Now your render should look something like this:
This is similar to the lighting you get when you take a picture on a point-and-shoot or
cameraphone with ﬂash enabled: because the light source is close to the lens, you don’t see
many shadows (think about it: the parts the light doesn’t reach are close to the parts your
vision doesn’t reach), leading to a very ﬂat image. This is why experienced photographers
often try to avoid using the ﬂash.
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97.2. Two-Point Lighting

Figure 863

At least some variation...

This time I have gone back to the default light position, and added a second light (“ﬁll
light”) close to the camera, reducing its strength to 0.5, while the original “key light” stays
at 1.0. That way the second light ﬁlls in the shadows just enough to make things legible,
without ﬂattening out the lighting completely.
Set the direction of the light using object rotation. The light must be selected, press the
R and move the mouse to change the angle.
The important point is that the key (brightest) light is not at the camera position.
That way, the image will contain some interesting shadows.
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97.3. Three-Point Lighting

Figure 864

Positioning the backlight

Now we add a third light, called the “backlight”. This is positioned behind and a little
above the model, and serves to accentuate the upper silhouette (particularly the head and
shoulders), and make our model stand out from the background. I set its energy to 2.0, to
increase the eﬀect. This screenshot shows what should be a good position for this light (it
is directly above the green line of the Y-axis). Put it too close to Suzanne, and her bald
head will glow a little too brightly. :)
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Figure 865

I’m ready for my close-up, Mr DeMille.

Now the render looks like this. Does the eﬀect look familiar? You should have seen something like it in countless close-ups in ﬁlm and TV, as well as portraits.

97.4. Other Lighting Setups
Of course, there are countless other ways to light a scene. The above ones are mainly
intended for close-ups and portraits. But where there are multiple characters in a scene,
or even no characters at all and just the scene, you may want to position multiple lights to
draw attention to some parts or characters while playing down other parts.
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98. Faked Global Illumination with
Blender internal
i Information
Applicable Blender version: 2.49
Getting uniform studio lighting with the blender internal renderer

98.1. Preamble
This tutorial will teach you how to use blender to create faked Global Illumination (here
forth called ”GI”). The reason it is faked is that blender currently doesn't support true
Global Illumination but it's not a diﬃcult task to fake. To fake global illumination, we will
surround our subject with a lot of suns. The easiest way to do this is to create a very large
sphere around our subject and place a sun at each vertex of this sphere, pointing inwards.
Luckily, Blender can automatically duplicate an object at each vertex of another object.
The results of this tutorial should look like this:
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Figure 866

This tutorial assumes you know the basics of the blender interface and how to add objects,
toggle editmode, and scale objects.
Now lets start blendering!
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98.2. Blender Faked GI Tutorial

Figure 867 In more recent Blender versions DupliVerts and Rotation options can be
found under the Object Data tab in the Properties Panel. Icosphere needs to be selected.
Add an ICO-sphere. Fire up blender and add an icosphere (SPACE → add → mesh →
icosphere). Set the subdivisions to 3 and accept.
Scale the ICO-sphere by 15 times
Flip the normals of the icosphere so that they point inwards. This will make sure
that our duplicated suns will point inwards. Go into edit-mode and press the A key till all
faces/verts/edges are selected and press WKEY and Flip Normals.
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Figure 868
Add a sun light source(SPACE → Lights → Sun)
Set the energy value of the light. This requires some special attention. If you keep the
value at the default 1, you get a pure white, washed out scene because we will duplicate the
light 162 times. A good way to calculate the light intensity required is to mess with the one
sunlight and do test renders while tweaking the energy value of the sun as required till you
get the brightness you want. THEN you divide the energy value of your sun by the amount
of vertices in your icosphere and then ﬁnally set the sun energy to the number you got.
Noob Note: I found I had to set the energy of the sun lamp extremely low, at .044. Otherwise, you end up with a completely washed-out image.
Parent the sun to the sphere. Select the Sun THEN shift select the sphere and hit
CTRL+PKEY
Enable dupliverts for the sphere. Depress the DupliVerts button. This will copy the
sun to each vertex of the sphere. Also depress the ROT button. The ROT option tells
Blender to rotate the suns to point along the normal of each vertex.

946

Blender Faked GI Tutorial

Figure 869

Enable AAO (Approximate Ambient Occlusion) This will result in more realistic soft
shadows around our subject. Set the AAO settings in the world buttons as in the following
image:

Figure 870

Set up the scene to render This can be anything you want but I used a simple curved
plane with Suzanne on top of it.
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Figure 871

One more note: Often it is hard to see your scene when you have this huge sphere encompassing your scene. So what you can do is to set the draw of the sphere to wireframe.

Figure 872

Just one last note: if you want more directional lighting, select the sphere and go into
editmode and press CTRL+TAB+3KEY for face select and select one face on a spot of
the sphere and press WKEY and subdivided a few times to get more lights in one spot
making that side a bit brighter and a stronger shadow on the far side of that cluster.
Blend happy and save often.
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99. Practising Good Parenting
i Information
Applicable Blender version: 2.71
In 2D drawing programs, you may be familiar with the concept of grouping objects together,
so that they can be manipulated and transformed as an indivisible whole.
Blender can achieve a roughly similar eﬀect through its concept of parenting one object to
another. (Blender also has a concept called “grouping”, but that serves an entirely diﬀerent
purpose, which will not be discussed here, so don’t be confused.)

99.1. Parenting and Unparenting

Figure 873

To parent one object to another is simple: in object mode, select the to-be-child
object(s), then select the to-be-parent object, then press CTRL + P to bring up the “Set
Parent To” menu. The options in the menu have the following meanings:
• Object: set the parent of the rest of the selection to the active (last-selected) object,
clearing any existing parent relationships the new-children-to-be may have had. Any
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objects that were previously parented are reset to their original transformations before
that previous parenting.
• Object (Keep Transform): similar to the above, except the children keep the transformations from any previous parenting they may have had.
• Vertex: this allows you to parent a child to a single, currently-selected vertex in the
parent (which must be a mesh). You can go into Edit mode on the parent mesh to make
the selection before using this option. The child will then track the movements of just
that vertex, not the entire object.
• Vertex (triangle): here 3 vertices are selected in the parent mesh. The child tracks, not
just their translations, but also their relative rotations as well.
When viewing your scene in Object mode, you will see black dashed lines connecting child
objects to their parents. Try moving, rotating or scaling just the parent object, and you
can see how the same transformation is automatically applied to its children as well.
To parent multiple children at once to a common parent, select all the child objects
in turn, then last of all select the parent object. Now when you do CTRL + P , all the
objects selected (except the last one) become children of the last one.
A parent of objects may in turn be a child of yet another object; any transformation of its
parent will automatically be passed on to it and all its children, and their children, and so
on.

Figure 874

To remove a parent relationship: select the child in Object mode, and press
P to bring up the clear-parent menu. The options here are:

ALT

+

• Clear Parent: remove the parent/child relationship, and reset the child to the original
transformation it had before the parenting.
• Clear and Keep Transformation: remove the parent/child relationship, but the child keeps
its current transformation as a result of the parenting.
• Clear Parent Inverse: this doesn’t actually clear the parent/child relationship, but it sets
the transformation of the child relative to the parent to the same as the transformation
the child had on its own before it was parented.
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99.1.1. Clear Parent Inverse Clariﬁed
Normally, when a parent relationship is set up, if the parent has already had an object
transformation applied, the child does not immediately inherit that. Instead, it only picks
up subsequent changes to the parent’s object transformation. What happens is that, at the
time the parent relationship is set up, the inverse of the current parent object transformation
is calculated and henceforth applied before passing the parent transformation onto the child.
This cancels out the initial transformation, leaving the child where it is to start with. This
inverse is not recomputed when the parent object is subsequently moved or subject to other
object transformations, so the child follows along thereafter.
The “Clear Parent Inverse” function sets this inverse transformation to the identity transformation, so the child picks up the full parent object transformation.
Note:
The shortcut CTRL + SHIFT + P
followed by Clear Parent Inverse.

is equivalent to setting up a parent relationship,
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99.2. Lock Up Your Children!

Figure 875

In the Properties shelf at the right of the 3D view (you can toggle its visibility with N ),
you will see at the top the Transform panel. This shows the overall object transformation
(translation, rotation, scaling), but note also the padlock icons next to the transformation
ﬁelds: clicking each one closes its padlock, locking the corresponding ﬁeld against further
changes, including changes made with the usual object-transformation tools in the 3D view.
(If you click a closed padlock, it will open again and remove the lock.)
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Example: Camera Pan
This can be useful for a child object: if its object transforms are locked, it will still follow
changes to transformations on its parent, but it cannot have its transformation changed
directly. This can prevent accidents when manipulating an “object” which is actually made
up of multiple Blender objects: parent them all to a common root object (e.g. an Empty),
and then lock them all, apart from the root object, and so they will transform together by
manipulating just the root object, and cannot (accidentally) be separated.
For example, you might construct a car with separate objects for the doors and wheels; these
might be left free to rotate (about their hinges and axles respectively), but are otherwise
locked in position relative to the car body.

99.3. Example: Camera Pan
Imagine you want to make a movie where the camera does a 360° pan right around an
object. We’ll leave the details of how to set up an animation for later, but for now let’s just
consider how to set up the camera movement.
Start with a new default Blender document. With the 3D cursor at its default location
(at the centre), add a new Empty object. It should end up inside the cube, so it won’t be
visible; switch Z to wireframe view, and it should be easier to see.
Select RMB the camera; then select SHIFT + RMB the Empty as well; now CTRL +
P parent the camera to the Empty.
Now select RMB just the Empty, and try R otating it: notice how the camera follows
along? For added fun, switch to camera view NUM0 (make sure the Empty is still the
only thing selected). Now try rotating the Empty: it should look like the cube is rotating
in the opposite direction, when it is really the camera moving around it.
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100. Overview
i Information
Applicable Blender version: 2.63

100.0.1. Frames and Keyframes
A frame is a snapshot of the scene at one moment in time. An animation consists of
displaying a succession of frames representing successive moments in time; if these are
shown suﬃciently quickly (at least 24 frames per second), the eye is fooled into seeing
smooth movement, instead of a succession of still poses.
This is the principle behind both cinema ﬁlm and digital video. But long before these were
invented, it was known that you could make a sequence of drawings on pages of a ﬂipbook,
which could then be rapidly ﬂipped by hand to produce an animation.
In live action video, we can capture the frames simply by letting the camera record as
the scene unfolds. In hand-drawn animation (cartoons), each frame had to be drawn by
a human animator (though there were some shortcut techniques like articulated character
pieces, separately-moving scenery layers etc). Actually what would happen was that the
most skilled artists would create keyframes representing pivotal points in the animation
(starting and ending poses in a character’s movement etc), and the lower-paid assistants
would have the job of ﬁlling in all the intermediate frames to produce smooth movement
between those endpoints.
Computer animation works in a similar way, except here Blender is your lower-paid assistant. You go to crucial points in the timeline of your animation, position and pose your
objects/characters appropriately, and tell Blender that this is a keyframe for the relevant
transformations (positioning/rotation/scaling) of those objects/characters. Then when you
run the animation, Blender will interpolate the speciﬁed transformation parameters between
keyframes, giving you smooth motion over those intervals.

100.1. The Timeline
At the bottom of the default Blender screen layout is a window called the timeline
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Figure 876

. This gives you an overview of your animation.

Figure 877

You can zoom the view in and out with the mouse wheel, or scroll left and right with MMB
.
The numbers across the bottom are frame numbers, with your animation starting at frame
1. The light grey background indicates the total duration of the animation. The vertical
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green line is positioned at the current frame time, and the current frame number is also
displayed in the box between the start/end values and the transport controls, and at the
lower left of the viewport in the 3D view window. Yellow lines indicate where keyframes
have been inserted.
You can set the current frame time by clicking with LMB at the desired position. You
can hop forward and backward a frame at a time with the left- and right-arrow keys, skip
to the next or previous keyframe with the up- or down-arrow keys, and jump immediately
to the ﬁrst or last frame by holding down SHIFT and pressing left- or right-arrow.
You can also “scrub” by dragging with LMB across the timeline, which causes the animation
to run backwards or forwards at whatever speed you choose, locked to the times across which
you drag.

100.2. See Also
• The animation section1 in the Blender user manual.

1

http://wiki.blender.org/index.php/Doc:2.6/Manual/Animation
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101. Introduction to Keyframing
i Information
Applicable Blender version: 2.63
In this module, you will learn the basics of how to insert and remove keyframes, and preview
the resulting animation in the 3D view.

101.1. First Keyframes
Start by opening a new Blender document. Select the default cube. Ensure that the timeline
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Figure 878

is showing that you are at frame number 1. Press I , and choose “Location”; this will
insert a keyframe at frame 1 which remembers the current location of the cube. Move the
current frame (green line) away from frame 1, and you will see that there is a yellow line
left behind.
Now go to, say, frame 25. With the cube still selected, press G , and move the cube to
a diﬀerent position—anywhere a few cube widths away will do ﬁne. Press I again, and
insert another Location keyframe.
Now try scrubbing with LMB between the two yellow lines in the timeline, and watch the
cube move smoothly between the two positions you set as keyframes.
Now press ALT + A , and Blender will automatically cycle through the timeline for you,
animating the cube as it goes. There will probably be a long pause in the motion after it
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gets to frame 25, because by default the animation will run until frame 250. Press ESC
to stop the animation, click in the box at the bottom of the timeline labelled “End:”, and
reduce the end frame number to, say, 50. Press ALT + A to start the animation again,
and watch the movement cycle through a little more quickly this time.
Stop the animation, go back to frame 1, and press ALT + I to delete that ﬁrst keyframe.
Move the current time away from frame 1, and conﬁrm that the yellow line that was there
has gone. Now restart the animation; what happens? You should see the cube snap to
the location speciﬁed by the only remaining keyframe, and stay there. Without a second
keyframe specifying a diﬀerent value for a parameter, Blender sees no reason to change the
value for that parameter to anything else. Hence the rule:
Note:
A parameter is only animated at a particular time if there are keyframes before and after
that time specifying diﬀerent values for that parameter.

101.2. Preview From All Angles
Press ESC to ensure the animation is stopped, then CTRL + Z to undo your deletion
of the ﬁrst keyframe above. Press ALT + A to start the cube moving between its two
positions again. While it runs, the 3D View window remains fully operational; try using
MMB to rotate the view, the mouse wheel to zoom in and out, NUM0 to toggle in and
out of camera view, etc. All the while, the cube keeps running through the dance you
choreographed for it. How neat is that?

101.3. What Is Being Animated?
Those yellow lines in the timeline aren’t really very informative. They tell you there is a
keyframe at that time, but not what settings are being speciﬁed. And there is no way to
adjust an already-inserted keyframe, you have to delete it and insert another one.
All this ﬁne control (and much more) is possible elsewhere, in the Graph Editor window,
but we’ll leave that for later. For now, just bring up the Properties Shelf in the 3D View by
pressing N (if it’s not already visible). At the top of this is the “Transform” panel, where
you can see location/rotation/scaling settings for the currently-selected object. Notice that
the Location values for the cube are displayed against a coloured background, either green
or yellow; move the current frame time to a keyframe time, and it will be yellow, otherwise
it will be green.
This coloured background is your cue that the speciﬁed value is being animated, and whether
the current animation time is a keyframe time for that value. This goes for animating other
properties as well, not just object transformations.
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101.4. Animating a Material Property
Think of this next example as a teaser. It will be left incomplete for now, because to see the
full eﬀect you will need to put a bit more work into material, lighting and render settings,
and render out the full sequence for viewing in some kind of external movie player. Feel
free to come back and ﬁll in the gaps as you learn more about those things.
One of the goals in the Blender 2.5x rework was to introduce the concept of being able
to “animate anything”. Animation had been a bit of an afterthought in earlier versions of
Blender, but in 2.5x it is integrated very deeply, to the point where just about any object
property can be animated over time.
Start a new Blender document. Select the default cube, and create a new material for it.
You don’t need to change the colour or any of the other settings for it, but look in the
material settings for the “Transparency” panel and check the title box.
Look in that panel for the “Alpha:” slider (which might be abbreviated to something like
“Alp”, depending on the size of your screen). It should be showing the default value of 1.000
(fully opaque). Right-click on it ( RMB ) to bring up a menu with a bunch of options,
of which the one we want is the top one, “Insert Keyframe”. Once you select this, the
background of the Alpha slider should turn yellow.
Set the current frame to another point, say frame 25. As you move away from frame 1,
the background of the Alpha slider turns green, indicating it is being animated, but is not
currently at a keyframe. At frame 25, set the Alpha value to zero, or fully invisible (by
either dragging across it with LMB or clicking in it and typing the new value). Then
right-click on it and insert another keyframe.
Now try scrubbing back and forth in the timeline between frame 1 and frame 25, and you
should see the Alpha value change accordingly between the two key values you speciﬁed.
If you look in the preview image at the top of the material properties window, you should
see the sample object there correspondingly fade in and out. Unfortunately the actual cube
in the 3D view won’t do this (”Solid” Viewport), but it will when you set the Viewport to
”Material”. If you were to render the image at the current frame with F12 , you should see
the cube appear with varying degrees of faintness, down to becoming completely invisible
at the end.
In short, you now have an animated disappearing cube.
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102. The Ways of the Animator
i Information
Applicable Blender version: 2.68
You have just seen how animation can be applied to most object property values. In addition
to this, Blender provides some speciﬁc features to aid in animating movements of parts of
objects:
• Meshes can have shape keys deﬁned for them. These give diﬀerent positions to the vertices (though their number and topology—edge/face connections—cannot change). The
amount of inﬂuence each shape key contributes to the shape can be continuously adjusted
from nothing to 100%, and like other property values can be made to vary over time.
• Armatures are specialized objects, consisting of rigid bones that can be connected by
joints, and moved and rotated relative to each other to produce diﬀerent poses, very
much like the skeleton of a human or animal. Armatures do not appear in the ﬁnal
render, but a mesh can be deformed (i.e. have its shape changed) by an armature to
bring lifelike movement to a character.
• Lattices are another kind of specialized object that can also be used to deform a mesh.
Like armatures, they do not appear in the ﬁnal render. Unlike armatures, they lack rigid
joints, and so produce more rubbery changes of shape, characteristic of creatures without
bones, or perhaps for a cartoony eﬀect.
• Curve and surface objects can also have shape keys deﬁned for them. And of course
curves can be used to deform a mesh via the curve modiﬁer.
• You previously saw the usefulness of the Empty object1 in modiﬁers. But being an
object with position, scale and rotation properties like any other, these properties can be
animated for an Empty, too, with corresponding eﬀects on those modiﬁers. Also if the
Empty happens to be a parent2 of other objects, then those objects can be animated as
a group, just by animating the Empty.

1
2

Chapter 72 on page 681
Chapter 99 on page 949
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103. Animation Editors
i Information
Applicable Blender version: 2.70
Blender oﬀers several diﬀerent kinds of editing windows speciﬁcally to do with animation.

103.1. Timeline
You have previously come across the Timeline
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Figure 879

view as the simplest way to see the keyframes in an animation. This window also includes
transport controls that you can use to start and stop the animation, jump to a particular
frame with LMB , and scrub by dragging across a time range with LMB .
This window also lets you deﬁne markers which you can name to identify important points
in the animation, for informational purposes. Also, using the “Bind Camera to Marker”
function, you can dynamically switch the active camera at marked points in the animation,
to cut between diﬀerent viewpoints.
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103.2. Graph Editor
You previously saw how to deﬁne keyframes for animating a property, such as an object
position or material setting. But what if you get a keyframe deﬁnition slightly wrong?
Perhaps the timing is slightly oﬀ, or the movement is not quite right. You could delete the
keyframe and try again. But, in many cases, it would be easier if you could get into the
actual deﬁnition of the keyframe and tweak it around a bit, move its time position, adjust
the animated property values, that kind of thing.
This is the purpose of the Graph Editor

Figure 880

. It gives you the most detailed, low-level view possible of your animation, by drawing an
FCurve for each animated property of the selected object, representing how the property
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value varies over time. Each curve has control points located at each of its keyframes,
and you can move these points around—horizontally to change the timing, or vertically to
change the keyframe value—as well as add and remove points.

103.3. Dope Sheet
The Dope Sheet

Figure 881

gives a high-level view of your animation, similar to the Timeline, but slightly more detailed.
Here you see the separate keyframes for each animated object, and you can do some limited
editing, like moving the keyframes around, and duplicating and deleting keyframes, but you
can’t seem to add entirely new ones.
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NLA Editor
Actually, this window can show any of ﬁve diﬀerent editor submodes: Dope Sheet, Action
Editor, Shape Key Editor, Grease Pencil or Mask. The Action Editor is useful in conjunction
with the NLA Editor (below).
• See also: Dopesheet1 on the Blender Wiki.

103.4. NLA Editor
The NLA (“Non-Linear Animation”) Editor

Figure 882

1

http://wiki.blender.org/index.php/Doc:2.6/Manual/Animation/Editors/DopeSheet
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represents a diﬀerent way of setting up an animation: instead of thinking of it as a single
linear sequence of keyframes, you break it up into actions, which are separate sequences
that can be arranged in various ways. You can also duplicate an action any number of
times, position the copies at diﬀerent times in the overall animation, and even attach them
to diﬀerent objects. But they still share a single set of FCurve contents, which you can
edit in the Graph Editor as you would a monolithic linear animation sequence, and your
changes will take eﬀect in all copies of the action.
To edit the contents of an action in the Graph Editor, you select the action and TAB into
“tweak mode” (analogous to Edit mode in the 3D view). TAB again takes you out of
Tweak mode.
Note:
Actions do not appear in the Timeline or Dope Sheet. This means that, once
you start to use actions, you no longer get a correct overview of your animation in these
two windows. The Timeline is still useful for its transport controls, but otherwise you
should stick to the NLA Editor for your overview.
However, the Action Editor submode of the Dope Sheet now becomes useful, for creating
new actions. These start out initially empty of any keyframes or FCurves, but you can add
these in Tweak mode.
• See Also: NLA Editor2 on the Blender Wiki.

103.5. To Summarize...
The above description may seem rather confusing in places. Basically, there are two ways
to organize your animation:
• Linear, as a single sequence of FCurves and keyframes
• Non-linear, as a sequence of actions, each consisting of a sequence of FCurves and
keyframes. The nonlinear data can be further divided into multiple overlapping tracks,
which combine together at any moment in time to produce the complete animation.
Objects that can have animation data attached to them can have both kinds, linear and
nonlinear. You can even attach both kinds at once, though then the linear animation data
takes precedence. It is easy to change your mind and switch back and forth; typically, the
development of a simple animation might start out linear, then change to nonlinear as it
gets more complicated.

2
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http://wiki.blender.org/index.php/Doc:2.6/Manual/Animation/Editors/NLA

104. Introducing the Graph Editor
i Information
Applicable Blender version: 2.70
The Graph Editor is where you exercise the lowest-level control over the details of an
animation, right down to the settings and placement of each keyframe. You previously
learned1 how to create and delete keyframes; now you will learn how to get inside them and
tweak them.
Let’s start by creating a very basic animation, using the default cube. As you did in “First
Keyframes2 ”, set up a couple of Location keyframes, one at frame 1, and another positioning
the cube a few widths away at frame 25. Scrub between these times in the Timeline, and
conﬁrm that the cube moves between those two positions.

1
2

Chapter 101 on page 959
Chapter 101.1 on page 959
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Figure 883

Now, add a new window to the left of the 3D view
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Figure 884

, and change its type to Graph Editor
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Figure 885

. Provided the cube is still selected, it should show something like this. The Location
controls at the left will likely initially appear collapsed to a single line; click on the rightpointing triangle so it points downwards, revealing the separate X, Y and Z Location control
lines.
The curves at the right are the FCurves; the colours for the X, Y and Z location curves
correspond to the colours of the squares surrounding the eye icons in the control lines at
left.
Note:
Remember, the Graph Editor only shows animation data for selected objects. If you ever
wonder why the right curves are not showing up here, make sure you have the right
objects selected in the 3D view.
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Note the following features of the display:
• The vertical green line represents the current frame. It always shows the same frame as
the corresponding line in the Timeline

Figure 886
, and also the frame number at the lower-left corner of the 3D view
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Figure 887

•

•

•

•

. Just as in the Timeline, you can set its position with LMB , or use the arrow keys
to step forward/backward one frame (right/left arrows) or jump to the next/previous
keyframe (up/down arrows).
There is also a horizontal green line which is positioned with LMB . This can be used
(together with the vertical line) for snapping selected control points to the speciﬁed value
or time.
The control points on each curve, at the position of each keyframe. These are black when
not selected, or a pinkish colour when selected. Various keyboard shortcuts you should
be familiar with from the 3D view also apply here: RMB to select one point (deselecting
everything else), SHIFT + RMB to add/remove a point to/from the selection, A to
toggle selecting everything/nothing, even B to do a box selection, even C ircle select
is available.
The little handles joined to each control point by straight lines. FCurves are Bézier
curve3 s, just like those commonly found in 2D illustration programs, or in Blender’s own
curve objects4 . By default each control point gives a smooth curve, causing the position
(or other object property) to smoothly accelerate and decelerate; but you can change the
handle type with V , if for example you want a more sudden change.
The eye, speaker and padlock icons in each control line.
• Clicking the eye icon causes the eye to close, and the corresponding FCurve to disappear
from the display; this reduces clutter and makes it easier to edit just the right curve.
Click the closed eye to open it again and make the hidden curve reappear.

3
4
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Chapter 68 on page 637
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•

•
•

•

• Clicking the speaker icon mutes (temporarily disables) the eﬀect of the corresponding
curve, without actually deleting it. This may be useful for debugging complex motions.
When muted, the radiating arcs disappear from the speaker, and the curve turns white;
click the speaker again to unmute the curve.
• Clicking the padlock locks the curve against selection and editing, while keeping it
visible. Clicking on the closed padlock opens it again, restoring the ability to select
and edit the curve.
Clicking on the text or background (i.e. not in any icon) on a control line with LMB
selects the entire curve. You can also SHIFT + LMB to select multiple curves at
once. Pressing DEL or X within the area of the control lines will get rid of the
entire selected curve(s)!
You can scroll around the view with MMB . Or you can drag the scroll indicators,
anywhere except at their ends.
The view can be zoomed with the mouse wheel, as in the 3D view. However, this zooms
both horizontally and vertically by the same factor. It is characteristic of the Graph
Editor that the curves are likely to be stretched very tall, while squashed very narrow.
To zoom on each axis independently, drag on the ends of the scroll indicators: lengthen
them to zoom out, shorten them to zoom in.
You can also use HOME and NUM. , just like in the 3D view, to zoom and centre the
view on the entire set of curves or just selected curves or parts thereof.

Set the current frame to something in-between the two keyframes, e.g. frame 12. Select
RMB one of the control points at frame 25, and try moving G it around: how does it
aﬀect the cube in the 3D view? Constrained moves are very useful here:
•

G
Y to change the value of the FCurve at the control point without moving the
keyframe in time
• G
X
to move the control point in time without changing the value it gives to
the FCurve. You can move one control point past another; Blender will automatically
reconnect the curve segments to ensure the curve does not loop back on itself.

Also, go to frame 25 (the time of the second keyframe), and make sure nothing is selected.
Now go to the Select menu, and choose the option “Column on Current Frame” (keyboard
shortcut CTRL + K ): this selects all keyframes located at the current frame time. Now
you could, e.g. use G
X to adjust the position of all control points for this keyframe
in time.
Inserting and removing control points: You can, of course, delete selected control
points with DEL or X in the usual way. You can also insert control points at the
current time with I : this will pop up a menu asking whether you want to insert control
points for all editable channels (FCurves), or only the curves containing currently-selected
control points. The new control points will be inserted so as to make minimal diﬀerence to
the actual shapes of the curves; but you can of course tweak them around afterwards.
Rescaling an entire animation sequence: Supposing you painstakingly set up an animation sequence, only to discover that the total length of it is not quite right, either too
long or too short. It is easy enough to lengthen the entire sequence (making it run slower),
or shorten it (making it run faster).
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First of all, make sure all the aﬀected objects are selected. In the Graph Editor, ensure all
the relevant FCurves are visible and not locked. Set the current time to frame 1. Press A
once or twice to ensure that all control points are selected.

Figure 888

In the window header for the Graph Editor, ﬁnd the Pivot Point menu (as at right). Make
sure the “2D Cursor” option is selected. Now press S
X to rescale the entire animation
in time, keeping only keyframes at the current time (which you set to frame 1, remember)
unchanged. Either type in a suitable number to get an exact new length, or adjust it by
eye so the last keyframe ends up at the right frame number. As always, press ENTER to
conﬁrm the transformation.

978

105. Animation Rendering
i Information
Applicable Blender version: 2.63
It’s time to revisit the rendering settings1 we looked at when we were ﬁrst learning about
rendering single still images, and go over some of the stuﬀ we skipped back then.

105.1. Render Control

Figure 889

We previously skipped over the second and third buttons in this panel: the second button
is equivalent to CTRL + F12 (render animation), while the third one invokes your player,
as conﬁgured in your user preferences, to play a rendered animation.

1

Chapter 24 on page 189
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105.2. Image Dimensions

Figure 890

We previously looked at the settings in the left column (spatial dimensions of the images),
now look at the ones on the right (time dimensions).
The “Start Frame” and “End Frame” numbers simply mirror the same values at the bottom
of the Timeline window; changing these numbers in either place automatically changes them
in the other place as well. These numbers determine which part of the animation sequence
you want to render. These numbers are remapped frame numbers (see below about time
remapping), so they don’t necessarily correspond directly to frame numbers in your timeline.
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The “Frame Step” number, if set to a value n greater than 1, tells Blender not to render
every frame, but only every nth frame. Like the scale factor in the image resolution, this
gives you a faster render, handy for previewing, at the expense of lower quality.
The “Frame Rate” controls how timeline frame numbers relate to actual time. The default
value of 24fps is the usual value for ﬁlm, while 25fps is the standard value for PAL video
and 29.97fps for NTSC.
The “Aspect Ratio” provides a pair of divisors for scaling to account for nonuniform pixel
densities in the X and Y direction. If you are creating footage for the old standard-deﬁnition
PAL or NTSC video formats, then these need to be set to suitable values (which you don’t
have to calculate, since they can automatically be ﬁlled in by choosing the appropriate item
from the preset menu). Otherwise, leave them at the default 1.0/1.0.
The two ﬁelds labelled “Time Remapping” let you warp time, and speed up or slow down
the animation from its original rate. The “old” value (on the left) is converted to a time
interval in seconds by dividing by the speciﬁed frame rate, and then the “new” value (on
the right) determines how many frames are actually rendered during that interval. If both
values are the same (the default), then time remains unwarped, and the frame numbers
correspond directly to timeline frame numbers.

105.3. Image File Formats

Figure 891
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Blender’s output ﬁle formats include regular movie formats (e.g. MPEG, Ogg Theora), but
you can also use a still-image format (e.g. PNG, OpenEXR). Outputting an animation to
a still-image format involves generating a separate ﬁle for each frame, named according to
the frame number, into the directory that is named in the box at the top of the “Output”
panel.
This editable ﬁeld gives the location for saving animation renderings. Only animation
sequences are automatically saved here; single still frames have to be explicitly saved from
the Image Editor. If the path begins with “//”, then it is interpreted as a subdirectory of
the parent directory containing the .blend ﬁle.
Outputting straight to a movie format is ﬁne if you don’t intend to do further processing of
the resulting movie. Trouble is, that’s rarely true. You might need to adjust the images in
some way, or edit the rendered sequence into a longer production along with other pieces.
But most of these movie formats are designed only for playback, not for such additional
processing and editing, and such processing requires decoding the movie format, doing the
processing, then re-encoding again. This is generally a time-consuming process, and it leads
to loss of quality.
And you might discover that your renders didn’t come out right in the ﬁrst place, and so
you need to redo it all. It is quicker to get to this stage if Blender doesn’t have to do movie
encoding as well.
Therefore it is usually better to render your animation to a sequence of still frames. The
ﬁles end up much larger, and there will be an awful lot of them, but they leave maximum
room for you to do further processing with a minimum of quality loss. Once you have
ﬁnished doing all your processing and editing, you can then encode the results to a regular
movie format for delivery to your users, using a tool like FFmpeg which oﬀers all kinds of
ﬁne-tuning over the encoding process that Blender cannot match. Nor is it Blender’s job
to match.
Having said all that... In these tutorials, you probably want to generate renders quickly
and conveniently, without worrying too much about quality. For that purpose, by all means
choose one of the “Movie” formats for animation rendering.
If you don’t already have a player to hand that will handle any of the formats that Blender
can generate, why not try VLC2 , which will play just about anything.

105.4. Single Frame Versus Entire Animation
You already learned how to use F12 to render a single still frame. In fact this renders
the current frame—i.e. whatever the state of the model/scene is at the current frame time.
Thus, you can go to diﬀerent frame times and hit F12 to check how things look at crucial
points, before doing a render of the entire animation, to save time in case you discover
something doesn’t look right.
Once you are satisﬁed with the state of the entire animation, you can go to the “Render”
menu and select “Render Animation” to render the whole thing (or hit CTRL + F12 , unless
2
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your GUI has usurped this for another purpose3 ). Of course, you might then discover further
things that don’t look right, that you didn’t notice before, and have to go back and ﬁx them
before rendering again. This is why it’s a good idea to user lower-quality render settings to
check how things are going from early on. Or in other words,
Note:
Preview early and often.
Note:
Animation rendering can take a while. Consider a short animation sequence of,
say 10 seconds at 25 frames per second—250 frames. If a single frame takes 10 seconds
to render, then the whole sequence will take about 40 minutes. If a single frame takes
a minute, then the whole animation will need over 4 hours to render. And it gets worse
the longer the movie is. And so it goes. This is why commercial studios have
renderfarms—to speed things up by rendering multiple frames concurrently. Make use
of shorter, low-frame-rate, low-resolution renders when you can.

3

Chapter 11 on page 55

983

106. Lattice Modiﬁer
i Information
Applicable Blender version: 2.49

106.1. What is a Lattice?
A Lattice is essentially a simple container that can be used to deform and manipulate a
more complex mesh in a non-destructive manner (i.e. A lattice can be used to seriously
deform a mesh then, if the lattice is later removed, the mesh can automatically return to
its original shape).

106.2. How to add and use a Lattice
A Lattice is added to the scene in the same way other objects are added. Either:
Noob Note For Blender 2.62 or 2.63 users, I recommend referring to this Lattice Modiﬁer
video tutorial1 by Ed Lazor for animating the lattice, as numerous interface changes have
occurred between Blender 2.4x and 2.6x.
1. SHIFT + A over the 3D window and choose Lattice from the pop-up menu, or
2. Press SPACE over the 3D window and choose Lattice from the pop-up menu (Note:
does not work in recent versions of Blender.), or
3. Click Add in the 3D View window header (located at the bottom of the 3D View)
and choose Lattice from the drop-down menu
The default Lattice looks just like a cube when ﬁrst added except that it is just one Blender
Unit (BU) wide whereas a mesh cube is 2 BU wide. When the Lattice is added, the window
remains in Object Mode and the Lattice can be moved, resized and rotated like any other
Blender Object.
On its own, a Lattice serves no purpose whatsoever since it can't be seen in a rendered image.
Its only use is to manipulate another object and so, to be useful, we need to associate another
object with it. The current method for doing this is by applying a ”Lattice Modiﬁer” to
a Blender object.
The basic workﬂow is:
• Add a mesh (cube, cylinder, cone, sphere, etc.)
1

http://www.youtube.com/watch?v=10asQDMhFQw
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• Add a Lattice
• In the Object Context

Figure 892
of the Properties window, enter the name of the Lattice (The default name is Lattice,
Lattice.001, Lattice.002, etc. - or you can give it a useful name that you'll remember
later)
• Select the mesh
• Go to the Modiﬁers Context
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Figure 893
in the Properties window. Click Add Modiﬁer > Lattice
NOTE: In older versions of Blender, a lattice was applied using a parent method - select the
mesh, then select the Lattice, then press CTRL + P and choose ”Lattice Deform”. While
this method is still available, it does not oﬀer the full functionality of the newer Lattice
Modiﬁer. If you use the parent method, you will need to press the ”Make Real” button in
the modiﬁers palette to enable the modiﬁer functionalities. Using the method, the Lattice
becomes a parent and a modiﬁer. As a parent, it will act on the mesh in Object Mode
whereas a true modiﬁer lattice only inﬂuences the mesh when altered in Edit Mode.
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Figure 894
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Adding a Lattice Modiﬁer to an object

How to add and use a Lattice

Figure 895 Lattice modiﬁer interface in Blender 2.78. The modiﬁer aﬀects object
Sphere. Eﬀect is governed by lattice object named Lattice.

Now, we can change the Lattice in Edit Mode and any changes we make to it will aﬀect
the mesh.
Note: Applying the Modiﬁer Correctly
When adding the modiﬁer to your object, you must enter exactly the same name as your
lattice. The default is Lattice with a capital ”L” but if you've changed it or have more than
one Lattice, then you will need to enter the new name. When you enter a valid Lattice
name, the name stays visible in the Ob: box. If your entry disappears then you've entered
the name incorrectly.
One simple way to get the right name is to select the Lattice, go to F9 , Link and Materials
panel and where it says Ob:Lattice or Ob:Lattice.001 etc., move the mouse over this ﬁeld
and press CTRL + C (don't click on it, just hover over it). This copies the Lattice name.
Then select your object, go to the Lattice Modiﬁer panel, hover the mouse over the Ob:
ﬁeld and press CTRL + V to paste the name in. Now it should stay there and your
Lattice should work in Edit Mode.
Noob note: I recommend the method with CTRL + P

for animation.
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106.2.1. Basic Exercise:
1. Start with a new Blender scene, delete the default cube and add a UVsphere ( SHIFT
+ A > Mesh > UV sphere). Accept the default 32 Segments and Rings. You could
use any of the mesh shapes but because the sphere is heavily subdivided (made up of
lots of edges and faces), you will get a better idea of what the Lattice is doing.
2. TAB back into Object Mode then add a Lattice. It is generally wise to resize the
Lattice so that it surrounds the mesh it will be deforming. So, press S and enlarge
the lattice to 2 BU wide.
3. Select ( RMB ) the Sphere and add a Lattice Modiﬁer to it. Make sure that you type
the exact Lattice name correctly into the box. Nothing appears to happen but that's
ﬁne. In newer Blender versions click the ﬁeld under the label ”Object:” and select the
desired lattice object from the drop-down menu.
4. Now select your Lattice, TAB into Edit Mode, select just one control point (a
control point looks like a vertex) on the Lattice and move it around. You will see
the sphere mesh stretching and squashing relative to that control point. Move each
Lattice control point one at a time and see just how far you can deform the mesh.
Zoom in your 3D window if you need a closer look.
5. The control points of the Lattice can be moved, scaled and rotated in the usual ways.
Try selecting a few of all the control points and scaling them ( S ) or Rotating them
( R ) and watch the mesh follow along.
6. Now, exit Edit Mode ( TAB ) and select the sphere in Object Mode. Go to the
modiﬁers panel and press the big ”X” button to remove the modiﬁer. Despite all that
deforming, the sphere immediately returns to its original size and shape. Nothing was
really changed in the sphere's mesh data. Immediately re-apply the modiﬁer as before
and see the Lattice immediately apply its own deformation to the sphere again.
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106.3. Getting more involved with Lattice

Figure 896

Lattice (Object Data) Context in the Properties window in Blender 2.78.

The default Lattice is two control points high, two wide and two deep, i.e., it is two control
points wide in each direction (these are referred to as the U, V and W directions). However,
we can change the number of control points in one, two or all directions. This is done by
selecting the Lattice, going to the Lattice Panel ( F9 ) and changing the values in the
U, V & W buttons. If you decrease one ﬁgure to a value of 1, the Lattice will become
two-dimensional (planar). Decreasing two values to 1 will change the Lattice to a line (one
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dimension). This can be useful, especially if the remaining value is increased, but is not the
most common usage of Lattice.

Figure 897

UVW settings for Lattice
NOTE: The ”Make Regular” button will set the UVW control points of an unscaled
Lattice to be exactly one Blender Unit apart in each direction. The ”Outside” button
eﬀectively removes all the internal control points which are added when the UVW settings
are higher than 2.
In most situations you will want to increase some or all the values as this gives you more
control over complex deformations, much like a subdivided mesh. How much you increase
the UVW directions depends entirely on how much detailed control you need over deformations. As you've already seen basic squash, stretch, shear and simple deforms can easily be
achieved with the default 2,2,2 Lattice but by increasing the UVW values a little, a whole
new range of deform possibilities becomes available.
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Figure 898

Three Lattices with diﬀerent UVW settings
One thing to understand, however, is that a Lattice cannot bend the individual edges of
a mesh (the lines connecting any two vertices) so the mesh must contain enough edges
in order to apply complex lattice deformations to it. These edges must be genuine edges
and not the virtual edges created by a subsurf modiﬁer (Correction: Yes, they can be
edges generated by a subsurf modiﬁer, provided the subsurf comes above the lattice in
the modiﬁer stack for the object being deformed; use the up/down-arrow buttons next
to each modiﬁer to rearrange them as necessary). Edges can also be added to a mesh
using a variety of tools including subdivide, knife and loop cuts (some info on these http:
//en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Die_Easy_22 http://).
New Note: Use K to open a menu for the knife, loop cuts, etc. Knives are used to add a
vertex to each line you left click and drag the cursor over, and loop cuts allow you to make
multiple cuts into your active object.
About loop cuts: CTRL + R also is a direct shortcut to a loop cut. Furthermore,
loop cuts' main uses are for subsurf modeling. In order to accomplish a hard edge in a
subsurfed object (for example the edges and corners of a wooden table or the bumpers of
a car) you must apply loop cuts to the faces surrounding the edge and place them very
close to them (and parallel). Experiment with a simple subsurfed cube and you'll see.
Keep in mind this is why when modeling it is highly recommended to use quads. A loop
cut will only cut a quad face, or every face connected with it in one direction, but only
quads. Another main reason why it is recommended to model with quad faces is regarding
animation but I suppose other tutorials will deal with that later. More information: http:
//wiki.blender.org/index.php/Manual/Edge_and_Face_Tools

2

Chapter 1 on page 5
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Figure 899

A simple subdivided cube after a complex lattice deformation

106.3.1. Intermediate Exercise
For this exercise, start over with a new scene and repeat Steps 1 - 3 in the Basic Exercise
above. Don't go into Edit Mode yet.
Basic Exercise:
1. Start with a new Blender scene, delete the default cube and add a UVsphere (Spacebar>Add>Mesh>UVsphere). Accept the default 32 Segments and Rings. You could use
any of the mesh shapes but because the sphere is heavily subdivided (made up of lots of
edges and faces); you will get a better idea of what the Lattice is doing.
2. Tab back into Object Mode then add a Lattice. It is generally wise to resize the Lattice
so that it surrounds the mesh it will be deforming. So, press S and enlarge the lattice to
2 BU wide.
3. Select ( RMB ) the Sphere and add a Lattice Modiﬁer to it. Make sure that you type
the exact Lattice name correctly into the box. Nothing appears to happen but that's ﬁne.
• In Object Mode, select the Lattice then press F9 and go to the Lattice Panel. Increase
all the UVW values to 4. You will immediately see the change displayed in the 3D
window.
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•

into Edit Mode and play with the control points again. The ﬁrst thing you
might notice is that the corner control points have less inﬂuence now than before. This
is because the eﬀect is proportional to the distance of each point from the mesh. Move
some points in the middle of a side face and you'll see the eﬀect is signiﬁcantly greater.
TAB

• Try selecting groups of control points and pulling them away from the Lattice to stretch
lumps and bumps out from the mesh. If you are familiar with the proportional edit tool,
try that too - it works on Lattices just like it does on meshes.
Try doing the same exercise but increasing values in only the W direction. (U divides in
the X direction, V divides the Y direction and W divides the Z direction). So, set the
UVW to 2,2,4 and play with the control points again in Edit Mode. Select the two rows of
control points around the centre of the Lattice and scale them up ( S ) then Scale them
down along Z-axis only ( S
Z ). Try other transforms constrained on diﬀerent axes for
interesting, controlled results.
There are three diﬀerent options for how the Lattice Modiﬁer aﬀects each UVW direction.
These are Linear, Cardinal and B-Spline. All I can say is that B-Spline is the default and
to ﬁnd out what the diﬀerence is, press the buttons and see.

106.4. Examples

Figure 900

Some examples of a Lattice deforming a standard UV Sphere mesh (not smoothed)
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106.5. Making it stick
To keep the mesh deformed permanently, you can select it and press the ”APPLY” button in
the Lattice Modiﬁer panel. This ”bakes” the mesh in the deformed position and disconnects
it from the Lattice. The Lattice can then be deleted without the mesh returning to its
original shape. This is useful if you are using the Lattice as a modelling tool rather than
an animating tool.
Also, instead of deleting the Lattice, you can use it to immediately modify another mesh.
Simply move the Lattice over the new mesh in Object Mode then apply the Lattice Modiﬁer
to the new mesh. If the Lattice is already in a deformed state, the mesh will immediately
be deformed too. Press Apply again to ”bake” that mesh and keep re-using the already
deformed Lattice on as many other meshes as you wish for matching results.
[Noob Note: I found it interesting that you can even apply the lattice deformation to the
original object again once baked, and it will deform even further.]

106.6. Animating a Lattice
Lattice animation uses a workﬂow almost identical to the RVK (Relative Vertex Key) workﬂow from Blender 2.37 and earlier. You don't need to know this but some people might ﬁnd
the information useful.
With your Lattice Modifer already added to your object, select the Lattice and press I
to tell Blender you wish to animate the Lattice. Choose ”Lattice” from the pop-up list.
This sets the basis key (undeformed state) for the Lattice.
Adding the basis key
In the Editing panel (F9), press the ”Relative” button.

Figure 901

Set the keys to ”Relative”
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NOTE: The Slurph setting determines the delay, in frames, for how long it will take to
morph from their former state to the one applied by the new lattice.
To set your ﬁrst deform key, press I-Key and then ”Lattice” again then enter Edit Mode.
Deform the Lattice by scaling or moving control points then Tab back into Object Mode.
If you open an Action Window now, you will see your ﬁrst key, ”Key 1”, added to the list.
If you press the small arrow at the top of the list, it will display the slider for that key.

Figure 902

Lattice key sliders in the Action Window[Noob note for blender 2.48a] In the action window,
select ”ShapeKey editor” in the dropdown ”editing modes for this editor” (in the panel header)
To add more Lattice keys, for a variety of deform shapes, repeat the process: I-Key, Tab to
Edit Mode, move control points, Tab back to Object Mode. Each time you exit edit mode,
a new key will be added to the list in the Action Window.
Animating the Lattice uses the same process as animating Shape Keys for meshes.
If you want the object to begin undeformed, then set each key slider to zero on the ﬁrst
frame of the animation. Move through the frames, setting the sliders as you go to deform
the Lattice as desired. You will often ﬁnd you'll need to set a key before and after each
deform key in order to control the rate at which deformations take place in the animation.
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Figure 903

Setting keys in an animation
Noob note: I'm doing everything as described and get no keys in action window when
exiting Edit mode... Any suggestions?
Noob note; Is it possible to create a keyframe using the object's mesh rather than applying
a lattice?
Noobie note: What to press after I-Key? I'm not getting any keys in the action window,
help please.
Another Noob: No keys here. I got something changing to IPO Curve Editor and choosing
Shape in IPO Type
Noob note; Select Action Editor header->Shape Key Editor. Make sure you also selected
Buttons Window->Editing (F9)->Relative Keys
Noob Tip: I am seeing a possible bug in 2.49 in which the key sliders will not appear on the
Action Editor unless there is at least one window set to Action Editor when the keys are
created. To reveal key sliders for keys that have already been created, save the ﬁle, re-open
it, set one window to ”Action Editor” set the window sub-type to ”Shape Key Editor” then
switch the Lattice ”Relative” setting on and oﬀ (putting the cursor over the Action Editor
window and hitting HOMEKEY will help locate the sliders). Or, by preference, make sure
at least one window is set to ”Action Editor” before creating the keys.
Noob note: I couldn't see the sliders either; then I scrolled up and there they were, oﬀ the
visible portion of the window. However, I had by then change the window type a few times,
so I can't rule out that that did something ﬁrst.

i Information
Applicable Blender version: 2.78
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106.6.1. Creating Shape Keys

Figure 904

The starting point for lattice animation tutorial.

We are going to animate the lattice using Shape Keys. Open a new Blender ﬁle, get rid
of the default cube, and add a new UV Sphere with 32 segments and 32 rings. Then add a
new Lattice and upscale it 2 times so it becomes visible ( S
2KEY
ENTER ). Scaling
the lattice does not have any eﬀect on shape of the sphere until the lattice is deformed.
When adding new objects the 3D Cursor should be in the same spot (centering your cursor
using SHIFT + C is recommended). Consequently the sphere and the lattice will have
the same center. Finally, select the sphere, add a Lattice modiﬁer, and select previously
created lattice as object.
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Figure 905

Setting the lattice parameters.

For the sake of simplicity we will only deform the sphere by making it wider or narrower. To
achieve this, we will need to give our lattice more vertices that can be tweaked by adjusting
the UVW parameters. In the Lattice context
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Figure 906

set the W to 6. Also check the ”Outside” checkbox to have vertices only on the edges
of the lattice cube (again, for the sake of simplicity). Lattice parameters have to be set
before adding any shape keys. You will not be able to change them later.
Before deforming the lattice, add the ”Basis” shape key:
1. Select the lattice.
2. Go to the Lattice Object Data context
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Figure 907
in the Properties window.
3. Under Shape Keys press the ”+” button and the ”Basis” key will appear (note that
the UVW parameters are grayed out now).
The ”Basis” key represents our starting point (shape). When no others shape keys aﬀect
the shape of the lattice (their values are 0), its shape is only governed by the ”Basis” key.
Now let's deform the sphere with additional shape keys to be able to animate the deformation later. The basic procedure is as follows:
1. Have the lattice selected in Object Mode.
2. Add a new shape key by clicking the ”+” button once more. ”Key 1” or similar should
appear in the list. Naturally, you can rename the shape key by double-clicking on its
name and entering a new one.
3. Go to Edit Mode and deform the lattice to your liking. You are editing the shape
key that is currently selected.
4. Go back to Object Mode.
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You have probably noticed that your shape keys appear to have no eﬀect when back in
Object Mode. This is because their values are set to 0 by default. To change how your
sphere really looks, select a shape key you have previously deﬁned in the Lattice context

Figure 908

, and set the ”Value” slider to, for example, 1. If you have multiple shape keys deﬁned,
you may also ”mix” them by setting multiple shape key values to non-zero. There are two
more things to note:
• The ”Basis” key does not have a value. It is a starting point after all.
• In Edit Mode you edit shape keys one by one (separately). You could imagine that the
value of the currently selected shape keys gets set to 1 and all other values are set to 0
while in Edit Mode.
In this example we will create only two shape keys (beside the ”Basis”) and perform two
simple deformations on the lattice (which will consequently deform the sphere, since the
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Lattice modiﬁer is active), which will result in a goblet-like shape. Create a new shape key
”Key 1” before deforming the lattice further. This way you will edit the new key instead
of the ”Basis”. Go to Edit Mode and switch to front orthographic view (keys NUM1 and
NUM5 ). Use Border Select ( B ) to select the top row of lattice vertices and upscale them
in the XY plane (or non-Z directions, use S
SHIFT + Z ). Go back to Object Mode,
create shape key ”Key 2” and, as shown before, downscale the second row of lattice vertices
from the bottom. When back in Object Mode, you can set the value of both shape keys
to 1 and observe the combined deformation of both keys. This will be our ﬁnal shape in
animation.
Note that there is no ”Limit selection to visible” button

Figure 909
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in Edit Mode when editing a lattice. When using Border Select or similar tool, the vertices
are selected even if they are not visible, so there is no need to switch to wireframe view to
be able to select whole rows in the Front view.

Figure 910

Deﬁning the ﬁrst shape key.

Figure 911

Deﬁning the second shape key.

Figure 912 The result with both shape
key values set to 1.
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106.6.2. Animating Shape Key Values

Figure 913 Shape Key Editor context of Dope Editor (above) and Graph Editor
(below). Screenshot does not correspond to the tutorial.

Figure 914 The ”Animation” layout. Dope Sheet context is set to ”Shape Key Editor”
and shape key values are visible in the Dope Sheet Summary.
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In previous steps we have created our objects, added a Lattice modiﬁer, and deﬁned the
shape keys. This is all we need to proceed to shape key animation. The concept is very
similar to animation of any other values. We will be, however, using one additional tool.
Folow these steps to set up the interface you will need:
1. Open a new Dope Sheet3

Figure 915
window or, even better, switch your screen layout4 to ”Animation”. Examples use the
latter method.
2. In the Object Mode of 3D View select the lattice object.
3. Switch the context of the Dope Sheet window to ”Shape Key Editor” using the
box in the window's header. Your shape keys should show up in the Dope Sheet
Summary.

3
4

Chapter 103 on page 965
Chapter 13.10 on page 81
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Shape key values have grey background. This means they are not animated (yet). We
will make the sphere deform from its original shape (”Base” key) to the goblet-like shape
(inﬂuenced by ”Key 1” and ”Key 2”). Before going forward with examples, we will learn the
basic keyframing procedure for shape key values.
1. Set the frame number. Either position the green bar cursor in the Dope Sheet to
the desired frame using LMB , or use controls in the Timeline window

Figure 916
. For more information about frames see Basic Animation5 .
2. Change the shape key values in the Dope Sheet Summary either by pressing LMB
and dragging, or clicking on the slider and typing the desired value. Notice that
Blender inserts a keyframe for changed values as soon as you do (indicated by yellow
diamonds in the Dope Sheet). Keyframed values should change their background

5

Chapter 100 on page 955
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colour to yellow (means that the value is keyframed in the currently selected frame)
or green (means that the value is keyframed in some other frame).
3. Once the keyframes are added, values of keyframed shape keys will be shown in the
Graph Editor6

Figure 917
as well, allowing you to ﬁne-tune them to your liking using F-Curves.
Alternative method is to insert keyframes in the Lattice Object Data context

6

Chapter 104 on page 971
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Figure 918

. Select a Shape Key and adjust its value using the slider below. Then
and select ”Insert Keyframe”.

RMB

the slider

Now let's animate the sphere using this procedure. Make sure you see the Shape Key Editor
context of the Dope Sheet and have your lattice selected in Object Mode of the 3D View.
Shape keys should be shown in the Dope Sheet Summary. Set your frame to 1. This is
the ﬁrst frame of our animation (indicated by the ”Start” ﬁeld in the Timeline). In the
Dope Sheet Summary set both shape keys values to 0 (note the diamonds -- keyframes -appearing). This means that in frame 1 our sphere will be shaped only by the ”Basis” key.
Go to frame 10 and set the value of ”Key 1” to 1. The following will cause the top of our
sphere to deform during frames from 1 to 10. Do not forget to insert a keyframe for ”Key
2” (value 0) at frame 10. To do this just set the value to 0 again or RMB → Insert
Keyframe. Dope Sheet should show an orange line connecting the two diamonds, showing
that values in these keyframes are the same (nothing is happening with this shape key).
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If you do not add this keyframe, the bottom will start deforming at the beginning of the
animation. Meanwhile you may use the mouse wheel or drag the ends (dots) of the sliders
in the Dope Sheet and Graph Editor windows to zoom in the view. Go to frame 20 and
set the value of ”Key 2” to 1. Similarly, this will cause the bottom of the sphere to deform
during frames from 10 to 20 while the top is already deformed. Finally, set the ”End” ﬁeld in
the Timeline to 30, which will stop our animation at frame 30. Feel free to play your new
animation using controls in the Timeline. Also feel free to add additional keyframes and
tune the transitions to your liking in the Graph Editor. In addition, you might want to try
scaling, moving, and rotating the deformed lattice (the situation at frame 30 for instance)
in Object Mode of the 3D View to see what happens to the sphere.

Figure 919

Frame 1

Figure 920

Frame 10

Figure 921

Frame 20

106.7. Let the fun begin!
Now you have your object safely locked away inside your Lattice, you can still animate the
object itself, inside the Lattice!
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106.7.1. Why would I animate the object too?
Take the case of the classic cartoon eyeball which is taller than it is wide. If you just
stretched the sphere object itself, instead of using a Lattice to deform it, then you couldn't
properly rotate the eyeballs to look up and down because the whole ”egg-shaped” eyeball
would rotate and end up lying on its front or back. The eyes would literally pop-out of the
head.

Figure 922

Cartoon eyes: The stretched spheres don't rotate properly.
If, however, you use a Lattice to deform the basic sphere to make it into a tall ”egg” shape,
you can still select the eyeball itself and animate it within the Lattice. Now when you rotate
the eyeball, it will look up and down but still maintain its deformed shape within the head.

Figure 923

Cartoon eyes: Spheres deformed with Lattice can still be rotated with good results.
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107. Bouncing Ball with Lattice
i Information
Applicable Blender version: 2.49

107.1. How to make a ball bounce convincingly!
This tutorial assumes basic Blender awareness and some knowledge of using
Blender Lattices as well as keyframes basics regarding the Blender Panels.
Knowledge of IPO curves will prove useful later as we progress to more advanced techniques.

107.2. How hard can it be to move a ball?
It would be easy to just put a sphere on the screen and animate it to move up and down
but in all honesty, it would not look like a bouncing ball. It would not be convincing in any
way.
To be believable, the ball must use some of the most fundamental principles of good animation. In particular, the ball must squash and stretch and change speed as it falls, hits
the ﬂoor, bounces and rises ready to fall again. With a little eﬀort we can make that boring
sphere look alive!

107.3. Why use a lattice?
It is possible to make a simple bouncing ball animation without using a Lattice object but
with the Lattice we can do more than just bounce the ball. For example, once we have a
ball that bounces how we'd like it, we can later add rotation to the ball so it spins through
the air and bounces then, as the bounces decrease, the ball can roll to a halt. Doing this
without lattice would be a far more complex exercise as a rotating squashed and stretched
sphere would look like it was wobbling in space (like having the ﬂat part of a ﬂat tire spin
around the tire instead of staying on the bottom, even while the wheel is turning).
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107.4. Let's begin then
To begin, add a UVSphere (SPACE add>mesh>UVShere) in Top View (NUM7). It is
important to add the objects in top view to keep their Z-Axis aligned upwards. Set Smooth
and Sub-surf on the sphere if desired. Tab back into Object Mode then immediately add
a Lattice(SPACE add>Lattice). Resize (SKEY) it so it closely surrounds the sphere. Make
the edges of the lattice align with the circumference of the sphere as this will make animation
easier.
(By default the Lattice Object Name is ”Lattice”. It is good to give all your objects unique
and sensible names, especially if you are planning a complex scene. So you might call the
Sphere ”Red_Ball” and the Lattice ”Red_Ball_Latt” or something similar for easy reference
and recognition later.) (Noob Tip: I have formed the habit of naming everything in ALL
CAPS. As the scene gets more complicated I can easily keep track of what I have named
and what needs naming.)

Figure 924

Top view of UV-Sphere inside selected Lattice
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107.4.1. Make the lattice deform the sphere
Prior to Blender 2.4, objects were parented to Lattices with a Lattice Deform option. In
version 2.4+ you can select the object (the sphere) and apply a Lattice Modiﬁer to it (Ob:
Lattice). However, if you use this new method then the ball will not move where the Lattice
moves and will not squash when the Lattice squashes and we want it to do both of these
things.
Luckily you can still use the good old Parent option then use the Modiﬁer palette to make
the Lattice Deform ”Real” . So select the sphere and THEN SHIFT SELECT the Lattice
then CTRL-P to make parent and choose the ”Lattice Deform” option. If you now select
just the sphere, press F9 and look in the Modiﬁers palette, you'll see a listing for ”Lattice
parent deform” with a button for ”Make Real”. You can either ignore this button or
press it. It really won't matter for now. If we wanted to do some weird things to our ball,
like kicking it or deforming it in other complicated ways, then we would have to use the
”real” Lattice modiﬁer option.
So, this may not be the purist approach to using a Lattice but it is a convenient way to
achieve the results we're after. Basically, it works and is reasonably intuitive.

Figure 925

Lattice Modiﬁer screen using parenting option.

1015

Bouncing Ball with Lattice

Figure 926

If you press ”Make Real” you enable the full Lattice Modiﬁer

i Information
Applicable Blender version: 2.69
(None of this seems to be necessary in later versions. The full Lattice screen comes up as
soon as you Parent it.)
You can easily check if the Lattice is working the way we want it to by selecting the Lattice
and resizing, moving or rotating it. The ball should do everything the Lattice does. I
don't wish this to be a full lesson in Lattices so if you don't understand any of the above,
or you're certain your Lattice is not working as it should, then please learn a bit about
lattices1 before proceeding.

107.4.2. Time to animate!
For our basic animation, we'll use just 23 frames starting with the ball high then falling,
squashing, bouncing and ending up back where it started. When this is played back in the
3D window, it will loop and we'll see the ball bounce forever in one place.
This part is easier done in ”SCR:1 - Animation” Viewport conﬁguration. It is also useful
to have multiple orthographic views open in the viewport by right clicking on the resize
viewport arrow and choosing ”split area” then making a top view, side, etc...
1

Chapter 106 on page 985
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Let's begin then
Go to Front View (Num1) Press F10 and set your start (Sta) frame to Frame 1 and your
end frame to Frame 23. Then make sure you're on Frame 1 (Shift+Left Arrow) to start
animating. Note that we are animating the Lattice, not the ball. Everything we do to
the lattice will directly aﬀect the ball too.
Note: all the modiﬁcations to the lattice must be done in 'Object' mode. If not, they will
aﬀect all the frames.
Select the Lattice (NOT the ball) then do the following on the corresponding frames:
• FRAME 1: Press IKEY and set a key for LocRotScale - the ball's start position (high).
• FRAME 11: Move the Lattice to ground level and key LocRotScale again (keep the fall
distance small for now).
• FRAME 13: Leave Lattice in same position as frame 11 and key LocRotScale again.
• FRAME 23: Move Lattice back to start position (use Num (N) Panel if you need to)and
key LocRotScale again.
(Noob note- This may seem obvious, but move the lattice BEFORE you insert the
keyframe.)
These four frames give a basic up and down animation with a pause at the bottom. We
can add squash on Frame 12 to ﬁnish oﬀ.
• FRAME 12: Place the cursor at the base of the Lattice then set the Rotation/Scaling
Pivot to ”3D Cursor”

Figure 927
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Scale the Lattice down along the Z-Axis SKEY-ZKEY and see the ball squash.
IKey LocRotScale again.
When you have set all ﬁve keys, you can cycle through the frames and you should see the
following result on the Key frames we just set.

Figure 928

Screenshots of the 3D window, front view, on each of our ﬁve key frames.
If you press Alt-A now in the 3D window, you should see the ball bounce. Even though
the squash happens on just one frame, it still reads properly in our minds and is a vast
improvement over an animation with no squash at all. (Press RMB or ESC to stop the
animation playback).
If you have a camera and lighting suitably set up you could render the animation out and
use Blender's ”PLAY” button to loop the rendered animation. See the bottom of the page
for an OpenGL render made from the steps above. Add material to the ball and a ground
plane for a more interesting result.

107.4.3. Looking at the IPO Curves
If you want the ball to bounce three times then you could repeat the above instructions
three times over - if you have the patience - but Blender has a better, easier way.
Select the Lattice then open up an IPO (InterPOlation) window and zoom into the group
of keys. If you select LocZ and SizeZ from the channel list on the right, you should see
something like this (I've added labels to the screenshot):
Note the IPO Type here is ”Object”. Purists may be disturbed or perplexed by this but if you
remember, we're not really using our Lattice in the purist, Lattice Modiﬁer form. Don't
worry about it though. It works.
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Figure 929

IPO curve for Lattice, showing LocZ and SizeZ channels.
This shows the relative position on the Z-Axis and size in the Z-Axis of the Lattice. You
can see that the Size remains constant until frame 11, then reduces, then goes back and
remains constant until frame 23. Similarly, the LocZ curve shows how the ball starts high,
falls then stops before rising again. The rounded bottom of the LocZ curve occurs because
the IPO curve maps the centre point of the Lattice and when we squash it, the centre point
lowers slightly.
Of special interest is that by default, Blender uses Bézier curves for IPOs and this gives us
rounded tops on the curve. This means the ball starts moving slowly downward then moves
faster until the reaches the bottom. Also, as it nears the top, it slows down again. This is
good because this is exactly what happens in reality when a ball rises and falls (It could be
better - but it's a good start).
While in the IPO window, select both curves then press KKEY and you'll see each key
frame indicated by a vertical line. (Note: You can also press View->Show Keys if you can't
remember this shortcut - this has helped me in the past.)
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Figure 930

IPO window set to show key frames
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Figure 931

Bouncing ball animated GIF

Press AKEY to select all key frames then duplicate (Shift-D) them. The curves will seem
to deform but when you drag the frames to the right, they will sort themselves out. Position
them so the ”ﬁrst” frame is at Frame 24 and the new end frame is now Frame 46. Reset
the End Frame in the Scene (F10) window then watch the animation again. It's not bad.
You can repeat this process for more bounces. (To have it bounce forever throughout a
long animation, ignore the above procedure and just set the ”Extend Mode” to ”Cyclic” in
the Curve menu. You'll have to adjust the curve a little on the ﬁrst and last frame but you
only do it once and Blender repeats the change for all other cycles.)
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i Information
Applicable Blender version: 2.69
Noob Note: Instead of IPO window, go to Graph Editor. I was not able to ﬁnd any way
to get yellow lines at each Keyframe, as above, but using A put Bezier handles at each
keyframe. I need to experiment to ﬁnd out how to use them. SHIFT D worked as above.
It's not bad for a start but there's a lot more to do to this ball before applying for that
animation job.
Note: In newer versions of Blender, you can go to Graph Editor, Select all graphs with
AKEY, and select Channel-Extrapolation Mode-Make Cyclic. This will extrapolate the
existing graphs to cover the total frames.

107.5. Saving The Animation
How do you tell Blender where to save the animated frames? The answer is in the “Output”
mini-window that you see in the Render settings (F10). Near the top of this are two
editable text ﬁelds, the ﬁrst of which is initially set on my Linux system to “/tmp/” and
the second to “//backbuf”. The ﬁrst one is the output pathname or directory preﬁx used
to save the generated frames as JPEG ﬁles when you press the “ANIM” button. If it has no
“#” characters in it, then it is used as a directory preﬁx; thus, the default will be to save
the animation frames as /tmp/0001.jpg, /tmp/0002.jpg etc. Alternative, if you put in a
ﬁlename spec with “#” characters in it, the hashes will be replaced with the frame number.
Thus, if I set the ﬁeld to “/home/ldo/Documents/BlenderTuts/ball####.jpeg”, then the
frames will be saved to that /home/ldo/Documents/BlenderTuts directory and be named
ball0001.jpeg, ball0002.jpeg etc.

107.6. So what next?
In real life and in a typical cartoon, balls don't just bounce forever in one spot. They move
along and slowly lose their bounce before rolling to a halt. And they have more character
than our bouncing ball.
Things to consider next:
•
•
•
•
•
•

Perfecting the squash - maintaining volume
Adding stretch
Look at acceleration and deceleration
Rotate the ball as it bounces
Reduce the bounce height over time
Move the ball around as it bounces
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Links
See this ANIMATION LINK2 (580kb, AVI-DivX) for an idea of how you can achieve interesting results with just a little more eﬀort. but its k? k

107.7. Links
Principles of bouncing ball animation: http://www.idleworm.com/how/anm/01b/bball.
shtml
Blender 2.49B bouncing ball animation: http://www.youtube.com/watch?v=BEY_6dFdUJY
Blender 2.49B vector blur animation, to add realism to your animations: http://www.
youtube.com/watch?v=qY4WcNgEXv8

2

http://members.westnet.com.au/andydolphin/blender/bounce.avi
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108. Creating Basic Water Animation
i Information
Applicable Blender version: 2.76

Figure 932

A low resolution, high viscosity ﬂuid test

108.1. Water and Other Fluids
Water is without a doubt one of the most important compounds in our lives; It covers about
75% of the earth and is therefore incredibly important in quite a few Blender animations.
Wouldn't it be great if we could get an accurate physical representation of this liquid in
Blender? We can, using a tool called Fluid Simulation. This tool looks unnervingly complex
at ﬁrst glance, but this tutorial should clear it up for you. At least to a basic level.
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108.2. The Domain
One can imagine how much time it would take Blender3D to think about everything in the
inﬁnite space of a 3D world in terms of ﬂuid objects and deﬂection, so we obviously need to
cut down on that size. Create a fairly large cube. This will eventually be set as the volume
in which all of the ﬂuid simulation occurs. Don't make it too large, but not too small either,
let's say 10 times bigger. With this cube selected, go to to the Physics context

Figure 933

of the Properties window. Find the button that says ”Fluid”, and click the ”Fluid” button
to enable the function. Set type to ”Domain”. All the ﬂuid physics will be calculated inside
this cube. Also in that tab, you'll see 3 sub-sections, ”Fluid World”, ”Fluid Boundary” and
”Fluid Particles”. Each one opens a diﬀerent set of settings. These will be explained as they
become important.
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The Fluid
Under ”Time” you can adjust how many seconds the ﬂuid animation will take. Due to this
you should change the ”End” frame to ”96”, under the ”Timeline”, because the standard
setting is ”4”. You can also change it how you like.
To make the other objects go into the ”Wireframe” viewport.

Figure 934

Domain

108.3. The Fluid
As a basic start up for your experiments with ﬂuid simulation, I am going to take you
through a small demo in which we drop an object into a pool of water, creating a splash.
To do this, we need a ﬂuid object and an obstacle object. For the ﬂuid, create another
cube, scaled down to cover the bottom of your domain. Make a rectangle, that hovers just
inside the domain and is half as high as the domain. Enable this object in ﬂuid simulation
also and set type to ”ﬂuid”. When we start to bake the ﬂuids, this will be set up as your
liquid.
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Let us go over what you have now. You have your starting cube, with ﬂuid physics and
type ”domain”, and will be referred to as ”Domain”. Inside this is the rectangle that will
cover the bottom of your Domain , which is the liquid. The liquid will be a diﬀerent object
with the type ”Fluid”.

Figure 935

Fluid

108.4. The Obstacle
Create a third object which we will call ”Obstacle”. This will be the object dropped into
the water, and will be described further in the explanation. Give it an IPO/Animation to
drop into the water, and enable it as --you guessed it-- an obstacle (click the ”ﬂuid” button,
in physics, and set type to ”obstacle”).
Set up the animation in the front/side views, not the top view. The z-axis is where gravity
works.
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Figure 936

Obstacle

108.5. Baking Fluids
Now we get to see what it all looks like. Select the domain object, and ﬁnd the big button
that says ”BAKE” under ”Physics” - ”Fluid”. If you want to use a bake again, don't choose
a temporary location, otherwise you'll have to bake it all over again. Press it. Be patient,
blender has to bake this simulation, something like it would render the ﬁnal product. The
loading bar of this baking will stay in the bar at the top of the screen with the blender logo.
If at any time you feel that you want to abort this process, press ”Esc”. Once the bake is
ﬁnished, click under the ”Timeline” on the play button. You should be able to view the full
simulation.
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Figure 937

Bake

108.6. Finishing touch
Blender will make your water its default opaque grey, unless you set its color. A good way
to make realistic, clear water (as well as glass for that matter) is to edit the color, then
apply a simple mirror eﬀect plus transparency eﬀect. After your water has rendered, select
the domain in object mode. This selects the liquid in the frame you have just added. in
the ”Materials” tab (if when you click on this, the colors settings are not up, just press add
new under the only panel there). Go to the ”Mirror” section, play around with the settings
until you get what you fancy. Suitable settings include Reﬂectivity to 0.1 for water, 0.15
for glass, set depth to 7; Under the Transparency section, click on Raytrace and set IOR
to 1.3 for water, 1.5 for glass; Then set the Alpha value to 0.1 while adding an appropriate
color under the ”Diﬀuse” section, like: ”6279E7”. I should do the same for the ”Fluid”
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Figure 938

Simulation

108.7. Other Fluid Objects
There are other incredibly useful types of ﬂuid objects like ”inﬂow” and ”outﬂow”. The both
of these do exactly what they sound like. Inﬂow objects pour more ﬂuid into the scene, and
outﬂow objects drain it away.
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109. Flying Through a Canyon
i Information
Applicable Blender version: 2.76

109.1. Creating the Canyon
109.1.1. Forming from Textures
1. Open up a new Blender ﬁle and erase the default cube with X
2. Add a grid and change the subdivisions to 100 for both X and Y.
1. Scale the canyon up to 5 times its current size
(Do this by either hitting S and typing in 5, or hitting
snap and scale your mesh 5 times.

S

while holding

CTRL

to

At this point your mesh should look like something like the picture below.
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Figure 939

109.1.2. Texturing, Shading, and Deforming Your Mesh
• Go to the Texture tab next to the Materials, and click New.
• This texture will be used to create our canyon, so give it an appropriate name. In this
tutorial, ”Canyon” was used.
• Select the Texture Type to be Wood
• If there is a Checkbox next to ”Canyon” in the Texture tab, uncheck it.
We will now displace the vertices based on the texture.
• Click on the Modiﬁers tab on the Properties panel (spanner icon).
• Click the Add Modiﬁer pop-up menu and select ”Displace”.
• Select your ”Canyon” texture for the displacement.
• Go into Object Mode. Notice that the vertices have been displaced! (To see the results
better, make sure you're in Solid Mode) However, the material is very jagged. This
is because Blender is preserving the original faces on the underlying material, and the
original faces don't run in the same direction as the grooves the wood material has
created.
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Noob Note: This will also work with an image texture, i.e. using an image as a texture.
Tested using NASA's Blue marble topographic pictures. Go to the end of this tutorial for
additional projects.
Your Mesh should now look something like the picture below.

Figure 940

109.1.3. Improving the Look
Now to make the canyon more interesting:
• Go back to the textures tab, under the Wood tab deselect Bands and select RingNoise.
Keep the default options for the moment.
• You will now see a ”rippling” texture. But it isn't a canyon yet.
Note: If you go into Edit mode (Tab), and select all vertices, then scale to 0.2 of the original
size. after this should leave Edit Mode into Object Mode, and scale the Object (as a whole)
up to 10.0 of the size. What will occur is that you'll pack the vertices closer to each other,
but not the texture. Then, you would have taken the object as a whole (including the
Texture) and up-scaled it. This is the diﬀerence between Scale in Edit Mode and Scale in
Object Mode. Don't do it!
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• You should now have a semi-boring canyon, but it does have circuits which the camera
can ﬂoat around in.
• To make the Canyon more interesting, play around with the Texture values for Wood.
I chose the values Noise Size: 1.0 and Turbulence: 15.00 as they produced a somewhat
interesting outer ring.
• You may also want to play around the Deform modiﬁer settings, especially Strength which
changes the strength of the deformations.
• When you are happy with your mesh, press the Apply button under the Deform modiﬁer.
• The displacements are now permanently baked into the Mesh, and the result should
be something like the picture below.

Figure 941

109.1.4. Eliminating the Unneeded
• We will now reduce the number of vertices. Go into Modiﬁers, and add Decimate. The
mesh will appear to change slightly, but it hasn't, except that 4-vertices faces have been
triangulated
• Add another Modifer, Sub Surf, and make sure that the Levels is just 1
• Under the Decimate, slowly reduce the ratio and watch the Mesh. Very tiny mesh details
will be changed but the Decimate modiﬁer will keep the shape while reducing vertices.
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• I got to 0.07 on my mesh before I decided the detail was getting too low. Remember you
will be ﬂying through the canyon, not over it, so the detail on the walls of the canyon is
more important.
• Hit apply to bake the reduced vertice count into the Mesh. Smaller vertice counts will
make rendering faster.
• Increase the number of levels on your Sub Surf modifer and take a good look, you have just
created a canyon! You may reduce the levels or remove the Sub Surf entirely afterwards.

Figure 942

109.2. Coloring the Canyon
109.2.1. A Rocky Material
This is one method to create a rocky wall. The result isn't particularly realistic but it is
easy to make. Creating materials is a diﬃcult practice, and the ﬁrst step is to know what
you're trying to recreate, perhaps by using actual photographs.
• Create a new material for the cliﬀ
• In the Specular panel under the Materials tab, set the Intensity value to 0.132 (our cliﬀ
isn't particularly shiny) and Hardness to 20.
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• Under the Textures tab, add a new texture in the ﬁrst slot.
• Give this texture the Marble texture type. Under the Marble options, select Hard and
set the Noise Depth to 1 and Turbulence to 1.7.
• Under the Colors tab, activate Ramp. The ﬁrst colorstop should be white with an
alpha of 0, leave the second as it is.
• This is meant to give our primitive rock a textured appearance
• In the second texture slot, add another texture.
• Set this type to Clouds, under the Mapping options set the X, Y, and Z sizes to .025,
under the cloud options select a noise depth of 2 and activate Hard Noise.
• This one will recreate some bumpiness and small inconsistencies in the rock
• In the third slot, add another texture
• Set the type to Clouds
• In the Colors tab, modify the colors to go from Black, 0 Alpha, to a Brown of your
choosing, 0.750 Alpha. Reposition the second color to Pos 0.820
• This Texture will simulate dirt on the Canyon
• You will deﬁnitely want to do a render now. Reposition the camera and lights, and adjust
render options to make for a fast render
• Go into Materials, then the textures tab and select the ﬁrst Clouds texture you entered
(should be 3rd on the list if you did not delete the Wood texture used earlier).
• With that selected, under the inﬂuence section, uncheck the Color, and check normal.
Set the Normal value to 2.0.
• What we have just done is set the second texture not to aﬀect color, but to aﬀect the
angle of the normal in a render. This can be used to reproduce jagged edges on ﬂat
surfaces, or waves in water
• Now, select the Marble texture again. Under the Map Input, adjust the sizeX, sizeY, and
sizeZ values to 5.0.
• Change the Z size under mapping to 5.0 from the second cloud texture.
• You will want to render here, adjust the values as desired. For more layers vertically,
increase the sizeZ value
• You should now have an unrealistic, but sort of rocky Canyon wall.

109.2.2. Lighting the cliﬀ
• Remove all existing lights
• Creating a new light with the type of ”Hemi”. Center it over our cliﬀs, and use Scale (s)
to scale it down.
• Create another light, with the type of ”Sun”. Position it where you want (position doesn't
matter with Sun), and use Rotate (r) to position its Ray at the Angle you desire.
• In this example, the Sun was more of an evening Sun. Its light is at a 45 degree angle
on one side. This creates some Canyon walls light, some dark.
• Position your camera and adjust the Energy values of your Hemi and your Sun. The
Hemi will light up everything, its an easy way to give light to canyon walls that would
otherwise be completely black. As a starting point, set your Hemi value at 0.4 and your
Sun value at 1.5 and observe how that looks from a few angles. Make adjustments if you
desire.
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• Finally change for all the three textures the Mapping - Coordinates to ”Generated” in
stead of ”UV”

Figure 943

109.3. Guide the camera through the canyon
The last step is to guide the camera through the canyon.
1.
2.
3.
4.
5.

Click on the camera in the Outliner.
Click on Num0 and zoom a bit, then lock camera to view.
Go to keyframe 1 and set a locrotscale keyframe.
Click on the red dot under the Timeline, which will keyframe every movement.
For simple keyframing set the Framerate to 8 FPS and set the End frame on ”1000”
then hit the play button under the Timeline.
6. Now ﬂy with shift+F through the canyon.
7. After this set the frame rate back at 24 FPS and watch and see your beautiful simulation, which will possibly take too long to render.
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109.4. Additional projects
1. Using NASA's topographic image map at http://earthobservatory.nasa.gov/
Features/BlueMarble/BlueMarble_2002.php
You have the option of selecting a small portion of your selected topographic map or you
can map the entire 360x180 degree panoramic map onto a sphere. Refer to UV Mapping
tutorial.
If you just select a small portion of the map of the world(cropping), note the resolution of
your cropped image. Create a basic plane and do not scale it yet. Sub divide as many as
required to match the resolution of your image. This is in order to get the most out of the
topographic image. If you don't bother, this is not essential.
Then apply the texture. Choose texture of type ”image” and do not disable this texture.
NASA's topographic pictures also come in a colourful form but shaded to indicate heights.
The reason why you leave the scaling to the last is that the texture is set to map onto the
basic plane size of 2x2 units. If you increase this, the textures will be repeated. Adjust the
strength level to a suitable level. The default 1 is too large.
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110. Using the Sequencer to Compile
Frames into an Animation
i Information
Applicable Blender version: 2.76

110.1. Preamble
When you render an animation, often it's a good idea to render the individual frames and
then compile them into the animation. This has several beneﬁts over rendering directly to
a movie ﬁle. Some of them are these:
• • If you discover a mistake in the render, you can modify sections of the animation and
rerender those frames without having to rerender the whole animation.
• If the render crashes because the power went out or, (psst), blender crashed, you can
pick up the render at the last rendered frame without having to rerender the whole
animation

110.2. Tutorial
• Open your animation in blender
Begin by opening blender to an animation that is ready to be rendered.
• If you don't have one and don't want to wait to long, just download the demo ﬁle from
blender.org For You1
• The output format should stay PNG. Though you can use any image format you want, I
recommend PNG because it is lossless format.
• Set the ﬁle output location.
Set the location on your ﬁle system where you want all the frames to be saved to.
• Set Endframe to match the animation
If you animated 500 frames, set the end frame to that same number. the default is 250.
• Render the animation!

1

http://download.blender.org/demo/test/ForYou.blend

1041

Using the Sequencer to Compile Frames into an Animation
Simply press the ”Render” button under the render tab.
• For ”For You”, you only need to click Num0 and go to ”Render” in the menu bar. Then
click on ”OpenGL Render Animation”. For exercise, 100 frames must be enough.

110.3. Use the Sequencer to compile the images into a
movie ﬁle
• Open a new blender and delete everything except the camera.
• Change the 3d window into the ”Video Sequencer Editor” window.

Figure 944

video Sequence Editor

• Add the images to the sequencer.
On the bottom of the sequencer window click Add>>Image then browse to the location
where you saved the images, Press A to select all the images and ﬁnally press “Add Image
Strip” on the top-right.

1042
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• Set ﬁnal movie format.
• Set the location that the movie will be saved to by changing the output path.

Figure 945

Format

• Change the End Frame.
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Figure 946

Ready for Render

• Render!
Just Press the Render ”Animation” button and wait a few seconds till it's done. Browse to
the location you saved your movie and enjoy the animation.
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111. Further Rendering Options
i Information
Applicable Blender version: 2.68
In previous units on renderer settings, you learned about
• Basic settings1 , and
• Animation rendering2 .
Here we will describe some more renderer settings that can be useful in certain circumstances.

1
2

Chapter 24 on page 189
Chapter 105 on page 979
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111.1. Stamping

Figure 947

The “Stamp” panel in the Render
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Figure 948

context provides options for placing descriptive text on top of each rendered frame. The
topmost checkbox enables/disables stamping (oﬀ by default), while the other checkboxes
control the precise information to include, and you can even specify the text and background
colour and font size. The information is inserted at the corners of the image, so it can be
included in production renders that get appropriately cropped as part of the post-production
process. Note: In blender 2.76, you'll ﬁnd it under Metadata. You'll have to check Stamp
Output.
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111.2. Toon Renders

Figure 949

Blender has long had an option for doing simpliﬁed “toon” (cartoon-style outlined) renders.
In the Render

1048

Toon Renders

Figure 950

context, look for the “Post Processing” panel and check the “Edge” box. You will also have
to set up the lighting and materials for your objects to give a more ﬂat-shaded look.
A more powerful set of options for doing this sort of thing is available with Freestyle3 , which
you will learn about later4 .

3
4

Chapter 161 on page 1439
Chapter 153 on page 1345
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111.3. Clay Renders
There is sometimes a need to render a scene without detailed materials and textures, just
to see what the object shapes look like. In the Render Layers

Figure 951

context, there is an option to override all lighting and materials for objects in the layer
with a particular light group and a particular material. It is common to use a plain diﬀuse,
colourless grey material for this purpose, making all the objects look like they are made out
of clay, hence the name.

111.4. Transparent Backgrounds
Blender by default provides a “sky” or background for your rendered scene; settings for this
can be controlled in the World
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Figure 952
context.
Sometimes you don’t want such a background at all; you simply want the objects in your
scene set against a transparent background. So, for example, if you insert the image in a
Web page, the scene is displayed against the page background, rather than its own image
background.
The way to do this is quite simple:
• Choose to render the Sky as Transparent. In the Render

1051

Further Rendering Options

Figure 953
context, look for the Shading panel, where there is a popup menu labelled “Alpha:”, with
items “Sky” and “Transparent”. Change this from its default “Sky” to “Transparent”. You
have to do this before rendering the image.
• When saving the rendered image, choose a ﬁle format (in the Output panel in the Render
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Figure 954
context) that includes an alpha channel5 ; for example, PNG allows for this, but JPEG
does not. With such a format chosen, you further have to remember to select the “RGBA”
button, not “RGB”, otherwise the transparent areas will simply be ﬁlled with black.
Note:
If you are not sure which formats support alpha channels: the formats which
do not support alpha channels will not show the “RGBA” button.

5

https://en.wikipedia.org/wiki/Alpha%20channel
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112. Overview
i Information
Applicable Blender version: 2.66

112.1. Introduction
Particle systems are used to simulate large amounts of small moving objects, creating phenomena of higher order like ﬁre, dust, clouds, smoke, or fur, grass and other strand based
objects. You may also use other objects as a visualization of particles.
Before you start with the tutorials, you should at least take a brief overview about the very
extensive documentation pages1 of the particle system. You will ﬁnd every single parameter
explained in the manual if you have the desire to delve deeper ...
Don't forget: particles alone don't do any magic. They are only a placeholder for something
nice to view. You have to take care of the visualization also, and that is usually the harder
part than to create the particle system.

1

http://www.blender.org/manual/physics/particles/index.html
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112.2. The very ﬁrst particle system
112.2.1. Creating a particle system

Figure 955

1056

Image 1a: Where to create a new particle system

The very ﬁrst particle system

Figure 956

Image 1b: The very ﬁrst particle system

To create a particle system:
• Create a mesh object to be the “parent” (source) of the particles (only mesh objects can
emit particles). Let’s use a simple plane to start with.
• select the object
• change to the Particles
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Figure 957
tab in the Object Properties window
• click on the “+” button (Image. 1a)
Voila, your ﬁrst particle system (Image. 1b)! It doesn't do anything useful now, but we're
going to change that on the following pages.
• To see the particles, you must start the animation running by pressing ALT + A . You
will see particles appear and fall from the plane. Press ESC to stop the animation;
you return to frame 1. The particle movement is cached (stored), so if you play your
animation again it will go faster (well, you won't notice any diﬀerence in this simple
case).
• If you want to stop the animation in the current frame, press ALT + A while it is
running instead of ESC .
• The shortcut for returning to the ﬁrst frame is SHIFT + ← )
• To see the particles even better change to wireframe mode ( Z ),
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If you change anything in your particle system you always have to return to frame 1, to
recalculate the system from the start.
Use the timeline window along the bottom of the screen to change easily between frames.
Note:
Ultra Physics Coolness:
While the animation is running, you can move the objects in the 3D window and the
particle system is updated in realtime. The system is not cached then.
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112.2.2. Changing properties of the system

Figure 958

Image 2a: Particles emitted in the direction of the face normal of the plane

Some important settings, from the “Emission” panel:
• Number: the total number of particles; increase this to 5000
• Start: and End: the start and end frame of the emission
• Lifetime: the lifetime in frames of the particles
And in the “Velocity” panel are settings that combine to determine the initial velocity of
the particles:
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•
•
•
•
•

Normal: a velocity component in the direction of the face normal (if emitted from faces)
Tangent: a velocity component parallel to the face
Rotation: controls the direction of the tangent velocity component
Emitter Object X/Y/Z: a velocity component oriented in the object’s coordinate system
Object: a multiplier that imparts some proportion of the object velocity to the particles
(try moving the object around with a nonzero value for this ﬁeld to see its eﬀect)
• Random: a random contribution to the object velocity
Initially, the plane has its face normal oriented upwards. However, it probably looks like
the particles are emitted downwards. This is because the initial normal velocity of 1.0 is
quite small compared to the force of gravity (which is on by default). Try increasing it to
something like 10.0, and when you rerun the animation, you should see the particles rise
quite high above the plane before falling down again.
If you render a frame with particles showing, you will see the particles appear as white
blobs. This is the default Halo rendering of the particles.
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112.2.3. Changing the material of the particles

Figure 959

Image 3a: The ﬁrst simple Halo material.

• Switch the Properties window to the Materials
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The very ﬁrst particle system

Figure 960
tab and create a new material for the plane.
• Change the material type to Halo. (see also the Manual on Halos2 ). Halos are a post
rendering eﬀect, that is applied after the scene is ﬁnished. So halos can't shed any lights
on other objects, they are not rendered behind RayTransp materials (like glass).

2

http://wiki.blender.org/index.php/Doc:2.6/Manual/Materials/Special_Effects/Halos
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Figure 961

•
•
•
•

Image 3b: Our ﬁrst particle system rendered in frame 68

Set the color to deep blue (RGB: 0/0/1)
Size: 0.05 so each halo is quite small.
Hardness: 127 so that each halo has the maximum sharp edge
Add: 0.5 so that the brightness increases where several halos overlap

Set the world color to black and render (Img. 3b). Nothing special till now, but that will
change soon. So proceed to the next page, where we're going to make some ﬁre.
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i Information
Applicable Blender version: 2.48a

Figure 962

Figure 1: My idea of particle ﬁre.
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We're going to create a camp ﬁre with a simple particle system. This tutorial is based
on the method described in the Blender Manual1 . The result of this tutorial is shown in
Fig. 1, the Blend-File is included at the bottom of this page.
If you need more realistic looking ﬁre, you should use the method described in BlenderArt
Magazine No. 162 , though that method is more advanced and uses Compositing Nodes
heavily.
The starting point of the tutorial is how ﬁre behaves physically. The ﬂames are made of hot
gases. These accelerate upwards due to their lower density in contrast to the cooler air in
the environment. Flames are in the middle hot and bright, to the outside they are darker.

113.1. The particle system

Figure 963

Figure 2a: A simple scene

I've created the usual scene with some stones and a few pieces of wood (the wood is by
courtesy of Teeth). (Fig. 2a).
Noob note: I made the stones by adding an Icosphere of 3 subdivisions, and then used the proportional edit falloﬀ (OKey) with the random falloﬀ mode. And then subdivide and smooth.
Noob note 2: For the wood I used a modiﬁed Plane with an Image texture created with GIMP

• Add a Plane in the middle of the stones.
1
2
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http://wiki.blender.org/index.php/Doc:Manual/Physics/Particles
http://www.blenderart.org/issues/

The particle system
This will become the particle emitter.
• Rename the Plane object to ”Emitter”.
If you use good names you will ﬁnd it much easier to orientate yourself in your scene later.
Having 100 objects named ”Cube.something” will make it very diﬃcult to quickly select a
desired object.
• Subdivide the plane once in Edit mode.
• Change the shape of the plane, so that it's shape equals the base of the ﬁre.
• Change to object mode.

Figure 964

Figure 2b: The particle system

• Change to the Particle buttons of the Object buttons.
• Create a particle systems (Add New in the Particle System panel - and make sure the
plane is selected!).
• Type: Emitter The plane emits the particles.
• Amount: 9000 The total amount of particles.
• Sta: -45 The simulation shall start before the rendering, to have a fully developed ﬂame
in the ﬁrst frame.
• End: 200 The simulation shall last 200 frames - here: the particles are emitted till
frame 200.
• Life: 16.6 I've adjusted the lifetime of the particles to their speed. Both parameters
together regulate the height of the ﬂame.
• Rand: 0.5 The lifetime is changed randomly.
• Emit from:
• Random
• Faces
• Even
• Random
This creates particles with a random distribution on the faces of the emitter object.
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Note:
Please note, that the particle simulation is only fully calculated if the bake parameters
in the Bake panel match the positive lifetime of the particles. If you want to run the
simulation longer than 250 frames, you have to increase the End frame in the Bake panel
as well. This is independent whether you want to bake or not.
The movement of the particles is controlled with particle physics. You set the Initial
Velocity and let the physics do the rest.
• Normal: -0.099 The particles are emitted slightly against the direction of the face normal.
This leads to a bit wider ﬁre at the base.
• Random: 0.014 This creates a random start velocity as well in speed as in direction (you
could use a texture to randomize only the speed, see the discussion page for that).
After you have given the particles an initial velocity they are moved by forces.
• AccZ: 2.57 A force in positive Z direction (upwards).
Note:
As far as I can see AccZ does not exist in later versions(2.69 in my case); the alternative
appears to be to set the Physics to Fluid and set a positive Buoyancy (something around
0.75 looks reasonable).
• Drag: 0.1 Air drag decelerates the particles.
• Brown: 1.99 Random movement simulates agitated air movement.

Figure 965
material

Figure 2c: Particles without

The particle system is ﬁnished. Until now is doesn't look like much (see the white Blob in
Fig. 2c). Therefore the emitter will get a material, this material will be animated.
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113.2. Material

Figure 966

Figure 3a: Material for the emitter object.

• Create a new material for the emitter, call the material Flames.
• Activate the Halo button in the Links and Pipeline panel. Else we couldn't set the particle
parameters. The particles would be rendered with the default Halo values.
• Halo color: 1/0/0 (red)
• Alpha: 0.8 The particles shall always be a bit transparent.
• HaloSize: 0.132 I wanted many, but fairly small particles.
• Hard: 45 The transition from fully transparent to fully opaque.
• Add: 0.875 Several Halos over each other combine their power. This makes the ﬁre in the
center really bright.
• HaloTex: A Halo can bear an individual texture, but only the texture in the ﬁrst texture
slot is evaluated.
To give the Halo a bit more structure, give it a texture:
• Add a new texture in the ﬁrst texture slot.
• Map To:
• Col
• Color: Bright yellow (1/1/0.664)
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Figure 967

Figure 3b: Adjusted texture

• Use an adjusted Clouds texture with a NoiseSize of 0.6.

113.2.1. Animation of the particle material

Figure 968

Figure 3c: Animation of the Alpha value

The particles ”pop” into life and vanish suddenly. We should change that. Therefore we're
going to animate the Alpha value of the particles.
• Make sure the material buttons are visible in the buttons window.
• Change to frame 21, move the mouse cursor over the button window and press I->Alpha.
This is going to be the maximum visibility of the particles.
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• Change to frame 1. Change the Alpha value to 0 and insert the next key.
• Change to frame 100. Change the Alpha value to 0 again and insert the third key.
If you want to see the IPO curve in the IPO Editor window you must change the IPO
Type selector in the window header from Object to Material.
Note:
Note: An animation of particle material is mapped from the ﬁrst 100 frames to the
lifetime of the particles. I.e. if the material is faded out during the ﬁrst 100 frames
(the ipo curve is 100 frames long) the particle will be faded out during it's own lifetime,
no matter how long that is. This holds true however only for Point visualization of
particles, not for object visualization.
The Alpha value therefore changes during the individual lifetime of each particle from 0 to
0.8 and back to 0 (Fig. 3c).
Note:
Note: In Blender 2.6, IPO curves no longer exist. Select the graph editor view to get the
same capabilities. Also note that in the texture settings from the previous section you
need to enable (and set to 1) the Alpha setting in the ”inﬂuence” section, otherwise the
Alpha animation will be applied to the particle system as a whole not to the individual
particles.

113.3. Rendering
Our particle animation is ﬁnished.
• Change the end frame in the Anim panel of the rendering Buttons to 200 and click on
Anim.
Note: If after rendering your particles are too small, such that the ﬁre doesn't
look realistic, try increasing the Halo size slightly. I used 0.300 instead of 0.132
To actually let the ﬁre glow you have to use one or more lamps and animate them as well.
But that would be part of another tutorial ...
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114. Fur
i Information
Applicable Blender version: 2.48a
There is an older version of this page created with Blender v2.401 .
(NOTE: New: marks

i Information
Applicable Blender version: 2.69
Notes added for newer versions. I'm not an expert but they seem to work.)

Figure 969
thing

Figure 1: The result of this tutorial: some furry

This tutorial deals with fur, i.e. lots of relatively short hairs covering a body. We will use
particles to create the fur, and discuss a few aspects here:
1

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FFurry%202.40
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•
•
•
•

How
How
How
How

to
to
to
to

determine the length and the thickness of the hair.
determine the place to grow the hair.
color hair.
render eﬃciently.

The particle system is far too complex to show more than one method in this tutorial. You
can achieve many of the same eﬀects shown here in diﬀerent ways.

114.1. The emitter

Figure 970

Figure 2a: Adding a particle system.

• Remove the cube.
• Add an UVSphere. This will become our emitter.
• Change to the Particle buttons in the Object buttons (Fig. 2a). New: looks like
newer versions.

in

• Click on Add New. New: Click on
in newer versions.
• Rename the particle system to ”Fur”.
• Change the particle system type to Hair.
A Hair particle system has a lot of specialties, the most important thing is that we can edit
the particle ”motion” by hand if we want to. Apart from that normal particle physics apply,
so everything a particle does hair can do also and vice versa. A particle hair shows the way
of the particle during its lifetime at once. To do that eﬃciently not every single frame is
rendered as a point, but a certain number of control points are calculated. Between these
control points there will be drawn an interpolated path. The number of control points is
the number of segments + 1.
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Figure 973

Figure 2b: Particle system settings

For fur you need lot's of particles, like 1.000.000 upwards. This will hurt us badly if we
have to deal with so many particles in the 3D window and want to render it. Therefore, we
will create the great amount of particles with so called ”children”, that mimic the behavior
of their parents. The amount of particle parents should be as low as possible, but you need
a certain amount to control the distribution of the hair. We will also use as little control
points as possible, three segments should be enough for short fur.
• Set the Amount to 1000.
• Set the number of Segments to three. New I can't ﬁnd this in 2.69. New2 In 2.7x, it's
right next to the particle system type you just chose (emitter or hair), below the slider
Seed.
• Emit from: New I can't ﬁnd this in 2.69. New2 In 2.7x, you must check the Advance box
near the Segments slider in order to see it.
• Random:Faces
• Even :Random
This will create a nice, uniform distribution.
Let the hair grow - the hair shows the path of the particle:
• Set Normal to 0.05. New: Hair Length under Emission. New2 In 2.7x, you must
check the Advance box in order to see the Velocity panel and adjust the Normal and
Random slider. If you change the Normal value, Hair Length will set itself to 0.2.
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• Random 0.005
Nothing special here: the hair grows in the direction of the face normals. Length and
direction are a bit randomized.
The Visualization type changes automatically to type Path if you select a hair particle
system. If you would render now, you couldn't see the emitter object any more.
• Activate Emitter in the Visualization panel. New: In the Render panel.
• Activate Strand Render. New: In the Render panel.
The Strand Render (which I have baptized keypoint strands to diﬀerentiate from the ”normal” polygon strands) renders the hair strands extremely eﬃciently and magnitudes faster
than the normal strand. It is the only way to handle many hairs in terms of memory
consumption. But it has a few disadvantages:
- They are not seen by raytracing, so you don't get raytracing reﬂections and no raytracing shadows. You can use environment mapping to compute the reﬂections and Spot
Lamps with buﬀer shadows for the shadow.
- If the hair is very thick (like 1 BU) sometimes the shape is not correct.
• Activate Children from Faces. New: I chose Interpolated under Children. Interpolated
is known to give better results when making Fur. Simple, maybe, will work with one
color, but we're going to use 2 colors from an image.
• Amount: 5 This is the amount of children particles for each parent.
• Render Amount: 50 This is the amount of particles during the render.
• Rough 2: 0.1 New: I used Roughness > Random for this setting. Random variation of
the shape of the particles. So the hairs will not stand plain upright and appear a bit
curly.
The parent particles are not rendered by default, so now we have 5.000 Particles that render
on my old machine in 6 seconds. If we use 1.000 children we have 1.000.000 particles, that
need approx. 1 GB of RAM and render in 1:42 minutes. If you render keypoint strands with
Children from Faces you can also use Child simpliﬁcation, which will reduce the amount of
particles on objects far away from the camera automatically. New: Don't see this when
using Children - Simple, When using Children - Interpolated, you'll see it all down the
Render section. However, the result is very bad, with the standard settings.
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Figure 974

Figure 2c: The ﬁrst render without material.

Now we should change the lighting to get a preview.
•
•
•
•
•

Select the lamp.
Change to the Lamp buttons.
Change the lamp type to Spot.
Change the shadow type to Buf. Shadow
Change the buﬀered shadow type to Classic-Halfway.

This is a great shadow type that renders keypoint strands very well and creates fewer
artifacts than Classical (In my opinion). I have inserted two other lamps and used a classical
three point lighting for the ﬁrst rendering (Fig. 2c).
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Figure 975
version.

Click on image to see larger

NEW:

i Information
Applicable Blender version: 2.69
Here are the settings I used and the render result I got. (Click to enlarge the image and
read the settings.)

114.2. Material
In the material buttons you can set diﬀerent aspects for the strands:
- their width and form
- the used shader
- the base color
- a texture along the strand
- diﬀerent particle attributes like length, density or roughness
• Add a material to the emitter.
• Name the material ”Fur”.
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114.2.1. Strands Shader

Figure 976

Figure 3a: Strands settings in the material buttons.

The default strands settings for Keypoint strands are shown in Fig. 3a. Take a look in the
Manual about Strands2 for an explanation of all settings.
• Change the End value to 0.25, this will make the hair more spiky (not shown in Fig. 3a).
New In 2.7x, it's called Tip (and Start has become Root)
Note:
Surface Diﬀuse: It might be easier to achieve a good lighting environment if you check
Surface Diﬀuse. With Surface Diﬀuse turned on, hair does not show as many highlights,
which may be too bright without it. I've seen many great examples of fur that use this
parameter. However, you have to decide right at the beginning whether you want to use
it because it aﬀects all the other material settings. This is something you have to decide
for yourself.

2

http://wiki.blender.org/index.php/Doc:Manual/Materials/Properties/Strands
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114.2.2. Giving the hair its base color

Figure 977

Figure 3b: Fur color texture

Strands are rendered with the material of the underlying face/vertex, including shading with
an UV-Texture. Since you can assign more than one material to each face, each particle
system may have its own material and the material of the underlying face can be diﬀerent
from the material of the strands. We will use an UV texture and use it for the surface of
the emitter as well as for the color of the hair.
•
•
•
•

Change to Front view in the 3D window (View->Front).
Make sure you are in Orthographic view mode (also in the View menu).
Change to Edit mode of the sphere.
Press U to unwrap, select Sphere from View. This is a quick and well working method
to correctly unwrap a sphere the easy way.

You don't need to assign a texture in the UV/Image Editor, we only need the coordinates
now.

Figure 978

Figure 3c: Emitter with color texture.

• Add a texture to the material, name it ”FurColor”.
• Set Map Input to UV.
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Changing Hair length with a texture
• Go to the Texture Buttons and set Texture-Type: Image.
• Load an image texture. I have used the image in Fig. 3b.
Normally I would just stop here, I think the material is good enough. But if you want
to make the fur more ﬂuﬀy and soft, you should a second texture along the strand, which
changes the alpha value. New: For this to work you have to choose Interpolated instead of
Simple in the Children panel of the particle system.

Figure 979

Figure 3d: Settings for a texture along the strand.

If you want to do that:
•
•
•
•
•

Activate ZTransp.
Add a second texture.
Map Input: Strand
Map To: Alpha and Spec, DVar=0
Use a blend texture (Linear or Quad)

You can change all other properties this way, for example the color along the strand
(bleached tips).

114.3. Changing Hair length with a texture
At ﬁrst I will show you how to render the emitter mesh with a diﬀerent material than
the strands. Then I will show how to change the length of the hair with a texture semiinteractively.
• Change to the Editing Buttons.
• Change to Edit mode.
• In the Links and Materials panel click on New in the material section (see Figure 4a).
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Figure 980

Figure 4a: Button to click

• Make sure all vertices are selected.
• Click on Assign.
• Change back to Object mode.
Now the emitter bears a second material.
• Return to the material buttons.
• In the Links and Pipeline panel click on the X next to the material name (Deletes link
to this Datablock).
• Add a new material.
• Name it Emitter.
Now you have a new material on your emitter object. Since the particle system uses material
no. 1 you can use diﬀerent settings for the emitter.

1082

Changing Hair length with a texture

Figure 981

Figure 4b: Texture painting

We have already unwrapped the emitter, this is something that will probably be the case
also for any real models. Now we will use an UV-Image and texture painting to determine
the hair length.
•
•
•
•

Split the 3D window.
Change the right hand side to an UV/Image-Editor window.
Change to edit mode of the emitter object.
In the UV/Image-Editor use Image->New... and conﬁrm the default settings. This will
create a new image, that we will paint on.
• Click on the package icon in the windows header of the UV/Image-Editor window. Conﬁrm.
• Change the object to Texture Paint mode. Noob Note: In the 3D Window, click on the
drop down menu. Change it to Texture Paint.
Now you see the texture on the object.
•
•
•
•

Paint a structure on the object.
Change back to object mode.
Go to the Material buttons.
Change the active material to Fur (click on the arrows in the Links and Pipeline buttons
where it reads 2 Mat 2).
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Figure 982

Figure 4c: Material settings for setting the particle length with a texture.

• Create another texture. Name it FurLength.
• Set Map Input to UV.
• Set Map To
• Turn Col oﬀ.
• PAttr
• Length
• DVar=0 All the white areas on the texture will produce a particle length of 0.
• Load the image texture that we have painted.

Figure 983
result

Figure 4d: Controlling particles with a texture:

The result is shown in Fig. 4d, you can also see the particles change in the 3D window.
New In Blender 2.7x, things have changed. I followed until the step Change the active
material to Fur. Then, I went to the Texture tab and clicked on the Particles Texture button
next to the Material Texture button (or you can click on the Particles tab button
and
then click on the Texture tab button). I added a new texture, opened the one I had just
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painted in the UV/Image-Editor, set Coordinates to UV (in the Mapping panel). Finally,
I enabled Density in the Inﬂuence panel and set its value to -1.00 (1.00 has the opposite
eﬀect = hair on the white areas of the texture). The result should be the same as above.
There would have been other ways to achieve this result, e.g. with vertex groups or with
particle editing. But I like to work with textures, because you have very ﬁne control and
may change the strength of the eﬀect at any time. Vertex groups don't allow for such ﬁne
control or you need very many vertices in the emitter. Particle editing (what we will do in
the next step) is lost if you change the base particle settings late on, and you can't change
it's eﬀect so easily.

114.4. Comb it!

Figure 985

Figure 5a: Combing in Particle Mode

An eﬀect that is often underestimated is the importance to comb fur in the natural directions. Fur doesn't simply stand upright, and it also doesn't follow gravity (or only to a
small amount). So back to the particle system!
• Change back to the Particle buttons.
• Click on Set Editable in the Particle System panel.
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• Change to Particle Mode.
Particle Mode only appears if you have made the particle system editable, and only hair
systems can be made editable. There are a few lifesavers to know when working in Particle
Mode.
- you can edit only the control points (remember the setting Segments from the beginning
of this tutorial)
- you can only edit parent particles, so you need enough parents for good control
• Activate Limit selection to visible
• Activate Point select mode for even ﬁner control.
Both settings are in the window header of the 3D window.
• Open the Particle Edit Properties panel with N key in the 3D window.
• Select Comb.
You have quite a few diﬀerent tools at hand in Particle Mode, see the manual on Particle
Mode3 .
• Comb the hair following the natural ﬂow.
On the example sphere I have used here it is a bit diﬃcult to tell what the natural ﬂow
should be ;-). So I have just very carefully combed and changed the length at a few places
a bit. You ﬁnd the rendered result in Fig. 1, the Blend ﬁle is linked below.

114.5. Links
• A tutorial in German that shows how to create Grass4 with a very similar method.
• Awesome fur shown here: Tiger5

3
4
5
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http://wiki.blender.org/index.php/Doc:Manual/Physics/Particle_Mode
https://en.wikibooks.org/wiki/%3Ade%3ABlender%20Dokumentation%2F%20Tutorials%2F%
20Partikel%2F%20Gras
http://blenderartists.org/forum/showthread.php?t=124839

115. Fireworks
i Information
Applicable Blender version: 2.48a

Figure 986

Figure 1: Some particle ﬁreworks
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[Note: In newer versions of Blender, the reactor particles are gone.]
[if you use 2.6x version of blender, then you could watch the YouTube video {particles from
particles part1/2}. It's a great tutorial, but the part 2 of it uses compositing, which is
described in this book a little later. Therefore, you could apply the knowledge you have
learnt from this book to animate the explosions!]
How to create a ﬁrework from particles? We will use cascaded particle systems especially
of the type Reactor. Abstract:
• We create a emitter object in the appropriate size.
• Than we use three successive particle systems:
• the ﬁrst of the type Emitter
• the second of the type Reactor. This system reacts to the death of the emitter particles.
• the third again of the type Reactor. This systems reacts to the proximity of the second
systems and thus creates a ”drag”.
• We create three diﬀerent materials (one of them animated) and assign them to the three
particle systems.

115.1. The Emitter
We use a Plane as emitter object. Scale it to your liking. I have used a relatively large
particle system, so my plane has a length of 15 BU (Blender units).

Figure 987 Figure 2a: Adding particle systems. First particle system on the left hand
side, a second particle system on the right hand side

• Add a particle system (Fig 2a, left hand side).
• Amount: 25
• Sta: 1
• End: 250
• Emit from:
• Random
• Faces
• Even
• Random
• Initial Velocity
• Normal: 22
• Random: 7
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• AccZ: -9.8
• Visualisation: Line
• Back: 1.1
A few particles (25) are created in the ﬁrst 250 frames of the animation and emitted upwards.
Gravitation, velocity and lifetime are adjusted so, that the particles reach the end of their
lifetime at the topmost point of their trajectory.
The Line visualization lets the particles appear as long drawn-out line.
• Bake the particle system. Use 500 as the End frame for bake. 300 would be suﬃcient
here, but 500 do no harm.
Noob Note: Bake is in the Bake tab next to particle system tab in particle buttons window.
The plane will get a Halo material.
•
•
•
•

Activate Halo in the Links and Pipeline panel.
Halo: color red
Halo Size: 0.421
Hard: 35

I've adjusted the size and hardness of the halo so long until I liked it, so there is no speciﬁc
reason to use these values.

115.2. Reactor 1
• Click on the arrow next to 1 Part 1 in the Particle System panel.
• The settings for the ﬁrst particle system are no longer shown, now it reads 1 Part
2 (Fig. 2a, right hand side).
• Click on Add New, now it reads 2 Part 2.
You just have created a second particle system. Rename this system, a good naming
convention will help you a lot to keep the overview.

Figure 988

Figure 3a: The ﬁrst reactor system

• Activate React on: Death.
• Life: 104
• Emit from: Particles
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You don't have to set anything for the Target. It is not necessary to set the target object if
it is the same object as the reactor. You just have to set the number of the target particle
system eventually.
The Reactor particles react on the Death of the particles of the target system. They will be
emitted from the point that the particles occupy at their death.
To control the movement of the system, I have made following setting in the Physics panel:
•
•
•
•

Particle: 0.345
Reactor: 10
AccZ: -0.09
Brown: 3.86

Because of the Reactor setting the star is moving away from the emitting particles. The
Brown movement lets the trajectory appear trembling like aﬀected by wind.
• Set the material number to ”2” in the Visualization panel.
• Bake the system, again use 500 as end frame.

115.2.1. Material 2

Figure 989

Figure 3b: Material settings for the 1. Reactor system

• At ﬁrst you have to assign a new material in the Link and Materials panel of the
Editing Buttons.
• Use the material settings from Fig. 3b,
• The material also gets a Clouds texture with Noise depth ”3”, simply leave all other
settings unchanged.
The texture is actually superﬂuous here, but the next particle system is given the same
texture, and colors should be adjusted a bit.
• Animate the Alpha value of the material.
• Set the ﬁrst Ipo key in frame 1 (Alpha=1). To do that move your mouse cursor over
the Buttons window. Press I->Alpha (and change ipo type to material in the ipo curve
editor if you are using that).
• Set the second Ipo key in frame 86 (Alpha=0.75).
• Set the third key in Frame frame 101 (Alpha=0.0).
The second particle system is faded oﬀ relatively quickly, but the particles don't disappear
suddenly.
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115.3. Smoke Trail

Figure 990

Figure 4a: Particle system for the trail

The third (and last) particle system is again a Reactor system and is reacting to the second
system. It's going to react to the Nearness of the particles. Without moving the variation
of the particles is created with a texture and a random variation of their lifespan. What
Blender considers as close can be changed with the particle Size.
• Create a third particle system (like you created the second).
• Use the settings from Fig. 4a. Important are the settings:
• Amount: 100000
• React on: Near
• Emit from: Particles
• Life: 75
• Rand: 0.4
• Target Sys: 2
• Material: 3
• Bake the system, again use 500 as end frame.

115.3.1. Material 3
Figure 4b: Material for the Trail particle system1
• At ﬁrst you have to assign a new material (the third) to the object in the Link and
Materials panel of the object buttons.
• Assign the existing Clouds texture from material 2 also to material 3, but select a dark
blue as target color (in the Map To panel).

115.4. Render
• Render your animation, use end frame 500.
That's all. I hope you were able to follow the tutorial. Criticism and suggestions, write
best on the talk page or improve the article directly.

1

https://en.wikibooks.org/wiki/%20File%3ABlender3D%20Fireworks-Reactor2-Material-2.
48a.png

1091

116. Particles forming Shapes
i Information
Applicable Blender version: 2.48a

Figure 991 Image 1a: Particles can move to the position of other particles
with Keyed physics.

Figure 992

Image 1b: Particles can react to force ﬁelds of other particles.

Note all the blender users of version 2.6X, 2.7X: Using sort of a domain to dissolve the
particles by using the alpha parameter of the material is how I did it. You should understand
along the way. I’ll write the sentences in key sequences to reduce the size. So [s], 0.5, [enter]
means to scale the object by 0.5. Don’t worry you’ll learn keyed physics here.
• Open a new blender ﬁle. Delete the default cube.
• [shift]+[A],text. [num0]
• In the menu, below the tool shelf check align to view. Select the text object, [alt]+[c],
convert to mesh.
• [shift]+[a], add Suzanne. [ctrl]+[2], not the numpad.
• Set smooth. In the modiﬁer’s tab apply the subsurf immediately.
• If you want you can scale the objects. Add a particle system to text object.[I leave the
renaming parts to you]
• In the emission subpanel of the text object’s particle system: Number:5000;
Start/end(both):1; Emit from: faces, check random and even distribution, random;
Physics: none; Uncheck emitter in the render subpanel and choose none rather than
halo.; Set all to zero in the ﬁeld weight’s sub panel(actually I didn’t notice much difference it even being on).; Now add a particle system to Suzanne and give it the same
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•
•
•
•
•

•

•

particle system but make sure to have it made to a single user(just press the ‘2’ beside
the system name).
[shift]+[a], uv sphere. Selecting the sphere, [alt]+[g](just in case).
[s],2000,[enter]. [ctrl]+[2],set smooth and apply the modiﬁer.
Give the same particle system to the sphere. Now [num0](assuming you’re not already
in camera view).
[LMB] on the pass partout(the greyed out area except for the camera). [shift]+[a], add
cube.
Give the cube a particle system. Assign the same particle system but let’s make a few
changes: In the physics subpanel select keyed.; In the render subpanel choose halo.; In
the menu labeled keys, click the ‘+’ icon thrice and set the target object to text , Suzanne
and sphere in order.; Now select the Suzanne’s particle system in the keys menu, check
use timing and set it to 200. Now select the sphere’s and set the time to 7025! ( well this
is just to lower the speed we won’t render this).; And set the life time of these particles
to 500.(this is in the emission subpanel).;
In the timeline header set the end frame to 300. Now for the material. Select the cube
and: Give it a new material.; Select halo.; Size: 0.03; Hardness: 16; Add: 1; RGB: As
you desire how the particles appear.(I did RGB=0, 0.106, 0.8); Now go to frame 260 and
insert a keyframe to alpha value.; Now go to frame 270 and insert make the alpha value
zero and insert another keyframe.;
Set the scene’s gravity oﬀ. [ctrl]+[F12]( I suggest you render this one in xvid rather than
png it’s fun)

I will show on this page two ways to let particles take the shape of other objects.
1. keyed particle physics (Img. 1a)
2. a harmonic force ﬁeld with a damping of 1. The force ﬁeld is emitted by another
particle system, so that each particle is attracted by another particle (Img. 1b).
v2.48
The second method is easier to control, but I've found that it may not work exact enough.
Even if you use RK4 as calculation method, there are some glitches in the precision of the
calculation, so that your particles may not come to a standstill (depending on the size of
the particles and their number this may be visible or not).
v2.49
That the particles didn't come to a standstill has been a bug that Jahka has ﬁxed in 2.49.
So if you use Version 2.49 and upwards you will ﬁnd it easier to work with the harmonic
force ﬁeld.
Note:
Plan Ahead!
Make it easy for yourself. If you know beforehand what will happen at each important
frame, you will save a lot of time ﬁddling with the parameters.
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116.1. Keyed Physics
So here we're going to use keyed particle physics and quite a few diﬀerent particle systems.
Basically this is the way to go:
•
•
•
•

Use mesh objects and let them emit particles.
Each system moves to another system because of the keyed physics.
Choose a good visualization of the particles and animate that also.
At last the hard part: sync the diﬀerent animations.

The animation shall last 300 frames, this will be 12 seconds.
- In the ﬁrst 2 seconds the word ”Blender” shall appear (frame 1 to 50).
- Than Suzanne shall build up in 3 seconds (frame 51 to 150).
- Suzanne shall be clearly visible for a few frames (frame 151 to 200).
- After that the form shall dissolve and the particles move a bit until they vanish (frame
200 to 300)

116.1.1. Preparing the scene
•
•
•
•

Remove the cube.
Add a text object Blender. Name it Blender-ﬁrst.
Add a Suzanne (Add->Mesh->Monkey). Name it Suzanne-ﬁrst.
Convert the text object to a meshobject, because only mesh objects can emit particles
(menu: Object->Convert Object Type->Mesh).
• Move the objects to their ﬁnal positions, also the camera.
• Clariﬁcation required - what are the ﬁnal positions? (Noob note: the author
probably means to move the camera and objects to a right position for viewing the
animation correctly.)
We need every visible object twice.
• Duplicate Blender-ﬁrst and call the duplicate Blender-last.
• Duplicate Suzanne-ﬁrst and call the duplicate Suzanne-last.
One problem is that the objects have diﬀerent sizes. So how many particles shall be used
to create a clearly visible form? Since the most diﬃcult object is Suzanne, I have ﬁrst
chosen an acceptable representation and set everything else accordingly. But I will discuss
the settings of the objects in order, and not in the way I did it in reality.

116.1.2. Set up the particle systems
Blender-ﬁrst:
• Add a particle system to Blender-ﬁrst.
• Amount 20.000
• Sta: 1, End: 50, Life: 50
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• Emit from:
• Random/Faces/Even/Random
Leave all other settings at default. This object will appear in the ﬁrst 50 frames. After that
the object has to vanish in the 51th frame.
•
•
•
•
•
•

Insert a layer key for Blender-ﬁrst in frame 50 (mouse over the 3D window, I->Layer).
Change to frame 51.
Move the object to layer 20 (M->select layer, bottom right box). Make that layer visible.
Insert the next layer key for the object.
Make layer 20 invisible again (select layer 1).
Change back to frame 1.

Suzanne-ﬁrst
• Add a particle system.
• Amount 20.000
• Sta: 50, End: 100, Life: 200 (we don't need this long life but the lifetime doesn't matter
as long as it's long enough)
• Emit from:
• Random/Faces/Even/Random
• Visualization: None
Leave all other settings as default. These particles shall not move and they shall not be
visible. They are simply a target to the next system.
• Animate the layer of this object also. Move it out of sight in frame 151.
Blender-last
These particles shall move from the shape ”Blender” to the ”Suzanne” shape.
• Add a particle system to Blender-last.
• Amount 20.000
• Sta: 51, End: 51, Life: 100
• Emit from:
• Random/Faces/Even/Random
• Physics:
• First/Keyed It is the ﬁrst system of a chain (a very short chain in this example) of
systems.
• Keyed Target: Suzanne-ﬁrst, Psys: 1. Target is the ﬁrst particle system of ”Suzanneﬁrst”.
• Set time to Absolute in the Extras panel. We're going to animate the material of the
particles, I want all particles to change at once in a certain frame.

Figure 993
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Image 2a: Particle system of the ﬁrst keyed system.

Keyed Physics
Suzanne-last
These particles shall dissolve the form, so at ﬁrst they take the shape and move around
randomly afterwards.
• Add a particle system to Suzanne-last.
• Amount 20.000
• Sta: 151, End: 151, Life: 150, Rand: 0.5. The lifetime is randomized from 151/2 to
151 frames. [Noob Note: In 2.49a, you can't set the start later than the end, so you
must ﬁrst change the end to 151, then change the start.]
• Emit from:
• Random/Faces/Even/Random
• Bake: End frame 300. Though we don't use baking here, you have to set the End frame
in the Bake panel. Else the last 50 frames wouldn't be calculated.
• Time: Absolute

Figure 994

Image 2b: Animation of Brownian Motion

Animate the Brownian motion of the particles.
• Open an Ipo window.

1097

Particles forming Shapes
• Select Ipo Type particles.
• Select the Brown channel (LMB).
• Ctrl-Click with the left mouse button in the Ipo window to create an Ipo-key for the
selected channel.
• Create a curve similar to Img. 2b. Brown = 0 to frame 200, than increase to Brown =
4 in frame 217.

116.1.3. Material
Blender-ﬁrst and Blender-last will get the same material, Suzanne-ﬁrst is invisible anyway,
but Suzanne-last will get a material. The material of the three objects is very similar, but
I have animated the visibility of the particles to match the brightness of the objects.

Figure 995

Image 2c: Material settings for the particles

Suzanne-last
• Create a simple Halo material like that in Img. 2c.
This is nothing special, relatively small particles with a relatively ”sharp” edge. The
Add parameter gives more brightness if particles overlap, I think this is a nice eﬀect here.
Blender-ﬁrst
• Assign the material also to ”Blender-ﬁrst”.
• Make the material a Single User Copy by clicking on the small number next to the
material name.
• Set Alpha to 0.438.
Blender-last
• Assign the ”Blender-ﬁrst” also to Blender-last”.
• Make the material a Single User Copy by clicking on the small number next to the
material name.
• Animate the alpha value of the material.
• Insert an Ipo key for Alpha in frame 50.
• Change to frame 150.
• Set Alpha to 1.
• Insert an Ipo key for Alpha.
Now the brightness of all systems are matched.
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116.1.4. Links
• Manual about Particle physics1

116.2. Harmonic Force Fields
So here we will use Harmonic force ﬁelds. The Text ”Blender” shall be transformed to the
text ”2.5” and than to the text ”The big leap forward” (Img. 1b).
• Use mesh objects and let them emit particles. Only the particles from the ﬁrst object are
visible and move.
• The other particle systems use an animated Harmonic force ﬁeld to attract the particles
from the ﬁrst system.
• The particles from the ﬁrst system take the place of the other particles.
• Choose a good visualization of the particles and animate that also. This is diﬃcult and
maybe you should animate the visualization at last.
• At last the hard part: sync the diﬀerent animations and force ﬁelds.

116.2.1. Preparing the scene
• Remove the cube.
• Add three text objects:
• ”Blender”
• ”2.5”
• ”The big leap forward”
• Convert the text objects to mesh objects (menu: Object->Convert Object Type->Mesh).

116.2.2. Set up the particle systems
• Give each of the three objects its own particle system.
• The ﬁrst object ”Blender” gets following system:
• Type Emitter
• Amount=4000. We need a lot of particles, to ﬁll the last text evenly. If you want to
make the animation even better, you could animate the Halo size of the particles to
match the density of the diﬀerent objects.
• Sta(rt)=1, End=10, Life=250. The particles are created from the ﬁrst to the 10th
frame and live for 250 frames.
Only the particles of this system will be visible later.
• Change the calculation method from Midpoint to RK4. We need the extra precision here.
The objects ”2.5” and ”The big leap forward” will get particle systems with very similar
settings:

1

http://wiki.blender.org/index.php/Doc:Manual/Physics/Particles/Particle_physics

1099

Particles forming Shapes
• ”2.5”:
• Type Emitter
• Amount=4000
• Sta(rt)=30, End=30, Life=70. So all the particles are emitted in frame 30 and live 70
frames. So their force ﬁeld (which we give them soon) will start in frame 30 also. If
you want a smoother transition you should give the particles a bit more time to be
emitted (like from frame 30 to frame 40).
• Emit from Random/Faces/Even/Random.
• Phyics None. The target particles shall not move.
• Visualisation None. The target particles are not rendered.
• ”The big leap forward”: All settings as for ”2.5”, except Sta, End and Life.
• Sta=101, End=101, Life=90.

116.2.3. The force ﬁelds

Figure 996

Image 3a: The object does not get a force ﬁeld.

The particle systems of the objects ”2.5” and ”The big leap forward” will get a force ﬁeld
now. The objects don't get a force ﬁeld.
• Select the object ”2.5”.
• Select the particle system in the Field panel of the Physics buttons (Img. 3a).

1100

Harmonic Force Fields

Figure 997

Image 3b: The particle system gets the force ﬁeld.

• Use ﬁeld type Harmonic. Now the particles from the object ”2.5” do attract the particles
from the object ”Blender”.
• The Strength of the force ﬁeld determines the time the particles need to reach the target.
Set it accordingly.
• The Damp(ing) makes sure, that the particles move to their target but not beyond.
Do the same for the object ”The big leap ...”, i.e. select the particle system and give it a
Harmonic force ﬁeld.
I have used a Wind ﬁeld in the last frames to blow the particles away.
(Noobie Warning: When i followed the tutorials up to this point, i didn't know how to
use wind. I thought selecting Wind instead of Harmonic would create the eﬀect but then
blender froze on me (I am guessing it went away and calculated wind for every single
particle). so don't try wind yet. Wind is instructed in later tutorials.)

116.2.4. Links
• The Blend ﬁle to download2
• The manual about force ﬁelds3

2
3

http://www.snapdrive.net/files/180816/Blender3D_HarmonicFieldText.blend.zip
http://wiki.blender.org/index.php/Doc:Manual/Physics/Force_Fields
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117. Billboard Animation
i Information
Applicable Blender version: 2.49
Billboard1 visualization of particles - and especially their animation - is one of the more
arcane concepts in Blender. We're going to shed some light on this. Billboard visualization
is extremely powerful, everything that can be done with a halo can also be done with a
billboard. But billboards are real objects, they are seen by raytracing, they appear behind
transparent objects, they may have an arbitrary form and receive light and shadows. They
are a bit more diﬃcult to set up and take more render time and resources.
Billboards are aligned square planes. If you move an aligned billboard in a circle around an
object, the billboards always faces the center of the object. The size of the billboard is set
with the Size of the particle.
Texturing billboards is done by using uv coordinates that are generated automatically for
them.
• The main thing to understand is that if the object doesn't have any UV Layers, you need
to create at least one in the objects Editing buttons for any of these to work (Img. 1a).
• Moreover, material should be set to UV coordinates in the Map Input panel (Img. 1b).

Figure 999

Image 1b: UV coordinates as Map Input

Figure 998 Image 1a: UV coordinates for Billboard textures

1

http://wiki.blender.org/index.php/Doc:Manual/Physics/Particles/Visualisation
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117.1. Splitting a texture

Figure 1000

Image 2a: Billboard settings and texture for UV split

The simplest thing we can do is to give every billboard its own fraction of an image texture.
We're going to use a simple image (Img. 2a, right hand side) and split this in four parts
(UV Split = 2, horizontally and vertically).
•
•
•
•
•

Create the UV coordinates (simply click on New next to UV Texture in the Mesh panel).
Create a particle system.
Activate Billboard visualization.
Set UV Split to 2.
Oﬀset: Random to randomly choose one of the images sections. None would give only
the ﬁrst of the four ﬁelds, so all billboards would be red, linear would ﬁrst use red, then
blue, then white and then yellow repeatedly.
• Set UV Channel to Split. This creates the necessary UV coordinates, that are stored in
the UV layer. If you use another UV channel, you need a second (or third) UV layer to
store the coordinates (see below for an example).
• Fill in the ﬁeld UV with the name of the coordinate set (here ”UVTex”).
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Figure 1001

Image 2b: UV Split for Billboards

• Now create a material for the particle emitter.
• Add a texture if not there already.
• Set Map Input to UV. If you only have one active UV layer this is used by default, but
if you want to continue this tutorial you have to ﬁll in the name of the UV set also (i.e.
”UVTex”).
• Load the texture as Image texture.
Now every billboard gets a random section of the texture (see Img. 2b).
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117.2. Animating Alpha in relative particle time

Figure 1002

Image 3a: Using an UV layer for time animation

Now we're going to combine the texture split eﬀect with an animation of the billboard
alpha. This is done in relative particle time2 , i.e. in the lifetime of each particle.
Billboard time is setup completely diﬀerent than particle time.
• Create a new UV layer (the second one). Name it ”UVTex.Blend”. Naming is not important here as long as it is unique.
• Select the UV channel Time-Index (X-Y) in the Visualization panel of the particle system.
Fill in the name of the newly created UV layer ”UVTex.Blend”. This creates an additional
set of UV coordinates in this UV layer.
Now both UV layers with diﬀerent UV coordinates will be used. The material settings:
•
•
•
•

Activate RayTransp and TraShadow.
Add a second texture to your material.
Map Input also UV, but now use the UV layer ”UVTex.Blend”.
Map To:
• Invert Alpha and Invert Spec
• No RGB (since we're going to use a colorband texture)
• DVar = 0 to set Alpha to zero where the colorband is black.

2
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http://wiki.blender.org/index.php/Doc:Manual/Physics/Particles/Controlling_Emission%
2C_Interaction_and_Time

Animating Alpha in relative particle time
This is one of the possible combinations for using a texture to make a material transparent
(Img. 3b), there are several other methods that work as well.

Figure 1003 Image 3b: Material for the Alpha animation. This is already the ﬁnished
preview with the texture.

The texture is really the most important thing here.
• Use a linear Blend texture.
• Activate Colorband for full control.
Note:
The left hand side of the colorband if the ﬁrst frame of the particle life time. The right
hand side is the last frame of the particle life time.
• Adjust the colorband to your liking.
I've mapped the texture so, that ”white” means full opacity, black full transparency.

Figure 1004

Image 3c: Texture to control the animation time.

See this animation3 for the result of the combined textures.

3

http://www.vimeo.com/4121571
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117.3. Animating billboard color

Figure 1005 Image
4a: Animating Billboard color.
Animationa
a

http://www.vimeo.com/4132553

I will show here a second example for animating with a billboard texture, because this is
so important. We're going to change the color during the lifetime of the billboard, but you
can animate every property that way that can be inﬂuenced by a texture. Additionally you
can animate the material itself, this is done in absolute time for billboards. So you can mix
relative and absolute time animations.
•
•
•
•

Open a new ﬁle.
Remove the cube and add a plane.
Add an UV layer to the plane
Add a particle system with Billboard visualization and UV Channel Time-Index. Fill in
the name of the UV layer.

The particle life time is 50 frames.
• Add a material to your plane.
• Basis color Yellow.
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• Use a linear blend texture. If you would use a color band here, you could create an even
more colorful animation.
• Map Input UV
• Fill in the name of the UV layer.
• Map To Col. I've used a dark blue color here.
Now the linear blend texture sets the amount of blue color that is mixed to the basis color
of the material.
• At the left hand side the blend texture has a value of 0, so zero blue is mixed to the base
color in the ﬁrst frame of the particle lifetime.
• At the right hand side the blend texture has a value of 1, so 100% blue is mixed to the
base color in the last frame of the particle lifetime.

117.4. Changing the starting color of a billboard

Figure 1006

Image 4b: Flipped XY for the blend texture

If you ﬂip the Blend texture, you get a diﬀerent eﬀect. Now every Billboard gets another
starting color, but keeps that color during it's lifetime.
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Have I mentioned that you may use multiple textures on a billboard, combining all eﬀects?
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118. Soft Body Animation
i Information
Applicable Blender version: 2.49
Due to rapid updates in Blender, some menu items may be diﬀerent from those mentioned
here. If the menus don't agree then just do what seems logical.
Softbody makes each individual vertex its own object that falls according to gravity and
reacts to outside forces like ﬁelds. By adjusting the settings, you change the behaviour of
the edges that connect the vertices. For example, you can make it so edges can stretch
really far (aka elasticity), allowing the vertices to become distant, or you can make the edge
stiﬀ, so the vertices will always stay the same distance apart.
To put this in perspective, picture two cloths, one elastic and one cotton. The elastic one has
edges that can extend, so if you view them in wire-frame (with vertices and edges visible)
you would see the edges are more extended than an equal distance. The cotton one would
only stretch a little bit, so the vertices would stay essentially the same distance apart.
We are going to make a big rubber ball, but not a big bouncy one, a ﬂat (and somewhat
lifeless) one. Start with a sphere. I would use a cube sphere or an icosphere, UV spheres
don't deform well as they have too few vertices. A cube sphere is made by subdividing a
cube and doing a ”To Sphere” in the Edit window, under Mesh Tools.
Move the sphere up and place a plane below it. Make sure to do this in the right views so
that it is aligned properly. Gravity acts on the z-axis (sphere should be above the plane
relative to the z axis).
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Figure 1007

Now for the soft body select the ball and go to the object tab then the physics subtab or
whatever your version has. Click ”enable softbody” and then turn up 'Grav' to 9.8. Click
oﬀ use goal. Press the > arrow key (a few times) and you should see the ball fall. The
center will remain in place but this is not a problem. If you are on a slow machine you will
notice lag. This is because blender moves it vert by vert, not eﬃcient.
Note: in Blender 2.49, you must deselect the ”Use Goal” button to release the
center of the ball. Otherwise, it will just hang there.
Note: In Blender 2.44, click F7 on keyboard, select the ”Physics Buttons” button, select
”Soft Body”.
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Figure 1008

When it reaches the plane it will pass through. To ﬁx this we must make the plane aﬀect
the softbody. To do this make the plane deﬂect in its physics buttons.
Noob Note: To do this in version 2.49 select the plane, go toobject buttons -> physics
context -> collision subcontext and select Collision. The variables you can play with here
are under the Soft Body and Cloth Interaction.
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Figure 1009

Now the ball collapses into a strange quivering wreck after impact. To ﬁx this, you need
to turn on the stiﬀ quad button, but set the edge stiﬀness down a bit, so its more bouncy.
You can use the bake function to solidify the settings see below
Noob Note: You might have to turn up the Rigidity Level to 0.100 (in the Soft Body Tab)
as well in order to prevent the object from collapsing. (I used a subdivided cube as Object)
What I recommend to do before rendering as animation: In the Bake Settings (Soft Body
Tab) Set Interval to 2 or 1, so the object will not start deforming too early before impact.
This will slow down the bake process - just slightly - but make the object bounce more
dynamically. Then bake again.
Noob note: In blender 2.46 you have to adjust the value of Be in the soft body tab, I changed
it to 0.4
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Explanation of Settings

Figure 1010

another thing you could do is animate the scene. Just put up animation video and set frames
at about 50. Go to object mode, select sphere and press i key, and select LocRocScale. =)

118.1. Explanation of Settings
I invite you to correct and expand these deﬁnitions:

118.1.1. Softbody
• Friction: creates a resistance to movement of the whole object, like being submerged in
a viscous ﬂuid
• Grav: the rate of velocity change due to gravity. Results in a constant -z force.
• Mass: (Force = mass × acceleration) aﬀects everything by making the object heavier.
• Speed: tweaks the simulation to run faster or slower.
• ErrorLimit: raise it and the simulation will solve faster but strange things might happen.
Save frequently, as blender might go nuts with this or any physic simulation (but less so
after 2.4)
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• Goal: makes the object try to return to its original position, useful at times, in the
tutorial you could turn gravity oﬀ and key the ball falling and use this to keep it a ball.
• use Edges: uses the edges a means of resistance to movement for the object. Helps to
keep it looking possible
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119. Simple Cloth Animation
i Information
Applicable Blender version: 2.63
In this tutorial, we will be making a simple skirt, and using the cloth physics system to
make it fall in realistic-looking folds.

119.1. Making the Skirt Mesh
1. Open Blender and delete the default cube, if you aren't looking down on the scene,
press NUM7 .
2. SHIFT + A → Add → Mesh → Circle
3. The circle will be created, and in the Tool Shelf on the left you should see a panel
appear for adjusting its settings. Set the number of vertices to about 12.
4. Switch to Edit Mode with TAB . All the circle’s vertices should be initially selected;
if not, use A to select them all.
5. Press E to extrude a second copy of the vertices; press S
SHIFT + Z to scale
the extruded vertices in the X and Y directions. These will make up the hem of the
skirt; scale it out to as large as you like. Note that this is positioning the skirt out ﬂat
horizontally, instead of hanging down as you would expect; Blender’s cloth animation
system will take care of that, and this positioning gives maximum opportunity for the
skirt to fall in dramatic folds.
6. Now we will need to subdivide the mesh. The physics can only act on actual vertices,
so the more of these we have, the more realistic the cloth eﬀect will be. Select all
vertices in the skirt, press W and select the “Subdivide” option. A panel will appear
in the Tool Shelf for controlling the settings for the subdivision operation; set the
number of cuts to, say, 4.
7. While you’re at it, switch to OBJECT mode and look in the Tool Shelf for a pair of
“Shading” buttons titled “Smooth” and “Flat”
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Figure 1011
, and click on “Smooth”.

119.2. Creating the Vertex Group
1. Now we have to specify that the waist of the skirt will stay ﬁxed in place as it falls:
deselect all vertices, and select the innermost ring of vertices. The quickest way to
do this is to hold down ALT + SHIFT and click with RMB on one of the edges
bordering the hole in the middle. With the entire ring of vertices selected, go to the
Mesh Object Data context
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Figure 1012
in the Properties window, ﬁnd the “Vertex Groups” panel, and click the + sign to
create a new group. This will initially be called “Group”; perhaps give it a more
meaningful name (like “Waist”), and click “Assign” to put the selected vertices into
the new group.

119.3. Animating the Skirt
1. Tab out of Edit Mode into Object Mode. The skirt should still be selected.
2. Go to the Physics tab
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Figure 1013
in the Properties window (last icon in the row at the top). This will just show a few
buttons to begin with

1120

Prior to Keeping the Folds

Figure 1014
.
3. Click the “Cloth” button; a whole lot of other settings should appear, most of which
can be left at their default values (make sure the checkbox at the top of the “Cloth
Collision” panel is checked). However, check the box titled “Pinning”; now you can
click in the ﬁeld just below it to bring up a popup menu of all the vertex groups in
the mesh; this should just contain the one entry named “Waist” you created earlier,
so select that.
4. Now the magic happens ... rotate the view to an oblique one to give yourself a good
view of the process, and hit ALT + A . You should now see the skirt fall from
its horizontal position to a more natural vertical one, developing some folds in the
process.
5. After the animation has run through at least one complete cycle, hit ESC to stop it.

119.4. Prior to Keeping the Folds
Before doing the next step, we need to enable one of the standard addons that come with
Blender. This will let us make a copy of any stage of the physics simulation into a separate
object.
Go into the User Preferences window and bring up the “Addons” tab. Look for the “Animation Corrective shape keys” addon (typing “shape k” into the search box should be enough
to ﬁnd it).
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Figure 1015

Enable it. Now back to the 3D view...

119.5. Keeping the Folds
1. Use the left- and right- arrow keys to step through the animation one frame at a time,
until you ﬁnd a position for the skirt that you like.
2. When the 3D view is showing a nice shape for the skirt, go to the mesh data tab in
the Properties window, and look for the “Shape Keys” panel. Click with LMB on the
down-arrow just below the + and - signs, and in the menu that appears, you should
see the item “Create duplicate for editing”
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Keeping the Folds

Figure 1016
. Select that.
3. It looks like nothing has happened, but in fact you now have a second copy of the skirt
mesh, “baked” into the position corresponding to the current frame of the animation.
Try using the arrow keys to move through the animation, and you will see the baked
copy remain in the chosen position.
4. At this point, you can delete the original animated skirt mesh (or move it to another
layer for future reuse), leaving the nicely-folded copy.
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Figure 1017

119.6. Extra Practice
1. You will notice at some points during the animation, the folds of cloth pass right
through each other, which is of course impossible with real cloth. To prevent this, you
could go to the “Cloth Collision” panel in the Physics tab, and click the “Self Collision”
checkbox. Rerun the animation ( ALT + A ) to see the diﬀerence; what other eﬀects
does it have?
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2. Maybe the folds don’t look realistic enough. Go back to the original mesh, bring up
“Subdivide” again and subdivide it by a couple more levels. Rerun the animation (
ALT + A ). It should take a bit longer for the ﬁrst cycle, but do the results look
better?
3. This YouTube tutorial might also help:
http://au.youtube.com/watch?v=
mgYhZ3hWwTQ happy animating!
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120. Soft Body with Wind
i Information
Applicable Blender version: 2.49

120.1. Prologue
This is the Blender wind and soft body tutorial. This tutorial will try and help your
knowledge of using Soft Body and the Fields and Deﬂection panels in Blender 3D. (For best
results, I recommend you use Blender version 2.43 or higher). Don’t forget to save your
work at various points throughout the tutorial.

120.2. Setting up scene
120.2.1. The plane
Delete the default cube [X key, or yes, even the Delete key] and enter Front view mode
[Num. Pad 1]. Add a plane, scale 3 times [S key, 3, Enter] and sub-divide 4 times until you
get something like the shape below. If your computer can handle more, and you want more,
sub-divide as many times as you like, but if your PC is struggling with this, undo once or
twice.
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Figure 1018

120.2.2. The wind items
TAB out of edit mode (if you haven’t done so already), enter side view [Num Pad 3] and
add an empty. Clear the rotation [ALT + R] and rotate it 90° [R, 90]. Place it about -5
from the centre [G, y, -5] and make sure its still in the middle of the X axis. Your scene
should look like the picture below:

1128

Setting up scene

Figure 1019

For the second wind item, add an empty like before and clear its rotation, but DON’T
rotate it any more. Move it along the Y axis by 4 places [G, Y, 4] and -10 by the Z [G, Z,
-10]. And now your scene should look something like this (with all items selected).
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Figure 1020

And that’s all your items you’ll need for this. Onto the harder part.

120.3. Designating each object's job
120.3.1. The plane
Now, the plane will become a soft body, so enter the Object Panel [F7], click on the Physics
Button (beside the three arrows, see second picture below) and click on the soft body
button. You will get a load of boxes, but we only need to look at the Grav, Goal, and the
bottom parts:
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Figure 1021

Change the values of these as shown above. Change the Aero part to 732 (if you go up to
1000, it changes the ﬁnal output by a bit).
Now, click on the Soft Body Collision tab and click on the Self Collision and Deﬂection
buttons. You don’t need to change any of the numbers here. The buttons window should
look something like this:

Figure 1022
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Now we will move on to the Empty items which will be the wind.

120.3.2. Creating the wind
The two empty’s we created earlier will be the items that will act like wind, and when
you render at the end, they will be invisible, just like the wind. Anyway, select one of the
empty’s and enter the Physics panel. Click on the box under the Fields and select “Wind”.
(Blender 2.5+ note: First you will have to choose ”Force Field”, then change the Type to
”Wind”.) Change the Strength to 20, click on Use MaxDist and change MaxDist to 2.5.

Figure 1023

Do the same for the other empty. Your scene should look something like this:
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The movement

Figure 1024

120.4. The movement
This is probably the most complicated part, but shouldn’t take long.

120.4.1. The Empty on the left
In side view [Num pad 3], select the empty on the left and do the following: 1. Press [I
key] and then select LocRotScale from the list it gives you. This inserts a key frame, saying
that on this frame, keep the Location, Rotation and scale the same throughout the rest of
the movie, unless it comes across another key frame, which might tell it to move or stay
the same. Now, press the Up Arrow Key until you get to frame 31 (about 3 times). If you
don’t know where the box is that tells you what frame your on, check the following picture:
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Figure 1025

Number 1 shows the current frame number and the name of the selected object while number
2 shows the current frame and allows you to change the frame with the arrows on either
side.

120.4.2. Back to the movement
On frame 31, select the empty on the left (the one selected in the picture above) and press
[G key]. Now press [Y key] and press “4”, then [Enter key]. Now press [I key] and select
LocRotScale again. Now, if you press and hold the Left Arrow Key, you should see the
Empty move back to its starting place. Now, to check the curve guide (called the ”IPO
Curve Editor”); right-click on the top panel (number 1 in picture below), then select ”Split
Area” and click when the line is a bit out from the side (number 2 in picture below).
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Figure 1026

Now, click on the box (shown below) and select ”IPO Curve Editor” from the menu.
Noob note In Blender 2.6+ the IPO Curve Editor has been replaced by the Graph
Editor, which allows you to edit F-curves.
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Figure 1027

This window just shows where the key frames you entered are, and how much the shape
changes, moves or rotates. Now, go back to frame 1 and press [ALT]+[A], which plays the
animation. You should see the ”wind” hit the sheet and the sheet will blow away. Pretty
nice, huh? Now, it would be ﬁne like that (I’ll show you how to get rid of the blockyness in
the last part), but say you want to hit the sheet again and send it upwards? We will use
the second empty for this.
Select the second empty (the one on the bottom). Insert a key frame ([I key], LocRotScale)
on frame 1 and frame 50. Go to frame 60, grab the empty and move it up 8 places ([G key],
[Z key], 8). Insert a key frame ([I key], LocRotScale) and then go back to frame 1. You
have completed the basics, and the most of this tutorial. Now, press [ALT]+[A key] and
watch your animation.

120.5. Finishing touches
120.5.1. Blockiness
Now, to sort out the blockiness, go to the Editing buttons panel [F9] and select the ”Set
Smooth” button.
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Figure 1028

Now if you preview again ([ALT]+[A]) you should see the plane is smoother, but might be
a bit unrealistic (i.e. not acting like real cloth). Now, that can’t be helped, the only way to
get rid of it is to subdivide the plane several more times, but that will put a LOT of strain
on your computer, so I wouldn’t recommend doing it unless your computer can handle it.

120.5.2. Background
First of all, got to the Scene panel [F10] and over at the Format panel, change SizeX to
400 and SizeY to 300. Now, to change the background colour when you render, go to the
shading panel [F5] and select the World buttons. Now, in the World panel change HoR to
0, HoG to 0.80 and HoB to 1.0.

Figure 1029
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All that does is just changes the background colour to a brighter, nicer shade of blue. Now,
I’m just getting a bit lazy, so I’ll just explain this part with a picture: (don’t forget to select
the plane).

Figure 1030

Change the values and press the buttons shown in the picture. This will change the colour
of the plane to white.
The only problem now is the light. Press [F12] and you should see what I mean. There's no
light shining on the plane where the camera is, so its just shaded dark. To ﬁx that, select
the light and go to the shading panel [F5]. You now have options for the light. Click on the
”Sun” button and press [ALT]+[R] to clear rotation. Now, in side view [Num pad 3] press
[R] and then type -45. Enter top view [Num pad 7] and press [R] and then -45. This now
shines the light in the direction of the plane, but, if like mine, the light is above the plane
in top-view, press [G], [Y] and then -5. The line coming out of the light source should be
roughly pointing at the centre of the plane. Here’s what your window should look like:
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Figure 1031

The pink line is the light. This was taken in camera view [Num pad 0]. Render the frame
and you should see what the ﬁnal product looks like. Move to any frame you want and
press [F12] and it will show the rendered image for that frame. Now, rendering the entire
animation might, in fact, will take a long time unless you have a completely new PC, are
using a big server like DreamWorks (one of the big PC’s, used for rendering images faster)
or have a quicker renderer, I don’t use any external renderers, and am stuck using a PC
that is about 2 years old (in other words, full of junk). It took my PC less than 5 minutes to
render 100 frames, and the last 25 were just blank (as the plane just ﬂew above the camera).
To change the amount of frames to render, and to render the full animation, here’s what
you press:

Figure 1032

The box that says End:100 lets you select what frame you ﬁnish rendering the animation
on (NOTE: the Sta:1 button lets you select what frame to start rendering the animation).
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When you press the ANIM button, it starts rendering the animation. The Box covered in
blue, that says Jpeg, lets you change the format of the image in the end.
To export the animation as an AVI format, select the AVI button shown below, then press
OK. Now, you need to Animate the sequence again, so press the ANIM button again.

Figure 1033

The ﬁnished.AVI will be saved in a folder with the rest of your rendered images. It should
be saved in a folder called tmp, which (on a Microsoft computer) is in My Computer/tmp.
The name of the ﬁle will be whatever your start and end frames are, so in this movie, mine
is called 0001_0100.avi. You can now do whatever you want with your movie now, and
hopefully you have learned a trick or two that will be helpful later on in your Blender career.

120.6. Final result
Here is an animated.gif of my ﬁnal result: (imported into Macromedia Flash and exported
as an animated.gif)You are required to be an auto conﬁrmed user or uploader. I made a gif
with a frame-step of 4.
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Final result

Figure 1034
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121. Blender Game Engine BasicsRolling Ball
i Information
Applicable Blender version: 2.49

121.1. Introduction
The Blender Game Engine is an interesting feature of Blender. It is basically a 3D environment in which 3D objects move around and react to each other upon contact. One common
application is to recreate 3D architectural tours.
In this tutorial, you will learn the basics of object collision within the Blender Game Engine
(BGE). From Blender games to use in animations, the bullet physics engine oﬀers a massive
number of possibilities. The tutorials found within this wikibook on the subject of the BGE
are generally focused on game creation, but the concepts taught within can be applied to a
multitude of situations.
As a start, we will teach you to make a ball roll realistically down the hill using Blender's
game engine.

121.2. Adding the Hill
First, make a plane, then switch to Edit mode (TAB), and multi-subdivide it with 2 cuts
(WKEY → Subdivide Multi → 2). Next, enter face select mode (CTRL+TAB → Faces)
to drag the center face up, in order to form a rough outline of a hill. Add a subsurf modiﬁer
(in the edit buttons) to about 3, then apply. You should now have a serviceable, but small,
hill. Scale the hill up (SKEY) by about 10 times, and we're ready to add the ball.
Noob note:
1. You can also use a 3*3 grid.
2. Delete the original cube ﬁrst.
3. The subsurf modiﬁer is not essential.
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121.3. Creating the Ball
Now, add an icosphere (SPACE → Add → Icosphere) and relocate it to be just above the
hilltop (GKEY or use the translate widget by pressing CTR+ALT+G). Let's change the
color of the sphere so we can diﬀerentiate it from the plane. Go to the material buttons
(with the sphere selected) and click on the white panel beside the COL value. In the color
selection wiget that appears, change its color to a bright red.
Next we need to make the Physics engine iterate over it. With the sphere selected, go to the
logic buttons (the little purple Pacman-icon). NOTE: In Blender 2.5 and above the
Logic Buttons are gone. In order to have the 'Actor' button, click on the button
showing 'Blender Render', and select 'Blender Game' Engine. Then go to the
physics tab in the buttons menu. There you will see the 'Actor' Button. You
will see a button in the top left that says Actor. Press it. Now select from the selection
box beside of the ”Actor” button Rigid Body. This makes the ball roll, instead of staying
completely upright the entire time. You will see a bunch of settings available now. Change
Radius to 2. This changes size the physics engine thinks the ball is. You notice a dotted
circle around the object; this is the boundary. Now change the Radius back to 1. You now
have your ﬁrst Blender game ready to go.
Noob Note:
1. Make sure you are in object mode ﬁrst before you add any object.
2. F4KEY is the shortcut to the logic panel.

121.4. Testing your game
Now the time has come for the ﬁrst test of our game.
1. Add a light source well above the hill (SHIFT+AKEY → Lamp → Lamp). Align
in front view (NUM1)
2. Press NUM5 to switch to Perspective mode, which gives a realistic view, rather than
a view in which objects stay the same size with distance (be sure to switch back to
Orthographic view when you are editing again using NUM5)
3. Enter textured mode (ALT+ZKEY -- press ZKEY to switch back to solid view
mode)
4. Switch into side view (NUM3) and press NUM8 several times to get a good perspective on the ball.
5. Press PKEY to play the game (Make sure you are in Object mode (TAB)
6. Press P to start testing the game. You should see the red ball drop onto the hill.
7. Press ESC to quit testing the game
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Video capturing your game

Figure 1035

Rolling ball tutorial screen capture

121.5. Video capturing your game
When you press the PKEY or click game, start play, Blender will play it using the 3D view.
Many rendering features are not shown in this 3D Window and it does not render the view
in order to get good pictures with textures and lighting. You must capture your object that
keep on changing(the actor) so that it can be animated.
View -> click View button , -> next step / -> alternative step RMB -> right mouse button
IKEY -> press the I key on keyboard
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Split window, IPO Curve Editor View, Game, Record Game Physics to IPO,
object mode, RMB(select actor), IKEY/select key frame, Loc(location of actor object only),
PKEY( play game), ESCKEY(stop game)
scene(F10), output, f:\animation\ball (your ﬁle name), stamp, time, date, draw stamp,
format,(choose your output format)
anim, end(ending frame), 270, step, 10(for testing), ANIM/Render, Render Animation/CTRL F12

121.6. Conclusion
With the knowledge acquired in this tutorial, there are many things you could accomplish
within the Blender Game Engine, although the majority of them would require more knowledge. So read on, and work your way through the multitudinous seas of tutorials (That is,
two).

121.7. Extra Tutorials
Making a Basic Game: Link1 , The State Actuator: Link2 , Blender Game Engine Mouse
Follow: Link3 , Blender Bullet Physics: Link4 , Domino Game: Link5 , Rag Doll: Link6

1
2
3
4
5
6
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http://www.youtube.com/watch?v=WGycLDs_dLg
http://forum.nystic.com/viewtopic.php?f=9&t=4633
http://forum.nystic.com/viewtopic.php?f=9&t=4743
http://forum.nystic.com/viewtopic.php?f=9&t=4752
http://forum.nystic.com/viewtopic.php?f=9&t=4820
http://forum.nystic.com/viewtopic.php?f=9&t=4987

122. Platformer: Controls and Movement
i Information
Applicable Blender version: 2.49
This tutorial will teach you the basics of the Blender Game Engine, and how to create a
platform game, which is a game where you overcome in-game obstacles by controlling the
character's motions. (e.g. Super Mario)
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122.1. Set Up

Figure 1036

How it should look so far.

To start, switch to the frontal view NUM1 and move the starting cube to -3.0 along the
Z azis, or three spaces down. If your default settings do not have you starting with a cube,
create one now. (Don't forget to switch to the Blender Game engine. You can do this by
going to the button on the top center of the screen that says Blender Render and switch it
to Blender Game.) Next, hit SPACE → Add → Mesh → Monkey to create Suzanne the
Monkey. Any mesh will do, but it's the easiest of the basic meshes to intuitively determine
local direction from. Next, go to the logic window (with Suzanne still selected) and toggle
on ”Actor” and then ”Dynamic”. Hit PKEY to test. Suzanne should fall, then stop upon
hitting the cube. Press ESC to exit.
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Figure 1037

122.2. Controls
Now we will add the controls. First, forward:
In Blender 2.59 these controls are available in the 'Logic Editor' window.
1. Create a Keyboard Sensor, AND Controller, and Motion Actuator. Connect them by
dragging lines between the dots next to their names. (In 2.59 the controller is created
automatically, if the other two are connected)
2. Select the empty box next to the word ”Key” on the Keyboard Sensor and hit the up
arrow key on your keyboard.
3. Set the dLoc on the Motion Actuator to 0.10 Z and toggle Local Transformation (may
appear as simply an L next to the dLoc row).
Next, backward. Repeat the process used for forward, but set the dLoc to -0.10 Z and the
key to the down arrow. You can repeat this for left and right if you so choose to have a
linear control scheme. We will not be using such a scheme for this tutorial, but you should
still be able to follow along just ﬁne. Instead, the character will rotate left and right and
move in the new forward and backward.
(Note: Using an X or Y value for Dloc may be more eﬀective as using Z value seems to just
make her jump not move in any sort of direction which defeats the purpose of the ﬁnal step
of the tutorial)
To rotate right:
1. As before, create a Keyboard Sensor, AND Controller, and Motion Actuator, then
connect them.
2. Set the key to the right arrow and set the dRot to -0.10 Y.
Repeat for left, with the left arrow and 0.10 Y.
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Figure 1038

Finally, the ubiquitous, and some say deﬁning, Platformer move: the jump. Repeat the
previous processes, with the space key as the trigger and the linV of the motion eﬀect as
7.50 Z (not local). This doesn't actually move the character in a certain direction, but sets
its velocity. If you've done programming for games before, this will probably be familiar
to you. Each frame, the engine adds the velocity of the object to its current position.
The gravity portion of the engine subtracts from the upward velocity each time. When it
reaches a negative, it's adding a negative number to its altitude, ergo subtracting from it,
ergo causing it to fall. This is why using linV to move the character does not cause it to
immediately relocate to the target position.
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123. Maze: Force and Multiple Levels
i Information
Applicable Blender version: 2.49

123.1. Introduction
This tutorial is intended as an intermediate introduction to the Blender game engine, in
the form of a game, and is the sequel to Platformer: Creation and Controls1 . It will require
a familiarity with the Blender UI, simple commands (such as AKEY to select) and basic
modeling skills. The game we will create within Blender will have the following features:
1.
2.
3.
4.
5.
6.

a protagonist controlled by means of the WASD keys
a maze surface without walls
death on falling oﬀ the maze
multiple levels
dynamic obstacles
a goal within the maze that will transfer you to the next level

This tutorial was written for version 2.44 and has been tested for all later versions (as of
April, 2008)

123.2. Maze Surface
Now we'll make the maze. When you are creating the path of the maze surface keep in
mind that you need a start and a goal.

1

Chapter 122 on page 1147
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Figure 1039

Selecting the faces

Clear the scene; Select all (AKEY), delete selected items (XKEY → ENTER)
Go into top view (NUM7)
Add a grid (SPACE → Add → Mesh → Grid) with X and Y resolution of 16
Scale grid by 24 times (SKEY, type 24, ENTER)
Enter edit mode with the grid selected (TAB)
Go into face select mode (CTRL+TAB → Faces)
Start selecting faces so as to make a two dimensional maze (use BKEY to draw
selection boxes)
8. With the faces selected, duplicate those faces (SHIFT+D, RMB)
9. Move those faces away from the original grid (GKEY or the movement wiget
CTR+ALT+GKEY)
10. Delete original grid
1.
2.
3.
4.
5.
6.
7.
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11. Center your maze using GKEY or by pressing the Center button in the Mesh panel
of the Editing buttons (F9)
You should now have a two dimensional maze. In the game engine, we only see one side
of every face, so this maze will not appear to be there when seen from below, and will be
obviously two dimensional when seen from the surface of the maze itself. This is undesirable
so we will make our maze 3 dimensional by extruding the maze surface down.

Figure 1040

The extruded maze

1. Go into side view (NUM3)
2. Select all the faces (AKEY)
3. Extrude down, -1 unit (EKEY → Region), hold CTR to constrain to 1 unit increments, or manually type in the value -1, like you scaled the grid in the beginning.
4. LMB to accept the operation, or RMB to cancel the move of the faces. If you cancel
it, the faces will have extruded, but will simply not have moved. You can undo the
operation (CTRL+Z), or delete the vertices/faces you have extruded (WKEY →
Remove Doubles).
Your maze is now complete, only lacking someone trapped in it...
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123.3. Character

Figure 1041

Extruding a nose

We will create a very basic character suﬃcient to illustrate the concepts meant to be conveyed in this tutorial. You can make a character as complex or basic as you desire, but
it is important to always have an indicator of direction on your protagonist, otherwise the
player may become confused. So, we will use a primitive with a 'nose' (i.e. a face or vertex
extruded away from the object center in order to provide a point of rotational reference).
I'll use a cone for this tutorial, simply because they don't roll very easily.
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Figure 1042

1.
2.
3.
4.
5.
6.
7.
8.
9.

Rotate to the direction character will move

Enter top view (NUM7)
Add the cone (SPACE → Mesh → Cone, use default values)
Select cone and enter Edit mode (TAB)
Enter face select mode (CTRL+TAB → Faces)
Select a face on the side of the cone
Extrude it about 1/4 of a unit or less (EKEY)
Merge the extruded face to make the nose pointy (WKEY → Merge → At Center)
Enter object mode (TAB)
Rotate the cone so the nose is aligned with the positive Y axis (RKEY, align with
the green arrow)

You've got your character now (Not exactly Pixar-like, but it will do for now). Now we just
need to give it motivation.
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Note: From points 8 to 9 it would seem that the cone should rotated so that the “nose” is
aligned with thee Y-axis in object mode, but after doing this I encountered the cone still
moved in the original Y-axis direction (before rotation). To remedy this I did the alignment
of the “nose” to the Y-axis in edit mode instead, this seems to have solved the problem.

123.4. Motion
We'll now make the character move, via the use of the WASD keys. In order to do this,
game logic needs to be associated with the WASD keys. Copy the conﬁguration seen in the
screenshot, taking care to include the convex hull polytope collision in the top left as well
as depressing the 'L' buttons, which make the force and torque local to that object rather
than global. If the force was global, the protagonist would continue moving in a straight
line, even when turning.
1.
2.
3.
4.

Go to the Logic buttons (The purple pac-man icon or F4)
Add four Sensors, Controllers and Actuators.
Maximize the logic window (CTRL+UPKEY)
Copy the conﬁguration seen in the screenshot below.

Figure 1043 Blender Game logic and Physics in version 2.76 and higher. The ”physics”
window is to be found by clicking on the last symbol of the properties window (on the
right)

(Note: I made the simulation using Actor->Dynamic since there was no way to use both dynamic and rigid body in 2.49b. After some testing it a

dLoc/dRot vs Force/Torque
The character logic in this tutorial is very similar to that of the previous platformer logic,
but it diﬀers in that it uses force and torque rather than dLoc and dRot, respectively. The
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diﬀerence between these two is that force and torque move and rotate the object within the
bullet physics engine, applying friction and collision to the process, whereas dLoc and dRot
move and rotate the object without regard for any other 'actors' (objects factored in to the
physics engine's calculations). Although dLoc and dRot would serve in most maze games,
many other instances demand force and torque. However, most of these instances occur in
more complicated games with a multitude of interactions with dynamic objects. Later in
this tutorial we will add dynamic objects to our maze, and the reasons for using force will
become clear.

123.5. Testing
Now the time has come for the ﬁrst test of our game.
1. Add a light source well above the maze (SPACE → Lamp → Lamp), align in front
view (NUM1)
2. Press NUM5 to enter perspective viewmode, which gives a realistic view, rather than
a view in which objects stay the same size with distance. Be sure to switch back to
orthographic view when you are editing (NUM5)
3. Enter textured mode (ALT+ZKEY) -- press ZKEY to switch back to solid view
mode
4. Switch into top view (NUM7) or camera view once we install the camera (NUM0)
5. PKEY to play the game
6. ESC to escape testing the game
If you receive a ”No camera” error, disregard it. We'll be adding a camera later.
If your character doesn't move at all make sure you drew the connecting 'wires' between
the actuators in the logic panel, as well as setting the ”Actor” ”Dynamic” and ”Rigid Body”
buttons to True.
You should now have a nosy cone that speeds around the maze.
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Figure 1044

(Answer to NQ1: If I understand your question right. If i used torque to turn and force
to move forward and pressed forward then turned it started spinning out of control. My
solution was to use rotation instead of torque.)
Answer to NQ2: First make sure your cone is not even partially inside the maze before
starting the game engine. Secondly, select your cone (named ”Protagonist” in my example),
then go back to the ”physics” properties in your property window. If you do not see the
property window press the NKEY and look on the right of your screen. Under ”Physics
type” make sure to have selected in the scroll down menu ”Dynamic” or ”Rigid body”. Then,
scroll down to ”collision bounds” and check the box. You shall also select a shape from the
”bound” drop down menu, for example ”cone”.
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123.6. Falling
We will now implement the ”death on falling oﬀ maze” feature. In order to accomplish this,
we'll add something that allows us to check whether the cone has fallen oﬀ the maze or
not. The simplest way to do this is with a 'skydome' object the entire maze is within, and
although there are a number of more elegant ways to accomplish the goal, we will use the
skydome method for its simplicity to replicate. From now on we'll need to test the maze
with both layers one and two enabled (SHIFT+2KEY)
1. Add a new cube
2. resize it to gargantuan proportions (SKEY, just large enough to encompass the maze,
and all within it)
3. Facultative: Move it to layer 2 (MKEY, 2KEY, Enter)
Now that you have a massive cube, go to the logic panel and add one Sensor, Controller,
Actuator set, and set them as seen in the screenshot.
1. Sensor: Touch, under ”property” put the name of your character (here ”Protagonist”)
This restart the scene if the protagonist (and only the protagonist, hits the ﬂoor)
1. Controller: And
2. Actuator: Scene, restart
3. Properties: Physics (last icon on the left), enable actor button as well as ”ghost” and
”invisible”
This will let the dynamic obstacles, which are added later on, fall through and not get stuck
there!

Figure 1045

Blender death skydome (Game Logic)
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If you test you game now, you should see the game be restarted when you fall oﬀ the maze.
As we discussed earlier, faces are one-sided in the game engine, so you should not be able
to see the cube.
(Answer: The tutorial says to create the cube in layer 2, although the layer shouldn't
matter. Make sure you test the game with both layers one and two selected. Also double
check the logic for the 'skycube')
(Answer2: I had the same problem. I ﬁxed this by replacing the cube with a grid, scaled
and placed under the maze. The grid had the touch logic mentioned above.)
(Answer3: Same here. I thought I'd remove ”Protagonist” from the material reference, but
that wouldn't do if the bricks fell down and touched the cube, it'd just restart the level...
the solution: create a property in the cone, a bool value named ”isCone” (=true), then in
the cube add a sensor 'collision' that checks for the object's property 'isCone' and keep the
rest as shown.)
(Answer4 (to restart when block hits cube):Do all as the pic shows you and RMB the cone
and go to links and pipelines and rename the MA: to cone or whatever you want, then RMB
the cube then in the Touch sensor then rename the MA: to whatever you called the other
MA: . :D this is in 24.9b)
(Answer5: For blender 2.57a you need to place a plane or something under the maze. Then
give it (touch -> and -> Scene(restart)) game logic. If it isn't working make sure that actor
is selected under physics tab.)
(Question 2: How do I make the box translucent? Right now all I see, also when testing,
is the skybox. Also, when I put the box underneath the maze, it works ﬁne, but then none
of the objects have shading, while when not showing layer 2 everything looks shaded. Can
anybody give a solution? This is in 2.48a)
(Answer: To make something transparent- press F5; press the ”Material Buttons” button;
under the Links and Pipeline tab press Halo and ZTransp, unpress Shadbuf; under Material
make A 0.000.)

123.7. Killing Floor
To add tension to your game, you can give motion to the ﬂoor. It will rise with time!
1. Add a static Plane, and set its logic panel as described above.
2. Add an ALWAYS sensor and connect it to a AND controller and connect it to a
MOTION actuator that has a vertiacal linear velocity of 0.01 (along the z-axis).
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Figure 1046

Blender Game logic ”Killing ﬂoor”. It rises with time!

This way it will slowly come up. To make it evident to the player that the ﬂoor is rising,
change the color of it (for example blue for water) and make it visible again.
You've just added some tension to your game! If you run out of time, you will touch the
ﬂoor and restart! If you need more time, simply put a lower vertical linear velocity.

123.8. Camera
SPACE → Camera near the protagonist cone. There are two easy ways to do the camera:
logic camera and child camera. In this case you might be better oﬀ with the logic camera,
but it really is a matter of personal preference.
• Logic Camera: Add to the camera's logic panel
1. Sensor: Always
2. Controller: And
3. Actuator: Camera, to object ”Cone” (or whatever your protagonist is called--look
under the object panel when you have the protagonist selected) height 5, min 5, max
10.
• Child Camera: Select the camera, then select the protagonist (order is important) then
CTRL+PKEY to parent the cone to the camera. Align the camera in a view that you
like, and test the game.
• First Person Camera: Well, this one doesn't really count as another method, but if
you're willing to redo your motion to just move the camera instead of the character, (just
do everything you did for the character for the camera) you can run around in the ﬁrst
person. Or you can just put the camera in the cone because one of the sides always are
invisible (look in texture mode) and parent it to the cone. REMEMBER: To access the
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ingame camera during gameplay, before you start, hit ctrl 0 or you can go to (view >
camera)
(Answer: Ctrl+0 assigns the selected object as a camera. To solve your problem select your
camera and press ctrl+0, to enter camera view press 0)

123.9. Beautiﬁcation
Blender is a great 3D modeling program, and with such a vast number of tools at your
disposal, you should be able to make your game look better than this:

Figure 1047 Under ”Diﬀuse” there is a white ﬁeld. Upon clicking, a color panel
appears. You can now pick a color for the selected object.

We'll add one or two textures to each of our objects.
1.
2.
3.
4.
5.

Select the object you want to texture
Go into edit mode if you want your object to have more than one color
Select all the faces you are going to assign to a color (CTRL+TAB → Faces)
Go to the edit panel (F9) on the buttons window
Near the left there should be a panel that says ”Material”. Click on the buttons
highlighted in the screenshot
6. Adjust the color of that material by clicking on the white ﬁeld under ”Diﬀuse”. A
color picker appears. Pick a color you like!
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Figure 1048

Maze without materials

Figure 1049

Maze game with materials

123.10. Mist
It looks better now, but when the camera is nearly horizontal, you can see where the camera
stops rendering the maze. You can ﬁx this by selecting the camera and, in its edit buttons,
changing its clipping range... but there is a better way. Mist.
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Figure 1050

With mist and raised sections

Mist obscures everything a certain distance away, is the same color as the world texture,
and can be handy. We'll add some mist to our game so the player can't see too far ahead
of him, thus making the game too easy.
We'll make the mist quite close, although you can vary the distance. Go to the Material
button, and to the World sub-buttons, then copy the settings in the screenshot. When
you test this out, make sure you are in texture mode to see the mist.

Figure 1051

Adding a mist around your character in Blender version 2.76

(Answer: Change Start to a smaller value like 15.)

(Question: Is the screenshot correct, or are my sizes diﬀerent. I found that a mist distance of 10 was barely visible, yet a distance of 1 had a much
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(Question: I have been able to create the mist, and can see it when I start the game, but the background colour is still grey, so the maze is obscured

123.11. Levels
Now all that remains is to create the next level with some obstacles.
1. Add a cube at the end of the maze, just above the ﬂoor level so the cone can touch it
(SPACE → Add → Mesh → Cube)
2. Press the Scene dropdown menu and select ”ADD NEW” → Full copy
3. You can now go back to the Maze Surface section to make a new maze mesh
4. Go back to level one via the Scene menu
5. Select the End of level cube
6. Change its logic panel to resemble this:
• Sensor: Touch, coneMat
• Controller: And
• Actuator: Scene, Set Scene, Scene.001 (or whatever you named your level 2)
(noob: In my level 2 my cone hits the cube and nothing happens!) Answer: Make sure that
the Sensors, Controllers and Actuators tabs under the Logic panel (F4) are connected with
wires.
(noob: When I went to level two I can't see anything!

Figure 1052

The scene button is on the top panel

To make it so multiple objects have to be touched (or acquired by the character, as it may
be), give each object the logic settings described above and change the actuator type to
Message with the subject ”goalget”. If you'd like the object to disappear after it is collected,
add an Edit Object actuator to the object of the type ”End Object”, and link it to the
existing AND controller.
Next, select the massive cube that restarts the level upon contact with the character. If
you chose not to include one such cube, create an empty at the start of the level (so you
can easily ﬁnd it again later). Give the cube or empty the following logical operators:
• Sensor: Message, goalget
• Controller: And
• Actuator: Property, Add, wincon, -1
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• Sensor: Property, Equal, wincon, 0
• Controller: And
• Actuator: Scene, Set Scene, Scene.001 (or whatever you named your level 2)
Then click ”Add Property” and give it the Type Int, the Name wincon, and a value equal to
the number of objects needed to be collected to complete the level (if all of them, make it
equal to the number contained in the level). This can be expanded to include other multiple
win conditions besides the collection of an item by making the completion of each condition
subtract from ”wincon”.
You now have a multilevel maze game. Feel free to elaborate on the gameplay mechanics
and models so they look better.
Noob note: I typed in where i thought everything should go but it's not doing anything. I'm
not sure of what I'm looking for while in playmode.

123.12. Dynamic obstacles
This part of the tutorial will assume increased skills and knowledge of the Blender interface
and basic commands. As such, this section will be written less speciﬁcally, and the shortcuts
for all basic commands will not be covered here. From this point on, this tutorial is of an
intermediate level. If you cannot follow this part of the tutorial, you can learn the basic
functions used below in an earlier tutorial2 .
We will now add some dynamic obstacles. In this case, they will constitute a 'brick' wall
that can be broken through by your character.
1.
2.
3.
4.
5.

Add a cube
Scale it (in edit mode) to the dimensions 1,0.5,0.5
Bevel it (WKEY) recursion 1, size 0.03 (press space to enter value manually)
In logic panel, set it to Actor, Dynamic, Rigid body, Mass 0.5
Go right below that to click Bounds and leave it on ”Box”. That makes Blender realize
that what you added is a box, and should act like it (instead of rolling, it will slide
now)
6. Move it to an intersection in your maze (GKEY) and duplicate it until you have a
brick wall (ALT DKEY, LMB)

2
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Conclusion

Figure 1053

You now have a barrier that your character can break through.

123.13. Conclusion
You have now learned enough of the Blender Game Engine (BGE) to create your own game.
If you wish to go very far into Blender games, I recommend you learn Python, as trying to
make a full game within the graphical interface for the BGE is like trying to dig a grave with
the blunt half of a toothpick. Blindfolded. And the toothpick is glued to your forehead.
However, you are now well on your way to becoming a game-maker! For a basic beginner
tutorial about Python, ”Open Source Video Game3 ” series.
If you have any questions, concerns, or 'noob notes', please post them in the discussion page for this tutorial, and not in the tutorial itself.

3

http://wiki.blender.org/index.php/Doc_talk:2.6/Tutorials
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124. Platformer: Improving the Physics
i

Information

Applicable Blender version: 2.45

124.1. Introduction
This tutorial is intended as an improvement on its prequel, Platformer: Creation and Controls1 , and will require ﬁles created through that tutorial. It is also recommended that you
read An aMAZEing game engine tutorial2 as well before beginning this tutorial. It will
require a familiarity with the Blender UI, simple commands (such as AKEY to select) and
basic modeling skills. This tutorial will introduce the following features and improvements:
1. only letting the character jump while touching the ground
2. stop the character from bouncing greatly upon hitting an object
3. where to adjust material friction
This tutorial was written for version 2.45.

124.2. Creating Your Hit Test Object
Copy the cube with SHIFT-D. Go into edit mode, select the bottom four vertices of the
cube and delete them. Go back to object mode. Go to the editing panel in the buttons
window. In the Link and Materials section, change the ME: value to ”Square” and the OB:
value to ”FloorHit”. In the Mesh section, there will be three buttons with the word ”center”
in them; Center, Center New, and Center Cursor. Press Center New. This will change the
origin of the ”Square” mesh to the center of all of its vertices, instead of the center of the
cube you made it from. Scale it to 0.99% of the original and move it up 0.01 along Z. Now
go to the shading panel and make sure you're in the Material buttons subpanel. Find Links
and Pipeline, and make sure ”ME is selected. Click the X next to the material selection
(under the words ”Link to Object”). Then select ”OB” and press ”Add New” and name this
material ”FloorHit” (again, no quotes). Make it green colored, so you can easily ﬁnd it
while editing, but turn on ”Shadeless” and ”No Mist” in the Material section and ”OnlyCast”
in the Links and Pipeline - Render Pipeline section and turn oﬀ ”Radio”, ”Traceable”, and

1
2

Chapter 122 on page 1147
Chapter 123 on page 1151
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”Shad(ow)buﬀer” in the Render Pipeline and ”Shadow” in the Shaders section. This will
make it completely invisible at runtime and take up little resources.
(question: it wont make it invisible it just ﬂashes rapidly)

124.2.1. Making the sensor require ﬂoor contact
Now select Suzanne and go to the logic panel. Add a touch sensor called ”jumpcol” (for
'jump collision') and connect it to the same AND controller as the jump keyboard sensor.
Set the f to 10 and the MA: to FloorHit. This will make it so your character can only jump
while it's touching something with the FloorHit material. By that same token you can link
this to all of your movement-related AND controllers so that the player can't adjust it's
movements in mid-air. This is a nice physics touch but for most platformer games, where
mid-air dexterity is almost essential, it doesn't work. You also have to use Force and not
dLoc, otherwise your character won't be able to move at all while jumping, useless your
character only needs to hit things with his/her head, and not jump over gaps. Note that
this still does not keep the character from jumping while touching the hit test object at the
sides, so they could still jump if they were touching the side of the collision surface, but at
least they can't jump in mid-air or while touching the bottom of the ground. I have yet to
ﬁnd a solution to this problem not involving Python.

124.3. Excessive Bouncing
Another problem with the original model, as you might have noticed, is that when you run
into one of the ground cubes you bounce back a great deal. To ﬁx this, turn to the materials
panel with one of your green hit test squares selected. Under the color selectors there should
be three buttons that say ”RGB”, ”HSV”, and ”DYN”. Select DYN, and turn the restitution
most or all the way up. As you can see, you can also ﬁnd the friction property from here,
if you want your ground to be more or less frictional (like mud or ice).

124.4. Final Notes
Always copy your ﬂoors, their respective hit test objects, and other generic objects with
ALT-D and not SHIFT-D. This keeps you from duplicating things that remain the same
for every one, like the material and mesh, which quickly drain resources if not recycled.
Since there's not much further you can take the Platformer without learning Python, I
suggest you start looking up information on the Blender API. Some essential information
is to be found in the procedural object creation3 tutorial. A Blend ﬁle of the tutorial's
ﬁnished product is coming soon.
Note: A (possibly) simpler method for jump limitation can be found on the discussion
page for this tutorial.

3
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125. How to Make an Executable
i Information
Applicable Blender version: 2.49
This tutorial will show you how to make an executable for your game made in Blender.
Note: The methods listed in the ”Windows” and ”GNU/Linux or Mac OS X” sections work
only for the operating system you are on when you create the ﬁle. To make it cross platform,
use the ”BlenderPlayer” method.

125.1. Windows
First create a folder that will hold all your game information. Name it something meaningful, like ”Yo Frankie!”.
The folder must contain four ﬁles that you can copy from your blender installation directory.(under windows it should be ”C:\Program Files\Blender Foundation\Blender”) They
are:
1.
2.
3.
4.

SDL.dll
python24.dll (Or other relevant python ﬁle; python25.dll, python26.dll etc.)
pthreadVC2.dll
zlib.dll

(sometimes you will need the following also...
1. avformat-51.dll
2. avutil-49.dll
3. avcodec-51.dll
They are in the same folder.)
Not quite a Noob Note: If you are using the latest version of Blender you WILL need the
following ﬁles)
I am running windows xp media edition and blender 2.46, here is a full list of ﬁles i needed:
1.
2.
3.
4.
5.

avcodec-51.dll
avformat-52.dll
avutil-49.dll
libfaac-0.dll
libfaad-0.dll
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6.
7.
8.
9.
10.
11.
12.
13.
14.

libmp3lame-0.dll
libx264-59.dll
pthreadVC2.dll
python25.dll
SDL.dll
swscale-0.dll
vcomp90.dll
xvidcore.dll
zlib.dll

On Blender 2.48a (Windows XP Media Center 2002, SP3), these .manifest ﬁles are also
required:
1.
2.
3.
4.

blender.exe.manifest
blenderplayer.exe.manifest
Microsoft.VC90.CRT.manifest
Microsoft.VC90.OpenMP.manifest

If you use random Python module in your game, you will have to add one more ﬁle to your
game directory. For Blender 2.49 it would be python26.zip, which you can ﬁnd in Blender
main directory (where blender.exe is). Otherwise there may be some errors during executing
the game in system without installed Python.
Since Blender 2.56 you will need to enable Save As Runtime; ﬁrst open blender with the
game that you have created and open the ﬁle menu. Click on User Preferences then select
Add Ons then Game Engine, check the box Game Engine Save As Runtime and return to
the ﬁle menu. Save As Runtime will appear as an option in the export menu then save to
the new folder that you have created and rename the ﬁle yourgamename.exe,
and then you can run the game!
If you encounter errors during the ”Save As Runtime” process (I'm on Windows 7) you can
right click on the Blender icon and select ”Run as administrator”. So you will have your
fresh .exe and you can spread it with a piece of your favourite pepperoni pizza.

125.1.1. Making A Screensaver (Windows Only)
1. First, save your runtime (that's the .exe addressed above.) via File->Save Game as
Runtime. (”Save Runtime” in older versions)
2. Now, go to your .exe game and rename it .scr - for instance, if your game was NotMyGame.exe, rename it to NotMyGame.scr. You can now right click to Install it,
and then use it as your regular screensaver by applying it as you would any other
screensaver (right click on desktop, properties... You know the drill.)
Screensavers are not games, and so they should not accept input. At most, they should be
videos showing what your game does. If you just rename your regular game as a .scr, it will
be remarkably boring, because your game needs input and screensavers do not.
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125.1.2. Intel screensaver bug
There is a caveat with Intel Integrated Graphics drivers, found in many laptops though. The
graphics driver shuts oﬀ OpenGL acceleration for screensavers, for some obscure reason. The
way to work around this is to rename the .scr extension to a .sCr as the driver's algorithm
is dependent on case-sensitive characters. If you experience very low framerates in your
screensaver, you should attempt this ﬁx, It is tested and reported to work.

125.2. GNU/Linux or Mac OS X
Open blender with the game that you have created and open the ﬁle menu. Click on Save
Game as Runtime and then save to the new folder that you have created and rename the
ﬁle yourgamename...
and then you can run the game!

125.3. BlenderPlayer
The methods shown above only create an executable for your operating system. Well,
BlenderPlayer can ﬁx that.
1. Make a new folder to store all your game data.
2. Then save your .blend ﬁle into the directory.
3. You can skip this step and the next step if you do not want a Windows version. For
the Windows users, copy blenderplayer.exe to the new folder from a Windows copy of
Blender. Then copy all your DLL ﬁles for Blender as mentioned for Windows to the
folder.
4. Next you have to make an MS-DOS batch ﬁle (for UNIX users, this is the shell script
equivalent). In a simple text editor, in CR-LF mode if available (Notepad is always
in this mode, and NOT a word processor!), copy and paste this text:
blenderplayer.exe yourgamename.blend
Save it as YourGameName-Windows.bat in your game folder.
5. You can skip this step if you do not want a UNIX (basically Mac OS X and
GNU/Linux) port. For GNU/Linux (at least), make a shell script. (A shell script is
the UNIX term for a batch ﬁle.) In a simple text editor, in LF mode (unfortunately
Notepad can't be used), copy and paste this text:
#!/bin/bash
./blenderplayer.app/Contents/MacOS/blenderplayer yourgamename.blend
Save the ﬁle as YourGameName-UNIX.sh in your game folder. You will need to have
BlenderPlayer in the same directory as the .blend game ﬁle.
6. Write a readme for your program. This is again best done with a simple text editor
like Notepad or gedit, but it does not matter which mode it is in. You should include
the name of the game, a description, perhaps a walkthrough or hints, and if you made
a *NIX port, mention that it requires BlenderPlayer, available with Blender.
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125.4. Legal Issues
Blender and the BlenderPlayer fall under the GNU General Public License. Blend ﬁles are
copyrighted to their respected owners and do not fall under the GPL as long as they are not
packed in the BlenderPlayer. If a user does not want the blend ﬁles to fall under the GPL,
it is recommended not to use the ”Save Game as Runtime” feature. To put it another way,
the user must keep the blend ﬁles and the BlenderPlayer in separate ﬁles. More information
can be found at http://www.blender.org/education-help/faq/gpl-for-artists/.
(Blender 2.4 now has a run game from ﬁle actuator.)

125.5. Proprietary Blend Files
Blender has no built-in functionality to ”lock” or protect user generated content. As a result,
anyone who has Blender can open and/or modify blend ﬁles. However, it's still possible to
lock blend ﬁles. Common methods involve encrypting the blend ﬁle and then temporary
decrypting it at runtime. This can be accomplished by using python scripts or by using
external 3rd party applications (which are feasible under the GPL v2).
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126. Build a Skybox
i Information
Applicable Blender version: 2.49

126.1. Prologue
One way to add a realistic feeling to your 3d environment in a game engine is to create a
skybox. A skybox is a large cube which has on its inside a projection of a 360◦ environment.
When the player (camera) is inside this environment, the scene is rendered with the illusion
of being inside a gigantic world. This is a similar eﬀect to Quicktime VR (see http:
//www.fullscreen360.com/ for examples). And, by setting up the skybox as a simple
cube shape, you place the least amount of strain on the graphics engine. It's a great
advantage for your game with very little overhead.
This tutorial will show you how to create skyboxes relatively easily from panoramic photos.
My favorite part is, you can do it easily using free tools such as Blender and the Gimp.
Using the Gimp to manipulate images is not really in the scope of this tutorial... check
out some other page on using that software. You should have an understanding of how
to edit images and apply alpha channels. (You could also use the Gimp to apply a polar
coordinate texture to your rectangular image in order to create a ﬁsheye image. Hint: it's
not the sphereize ﬁlter.)

126.2. Gather your graphics
You can take panoramic images yourself using a regular digital camera and a tripod. A
quick way to accomplish this is to draw marks on your tripod base at every 30 degrees (think
of the hours on a clock face). Make a single mark on the swivel of your tripod to allow you
to line up your shots -- twelve shots at 30 degrees each. Then, using a program such as the
Gimp1 or the incredibly cool Autostitch2 to merge the photos into one big panorama.
Or, if you're lazy like me, you can just grab photos online to use as templates to create
original images. There are also many places you can download non-copyrighted photos
for free as well. One resource for cloudy sky textures, as well as panoramic photography

1
2

http://www.gimp.org
http://www.autostitch.net
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instructions, is Philippe Hurbain's site Philo's Home Page3 . This tutorial will use a ﬁsheye
sky photo from his copyright-free Panoramic Skies images collection.
You'll also probably want a photo for your ground, unless you prefer to use real models
such as buildings in your skybox. This earlier chapter4 on creating landscapes can be
incorporated into setting up your skybox. However, this tutorial will use the sky photo for
the top half of our world, and a panoramic landscape with an alpha channel for the bottom
half. I've created a ground image using copyright-free textures obtained from Accustudio5 .
Here are the images I'll be using (you'll want to use images with higher resolution): Note
that the sky has trees, etc.

Figure 1054
3
4
5
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http://www.philohome.com
http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Mountains_Out_Of_Molehills
http://www.accustudio.com

Create a dome for the sky

Figure 1055

Note: I've outlined the horizon of the ground texture with an alpha channel which will
allow me to place the ground mesh right against the sky mesh with a very natural feel.

126.3. Create a dome for the sky
Open a new ﬁle in Blender. Your default new ﬁle will probably be a two-unit cube in the
center of the screen, with a single light source and a camera. You can delete the light
source because we won't be needing it. Leave the cube, because that is what will become
our skybox.

Figure 1056

skybox tutorial 1
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The cube will be the center of our environment, so use Object->Snap->Cursor To Selection if your cursor is not centered. Then, from the top view [KEYPAD-7], Use [KEYSPACEBAR] to insert a new mesh; make it a UV sphere. I ﬁnd a 32-segment, 32-ring sphere
to be suﬃcient. We create the sphere from the top view because that is the projection from
which we want to add the sky texture.

Figure 1057

skybox tutorial 2

Scale up the sphere so it resembles a large ”arena” in comparison to your cube, and select
and delete the lower half of the vertices, using the front view [KEYPAD-1] and [KEY-B] to
create a bounding box. It helps if ”Select Visible” is turned oﬀ so you can select all of the
vertices in one go.
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Figure 1058

skybox tutorial 3

Turn on proportional editing with [KEY-O], then select the bottom row of vertices and
scale them up with [KEY-S] so that the bottom of the sphere gets a bell shape. Because
the projection of the sky texture will be from the Y-axis (ceiling) we need the bottom faces
of the sphere to be at an angle, to catch the texture. (Faces perpendicular to the projection
will look like smears.) Alter the inﬂuence of proportional editing with [KEY-PAGEUP] and
[KEY-PAGEDOWN]. Linear or Sharp falloﬀ works best with the sphere shape.
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Figure 1059

skybox tutorial 4

Now you're ready to add your sky texture to this mesh. In the Materials menu, create a new
material and a new texture. Be sure to set your material not to receive shadows by clicking
the ”Shadeless” button. Then, in the Texture menu, set the texture type to Image, and click
the Load Image button to insert our sky texture. Back in the Materials->Texture->Map
Input menu, you may need to scale your image to get rid of the distorted textures at the
edges of the ﬁsheye by setting the Size to, say, 0.950 for X, Y and Z.

Figure 1060
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Create a dome for the ground

Figure 1061

skybox tutorial 6

At this point, if you wish, you can reposition the camera and render the scene to see how
your sky mesh looks.

126.4. Create a dome for the ground
I found it easiest to move the sky dome to a new layer with the [KEY-M] move to layer
command. Then you can select the cube, Object->snap cursor to selection if you need to,
select the top view [KEYPAD-7] and insert another UV sphere just as before -- except this
time, remove the top hemisphere of vertices. I left an extra row of vertices at the ”equator”,
scaled up, to function as a ”billboard” to display the horizon of our ground texture with the
alpha channel. This sphere should be slightly smaller than the sky hemisphere.

Figure 1062

skybox tutorial 7
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This time, I will apply the ground texture with a tube projection, so it is projected onto
the mesh horizontally [Materials panel | Map Input tab | Tube button]. Because I have
an alpha channel on this texture, I click ”Use Alpha” in the Texture menu and Map To
-> both Col and Alpha buttons [Materials Panel | Map To Tab | -> both Col and Alpha
buttons]. You will also need to set ZTransp in the Mirror Transp menu [Materials Panel
| Links and Pipelines Tab | ZTransp button] so that your alpha channel shows up in the
envmap (which will become your skybox), and Alpha to 0 [Materials panel | Material tab |
A slider ] to allow the masked areas to be transparent. (Alpha channels appear to require
Z buﬀering to appear on procedural textures.) Also, you may need to adjust the oﬀset of
the ground texture (Y-axis), so that the horizon appears properly on the ”billboard” area
of your ground hemisphere.

Figure 1063

skybox tutorial 8

Figure 1064

skybox tutorial 9

Again, you can reposition the camera and render the scene to make sure everything is
properly aligned. Be sure to activate the layer where you moved the sky mesh. Your results
will look similar to the following image. Set OSA on in the render screen for best results.
Also, use higher resolution images with cleaner alpha channels -- the image below is rather
blurry and you can see a halo around the horizon.
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Figure 1065

skybox tutorial 10

126.5. Render the environment map
The last step is to use the procedural Envmap texture to project the dome textures onto
the cube, which will become our skybox. Select the cube and create a new material. Set
the material to ”Shadeless” [Materials Panel | Materials Tab | Shadeless button]. Add a
new texture and make its type Envmap. Set the CubeRes [Envmap tab | CubeRes setting
] to whatever you want the resolution of your skybox to be (512 is a good resolution for a
game; 1024 or 2048 are fairly high-res; I stuck with low-res for this tutorial). If your sky &
ground hemispheres are very physically large, you may also need to increase the ClipEnd
value to include all of the faces. You may want to set the Envmap calculation to Anim so
you don't have to keep freeing envmap data if you're experimenting. (Anim automatically
clears Envmap data with every render, otherwise you must click 'Free Data' to reset the
Envmap.)
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Figure 1066

skybox tutorial 11

Once you've created the Envmap texture, you should be ready to render the Envmap for
your skybox. If you want to set your ﬁle format such as JPG or PNG, you should do
that ﬁrst. Then, simply go to the render screen and click ”Render.” Again, make sure all
layers are visible. The rendering window appears. First, Blender renders the environment
map of the cube. Afterward, the camera view is rendered, at which point you can hit
[KEY-ESCAPE] to stop rendering -- we are only interested in the environment map which
is already complete.
Select the cube again, then get to its texture menu. You will see the newly-rendered
Envmap on the sample texture. Click ”Save EnvMap” in the texture menu to save the
rendered Envmap.

Figure 1067

skybox tutorial 12

Blender environment maps are saved as a 3x2 matrix of squares, as seen here:
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Figure 1068

skybox tutorial 13

The cube faces are in the following order.
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Figure 1069

skybox tutorial 13

You can now load this image as an envmap texture in a new cube, which you can incorporate
into your game as a skybox. This ﬁle can also be edited in the Gimp to remove any
unwelcome artifacts such as trees, buildings, jet trails, etc. Also, because I used a tube
projection on the lower hemisphere, in the bottom face of the envmap you see a strange
star shape at the ”pole.” You'll most likely have a ﬂoor in your game, so you probably won't
see that face anyway, but sticklers can avoid it with clever use of the Filters->Distorts>Polar Coords ﬁlter in the Gimp or Filter->Distort->Polar Coordinates (Polar to Rect.)
in Photoshop. Patching also works well.
To make the skybox appear as a static background in your game, vertex-parent it to the
current active camera object.

126.6. Video Tutorial
Ira Krakow's Blender 2.49 Skybox Tutorial:
azkk3JrM5Es
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127. Basic Mouse Pointer
i Information
Applicable Blender version: 2.49

127.1. Mouse Pointer
Making a simple mouse pointer in the game engine. This takes up a lot of resources but it
is very simple.
A little Python is involved but it is very easy to use and is only 2 lines of code.
1. Open up blender and split the screen in two.
2. Make the right screen a text editor and add a new text ﬁle with ALT+N. Type in
the following code.
import Rasterizer as r
r.showMouse(1)

3. Set TX: showpointer in the middle of the Text panel menu bar.
4. Select an object that will always be available - preferably a camera.
5. Go to the logic tab, add a ”Property” sensor, a ”Python” controller, an ”AND”
controller and a ”Property” actuator.
6. Activate the True Level Triggering (the “ ‘ button), set Prop: switch and Value: 0.
Connect the property sensor to the python and AND controllers by dragging lines
between the bullets.
7. For the python controller set Script: showpointer.
Note: If the value keeps being reverted to blank after setting it, the name you entered is not a legal script name; chances are you did not set the name of your script
correctly. Look for the selection menu beginning with ”TX:” and make sure it says
TX:showpointer.
8. Now connect the AND controller to the property actuator. Set Prop: switch and
Value: 1.
9. Select Actor and click on Add Property make it a Int type and set Name:switch.
Now press P to start the game and now you‘ll see your mouse pointer.
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128. Text in BGE
i Information
Applicable Blender version: 2.49

128.1. Text
There are a lot of tutorials that show how to make text for the Blender Game Engine, for
example to use in menus. Most involve editors, graphics programs, TGA ﬁles, UV mapping,
scripting, higher magic and so on. Here is a diﬀerent approach that takes but a minute.
1.
2.
3.
4.

Start Blender.
Remove the default cube. (X)
Add text. (SPACE → Add → Text)
You may want to switch to edit mode (TAB) and use the variety of features that
Blender provides for editing, formatting and laying out text. They are described in
the Blender Manual Section1 . For a start just use BACKSPACE to delete the letters
”Text” and type your own like ”This is simple”.
5. When ﬁnished editing go back to object mode. (TAB)
6. Convert your text to a mesh. (ALT+C → Mesh)
7. Press P
This is as simple as it gets. Of course you can do all kinds of laying out with your text
before the conversion in step 6 (check the Blender Manual) as well as modeling, texturing
and dynamically manipulating thereafter (as you have a normal mesh). Simply remember
that you need to make sure the text is ﬁnal before you convert it.
This tutorial has been tested with Blender 2.8 RC1.
”However, it should be pointed out that while this is so incredibly simple, it is not poly-count
eﬃcient. Remember, there is more to making a game than making it look good--making
it run well. If you need a cut-and-dry menu, this is the best way. If you need to worry
about performance, then it might be worth it to check out some UV Mapping and external
program usage.
It is also important to note that these fonts can't be dynamic, contrary to bitmap-uvmapped
ones...

1

http://wiki.blender.org/index.php/Manual/Text
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128.2. Links
• How to create Dynamic Text in Blender Game Engine (Youtube)2

2
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http://www.youtube.com/watch?v=kcGLyl__QsA

129. Platformer: Creating the Engine
with Python
i Information
Applicable Blender version: 2.49

129.1. Introduction
Note: Python code is placed in a Text Editor window. It might be helpful to split your 3D
View window into a separate part, so that you can use a buttons, 3D view, and text editor
window simultaneously.
The initial stages of the Python Platformer tutorial series will mostly have to do with
replicating what was done in the logic board Platformer tutorials. If you have not read and
understood those tutorials, you may not understand exactly what the function of most of
this code is. This tutorial details:
1. An explanation of the ”code sections” to be modiﬁed, rewritten, or redeﬁned frequently
throughout the series
2. Creating an object linked to a pre-made mesh
3. Linking an object to a scene
and will detail by completion:
1. How to move an object in response to keyboard triggers

129.2. Code Sections
We will refer to the sections of the code in this manner throughout the series:

129.2.1. Import Section
The series of import commands at the beginning of the piece of code, like the contents of
the head tag in HTML documents. Python has a basic set of commands kept naturally in
the language, and the rest are imported so that a large amount of commands aren't loaded
when not needed, causing unnecessary memory expenditure. This lends the advantage of
being able to extend the language by writing custom sets of commands to be imported into
Python, which is how Blender interfaces with Python. For this tutorial, our import section
is:
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import Blender
import bpy

When you import something as something else, it basically creates a variable equal to the
imported module's name, so that you don't have to type it out. It is inessential, but it makes
the coding go faster. You might want to run a ﬁnd and replace search on your document
afterwards, replacing all instances of the name you imported it as with the real module's
name and deleting the part that imports the module by another name, as this can make
the code run slightly faster.

129.2.2. Essential Footer
This is the collection of commands that you must remember to include at the end of the
document, regardless of any changes made to the code, for it to work. It must be noted
whether you should change the entire footer (as if a feature was removed from the main
code-in-progress) or adding a command to your existing footer (if the text deals with the
addition of a single feature). Every article in the main tutorial line should contain the full
footer as it should look at that point in the series. For this tutorial, our essential footer is:
Blender.Redraw()

129.3. Adding the Player Object
To start, create a new document and delete the basic cube. Create a Monkey/Suzanne. In
the Editing panel with the monkey selected, change the mesh name (ME:) under Link and
Materials to ”Hero”. Click the F next to the input box to preserve the data block even when
nothing links to it. Now delete the monkey object.
The following code will create an object called ”Player” in the library and link it to the Hero
mesh:
player = Blender.Object.New("Mesh","Player")
player.link(bpy.data.meshes["Hero"])

In the ﬁrst line, Blender.Object.New obviously references a new object. The ”Mesh” variable
should not be changed for the purposes of this code. I don't know exactly it's function, so
I don't want to give out misinformation, but I speculate that it has to do with the object
type. If the object were to be a lamp or camera type, for example, you would not be able
to apply a mesh to it. The second variable, ”Player”, is the name of the actual object you're
creating. Change it to your liking.
In the second line, we link player (which was equated to our new object) to the pre-existing
mesh ”Hero”, which is the Suzanne mesh we dealt with before. Using this method, you
can model your character's mesh beforehand but have the actual character created dynamically. Using a complication of this code, you can make player.link() link to a variable
and not the bit ”bpy.data.meshes[]”. That variable can reference an existing mesh or it
can create a new one. As for the meaning of the link's value, bpy.data.meshes is an array containing all the meshes in the movie. Likewise, bpy.data.objects contains all the
objects in the movie. By going to the Scripts window and going to Scripts->System>Interactive Console you can gain such information as the contents of these arrays. By
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entering ”list(bpy.data.objects)” into the console, you will be rewarded with a list in the
format of [[Object ”Camera”], [Object ”Cube”], [Object ”Lamp”]] which is the list of objects
in the standard new document set-up. So, to reference the item [Object ”Cube”] you would
use the line ”bpy.data.objects['Cube']” and so on. For these commands to work, you must
make sure to import bpy in your import section.

129.3.1. Appending the Object to the Scene
Like you must append the mesh to the object, you must also append the object to the scene,
or it will just be a ﬂoating data block and not actually appear anywhere.
scene = Blender.Scene.GetCurrent()
scene.link(player)

If you were to test this code by pressing ALT-P while the mouse is hovering over the Text
Editor window, it would create an object named Player with the monkey ”Hero” mesh at
the origin point of your scene. Make sure you included this tutorial's import section before
all of the other code and the essential footer after all of other code.
version 2.7:
import bpy
myMesh = bpy.data.meshes["Hero"]
player = bpy.data.objects.new("Mesh", myMesh)

# reference existing mesh
# create new object

player.name = "Player"

# give it a name

bpy.context.scene.objects.link(player)

# link to the scene to show
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130. Introduction
i Information
Applicable Blender version: 2.67
Python is a powerful, high-level, dynamic language. The version of Python used in Blender
2.67 is 3.3. If you are unfamiliar with Python, start with the Python book1 . If you are
familiar with older (2.x) versions of Python, this page2 summarizes what’s new in 3.x.
If you are familiar with Python scripting in older versions of Blender, be aware that
2.5x/2.6x is completely diﬀerent; the old Blender module is gone. Much of the functionality
is now available through the bpy module, but don’t expect an exact 1:1 correspondence.

130.1. First Steps In Blender Scripting
Open a new, default Blender document. If you haven’t customized your settings, there will
be a Timeline

1
2

https://en.wikibooks.org/wiki/Python
http://docs.python.org/py3k/whatsnew/3.0.html
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Figure 1070

window along the bottom; change this to a Python Console
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Figure 1071

. Perhaps increase its height to let you see more lines at once.
To start with, let’s ﬁnd out what objects are present in the document. At the “>>>”
prompt, type
bpy.data.objects

You should see the response
<bpy_collection[3], BlendDataObjects>

which isn’t actually all that informative. In fact what you have here is an iterator; to see
its contents, just do the usual Python thing and convert it to a list. Try entering this:
list(bpy.data.objects) #or bpy.data.objects[:]

This time the response should be
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[bpy.data.objects["Camera"], bpy.data.objects["Cube"], bpy.data.objects["Lamp"]]

which shows you how to refer to the three default objects you can see in the 3D View
window.
Let’s get a reference to the Cube object for more convenient access: type
Cube = bpy.data.objects["Cube"]

Now let’s try querying the value of one of its attributes: type
Cube.delta_location

You should see the response
Vector((0.0, 0.0, 0.0))

The Vector type comes from the mathutils module provided by Blender. But unlike
bpy, this is not automatically imported into the Python Console. So let’s bring it in for
subsequent use: type
import mathutils

OK, now let’s try changing the location of the default Cube: type
Cube.delta_location += mathutils.Vector((1, 1, 1))

(Note the doubled parentheses: mathutils.Vector takes a single argument, which is a
tuple of X, Y and Z coordinate values.)
Were you watching the 3D View when you pressed ENTER ? You should have seen the
cube jump to a diﬀerent position. To make it move again, press UPARROW to bring back
the above command, so you can execute it again with ENTER . As soon as you do this,
the cube will jump another step, like before. And that’s it—you’re scripting!

130.2. The bpy Module
The contents of the bpy module are divided into several submodules, among which are:
• bpy.data — This is where you ﬁnd the contents of the current document.
• bpy.types — information about the types of the objects in bpy.data.
• bpy.ops — operators perform the actual functions of Blender; these can be attached to
hotkeys, menu items and buttons. And of course they can be invoked from a script.
When you write an addon script, it will typically deﬁne new operators. Every operator
must have a unique name.
• bpy.context — contains settings like the current 3D mode, which objects are selected,
and so on. Also accessible in the Console window via the global variable C.
• bpy.props — functions for deﬁning properties. These allow your scripts to attach custom
information to a scene, that for example the user can adjust through interface elements
to control the behaviour of the scripts.
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130.3. The mathutils Module
The module mathutils deﬁnes several important classes that are used heavily in the rest
of the Blender API.
• Vector: the representation of 2D or 3D coordinates.
• Matrix: the most general way of representing any kind of linear transformation.
• Euler: a straightforward way of representing rotations as a set of Euler angles, which are
rotation angles about the X, Y and Z axes. Prone to well-known pitfalls such as gimbal
lock3 .
• Quaternion: on the face of it, a more mathematically abstruse way of representing rotations. But in fact this has many nice properties, like absence of gimbal lock, and smoother
interpolation between two arbitrary rotations. The latter is particularly important in
character animation.
• Color: a representation of RGB colours and conversion to/from HSV space (no alpha
channel).

130.4. See Also
• Scripting & Extending Blender Advanced4
• Blender 2.67.0 r56533 API Reference5
• Blender site Python scripts catalog6

3
4
5
6

https://en.wikipedia.org/wiki/Gimbal_lock
https://docs.blender.org/manual/en/dev/advanced/scripting/index.html
http://www.blender.org/documentation/blender_python_api_2_67_release//
http://wiki.blender.org/index.php/Extensions:Py/Scripts/Catalog
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131. Anatomy Of An Addon
i Information
Applicable Blender version: 2.57

131.1. Introduction
An addon is a Python script that can extend the functionality of Blender in various ways.
It can reside in a ﬁle within your Blender user preferences directory, or it can be stored
in a text block within the Blender document. In the former case, the addon needs to be
enabled in each Blender document where you want to use it, by ticking the checkbox in its
entry in the Add-Ons list in the User Preferences window for that document. In the latter
case, the script can be run by pressing ALT + P in the Text Editor window; or you
can tick the “Register” checkbox for that script in the Text Editor, to have the addon be
automatically enabled as soon as the document is loaded into Blender.
The main thing an addon script typically does is deﬁne one or more new operators. All
the user-interface functions in Blender are performed by operators; these are invoked by
being associated with menu items, buttons or hotkeys. Each operator is a subclass of the
bpy.types.Operator class. The name you give your class in Python is immaterial outside
the script where it is deﬁned; it will be referred to from the rest of Blender via its operator
name, which must be unique within the document. In the same way, your script can invoke
other operators deﬁned elsewhere via Blender API functions that take their operator name.

131.2. Text Blocks
A Blender document can contain text blocks, which are not the same as text objects in a 3D
scene (though the former can be converted to the latter). Besides generating text objects, a
text block can serve any purpose you like; for example, use it to pass workﬂow instructions
to a colleague along with the document; display a copyright or help message in the initial
layout that a user sees on opening the document; or hold a Python script that can be run
by the user to perform some useful action related to the document.

131.3. Your First Operator
Open a new, empty Blender document. Bring up the Text Editor
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Figure 1072

in any convenient window; you will see an empty, grey rectangle. Before you can type in
text, you need to create a text block; do so by clicking the large button labeled “New” in
the window header. As soon as you do this, you should see a popup menu appear listing all
the text blocks in your document, with the current (only) entry named “Text”. You should
also see a red insertion cursor appear at the top left, indicating that you can start typing.
Unlike the Console Window, nothing is automatically imported for you. So as in any other
Python script, you need to mention every module you want to access.
You deﬁne your operator as a subclass of a subclass of the bpy.types.Operator. It must
have a bl_idname class attribute which gives the operator name, while bl_label gives the
user-visible name that appears in the spacebar menu. The former must have valid Python
syntax for a name, including a single dot; the part to the left of the dot must be the name
of one of the valid categories of operators, which you can ﬁnd by typing
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dir(bpy.ops)

into the Console Window.
Let’s deﬁne an operator that will add a new tetrahedron object to the document. The class
deﬁnition should start something like this:
class MakeTetrahedron(bpy.types.Operator) :
bl_idname = "mesh.make_tetrahedron"
bl_label = "Add Tetrahedron"

It has to deﬁne an invoke method, which starts oﬀ like this:
def invoke(self, context, event) :

The invoke method performs the actual function of the operator; after it has ﬁnished, it
must return a value which is a set of strings, telling Blender things like whether the operator
is still executing in a modal state, or whether the operation has ﬁnished, and if so whether
it was successful or not. To indicate successful completion: end the invoke method with
this:
return {"FINISHED"}

Anyway, let us compute the coordinates of the vertices for the tetrahedron: with edges
1
1
, 0), (− 21 , 2√
, 0) and
with a length of 1 Blender unit, suitable values are (0, − √13 , 0), ( 12 , 2√
3
3
√

(0, 0,

2
3 ).

Or in Python:

Vertices = \
[
mathutils.Vector((0, -1 / math.sqrt(3),0)),
mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((0, 0, math.sqrt(2 / 3))),
]

Then we create the mesh datablock, giving it the name “Tetrahedron”:
NewMesh = bpy.data.meshes.new("Tetrahedron")

Fill it in with the above vertex deﬁnitions and associated faces:
NewMesh.from_pydata \
(
Vertices,
[],
[[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]]
)

The Mesh.from_pydata method is not currently well documented in the Blender API, but
its ﬁrst argument is an array of Vector deﬁning the vertices, the second argument is an
array of edge deﬁnitions, and the third argument is an array of face deﬁnitions. Each edge
or face is deﬁned as a list of vertex indices (2 elements in each list for an edge, 3 or 4 for a
face), 0-based in usual Python style, being indices into the array of vertex deﬁnitions that
you passed. Note that you pass either the edge deﬁnitions or the face deﬁnitions,
but not both: the other one should be passed as the empty list. If this function is not
used correctly, it will cause Blender to crash.
We also need to add the following, to tell Blender the mesh has changed and needs updating
(as if it couldn’t ﬁgure it out itself):
NewMesh.update()
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(Omitting this produces a minor quirk: right-clicking the newly-created tetrahedron does
not highlight its outline in orange as with other objects, though the problem goes away if
you enter edit mode on the object and exit again.)
Now to create the object datablock (I also give it the name “Tetrahedron”), and link it to
the mesh:
NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)

But the object will not appear to the user until it is linked into the scene:
context.scene.objects.link(NewObj)

To recap, here is the complete script:
import math
import bpy
import mathutils
class MakeTetrahedron(bpy.types.Operator) :
bl_idname = "mesh.make_tetrahedron"
bl_label = "Add Tetrahedron"
def invoke(self, context, event) :
Vertices = \
[
mathutils.Vector((0, -1 / math.sqrt(3),0)),
mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((0, 0, math.sqrt(2 / 3))),
]
NewMesh = bpy.data.meshes.new("Tetrahedron")
NewMesh.from_pydata \
(
Vertices,
[],
[[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]]
)
NewMesh.update()
NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
context.scene.objects.link(NewObj)
return {"FINISHED"}
#end invoke
#end MakeTetrahedron
bpy.utils.register_class(MakeTetrahedron)

Note the addition of the register_class call, to make Blender add your operator to its built-in
collection.
Now execute your script by typing ALT + P . If all goes well nothing should appear to
happen; Blender will deﬁne the class and register it as a new operator as you requested,
ready for use.
If you hit any syntax errors, Blender should display these in a popup window; go back and
correct them, and re-execute the script with ALT + P .

131.4. Invoking Your Operator
We haven’t (yet) deﬁned any user interface for this operator; so how do we invoke it? Simple.
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Go to a 3D View window. Delete the default cube to avoid it obscuring things, and press
SPACE . This brings up a searchable menu of every operator deﬁned for the current document. Into the search box, type part or all of the string you deﬁned for the bl_label
attribute above (typing “tetra” should probably be enough). This will restrict the menu to
only showing items that contain that string, which should include the name of your operator; click with LMB on this or highlight it and press ENTER . If all goes well, you should
see your tetrahedron object appear!

Figure 1073

131.5. If You Hit An Error
If there is any error compiling or running the script, Blender should display this in a popup.
For example, the following simple one-line script
raise RuntimeError("Uh-oh")

displays this popup:

Figure 1074
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The full Python traceback message is written to Standard Error, and looks something like
this:
Traceback (most recent call last):
File "/Text", line 1, in <module>
RuntimeError: Uh-Oh!

On Linux/Unix systems, the message will appear in the terminal session if you invoked
Blender from the command line; otherwise it will be appended to your ~/.xsessionerrors
ﬁle if you launched Blender from a GUI. On Windows the message appears in the console
window.
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132. A User Interface For Your Addon
i Information
Applicable Blender version: 2.68

132.1. Start
So you’ve deﬁned a new operator in your addon. Now it would be nice to give that addon
a proper interface, so the user doesn’t have to hunt through the spacebar menu to ﬁnd that
operator.
The nicest way to do this is to deﬁne a panel that shows up in a window somewhere, with
controls in it that the user can click on to operate your addon. You can put the panel in all
kinds of places, but here we will insert it in the Tool Shelf (which can be hidden or shown
on the left side of the 3D View by pressing T .

132.2. Your First Panel
A panel is deﬁned by subclassing the bpy.types.Panel class. You set the value of various
attributes (bl_space_type, bl_region_type, bl_category and bl_context) to determine the
context in which the panel will appear, and also give a title to the panel (bl_label):
class TetrahedronMakerPanel(bpy.types.Panel):
bl_space_type = "VIEW_3D"
bl_region_type = "TOOLS"
bl_context = "objectmode"
bl_category = "Create"
bl_label = "Add Tetrahedron"

Those ﬁrst three attributes cause the panel to appear in the Tool Shelf, but only while the
3D View is in Object mode.The bl_category line determines the toolbar tab the addon is
placed in, and only applies to the toolbars with tabs (added 2.7). Specify any existing tab,
or deﬁne a new one.
Your class also needs to deﬁne a draw method, which deﬁnes the items that go into the
panel. This example creates a new column of UI elements for the panel, and inserts a single
UI element which is a button that will invoke the operator with the name you previously
deﬁned when clicked:
def draw(self, context):
TheCol = self.layout.column(align=True)
TheCol.operator("mesh.make_tetrahedron", text="Add Tetrahedron")
#end draw
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132.3. Adding Undo Support
While we’re at it, go back and add the following line to the operator deﬁnition:
bl_options = {"UNDO"}

This allows the user to undo the addition of the tetrahedron in the usual way with CTRL
+ Z , and redo it with CTRL + SHIFT + Z .

132.4. Put It All Together
Here is the complete script for the addon as it stands now:
import math
import bpy
import mathutils
class TetrahedronMakerPanel(bpy.types.Panel):
bl_space_type = "VIEW_3D"
bl_region_type = "TOOLS"
bl_context = "objectmode"
bl_category = "Create"
bl_label = "Add Tetrahedron"
def draw(self, context):
TheCol = self.layout.column(align=True)
TheCol.operator("mesh.make_tetrahedron", text="Add Tetrahedron")
#end draw
#end TetrahedronMakerPanel
class MakeTetrahedron(bpy.types.Operator):
bl_idname = "mesh.make_tetrahedron"
bl_label = "Add Tetrahedron"
bl_options = {"UNDO"}
def invoke(self, context, event):
Vertices = \
[
mathutils.Vector((0, -1 / math.sqrt(3),0)),
mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((0, 0, math.sqrt(2 / 3))),
]
NewMesh = bpy.data.meshes.new("Tetrahedron")
NewMesh.from_pydata \
(
Vertices,
[],
[[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]]
)
NewMesh.update()
NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
context.scene.objects.link(NewObj)
return {"FINISHED"}
#end invoke
#end MakeTetrahedron
bpy.utils.register_class(MakeTetrahedron)
bpy.utils.register_class(TetrahedronMakerPanel)

Note the addition of another register_class call for our custom panel.
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As before, hit ALT + P to execute it. Nothing should appear to happen; Blender processes
your subclass deﬁnitions, and registers them for use, as requested, in the appropriate places.
But now, go back to the 3D View. Make sure you are in Object mode. Bring up the Tool
Shelf if it isn’t visible, by pressing T . At the bottom; in the tab you have speciﬁed, you
should see your new panel appear:

Figure 1075

Note the triangle next to the title that Blender automatically gives you, to collapse or
expand the panel without any extra work on your part. Get rid of any tetrahedron object
that might have been created by following the tutorial on the previous page; now click your
new “Add Tetrahedron” button, and watch the object be created again!

132.5. Space Types, Region Types, Contexts, Oh My!
Those values for bl_space_type, bl_region_type and bl_context are (partially) listed here1
in the Blender API documentation, but not fully explained. Here’s a list of permissible
values for each that I found from looking at source code:
Attribute

1

Permissible Values

Source Reference

http://www.blender.org/documentation/blender_python_api_2_68_release/bpy.types.Panel.
html
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Attribute
bl_space_type

Permissible Values
”EMPTY”, ”VIEW_3D”,
”TIMELINE”,
”GRAPH_EDITOR”,
”DOPESHEET_EDITOR”,
”NLA_EDITOR”, ”IMAGE_EDITOR”, ”SEQUENCE_EDITOR”,
”CLIP_EDITOR”,
”TEXT_EDITOR”,
”NODE_EDITOR”,
”LOGIC_EDITOR”, ”PROPERTIES”, ”OUTLINER”,
”USER_PREFERENCES”,
”INFO”, ”FILE_BROWSER”,
”CONSOLE”
bl_region_type ”WINDOW”, ”HEADER”,
”CHANNELS”, ”TEMPORARY”, ”UI”, ”TOOLS”,
”TOOL_PROPS”, ”PREVIEW”
bl_context
”mesh_edit”, ”curve_edit”, ”surface_edit”, ”text_edit”, ”armature_edit”, ”mball_edit”,
”lattice_edit”, ”posemode”,
”sculpt_mode”, ”weightpaint”,
”vertexpaint”, ”imagepaint”, ”particlemode”, ”objectmode”

Source Reference
space_type_items in
rna_space.c2

region_type_items in
rna_screen.c3

data_mode_strings in context.c4

Presumably, not all combinations will make sense.

2
3
4

https://svn.blender.org/svnroot/bf-blender/trunk/blender/source/blender/makesrna/
intern/rna_space.c
https://svn.blender.org/svnroot/bf-blender/trunk/blender/source/blender/makesrna/
intern/rna_screen.c
https://svn.blender.org/svnroot/bf-blender/trunk/blender/source/blender/blenkernel/
intern/context.c
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133. Adding A Custom Property
i Information
Applicable Blender version: 2.57
Addons will commonly do more than unconditionally perform a single action; the user may
be able to control their actions in various ways. We can add controls for adjusting settings to
our addon panel, and associate these with custom properties that we deﬁne for the current
scene; Blender will then take care of updating the property values as the user operates those
controls, and our operator’s invoke routine can fetch those property values when it runs.

133.1. Deﬁning A Property
Properties need to be deﬁned at the same time our custom classes get registered. We
previously did this in top-level statements, but now let’s gather it all together into a
register method, like this:
def register() :
bpy.utils.register_class(MakeTetrahedron)
bpy.utils.register_class(TetrahedronMakerPanel)
bpy.types.Scene.make_tetrahedron_inverted = bpy.props.BoolProperty \
(
name = "Upside Down",
description = "Generate the tetrahedron upside down",
default = False
)
#end register

Here we are attaching the property as a new attribute of Blender’s Scene class; Python
lets us assign new attributes to just about any object, and Blender takes full advantage of
that. Note that the property must be created using one of the property-deﬁnition routines
provided in bpy.props: choose the one that matches the type of property you want to create.
Here we are deﬁning a simple true/false toggle, which the user will control via a checkbox.
Whatever name you use for your custom class attribute, an instance of that class will have
an attribute with the same name, holding the actual value for that property.
The name will be used as the name of a control for examining or changing this property,
while the description will appear as a tooltip when the user hovers the mouse over the
control. The default is used as the initial value of the property.
Note also I tried to use a name, make_tetrahedron_inverted, which is less likely to clash
with names deﬁned by other addons or parts of Blender.
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Let’s also add an unregister method, which undoes everything that register does. This won’t
actually be used for now, but it will become relevant later when we extract the addon for
separate installation:
def unregister() :
bpy.utils.unregister_class(MakeTetrahedron)
bpy.utils.unregister_class(TetrahedronMakerPanel)
del bpy.types.Scene.make_tetrahedron_inverted
#end unregister

To make the checkbox appear, add the following line to our panel’s draw routine:
TheCol.prop(context.scene, "make_tetrahedron_inverted")

The ﬁrst argument to the prop method must be an instance of the class to which we attached
our property deﬁnition above; in this case, it is the current scene.
Finally, we need to ﬁnish oﬀ our script with the following bit of boilerplate which will invoke
our registration routine in the situations (like the Text Editor) where Blender doesn't do it
for us:
if __name__ == "__main__" :
register()
#end if

133.2. Using The Property
Now we actually need to use the property in our operator’s execute routine. We’ll use it
to negate a scale factor which will be applied to the Z coordinate of the vertices of the
tetrahedron:
Scale = -1 if context.scene.make_tetrahedron_inverted else 1

But only the last vertex has a nonzero Z coordinate, so this is the only one that needs a
change in its computation:
Vertices = \
[
mathutils.Vector((0, -1 / math.sqrt(3),0)),
mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((0, 0, Scale * math.sqrt(2 / 3))),
]

133.3. Put It All Together
To recap all our changes, here is the complete updated script:
import math
import bpy
import mathutils
class TetrahedronMakerPanel(bpy.types.Panel) :
bl_space_type = "VIEW_3D"
bl_region_type = "TOOLS"
bl_context = "objectmode"
bl_category = "Create"
bl_label = "Add Tetrahedron"
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def draw(self, context) :
TheCol = self.layout.column(align = True)
TheCol.prop(context.scene, "make_tetrahedron_inverted")
TheCol.operator("mesh.make_tetrahedron", text = "Add Tetrahedron")
#end draw
#end TetrahedronMakerPanel
class MakeTetrahedron(bpy.types.Operator) :
bl_idname = "mesh.make_tetrahedron"
bl_label = "Add Tetrahedron"
bl_options = {"UNDO"}
def invoke(self, context, event) :
Scale = -1 if context.scene.make_tetrahedron_inverted else 1
Vertices = \
[
mathutils.Vector((0, -1 / math.sqrt(3),0)),
mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((0, 0, Scale * math.sqrt(2 / 3))),
]
NewMesh = bpy.data.meshes.new("Tetrahedron")
NewMesh.from_pydata \
(
Vertices,
[],
[[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]]
)
NewMesh.update()
NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
context.scene.objects.link(NewObj)
return {"FINISHED"}
#end invoke
#end MakeTetrahedron
def register() :
bpy.utils.register_class(MakeTetrahedron)
bpy.utils.register_class(TetrahedronMakerPanel)
bpy.types.Scene.make_tetrahedron_inverted = bpy.props.BoolProperty \
(
name = "Upside Down",
description = "Generate the tetrahedron upside down",
default = False
)
#end register
def unregister() :
bpy.utils.unregister_class(MakeTetrahedron)
bpy.utils.unregister_class(TetrahedronMakerPanel)
del bpy.types.Scene.make_tetrahedron_inverted
#end unregister
if __name__ == "__main__" :
register()
#end if

As before, execute the script with ALT + P . Check the Tool Shelf in the 3D View, and
your panel should now look like this:
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Figure 1076

Try executing it with and without the checkbox checked, and you should end up with two
tetrahedra pointing in opposite directions.
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134. A Separately Installable Addon
i Information
Applicable Blender version: 2.57
Embedding a script inside a Blender document is useful for some special purposes, but
often you want to be able to reuse an addon across any number of Blender documents, and
perhaps distribute it to others for use with their Blender projects. To do this, you will need
to save the script as a text ﬁle that can be copied into your Blender user preferences. It
will also need to have some additional information inserted.

134.1. The Addon Info Dictionary
In order for the addon to be installable by Blender, it will need to deﬁne a global called
bl_info, the value of which is a dictionary. This contains various information about compatibility with versions of Blender, and also descriptive information to be shown to the user
as they browse through the list of installable addons.
Here’s what the info should look like:
bl_info = \
{
"name" : "Tetrahedron Maker",
"author" : "J Random Hacker <jrhacker@example.com>",
"version" : (1, 0, 0),
"blender" : (2, 5, 7),
"location" : "View 3D > Edit Mode > Tool Shelf",
"description" :
"Generate a tetrahedron mesh",
"warning" : "",
"wiki_url" : "",
"tracker_url" : "",
"category" : "Add Mesh",
}

Most of the ﬁelds are informational. The “category” value must be one of the predeﬁned
ones that you will see listed in Blender’s User Preferences window when you switch to the
“Add-Ons” tab; the addon display is sorted by category and by name within category, and
the user can list scripts in all categories or in just one category.
The “version” ﬁeld indicates the version of your script, and can be a tuple of any number of
integers; the numbers are shown to the user joined with decimal points (e.g. “(1, 0, 0)” is
displayed as “1.0.0”). The “blender” ﬁeld indicates compatibility with versions of Blender;
Blender versions older than this are supposed to reject the script. (Though what happens
when a newer version introduces a backward-incompatible API change is not quite clear...)
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134.2. Making The Addon Installable
The contents of your addon script are now complete. In the Text Editor, ﬁnd the “Save As”
option under the “Text” menu, and choose a ﬁlename for saving your script—perhaps call
it TetrahedronMaker.py.
That’s it. This saved text ﬁle is your complete addon, ready for installation into your
Blender user settings, or distribution to others for installation in their settings.

134.3. Installing The Addon
To install the addon into your Blender user settings, go to the User Preferences, and bring up
the Add-Ons tab. (It doesn’t matter what document you might have open at this stage.) In
the window header, click the “Install Add-On...” button, and ﬁnd the TetrahedronMaker.py
ﬁle you previously saved; select that, and click the “Install Add-On” button in the ﬁle
selector. This copies the script ﬁle into your personal addons directory, which in Unix/Linux
is ~/.blender/2.5x/scripts/addons/. You can also directly copy your script ﬁle into this
directory, instead of using the “Install Add-On...” button. To uninstall an addon, use
the Remove button that appears in its info panel (see below) or delete the script from this
directory, together with its .pyc (compiled) version (which you will ﬁnd in the __pycache__
subdirectory).

134.4. Using The Installed Addon
To make use of the installed addon, open a new Blender document. Go to the User Preferences window, and bring up the Add-Ons tab. Browse through the list of addons (feel free
to restrict the display to the “Add Mesh” category as speciﬁed above) until you ﬁnd your
Tetrahedron Maker. You can click the white triangle to the left of the name to expand the
list item display to show all the details:

Figure 1077

Note the buttons that may appear along the bottom: the “Remove” button appears for your
own user-installed scripts, not for ones installed systemwide; the “Link to the Wiki” button
is only visible if you provided a URL in the “wiki_url” ﬁeld of your bl_info; and “Report a
Bug” comes up only if there is something in the “tracker_url” ﬁeld.
Click the checkbox in the top right corner of the item display to enable the addon for this
document.
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Now switch to the 3D View, bring up the Tool Shelf if it’s not already visible, and you
should see that familiar panel appear:

Figure 1078

You know what to do next...
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135. Object, Action, Settings
i Information
Applicable Blender version: 2.68

135.1. Prologue
Now that we’ve covered the basics of writing a working addon and making it installable,
let’s add some reﬁnements to its functionality.
To start with, users normally add new objects via the Add menu which pops up when pressing SHIFT + A , rather than via a custom panel. Can our script add a new “Tetrahedron”
item to that menu? Yes it can.
Also, our script currently requires us to adjust its setting (the “Upside-Down” checkbox) before it performs its action. In user-interface parlance, this is the ordering “Object→Setting→Action”: select an object, specify the settings for the action, then perform
the action. Whereas the preferred order in Blender 2.5x is “Object→Action→Setting”: which
means the action is performed with some initial settings, which the user is then free to modify while observing their eﬀect. This gives a much smoother workﬂow, rather than the user
having to guess what the eﬀects will be before applying them, and then undoing and trying
again if they guessed wrong.
(Of course, since our example script creates a new object rather than modifying an existing
one, the initial “Object” step is not relevant here. But it is to other operators.)
So the modiﬁcations we need to make to our script are:
• Get rid of the existing Panel subclass.
• Our register function will add a new entry to the Add menu (speciﬁcally, the mesh-add
submenu) to invoke our Operator subclass.
• When our operator is invoked, a panel will appear, with all the settings controls we
previously had, except for the “Add” button. The user can play with these settings, and
observe the eﬀect on the newly-created object immediately.
The nice thing is, Blender does most of the hard work for us, so we only need to edit a few
lines of code to achieve all the above!
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135.2. Adding To The Add Menu
This needs to be done in two steps. First we need a function which will be invoked when
Blender creates its Add menu: this will add an entry that invokes our custom operator by
its name. Speciﬁcally, we will add our custom item to the “Mesh” submenu of the “Add”
menu. We can also assign an icon to the menu item; here I’m using the generic plugin icon:
def add_to_menu(self, context) :
self.layout.operator("mesh.make_tetrahedron", icon = "PLUGIN")
#end add_to_menu
# version 2.72b only allows for the icon value from the set:
# ("NONE", "QUESTION", "ERROR", "CANCEL", "TRIA_RIGHT", "TRIA_DOWN",
# "TRIA_LEFT", "TRIA_UP", "ARROW_LEFTRIGHT", "PLUS", "DISCLOSURE_TRI_DOWN",
# "DISCLOSURE_TRI_RIGHT", "RADIOBUT_OFF", "RADIOBUT_ON", "MENU")

Having done that, we change our register function to add our add_to_menu item to a list
that Blender uses to create its Add→Mesh menu:
def register() :
bpy.utils.register_class(MakeTetrahedron)
bpy.types.INFO_MT_mesh_add.append(add_to_menu)
#end register

Note this bpy.types.INFO_MT_mesh_add object is not currently mentioned in the API
documentation; I found it by examining the scripts that come bundled with Blender.
And of course we should clean up ourselves, so the unregister function needs to remove the
item we added:
def unregister() :
bpy.utils.unregister_class(MakeTetrahedron)
bpy.types.INFO_MT_mesh_add.remove(add_to_menu)
#end unregister

135.3. Fixing Up The UI
Note that previously, our register and unregister functions were attaching a custom property
to Blender’s Scene class to hold our setting value. That code is now gone, but we still need
the property. Instead, it will now be attached directly to our MakeTetrahedron class.
Also, remember we said we were getting rid of the TetrahedronMakerPanel class? In fact
we keep the draw method from that, and move it to our MakeTetrahedron operator, only
getting rid of the last button in the panel for invoking the operator. This is because by the
time the panel is being drawn, the operator has already been invoked.
We also need to tell Blender that we are conforming to the Object→Action→Settings convention, by adding the ”REGISTER” item to our bl_options.
So the header of our operator class now looks like this:
class MakeTetrahedron(bpy.types.Operator) :
bl_idname = "mesh.make_tetrahedron"
bl_label = "Tetrahedron"
bl_options = {"REGISTER", "UNDO"}
inverted = bpy.props.BoolProperty \
(
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name = "Upside Down",
description = "Generate the tetrahedron upside down",
default = False
)
def draw(self, context) :
TheCol = self.layout.column(align = True)
TheCol.prop(self, "inverted")
#end draw

Previously our custom property was called make_tetrahedron_inverted, but here I just call
it inverted, because after all it is being attached to our own class, so there should be no
worry about name clashes.
Note that I also changed the bl_label text, taking out the word “Add”. This is redundant,
because our label will be appearing in a menu that is already titled “Add”.

135.4. invoke Versus execute
The last thing to do is rearrange the code for actually creating the tetrahedron object.
Previously we had it in a method called invoke, and that method will still be called when
our operator is selected from the Add→Mesh menu. Then our draw method will be called,
so our panel will also appear. But then, if the user makes adjustments to the controls in
our panel, Blender will invoke a diﬀerent operator method, called execute.
To the user, it looks like they are making adjustments to an already-created object. But
in fact our execute method can do exactly the same thing as invoke, namely create a new
object every time it’s called! Blender will take care of getting rid of previously-created
objects, so the user won’t know the diﬀerence.
Nice, isn’t it? But in order for this to work, our code needs to do one thing more: ensure
that our newly-created object is the only selected, active object. So the following is added
after NewObj has been created and linked into the scene:
bpy.ops.object.select_all(action = "DESELECT")
NewObj.select = True
context.scene.objects.active = NewObj

135.5. Put It All Together
Note that the object-creation code has been moved into a common routine that I have called
action_common. This can then be called from both the invoke and execute methods.
import math
import bpy
import mathutils
class MakeTetrahedron(bpy.types.Operator) :
bl_idname = "mesh.make_tetrahedron"
bl_label = "Tetrahedron"
bl_options = {"REGISTER", "UNDO"}
inverted = bpy.props.BoolProperty \
(
name = "Upside Down",
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description = "Generate the tetrahedron upside down",
default = False
)
def draw(self, context) :
TheCol = self.layout.column(align = True)
TheCol.prop(self, "inverted")
#end draw
def action_common(self, context) :
Scale = -1 if self.inverted else 1
Vertices = \
[
mathutils.Vector((0, -1 / math.sqrt(3),0)),
mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
mathutils.Vector((0, 0, Scale * math.sqrt(2 / 3))),
]
NewMesh = bpy.data.meshes.new("Tetrahedron")
NewMesh.from_pydata \
(
Vertices,
[],
[[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]]
)
NewMesh.update()
NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
context.scene.objects.link(NewObj)
bpy.ops.object.select_all(action = "DESELECT")
NewObj.select = True
context.scene.objects.active = NewObj
#end action_common
def execute(self, context) :
self.action_common(context)
return {"FINISHED"}
#end execute
def invoke(self, context, event) :
self.action_common(context)
return {"FINISHED"}
#end invoke
#end MakeTetrahedron
def add_to_menu(self, context) :
self.layout.operator("mesh.make_tetrahedron", icon = "PLUGIN")
#end add_to_menu
def register() :
bpy.utils.register_class(MakeTetrahedron)
bpy.types.INFO_MT_mesh_add.append(add_to_menu)
#end register
def unregister() :
bpy.utils.unregister_class(MakeTetrahedron)
bpy.types.INFO_MT_mesh_add.remove(add_to_menu)
#end unregister
if __name__ == "__main__" :
register()
#end if
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135.6. Undocumented Blender
That INFO_MT_mesh_add object is one of a bunch of undocumented things lurking in the
bpy.types module. They all have names of the form preﬁx_type_restofname, where preﬁx is
an all-uppercase mnemonic for the category of object (mostly a window type, e.g. INFO for
the Info window, which is where the main menu bar appears, though there are also names
for major object categories like MESH and LAMP), and type indicates the class of object:
HT for a window header UI object (bpy.types.Header), MT for a menu (bpy.types.Menu),
OT for an operator, and PT for a panel (bpy.types.Panel). The OT ones seem to correspond
directly to objects in bpy.ops, but at a lower level; it’s probably easier just to use the oﬃcial
bpy.ops objects. As for the HT, MT and PT objects, these all have append, prepend and
remove methods that you can use to customize them: append adds a widget at the end
(right or bottom), while prepend puts it at the front (left or top).
Since they aren’t (yet) mentioned in the oﬃcial Blender documentation, here is a list of all
the ones I’ve been able to ﬁnd:
Operator Category
Bone Properties

Header

Movie Clip Editor

CLIP_HT_header

Cloth Properties
Console

CONSOLE_HT_header

Menu

Panel
BONE_PT_constraints,
BONE_PT_context_bone,
BONE_PT_custom_props,
BONE_PT_deform,
BONE_PT_display,
BONE_PT_inverse_kinematics,
BONE_PT_relations,
BONE_PT_transform,
BONE_PT_transform_locks
CLIP_MT_camera_presets, CLIP_PT_active_mask_point,
CLIP_MT_clip,
CLIP_PT_active_mask_spline,
CLIP_MT_proxy,
CLIP_PT_display,
CLIP_MT_reconstruction,
CLIP_PT_footage,
CLIP_MT_select,
CLIP_PT_footage_info,
CLIP_MT_select_grouped, CLIP_PT_marker,
CLIP_MT_select_mode,
CLIP_PT_marker_display,
CLIP_MT_stabilize_2d_specials,
CLIP_PT_mask,
CLIP_MT_track,
CLIP_PT_mask_display,
CLIP_MT_track_color_presets,
CLIP_PT_mask_layers,
CLIP_MT_track_color_specials,
CLIP_PT_objects,
CLIP_MT_track_transform, CLIP_PT_plane_track,
CLIP_MT_track_visibility, CLIP_PT_proxy,
CLIP_MT_tracking_settings_presets,
CLIP_PT_stabilization,
CLIP_MT_tracking_specials, CLIP_PT_tools_cleanup,
CLIP_MT_view
CLIP_PT_tools_clip,
CLIP_PT_tools_geometry,
CLIP_PT_tools_grease_pencil,
CLIP_PT_tools_marker,
CLIP_PT_tools_mask,
CLIP_PT_tools_object,
CLIP_PT_tools_orientation,
CLIP_PT_tools_plane_tracking,
CLIP_PT_tools_solve,
CLIP_PT_tools_tracking,
CLIP_PT_track,
CLIP_PT_track_settings,
CLIP_PT_tracking_camera
CLOTH_MT_presets
CONSOLE_MT_console,
CONSOLE_MT_language
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Operator Category
Cycles Renderer

Object Data Context

1226

Header

Menu
Panel
CYCLES_MT_integrator_presets,
CYCLES_MT_sampling_presets
DATA_PT_active_spline,
DATA_PT_area,
DATA_PT_bone_group_specials,
DATA_PT_bone_groups,
DATA_PT_camera,
DATA_PT_camera_display,
DATA_PT_camera_dof,
DATA_PT_cone,
DATA_PT_context_arm,
DATA_PT_context_camera,
DATA_PT_context_curve,
DATA_PT_context_lamp,
DATA_PT_context_lattice,
DATA_PT_context_mesh,
DATA_PT_context_metaball,
DATA_PT_context_speaker,
DATA_PT_curve_texture_space,
DATA_PT_custom_props_arm,
DATA_PT_custom_props_camera,
DATA_PT_custom_props_curve,
DATA_PT_custom_props_lamp,
DATA_PT_custom_props_lattice,
DATA_PT_custom_props_mesh,
DATA_PT_custom_props_metaball,
DATA_PT_custom_props_speaker,
DATA_PT_customdata,
DATA_PT_display,
DATA_PT_distance,
DATA_PT_empty,
DATA_PT_falloﬀ_curve,
DATA_PT_font,
DATA_PT_geometry_curve,
DATA_PT_ghost,
DATA_PT_iksolver_itasc,
DATA_PT_lamp,
DATA_PT_lattice,
DATA_PT_lens,
DATA_PT_mball_texture_space,
DATA_PT_metaball,
DATA_PT_metaball_element,
DATA_PT_modiﬁers,
DATA_PT_motion_paths,
DATA_PT_normals,
DATA_PT_paragraph,
DATA_PT_pathanim,
DATA_PT_pose_library,
DATA_PT_preview,
DATA_PT_shadow,
DATA_PT_shadow_game,
DATA_PT_shape_curve,
DATA_PT_shape_keys,
DATA_PT_skeleton,
DATA_PT_speaker,
DATA_PT_spot,
DATA_PT_sunsky,
DATA_PT_text_boxes,
DATA_PT_texture_space,
DATA_PT_uv_texture,
DATA_PT_vertex_colors,
DATA_PT_vertex_groups
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Operator Category
Dopesheet

Filebrowser

Header
DOPESHEET_HT_header

Menu
Panel
DOPESHEET_MT_channel,
DOPESHEET_MT_gpencil_channel,
DOPESHEET_MT_gpencil_frame,
DOPESHEET_MT_key,
DOPESHEET_MT_key_transform,
DOPESHEET_MT_marker,
DOPESHEET_MT_select,
DOPESHEET_MT_view

FILEBROWSER_HT_header

Fluid Simulation
Graph Editor

GRAPH_HT_header

UV/Image Editor

IMAGE_HT_header

FLUID_MT_presets
GRAPH_MT_channel,
GRAPH_MT_key,
GRAPH_MT_key_transform,
GRAPH_MT_marker,
GRAPH_MT_select,
GRAPH_MT_view
IMAGE_MT_image, IMIMAGE_MT_image_invert,
AGE_PT_active_mask_point,
IMAGE_MT_select,
IMIMAGE_MT_uvs,
AGE_PT_active_mask_spline,
IMAGE_MT_uvs_mirror,
IMIMAGE_PT_game_properties,
AGE_MT_uvs_select_mode, IMIMAGE_PT_image_properties,
AGE_MT_uvs_showhide,
IMAGE_PT_mask, IMIMAGE_MT_uvs_snap,
AGE_PT_mask_display,
IMIMAGE_MT_uvs_transform, AGE_PT_mask_layers,
IMIMAGE_PT_paint,
AGE_MT_uvs_weldalign,
IMAGE_PT_paint_curve,
IMAGE_MT_view
IMAGE_PT_paint_stroke,
IMAGE_PT_sample_line,
IMAGE_PT_scope_sample,
IMAGE_PT_tools_brush_appearance,
IMAGE_PT_tools_brush_texture,
IMAGE_PT_tools_brush_tool,
IMAGE_PT_tools_mask,
IMAGE_PT_tools_mask_texture,
IMAGE_PT_view_histogram,
IMAGE_PT_view_properties,
IMAGE_PT_view_vectorscope,
IMAGE_PT_view_waveform
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Operator Category
Info Window

Header
INFO_HT_header

Lamp Properties
Logic Editor

LOGIC_HT_header

Mask Properties

Material Properties

Mesh Properties
NLA Editor
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NLA_HT_header

Menu
Panel
INFO_MT_add,
INFO_MT_armature_add,
INFO_MT_curve_add,
INFO_MT_edit_curve_add,
INFO_MT_ﬁle,
INFO_MT_ﬁle_export,
INFO_MT_ﬁle_external_data,
INFO_MT_ﬁle_import,
INFO_MT_game,
INFO_MT_help,
INFO_MT_mesh_add,
INFO_MT_render,
INFO_MT_report,
INFO_MT_surface_add,
INFO_MT_window
LAMP_MT_sunsky_presets
LOGIC_MT_logicbricks_add,LOGIC_PT_properties
LOGIC_MT_view
MASK_MT_animation,
MASK_MT_mask,
MASK_MT_select,
MASK_MT_transform,
MASK_MT_visibility
MATEMATERIAL_MT_specials, MARIAL_PT_context_material,
TERIAL_MT_sss_presets
MATERIAL_PT_custom_props,
MATERIAL_PT_diﬀuse,
MATERIAL_PT_ﬂare,
MATERIAL_PT_halo,
MATERIAL_PT_mirror,
MATERIAL_PT_options,
MATERIAL_PT_physics,
MATERIAL_PT_preview, MATERIAL_PT_shading,
MATERIAL_PT_shadow,
MATERIAL_PT_specular,
MATERIAL_PT_sss,
MATERIAL_PT_strand,
MATERIAL_PT_transp,
MATERIAL_PT_transp_game,
MATERIAL_PT_volume_density,
MATERIAL_PT_volume_integration,
MATERIAL_PT_volume_lighting,
MATERIAL_PT_volume_options,
MATERIAL_PT_volume_shading,
MATERIAL_PT_volume_transp
MESH_MT_shape_key_specials,
MESH_MT_vertex_group_specials
NLA_MT_add,
NLA_MT_edit,
NLA_MT_edit_transform,
NLA_MT_marker,
NLA_MT_select,
NLA_MT_view
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Operator Category
Node Editor

Object Properties

Header
NODE_HT_header

Menu
Panel
NODE_MT_add,
NODE_PT_active_node_color,
NODE_MT_category_CMP_CONVERTOR,
NODE_PT_active_node_generic,
NODE_MT_category_CMP_DISTORT,
NODE_PT_active_node_properties,
NODE_MT_category_CMP_GROUP,
NODE_PT_backdrop,
NODE_MT_category_CMP_INPUT,
NODE_PT_category_CMP_CONVERTOR,
NODE_MT_category_CMP_LAYOUT,
NODE_PT_category_CMP_DISTORT,
NODE_MT_category_CMP_MATTE,
NODE_PT_category_CMP_GROUP,
NODE_MT_category_CMP_OP_COLOR,
NODE_PT_category_CMP_INPUT,
NODE_MT_category_CMP_OP_FILTER,
NODE_PT_category_CMP_LAYOUT,
NODE_MT_category_CMP_OP_VECTOR,
NODE_PT_category_CMP_MATTE,
NODE_MT_category_CMP_OUTPUT,
NODE_PT_category_CMP_OP_COLOR,
NODE_MT_category_SH_CONVERTOR,
NODE_PT_category_CMP_OP_FILTER,
NODE_MT_category_SH_GROUP,
NODE_PT_category_CMP_OP_VECTOR,
NODE_MT_category_SH_INPUT,
NODE_PT_category_CMP_OUTPUT,
NODE_MT_category_SH_LAYOUT,
NODE_PT_category_SH_CONVERTOR,
NODE_MT_category_SH_NEW_CONVERTOR,
NODE_PT_category_SH_GROUP,
NODE_MT_category_SH_NEW_GROUP,
NODE_PT_category_SH_INPUT,
NODE_MT_category_SH_NEW_INPUT,
NODE_PT_category_SH_LAYOUT,
NODE_MT_category_SH_NEW_LAYOUT,
NODE_PT_category_SH_NEW_CONVERTOR,
NODE_MT_category_SH_NEW_OP_COLOR,
NODE_PT_category_SH_NEW_GROUP,
NODE_MT_category_SH_NEW_OP_VECTOR,
NODE_PT_category_SH_NEW_INPUT,
NODE_MT_category_SH_NEW_OUTPUT,
NODE_PT_category_SH_NEW_LAYOUT,
NODE_MT_category_SH_NEW_SCRIPT,
NODE_PT_category_SH_NEW_OP_COLOR,
NODE_MT_category_SH_NEW_SHADER,
NODE_PT_category_SH_NEW_OP_VECTOR,
NODE_MT_category_SH_NEW_TEXTURE,
NODE_PT_category_SH_NEW_OUTPUT,
NODE_MT_category_SH_OP_COLOR,
NODE_PT_category_SH_NEW_SCRIPT,
NODE_MT_category_SH_OP_VECTOR,
NODE_PT_category_SH_NEW_SHADER,
NODE_MT_category_SH_OUTPUT,
NODE_PT_category_SH_NEW_TEXTURE,
NODE_MT_category_TEX_CONVERTOR,
NODE_PT_category_SH_OP_COLOR,
NODE_MT_category_TEX_DISTORT,
NODE_PT_category_SH_OP_VECTOR,
NODE_MT_category_TEX_GROUP,
NODE_PT_category_SH_OUTPUT,
NODE_MT_category_TEX_INPUT,
NODE_PT_category_TEX_CONVERTOR,
NODE_MT_category_TEX_LAYOUT,
NODE_PT_category_TEX_DISTORT,
NODE_MT_category_TEX_OP_COLOR,
NODE_PT_category_TEX_GROUP,
NODE_MT_category_TEX_OUTPUT,
NODE_PT_category_TEX_INPUT,
NODE_MT_category_TEX_PATTERN,
NODE_PT_category_TEX_LAYOUT,
NODE_MT_category_TEX_TEXTURE,
NODE_PT_category_TEX_OP_COLOR,
NODE_MT_node,
NODE_PT_category_TEX_OUTPUT,
NODE_MT_node_color_presets,
NODE_PT_category_TEX_PATTERN,
NODE_MT_node_color_specials,
NODE_PT_category_TEX_TEXTURE,
NODE_MT_select,
NODE_PT_quality
NODE_MT_view
OBJECT_PT_animation,
OBJECT_PT_constraints,
OBJECT_PT_context_object,
OBJECT_PT_custom_props,
OBJECT_PT_delta_transform,
OBJECT_PT_display,
OBJECT_PT_duplication,
OBJECT_PT_groups,
OBJECT_PT_motion_paths,
OBJECT_PT_relations,
OBJECT_PT_transform,
OBJECT_PT_transform_locks
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Operator Category
Outliner

Particle Properties
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Header
OUTLINER_HT_header

Menu
Panel
OUTLINER_MT_edit_datablocks,
OUTLINER_MT_search,
OUTLINER_MT_view
PARTICLE_PT_boidbrain,
PARTICLE_PT_cache,
PARTICLE_PT_children,
PARTICLE_PT_context_particles,
PARTICLE_PT_custom_props,
PARTICLE_PT_draw,
PARTICLE_PT_emission,
PARTICLE_PT_ﬁeld_weights,
PARTICLE_PT_force_ﬁelds,
PARTICLE_PT_hair_dynamics,
PARTICLE_PT_physics,
PARTICLE_PT_render,
PARTICLE_PT_rotation,
PARTICLE_PT_velocity,
PARTICLE_PT_vertexgroups
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Operator Category
Physics Properties

Properties Properties
Render Layer Properties

Header

Menu

Panel
PHYSICS_PT_add,
PHYSICS_PT_cloth,
PHYSICS_PT_cloth_cache,
PHYSICS_PT_cloth_collision,
PHYSICS_PT_cloth_ﬁeld_weights,
PHYSICS_PT_cloth_stiﬀness,
PHYSICS_PT_collision,
PHYSICS_PT_domain_boundary,
PHYSICS_PT_domain_gravity,
PHYSICS_PT_domain_particles,
PHYSICS_PT_dp_advanced_canvas,
PHYSICS_PT_dp_brush_source,
PHYSICS_PT_dp_brush_velocity,
PHYSICS_PT_dp_brush_wave,
PHYSICS_PT_dp_cache,
PHYSICS_PT_dp_canvas_initial_color,
PHYSICS_PT_dp_canvas_output,
PHYSICS_PT_dp_eﬀects,
PHYSICS_PT_dynamic_paint,
PHYSICS_PT_ﬁeld,
PHYSICS_PT_ﬂuid,
PHYSICS_PT_game_collision_bounds,
PHYSICS_PT_game_obstacles,
PHYSICS_PT_game_physics,
PHYSICS_PT_rigid_body,
PHYSICS_PT_rigid_body_collisions,
PHYSICS_PT_rigid_body_constraint,
PHYSICS_PT_rigid_body_dynamics,
PHYSICS_PT_smoke,
PHYSICS_PT_smoke_adaptive_domain,
PHYSICS_PT_smoke_cache,
PHYSICS_PT_smoke_ﬁeld_weights,
PHYSICS_PT_smoke_ﬁre,
PHYSICS_PT_smoke_ﬂow_advanced,
PHYSICS_PT_smoke_groups,
PHYSICS_PT_smoke_highres,
PHYSICS_PT_softbody,
PHYSICS_PT_softbody_cache,
PHYSICS_PT_softbody_collision,
PHYSICS_PT_softbody_edge,
PHYSICS_PT_softbody_ﬁeld_weights,
PHYSICS_PT_softbody_goal,
PHYSICS_PT_softbody_solver

PROPERTIES_HT_header
RENDERLAYER_PT_freestyle,
RENDERLAYER_PT_freestyle_lineset,
RENDERLAYER_PT_freestyle_linestyle,
RENDERLAYER_PT_layer_options,
RENDERLAYER_PT_layer_passes,
RENDERLAYER_PT_layers
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Operator Category
Render Properties

Header

Scene Properties

Sequencer Window
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SEQUENCER_HT_header

Menu
Panel
RENRENDER_MT_ﬀmpeg_presets, DER_PT_antialiasing,
RENRENDER_PT_bake,
DER_MT_framerate_presets,RENRENDER_PT_dimensions,
DER_MT_lineset_specials, RENDER_PT_embedded,
RENDER_MT_presets
RENDER_PT_encoding,
RENDER_PT_freestyle,
RENDER_PT_game_display,
RENDER_PT_game_player,
RENDER_PT_game_shading,
RENDER_PT_game_sound,
RENDER_PT_game_stereo,
RENDER_PT_game_system,
RENDER_PT_motion_blur,
RENDER_PT_output,
RENDER_PT_performance,
RENDER_PT_post_processing,
RENDER_PT_render,
RENDER_PT_shading,
RENDER_PT_stamp
SCENE_PT_audio,
SCENE_PT_color_management,
SCENE_PT_custom_props,
SCENE_PT_game_navmesh,
SCENE_PT_keying_set_paths,
SCENE_PT_keying_sets,
SCENE_PT_physics,
SCENE_PT_rigid_body_cache,
SCENE_PT_rigid_body_ﬁeld_weights,
SCENE_PT_rigid_body_world,
SCENE_PT_scene,
SCENE_PT_simplify,
SCENE_PT_unit
SESEQUENCER_PT_edit,
QUENCER_MT_add, SESEQUENCER_PT_eﬀect,
QUENCER_MT_add_eﬀect, SEQUENCER_PT_ﬁlter,
SESEQUENCER_PT_input,
QUENCER_MT_marker,
SEQUENCER_PT_mask,
SESEQUENCER_MT_select,
QUENCER_PT_modiﬁers,
SEQUENCER_MT_strip,
SESEQUENCER_MT_view,
QUENCER_PT_preview,
SESEQUENCER_PT_proxy,
QUENCER_MT_view_toggleSEQUENCER_PT_scene,
SEQUENCER_PT_sound,
SEQUENCER_PT_view
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Operator Category
Texture Properties

Header

Text Editor

TEXT_HT_header

Timeline

TIME_HT_header

User Preferences

USERPREF_HT_header

Menu
Panel
TEXTEXTURE_MT_envmap_specials,TURE_PT_blend, TEXTEXTURE_MT_specials
TURE_PT_clouds, TEXTURE_PT_colors, TEXTURE_PT_context_texture,
TEXTURE_PT_custom_props,
TEXTURE_PT_distortednoise,
TEXTURE_PT_envmap,
TEXTURE_PT_envmap_sampling,
TEXTURE_PT_image,
TEXTURE_PT_image_mapping,
TEXTURE_PT_image_sampling,
TEXTURE_PT_inﬂuence,
TEXTURE_PT_magic,
TEXTURE_PT_mapping,
TEXTURE_PT_marble,
TEXTURE_PT_musgrave,
TEXTURE_PT_pointdensity,
TEXTURE_PT_pointdensity_turbulence,
TEXTURE_PT_preview,
TEXTURE_PT_stucci,
TEXTURE_PT_voronoi,
TEXTURE_PT_voxeldata,
TEXTURE_PT_wood
TEXT_MT_edit,
TEXT_PT_ﬁnd,
TEXT_MT_edit_select,
TEXT_PT_properties
TEXT_MT_edit_to3d,
TEXT_MT_format,
TEXT_MT_templates,
TEXT_MT_templates_osl,
TEXT_MT_templates_py,
TEXT_MT_text,
TEXT_MT_toolbox,
TEXT_MT_view
TIME_MT_autokey,
TIME_MT_cache,
TIME_MT_frame,
TIME_MT_playback,
TIME_MT_view
USERUSERPREF_MT_addons_dev_guides,
PREF_PT_addons,
USERUSERPREF_PT_edit,
PREF_MT_interaction_presets,
USERPREF_PT_ﬁle,
USERUSERPREF_PT_input,
PREF_MT_keyconﬁgs,
USERUSERPREF_MT_splash
PREF_PT_interface,
USERPREF_PT_system,
USERPREF_PT_tabs,
USERPREF_PT_theme
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Operator Category
3D View

1234

Header
VIEW3D_HT_header

Menu
Panel
VIEW3D_MT_armature_specials,
VIEW3D_PT_background_image,
VIEW3D_MT_bone_options_disable,
VIEW3D_PT_context_properties,
VIEW3D_MT_bone_options_enable,
VIEW3D_PT_etch_a_ton,
VIEW3D_MT_bone_options_toggle,
VIEW3D_PT_sculpt_options,
VIEW3D_MT_brush,
VIEW3D_PT_sculpt_symmetry,
VIEW3D_MT_brush_paint_modes,
VIEW3D_PT_sculpt_topology,
VIEW3D_MT_edit_armature,VIEW3D_PT_tools_armatureedit,
VIEW3D_MT_edit_armature_parent,
VIEW3D_PT_tools_armatureedit_options,
VIEW3D_MT_edit_armature_roll,
VIEW3D_PT_tools_brush,
VIEW3D_MT_edit_curve, VIEW3D_PT_tools_brush_appearance,
VIEW3D_MT_edit_curve_ctrlpoints,
VIEW3D_PT_tools_brush_curve,
VIEW3D_MT_edit_curve_segments,
VIEW3D_PT_tools_brush_stroke,
VIEW3D_MT_edit_curve_showhide,
VIEW3D_PT_tools_brush_texture,
VIEW3D_MT_edit_curve_specials,
VIEW3D_PT_tools_curveedit,
VIEW3D_MT_edit_font,
VIEW3D_PT_tools_latticeedit,
VIEW3D_MT_edit_lattice, VIEW3D_PT_tools_mask_texture,
VIEW3D_MT_edit_mesh, VIEW3D_PT_tools_mballedit,
VIEW3D_MT_edit_mesh_clean,
VIEW3D_PT_tools_meshedit,
VIEW3D_MT_edit_mesh_delete,
VIEW3D_PT_tools_meshedit_options,
VIEW3D_MT_edit_mesh_edges,
VIEW3D_PT_tools_objectmode,
VIEW3D_MT_edit_mesh_extrude,
VIEW3D_PT_tools_particlemode,
VIEW3D_MT_edit_mesh_faces,
VIEW3D_PT_tools_posemode,
VIEW3D_MT_edit_mesh_normals,
VIEW3D_PT_tools_posemode_options,
VIEW3D_MT_edit_mesh_select_mode,
VIEW3D_PT_tools_projectpaint,
VIEW3D_MT_edit_mesh_showhide,
VIEW3D_PT_tools_rigidbody,
VIEW3D_MT_edit_mesh_specials,
VIEW3D_PT_tools_surfaceedit,
VIEW3D_MT_edit_mesh_vertices,
VIEW3D_PT_tools_textedit,
VIEW3D_MT_edit_meta, VIEW3D_PT_tools_vertexpaint,
VIEW3D_MT_edit_meta_showhide,
VIEW3D_PT_tools_weightpaint,
VIEW3D_MT_edit_surface, VIEW3D_PT_tools_weightpaint_options,
VIEW3D_MT_edit_text_chars,
VIEW3D_PT_transform_orientations,
VIEW3D_MT_hide_mask, VIEW3D_PT_view3d_cursor,
VIEW3D_MT_hook,
VIEW3D_PT_view3d_curvedisplay,
VIEW3D_MT_make_links, VIEW3D_PT_view3d_display,
VIEW3D_MT_make_single_user,
VIEW3D_PT_view3d_meshdisplay,
VIEW3D_MT_mirror,
VIEW3D_PT_view3d_meshstatvis,
VIEW3D_MT_object,
VIEW3D_PT_view3d_motion_tracking,
VIEW3D_MT_object_animation,
VIEW3D_PT_view3d_name,
VIEW3D_MT_object_apply, VIEW3D_PT_view3d_properties
VIEW3D_MT_object_clear,
VIEW3D_MT_object_constraints,
VIEW3D_MT_object_game,
VIEW3D_MT_object_group,
VIEW3D_MT_object_parent,
VIEW3D_MT_object_quick_eﬀects,
VIEW3D_MT_object_showhide,
VIEW3D_MT_object_specials,
VIEW3D_MT_object_track,
VIEW3D_MT_paint_vertex,
VIEW3D_MT_paint_weight,
VIEW3D_MT_particle,
VIEW3D_MT_particle_showhide,
VIEW3D_MT_particle_specials,
VIEW3D_MT_pose,
VIEW3D_MT_pose_apply,
VIEW3D_MT_pose_constraints,
VIEW3D_MT_pose_group,
VIEW3D_MT_pose_ik,
VIEW3D_MT_pose_library,
VIEW3D_MT_pose_motion,
VIEW3D_MT_pose_propagate,
VIEW3D_MT_pose_showhide,
VIEW3D_MT_pose_slide,
VIEW3D_MT_pose_specials,
VIEW3D_MT_pose_transform,
VIEW3D_MT_sculpt,
VIEW3D_MT_select_edit_armature,
VIEW3D_MT_select_edit_curve,
VIEW3D_MT_select_edit_lattice,
VIEW3D_MT_select_edit_mesh,
VIEW3D_MT_select_edit_metaball,
VIEW3D_MT_select_edit_surface,
VIEW3D_MT_select_object,
VIEW3D_MT_select_paint_mask,
VIEW3D_MT_select_paint_mask_vertex,
VIEW3D_MT_select_particle,
VIEW3D_MT_select_pose,

Undocumented Blender
Operator Category
Window Manager Properties
World Properties

Header

Menu
WM_MT_operator_presets

Panel

WORLD_PT_ambient_occlusion,
WORLD_PT_context_world,
WORLD_PT_custom_props,
WORLD_PT_environment_lighting,
WORLD_PT_game_context_world,
WORLD_PT_game_mist,
WORLD_PT_game_physics,
WORLD_PT_game_world,
WORLD_PT_gather,
WORLD_PT_indirect_lighting,
WORLD_PT_mist,
WORLD_PT_preview,
WORLD_PT_stars,
WORLD_PT_world
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137. High Dynamic Range imaging
(HDRi)
i Information
Applicable Blender version: 2.69

137.1. Introduction
You may have heard various people talk about HDR images. (WETA, Lucas, even Tim
Sweeny). HDR images are part of a technology called HDRi which stands for ”High Dynamic
Range (image)”. So... what on earth does that mean?
Here's a link to Wikipedia's article on the HDR format1 which I personally give all my credit
to Paul Debevec for putting it to use for computer graphics purposes. Anyway, before you
start trying to understand the usefulness of HDRi, please read the wikipedia link.
Also, visit Paul Debevec's website2 if you've got some more time to spare.
To sum up the excitement of HDR CG, think of it like the hype of the next-generation
videogames that are about to come out, except set the stage for 1996 instead of 2006. Paul
Debevec pioneered paralax mapping, HDR lighting, image-based modeling, his latest work
includes some even more amazing technologies, and for the record he's my hero too.
To use HDRi images for 3D rendering, you need something called a light probe3 ...

137.2. Deﬁnitions
HDRI

1
2
3

http://en.wikipedia.org/wiki/High_dynamic_range_imaging
http://www.debevec.org
Chapter 138 on page 1247
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Figure 1079

HDR image ﬁle example

HDRI stands for High Dynamic Range Imaging, and is basically an image format
that contains from the deepest shadow up to the brightest highlight information. While an
'ordinary' digital image contains only 8 bits of information per color (red, green, blue) which
gives you 256 gradations per color, the HDR image format stores the 3 colors with ﬂoating
point accuracy. Thus the 'depth' from dark to light per color is virtually unlimited. Using
HDR images in a 3D environment will result in very realistic and convincing shadows,
highlights and reﬂections. This is very important for realistic emulation of chrome for
example.
Light Probe
A Light Probe is a HDR image containing 360 by 360 degrees (solid angle4 4π steradians5 )
image information. In other words : it's a 360 degree spherical panorama image, not only
looking around the horizon, but also up and down. Thus a Light Probe image contains all
visible information as can be seen from a speciﬁc point, wherever you turn your head.

137.3. Usage
Given that a Light Probe image is an 'all around' image with a high dynamic range, it's
the perfect solution for your 'world' background, especially for a 3D animation.

4
5
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http://en.wikipedia.org/wiki/Solid_angle
http://en.wikipedia.org/wiki/Steradian

Quick Tutorial (for experienced blendies)

137.4. Quick Tutorial (for experienced blendies)
First of all, you'll need an HDR image. There is a whole range at http://debevec.org/
Probes/ that you can download for free. (There are even more at http://blenderartists.
org/forum/showthread.php?t=24038 ). I will use the St. Peter's Basilica probe, but any
other HDR image will do just ﬁne.
To apply the HDRI environment to your scene:
• Go to the shading settings (press F5) and click the World button.
• Enable ”Real” to force the horizon to stay still, as opposed to follow the camera
• If you're rendering with Blender Internal (ver. 2.49), go to ”Ambient Occlusion” tab and
activate ”Ambient Occlusion”, then activate ”Sky Texture”. Skip this step if you're using
external renderers.
• In the ”Texture and Input” tab, click ”Add New” and ”Angmap”.
• Then go to the ”Map To” tab and deactivate ”Blend” and activate ”Hori”.
• Now go to the Texture settings (press F6) and change the ”Texture Type” to ”Image”.
• Click the ”Load Image” button and locate your HDR image.
• If you're using YafRay or other external renderers, you need to turn on Global Illumination
and to set the quality to something other than ”none”.

137.5. Step-by-step Tutorial
137.5.1. Build a simple scene
To see the advantage of using a 360 by 360 world image, the simplest example to demonstrate
this is a scene with a mirrored sphere.
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Figure 1080

Scene

1. Add a sphere and a cube to your scene and place them in a bit of an interesting
position. (note that I added a second lamp to light up the shadow part of the cube)
2. Perhaps give the cube a diﬀerent color than the default grey.

Figure 1081

Material setting for a mirror surface and a preview of it

1. Give the sphere a mirrored material : go to the Shading -> Material panel (F5)
and ﬁnd the Mirror Trans buttons.
2. Check that Ray Mirror button is pressed. If it is not, check it.
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3. Set the RayMir value to a value of 0.5 or higher. Your preview should show the
reﬂection of the checkboard environment.

137.5.2. Render with HDR (Blender Internal v2.49)
1. Download a HDR image (see Paul Debevec's website)
2. Go to the shading settings (press F5) and click the World button.

Figure 1082

AngMap enabled

1. Go to ”Ambient Occlusion” tab and activate ”Ambient Occlusion”, then make sure
”Raytrace” is chosen as gather method, and activate ”Sky Texture”
2. Adjust quality settings:
a) Increasing number of samples reduces noise, but increases render times
b) Adaptive QMC is faster, but generates more noise than Constant QMC
3. In the ”Texture and Input” tab, click ”Add New” and ”Angmap”
4. Then go to the ”Map To” tab and deactivate ”Blend” and activate ”Hori”.
5. Now go to the Texture settings (press F6) and change the ”Texture Type” to ”Image”.
6. Click the ”Load Image” button and locate your HDR image.

137.5.3. Render with HDR (Blender Internal v2.69)
1. Download a HDR image (see Paul Debevec's website)

1243

High Dynamic Range imaging (HDRi)
2. Go to Properties tab and click the World button.In the World Section check the ”Real
Sky” Button
3. (optional)Go to ”Ambient Occlusion” section and activate ”Ambient Occlusion”, then
make sure ”Raytrace” is chosen as gather method in Gather section”
4. (optional)Adjust quality settings:
a) Increasing number of samples reduces noise, but increases render times
b) Adaptive QMC is faster, but generates more noise than Constant QMC
5. In the Properties tab click Texture button->then click on 'show world texture'>then select type as 'image or movie'->then in mapping section select coordinates
as 'Angmap'->then in in inﬂuence section uncheck the 'blend' button and check the
'horizon' button.
6. In the Image section click on open button and locate your HDR image and Load it.

137.5.4. Render with YafRay
1. Download a HDR image (see Paul Debevec's website).
2. Go to the shading settings (press F5) and click the World button.
3. In the ”Texture and Input” tab, click ”Add New” and ”Angmap”. Note that the Angmap
button is the important thing to tell Blender that this ﬁle is a Light Probe ﬁle !
4. Then go to the ”Map To” tab and deactivate ”Blend” and activate ”Hori”.
5. Now go to the Texture settings (press F6) and change the ”Texture Type” to ”Image”.
6. Click the ”Load Image” button and locate your HDR image.
(optional step, as it was not needed for my setup :)
5. Press F10 and change the ”Blender Internal” to ”YafRay”. You need to turn on Global
Illumination and to set the quality to something other than ”none”. Note that the YafRay
renderer does not come standard with the Blender installation. You need to download and
install this separately.
Your result should look like this: (Rendering: left with Blender, right with YafRay) Click
for larger version
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Figure 1083

Figure 1084

Note that the reﬂecting ball reﬂects the whole interior from every angle, even though we
added just a single image to the World settings !

1245

138. Creating a Light Probe
The light probe is, in the simplest terms, a photograph of your environment. they work in
very much the same way that reﬂection maps do, and are made the same way.
Equipment:
1. A pure silver ball. Try a plastic Christmas tree ball ornament.
2. A camera, preferably digital. If you have a high-end digital camera, you'll have less
work ahead.
3. A place you'd like to capture the lighting from. Try laying diﬀerent things in your
environment to get a good idea.
4. Something to ﬁre the shutter without touching the camera. For digital cameras, Paul
Debevec recommends using a program that will take all the pictures for you.
5. A tripod.
Set it up like so. Remember that the height of your camera and the height of the ball
relative to each other controls the angle at which the horizon will be shot. In other words,
shoot the ball at the same angle that you plan to shoot your 3D scene in. If your scene is
animated... consider making a similar rig except attaching your reﬂective ball to a video
camera as was done for Flight of the Navigator1 .

1

https://en.wikipedia.org/wiki/Flight_of_the_Navigator
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Creating a Light Probe

Figure 1085

(note from a VFX pro who is using this technique for years: on a mirror ball everything is
reﬂected except the area right behind the sphere opposite to the camera - where the tape
is on the above picture)
The process:
1. Set up your rig and take a series of images with varying exposure times.
2. Taking 2 sets of pictures, each oﬀset by 90 degrees, will enable you to get better
coverage of the background and eliminate the reﬂection of the camera taking the
picture.
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139. Landscape Modeling with
Heightmaps
i Information
Applicable Blender version: 2.41
This tutorial will show you how to make advanced terrain such as mountains using Blender
and gimp or any other image editing software. Blender has the ability to use height maps to
create meshes. Height maps are black and white images with white representing the highest
point and black the lowest.

139.1. Creating the heightmap image
Note: This entire Tutorial presumes that you are already familiar with other Editing Software, such as GIMP... and already know how to create ”textures” with that software.
However, you do not have to use another program to obtain a texture. At the end of the
next section, they show you how to generate a random 'cloud' texture which you can use
directly. Do not worry about GIMP or Photoshop. Just skip the rest of this section and
most of the next one.
To begin with, open your image editing software. This part applies to Gimp only (downloadable at http://gimp.org), if you use another program you will have to do it another
way.
First use the ”New” menu option to create an image 1600 wide by 1200 tall. Go to Filters →
Render → Clouds → Plasma (In Photoshop, this is Filter > Render > Clouds). For this
example just use the default settings, it doesn't really matter. Click OK. You should now
have a nice colorful image. We don't want that, we want it in black and white. Make
sure your Gradient is set to ”FG to BG(RGB)”(this is the default anyway) and that your
foreground color is black and the background color is white. Go to Colors → Map →
Gradient Map. This will convert it to black and white for you.
Save your image as PNG or JPEG.
It should look something like this
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Figure 1086

139.2. Create grid and add the image as texture
Open Blender and delete the default cube.
Add a grid (SPACE → Add → Mesh → Grid) with resolutions 32 and 32 from top view.
Do not scale the grid just yet, zoom instead if you wish to take a closer look at your grid.
It will be explained later why you shouldn't scale now.
Note: When I followed this tutorial it didn't work - the vertices in the grid were moving sideways
rather than vertically. It turns out I needed to TAB into object mode after creating the grid, then
hit CTRL+AKEY to reset the transformation, then TAB back into edit mode. If someone could
explain why that was necessary, or what it does exactly, that would be helpful.

• Response 1: You should create the basic shape and outline in object mode, then edit
the details in edit mode, kinda like the names imply.
• Response 2: When you create an object using the Front or Side views while having
Aligned to View selected in the Edit Methods in Blender Settings Panel, the
Local Z axis of the object will be pointing to the Global Y or X axis, respectively.
For the matter of this tutorial, if you do that, you'll be forced to rotate the object
90º in X or Y, before going on. That's where problems may begin, if you rotate it in
Edit Mode which doesn't change local axis orientations. In that case you'll be forced to
reset transformations (Ctrl+A -> Scale and Rotation to ObData). However, if you
rotate it in Object Mode, and if you make sure the Local Z axis points upwards after
the rotation, you should be seeing good results later on. ( To see the Local orientations
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Create grid and add the image as texture
of an object, Press F7 for the Object Panel (the one with three arrows, 4th from the
left) and in the Draw pane click the Axis button.)
Click F5 to go to the Shading panel. By default the Material buttons button should be
selected (button with red ball), but if it isn't then click on it. If this window has a panel
named Preview and it is empty then look to the right for the Links and Pipeline panel.
Here you should ﬁnd an Add New button beneath Link to Object, click on it. 3 more panels
should appear when you do this. You should ﬁnd the Texture buttons button, it is just to
the right of the Material button and is black & yellow. You may also just hit F6. Now you
should get two new panels titled Preview and Texture, in the Texture panel you'll ﬁnd an
Add new button, click it. Where the button just was it should now be a text ﬁeld saying
something like ”TE:Tex.001”, click in the text ﬁeld and write ”height” instead. Look a bit
to the right and down for a dropdown menu allowing you to choose Texture Type, click it
and select Image. Two more panels will appear and the rightmost should be Image with a
Load button.
Note: The Texture buttons button is not part of the windows that pop up after you
click Add New button, but it directly to the right of the Material button that is a red
ball.
Note: If you can't ﬁnd the Texture Type menu, press F6. Once you press F6, or the Texture
buttons button, you'll see another panel, also called Texture. This one, however, shows a Texture
Type menu after you select Add new. Having two very similar panels can be a nasty trap.

Before you load the image take a look at the Map Image panel. About in the middle
there should be 5 buttons, Extend, Clip, ClipCube, Repeat and Checker. Select Clip or your
heightmap may wrap around the grid (if this doesn't make sense then do this tutorial twice,
one where you keep Repeat selected and one without. In that case make sure there's some
bright white spots in your height map on each edge).
Click the Load button and load the heightmap you just created in your favourite image
editing software.
If you're going for the random cloud-type image, though, you can make it from
within Blender itself - when you add a texture, in the menu where you select
'image,' before actually selecting it, pick 'clouds' instead, and play with the
settings.

Figure 1087
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Click the Material buttons button again (the red ball button) and look in the Preview panel.
If this just shows a black ball then click on the uppermost button just to the right of the
black ball.

Figure 1088

139.3. Use texture as heightmap
(Blender 2.5+ note: Now you do this using a ”Displace” modiﬁer that applies the Texture
you created.)
Look to the top right of the rightmost panel, the window should have 3 panes titled Texture,
Map Input and Map To. Click on the Map To pane. A whole lot of buttons will appear:
• Turn oﬀ the Col button. ”Col” stands for ”color,” and we don't want our plane to be
colored by this texture.
• All of these buttons should be turned oﬀ: we're not going to be using this texture to
”Map To” anything. Instead, we'll be using it to deform the actual geometry.
Go to the Edit window (F9) and enter edit mode (TAB) if you're in Object Mode. Go to
either front or side view so you can see what you are doing. Click the Noise button in the
Mesh Tools-panel (it's located in the top left corner of this panel) and your grid should start
to change shape.
Note: make sure all your vertices are selected with AKEY or whatever you want to use to
select. If not selected, Noise won't do anything!
• (While you could, theoretically, use this to your advantage ... intentionally de-selecting
vertices that you don't want to inﬂuence ... in practice that's quite awkward if for some
reason you have to do it again. It's much easier to leave any such areas, that you don't
want to inﬂuence, ”completely white” in the image.)
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Figure 1089

Continue clicking the button until the terrain has reached the height you want and voilà,
you have just made terrain using heightmaps. You may want to subsurf the shape to get a
smoother eﬀect. If you wish to scale your new landscape then now is the time. There seems
to be a bug or gotcha causing your heightmap to be tiled on your grid rather than resized if
you scale the grid before applying the heightmap. Hopefully someone familiar with blender
will clarify how this should be done properly, but until then this method will work.
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Figure 1090

Tips:
1.If you want a more jagged landscape then adjust the contrast on the image editing software
2.Once you've ﬁnished using the Noise button in the Mesh Tools panel as shown above,
the texture is no longer needed: the eﬀect it has made on the geometry of the object is
permanent. If texture-resources are tight, you can remove it now. But it's advisable to keep
it, unchanged, in case you need to re-do your work at some time in the future. If you want
to use other kinds of texture-maps (Color, Normal maps, and so-forth), you can use the
landscape-image as a handy reference (say in a background-layer in your painting program)
for correct placement of these features, but you should not alter the landscape-image itself).
3.Height maps can also be used to make city terrain. Draw white squares on a black
background. If you do this make sure you make the squares perfectly parallel to the sides
of the image. This prevents jagged edges to buildings. You can also use gray squares to
adjust the buildings to diﬀerent heights.
4.The ”Noise” mesh-editing button displaces vertices in the object's Z-Axis and negative
Z-Axis only. To deform your mesh's other dimensions, simply rotate your object and ”apply
rotation,” or rotate the vertices in edit mode, and apply Noise. Then, rotate it back again
to get your original orientation.
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5.The ”Noise” button permanently modiﬁes your mesh according to the material texture.
Each click adds onto the current mesh. For a temporary eﬀect, map the texture to
Disp(lacement) for a render-time eﬀect (and do not click the ”Noise” button at all). In
object/edit mode your object will appear normal, but will render deformed.
6.Note: The ”Noise” mesh-editing button, as used here, is not the same as the ”Noise”
texture that is referred to in other tutorials!
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140. How to Do Procedural Landscape
Modeling
i Information
Applicable Blender version: 2.40

140.1. Mountains
I was playing around in Blender several months ago and messing with cloud textures when
I found a great way to make landscapes entirely within Blender (without height maps from
The Gimp or some other application) and decided to make a tutorial (yes, it does use the
noise tool).
For 2.7X blenderers out there:though this is a 2.4 based tutorial it works ﬁne for 2.7X
versions. The only big diﬀerence that doesn't work is that the normal button in the inﬂuence
panel instead of map to panel, and the diﬀuse shader they mention later is actually in the
material's context and in the diﬀuse panel.

140.1.1. Making the Mesh
To start, open up Blender and with the cube selected, press the XKEY and click Erase
Selected Objects.
Add a grid (SPACE--> Add--> Mesh--> Grid), using whatever numbers you like, remembering that bigger numbers means more vertices. For this tutorial, I'll use 60 for x and y
resolution. Scale the grid up, but only a little bit (I went up to 1.3) as the texture won't
make very tall landscape with a very big grid. Press the F5 key to go to the Materials tab,
then add a new material.

1257

How to Do Procedural Landscape Modeling

Figure 1091

140.1.2. Displace and Shade
Now press the F6 key to go the Textures panel, and add a cloud texture in the very ﬁrst
slot (slot 0).
After Pressing F6, look at the windows on the bottom. To the left is the ”preview” window
and next to that (to the right) is a Texture window with an Add button... click that and
then go to the little pull down menu that shows up just below and to the right. From there,
ﬁnd and select ”Clouds”... and now, continue!
---You may be wondering how we are going to make landscape with a cloud texture, when
you could just use the Gimp height map plugin, Terragen, or the A.N.T. modeling script
right in Blender. Well, we are going to make the landscape with a height map. The color
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determines the height: white = very tall; grey = halfway tall; black = no height. This
makes the cloud texture a very good candidate for land.
The next thing we are going to do is adjust the size. You can set the noise size to whatever
you want, but I want to have several bigger pieces of landscape, instead of a bunch of little
ones so I'm setting noise size to 1.00 and noise depth to 6, as I want a high level of detail.
(The Preview immediately shows you the eﬀect of your ”tweaks” as you make them.)
Noob Note: You can hold shift and click the number next to noise size then just type 1
and press enter instead of using the arrows. The same applies for NoiseDepth, almost every
other setting in blender changes like this as well.
At the top, we can select Hard noise or Soft noise. Each gives a diﬀerent landscape, so
experiment with them. Next, go to the Colors tab (it's right next to the texture button by
default). Adjust the brightness and contrast as required. For ”Hard noise,” try a brightness
of 1.9 and a contrast of 3.45. For ”Soft noise,” a brightness around 1.0 to 1.2 should be ﬁne.
Noob Note: The above noob note applies to the brightness setting as well!

Figure 1092

Jump back to material buttons with F5 and go into the ”Map To” panel. Turn oﬀ col and
press nor once.
Noob Note: I had a diﬃcult time ﬁnding the ”Map To” so if you are too... This is one of
the several small Windows that opens at the bottom of your screen after pressing F5 and
for me, it was on the far, far right, oﬀ my screen. I had to use my mouse wheel to scroll
the Windows to the side to bring it into view and found it as a Tab on a Window with two
other tabs. ”Col” and ”Nor” are buttons in the Map To Tab.
Another Noob note: In version 2.66, the ”map to” equivalent is found in the texture
window (under the tab ”inﬂuence”) there you can adjust the color and normal settings.
they are referred to by their full names.
• What the buttons are for: The ”Map To” settings determine which various attributes of
the material will be aﬀected by our ”cloudy texture.”
• ”Col” refers to ”color.” We turn it oﬀ here, because we don't want our surface to
look ”cloudy.”
• ”Nor” refers to ”surface normals.” This is the angle at which light seems to reﬂect from
the surface. (The so-called ”bump map.”)
• Experiment with the other ”Map To” buttons, as well! For instance, ”Disp” (for
”displacement) actually causes a map to deform the geometry of a surface... but doing
so only during rendering.
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In this tutorial, as you will see, we are going to combine several techniques to produce a
very rocky surface. Here, we are changing the way that the surface reﬂects light. Then,
we'll actually deform the surface geometry. ---Turn the nor value all the way up, to 25 (that will give it a nice rocky look). Go into
the Shaders tab and then change the ”Diﬀuse Shader” (the top left selector, defaulting to
”Lambert”) to ”Oren-Nayer,” and the ”Specular Shader” (the 2nd selector, defaulting to
”CookTorr”) to ”Blinn.” Adjust the Rough value in Oren-Nayer to 1.5 (rock is really rough).
Also, set the Spec value to 0.01 and Hard to 25. Now we are ready to make some mountains!
• Trivia note: In computer graphics, a ”shader” is a mathematical function, and they're
customarily named after the clever people who invented them. These functions determine
exactly how the cloudy-texture will ”map to” the attributes (e.g. ”Nor”...) that we selected.

Figure 1093

140.1.3. Making Mountains
Press TAB to go into edit mode and press the AKEY twice, in case you had any speciﬁc
vertices selected. Go into the front view and press the ”Noise” button(located under mesh
tools in F9). You should see the vertices jump up a good bit.
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Figure 1094

If not, you may have scaled your grid up too much, so make it somewhat smaller. Depending
on how high you want your mountains, press the Noise button to your required amount,
though I pressed it 8 more times. The mesh doesn't look very good right now, as it is not
only blocky, but it is missing that last bit of random detail.
• Important note! The mesh-editing button named ”Noise” causes a permanent change
to the geometry of the object in the ”Z”-axis, as provided by the texture. (The vertices
actually moved, and their new position is permanent.)
• There is also a procedural texture named ”Noise,” but that is just pure coincidence. The
two are unrelated, both in what they do and in how they work.
• Important note! Those using Blender 2.5 Beta in order to get the height map to aﬀect
the geometry you will need to use the displace modiﬁer instead.
If you are not in edit mode, go into it and select all the vertices. Press Fractal (in the same
row as Noise under mesh tools) and enter a value of 15 in the random factor. Hopefully,
your system can manage all these vertices: if not, then don't do any fractal subdivide. If
you want to, you can use a smaller value in the fractal box and do it several more times
for more displacement. Be careful, though: too much randomness will cause vertices to
separate, causing tears in the mesh that you will have to ﬁx by hand.
Finally, tab out of edit mode and press Set Smooth. Then, if you want to make the mesh
even more smoother, add a Subsurf modiﬁer, with what ever level you want. (I'm going
with 1 for faster render times.)
If you desire, you can scale up the mesh however big you want though for close-ups, you
may want another level of subsurf or another subdivide. Then, apply colors, set up the
lights, and render! A word to the wise, however: this process creates a huge ﬁle (about
986kb).

140.1.4. Discussion
You have just made mountains all in Blender, without having to generate height maps in
The Gimp, or any other program. The next step is to go beyond the tutorial. Try using
diﬀerent noise sizes and noise basis, and even try using other textures like musgrave and
marble. Or try using two textures and see the conclusion. The possibilities are almost
inﬁnite! Have fun.
Observe how the technique illustrated this tutorial is ”the same, yet diﬀerent” from the one
demonstrated in the tutorial for ”height maps”:
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• A procedural texture was used to supply changes to the Normal Mapping of the object at
render time. (This is the angle at which the object reﬂects light.) (The ”height mapping”
tutorial did not do this.)
• Then, the mesh-editing button (also...) named ”Noise” was used to deform the actual
geometry of the mesh. (This is the same technique used in the ”Height Map” tutorial,
although a diﬀerent kind of texture .. an image .. was used.)
• The texture, once used for the height-mapping (deformations) was left in place, still
mapped to the surface ”Nor”mals. The result will be a very mountainous landscape.
Yep! The techniques shown in all of these terrain-modeling tutorials can be combined!
And, they frequently are. Very often the most satisfactory results are obtained by combining
several diﬀerent techniques. You could have used an image-map (from the ”Height Mapping”
tutorial) to deform the geometry, then used the ”noisy Normal-mapping” idea from the ﬁrst
part of this tutorial, and even used smoothing. All at the same time. The choice is yours.
When using ”Map To,” remember that a single material can have several diﬀerent textures
applied to it, each one mapped to the same or to diﬀerent attributes. This mapping can
even be animated.
Experiment! The sky's the limit!
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Terrain
i Information
Applicable Blender version: 2.44

141.1. Introduction
I worked with a group to make a small animation for class and I was responsible for the
environment modeling. I really liked the results of the process I used, so I decided to share
it with others. By the end of this tutorial you'll have the know-how to create your own
ﬂexible, realistic terrain utilizing multiple textures for diﬀerent ground types. This tutorial
assumes that you have the very basic understanding of using Blender (how to add/remove
a mesh, how to change views, etc...) I use the following textures in this demo. Feel free to
use them if you don't have something on hand to use.

Figure 1095

NOTE: This page uses a diﬀerent grass texture for licensing reasons (sorry).
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141.2. Creating the Canvas

Figure 1096 The grid that will be used to
build our landscape.

The ”canvas” that we'll use for our terrain is an evenly spaced grid of vertices. Open a
new project, delete the default cube, and add a grid mesh. Use whatever size you want.
The more vertices you have, the more detailed and realistic your landscape will appear, but
don't get crazy with it since we'll apply subsurfacing at the end to smooth it out. At the
same time, you do want enough vertices to prevent sharp edges, and we'll need them in
the second tutorial when we cover texture stenciling. So consider how big you want your
landscape and try to ﬁnd a reasonable balance. I like to start with 100x100. The grid will
be pretty small, so scale the entire thing up, let's say by a factor of 20. This grid will be
used to build our landscape by pulling hills and mountains out of it.
Noob Note: If you don't want to have to delete the default cube every time you open a
new ﬁle, just delete the cube once so you have the blank window (only lamp and camera
left) . Then select File - Save default settings or hit Ctrl+U. From now on, each new project
you create will start oﬀ without the cube.

141.3. Molding the Mountains
The key to making good mountains is using the proportional edit mode (OKEY) and
constantly adjusting the radius of inﬂuence. If you've already gone through the Mountains
Out Of Molehills1 tutorial then this section will be familiar. One major diﬀerence is that
in this tutorial I recommend rotating the 3D view around so you have a good view of all
three axes instead of working in the front or sides view. Using the proportional editing
tool aﬀects multiple vertices, and it helps to see what eﬀect your changes are having as you
make them.

1
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http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Mountains_Out_Of_Molehills

Molding the Mountains
• Go ahead and turn on proportional editing, either by pressing OKEY or clicking on the
grey ring on the 3D View header. You have to be in Edit Mode to select this option.
Once proportional editing is enabled, the ring will appear orange and a new drop-down
menu will appear next to it with diﬀerent falloﬀ styles. Select Smooth if it is not already
selected.

Figure 1097

• Select any random vertex and grab it (GKEY). You will see a ring around the vertex
you are grabbing. This is the radius of inﬂuence, and only vertices inside this ring are
aﬀected by the transformation. If you are doing this in the orthographic view from the
front, side, or top, then this will be obvious. But if you're at a view where you can see
all three axes, then it may be less obvious.

Figure 1098 The ﬁrst mountain created
using proportional editing.

• Restrict movement to the z-axis (ZKEY) and translate the vertex upward. Throughout
this entire process you ONLY want to translate along the z-axis. If you start moving
vertices in the x or y directions, things become distorted and you get some nasty creases.
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Play around with adjusting the size of the radius of inﬂuence (Mouse Wheel) to get
steeper or ﬂatter hills.

Figure 1099

A nice group of hills

• Keep repeating this process with diﬀerent size radii and diﬀerent heights until you have
a decent mountain range, but leave an area ﬂat. We'll be using that spot later in the
second tutorial. Don't be afraid to occasionally translate some vertices down instead of
up to create depressions in the hills. Remember, variety is the spice of life. Very few
things in nature are naturally geometric, so mix up your hills and especially make sure
they overlap. How often do you see a nice, smooth hill all by itself in nature?
Note: You'll notice in my screenshot that I have reduced the size of my grid. For simplicity's
sake, I didn't feel like ﬁlling an entire 100x100 grid with mountains since this can take some
time.
• Well now, that's looking pretty good! Now, there's one problem with our hills so far.
They're too smooth! Let's bumpify them a little. Change the falloﬀ type from Smooth
to Random.

Figure 1100
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Figure 1101
realistic

Rougher hills look more

• Select a single vertex and grab it (GKEY). We're still working on the z-axis only, to
restrict your movement with the ZKEY. Now when you move the vertex up and down,
all vertices in the radius of inﬂuence will also move but with a random falloﬀ instead of
smoothly. It only takes a little movement to get the eﬀect we want, so something around
0.5-1.0 is enough. Mix up moving up and down with diﬀerent vertices, again to add
variety to the scene.
• Once you have your landscape the way you like it, add a subsurf modiﬁer under the
Editing tab (F9) and select Catmull-Clark. This will smooth out your terrain a little so
that it's not too rough. Given the number of vertices you already have, it's not necessary
to have a higher render value than 1 unless you just REALLY want it to be smooth, but I
don't recommend it. Land is supposed to be bumpy and rocky, we just don't want sharp
edges.
Noob note: If you're making mountains using Random Falloﬀ and the peaks stick up too
much: in Edit mode, select the points in the area around the peak using circle select, then
press WKEY and click 'Smooth' until you're satisﬁed (or, in the Editing tab (F9), click
the 'Smooth' button).
Useful Tip Proportional editing can be used on multiple vertices simultaneously. This
is especially useful if you're trying to create a cliﬀ face or a river bed. Use the box tool
(BKEY) to select a group of vertices and then translate them. Keep in mind that the size
of the radius of inﬂuence determines how many vertices around EACH VERTEX will be
inﬂuenced. So suppose you have a 5 vertex radius, that means that 5 vertices all the way
around your selected region will be inﬂuenced.

141.4. Texturing the Terrain
Alright! We've got some pretty nice hills now! But there's still a few problems. Hills
shouldn't be white, and hills shouldn't be SHINY! Let's dress them up a little, shall we?
• With your landscape selected, go to the Shading Panel (F5) and add a new material.
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•
•
•
•
•

Under the Shaders tab, drop the Specular value to 0.
Go to the Texture tab (F6) and add a new texture.
In the Texture Type drop down menu, select Image.
Two new tabs will appear. In the Image tab, click Load and load a texture from ﬁle.
In the Map Image tab, increase the Xrepeat and Yrepeat. Depending on the size of your
terrain and the image that you use (please use something that tiles!), these values will
vary. I've used 10 for each in this tutorial.

Figure 1102

(Noob note: Render the scene (F12) to see the applied texture) (Noob note: A quicker
way to do this is by using the render preview tool, 3d view window - render preview, View-> Render Preview or press SHIFT--> PKEY) (Noob note: you may also select shaded
in the Viewport Shading menu next to where you select object mode or edit mode to see
your texture on your mountains without rendering, however it does slow your computer
down some which could make editing frustrating. So only do this if you want to see what
your textures look like, then switch back to solid for more editing.)
• Finally, let's do something about the lighting. Go to Object Mode (TAB) if you're not
already there and select the lamp. Choose the Shading Panel (F5) and then click the
icon that looks like a light bulb to display the Lamp buttons. Change the lamp to a sun
and up the energy to 1.5. You may also need to increase the distance if your terrain is
large, or rotate it around if you don't like where it's pointing. The dashed line coming
out of the light is the direction. Play around with diﬀerent angles and energy values for
the sun to get diﬀerent times of day in your scene.
And there you have it! Your landscape is now textured with some nice grass to make it look
a little more realistic. Play around with hill sizes and roughness if you're not satisﬁed with
your landscape, but try not to be too picky. Nature shouldn't look too sculpted. Remember,
you won't notice a change in texture unless you render your image.
NOTE If you went with the suggested 100x100 grid, the rendering process could deﬁnitely
take some time depending on your system, especially if you have ray tracing and shadows
enabled. To boost the rendering speed, go to the Scene panel (F10) and under Rendering,
disable the buttons that say Shadow and Ray. Also note that because we've created some
hills, your camera may now be under the terrain. Switch to the camera view (NUM0) to
see what your camera sees and move it if you need to.

1268

Reader Contributions

Figure 1103

Join us next time as we explore how to make the landscape look even better using texture
stenciling!

141.5. Reader Contributions
I'm mainly doing this so the hills look better and more realistic. Reading this will consume
more time than doing it. I'm making everything clear for beginners. It will only take about
8 minutes more for your hills to end up like this:
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Figure 1104

1. First step to achieve it is to switch from the default lamp to Sun.
a) You do this by clicking on the default and go to the shading tab (F5)
b) Click on Sun.
c) Go to rotate manipulator mode with Ctrl Alt R.
d) Rotate the sun until the dotted line is in your desired position. That is where
the main energy will go. It will diﬀer if you want to achieve the diﬀerent time of
day. You can make the distance greater or less with dist.. I kept mine at default
30.
2. Now let's make more realistic, paler sunlight.
a) In the RGB slider, set R for 1, G for 1, and B for .848.
b) Set energy for 1.63. This will all diﬀer for diﬀerent times of day, so set your east
and west in your head, and the later into the day, the further the sun to the west
and the more orange. For midday, keep the energy on 1.63 and put the sun right
above your hills. I set mine for earlier in the morning.
3. Now click on the picture of a globe to change the background.
4. Click on the blend button for a more realistic looking sky. On the left of the World
toolbar, that will be the color of lower down in the sky and the right sliders will be the
color of the top of the sky. Naturally, the top should be darker blue than the bottom.
a) It will diﬀer for diﬀerent times of the day. So you might want something diﬀerent
from this. But I set up mine for the morning using the settings below:
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5.
6.

7.
8.

• The left HoRGB sliders to 0.50, 0.68, and 1.
• The right ZeRGB sliders to 0.11, 0.25, and 0.66.
Now for the texture. This won't diﬀer for the times of day, but it will diﬀer for what
type of landscape you want.
Download a nice texture from google or an artists website.
a) Go back to Blender, go to Texture buttons (F6)
b) Click add new
c) Select image for the texture type
d) Go to the image toolbar, and upload the texture. Blender will only allow you
to upload from the Blender documents, unless if you click on the up and down
arrows on the top left of the screen and choose the place where you saved the
texture (or picture).
e) After uploading, the X and Y repeats should be smallish, like 6x6, so the changes
aren't noticeable. It will look ugly in the preview, but it will look nice after its
wrapped.
Render, and 1 minute later, voila! Those are nice looking hills!
Now boast in front of your friends!

Noob Note: You need to have your landscape selected if you are in object mode to change
the texture, otherwise it will change the texture of the world.

141.6. Reader Contributions 2
You can have an even better result if you use the texture to ”bumpmap” the mountains.
1.
2.
3.
4.

Press F5 until you are into Material Buttons
Select the Map to tab
Click on Nor once (the Col option must stay selected as well)
Slide the Nor slider to 5 or more (might diﬀer depending on texture size and repeat
options)
5. Render with F12

141.7. Reader Contributions 3
Alternately from making the hill model manually, you can use a program like L3DT2 . It
uses various algorithms to generate very detailed and realistic terrain heightmaps. It also
lets you edit them in a more intuitive way than Blender does. After you have L3DT make
your height map, you can export it as a .x ﬁle, which you can import into Blender. Noob
Note: That can be done by going into File->Import->DirectX(.x). And there you have a
very realistic landscape mesh with a lot less work. (Noob Question: I want to use Unity3d
game engine to create a game, but i want to use blender to create landscapes. To create
massive world landscapes, does anybody have any tips? as Unity limits any mesh to 65000
vertices, which i've already passed with my method without doing half the map.)

2

http://www.bundysoft.com/L3DT/downloads/standard.php

1271

Landscape Modeling I: Basic Terrain
-If you are using unity 3d just use it for the terrain. Download the terrain toolbox and just
use .raw images. Or simply generate from there and save. 65,000 verts is plenty btw. If
you insist on using blender for the terrain then model a high poly terrain ﬁst consisting of
around 1 mil+ verts. bake the normal map and ambient occlusion decimate your terrain
to around 10k or w/e looks good for the game. Then bam you got 10k terrain that looks
like 1mil. But to be honest blender terrain texturing is a pain compared to unity. Anyhow
hope that helps.
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Stenciling
i Information
Applicable Blender version: 2.44

142.1. UPDATED FOR 2.7 USERS
This is a continuation of the previous tutorial, Landscape Modeling I: Basic Terrain1 . In
this tutorial, we will make our terrain look even better by using some texture stenciling to
add multiple textures where we want them in the landscape. This tutorial assumes that
you have a basic understanding of how to use Blender (how to add/remove a mesh, how to
change views, etc...)

142.2. Creating the Stencil
The landscape from the previous example looks pretty good, but the entire thing has the
same texture, so it doesn't look very natural. Let's add some rocks to those hills. If we just
add a second texture to our material, it will completely cover the previous one. What we
want is to have the ﬁrst texture only show in certain places and the second texture cover the
rest. In order to do this we'll have to create a stencil, which is like a mask that determines
where textures appear on the material. The stencil is a black and white image, similar to a
heightmap, except the intensity of each pixel determines how much of the next texture will
appear (black = 0%, white = 100%). I highly recommend viewing this2 tutorial for a more
in depth description of how stencils work. If you think you have the gist, then continue
on here. [Note: Link is broken now] We're going to create our own stencil to determine
where we want rock in the landscape by ”painting” on the object. *IMPORTANT* The
next few steps will be performing temporary modiﬁcations to your scene, so be sure to save
your ﬁle before you continue so that the changes will not be saved!! Also, if you have a
subsurf modiﬁer on the landscape, remove that at this time as it drastically slows down the
following process.
• Select the landscape object and switch from ”edit mode” or ”object mode” to
”Vertex Paint mode”. This is found in the Mode drop down menu, on the 3D View
header. This mode lets you paint the object, and thereby change the color value of each
1
2

Chapter 141 on page 1263
http://feeblemind.org/blog/index.php?post/2005/02/27/16-didacticiel-usage-des-masques-de-textures-tutoria
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vertex. When in Vertex Paint mode, you'll notice your object change color to a pixelated
version of the texture that is applied to it. This is because with that texture applied,
each vertex will be drawn with the colors you see.
Noob Note: Vertex Paint mode is in the drop down menu that contains Object mode and
Edit mode. Just select the object while in Object mode, click the drop down menu, and
select Vertex Paint mode from the list.
• Switch to the Editing menu (F9) and you'll see a new tab called Paint. Notice the sliders
labeled Opacity and Size. Opacity determines how much to blend the selected color with
the existing colors when you paint. So 0.2 means that when you click, you'll get 20% of
the selected color mixed with whatever is currently there. Over on the right are diﬀerent
options to combine to colors. We want to mix, so as we paint the colors will mix together
and give us a nice smooth blend. Size is the size of your cursor while painting, and thus
how many vertices are aﬀected. Keep in mind that does not change as you zoom in and
out, so a size of 10 can actually paint more pixels if you're zoomed way out than a size
of 30 if you're zoomed way in.

Figure 1105

• Change the color to black and click the button that says Set VertCol (in 2.48 version,
that button is below the color square and named 'SetVCol'). This will change the color of
your entire object to black. You'll notice that the object is not lit in Vertex Paint mode,
so when the entire object is black it can be diﬃcult to see where your hills are. You'll
have to move the camera around to see the shapes.
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[Another newbie recommends: if you switch to the ”object” buttons (f7) and turn on ”Wire”
under ”Draw Extra” in the ”Draw” panel/tab you should see a wireframe on top of the vertex
colors you are painting, which makes it much easier to see where the hills are. Remember
to switch this back oﬀ when you have ﬁnished painting.]
• Now we're going to paint the places where we want rock to show through. Change the
paint color to white. It's less likely that grass will grow on steep slopes, so start painting
the tops and edges of the steeper hills white by holding down LMB and dragging your
mouse (think MSPaint). If you didn't heed my earlier advice and still have a subsurf
modiﬁer in eﬀect, the painting will be very choppy, so remove that now.
• As you're painting, try to make some spots pure white by going over them again and
again, but don't make any one area of white too large as this will make a huge area be
all rock, and we're trying to blend two textures.
• This process can just be trial and error getting the landscape painted the way you want.
Once we apply our stencil later you may decide there's too much rock in one area, or not
enough in another and go back and change it. A few things to keep in mind:
• 20% opacity means that most of the original texture (grass, in our case) will show
through, so the rock won't be very noticeable if at all. You'll have to go over the same
spots a few times to increase the intensity.
• You don't want a dramatic change from grass to rock, so be sure to blend white areas
with black. That's why we're using the 20% opacity instead of just bumping it up to
100%.
• Make your patches random and spotty. This will end up creating a more realistic eﬀect
once we combine the textures.

Figure 1106
landscape

Painting the stencil onto the

• Once you're done you should have something that looks like this. Notice the mixture of
white and black in some places, how it doesn't just go from pure white to pure black as
you move down the hills. This will make a more natural blend and it will cause random
rocky areas mixed in when the grass. Now we need to turn this into our stencil.
• Go to the overhead view (NUM7) and make the projection orthographic if it's not
already (NUM5).

1275

Landscape Modeling II: Texture Stenciling
• Zoom in/out (Mouse Wheel or NUM+/NUM-) until the plane almost occupies the
entire window.
• Move the 3D cursor and any lamps or cameras away so that they're not over the landscape
and take a screenshot.

Figure 1107 The stencil after its been cut
from your screenshot

• Open your favorite image editor (I'm a traditionalist, so I still like MSPaint), and cut out
the image of landscape. This is now your stencil. Save it under your favorite format.
• Re-open the saved version of your landscape to undo the changes we made to create the
stencil.
So why did we make our stencil this way? This allowed us to actually paint on our terrain
so that we ensure we get the rock exactly where we want it. Using this method, you can
customize your stencil to any object, as long as it has enough vertices. For example, if we
just had a ﬂat plane made of 4 vertices, this technique would not have worked because we
could only paint the corners. That's why in the previous tutorial I recommended using a
high (but not too high) number of vertices in your grid.

142.3. Applying the Stencil
So now we need to apply the stencil to the landscape to mix our grass and rock textures
together.
• Return to either Object Mode or Edit Mode (TAB), it doesn't matter which.
• Go to the Texture menu (F6) and add two new textures in the material (you should
already have the grass texture).
• Make texture 2 (the ﬁrst new one you added) an image and load your stencil from ﬁle.
Do not repeat this in the x or y directions. We want it to map to the entire object.
• Make texture 3 an image and load your rock texture from ﬁle. This one you do want to
repeat, just as you did the grass.
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• Now return to the Materials menu and select your stencil texture. It's a good idea to
name your textures, materials, objectives, etc... so that they're easily identiﬁable.
• With your stencil texture selected, switch to the tab labeled MapTo. Deselect Col (which
maps the texture to the color), and select Stencil and No RGB. Stencil will treat this
image as a stencil, and No RGB treats it as a black and white image. If you didn't select
this second option your stencil wouldn't work.

Figure 1108

Mapping the stencil texture

• In the preview tab you should notice your material change so that the grass and rock are
now mixed. If you render, you'll see a much more realistic landscape than the one from
the previous tutorial!
Noob Info: Be sure that for the rock - texture col is selectet because we want to color the
landscape with the rock-texture! Otherwise it doesn´t work. Select Rock-Texture -> Map
To -> col
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Figure 1109

Landscape with grass and rock textures mixed

142.4. Adding Snow
Since you already have some nice mountains, why not add some snow to them? Adding
snow is easy. All you have to do is add a fourth texture AFTER all the others. Make this
texture the same as your stencil.
•
•
•
•
•

Make sure you're in Shading (F5) > Texture Buttons (F6) > Textures.
Click on an empty panel beside Texture Type
Click on the little box to the left of Add New
Choose your stencil from the menu (hint: it helps if you name your textures)
Render and see the results.

If you made your stencil properly, you should have some nice, snowcapped peaks. It's not
much, but it's enough for a quick ﬁx. If it isn't even, you probably didn't make your stencil
properly (meaning pretty much all white on the peaks, and not much anywhere else). Of
course, there are better ways to do this, ways I wouldn't know about; I discovered Blender
merely three days before the time of writing. I leave it up to you to see the eﬀect: I only
have so much room and bandwidth for pictures!
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This eﬀect works by saturating the underlying color with white, depending on the amount
of white in your stencil. A light gray will saturate it only a bit, whereas a bright, 100%
white will cover it very clearly and eﬃciently. If you look closely, you'll see that the light
gray on the stencil DOES make a diﬀerence, but it's not immediately visible and requires
lots of ﬁdgeting with the Render Preview and texture options. You might also try ﬁddling
with the Stencil and NoRGB option, although it worked ﬁne for me with both turned oﬀ (I
use Blender 2.48a)
Some challenges:
• Try to change the color of the snow. Hint: RGB
• I've yet to do this, but try making snow out of a heightmap.

142.5. Multiple Stencils
Remember in the ﬁrst tutorial when I said to leave part of the landscape ﬂat, because I'd
be using it later? Well it's time to use it. I want to eventually use the landscape as the
backdrop for a military base, so let's texture the ground around where the base will go to
give it a dirt ground and road leading to it. *IMPORTANT* Just as before, the next
few steps will be performing temporary modiﬁcations to your scene, so be sure to save your
ﬁle before you continue so that the changes will not be saved!!
• Switch to the Vertex Paint mode in the mode menu on the 3D View header.
• Go to an overhead view (NUM7) and make the projection orthographic (NUM5)
• Once again, paint the entire object black by selecting the color black in the Paint tab
and clicking on Set VertCol.
• For the next few steps, you may need to TAB back and forth from Vertex Paint mode to
Object mode to make sure you're painting in the correct area. Make the opacity of the
painter 1.0 and the size 10 so that we can work very precisely.

Figure 1110
base

The stencil for our future
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• Paint an area over the ﬂat terrain in the shape of a generic military base, like you see
here.
• Reduce the opacity back down to 0.2 and increase the size to 20.
• Paint the road leading away from the base. We've reduced the opacity and increased the
size so that the road will blend more with the landscape around it instead of being more
deﬁned like our base.
• Once you have your stencil looking the way you want, take a screen shot and save it.
Then revert back to your previous environment (before you started painting on it).
• Go to the Texture menu (F6) and add two new textures.
• Load your stencil into the forth texture (the ﬁrst new one), and the dirt image into the
ﬁfth texture. Once again, remember to set the x and y repeat for the dirt texture.
• In the Materials menu (F5) select your new stencil and go to the MapTo tab. Deselect
Col again, and select Stencil and No RGB. Notice the new preview.
• Wait a second, where's the dirt path?!? Here's the problem and the reason I've included
this section: stencils are cumulative. That is, the ﬁrst stencil deﬁnes which portions of
ALL successive textures will be drawn, including other stencils! In order for our new dirt
path to show up, we need to make sure it's part of the ﬁrst stencil.

Figure 1111
one

Both stencils combined into

• Open your ﬁrst stencil (the one you used to add rocks to the hills) in your image editor
and combine the new stencil with it. The result should appear somewhat like this. Be
sure that when you combine your dirt stencil with your rock stencil that the dirt stencil
remains the same size and in the same place. That is, you want the two to be perfectly
aligned.
• Reload your ﬁrst stencil on your material, the one we used for the rocks. Now the preview
should look the way we want it to, and if you render you will see your new dirt area on
the ﬂat part of the landscape. You can add even more stencils the same way. Here is how
all of the textures blend together:
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Figure 1112

NOTE I had to replace the grass texture in the above image since I could not ﬁnd the
licensing information for it. I apologize for the inconsistencies in the diagram that result
from this.
Well there you have it! This is a pretty useful method of texturing complex objects. Check
out our new landscape and how it compares to the previous, boring, single-textured landscape!
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Figure 1113

Once again, if you have any issues with the tutorial, or feedback (positive or negative), drop
it in the discussions.

142.6. For 2.7 blender users:
• ﬁrst you add the material
• leave the grass texture at the default
• add the next two textures , the stencil and the rock, soil etc texture as stated in the above
tutorial.
• go to the stencil texture
• in the inﬂuence panel, uncheck col
• check 'RGB to intensity' button
• check stencil
• others everything as their default values are good
-For me, with settings above, the rock texture was not very visible. It may help to play
around with the color intensity settings in the inﬂuence panel (increase in the rock texture,
and decrease in the grass texture) -
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143. Landscape Modeling III: Exporting
as a Heightmap
i Information
Applicable Blender version: 2.44
In this tutorial, I will show you how to export your beautiful terrain to a heightmap that
can be used in most 3D graphics engines. The beneﬁt to doing this as opposed to just
exporting your mesh is that many engines have a special process for dealing with terrains as
opposed to regular meshes where it divides the terrain up into diﬀerent sections so that it
can subdivide regions closer to the camera more for greater detail, and also cull (not render)
regions outside the camera's ﬁeld of view, saving precious processing time. This structure
is called an oct tree1 and is a highly optimized way to render large meshes such as terrains.
Before I begin, I must give credit to the Creating a Heightmap from a Plane2 tutorial on
the Blender wiki3 . This is how I learned to do this trick, and most of what I will cover
came from this tutorial. I'm simply including it here with the other landscaping tutorials
I've written for convenience.

143.1. A Word About Heightmaps
I will brieﬂy cover what a heightmap is and how it's useful for those who may not know. If
you are familiar with heightmaps, you can skip ahead to the next section.

1
2
3

https://en.wikipedia.org/wiki/Oct_tree
http://wiki.blender.org/index.php/Tutorials/Creating_a_Heightmap_from_a_Plane
http://wiki.blender.org/index.php/Main_Page
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Figure 1114

An example of a heightmap

A heightmap is a grayscale image that uses various shades of gray to represent diﬀerent
elevations across a map. Since the images are 8-bit (with the exception of some RAW
formats that are 16-bit), you have 256 diﬀerent shades of gray, ranging from pure black
(0) to pure white (255). Black represents the lowest elevation on the map, while white
represents the highest. Many 3D graphics engines already have functions to read in a
heightmap and generate terrain from it. The way it does this is it creates a grid of vertices
(like we are going to do in Blender in just a moment), and uses the heightmap to determine
the elevation of each point on the grid. The more intense the pixel color (the closer it
is to white), the higher the elevation of that vertex. In most cases, if the resolution of
the heightmap is smaller than the resolution of the terrain, the engine will interpolate the
vertices in between those set by the heightmap. For example, if your heightmap is 256x256
and your terrain is 1024x1024, your heightmap will determine the elevation of every fourth
vertex, and the three in between will be interpolated.
Note that these values do not represent the absolute height of any given pixel, but rather
the height relative to the rest of the map. That is, your heightmap does not represent a
landscape with altitudes ranging from 0 to 256. When importing a heightmap, you can
specify the minimum and maximum altitudes for the map, and the whole thing gets scaled.
For example, suppose you decide the minimum is 1000 feet, and the maximum is 5000 feet.
When the terrain is rendered, black pixels will represent 1000, white pixels will represent
5000, and a pixel that is exactly in between black and white (128) will represent 3000 feet
(half of the sum of min and max). This makes heightmaps relatively ﬂexible.
Unfortunately, as you may have already noticed, there is a limitation of using heightmaps.
Since you only have 256 shades of gray, you only have 256 possible elevations. This causes
a problem. No matter how precise your vertices may be in the mesh that you model, no
matter how smooth you may have it looking, each point will get rounded oﬀ to an integer
value between 0 and 255. When used to render a terrain, this can cause a ”stair step” eﬀect
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as the terrain goes from one discrete elevation to the next instead of making a smooth
transition. But there are ways to avoid this, which I will cover later.
I apologize if you're scratching your head right now saying ”Huh?” For a further explanation
and example, check the Wikipedia page on heightmaps4 .

143.2. Creating the Material

Figure 1115 The terrain that will
generate the heightmap

To begin this tutorial, I will assume that you already have a landscape that you want
to create a heightmap for. If not, read my ﬁrst tutorial, Landscape Modeling I: Basic
Terrain5 , to quickly create something. WORD OF CAUTION!!! If you've already
created a landscape, try to remember the exact size of the plane that you used. If you're
about to make one, it's okay to scale the plane to have a larger surface to work with, but
REMEMBER how much you scale it by. This will make things easier later. I recommend
just working with the default 2x2 plane or grid and zooming in on it. You may also want
to backup your scene since we'll be changing a few things
To create the material we need, do the following steps:
• Remove any existing materials that may be applied to the terrain.
Note: to remove a material, I think you need to go to the links and pipeline window in the
shader section and click the little ”X” underneath the words ”link to Object”
• Add a new material in the Shading tab (F5).
• Go to the Textures tab (F6) and add a new texture. This should be the only texture on
your material.
• From the Texture Type drop down menu, select Blend.

4
5

https://en.wikipedia.org/wiki/Heightmap
Chapter 141 on page 1263
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• In the same window, ﬁnd the Colors tab and select Colorband. This will let us deﬁne the
blend pattern, which by default fades from black with full transparency to a solid cyan.
Why cyan? I have no idea. It's an odd default.
• Select the black color by clicking on the left side of the colorband. You should see a little
black and white bar selected.
• Increase the Alpha all the way up to 1 by adjusting the slider labeled ”A”.
• Select the cyan color and change this to a solid white.
• What you have now should look like my colorband below.

Figure 1116

The blend colorband

• Return to the Materials tab (the red ball icon next to the cheese looking icon).
• In the Material pane, select the Shadeless option to disable lighting on the material.
• To the right, ﬁnd the pane labeled Map Input. In the bottom of this pane is a grid that
by default reads:
XYZ
XYZ
XYZ
• Set all three rows to Z so that the texture will map entirely to the Z coordinate.
• In the preview window to the left, if you select the sphere or cube you should see that
it goes from black on the bottom to white on the top. That's the eﬀect we want for
the terrain. Remember, in a heightmap, black represents the lowest point and white the
highest.

Figure 1117
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Map the input to the z-axis and make the material Shadeless

Setting up the Camera
• Finally, switch back to the Editing tab (F9) and click the Set Smooth button to enable
Gouraud shading6 so that everything appears smooth.

143.3. Setting up the Camera
That's all we need to do for the terrain itself. Now what we're going to do is setup the
camera in such a way that when we render the scene we'll get an orthographic projection
straight down on the terrain so that we can save it as our heightmap.
• If you still have any lights or cameras in the scene, delete them.
• Switch to the top view (NUM7) and place the 3D cursor at the origin (0, 0, 0) by
left clicking near the origin, hitting SHIFT+SKEY and selecting Cursor to Grid. (An
easier way is: hitting 'SHIFT+SKEY' and selecting 'Cursor to Center')
• Add a new camera, Space->Add->Camera. This will add a new camera to the scene that
is looking straight down.

Figure 1118 The camera needs to be
above the terrain
• Switch to a side view (NUM1 or NUM3) and move the camera up the Z axis so that it is
above the highest point in your terrain. Even though the view is going to be orthographic,
and therefore distance doesn't matter, the entire terrain still needs to be in front of the
camera.
• Now, with the camera selected, go to the Editing tab (F9) and select the ”Orthographic”
button. This will change the camera to an orthographic projection which basically ignores
the z-coordinate for all vertices (except for determining which pixels should be in front
of others).
• Just above the orthographic button is a value labeled ”Scale”. Remember earlier when I
told you to remember how big your terrain is? This is why.
• Change the Scale of the lens (default: 6) to match the size of your terrain. If you left the
plane the default size, this should be 2. If you scaled the plane up by a factor of 20, as

6

https://en.wikipedia.org/wiki/Gouraud_shading
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suggested in the ”Landscape Modeling I: Basic Terrain” tutorial, this should be 40 (the
plane is initially 2 units square).
• Now go to the scene tab (F10) and under Format, change the SizeX and SizeY to be the
size you want your heightmap to be. For most graphics engines, this is required to be
either a power of 2 (2^n) or one more than a power of 2 (2^n+1). So try something like
256 (or 257 if you need it to be 2^n+1).

Figure 1119 What the terrain will look
like from the camera view
• Now, if you switch to the camera view (NUM0) you should see a ”ﬂat” square that
completely ﬁlls the dotted box which represents the camera's ﬁeld of view.

Figure 1120 The rendered image will be
your heightmap.

• Render the scene (F12). You should be looking at your heightmap. Hit F3 to save the
rendered image and you're good to go!
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Avoid Stair-Stepping
Since this image has no color, and some engines require that your heighmap be a grayscale
image (only one color channel instead of three), select the BW button in the Format pane
before rendering. This will render it as a grayscale image instead of a color image.

Figure 1121

Select BW to save as a grayscale image.

143.4. Avoid Stair-Stepping
As mentioned earlier, exporting the heightmap as an 8-bit image (Blender doesn't
any 16-bit formats that I'm aware of) has the drawback that you only have 256
height values which can cause a stair-step eﬀect when the terrain is subdivided.
you could use an application that can export the image in a 16-bit raw format,
Terragen. But this is a Blender tutorial, so we'll not go into that. =P

support
discrete
Ideally,
such as

143.4.1. Reducing the resolution
One way you can ”smooth” out the rendered terrain is to actually reduce the resolution of
the heightmap. This may sound counter intuitive, but bear with me. Suppose you have
a heightmap that is a simple blend from black to white going from left to right. If your
heightmap is 1024x1024, you will get 4 columns of each height since you only have 256
diﬀerent values. In other words, your grayscale will look something like this:
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00001111222233334444...
00001111222233334444...
00001111222233334444...
00001111222233334444...
00001111222233334444...
00001111222233334444...
If you try to render terrain from this, you'll get 4 points with 0 altitude, 4 with 1, 4 with
2, and so on, creating the stair-step eﬀect.
Now suppose you make the same heightmap, but reduce its size to 256x256. Now you'll
have 1 column for each height, and your grayscale will look something like this:
012345678...
012345678...
012345678...
012345678...
You may be thinking, ”But then my terrain will be smaller, or less detailed.” But it turns
out the opposite is actually true. Consider applying the above heightmap to a terrain that
is 1024x1024. The values from your heightmap will be applied to every 4th vertex, and the
ones in between will be interpolated. So instead of having something like:
0.0 0.0 0.0 0.0 1.0 1.0 1.0 1.0 2.0
which is what you would get with the 1024x1024 heightmap, you'll actually get something
like this:
0.0 0.25 0.5 0.75 1.0 1.25 1.5 1.75 2.0
Where the integers are the values from your heightmap and the fractions are interpolated
values. This is assuming that whatever engine you are using will interpolate the values
between heights read in from the heightmap.
At the present time, this is the only method I have veriﬁed that helps reduce the eﬀects of
stair-stepping. As I try diﬀerent techniques I will update this page with them. For example,
I know that Adobe Photoshop can export images in 16-bit raw formats, but I haven't tried
it yet so I don't want to suggest it as a solution.
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144. Bump Mapping
i Information
Applicable Blender version: 2.49
Bump Maps are textures that store the relative height of pixels from the viewpoint of the
camera. The pixels seem to be moved in the direction of the facenormals, either in direction
to or away from the camera. You may either use greyscale pictures or the intensity values
of an RGB-Texture (including images).

Figure 1123

Figure 1122

Image 1b: Material settings for the texture.

Figure 1124
to a plane.

Image 1c: The texture grid applied to a sphere and

Image 1a: A texture grid for bump mapping.

Bump Maps are easy to apply. They work well on ﬂat surfaces, only to some extent on
curved surfaces. On curved surfaces it is more easily noticeable that you don't create real 3D
structures. The visible eﬀect depends on factors like lighting, specularity of your material,
camera angle, distance and so forth.
•
•
•
•

Add a new texture to your object.
Activate the Nor button in the Map To panel.
Set the depth of the bumping with the Nor slider.
Use the texture type Image and load your bump map.

Bump maps should contain hard transitions between black and white. A gray wedge (e.g.
a linear blend texture) would be hardly visible in the rendering.

144.1. Creating Bump Maps
You can easily create Bump Maps with Blender yourself, this is especially useful if you have
modeled some small details on a surface and you realize at the end that your scene will get
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too complex. You could also use the Bump Maps in a 2D application like Gimp or other,
similar programs.
I will create an animated bump map in highest possible quality, it is not always necessary
to make such an eﬀort. The goal is to create a wave eﬀect and make an image sequence of
it, to be used as a bump map. The original object has 600.000 vertices, the object the map
is applied to has 8 vertices.

144.1.1. Setting up the scene

Figure 1125
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Image 2a: Setting up camera and object in the 3D view.

Creating Bump Maps
•
•
•
•
•
•
•

Open the default scene and remove the cube.
Insert a plane and change to edit mode.
Crease its edges with +1 (Shift-E).
Subdivide multi with 11 cuts.
Change to object mode.
Add a SubSurf modiﬁer with a render level of 6.
Add a Wave modiﬁer.
• Time Sta: -10
• Height: 0.2
• Width: 1.5
• Narrow: 1.5
• Set the camera dead upon the plane.
• X/Y/Z: 0/0/5. You can use the Transform Properties Panel to bring the camera to a
certain position, the Z-Position is important is this case.
• Set the camera lens to 80.00 (Editing Buttons->Camera Panel).
The plane should now ﬁt exactly into the camera view.
• Save your ﬁle.
We're going to use the Z-Buﬀer information to create the bump texture. The Z-Buﬀer
contains the distance from the camera, this is exactly what a bump map is. To render the
Z-Buﬀer information as an image, we're going to use Composite nodes. To get the highest
possible quality, we will use Open EXR as ﬁle format, this allows us to store the Z-Buﬀer
information with a numerical accuracy of 32-Bit ﬂoating point, instead of a meager 8-Bit
value.

144.1.2. Render settings
•
•
•
•

Change to the Anim tab buttons (f10).
Set End to 40.
Activate Do Composite.
Select Open EXR in the Format panel, set SizeX/Y to both 600 (square image for the
square plane).
• Set the Output directory to //BumpAnim/. This creates a subdirectory to the ﬁle where
the image sequence will be stored. Don't omit the slashes.
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144.1.3. Node editor

Figure 1126

Image 2b: Composite Nodes setup to render the Z-value.

Now the setup for the composite nodes.
• Open a Node Editor window.
• Select Composite Nodes.
• Activate Use Nodes.
A Render Layer and a Composite node will be inserted automatically.
• Add->Vector->Map Value.
• Connect the Z-Output of the Render Layer to the Value input, and the Value output to
the Image input of the Composite node.
If you render now the image is plain white, we have to talk a bit about the Map Value node.
The Oﬀs value is the distance from the camera where the Z-Buﬀer should start (in negative
BU). It is not to important to get the best range, because we use OpenEXR, but if you
would like to use PNG instead, you have to select this value carefully.
• Set Oﬀs to -4.8. This is the smallest distance from the camera needed. You can measure
this value if you use the Camera Clipping, or if you render and move your mouse with
pressed LMB above the render window.
• Set Size to 4. The size value is a bit complicated. This is not directly the value range,
1
1
instead range = size
, and size = range
.
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Applying the animated bump map
• If you want to include the Z-Values from -4.8 up to -5.05 the range is 0.25, so Size is 4.
• If you want to include the Z-Values from -4.5 to -3.5 the range would be -1, so Size would
be also -1.
• If you want to include the Z-Values from -4.5 to -5.5, the range would be 1, so Size would
be 1.
• Render the animation.

144.2. Applying the animated bump map

Figure 1127
a

•
•
•
•
•
•
•
•

Image 3a: The Bump Map applied Videoa .

http://www.vimeo.com/4959751

Open a new ﬁle.
Select the default cube and change to the Texture buttons.
Use the texture type Image.
Load the ﬁrst OpenEXR-Image from the directory where you have stored the sequence.
Activate Sequence in the Image panel, set Frames to 40.
Change to the Material buttons.
Activate Nor for the texture and set the Nor slider to 25 in the Map To panel.
Set the mapping to Cube in the Map Input panel.

This is it. Pretty much the same look as with the real deformation, but using much less
resources.
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145. Normal Mapping
Noob Warning: This technique is best used for models and animation, and is not well used and
applied in the Blender Game Engine

Normal Mapping in 3D graphics development is the process of using an RGB1 color-map
to create a three-dimensional relief on a two-dimensional plane. The source for the normal
map in blender can either be a texture already installed in Blender, or using an external
picture-ﬁle (.jpg, .jpeg, .bmp, and so on) and loading it as a normal map. One great aspect
of Blender and normal maps is that Blender can very easily be used to create normal
maps that can be turned around and used in blender to reduce poly count. This tutorial
will show the various ways to create a normal map and how to apply diﬀerent normal maps
to your model in Blender.

Figure 1128

1

https://en.wikipedia.org/wiki/RGB
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Figure 1129

Figure 1130

Sections within Chapter:
1. Texture Normal Mapping2
2. Color Map Normal Mapping3

2
3

Chapter 146 on page 1299
Chapter 147 on page 1305
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146. Texture Normals
i Information
Applicable Blender version: 2.46

146.1. The Texture-Normal
To familiarize yourself with normal maps and how they work, we will begin by using the
texture engine in Blender to create our ﬁrst normal map. This process is very useful for
creating quick and non-speciﬁc normal maps for your projects that need a bit of texture.
To begin, open blender and whatever your basic load settings are, in the 3D view, delete
everything so the ﬁeld is clear. ( A to select all, then X to delete)
Move the 3D cursor to the center of the X,Y, and Z axis ( SHIFT + S Cursor to Center,
and switch to top view ( NUM7 ) orthographic view ( NUM5 ). Hit SHIFT + S - NUM4
then CKEY to center your view now. Toggle Quad View, CTRL + ALT + Q or menu
View->Toggle Quad View

Figure 1131

Add a mesh plane to the ﬁeld, and scale that plane to ﬁve times normal size. ( SHIFT +
A , select Add->Mesh->Plane, S then NUM5 to scale ﬁve times size.) This plane is
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going to be our base-it will remain untextured so it can be used as a comparison. Don't
give it a material.
Now, with the 3D cursor still on the center, add a mesh cube to the ﬁeld. Scale this cube
3 times in the X and Y directions, and 0.5 times in the Z direction. ( SHIFT + A , select
Add->Mesh->Cube, S , SHIFT + Z , then NUM3 to scale 3 times in X and Y directions,
S , Z , then . - NUM5 for Z.) This cube will serve as our texture comparison.

Figure 1132

For this tutorial, lets use the ”Musgrave” texture to make a 3D relief.
Select the cube, and then in the Buttons Window select the material index. Give the Cube
a material, and make this material any light color you wish to diﬀerentiate it from the base
plane (darker colors won't show the relief that well). Now select the texture icon in the
material window. Add a new texture, and make that texture Musgrave with the following
settings :
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Figure 1133

•
•
•
•
•
•

Type: Multifractal
Dimensions: 0.5
Lacunarity: 3
Octaves: 2
Intensity: 0.45
Noise:
• Basis: Voronoi F2
• Size: 0.075
• Nabla: 0.025

Excellent, now we are ready to show what we have done! If you return to the material
window in the material index, then you will probably be wondering what's wrong-your
preview window just shows a sphere with a huge purple splotch! Don't worry, we just
haven't applied the texture as a normal map yet, it's still just a color map. Click the
”Map To” tab in the material window and you will see a whole row of buttons, menus, and
sliders. Currently on the top row of buttons the ”Col” button is depressed, which is how
the texture knows to apply as a color map. Click the ”Col” button to remove the color from
your preview window. Now click and depress the ”Nor” button and look what happens! An
intricate texture embeds itself on the sphere in the preview window. The Musgrave texture
has caused a depression texture within the preview. If you happen to click the ”Nor” button
again, you will see the letters turn yellow and now that means the Musgrave texture is
causing an elevation texture. Click it once more and the texture is turned oﬀ. Keep the
”Nor” button depressed for this tutorial.
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Figure 1134

Now that you know how that works, let's see what it did to your cube. First, go to front
view (numpad-1) and zoom out a bit so about 10% of the screen is ﬁlled with your cube.
Select the cube and hit Shift-S-key-4-key then C-key to center your view. In the upper-left
corner, add a sun-lamp (Shift-A-key, Add->Lamp->Lamp). Adjust the ”Dist” Slider to a
very far length, to make sure it reaches the cube. In the upper-right corner (make it a little
closer to the cube) add a Camera (Shift-A-key, Add->Camera).
Move the Camera to get a better perspective of your work, by rotating it to look at the
cube and the plane. If you want exact directions: Switch to top view (numpad-7). Move -4
Units in Y direction. Rotate -75 degrees on Z rotation. Rotate -45 degrees on Y rotation.
Now hit numpad-0 to see how well pointed it is to the cube. Make adjustments to your own
work if you'd like.
Now you are ready to Render and see how it turned out!

Figure 1135

After your ﬁrst render, I'll let you know that you can adjust the depth of the shading. Select
the cube, and in the material index in the ”Map To” tab, in the mid-right area, there is a
slider called ”Nor” that should be set at 0.5. Just to test, set it to 0 and render to see what
happens. Then set it to 2 and render to see the results.
After you see it rendered, you probably realized that the edges of the cube were very sharp
and didn't have the rocky texture. This is because the 3D relief on the cube is fake--it's

1302

The Texture-Normal
not actual 3D, it's the computer just calculating where light should bounce oﬀ and in what
direction. Imagine how many faces it would have taken to create this texture shading
without Normal Mapping.
If you want, you can move the lamp around and see how the light moves around the fakebumps.

Figure 1136

This is best if you just need a non-speciﬁc texture, such as asphalt, cement, carpet, or even
fabric. Now if you want to do something like make a low-poly brick wall, you will need to
a speciﬁcally-tailored normal map for such thing. The next section will show you how you
can make your own normal map and apply it as well.
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147. Color Map Normals
i Information
Applicable Blender version: 2.46

147.1. The Color-Map-Normal
For more advanced Blender users, you probably have at one time or another wanted to
create something very detailed and realistic, only to realize that one modeled head or
one cool building has taken an enormous amount of memory, and rendering (or worse,
animating!) something like that would probably take days! Well there is an awesome trick
you can use to create intricate details and design shading, with a relatively low amount of
faces. You can use blender to create and apply normal maps, which are RGB colored maps
that can be used as a texture to calculate how light will bounce of an objects surface. All
you need is blender and photo-editing software to tweak the picture a bit.

147.2. Creating a Normal Map
You can very easily create a normal map once you ﬁgure out all the necessary settings. You
can start by either making a high-poly count version of your object, or making the material
that will be applied to the object to make the normal map.

147.2.1. High-Poly Version
We will ﬁrst start by making a simple object with a high-poly count. Start up blender, and
let's delete everything there ﬁrst, then go to top-view, orthographic, and start by adding a
camera.
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Figure 1137

Next, start with a circle, with a radius of 2 and 32 vertices in circumference. Keep it ﬁlled.
Select the edges of the circle, keeping the inner vertex unselected, and extrude edges only.
Scale the new vertices by 1.1. Repeat this with only the outermost vertices 6 more times,
until you have a ring of 7 vertices and a center vertex. Now, we will refer to the center
vertex as center, the innermost ring as Ring 1, and the outermost ring as Ring 7. Deselect
all vertices, then select all vertices of ring 2, 4, and 6 (This can easily be done by holding
the Alt and Shift keys, then selecting an edge adjoining two vertices of the same ring for
each ring). With these rings selected, move it 0.4 in the Z direction. Now, let's smooth this
bowl out. In the editing index, under the modiﬁers tab, add a subsurf modiﬁer of 2, and
then apply the modiﬁer. Then under the links and materials tab, select Set Smooth. Next
after the object looks all nice and smooth, select your Camera and move it positive in the
Z direction so it's positioned directly above the object looking straight down at it, and edit
the camera Lens properties so that it is set to Orthographic, and scale the lens so that it
includes all the bowl and ﬁlls up the camera space as much as possible.

Figure 1138
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147.2.2. Creating the Color-Map Material
Now, to be able for the Render to apply the colors on the right areas of the object. For this,
we will start by applying a material the bowl. Make this material 0.0 on the R, G, and B
spectra, and depress the shadeless button. Now, go to the textures index and add 3 textures
to the material, and set them as ”Blend” textures with ”Lin” depressed (a linear calculation).
For these 3 textures, name them something to do with either ”Red”/”Green”/”Blue” or
”X”/”Y”/”Z” in that order, because doing this will ensure you keep the channels in order.
The following image will show all settings that need to be set to make the material work.

Figure 1139

Now before your Rendering you want to make the World texture to be completely black, so
this way it won't interfere when you apply it as a normal map. Now Render your image,
and hit F3 to save. It should come out to something like this.
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Figure 1140

As a ﬁnal note in this subsection, what I suggest doing is deleting the bowl and saving
the ﬁle as something like ”BlenderForNormals.blend” so if you ever want to make another
normal, the area and materials are already set up and all you need to do is import or create
the object. Just a suggestion.

147.2.3. Applying as a Normal Map
Well we got the image, now let's apply it and make it come out as a low poly-count texture.
So, let's continue by deleting the high poly bowl and instead add a plane in the middle of the
camera. Now, apply a material to the object and make the material hard, soft, rocky, wet,
or however you want it to look. After you've made the plane how you want, add a texture
to the material, and make it an image texture. Load the image as the texture, depress the
normal map button, and set the normal spacing to object. Now, on the materials index
under the Map To tab, make sure the Col button is relieved and instead depress the Nor
button. Just add a lamp above the plane, and Render! You should now have the same
shading eﬀect as the original bowl, with about 0.01% of the original faces--one.
If your Render comes out odd, it may be because the shading is being applied too heavily.
You can alter this by adjusting the Nor slider directly below the ”Mix” drop-down menu. O
used about 0.2 and it came out just ﬁne, like this picture.
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Figure 1141

Congratulations, that's all there is to normal mapping. It's a simple technique
with many great uses!
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148. Introduction
Blender’s Node Editor lets you assemble various processing blocks (nodes) into combinations
which feed data to one another along connections that you specify to produce complex
eﬀects. These eﬀects can be used in three diﬀerent ways: as textures, as materials, or
for compositing. The Node Editor makes diﬀerent kinds of processing blocks available,
depending on which of the three kinds of eﬀects you are producing:
• Texture nodes
• Material nodes
• Compositing nodes
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149. Texture Nodes
i Information
Applicable Blender version: 2.67
Texture nodes allow you to produce textures that are the result of complex computations.
This tutorial will just scratch the surface of what’s possible.

149.1. A Simple “Rainbow” Texture
Start with a new Blender document. Delete the default cube. Add a new plane object.
In the Material context in the Object Properties window, click the icon to the left of the
material name to assign a material to the plane (there should already be a default unused
one called “Material”). In the Texture context, there should already be a texture called “Tex”
assigned to this material. Now split the area showing the 3D view into two side-by-side
areas. In the right-hand area, bring up the Node Editor. In its area header, you should see
a group of 3 little icons next to the menu

Figure 1142

; click on the middle one for Texture Nodes. You will see appear, further along the area
header, a popup menu containing the names of the textures so far created in your document:
this should be showing the name “Tex” of the texture you assigned to the material for your
plane object. And to the right of that, there should be a checkbox titled “Use Nodes”.
Check that, and you should see a pair of initial nodes immediately appear in the editor: an
input node titled “Checker” and an output node titled “Output”, with an editable ﬁeld in it
containing “Default”.
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There must be at least one output node in the texture deﬁnition; the data fed to this
will make up the ﬁnal texture. The names you assign in the Name ﬁeld will appear in
the Texture context in the Object Properties window, in a popup menu titled “Output:”,
with one item for each output node. Initially this may show “Not Speciﬁed”: change it to
“Default”.
Note:
Navigation in the Node Editor: As in most Blender windows, you can scroll around
by dragging with MMB , and zoom the view in and out with the mouse wheel.
Each node window has little coloured circles (terminals) on its left and right edges; the
ones on the left edge (if any) are inputs for feeding data from other nodes, and the ones
on the right edge (if any) are for supplying data to other nodes. Thus, output nodes have
no outputs (they’re the ﬁnal destination for the data), while input nodes have no inputs.
Other node types represent intermediate stages in the processing, so they will have both
inputs and outputs.
Back in the Node Editor, click on the titlebar of the “Checker” node window and use either
X
or DEL to delete it. Note that, unlike deleting objects in the 3D view, there is
no conﬁrmation popup: the node immediately disappears. (Of course, you can use CTRL
+ Z to undo operations in the usual way.)
Now go to the “Add” menu (or use the usual SHIFT + A shortcut), ﬁnd the “Input”
submenu, and select the “Coordinates” item. This will add a new input node, which just
produces the unadorned texture coordinates as its data. The newly-added node will follow
the mouse around; press LMB once you have moved it to a convenient place. You will see
the new node has one output terminal, titled “Coordinates”. Left-click on this, and drag to
the input terminal in the Output window with the word “Color” and a small rectangular
colour swatch next to it. Voilà! A line (eﬀectively a wire) should appear connecting the two
terminals, and you should see the big square colour swatch in the Output window change
from black to a whole rainbow of colours. That’s your texture!
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Figure 1143

If you make a wrong connection, you can move or cut it by dragging the output end of
the wire away from the input terminal it is attached to with LMB , to either a new input
terminal or simply into an unoccupied space between nodes; when you let go the button,
the wire will attach to the new input terminal in the former case, or disappear in the latter
case.
At this point, you should be able to hit F12 to render, and you will see your plane object
with the rainbow texture applied. You can see why I chose a Plane object: being ﬂat, the
entire texture is visible from one camera angle.
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Figure 1144

149.2. Scalars Versus Vectors
The wires carry numbers between nodes. These numbers can be of two kinds: a scalar is a
single real quantity, like “0.5”, while a vector can consist of two, three or four scalars in a
sequence, like “(0.5, 0.75, 0.2, 1.0)”. The number of components in a vector is also known
as the dimension of the vector. Two-dimensional vectors can be used to represent texture
coordinates, while three-dimensional vectors can represent positions in space. Colours can
be represented with 3 dimensions (R, G,B or H, S, V) or 4 dimensions (RGB or HSV plus
alpha channel).
Some nodes operate on scalars, while others operate on vectors. And there are nodes where
some terminals input or output scalars, while others input or output vectors.
Try this. To the above Coordinates and Output nodes, add a “Separate RGBA” node (under
the “Color” submenu of the “Add” menu). Feed the output from the Coordinates node to
the “Color” input node of the Separate node. Now connect just the “Red” output terminal
from the Separate node to the output node (if you move the newly-created node on top of
the existing wire, this should happen automatically):
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Figure 1145

See how the Output swatch shows just a greyscale ramp running from black on the left
to white on the right? This shows how the ﬁrst dimension of a vector is interpreted as
the red component in an RGB colour, but as the X coordinate in a position. Remove the
output from the Red terminal (delete the existing wire), and take it from the Green terminal
instead (by dragging a new wire from Green to the Color terminal on the Output node);
now you will see the ramp going from black at the bottom to white at the top. The second
dimension of a vector is the green component in an RGB colour, and the Y coordinate in a
position.
The terminals have diﬀerent colours to remind you what type of data they should be
used for (purplish for coordinates, yellow for colours, grey for scalars), but as far as
Blender’s Node Editor is concerned, colours and positions are not actually different types. Both are vectors, and one can be interpreted as the other. This can be
(ab)used for some creative eﬀects! For example, the name of the “Separate RGBA” node
says it’s for separating an RGBA colour into its components, but here we are using it to
take apart a coordinate vector instead.
Note also in the above, that the Color terminal on the Output node expects a vector RGB
colour, but when you feed it a single colour component (i.e. a scalar), it simply replicates
it the necessary number of times to make a vector of the required dimension. Since all
components of the RGB colour are the same, you get a shade of grey.
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150. Material Nodes
i Information
Applicable Blender version: 2.4x
Material nodes look very similar to texture nodes, and indeed there is a fair amount of
overlap in functionality. Some important diﬀerences are:
• Functions for performing spatial transformations (e.g. rotation and scaling) are only
available for texture nodes.
• Functions for altering diﬀuse versus specular colours and rendering parameters, like
translucency, are only available for material nodes.

150.1. A Simple Graduated Material
First of all, let’s set up a really basic modelling scene to show oﬀ the node-based material
you’ll be creating in a moment.
Open a new Blender document, with the default cube, default light and default camera.
Create a plane object. Rotate and position that so it lies behind the cube from the camera’s
viewpoint. Scale the plane up to say, 4x, to form a decent-sized backdrop. Assign it a new
default material, and a texture with some detail to it; I used a simple Marble with default
settings, except under the “Map To” miniwindow I changed the colour to a medium grey
from the default magenta, to stop it hurting my eyes.
Now select the cube. Scale it 3x in the Z-axis; the elongated proportions should show oﬀ a
gradation more nicely. In the “Material” miniwindow, set the “Col” (diﬀuse) colour to white,
and the alpha to zero. In the “Mirror Trans” miniwindow, turn on “Ray Transp” and set the
“IOR” to some suitable refractive index, say 1.5 for glass.
Hit F12 to do an initial render, just to conﬁrm you’ve got everything nicely arranged.
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Figure 1146

With the cube still selected, open the Node Editor. By default, the Material Nodes mode
should already be selected, and the combo box should be showing the name of the material
you assigned to the cube; select it if it’s not. Click the “Use Nodes” button, and immediately
two node windows should appear, a Material one and Output one.
Click on the title of the Material node window, and use XKEY or DEL to get rid of it.
Go to the “Add” menu, “Input” submenu, and add a new “Geometry” node. Also add a
new “Extended Material” node. And from the “Convertor” submenu, a new “Separate RGB”
node. In the middle of the Extended Material node window, there is a popup menu showing
you the names of the materials in your document; select name of the material you previously
assigned to the cube again.
Make sure there are no wires running between any of the nodes; now run one from the
“Color” output terminal on the Material node to the “Color” input on the Output node, and
one from the “Alpha” output on the former to the “Alpha” input on the latter.
Notice that, next to each of the input terminals in the Material window, there is either a
ﬁeld for entering a scalar value (grey terminals), or a button which pops up a little set of
controls for letting you specify X, Y and Z components for a vector (blue terminals), or a
colour swatch which pops up to let you pick a new colour (yellow terminals). This way, you
don’t have to make connections to all the inputs, or indeed any of them; any unconnected
inputs will be set to the constant value that you specify.
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Anyway. connect a wire from the “Global” output of the Geometry node to the “Image”
input of the Separate RGB node. “But geometry isn’t a colour!?” I hear you cry. But as
explained on Texture Nodes1 , a vector is a vector. Feeding in a position instead of a colour
to Separate RGB means its outputs are not the R, G and B components of the colour, but
the X, Y and Z components of the position. So run another wire from the B (i.e. Z) output
of Separate RGB to the Alpha input of the Extended Material window. The resulting layout
should look like this:

Figure 1147

1

Chapter 149 on page 1313
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Now you’re ready to render. But before hitting F12, hit JKEY to switch render buﬀers.
That way you still have the previous render to compare with. Once the render window
comes up, you can hit JKEY to alternate between the two renders.
Here’s what my node example looked like (note I turned the energy of the lamp down to
0.5, otherwise it seemed too bright):

Figure 1148

Notice the gradation of transparency along the Z-axis, from fully transparent at the bottom
to fully opaque at the top.
For added fun, try taking the material Alpha setting from the R or G outputs of the Separate
RGB node instead, just to see the gradation orient along the X or Y axes.
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151. Compositing
i Information
Applicable Blender version: 2.67
Compositing is the combination of multiple sources of visual input into a single, ﬁnal
image. This is common functionality in expensive, commercial video editors. Some of these
(such as Adobe After Eﬀects) use a layer-based compositing engine. Others (such as Apple
Shake, The Foundry's Nuke, and eyeon fusion) use a more powerful node-based compositing
engine. Blender features a very advanced and powerful compositing engine through the use
of the Nodes Editor window. Although the challenge of learning to use nodes may seem
intimidating, it can be very rewarding because of the professional-looking ﬁnal products
that can be easily produced.

151.1. Compositing Example
In this tutorial, we will see how compositing, combined with render layers, can produce
some eﬀects that are diﬃcult or impossible to achieve just by straight rendering of a 3D
model.
Start with a new Blender document. For a change, let’s use the default cube. Assign it a
new material. Keep all the settings at default, but in the Shading panel, set the Emit value
to 1.0 and give it an interesting diﬀuse colour.
Go to the Render context
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Figure 1149

, look for the Post Processing panel, and check the “Edge” box. This will draw a black
outline around all objects. If you hit F12 to render right now, you should see something
like this:
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Figure 1150

So far, not very exciting. Now go to the Render Layers context
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Figure 1151

. You should see there is already an initial default layer called “RenderLayer”. If you look in
its Layer panel, you should see checkboxes indicating all the passes of the rendering process
to include in this layer. Look for the “Edge” checkbox, and uncheck that. Now click the
+ icon next to the list of layers, to add a new layer. Look in its Layer panel, make sure
“Edge” is checked, and uncheck all the other checkboxes in the “Include:” section.
Now open up a Node Editor window, and look for the three icons to the right of the menus,
showing what kind of nodes to edit:
; click on the middle one (if it’s not
already selected) to enable compositing nodes. Now check the “Use Nodes” box to the right
of it. You should now see the initial default node setup, with a single Render Layers node
feeding the initial default render layer directly to the output:
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Figure 1153

Add another Render Layers node. From its layer popup menu, select the second render layer
you created, the one producing the edge outlines (which should be called “RenderLayer.001”
if you didn’t change its name).
Now, add a Blur node (Filter submenu of the Add menu). The default Gaussian kind of
blur will do ﬁne. Put nonzero values (e.g. 1) into the X and Y ﬁelds (otherwise the blur
Size value will have no eﬀect). Give it a Size value of, say, 20. Connect the Image output
of the ﬁrst render layer (the one doing everything except the edge outlines) into its Image
input.
Add an Alpha Over node (from the Color submenu of the Add menu). Feed the Image
output from the Blur node into its upper image input, and the Image output from the
second render layer (the one producing the outline edges) into its lower image input. Leave
the Factor at its default 1.0. Connect the Image output of this Alpha Over node to the
Image input of the Composite node (the ﬁnal output).
When you are done, check that your connections look like this (remember, the exact positions of the nodes are unimportant, except for clarity; what’s important is the connections
between them):
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Figure 1154

The eﬀect of this is to blur the rendering of the cube (apart from the edge outline), and
then put the edge outline back on top of it. If you hit F12 to render now, you should see
something like this:

1328

Things to Try

Figure 1155

151.2. Things to Try
What happens if you put diﬀerent values into the X and Y ﬁelds of the Blur node? Try
making the X value diﬀerent from the Y value.
What happens if you get the inputs the wrong way round into the Alpha Over node?
Try the other blur types available from the menu in the Blur node.
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151.3. Other Tutorials
Composite Nodes
AAnxoJsdAAM

Video

Tutorial

(2.49b):

http://www.youtube.com/watch?v=

Vector Blur Tutorial (2.49b): http://www.youtube.com/watch?v=qY4WcNgEXv8
Depth of Field (DOF) Using Composite Nodes (2.49b): http://www.youtube.com/watch?
v=HBomEv-bEtw
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152. Further Compositing: A Portal
Eﬀect
i Information
Applicable Blender version: 2.70
You may be familiar with the time-travelling machine known as the TARDIS1 , which is
much bigger inside than it appears from the outside. Alternatively, you may have come
across the concept of a portal2 in science ﬁction, which lets you instantaneously move from
one space/time location to another, just by taking a step.
In this tutorial, we will see how to create an animation where a doorway leads from one world
into a completely diﬀerent world that clearly cannot be occupying the same space as the
original world. We will be making use of multiple scenes within a single Blender document,
as well as matte nodes3 in the compositor to combine them together. The overall workﬂow
will consist of these steps:
• Create a scene representing the “Outer” world (the world outside the doorway, which is
also the world where the observer is located.)
• Assign a specially-coloured material to the doorway in the “Outer” scene, which will be
come transparent when composited.
• Deﬁne a camera movement panning around the “Outer” world, to accentuate the portal
illusion.
• Create a scene representing the “Inner” world, which is visible through the doorway.
• Copy the exact same camera movement from the “Outer” world to the “Inner” one, so the
view through the door remains consistent with what is seen on both sides. (This is why
it is best to keep the two scenes in the same Blender document.)
• Render out separate animation sequences for the “Outer” and “Inner” scenes.
• Create a third scene purely for compositing purposes, bringing in the two previouslyrendered animation sequences.
• Render out the complete composited result sequence.
The actual modelling we are doing here will be very simple, not to say crude, just to illustrate
the basic principle; feel free to create your own more elaborate and more interesting scenes,
once you have mastered the basic technique!

1
2
3

https://en.wikipedia.org/wiki/TARDIS
https://en.wikipedia.org/wiki/Portals%20in%20fiction
http://wiki.blender.org/index.php/Doc:2.6/Manual/Composite_Nodes/Types/Matte
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152.1. The Outer Scene
Start with a new Blender document. Change the Scene name to “Outer”. We will use the
default cube as our portal object (why not?). Make it taller, so the front face has about
the right proportions for a doorway. Add a plane for a ﬂoor just underneath. Go back to
the portal, TAB into Edit mode, select the front face, and I nset it just a little bit, for
a door frame. Switch to face-select mode, and select just the inner face; give this a new
bright green material, and be sure to select the “Shadeless” option in the Shading panel
under Materials

Figure 1156

settings. Making it shadeless ensures that the whole doorway has a uniform colour regardless
of lighting; the exact colour doesn’t matter, so long as nothing else in the scene comes too
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close to the same colour. Green is the colour traditionally used for chroma-key4 work in
movies.

Figure 1157

Your basic scene setup should look something like this. Apart from the doorway material as
discussed above, none of the other material assignments really matter. Note the egg-shaped
object (stretched-out sphere) I added poking halfway through the doorway: this object will
also appear in the inner scene, reinforcing the idea of a doorway between worlds that you
can actually move through.

152.2. Animating The Camera
Still in the Outer scene, add an Empty object at the default 3D cursor location. Parent the
camera to this; now I nsert a LocRot keyframe for the Empty at frame 1, then go to,
say frame 51, rotate the Empty about the Z axis by -90° (so the view moves across to the
opposite side of the but still showing the doorway), and I nsert another LocRot keyframe.
While you’re at it, make the following changes in the Render

4

https://en.wikipedia.org/wiki/Chroma%20key
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Figure 1158

Context:
• Set the end frame for the animation frame range to 51.
• In the Shading panel, make sure the output format is PNG, and set the Output path to
//output frames/. Putting the rendered frames from this scene into their own directory
will avoid any mixups with the other scene renders.
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Figure 1159

If you were to render this scene animation out now, you should end up with something that
looks like at right.
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152.3. The Inner Scene

Figure 1160

In the Scene popup menu, click the “+” icon to create a second scene. Choose the option
“Link Objects”: this means the new scene will initially share exactly the same objects as
the ﬁrst scene. (Sharing the same objects, rather than making copies of them, just makes
it easier if you need to make any changes to those objects; those changes are automatically
visible in all scenes sharing the same objects.) Name the new scene “Inner”. We only want
it to share the camera (and its pivot Empty) and lighting, and that purple egg thingy that
is travelling between the worlds. So select the portal box and ﬂoor, and delete them. Create
some new objects to make up this inner world, something like at right. Note I gave the
inner world its own ﬂoor, with a contrasting colour.
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Figure 1161

Inner scene with Outer as background

Tip: In the Scene
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Figure 1162

Context, there is a “Background” ﬁeld in the Scene panel, where you can choose another
scene to overlay this one. This is what I did in the screenshot at right, just so I could make
sure those balls in the Inner world lie behind the portal door. Don’t forget to remove this
Background scene setting when you are done. Otherwise the Outer scene will show up
in the render for the Inner scene, which we don’t want!
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152.4. Inner Scene Animation

Figure 1163

When you created the Inner scene, it would have inherited the same Render
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Figure 1164

settings as for the ﬁrst scene: the same frame rate and number of frames to render. Just
make one change: in the Output panel, set the path to //inner frames/, so as to keep the
rendered frames separate from the Outer scene.
Now when you render out the animation of this scene, you should end up with something
like at right.

152.5. Compositing It All Together
Now, make a third Scene, just for the compositing. In the menu that appears when you click
“+” next to the scene name, choose “New” to create a new Scene with nothing in it. Call
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this scene “Compositing”. Leave it empty; we won’t actually be rendering any 3D content
in this scene.
Open up a Node Editor window, and change the node editor type to Compositing nodes.
Check the “Use Nodes” box; you will see the usual initial two nodes, “Render Layers” (representing the rendering of the 3D objects in the scene), and “Composite” for the ﬁnal output
from the compositor. Get rid of the Render Layers node; we won’t need it at all (and
anyway, it won’t work without a camera in this Scene).
Instead, SHIFT + A dd an Input→Movie Clip node. Click its Open button, go to the
“inner frames” subdirectory where the Inner scene has put its rendered frames, and select
A ll the PNG ﬁles you ﬁnd there to make up this movie clip. Click the “Open Clip” button
to conﬁrm and return to the Node Editor.
SHIFT + A add a second Input→Movie Clip node. Click its Open button, and this time
go the “outer frames” subdirectory where the Outer scene has put its rendered frames, and
select A ll the PNG ﬁles you ﬁnd there to make up this movie clip. Click the “Open Clip”
button to conﬁrm and return to the Node Editor.

Figure 1165

Now put together the complete node setup as at right. Note the use of a Matte→Color
Key (not Chroma Key) node to make the doorway transparent. To choose the right colour,
bring up the colour picker for the “Key Color” input terminal, and use the eye dropper to
click on the door part of the thumbnail image in the Movie Clip node for the Outer scene.
Note I had to add a Filter→Dilate/Erode node with a Distance of -1, otherwise I had a
little trace of green showing at the edge of the doorway. The computed colour-key mask
then feeds a Color→Mix node which causes the Inner scene to show through exactly where
the door is located in the Outer scene, but nowhere else! Simple, isn’t it?
Now, make one ﬁnal change to the Render
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Figure 1166

settings, setting the path in the Output panel to //composite frames/ to keep them separate
from the two input scenes.
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Figure 1167

Now when you render out the Compositing scene, you should end up with an animation
something like at right.

152.6. More On Lighting
In this example, I gave both scenes the same lighting. But in general there is no reason for
this; in fact, giving the two scenes completely diﬀerent lighting (e.g. night in one, day in
the other) would emphasize the jarring discontinuity in moving between them.
However, you might then have to deal with the issue of light spilling from one world to the
other through the doorway. This could be faked by judicious placement of additional lights.
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Further exploration of this issue is left up to the reader. ;)
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153. Advanced Rendering
i Information
Applicable Blender version: 2.67
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154. Alternative Renderers
You previously learned about the Blender Internal1 renderer. This is the old, original
renderer that was included from the earliest days of Blender. However, it is not the only
way to render scenes created with Blender.

154.1. Cycles

Figure 1168 Example Cycles render showing 1) illumination via an emissive material
(middle ball), and 2) colour bleed via indirect diﬀuse lighting (note coloured light on
ground near red and green balls). The glowing middle ball is the only light source in this
scene.
Beginning with Blender 2.61 came the new Cycles renderer. Its most important new feature
is more physically-accurate handling of lighting in the form of global illumination2 .
What this means is that Cycles automatically implements subtle indirect-lighting eﬀects,
where light can bounce oﬀ a diﬀuse surface and provide some illumination to other diﬀuse
surfaces nearby. And it doesn’t distinguish in its lighting calculations between “lamp” objects

1
2

Chapter 24 on page 189
https://en.wikipedia.org/wiki/global%20illumination
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and non-lamp objects which have “emissive” materials; in Blender Internal, the latter do
not provide any light to other objects, whereas in Cycles they do.
Cycles also oﬀers high-ﬁdelity previews in the interactive 3D view. As it continues to be
developed, it will perhaps replace the old Blender Internal renderer someday, but not all
the features are there yet for this to happen.
See also:
• Manual3 on Cycles.
• Andrew “BlenderGuru” Price’s Introduction to Cycles4 .

154.2. Freestyle
This is not a complete renderer in itself, but a new addition to the Blender Internal renderer
in version 2.67 of Blender. It adds sophisticated options for accentuating edges to produce
cartoon-like renders.
See also:
• Manual5 on Freestyle.
• Report6 by Libre Graphics World on the origins of Freestyle.

154.3. External Renderers
There are also a great number of stand-alone renderer programs, both proprietary and Free
Software, around (e.g. Aqsis7 , LuxRender8 , Octane9 , RenderMan10 , Yafaray11 ). These have
no capability to create or edit 3D models or scenes, they are designed purely to perform
rendering on already-created models and scenes. Several of them—particularly the Free
Software ones—are supported by addons to allow them to work with Blender almost as
conveniently as its built-in renderers.

3
4
5
6
7
8
9
10
11
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http://wiki.blender.org/index.php/Doc:2.6/Manual/Render/Cycles
https://www.youtube.com/watch?v=UTwXG3K4l2g
http://wiki.blender.org/index.php/Doc:2.6/Manual/Render/Freestyle
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155. Disadvantages of Other Renderers
Of course, there can be a downside or two to choosing a renderer other than good old
Blender Internal.

155.1. Say Goodbye to Your Materials and Lighting
One important thing to note when constructing models is that materials and lighting
are renderer-speciﬁc. If you have painstakingly set up transparent materials and bump
maps and all the rest of it, then decide to switch renderers, you will have to do that work
all over again. And you may ﬁnd that there is no exact one-to-one correspondence between
particular features of Blender Internal materials and lights and those supported by the
alternative renderer, so you will have to ﬁnd approximate workarounds.
Of course, the actual geometry of your models remains unaﬀected.

155.2. High-Quality Renderers Are S-L-O-W
If you are accustomed to hitting F12 and seeing an image appear after just a few seconds
with Blender Internal, using one of these other renderers will likely come as a shock. To
get a good-quality render can easily take 10-100 times as long as with Blender Internal.
You can speed things up by choosing lower-quality settings, but then the results tend to be
ﬁlled with noise and not ﬁt for much more than preview purposes.
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156. Introduction to Cycles
i Information
Applicable Blender version: 2.67
Cycles is a renderer which ﬁrst appeared in Blender 2.61. It oﬀers more physically-accurate
handling of lighting, based on a completely diﬀerent handling of materials from the old
Blender Internal renderer.
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156.1. A Simple Cycles Example

Figure 1169

Start with a new Blender document. From the renderer menu
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Figure 1170

at the top of the screen, select “Cycles Render”. Select the default cube. Go to the Material
Context
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Figure 1171

in the Properties
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Figure 1172

Window, and you should see something like at right.
What happened to diﬀuse/specular shader settings, transparency, mirror, etc?
All that is gone. Instead, Cycles deﬁnes its materials in terms of something called a
BSDF1 , or Bidirectional Scattering Distribution Function. When light hits the surface
of an object, it can be reﬂected, absorbed or transmitted (through the material, giving rise
to transparency or translucency), or more typically a combination of all three. Ignoring
absorption (which means the light is lost anyway), the way the light is reﬂected can be

1

https://en.wikipedia.org/wiki/BSDF
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represented mathematically as a BRDF2 , and the way it is transmitted as a BTDF3 ; Cycles
uniﬁes the two into the general concept of a BSDF.
If you look in the window at right, you will see little in the way of actual material settings
except for the choice of a “Diﬀuse Color” for the material, and above it a “Use Nodes” button.
There is a little bit more in the “Settings” panel below (including what colour to use to show
the object in the 3D viewport), but we will ignore that for now.
By default, the material is assigned a simple diﬀuse BSDF (non-shiny surface), and the only
parameter exposed for you to play with is the diﬀuse colour. To get access to more, you
will need to click the “Use Nodes” button. But don’t do that yet.
Instead, delete the default lamp. We are going to light our scene entirely with an emissive
material. Why? Because, with Cycles, we can. In real life, we can usually see the sources of
light in our scene, they are not invisible the way the Blender Internal renderer treats them.

2
3
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Figure 1173

Add a new UV sphere object, and position it above the cube. Go to the Materials Context,
and assign it a new material. You should see a few more settings appear this time, as at
right (if you see the “Use Nodes” button as before, then click it).
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Figure 1174

Go to the menu next to the label “Surface:”. Clicking on this will show you (in the left
column) the list of available BSDFs:
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Figure 1175

Select “Emission”. The “Surface” panel should now look like this:
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Figure 1176

Crude render with Blender Cycles

If you hit F12 to render at this point, you will probably end up with something like this.
This shows the emissive sphere shedding light on the diﬀuse cube, which shows Cycles in
action, but is otherwise not very interesting. Also note the noise, particularly on the upper
surface of the cube.
Let’s see if we can spice it up a bit.
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Figure 1177

Slightly better, but still crude, render with Blender Cycles

Add a plane below the cube, and scale it out a bit to look more like a ﬂoor. You can give
it the same material as the cube. While we’re at it, go back to the glowing sphere and
increase the Strength of the emission material to 10.
Now if you render, you should see something like this:
OK, so that’s slightly more interesting (if you look carefully, you can see the lower part of
the cube pick up some light bouncing oﬀ the ﬂoor), but that noise is even more terrible
than ever. Can we do something about that?
Yes we can.

1361

Introduction to Cycles

Figure 1178

Go to the Render Context
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Figure 1179

in the Properties window. Look for the Sampling panel (this is speciﬁc to the Cycles
renderer, you won’t have seen it while doing renders with Blender Internal). See the two
numbers in the column headed “Samples:”, in particular the one labelled “Render:”. Change
the number from the default 10 to 100.
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Figure 1180

Getting better, crude render with Blender Cycles

Now if you hit F12 , you should see something like at right: the noise is noticeably less.
However: note the increase in render time. On my quad-core Core i7 machine, the previous
image renderered in less than a second at 1500×2000 resolution, while this one took closer
to 6 seconds—almost exactly a factor of 10.
You can crank up the number of render samples some more, and get an even better-quality
result, but it will take even longer. This is the tradeoﬀ with all high-quality renderers, not
just Blender Cycles: you can get better results, but at the price of longer render times.
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156.2. Real-Time Rendering Previews

Figure 1181

Cycles has another little trick up its sleeve. In the 3D view
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Figure 1182

window, look for the shading menu, where you can choose solid/wireframe/textured etc
previews.
Notice anything diﬀerent? With Cycles enabled, there are extra “Material” and “Rendered”
items in this menu. Try selecting “Rendered”, and suddenly you will be seeing a full Cycles
render happening in the 3D view! Try rotating the view, zooming and out etc, and watch the
render being redone every time: initially it starts out very blocky and noisy, then gradually
reﬁnes itself if you don’t touch anything.
Remember the two render samples values we encountered above? Now you know what
the lower “Preview” one is for: it controls the quality of rendering done in preview mode.
You can also set this value to 0, which means “inﬁnite”: rendering becomes a never-ending
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process, where the quality of the image gets better and better, the longer you leave it. Of
course, you can interrupt it at any time, just by doing something to the view.
Of course, all the usual object/edit-mode functions etc remain available, but they’re a bit
hard to use, because there is no selection feedback in this view.

156.3. Nodes? What Nodes?
This example has been a very simplistic use of Cycles materials. Much more sophisticated
uses are possible, by combining various BSDFs and putting them through all kinds of
processing. But that requires delving into the Node Editor.

156.4. See Also
• Reducing noise with Cycles renders4 in the Blender wiki.
• Video tutorial5 by Peter Drakulitch showing how to use a despeckle ﬁlter to reduce
“ﬁreﬂies” (anomalous bright dots) in Cycles.
• Andrew Price’s 4 easy ways6 to speed up Cycles.
• Thomas Dinges7 at BConf 2013 explaining various Cycles options and likely future development directions.

4
5
6
7

http://wiki.blender.org/index.php/Doc:2.6/Manual/Render/Cycles/Reducing_Noise
http://www.youtube.com/watch?v=DSP9EMUGs5g
http://www.blenderguru.com/4-easy-ways-to-speed-up-cycles/
http://www.youtube.com/watch?v=ENy9TAskxt8
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157. A Glass Material in Cycles
i Information
Applicable Blender version: 2.68
This tutorial will redo the previous Ray Tracing1 lesson, this time using Cycles rendering.
Start with a copy of the same document you created last time; we will keep the same
geometry, but redo all the materials, and then you can compare the ﬁnal results to see how
the diﬀerent renderers perform.
Open the ray-tracing document. Switch the renderer

1

Chapter 78 on page 755
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Figure 1183

to Cycles. We previously deﬁned two materials: the world background with the “magic”
texture, and the glass for the cubes. So we will need to redo these.
For all but the most basic plain diﬀuse materials, Cycles requires you to use the Node
Editor. You should have done the prior introduction2 to this; please review that, if not.
Cycles material nodes are not the same as Blender Internal material nodes3 ; but the basic
mechanics of node editing are the same.

2
3

Chapter 148 on page 1311
Chapter 150 on page 1319
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157.1. The Magic Sky

Figure 1184

Let’s try ﬁxing the background material ﬁrst. Go to the World

1371
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Figure 1185

context in the Properties
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Figure 1186

window. It should look something like at right. What happened to all the world settings?
Nearly all of them have disappeared!
But see that big “Use Nodes” button? It’s big so that you will ﬁnd it hard to miss. Click it.
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Figure 1187

OK! Now there are a few more settings, but still not much. For all the fun stuﬀ, we must
go into the Node Editor.
You probably have a Timeline
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Figure 1188

window across the bottom of your Blender screen layout. Change the window type to Node
Editor
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Figure 1189

, and increase its height. (Or add a new window if you don’t already have one, and make
it a Node Editor.) In its header, next to the menu titles, you should see a group of 3 icons
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Figure 1190

indicating what type of nodes you want to edit: if you hover over them, from left to right, you
should see tooltips identifying them as respectively “shader nodes” (i.e. Cycles materials),
“compositing nodes” and “texture nodes”. It is the “shader nodes” we want.
Note:
Cycles doesn’t use the Texture Node Editor. It may be confusing to see this
mode of the Node Editor still available with Cycles chosen as the renderer, but don’t
bother using it. All setup of textures in Cycles is done within the Shader/Material Node
Editor.
With shader nodes selected, you will see another pair of icons

Figure 1191

appear immediately to the right of these three: these indicate whether to edit shader nodes
for a selected Object, or for the World. It is the World that we want.
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Figure 1192

Soon as you select the World shader, the following should appear in the Node Editor window.
Note the special “Background” and “World Output” nodes: you must have these in the World
shader, but note that “Color” input terminal on the Background node? That’s just itching
to have something plugged into it.
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Figure 1193

upright

Bring up the menu to add a node, with SHIFT + A . Look for the Texture submenu,
which should look like at right. Select the “Magic Texture” item.
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Figure 1194

This will add a new node representing the texture; connect its “Color” output to the “Color”
input on the Background node, like at right.

Figure 1195

Now if you hit F12 to render, you should see your new magic World background.

157.2. Here Comes The Glass
Make sure the cubes are selected in the 3D view. Go to the Materials
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Figure 1196

context in the Properties window. As before, you will see very few settings, and a big “Use
Nodes” button. Click it.
In the Node Editor, remember there are two icons for selecting what type of shader/material
nodes to edit, the Object one and the World one? Click the Object one this time.
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Figure 1197

As before, you will see an initial default node setup, like at right.
This time, there is only one node that needs to be present for the node setup to work
correctly, and that is the Material Output node. Click with RMB on the node titled
“Diﬀuse BSDF”, and press DEL to get rid of it.
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Figure 1198

upright

Now bring up the Add SHIFT + A menu, and this time look for the Shader submenu.
We will need three items from here, so add them one at a time:
• A Glossy BSDF to give the shiny surface (note the default Roughness setting in this node
is 0.2, set it to zero)
• A Refraction BSDF to give the eﬀect of light refracting through the transparent material,
and
• A Mix Shader to combine the two.
Ah, but how do we combine the two? Remember the Fresnel factor we talked about in
the Blender Internal tutorial? Well, in Cycles, there’s a node for that!
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Figure 1199

upright

In the Add SHIFT + A menu, bring up the Input submenu. In there, you will see a
Fresnel node type. Add one of these. You will see it starts with a default IOR (Index of
Refraction) value of 1.45, which is about right for glass.

1384

Here Comes The Glass

Figure 1200

Finally, connect together your little collection of nodes like this. See how the Fresnel factor
controls the mixing proportion of the Glossy and Refraction shaders? A larger input factor
to the Mix shader means a higher proportion of its second (lower) shader input, while a
smaller factor gives a higher proportion of its ﬁrst (upper) shader input. The higher output
Fresnel factor corresponds to the regions closer to the edges of the object, where you want
more reﬂection, while the lower value corresponds to the interior regions, where you want
more transparency.
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Figure 1201

And ﬁnally ﬁnally, hit F12 to see what the result looks like.
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Note:
Does it look grainy, and not as clear as this? Increase the number of samples in the
Sampling panel in the Render

Figure 1202
context, as you learned to do in the previous tutoriala . The picture here was done with
500 samples.
a

Chapter 156 on page 1351

.
Note:
Why not just use the Glass BSDF? You might have seen this in the Add Shader
menu, above. However, this doesn’t seem to produce the right eﬀect: it seems little different to the Refraction BSDF, without providing much in the way of glossy reﬂections.
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157.3. Adjustable Refraction
You may have noticed that the above collection of nodes includes two diﬀerent ﬁelds labelled
“IOR”: the one on the Fresnel node, and the one on the Refraction BSDF. The former
governs the transition between transparency and reﬂectivity, while the latter governs the
actual refraction through the material. In the real world, the two would always be the same,
since they are the same physical quantity.
With the right IOR4 , this same node setup can be used to represent other transparent
materials. Instead of having to set the value in two places, why not just set it in one?

Figure 1203

To do this, add SHIFT + A another node, from the Input submenu, of type Value. This
will feed a ﬁxed value that you specify into any number of output terminals. Connect its
Value output to the two IOR inputs, on the Fresnel and Refraction BSDF nodes. Here I
have set its value to 1.45, which is a suitable value for glass.

157.4. A Reusable Custom Shader
What if you wanted to have multiple transparent materials in a document? Would you need
to go through all the above setup every single time?

4
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Naturally you wouldn’t. Instead, you can deﬁne a custom node group, and insert that into
a Node Editor setup wherever you want, as many times as you want.
Start with the node setup as in the previous screen shot. Select RMB the Value node
supplying the IOR value, and DEL ete it. Now look at the remaining four nodes, the
Fresnel input and the three shader nodes (apart from the material output)? Select these,
and only these, in any of the usual ways: press A once or twice to deselect everything,
then RMB on the ﬁrst node and SHIFT + RMB on the rest, or drag a B ox selection
around the desired nodes.

Figure 1204

Now, with these nodes selected, select “Make Group” from the “Node” menu, or use the
keyboard shortcut CTRL + G . Also press N to bring up the Properties shelf at the
right side of the Node Editor window. The result should look like at right. Notice a couple
of things:
• The greenish background indicates you are editing a node group, not the entire node
setup
• The blocks with yellow headers, labelled “Group Input” and “Group Output”: these deﬁne
the input and output terminals for the entire node group: inputs to the group appear as
outputs on the Group Input block, and outputs from the group appear as inputs to the
Group Output block. Any terminals within the group not connected to these will not be
visible outside the group.
You can press TAB to switch out of editing the node group and back into editing the entire
node setup, where you will see your group appear as a single block entitled “NodeGroup”.
Try this if you want to have a look, then press TAB to get back into editing the group
again, because we haven’t ﬁnished setting it up yet.

1389

A Glass Material in Cycles

Figure 1205

First of all, we need an input to specify the IOR value. Click on the IOR input terminal
on the Fresnel node, and drag to the right edge of the Group Input node. Blender should
automatically create an output terminal named “IOR” on the Group Input node, with a
wire running to the Fresnel IOR input.

Figure 1206
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Now click on this Group Input IOR terminal, and drag another wire to the IOR input on
the Refraction BSDF node.

Figure 1207

Glass often has a colour. This colour aﬀects light passing through the material, while glossy
reﬂections remain uncoloured.
To create a colour input terminal for our node group, just drag from the “Color” input
terminal on the Refraction BSDF node to the right edge of the Group Input node; as
before, Blender will automatically add a new Group Input terminal and connection.
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Figure 1208

Now press TAB to ﬁnish editing your custom node group. This will take you back
to the overall node setup, with your custom node still selected. Its name will be shown
in the Properties panel in the Properties shelf at the right; change this from the default
“NodeGroup” to something more meaningful, like “Custom Glass”.
And now you can add back the input Value node you deleted, to supply a value to the
IOR terminal. And similarly you can add an RGB node to feed into the glass colour. Or,
since each value only needs to feed one input terminal, you can type them directly into the
unconnected inputs on your Custom Glass node.
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Figure 1209

And furthermore, your custom node is now present in the Add Group menu, ready for you
to insert somewhere else, in this or another node setup.
Note that the node deﬁnition itself is not duplicated when you insert another instance of
your custom node. Each instance operates on its own separate input values and produces
its own corresponding separate output values, but any changes you may subsequently make
to the internal deﬁnition of the node group will automatically take eﬀect everywhere you’ve
already used it.
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158. Dealing with Fireﬂes in Cycles
i Information
Applicable Blender version: 2.68

Figure 1210
closely.)

See the little white dots? (Click to view the full-size image, and look
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Figure 1211

Fireﬂies gone.

Cycles is a wonderful renderer, capable of some exquisite lighting eﬀects. However, sooner or
later, you will encounter the problem of ﬁreﬂies, which are isolated bright pixels scattered
over various parts of the image. Unlike simple noise (which can be reduced by increasing
the number of render samples, or alternatively by simple ﬁltering), ﬁreﬂies are caused by
numerical instabilities in the rendering computation, because after all computers can only
calculate the formulas to a ﬁnite precision. They seem an inevitable consequence of trying
to use realistic physics formulas to create our renders.
But are they so inevitable? In fact there are various tricks and tweaks we can use to keep
them out of our renders. There are pros and cons to each technique (in terms of the amount
of work involved and unwanted side-eﬀects), so it is up to you to decide which to use and
when.
Fireﬂies tend not to aﬄict the simplest renders. This means that it takes work to come up
with a tutorial example suﬃciently complex to exhibit them. If you already have one of
your own renders which is being plagued with ﬁreﬂies, and you came here hoping to ﬁnd a
ﬁx, then great—you can skip ahead to the part with the ﬁxes. Otherwise, please have some
patience while we construct an example.

158.1. Making An Example
This example arose out of a real model I was trying to construct: a house with louvred1
windows made out of frosted glass. Some interaction involving light coming in through
the panes of one window, bouncing around the diﬀuse walls of the room and out another
1

1396

https://en.wikipedia.org/wiki/Louver

Making An Example
window, together with the combination of shaders making up the glass material, led to the
appearance of the ﬁreﬂies. This example will cut the situation to the bare minimum I could
come up with to exhibit the problem, namely a pair of adjoining rooms with two windows.

Figure 1212

Loop cut to demarcate rooms (view from underside)

Start a new Blender document. Switch the renderer to Cycles. Select the default cube, and
TAB into Edit mode. Scale the cube out horizontally a bit so the room is not so narrow
and tall. Switch to face-select mode. Select the bottom face and DEL ete it. I found that
the room needed a ceiling to show the ﬁreﬂies, but not a ﬂoor, so why not get rid of it?
Give your cube a Solidify modiﬁer, so the walls have a nonzero thickness. The exact
thickness doesn’t matter.
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Figure 1213

Wall ﬁlled in between rooms.

Next, make a single loop cut CTRL + R around the sides of the shape to deﬁne the
boundary between the front and rear rooms. Then press F , and the vertices of the new
loop should be joined to form a new face which is the wall between the rooms.
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Figure 1214

Windows and doorway cut into walls.

Now we need to make holes for the windows, and for a doorway between the rooms. Still
in face-select mode, select the front face (the one you see in NUM1 view), and I nset
it a little way. If you inset it too far, you may ﬁnd the height gets too small, so after the
initial insetting, select just the middle face and scale it horizontally S + X to make a
reasonable-looking window.
Do the same with the wall on the right side of the front room, and also on the wall between
the rooms. A real doorway would extend to the ﬂoor, but our simple hole in the wall is
suﬃcient for this exercise.

158.1.1. Add The Windows

Figure 1215

Front window with louvres.

Add a new horizontal plane. Shrink it along the Y-axis to 20% of its length along the X-axis.
Add a couple of array modiﬁers: one along the Z-axis with a constant oﬀset of something
like 0.2 and a count of about a half a dozen, and another along the X-axis with a constant
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oﬀset around 2.2 and a count of 4. Position your resulting array of louvres within the hole
for the front window.

Figure 1216

Recipe for ﬁreﬂies

Before going any further, we mustn’t forget to make the windows out of frosted glass. Assign
a new material to your window object. Bring up the Node Editor, and set up a material
for the window glass as at right. Set the roughness on the Glossy BSDF to zero, but note
the small, but nonzero Roughness setting on the Refraction BSDF: I deliberately tuned this
to maximize the production of ﬁreﬂies. A zero setting will make them go away, but that
defeats the point of this exercise, doesn’t it?
(The room walls can be left at the default diﬀuse material assigned by Blender.)
After setting up your window material, duplicate your louvres object and rotate and position
the copy within the hole for the side window. Leave the hole between the rooms empty (it
is supposed to be a doorway, after all).

158.1.2. Completing The Recipe
As the ﬁnal part of our recipe for ﬁreﬂies, change the type of the Lamp object to Sun, and
change its angle to close to horizontal so it will shine in through the side window. Give it
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a strength of 3. Position the camera to look directly into the front window. Also increase
the number of render samples to 100; that should be suﬃcient to keep down the noise.
So, in summary, we have sunlight coming in low through louvres in a side window in the
front room, bouncing around between front and back rooms, and exiting through louvres
in the front window, the louvres all being made of lightly-frosted glass.

Figure 1217

Fireﬂies! (Click to examine more closely.)

If all goes well, hitting F12 to render should produce an image like at right.
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158.2. Fixing The Problem 1: Renderer Tweaks

Figure 1218

Relevant renderer settings

OK, now that we can create the problem, how do we solve it?
Probably the ﬁrst things to try are one or two renderer settings. Look for the Sampling
and Light Paths panels in the Render
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Figure 1219

context, as at right. In the Sampling panel, look for the “Clamp” ﬁeld. If nonzero, this
imposes a maximum value on the light-intensity calculations at each pixel. Normally 1.0
corresponds to full white, but some points can be brighter than this. Try changing the
default 0 value to, say, 3, and rerender.
In our simple example, this should be enough to ﬁx the ﬁreﬂies. However, I have come across
a case or two where this reduced the intensity of some bright indirect lighting, leading to a
more subdued appearance for the overall render.
So let’s try the next thing. Set the Clamp back to 0, and this time look in the Light Paths
panel, for the “No Caustics” checkbox. Caustics2 can be an important part of realistic
lighting eﬀects, but if your scene doesn’t need them, disabling them can help get rid of
2

https://en.wikipedia.org/wiki/Caustic_%2528optics%2529
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ﬁreﬂies, and perhaps speed up the render as well. However, the tooltip for this checkbox
warns that the result can be a darker image.
In our simple case, checking this box does work.
The third renderer setting to try is the ﬁeld just below the No Caustics checkbox, labelled
“Filter Glossy”. This applies deliberate blurring to certain kinds of light bounces, sacriﬁcing
a bit of lighting accuracy for the sake of avoiding ﬁreﬂies. And again, in our case, this
option works: setting it to a value of, say, 1, does indeed ﬁx the ﬁreﬂies.
But, at some point, you may ﬁnd that none of these three techniques will work for you:
they may make no diﬀerence to the render, or may cause unacceptable loss of quality in
places. After all, being settings that apply to the render as a whole, they can be something
of a blunt instrument.
So for our next ﬁx, we will need to resort to the compositor.

158.3. Fixing The Problem 2: The Despeckle Filter
The approach to ﬁxing the ﬁreﬂies problem is to apply some kind of processing to the
rendered image. If you are familiar with image-editing programs like Gimp or Photoshop,
you will have come across the despeckle ﬁlter, whose job is precisely to smooth out random
dots that don’t ﬁt in with the rest of the image. In principle you could use an imageediting program to touch up your renders (and some people producing professional-quality
renders do), but what happens if you are rendering an animation? Imagine having to ﬁx
up hundreds or thousands of frames by hand!
Blender, too, has a bunch of image-processing operations available in its compositor, including a Despeckle ﬁlter. And the nice thing is, these operations can be applied automatically
after rendering each frame.
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Figure 1220

Open up a Node Editor
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Figure 1221

window in your Blender document (you can reuse the Timeline
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Figure 1222

window at the bottom of the default window layout, just make it a bit taller). Look for the
icons
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Figure 1223

indicating what type of nodes to edit: click on the one showing little layers or sheets,
representing the compositor (in the middle in Blender 2.68, on the left in earler Blender
versions). Immediately you should see a “Use Nodes” checkbox appear to the right of these
icons: check that to enable node-based compositing. You should get a default node setup
like at right.

Figure 1224

Move the two existing nodes a bit further apart, to make way for a new one in-between.
Press SHIFT + A to bring up the Add menu, and look in the “Filter” submenu for the
“Despeckle” entry. Move the new Despeckle node into the gap you previously cleared, and
if you position it right, it should automatically connect itself into the chain like this.
To see the eﬀect of your changes, switch the 3D view window to an Image Editor
window. Make sure the image being shown is the “Render Result”. Next to the menu for
selecting the image slot (which should be showing “Slot 1”), there is a menu for selecting
which layer of the image to show:
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Figure 1225

. “RenderLayer” is the raw output from the renderer, while “Composite” is the result after
going through the compositor. By switching between these two, you should see that the
default Despeckle ﬁlter settings have removed some of the ﬁreﬂies, but not all. I found if I
reduced the “Threshold” ﬁlter parameter from its default 0.5 to something like 0.1, then all
the ﬁreﬂies did indeed disappear.

158.3.1. What The Despeckle Filter Does
The despeckle ﬁlter is designed speciﬁcally to get rid of isolated anomalous pixels. This
is unlike blur ﬁlters, which average a bunch of pixels together, and can spread the ﬁreﬂy
across a larger area instead of removing it.

But what do those “Threshold” and “Neighbor” parameters actually mean?
The
following explanation was put together from studying the Blender source code, mainly
https://developer.blender.org/diﬀusion/B/browse/master/source/blender/compositor/operations/COM_Des
The target pixel being processed is compared with its eight neighbours. However, these
neighbours are not treated equally: each one is given a weight that governs its relative
importance to the computation. The horizontal and vertical neighbours√each have a weight
of 1, while the diagonal neighbours are each given a lower weight of 12 (approximately
0.7). This reﬂects the fact that they are slightly further away along the diagonals, therefore
they have correspondingly less inﬂuence on the outcome.
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For each neighbour pixel, the “Threshold” input parameter is compared against the diﬀerence between each of the neighbour’s R, G and B components (normalized to 0 being black
and 1 being maximum intensity) and those of the target pixel; if any of the corresponding
pairs of components have a diﬀerence exceeding the threshold, then the neighbour pixel
value is accumulated onto an average (weighted by neighbour weights) that the code calls
color_mid_ok—the presumed “correct” value of the target pixel, if you like. All neighbour pixels, whether within or outside the threshold, are accumulated onto another (also
weighted) average called color_mid. The value w is the total weight of all neighbours that
contributed to color_mid_ok.
Then
the value of w is divided by the total weights of all neighbouring pixels (4 × 1 + 4 ×
√
1
2 ),

to produce a fraction in the range [0.0 .. 1.0], and the resulting fraction compared to
the “Neighbor” input parameter. Also the diﬀerence between the components of color_mid
(the average of all the neighbours) and those of the original target pixel are compared to
the “Threshold”. If either comparison returns less than or equal, then the pixel is considered
not to need correction. But if both comparisons are greater, then the target pixel is adjusted
from its initial value towards the color_mid_ok average, according to the “Fac” input socket
value. If “Fac” is 1.0 (the default), then the pixel is completely replaced with color_mid_ok;
otherwise it becomes the corresponding blend of this and its original value.
“Fac” can be used to ﬁne-tune the eﬀect of the Despeckle. For example, if this was fed from
an inverted edge-detection (“Kirsch”) ﬁlter, then it can be used to reduce the eﬀect along
sharp edges, which are otherwise likely to confuse the ﬁlter.
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159. Fireﬂes in Cycles, Continued
i Information
Applicable Blender version: 2.68
You previously read1 about techniques for controlling ﬁreﬂies in renders done with Blender
Cycles, and how, when all else fails and tweaking renderer parameters doesn’t help, it is
time to roll out the Despeckle ﬁlter. Sometimes a despeckle applied across the entire image
may be too blunt, leading to unwanted eﬀects in parts of the image where there are no
ﬁreﬂies.
But never fear. There are yet more options in Blender’s compositor that we have yet to
explore, to give us even ﬁner control over the application of despeckling, and hopefully avoid
the ﬁnal, desperate measure of hand-retouching (shock! horror!) individual blemishes in an
image-editing program.
The basic principle is, ﬁreﬂies are caused by speciﬁc interactions of types of materials and
lighting, hence they will only occur in particular parts of the image. By separating out
the problematic materials/lighting cases, we can selectively apply the ﬁlter just to them,
minimizing side-eﬀects on parts of the image that look just ﬁne.
We will present a way to do the separation.

159.1. Finer Despeckling: Separate Lighting Passes
159.1.1. Separating The Lighting Passes
The Cycles renderer has the capability to separate out diﬀerent kinds of light paths into
separate passes for individual processing. Consider the diagram on the Blender wiki2 , showing how the direct lighting, indirect lighting and colour calculations are broken down by
diﬀuse, glossy and transmission light paths, before being combined together with emission
and environment lighting. We can split out all these passes, and use compositor nodes to
recreate the standard combination as described there. But we can also intersperse our own
processing onto particular passes, leaving the others untouched.

1
2

Chapter 158 on page 1395
http://wiki.blender.org/index.php/Doc:2.6/Manual/Render/Cycles/Passes
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Figure 1226

upright

To tell Blender that we want to extract the light passes, go to the Render Layers
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Figure 1227

context in the Properties
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Figure 1228

window, and look for the Passes panel. Notice the four groups of 3 buttons each for “Direct”,
“Indirect” and “Color” grouped under “Diﬀuse”, “Glossy”, “Transmission” and “Subsurface”?
(Depending on your Blender version, the “Subsurface” group might not be present.) Click
all these buttons, and also check the “Emission” and “Environment” boxes just below.
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Figure 1229

Now if you go back to the compositor window, you should see that the RenderLayers node
has sprouted a whole lot of extra output terminals, one for each of the buttons/checkboxes
you clicked.
Next, we want to recombine these to mimic the behaviour that Blender provides by default.
If you go back to that Blender Wiki diagram above, you will see that, for each shader type
(diﬀuse, glossy etc), the direct and indirect light passes are added together, and the sum
is then multiplied by the colour calculation. The result from all the passes is then added
together.
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Figure 1230

How not to do it: notice the repeating patterns?

The Blender compositor has standard node types for adding and multiplying colours. Armed
with this information, you might immediately set to work putting together an intricate node
setup to implement the formula depicted in that diagram, perhaps ending up with something
like at right.
Show this to a seasoned computer programmer, and they will perform the gesture known
as a “facepalm3 ”. Yes, technically this will work, but it is quite complicated-looking and
error-prone. Supposing you get a connection wrong: how would you ﬁnd it? How would
you debug your node program?
For, make no mistake, nodes are a programming language. Putting together a node
setup is very much like writing a computer program. One of the important principles is
don’t repeat yourself. That is, if you ﬁnd yourself doing the same sequence of steps more
than once, it makes sense to spell it out once, and then next time just tell the computer to
do the same thing again.
Note:
In programming, laziness is a virtue. Programmers spend a lot of their time thinking
up ways to avoid work, by getting the computer to do it.

3
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Figure 1231

So let us see how a programmer would approach this same problem. To start with, consider
the most basic operation, which is: add the direct and indirect components, and multiply
by the colour. So create a pair of Mix nodes, one to do the Add and the other to do the
Multiply, and wire them appropriately. Turn them into a group CTRL + G , and add
group inputs and outputs as in the diagram.
To change the names of the inputs and outputs, you can select them in the list that appears
in the Properties shelf N in the Node Editor window, then type a new name in the
appropriate ﬁeld just below the list.
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Figure 1232

Having done all the wiring, TAB out of the group, so you can give it a name. Here I call
it “Pass Combine”. See how naming the inputs and outputs helps make it clearer what the
node is for? And if you want to see the details, just TAB into the node for more. This
technique is called abstraction, where you start by seeing only the overview, but you can
progressively peel back the layers to see more and more detail, but only where you want to.
This is an important technique for dealing with complexity, which is what programmers do
every day.
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Figure 1233

We will need four instances of this group, plus another bunch of Mix nodes to add them all
together. We are adding 6 quantities, so we will need 5 Mix nodes. Again, I make a group
to combine all these adders, just to make things neater.
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Figure 1234

I call the resulting group “Add6”. Blender only provides nodes to add two quantities at a
time, yet here we have made our own custom node that can take 6 inputs at once. Neat,
huh?
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Figure 1235

So now we combine our building blocks into a new building block that computes the combination of all the passes, and looks like this.
Note the ordering of the group inputs, to ensure a nice and neat arrangement when we
connect this node up below. You can rearrange the inputs by selecting one from the list
in the Properties Shelf N and using the up- and down-arrow buttons next to the list to
change its position.

1421

Fireﬂes in Cycles, Continued

Figure 1236

And then when we connect that building block (here called “Combine All”) into all the
RenderLayers outputs, our complete node setup now looks like this.
Compare this with the original simple-minded recreation of the pass-combining algorithm:
which would you rather be presented with when you open a Blender document?
Note:
Groups within groups: When you have one node group within another, you may
become confused over the behaviour of the TAB key: will it exit the current group, or
take you into an inner one? If you select an inner group, it will go into that, of course.
But if you’re trying to get out, click on a node that isn’t a group. You always have two
of these, the Group Input and Group Output nodes, handily marked out by their yellow
title bars. So click on one of those before pressing TAB , and that takes you out of the
group.

159.1.2. Fixing The Fireﬂies
Anyway, now that we have separated the lighting passes, such that we can recombine them
to produce the original image anyway, how do we actually go about ﬁxing the ﬁreﬂies?
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Figure 1237

Diﬀuse-indirect pass produces ﬁreﬂies

First we have to isolate which passes are producing the ﬁreﬂies. Click the “Backdrop”
checkbox in the header of the compositor Node Editor window. Now, CTRL + SHIFT +
LMB on the RenderLayers node, and you should see a new Viewer node automatically
appear and connect itself to the ﬁrst output terminal on that node. At the same time, the
background of the window changes to show the image produced by that output terminal.
The ﬁrst terminal should be showing the complete image, including the ﬁreﬂies.
Keep pressing CTRL + SHIFT + LMB , and the Viewer node will connect to each output
terminal in turn. Some may be all black or all white, but don’t worry, just keep going.
When you come to the Diﬀuse Indirect output, you should see something like at right,
mostly dark, but with noticeable ﬁreﬂies. Make a note and keep going; I also found that
the Glossy Indirect output was another source of problems in this case.
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Figure 1238

So we need to insert a Despeckle node between the Diﬀuse Indirect output from the RenderLayer node, and the corresponding Diﬀuse Indirect input on our Combine All node. But
instead of just making a simple Despeckle node, let’s make a custom node group. Why?
Because we’ll need it in two places. So rather than having to set it up twice, just do the
setup once, and insert two instances. That way, we can adjust the despeckle settings in just
one place, and have it automatically take eﬀect wherever there is an instance. Also, maybe
we want to try other ﬁlters in combination with or instead of Despeckle; again, we would
only need to make the change in one place, and it would automatically aﬀect all instances.
“Don’t repeat yourself”, remember?

Figure 1239
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Conclusion
So here we are, with a couple of instances of our custom “Fix Fireﬂies” node group inserted
in the most troublesome light paths.

Figure 1240

Fireﬂies gone!

And here is the resulting render.

159.2. Conclusion
Fireﬂies can be troublesome, particularly because there is no 100%-foolproof way of getting
rid of them. After all, if there were, why not just build it in as an automatic part of every
render? This pair of pages has presented a range of techniques for dealing with them, from
simple to complex. Of course it makes sense to try the simple ones ﬁrst, and only if they’re
not good enough, is it worth expending eﬀort on something more complex.

159.3. See Also
• This video4 by Bartek Skorupa, which was the inspiration for this page.

4

http://cgcookie.com/blender/2012/12/10/compositing-cycles-render-passes-blender/
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160. Procedural Eyeball in Cycles
i Information
Applicable Blender version: 2.70
You previously learned1 how to model an eyeball using just procedural textures with the
Blender Internal renderer. This page will redo the exercise using the Cycles renderer.
Note: The BI version of the tutorial relied on a quirk of the Musgrave texture, in that a
certain combination of settings produced a nice pattern of radial ridges for modelling the
iris of the eye. While Cycles also has a Musgrave texture, I was not able to reproduce
the same eﬀect. However, Cycles has a much more powerful material node system, and in
particular by transforming to polar coordinates2 and applying a radial scaling, I was able
to get a suitable pattern of radial ridges using just a simple Noise texture.

160.0.1. Why Procedural?
Rather than mess around with intricate manipulations of procedural texture generators,
the previous tutoral Creating Pixar-Looking Eyes3 used an image for the iris texture. This
simpliﬁes some things, but it has its own drawbacks:
• How do you create this image texture? Do you hand-paint it? If the resolution is not
high enough, or the patterns or colours are not right, you must redo it.
• It’s a separate ﬁle you have to remember to include with your project. The Cycles renderer
does not (yet) support packing images into the .blend ﬁle.
As you will see below, a procedural node setup gives you plenty of opportunities to tweak
parameters, to produce eﬀects that are subtly (or not-so-subtly) diﬀerent. This allows for
a great deal of variety, with very little eﬀort—once you have worked out the node setup, of
course.

160.1. Creating the Mesh
The modelling part of the exercise is exactly the same as in the BI version. If you already
have a mesh that you did for the BI tutorial, feel free to reuse that and skip to the next
section. Otherwise, continue reading.
1
2
3

Chapter 86 on page 831
https://en.wikipedia.org/wiki/Polar_coordinates
Chapter 85 on page 819
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The mesh will consist of two modiﬁed UV spheres, one just slightly inside the other. The
outer mesh will have a material that is both transparent and reﬂective; at the front of the
eye, this will represent the cornea (where the light enters the eye), while over the rest of the
eye, it will add shininess to the eyeball. The inner mesh will make up the remaining three
major parts of the eye that are visible from outside:
• the sclera, the white part of the eyeball
• the iris, the variously-coloured ring of muscle that surrounds the hole that actually lets
in the light, and
• the pupil, the hole where the light goes into the interior of the eye.
Start in Object mode. Get rid of the default cube. SHIFT + A dd a new UV sphere
mesh; 24 rings and segments should be suﬃcient. Switch to front view NUM1 , and check
the “Align to View” box that should have appeared in the panel at the bottom of the Tool
Shelf. This will be the inner mesh.
into Edit mode; make sure the entire mesh is selected; SHIFT + D uplicate it, and
cale it slightly up to create the outer mesh. (You may ﬁnd it easier to work in wireframe
Z mode.) H ide the outer mesh you just created for now, to make it easier to work on
the inner one.
TAB

S
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Figure 1241

Select RMB the single vertex at the front of the inner mesh. Now press NUM+ four
times to extend the selection to include the ﬁrst four rings of vertices out from this front
vertex. The selection should look like at right.
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Figure 1242

Now ﬂatten the selected vertices with the sequence S
Y
0KEY
ENTER . Next,
reduce the protrusion of the resulting ﬂattened disc with G
Y and moving it a little
closer to the rest of the eyeball. The result should look like at right.
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Figure 1243

This will do for shaping the inner mesh. Now to do the outer one. Unhide it ALT + H
. Select RMB just the frontmost vertex. In the Mesh menu, set Proportional Editing
to “Connected” and Proportional Editing Falloﬀ to “Root”. Now move the selected vertex
forward with G Y , and use the mouse wheel at the same time to adjust the proportional
editing inﬂuence until you make a bulge that is about the right proportions for a human
cornea.
OK, that’s the modelling done, now on to the fun part—creating the materials in Cycles.

1431

Procedural Eyeball in Cycles

160.2. UV-Mapping the Iris

Figure 1244

The iris pattern needs to be correctly located so that the radial striations are symmetrically
arranged around the centre. To control the placement of the iris texture, we need to set up
a UV map.
Set your layout to have both a 3D view and a UV/Image Editor view, as at right. Create
a new image in the Image Editor; this will be just a dummy for the UV unwrapping, so its
size and contents do not matter.
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Make sure you are in Edit mode in the 3D view. H ide the outer mesh, to reduce the
clutter. Switch to frontal view NUM1 . Make sure ( A once or twice) nothing is initially
selected. Select the rings of vertices that will make up the iris, as at right. Bring up the U
nwrap menu, and select “Project from View (Bounds)”. This should unwrap the selected
vertices, exactly as they look in the frontal view, and place them neatly within the bounds
of the dummy image, as in the lower window in the screenshot at right.

160.3. Creating the Materials
160.3.1. The Cornea
For the outer mesh, you can set up a material similar to the one previously discussed in
A Glass Material in Cycles4 . Only, instead of an IOR of 1.45 (glass), use a value like 1.33
(water), since water is the main constituent of the transparent tissue (as indeed of all human
tissue).

160.3.2. The Sclera

Figure 1245

The material for the white of the eye needs a little tracery of red blood vessels, but not
too much. Here the network of blood vessels is provided by a Wave texture node with a
very high distortion setting. This is then put through a Bright/Contrast node: enhanced
contrast to sharpen the edges, and reduced brightness to make the blood vessels very pale.
This value is then fed to a Mix RGB node to mix between the white of the main part of
the eyeball and the red of the blood vessels.
The original tutorial added some shininess to this material. However, since the cornea
material is already shiny, and already overlaying the entire eyeball, it seemed redundant to
have shininess here as well.

4

Chapter 157 on page 1369
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160.3.3. The Iris
This is the fun one, because it will require the most intricate Cycles node programming.

Figure 1246

As previously mentioned, we have to convert some texture coordinates from rectangular5
to polar coordinates. The node group at right will achieve this. It looks quite complicated!
However, it becomes easier to understand if you take it step by step:
• The two rows of 3 nodes each at the upper left (each containing a Subtract followed by
two Multiply nodes) take the incoming X (upper row) and Y (lower row) values, subtract
0.5 to convert the range from 0..1 to -0.5..+0.5, multiply by 2 so the range is now -1..+1,
and takes the square of each value. These are then added and the square root (Power
of 0.5) of the result taken, to give the distance of the point
from the origin, in the range
√
0..1. In other words, it is computing the equation r = x2 + y 2 . This is the Mag output
from the node group.
• The bottom-most row of nodes divides X by Y (actually it should be Y by X, but that
doesn’t matter for our purposes) to compute a slope, and then uses the arctangent function to get the angle of this slope. This value is in radians, so it is divided by 1.571 ( π2
or close enough) to convert it to the range 0..1. This becomes the Angle output from the
node group.

Figure 1247

5
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Creating the Materials
Now we use the above node group in this node setup. Note the “Separate RGB” and “Combine RGB” nodes: they are not separating/combining RGB colour components, but XYZ
coordinate components. In both cases, the components are scalar reals, so mathematically
speaking, this (ab)use of the separate/combine RGB functions is perfectly all right. Note
also how we ignore the B component (i.e. the Z coordinate), since we are only dealing with
a two-dimensional texture.
After separating out the X and Y values, these are fed through the Rectangular→Polar
conversion node group we created above. But then note how the Mag value is put through
a division by 4 to stretch out the texture radially: this is the secret to getting the radial
ridges in the iris texture. After the coordinate components are recombined, they are used
to control a Noise texture, which then gives a bump map to the iris material.

Figure 1248

But we’re not done yet. There is still some more node magic to wield, to get a radial
gradation in colour from the centre to the edge of the iris. To build that, we will need
another node group, as at right. This one is called “Rescale”: it takes a value in an input
range (deﬁned by the “In Low” and “In High” inputs) and linearly transforms it to an
output range (deﬁned by the “Out Low” and “Out High” inputs). Or, using mathematical
symbols x for the input value, y for the output value, and x0 , x1 , y0 and y1 for In Low, In
High, Out Low and Out High respectively, this node group implements the transformation
(y1 −y0 )
y = (x − x0 ) (x
+ y0 .
1 −x0 )
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Figure 1249

And now, here’s how we add a use of the Rescale node group to our iris material node setup.
We use it to transform the Mag polar coordinate (distance from centre), and then use that
to drive a colour ramp that actually controls the diﬀuse colour of the iris. Here I have done
a gradation from light green to dark green; feel free to substitute whatever eye colours and
gradations you choose.

160.3.4. The Pupil
Here I just used a simple black diﬀuse material. The original tutorial added some subtle
suggestion of red blood vessels, similar to the sclera; you could do that here if you want,
but I thought the eﬀect was too subtle to see, so I didn’t bother.
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160.4. The Final Result

Figure 1250

And here is what the ﬁnal render might look like.

160.4.1. Parameters to Tweak
The above node setups are quite complex, but they oﬀer many opportunities for experimentation.
For example, in the Sclera material, try tweaking the Bright/Contrast settings, to see how
that aﬀects the result. Make the red blood vessels more prominent, and the eye looks
bloodshot!
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In the Iris material, you can change the eye colour (of course). But also try changing the
radial striations: see how they look if they are larger. Why did I put the Rescale node
there? It was to let you increase or decrease the eﬀect of the colour ramp, without having
to edit the ramp itself.
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161. Introduction to Freestyle
i Information
Applicable Blender version: 2.67
New in Blender 2.67, the Freestyle renderer adds a whole range of non-photorealistic eﬀects
to the Blender Internal renderer. It seems in some ways like the decades-long quest for
photorealism in computer graphics has come full circle, and people are now deliberately
seeking how to achieve more cartoony or line-drawing-style eﬀects!

161.1. A Simple Freestyle Example
Start with a new Blender document. Delete both the default cube and the default lamp.
In the World
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Figure 1251

context, check the Environment Lighting box and set its energy to 1.0. This will give your
scene a ﬂat, shadowless light that suits a cartoony eﬀect.
Create a Circle mesh object. TAB into Edit mode; all the vertices should be selected, so
you can add a face joining them all just by pressing F . Next, select just one vertex with
RMB . Go to the Mesh → Snap menu and select “Cursor to Selected”. TAB out of Edit
mode, and go to the Object → Transform menu and select “Origin to 3D Cursor”. Putting
the geometry origin at one edge of the circle, rather than its centre, makes it easier to apply
the upcoming transformation via an array modiﬁer.
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Figure 1252

back into Edit mode. Select two vertices equidistant from the one you used to
position the geometry origin. Turn on proportional editing (Mesh → Proportional Editing
→ Connected). Now press S to scale the two selected vertices closer to each other, and
use the mouse wheel to regulate the proportional-editing falloﬀ to get a reasonable leaf or
petal shape, as at right.
TAB

Once you’ve got a decent shape, select all the vertices and rotate them by a small angle,
say, 5°, e.g. R
Y
5KEY
ENTER . This will keep the overlapping copies of the object
from running into each other and producing some unpleasant rendering eﬀects.
TAB back into Object mode. Now add an Empty at the current position of the 3D cursor.
Rotate it about the Z-axis by 60°: R
Z
6KEY
0KEY
ENTER . Since this shares the
same geometry origin as your circle, it can be used to apply a rotation to the latter without
it turning into a spiral.
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Select your circle again. Add an Array modiﬁer: uncheck Relative Oﬀset (and ensure
Constant Oﬀset is oﬀ as well), and turn on Object Oﬀset. Click on the ﬁeld for entering
the object name, and in the popup menu that appears, select the name of your Empty (it
should be called “Empty”). Set the Count to 6. You should now see a leaf-like or ﬂower-like
arrangement of 6 copies of your circle. While you’re at it, give it a suitably plant-like colour,
like leaf green.
Now go to the Render Context

Figure 1253

. Look for the “Freestyle” checkbox near the bottom, and check it. Switch to the Render
Layers Context
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Figure 1254

, and you should see that a “Freestyle” panel has appeared. Click the “+” button next to
the “Freestyle Line Set” list to create a new entry. You can leave all the settings for the new
Line Set at their defaults.
Now hit F12 to render, and you should end up with something like this:
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Figure 1255

161.2. See Also
• Video tour1 of just about every Freestyle setting.

1
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163. Introduction
i Information
Applicable Blender version: 2.4x
Welcome to the wonderful yet complex world of computer animation! Through these pages
I will try to show you everything old and new about the new animation system in Blender
2.4. But, before we get started, there are some basic notions about datablocks you should
know. Animation in Blender is based on the fact that you have something moving in a
Blender scene. For example, a ball bouncing on a ﬂoor plane:
-So you have a scene datablock, which holds some info about the scene itself, as you can
see in the Render button window (F10KEY). -You populate this scene with various objects
(which in this case refers to containers for data, not the actual mesh data that shapes the
object itself). The only goal of an object is to hold the whereabouts of the data you want
to see in your scene. It also holds the object instance's properties such as ”does it have soft
body or particle options, and do we draw its name?”. Most of the info on an object can be
seen in the Object Window (F7KEY).
An object links to all of the data you can see in a 3D view such as mesh, curves, nurbs,
lattices, armatures, metadata, the empty property, text, camera and lamps.
So the ball you just added to the scene is in fact a mesh, linked to an object that is in turn
linked to the current scene.
Now there are also data blocks you can't see in 3D view, such as material, texture, Ipo,
action and image. Instead, you have a special window in which to edit them. This is the
idea behind the Blender interface, wherein each data block has a window for you to edit
the data.
So back to this bouncing ball: It's also moving across the plane! So an ” ”Ipo” ” data block
is linked to the object, telling it where in space the object will be at each frame of the
animation. This Ipo is editable in the Ipo window when selecting the ball in 3D view. In
Blender, the work you are performing is always on the currently active (selected) object
and data.
Note: In Blender 2.5x and later the OOPS view has been removed.
Looking at the OOPS (object oriented programming system) view (or SHIFT-F9KEY), we
can get a good idea of the internal data structure:
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Figure 1256

Again, you are working in the scene ”Scene”, with an object ”Sphere” linked to the mesh
data block ”Sphere” and the Ipo datablock ”ObIpo”. Why is that important? Because from
there, you can start playing with the datablocks, linking them all around your projects to
reuse old work. For example you can create more than one Ipo, and use the one you want,
or tell more than one object to use the same Ipo, or to use the same object in more than
one Scene.
Most of the linking job can be done in the Edit button window (F9KEY). Where you can
tell an object to use another mesh's data block for Ipo, material, texture or image. There
is always a little dropdown menu button for you to select an already-existing data block.
Now, when it comes to animation, you have to understand the way Blender handles data
very well, because using Blender is always a matter of plugging data blocks together when
working with Ipos, actions and NLA objects.
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164. Guided Tour:
Here I'll show you all the stuﬀ you need to know about the interface when animating. Where
is it? How does it work? Why use it?
We are going to talk about:
•
•
•
•
•
•
•

1
2
3
4
5
6
7

Armature Object1
Mesh Object2
Constraints3
Timeline Window4
IPO Window5
Action Window6
NLA Window7

Chapter 165 on page 1451
Chapter 169 on page 1485
Chapter 175 on page 1523
Chapter 184 on page 1561
Chapter 185 on page 1563
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FAdvanced%
20Tutorials%2FAdvanced%20Animation%2FGuided%20tour%2FAction%2Findex
Chapter 187 on page 1567
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165. Armature Object
The Armature Object in itself is a tool for the animator to move an object or group of
vertices in a reliable way. An armature is made of bones, which can be parented to each
other, or connected to each other. It was built with the idea of a skeleton in mind. And in
fact, in the 3D world with animation inclusive, its considered to be the skeleton.
You can add it using the SPACEKEY in 3Dview and selecting Armature. You'll then enter
into Edit Mode where you can add or move bones to build your default rig. An armature has
3 states. You can switch using the dropdown menu in the header of the 3Dview or use the
TABKEY to switch between Editmode <-> [Objectmode|Posemode] and CTRL-TABKEY
to switch between Objectmode <-->Posemode:
• Object Mode1 : Your armature is like any other Object, you can move it around the scene,
scale it, rotate it and edit options in the button window.
• Edit Mode2 : Your armature is in what we call rest position, you can modify the bones it
contains.
• Pose Mode3 : Your armature is ready to be animated, each bone can be moved, scaled
or rotated, constraints get applied, you can pose your character and animate the bones'
behavior over time.
Take note that Pose mode is now a state of the armature you can switch on/oﬀ using
CTRL-TABKEY. So when in Pose, you are still in object mode (you can select another
object, contrary to the edit-mode)
Note: The following 3 pages of this tutorial contain screenshots and discuss techniques that
are only available in Blender 2.40a and later. Refer to the Blender 2.40a release notes 4 on
Armature draw types and Armature envelopes.

1
2
3
4

Chapter 166 on page 1453
Chapter 167 on page 1465
Chapter 168 on page 1479
http://www.blender.org/cms/Blender_2_40_alpha.598.0.html
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166. Armature Object in Object Mode
i Information
Applicable Blender version: 2.4x

166.1. The Armature Object
Armature Object is like any other object type:
• It has a center, a position, a rotation and a scale factor.
• It can be edited.
• It can be linked to other scenes, and the same armature data can be reused on multiple
objects.
• All animation you do in object mode is only working on the object, not the armature's
contents like bones.
Try it now: add an armature to your scene: SPACEKEY --> Add --> Armature.

Figure 1257

How to add an armature bone in Blender 2.62
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Or you can press the Shift + A keys, and select single bone from the armature menu.

Figure 1258

How to add an armature bone in Blender 2.62

When you add a new armature, you'll enter editmode automatically. To switch between
modes, use the TABKEY or the dropdown menu in the Header of the 3Dview window
(This might not be the case with blender 2.49b, you won't enter edit mode in that version):
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The Edit Panel When in Object Mode

Figure 1259

Modes that relate to Armature bones

166.2. The Edit Panel When in Object Mode
This is how the edit panel looks after you have added a new armature and switched to
object mode (TABKEY):
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Figure 1260

• Link and Materials panel:
• The AR: ﬁeld let you rename your armature Datablock. The dropdown is a quick way
to select which Armature datablock you want to connect to this armature. You can
keep more than one version for the same character. Useful when you have a special
move to achieve in a shot, you can turn on an armature for a special purpose.
• The F button is an option to assign a Fake user to the Armature. Again if you have
more than one armature for your character, it's a good idea to turn the Fake on, because
if your armature datablock is not used (linked) it's not going to be saved in your .blend
ﬁles. You can always do batch Fake-assignment of armatures by opening the Datablock
browser (SHIFT-F4KEY), go in Armature datablock, select all the armatures you want
to keep, and Press the FKEY.
• The OB: ﬁeld is just to Rename your armature Object to something more cool and
useful than Armature... Armature.001...
• Armature panel:
• Editing Options:
• X-Axis Mirror Edit: Not really useful now, it's more of an editmode option. This
feature tells Blender you want to replicate all of your bones on one part of the
Armature to the other. It's a clean way to just do half the job ;). The axis of
mirroring is X so left<-->right in frontview (NUMPAD_1KEY) and the center is
the center of the armature object. We will see this feature in detail in the next page.
• X-Ray: This option will let you see the armature through anything in the scene,
solid or not. It's useful to see where your bones are in your character so you can
select them.
• Automatic IK is a Posemode option. It lets you pose a chain of bones as if the bone
you were holding was an ik target. More info in Posemode page.
• Display Options: These options give you the chance to visualise your bones in various
ways. Also note that there is some speciﬁc options and features regarding the display
mode you're in.
• Octahedron: This is the default view. Nothing exciting except you have a good idea
of the rolling of the bones.
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Figure 1261
• Stick: This display mode is really useful when you have a lot of bones in your view.
It lets you ”unclutter” the screen a bit. It draws the bones as tiny sticks.
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Figure 1262
• B-Bones: It's more a feature than a display mode. This is only useful to visualise
the eﬀect you get when you activate the B-bones (Bézier-Bones). Each bone acts
like a curve handle and lets you get extremely curvy poses. This will be exposed in
the following pages.
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Figure 1263
• Envelope: Again it's more a feature than a display mode. But in this case the
visualisation will be useful to tweak your rig later. Envelope lets you easily tell
which part of your character this bone will animate and it's visually possible to
change the zone of inﬂuence exclusively in this display mode. The zone is only
visible in Editmode or Posemode though.
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Figure 1264
• Draw Axes: To draw the axes on each bone of the armature when you are in Editmode
or Posemode. Useful when you want to know where you are and which axis to use
in a constraint for example. Mental note: Y is up, Z is depth and X is side, contrary
to object for which Z is up, Y is depth and X is side.
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Figure 1265
• Draw names: This lets you see names of bones whatever the mode you are in. It's
useful again to edit your armature, create parent dependencies or add constraints.
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Figure 1266
• Ghost: This option lets you see a ghost of the armature in frames behind and over the
current time. This is only working when you have an action linked to the armature,
as we will see later.
• Step: This option lets you choose the frames interval between ghost instances.
• Deform options:
• Vertex Groups & Envelope: These two toggles let you choose if you want the armature
to deform your character using the Vertex Groups and/or the Envelopes. We will
see that later.
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Extra Practice
• Rest position: This will bring the character back to factory default (item as Editmode), and no actions will be applied to the armature so you can easily edit it in
the middle of an animation.
• Delay Deform: This was useful before as the old system was very slow. What it does
is when you do a manipulation to the rig, it waits until you ﬁnish to update the view.
Can still be useful though.

166.3. Extra Practice
This YouTube tutorial might also help: Link1 The short tutorial might be a help Link 22

1
2

http://youtube.com/watch?v=GbFvrilssNo
http://www.youtube.com/watch?v=T1-tvJVokr8
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167. Armature Object in Edit Mode
i Information
Applicable Blender version: 2.4x
Now you've got your armature1 , but it's not much use until you add some more bones to it.
Think about your body for a moment -- you've got this thing you call a 'skeleton', which
for our purposes corresponds more or less to an armature object. Your skeleton consists
of a number of bones (about 206, to be precise), but generally these are not independent
from each other. If you move your femur (the bit of your leg between your pelvis and your
knee) then conveniently the rest of your leg moves with it. In that example, the tibia/ﬁbula
would probably be counted as one bone, with the femur as their 'parent' bone. In this way,
you build up a hierarchy of bones, making animation much simpler.
Editing an Armature Object gives you the chance to add, move or connect bones together.
Whilst in edit mode, you will see all of the bones within the currently selected Armature.
When you create a new armature in Object mode a single bone will automatically be created
for you, centered at the cursor position. Blender will then switch straight to Edit mode to
allow you to add further bones. At this point we're just deﬁning the default 'rest' position
of the bones and specifying how they connect together -- you'll have to wait until the next
chapter2 to ﬁnd out how to create speciﬁc poses.

1
2

Chapter 166 on page 1453
Chapter 168 on page 1479
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167.1. Now the basics about bones

Figure 1267

Having created and selected an armature in Object mode, you can add and modify the
bones in this armature by switching to Edit mode.
• You can add a new bone at cursor position by pressing SPACEKEY in the 3DView -->
Add --> Armature.
• A bone has two ends: a root (the lower part) and a tip (the upper part). You can select
and move the tip or the root independently with RMB, or you can select the entire bone
by clicking on its body.
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The edit panel
• You can extrude a new bone from the selection using EKEY. This will create a bone
connected to the original one, meaning the Root of the new bone will follow the Tip of
the original one. You can also CTRL-LMB to extrude a new bone. It will extrude to
where you clicked.
• Alternatively, you can connect two existing bones by selecting them one after the other
and pressing CTRL-PKEY. You can then choose either 'Connected' (the child bone the one you selected ﬁrst - will automatically be moved so that it touches the parent) or
'Keep oﬀset'.
• You can use SHIFT-DKEY to duplicate a bone
• Using the WKEY menu, You can subdivide your bone or ﬂip the name of the bone
between Left-Right (See Naming convention below).
• You can delete the bone with XKEY
• You can select a chain of bones (connected together) using LKEY, when you hover your
mouse over a bone.

167.2. The edit panel

Figure 1268

• Armature Bones Panel
• OB: this ﬁeld lets you rename your bone.
• ”Child of” Dropdown: lets you choose which bone will be the parent of this bone. If
a parent is selected, there will be a small button labelled ”con”, meaning connected.
Setting the parent deﬁnes the relationship between your bones. When one bone has
another as its parent, it will do everything the parent does, such as rotate, move and
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scale. A dotted line between the parent and child will appear. If you select Connected,
the Root of the Children will go stick to the tip of the parent, giving you a chain of
bones like the 2 bones in your arm.

Figure 1269

none

• Segm: If you set this value to something greater than 1, it will cut your bone into
several little segments and deform them on a bezier curve - referred to as a 'B-Bone'.
You need to create a chain of bones to really show oﬀ this feature though. In the
example below, the image on the right has 1 segment, and the one on the left has 3
segments each (these are shown in Object mode to show the eﬀect more clearly):
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The edit panel

Figure 1270

none

• Dist: This is the area of inﬂuence of the bone. It can be visualised using the Envelope3
display mode. We generally don't touch this ﬁeld as there is an easier and faster way
to change this option. Turn Envelope on and select a bone. Then using ALT-S, you
can scale the zone of inﬂuence. This has the advantage that you can do it on multiple
bones simultaneously, and it works in both editmode and posemode:

3

Chapter 171 on page 1491
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Figure 1271

none

• Weight: This speciﬁes how strongly this bone will inﬂuence the geometry around it,
relative to the other bones. If two bones crossing each other, both with envelope
inﬂuence, have the same weight (like 1:1) they will inﬂuence the surrounding geometry
equally. But if you set one to 0.5, the geometry will be aﬀected more signiﬁcantly
by the other one, with weight 1. For example, in this image, 2 bones using envelope
inﬂuence try to move the same geometry. The 2 on the left have the same weight, you
can see the geometry didn't move. On the right, one of the bones has 0.5 so the bone
with weight 1 is winning the tug-of-war!:
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Figure 1272

none

• Hinge: This tells the bone to remain motionless in a chain. It doesn't copy the rotation
and scale of the parent. Useful for mechanical rig I would say, as you can animate the
rotation of the hinge bone without having to correct it because the parent rotated:
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Figure 1273

none

• Deform: This lets you say if you want the bone to deform the geometry at all. Switching
it oﬀ is like setting the weight to 0, except it's faster this way. Useful when using a
bone as a target or a controller, i.e. a bone you just want to use to control other bones,
but not the geometry itself.
• Mult: to deform geometry you can use vertex group4 and/or Envelope5 . The ability to
mix both of these methods is handy for using one to tweak the other. For example, you

4
5

Chapter 172 on page 1497
Chapter 171 on page 1491
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Naming convention
might use envelope everywhere but tweak diﬃcult places manually with vertex group.
We'll discuss this in more detail later on.
• Hide: This option lets you hide the bone. You can use it to hide the less important
bones when you want to see what you're doing or for when you come to animate later
on. For example, when you animate you don't need to see the entire chain of the leg,
just the controllers. The values you select here apply to both Editmode and Posemode.

167.3. Naming convention
In many cases, rigs are symmetrical and can be mirrored in half. In these cases, it is helpful
to use a left-right naming convention. This is not only useful for your own sake, but it gives
Blender a hint that there is a pair of equivalent bones, and enables the use of some very
cool tools that will save you some signiﬁcant work.
• It's helpful to name your bones with something useful telling you what it's there for, such
as leg, arm, ﬁnger, back, foot, etc.
• If you get a bone that has a copy on the other side, however, like the arm (you have 2
arms right?), then the convention is to call them arm.Left and arm.Right.
• Other alternatives are also possible, like _L, _LEFT, _left, .L, and .Left. Anyway, when
you rig try to keep this left-right thing as accurate as possible; it will pay oﬀ later on.
• You can copy a bone named blah.L and ﬂip it over using WKEY --> ﬂip name. So the
bone will be blah.L.001 after you copy it, and ﬂipping the name will give you blah.R.
Blender handily detects if the .001 version already exists, and increments the number for
you.
This is an example of naming in a simple rig:
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Figure 1274

167.4. Mirror Editing
Now we come to the X-Axis Mirror Edit feature. This handy little number allows you to
deﬁne only half of your character and tell Blender to automatically repeat the same actions
on the other side. It's cool, it's simple and it saves a whole lot of time.
We will create a little guy out of sticks for the occasion -- don't worry about the geometry
yet.
• Create a new, empty scene. Since the mirror editing feature mirrors along the X Axis,
make sure you've got the front view selected (NUMPAD_1KEY) so that the X Axis runs
from left to right. Add a new armature to the scene (SPACE, Add|Armature). Enable
'Draw names' from the 'Display options' section of the Editbutton panel, so we can see
what we're doing.
• Now enable mirror editing by pressing F9 on the buttons window and clicking the X-Axis
Mirror button in the Armature panel under Editing options. You'll also need to use
the center of the armature (indicated by a purple dot) as the center of your rig, otherwise
the symmetry will go wrong when we come to create the mirror image.
• Name the ﬁrst bone you have ”Back”. You can scale it to make the entire back of the guy.
• Select the tip of this and extrude a new bone from it to do the Head. Name it Head.
• Select the tip of Back again and do SHIFT-EKEY to tell Blender you're starting a
mirrored chain of bones. Blender will automatically extrude another bone and will
create an exact mirror of whatever you do. Take note that the name of both bones are
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Back_L and Back_R. Blender also tries to keep to the naming convention. Unfortunately,
since we extruded from the Back bone, the names aren't quite right anymore.
• To change the names: Start by editing one of the names as Arm. Add the suﬃx to it
(_L or _R). Then hover your mouse over the name ﬁeld and do CTRL-CKEY. You just
copied the name of the bone! Select the other bone, hover you mouse over the name ﬁeld
and do CTRL-VKEY. This will paste the name as-is. But as there is already a bone with
the same name, Blender will add .001 after it. No problem; just go into 3Dview and do
WKEY --> Flip name. There you have it -- a working mirror again.
• Mirror editing works using names. If you move a bone named blah_L and there is a bone
named blah_R in the same armature, Blender will mirror the move you do to it, so make
sure you follow name convention correctly.
• Then we can continue: extrude an other bone to make the lower part of the arm using
EKEY or CTRL-LMB. The new set of bones should be arm_L.001 arm_R.001.
• Then we will add the legs. Up till now we have always worked from the tips of the bone.
This is easy as Blender understands you want to create children of the selected bone, but
to make the legs you need to extrude from the root of ”Back”. So go ahead, select the root
of ”Back” and do SHIFT-EKEY to start a pair of chains. Rename them to ”leg”+suﬃx.
• Now take note that doing so will not parent or connect the new bones to anything. We
don't want it to be connected to the tip of ”Back”, it would look silly. But we want it to
follow the body!
• The way to go is to parent the two legs we just created to the ”Back” bone. The old way
(pre 2.40) was to select all bone and select the parent manually in the drop down. In the
new version, editmode and posemode have an active bone. The active bone is the last
bone you selected. In this case we can't work with more than 2 bones selected. Select
the child (a leg) then select the parent (Back) and Do CTRL-PKEY. A menu will popup
asking Connected or Keep oﬀset. For now use Keep oﬀset. Do this for the other leg as
well.
• it's also possible to remove parent easily. Select any bone you want to remove parent
relation from and do ALT-PKEY. A menu will popup asking if you want to clear all or
just to unconnect. Of course you don't need to select the parent and/or the child for this
to work since any parent relationship will be cleared. So if you do that on a bone which
is parent of 5 bones, then immediately all the children will be parentless.
• Extrude one more time to get a leg with 2 bones.
• Turn on the Stick display mode and enjoy your guy made of sticks!
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Figure 1275

• Now you can go into Posemode and pose your guy as you want.
• You can move the entire guy just by moving the ”Back” bone, since this is how we built
him. This bone is the highest in the bone hierarchy, ”The daddy of all bones”, you could
say!
FASTER WAY TO NAME YOUR BONES 1) Create one side of the armature complete
with correct bone names like the way this tutorial describes. 2) Copy the side of the
armature you just created and paste it on the opposite side to form a complete armature.
3) On the side that you just duplicated, your names would have numbers added to them.
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Now select each bone on 3D View and hit ”W” then select ”FLIP NAME”. MAKE SURE
YOUR PARENTING IS THE SAME AS THIS TUTORIAL DESCRIBES!
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168. Armature Object in Pose mode
i Information
Applicable Blender version: 2.4x
Posemode is a very versatile place where you Animate your character, create and manage
constraints and apply your rig to your character.
Contrary to Editmode, Pose mode isn't an obligatory mode where you can't do anything
else. It's now part of the UI like any other object. A good example of it is you can be in
posemode and still select another object.

168.1. So What Can You Do?
When you are done building your armature, you can go into Posemode to add constraints
and start creating actions. There are also some new tools accessible in Posemode that you
may want to look at. You can easily get into ”pose” mode by selecting the mode from IPO
type list box in the left portion of the lower screen.
The panel has changed a bit too:

Figure 1276

• What's new in the panels?:
• You can use the Automatic IK feature in the Editbutton(F9) to pose a chain of bones
like it was an ik chain. It's usefulness is very limited though. It works well only if there
is no other ik solver in the chain, and if your chain is isolated from the rest of the rig.
• Ghost: in the armature panel the ghost option lets you see the action linked to the
armature over time. Also called onion skinning.
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Figure 1277
• There are two number ﬁelds to better tweak the eﬀect of B-Bones. The in/out
is used to tell the scale of the virtual handle of the bezier curve. In is the Root
of the bone, and Out is the Tip. The bigger the value, the bigger the eﬀect of rotation.
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Figure 1278
• There is now a Constraint panel where you can add a constraint to a bone, like any
other object in the scene. This will be shown later.
• You can pose your rig using GKEY, SKEY and RKEY. Note that if the bone is part of a
chain it can't be moved (except if it's the ﬁrst of the chain, moving all the chain as they
are all children), so you rotate the bone instead.
• You can do ALT-SKEY on one or more bones while in Envelope display mode to tweak
the envelope size in real time while animating. Useful when for example you move the
hand and some part of the character isn't in the inﬂuence zone; the result will be that
some vertices will stay behind.
• You can do CTRL-CKEY to copy stuﬀ from a bone to bones. The options are location, rotation, scale and constraint. Constraint is very handy when you wan to copy a
constraint to other bone. The way it works is easy.
• The W-KEY menu gets some neat options too:
• Select constraint target: Will select the target of the bone's constraint currently selected.
• Flip name: Yep, you can ﬂip name in Posemode too.
• Calculate/Clear path: This is a visual way to see the action linked to your armature.
You can select just some bones and ask Blender to show you the paths of the bones.
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Figure 1279
• You can pose your character and select all bones you want to see included in the action
and press I-KEY. You can insert a key just for loc, rot or size. Avail will add a key to all
available channels in IPO window (all channels you previously added something).
• When you insert key for your armature, a new action is created and linked to the armature
if there was no action before. You can also see the curves of each selected bone of the
armature in the IPO window. We will see action window and IPO window later.
• You can parent a bone to an external object by selecting this object then selecting the
bone in question so it's active (The armature is in Posemode so you can select a bone).
Do CTRL-PKEY. Then when you move the bone the object will follow. This kind of
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Hard relationship doesn't include any bending at all. It's useful when doing robot rigs as
you are just moving objects around.
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169. Mesh Object
This section will explain how to deform your mesh using the armature.
There are two ways to tell Blender which vertex will go with which bone: Vertex group,
and Envelope.
There is also a tool useful when animating which is part of the mesh object: the Shape key,
to create a preset deformation. For example: deform the face to look like a smile.
•
•
•
•

1
2
3
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Connection between Armature and Mesh1
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Shape Key4
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170. Connection between Armature and
Mesh
i Information
Applicable Blender version: 2.4x
How to tell Blender: ”use this armature to deform this mesh”

170.1. The Armature Modiﬁer
Blender now has a Modiﬁer stack (Editbutton, F9KEY). As such, we should use it over
existing methods to pair mesh and armature, as the modiﬁer stack is optimised and simple
to use. Note: You don't need to parent the mesh to the Armature anymore. The only
case you could need to do this would be animating the Armature object itself. Then the
mesh should also follow the armature. In this case select mesh, then armature, and do
CTRL-PKEY --> Object.

Figure 1280
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The clean way to do so is to go in the Editbutton window (F9KEY) and press ”Add modiﬁer”
in the Modiﬁer panel, then select ”armature” in the dropdown menu. Then you'll get a new
modiﬁer ”Armature” like the previous picture. Change the OB: ﬁeld to the name of the
armature object that should control the mesh. This step is very important! Without the
armature object being deﬁned, Blender won't know how to modify the mesh since there
may be multiple armatures within your world. To limit the eﬀect of the modiﬁer, you can
enter the name of a vertex group in the VGroup: ﬁeld. This will minimize unwanted
distortions in very dense meshes. There are also ﬁelds to enable/disable the modiﬁer when
rendering, enable/disable when working to only move the armature (could get handy with
massive character), and when editing (that's very handy, you can edit the topology while
it's deformed). There are also two toggles to tell Blender what it should use to deform:
Vertex Groups and/or Envelopes. You may have noticed these options are repeated also in
the Editbutton --> Armature panel, but as the tooltip says: these two are used when you
use virtual modiﬁer (the old way) to keep compatibility with old ﬁles.
Parenting the mesh to the ”armature” will create an old-way link, still visible in the modiﬁer
stack, but not very useful. The ﬁrst entry with the ”make real” button is what appends if
you do a CTRL-PKEY to ”armature”. You should not use that kind of connection when
you see that. Press ”make real” to get a working modiﬁer.

170.2. The Old Way
This way is not recommended but can still be useful. When doing CTRL-PKEY to ”armature”, you will get a menu like this:

Figure 1281

• Don't Create Groups will just create a virtual modiﬁer so you can deform the mesh (the
”make real” button)
• Name Groups is almost useless now as blender will create a group for you when you do
weight painting.
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Tip: Bake envelope to vertex groups
• Create From Closest Bones is a function to remember when you want to bake all your
envelopes to vertex groups.

170.3. Tip: Bake envelope to vertex groups
The workﬂow is very simple. When you are done with the envelope's tweaking and you
have gotten the best out of it, delete the Armature modiﬁer and parent the mesh to the
armature. To parent it, go to object mode, ﬁrst select the mesh and then the armature,
then press CTRL-PKEY. Select Create From Closest Bones.
Do ALT-PKEY and redo the Armature modiﬁer. Now all the envelope inﬂuence are converted to Vertex Groups. This way you can further tweak inﬂuence zone using Weight paint.
More info in the following pages.
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171. Envelope
i Information
Applicable Blender version: 2.4x

171.1. What is Envelope
Envelope is a new visual tool to help you rig your characters faster and easier. It can often
save you a lot of time. Each bone has a special area around it, allowing you to tell Blender
what part of the geometry will follow each bone. This zone is customizable so you can
move, scale and blend them together.
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Figure 1282

171.2. Edit Envelope
You can edit this white zone in Editmode or posemode by going in Envelope display mode
(Buttons Window → Armature → Display Options → Envelope), selecting bones and using
SKEY or CTRL-ALT-SKEY.
In Editmode: you can select the Tip, the Body or the Root and scale using SKEY. This
area in the middle will assign a weight of 1 to all vertices contained in here. All vertices
with a weight of 1 will completely follow this bone. The white transparent area around the
center is a zone of inﬂuence which loses power as you go away from the center. This area is
scaled when selecting the body of a bone and doing CTRL-ALT-SKEY. In Posemode: You
can only scale the zone of inﬂuence with ALT-SKEY when in Envelope display mode. It's
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real time, and lets you tweak the inﬂuence while you animate. So if you notice there is a
vertex not following in the new pose you just did: Just select the bone it should follow, and
scale the zone a bit until the vertex goes back with his friends. Example:

Figure 1283
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Envelope

Figure 1284

171.3. Envelope Options
It's possible to enable/disable the use of Envelope in the Modiﬁer stack using the ”Envelope”
toggle.
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Envelope Options

Figure 1285

There are also two important buttons in the Armature Bones panel: Deform and Mult.

Figure 1286
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Enabling the Deform button will tell Blender to deform geometry with this bone. It's useful
because in a more complex rig not all the bones are there to deform, some bones are just
there to move other bones.
The Mult option will tell Blender to multiply the weight it gets from envelope (let's say 0.7)
with the weight you painted in weight paint (let's say 0.5). The result will be 0.5*0.7=0.35
so in fact you just tweaked the envelope inﬂuence to 0.3 when it was at 0.7. If you don't
want vertices to be part of the zone, you can always paint it with 0, as 0*(something) will
always give 0. This way you can give custom shape to your envelope. More on weight paint
on next page.

Figure 1287

In this example of a formerly ﬂat surface you can see that all the selected vertices are not
following the bone when it is moved upwards. This is because I painted a weight of 0 on
them. In weight paint you'll see nothing. But just the fact that they are part of the group
with a weight of 0 will make that possible. If Mult is oﬀ and you have both a vertex group
and envelope, Blender will add value.
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172. Vertex Groups & Weight Paint
i Information
Applicable Blender version: 2.4x

172.1. What Are Vertex Groups?
Vertex groups are very useful. You can use a vertex group to:
•
•
•
•

Group
Deﬁne
Deﬁne
Deﬁne

vertices together while you model (keep a selection and come back to it later).
which vertices softbody simulation aﬀects.
which vertices emit particles.
which part of a mesh will follow a speciﬁc bone.

Vertex groups are speciﬁc to the Mesh object and can be modiﬁed in Editmode.
If you have vertices assigned to multiple groups (for example, in a character you may have
some vertices in the ”upper arm” vertex group that are also in the ”lower arm” vertex group),
you can assign weights to those vertices to specify how much relative inﬂuence the diﬀerent
groups have. A weight can range from 0 to 1 and is assigned when you create the group.
Let's take a peek at the GUI of vertex groups in the Editbutton(F9KEY):
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Figure 1288

From top down:
•
•
•
•
•

The dropdown menu lets you select an existing vertex group or rename the current one.
The weight numﬁeld lets you choose the weight value assigned when you add vertices.
You can add a new group or delete the current one.
Assign or remove selected vertices to/from current group.
Select/deselect all vertices in current group.

172.2. Weight Paint
As mentioned above, you may often ﬁnd that you have some vertices that are assigned to
more than one vertex group. By assigning weights, you can specify the relative inﬂuence each
of the vertex groups have. You have two options to assign weights: 1) manually selecting
each vertex and typing in a weight value, or 2) use weight painting to - you guessed it paint weights.
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Weight Paint
Weight painting lets you paint weight values on the mesh like you were painting on a wall
with a can of spray paint. It is a Mode of the 3Dview and is accessible in the 3Dview's
header in the dropdown menu with Objectmode, Editmode and such. A hotkey is also
available: CTRL-TABKEY.
In Weightpaint Mode, the ﬁrst thing you'll notice is the blue color of the mesh. Blender
provides an easy way to quickly visualise the weight value of each vertex. This is the color
spectrum used:

Figure 1289

When you are in Weightpaint mode you can paint all over the mesh as if it was a solid
object on your desk. The paint only works on vertices so don't try to paint in the middle
of an edge or a face, it will never work. To help you in your task there is a new panel in
Editbutton:

Figure 1290
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• The weight slider is just the same thing as the weight numﬁeld we saw earlier in the
vertex groups button. It's just easier to work with. It's simply the weight you want to
apply to the vertices. In painting terms, think of this as the color.
• The buttons from 0 to 1 are shortcuts for weight value, to speed up the workﬂow.
• The opacity slider (and shortcuts) tell Blender what is the percent of the weight value
you want to apply in one shot. If you set opacity and weight to 1 the vertex will turn red
instantly. In painting terms, think of this as the pressure.
• ”All faces” tells Blender if you want to paint on all faces in the mesh or just the visible
one.
• ”Vertex Dist” tells blender to use vertex distance instead of faces. When active, the
painting will only check if the vertex is in the brush, then apply a weight value. If it's
oﬀ, all vertices part of the faces in the brush will receive weight value. Turning on Vertex
Dist can give good results when you have a lot of polys in your mesh.
• ”Normals” will apply vertex normals before painting. This means Blender will take consideration of the direction the vertex is pointing when painting: the more it's facing away
from view, the less it will receive value.
• ”Spray” really makes it like spraying paint. Without it, a single click will only paint one
value. With Spray on, each time you move the mouse a paint shot will be added. To get
a good eﬀect, use a small opacity value so the weight will increase slowly.
• ”X-mirror” will tell Blender to apply the weight paint on the other group if there is one.
Like Hand.L --> Hand.R. If you paint the group hand.L and there is a hand.R the paint
will be copied over. For this to work your groups must be created, the name of the
groups have to follow name's convention (left right) and both side of the mesh need to
be identical.
• ”Wire toggle” toggles the visibility of wire while painting. Useful to ﬁnd where the vertices
are (activate the edit mode option ”Draw all edges” to see even better).
• ”Mix”/”Add”/”Sub”/”Mul”/”Filter” is how you want to apply the paint based on what is
already there. Mixing will do a mean from brute weight value and current weight value,
”Add”/”Sub” will directly add or subtract value, ”Mul” will multiply (exponential painting)
and ”Filter” will paint based on alpha value.

172.3. Vertex Groups and Armatures
So what use are vertex groups in rigging? You can specify what vertices will move when a
bone moves. When you want to paint a mesh for an armature, do the following:
• Make sure the Mesh has an Armature modiﬁer.
• Select the armature and enable Armature Posemode (CTRL-TABKEY).
• Select the mesh and enter Weightpaint mode (CTRL-TABKEY). (Question: if we're
in Pose Mode for the Armature, how are we supposed to select the mesh?
Ans: right click on it.)
• Select the bone you want to paint for with RMB.
• Paint the parts you want that bone to aﬀect.
You'll notice that, if there is no group created when you ﬁrst paint, Blender will create a
group for you, and give it the same name as the selected bone. This is important, because
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Using Weight Painting with Armatures
when the ”Vert. Groups” toggle is on in the Armature modiﬁer, Blender will try to match
bones with Vertex Groups based on the same names.
What happens when we try to blend groups together? See this simple example of 2 bones
trying to bend a tube:

Figure 1291

The Groups are painted so the body of each bone is in red and the zone between the two
bones are gradually going from 1 to 0. This will bend nicely. If, for a special reason, you
want a side to react diﬀerently, you can always move the bone while painting and try the
new modiﬁcation you just did. By the way, having Subsurf on while painting can be very
cpu expensive. It's a good idea to turn it oﬀ.

172.4. Using Weight Painting with Armatures
Armatures are used for many purposes, but one common use is to deform a mesh with
an armature. This example will demonstrate how weight painting can improve armaturedeformed meshes.
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In this example, we have two objects; each has an armature modiﬁer applied. The one on
the left is going to be the ”before” and the one on the right will be the ”after”.

Figure 1292

For the object on the left, take a look at the vertex groups as initially assigned (from left
to right: Bone1, Bone2, Bone3, and Bone4). These same vertex groups were assigned for
the object on the right:
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Using Weight Painting with Armatures

Figure 1293

Important: A bone in an armature will only act upon those vertices that are in a vertex
group with exactly the same name as the bone.
• In Blender 2.37 and previous, this was the ONLY way to get a bone to deform a mesh.
• In Blender 2.40 and on, selecting the ”Envelope” button in the armature modiﬁer will
allow bones to deform even if you haven't assigned any vertex groups yet.
If you enter Weight Paint mode (CTRL-TAB with object selected) right after assigning the
vertex groups, you can see that the vertex groups as assigned all have a weight of 1.0:
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Figure 1294

OK: both objects have vertex groups assigned and they have armature modiﬁers. Let's
grab a bone (select the Armature, CTRL-TAB to enter Pose Mode, select Bone4, GKEY
to grab, and move) to deform the mesh. We haven't made the objects diﬀerent from each
other, so after moving their armatures in the same way . . there's still no diﬀerence. That's
good.

Figure 1295
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173. Shape Keys
i Information
Applicable Blender version: 2.4x

173.1. Shape Key?
Shape keys are modiﬁcations of the original mesh that you can animate and mix with each
other. Previously called Relative Vertex Keys (RVK), one of their major uses is to create
facial expressions.
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Shape Keys

Figure 1296

The idea behind Shape keys is simple. The basic, undeformed mesh you start with is the
”Basis” shape. You can add a variety of diﬀerent versions of this shape and store each one
as a Shape Key for use in an animation (other software sometimes refers to these as ”morph
targets”). You can't add or delete vertices as Shape Keys only store the positions of vertices
and not the creation/deletion of them.
Ok, to start out, take a plane. I'll add a new shape to it and move a vertex away:
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Shape Key?

Figure 1297

When I play with the inﬂuence, this key has over the basic shape, the result will be as
follows (0.5 in this example):
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Shape Keys

Figure 1298

If I play with the slider from 0 to 1, Blender will gradually apply the Key 1 shape with
a constantly varying amount of deformation. So from 0 to 1, it will slide from the basis
shape to the Key 1 shape. The movement of the vertices is linear from start position to
end position and you can even set an inﬂuence greater than 1 or lower than 0 and Blender
will extrapolate the movements of the vertices relative to the basis shape (marked as a
dotted line above). This feature allows you to set general shapes such as a smile and then
exaggerate the shape without needing to remake it.
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The GUI

173.2. The GUI

Figure 1299
----

173.3. Shape Keys step-by-step
Here's a hand-held walk-through of how shape keys are used.
Start with the default cube or a more interesting mesh of your choice.
1: Select your object in Object mode. Go to F9 Editing window. Find and select the
”Shapes” panel. Press the ”Add Shape key” button. This adds a key called ”Basis” and
this stores the ”basic” mesh in its undeformed state. Make sure the ”Relative” button is
pressed (should be default).
2: Press the ”Add Shape key” button again. It now says ”Key 1” and you have a slider
and some other settings. Go into Edit Mode, grab a vertex and move it. Exit Edit
Mode. The mesh returns to normal but you've just added a real Shape key and Blender
has stored it.
3: Repeat step 2 for as many diﬀerent shapes as you like. You can rename the keys to
whatever you want. Normally you create each new shape by ﬁrst selecting the ”Basis” key
but if you select an existing key from the list and immediately press ”Add Shape Key” then
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enter Edit Mode, the mesh will already be deformed. This is useful for making similar but
unique keys.

173.3.1. Using Shape Keys
1: Starting on frame 1, select each key one by one from the pop-up list (or go to the Action
Window, press the sliders button and select the Keys from the list there) and click on the
slider and move the slider forward then back to zero. Sometimes just clicking on the slider
at the zero point is enough to set the key.
2: Move forward ten frames, select Key 1 from the list and move the slider to 1.00. You'll
see your object deform. Move more frames and slide another key. And so on and so on.
You can move them forwards and/or backwards as you move through the frames and they'll
just add together if they have to. Each time you move the slider, you set a keyframe for
that Shape Key.

Figure 1300

Setting Shape Keys

173.3.2. IMPORTANT NOTE:
You should add shape keys to a ﬁnished mesh. Don't work on a mirrored mesh or a partially
ﬁnished model. Adding geometry (vertices, faces, loops, joining etc...) can result in the loss
of the shape keys or to unpredicatable results. Not always, but probably when you least
expect it. There are scripts available to make some of these things possible.
That's the basics. Note that shapes will constantly transform between keys so if you set a
key at frame 1 to zero and at frame 10 you set the slider to 1 then at frame 5 the slider will
be at 0.5 - which you may or may not want. If you want it to hold shape for a while before
changing (e.g. staying at zero until frame 7), you'll need to set a key at the beginning and
end of the time frame you want it to stay the same (So you would set it a zero at the start,
then zero again at frame 7 then to one at frame 10). You can also edit the IPO curves (use
Shapes pop-up) to really mess with the transformations.
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174. Lip-Sync with Shape Keys
i Information
Applicable Blender version: 2.4x

174.1. Lip-Sync with Shape Keys
Here I will attempt to explain my recent dealings with using Blender Shape Keys to produce
convincing lip-sync (Lip-synchronisation, i.e.: ”speech”) for simple, humanoid characters.
This is aimed at people with an understanding of Blender fundamentals like vertex loops,
face loops, sequencer and of course, Blender's new Shape Key system. If these terms mean
nothing to you, then you may well struggle to keep up. If you're familiar with them then I
hope this tutorial will prove to be a breeze and your characters will be speaking so ﬂuently
you'll have trouble shutting them up!
Other Lip-sync tutorials, if you can ﬁnd them, recommend using other software like Magpie,
Papagayo and others, but while I've no doubt they provide a valuable service and maybe
make syncing easier, I will be using only Blender for this tutorial. I haven't tried using
lip-sync software yet so I can't really say if it's easier or not.
You will ﬁnd links to interesting audio ﬁles you can use for testing animation and lip-sync
near the bottom of the page.

174.2. The hard work ﬁrst
174.2.1. Setting up for Lip-Sync
First, set up your Blender screen so you have everything you need for this project. You'll
need a front 3D Window, an Action Window, the Buttons Window (showing Editing - F9
- panels) and a Timeline Window. If you've got the room, a Side-view 3D Window would
be handy too.
The basic sound units are called phonemes and the mouth shapes we use to represent
these phonemes for lip-sync are called visemes (or sometimes, phoneme shapes) and there
are many references for these around the web. Legendary animator Preston Blair created
one of the most popular viseme sets1 , which is great for cartoon-style characters. Other

1

http://www.garycmartin.com/mouth_shapes.html
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visemes are aimed at more-realist, humanoid characters. The shapes you choose depend on
the style of your model. (I'll try to provide some useful links later)

Figure 1301

Sample phoneme shapes

Sample viseme shapes.
The ﬁrst and most diﬃcult step in good lip-sync is making the shape keys for these visemes.
How well these are made ultimately determines the success of the animation and it is worth
spending time getting them right, although they can be modiﬁed and tweaked later. So
choose your favourite set of visemes (or even look in a mirror and use your own face as
a reference) and start setting your keys. A model with good topology - especially well
formed edge loops around the mouth area - will be a big help here!
What on Earth are topology and edge loops?!?!
Topology refers to the way your 3D mesh deﬁnes the object, in this case your character's
head. Edge loops refers to the ﬂow of consecutive edges around the character's major
features. Typically, good edge loops ﬂow around the eyes and around the mouth in a
somewhat deformed, ”circular” manner. Selecting and deforming a single loop of edges and
vertices surrounding a facial feature is much quicker than having to individually select a lot
of edges that don't ﬂow naturally around that feature. Similarly, deforming a single loop
or collection of related, nested loops is much easier and quicker than trying to deform a
seemingly random set of edges. You can easily see these loops in the character screenshots
above. The series of edges surrounding the mouth simply stretch from wide ellipses to
almost circular to create a useful variety of mouth shapes. The faces deﬁned by paired edge
loops are referred to as face loops. The close-up image below shows selected face loops.
There are many tutorials on the web about these topics so if you need more information
before proceeding then a quick search is probably a good idea.
Setting the basic viseme shape keys
First, select your undeformed mesh and create your basis key. Go to Editing (F9) window
and go to the ”Shapes” panel. Press the ”Add Shape Key” button. Enter and exit edit
mode to set the basis key. Then create your ﬁrst key Key 1 and name it ”M”. Enter
edit mode and if your character's mouth isn't already closed (some people make them that

1512

The hard work ﬁrst
way) then close it by carefully selecting the faces and loops around the mouth. You will
usually use Size-Z plus a bit of grabbing and shifting to achieve this. Don't forget to
include the faces on the inside of the lips or the deformation will be unpleasant. When
you're happy with the shape, exit Edit mode and there you have it. Your character can
now say ”Mmmmmm” whenever you like. Test it by moving the Shape Key slider back
and forth but make sure to leave it at zero before making more keys. (If you made your
character with a closed mouth then you can just add the new ”M” key then enter and exit
edit mode to set it.)

Figure 1302

Selecting face loops

Selecting face loops
For most new keys, you will select the basis key ﬁrst then press ”Add Shape Key” then
make the required shape from scratch in edit mode. However, some mouth shapes are very
similar, like ”OH and OOO” or ”EE and SS” and it would be easier if you could start with
something close to what you want rather than shifting everything from scratch every time.
Luckily, Blender allows you to do just this. Once you've made your ”EE” key, for example,
you can select it and immediately press ”Add Shape Key” then enter edit mode and the
mouth will already be deformed and you only need to make subtle changes to it to make
your ”S” shape.
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Remember that the keys you make are for sounds, not letters.
In general, you'll need shape keys for the following sounds
•
•
•
•
•
•
•
•
•

M, B, P
EEE (long ”E” sound as in ”Sheep”)
Err (As in ”Earth”, ”Fur”, Long-er” - also covers phonemes like ”H” in ”Hello”)
Eye, Ay (As in ”Fly” and ”Stay”)
i (Short ”I” as in ”it”, ”Fit”)
Oh (As in ”Slow”)
OOO, W (As in ”Moo” and ”Went”)
Y, Ch, J (”You, Chew, Jalopy”)
F, V

These can often be used in combination with each other and with jaw bone rotations and
tongue actions to also produce other sounds like ”S”, ”R”, ”T”, ”Th” and a short ”O” as in
”Hot” - or these can also be speciﬁcally made with their own shapes. This decision depends
largely on your character. Start with the essentials and make others if you need them.
NOTE: I use one jawbone in my current character and this is also used to control the mouth
shapes. It doesn't drive the shapes but it moves the bottom teeth and tongue (which can
also be controlled separately) and the faces that make up the chin part of the character
mesh. For some visemes, I move the jawbone into a logical position before adding the shape
key. For example. I open the jaw for the ”OH” key and close it for the ”M” key. Later, when
animating, the jawbone is animated along with the Shapes for a very convincing result.
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Figure 1303

Using jawbone with shapes

Using jawbone with shapes
Load the audio
Once all your viseme shapes are set the time comes to get your character to speak. (Normally
you would animate the body ﬁrst and leave the lip-sync till near the end).
If you haven't already done so, load your audio ﬁle into a Blender Video Sequencer
Window and position it where you want it. Currently, Blender only supports 16 bit wav
format audio ﬁles so you may need some editing or conversion software to process the ﬁle
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if it isn't in this format. ”Audacity” is a good, open-source (free) editor that will suit this
purpose and much more.

Figure 1304

Blender Soundblock Panel

Blender Video Sequence Editor Window showing loaded Audio Strip
Go to the Scene Window (F10) and press the ”Sound block buttons” button --(in the three
buttons near the frame counter. It looks like an audio wave)--. Press the ”Sync” and
”Scrub” buttons. The ”Sync” button makes the playback in the 3D window closely match
the audio when you press Alt-A (it does this by dropping image frames if necessary and
it generally provides only a rough guide of how things match-up). The ”Scrub” button is
important for lip-sync as it means that whenever you change frames, Blender plays the
audio at that point (Currently in some Blender builds you have to press Alt-A at least once
to get this feature to start working).

Figure 1305

Blender Soundblock Panel

Blender Soundblock Panel
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Select your character and your Shape Keys should be listed in the Action Window, in
the order in which you made them (I don't think they can be shuﬄed). You will see a small
triangle button labelled ”Sliders” at the top of the list - press it to show the sliders for each
shape. If you drag the mouse back and forth in this window, you should hear the audio play
as you cross frames. This is how you will identify the main viseme/phoneme key frames.

Figure 1306

Shape Key Sliders

Shape Key Sliders

174.3. Getting down and dirty
Before you begin your lip-sync, you obviously need to know what your character says. It
might be worthwhile writing it down and even speaking it over and over, in time with the
audio, to get a feeling for the sounds you'll be dealing with. Some sounds are what I'll call
”key sounds” and others are almost dead, non-descript ”in-between” sounds that ﬁll in the
gaps between the key sounds. Obvious key sounds are those where the lips close and those
where they are tightly pursed or wide and round, other key sounds can diﬀer with every
piece of audio. Don't make assumptions about the shapes you'll use based on the words
you know are there. What you are animating are the actual sounds - not letters or words
(Keith Lango has much to say about this on his website and I recommend reading it)
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174.3.1. The Timeline Window
Go to the Timeline Window. This window seems to have been largely overlooked in
previous documentation yet it provides the basics for timed animation plus a few other
goodies to make your animation life a little easier. Here you can turn auto-keying on and
oﬀ at will (you'd normally go to the hidden User Preferences window which is a pain
and easy to forget), navigate frames, play and pause the animation in the 3D window, turn
Audio Sync on and oﬀ, set the start and end frames for the animation and set frame
markers. This last feature is the key to our project.
In recent Blender releases,the audio ”Scrub” feature works in most windows. As you scrub
through the audio, listen for where the key sounds occur. As you hit a key sound, scrub
back and forth to ﬁnd where that sound commences. In the Timeline Window, press ”M”
to set a frame marker at this frame. The marker can be labelled by pressing CTRL-M in
the Timeline Window while the marker is selected (yellow). Enter a sensible name for the
marker that indicates what the marker is for (like the phoneme sound and/or which word
it starts or ends). Markers are selectable and moveable and can be deleted just like other
Blender items.
NOTE: Depending on the speed of your system, you may ﬁnd you get more pleasing audio
scrubbing and better 3D window playback if you turn oﬀ subsurf for your model and hide
any unimportant parts of the scene on diﬀerent layers. The fewer things Blender has to
calculate as you scrub or play-back, the faster it can draw the frames to maintain sync with
the audio.

Figure 1307

Turn oﬀ these buttons to disable subsurf setting in 3D window

Figure 1308
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Getting down and dirty
Blender Timeline Window
Scrub through the whole audio - or sections of it in a long piece - marking and labelling all
the key sounds.

174.3.2. Setting the keys
Now you have everything you need for your ﬁrst lip-sync pass. Start at the ﬁrst frame and
click once on all your Shape Key sliders in the Action Window to set them all to zero.
Move through the frames from start to ﬁnish setting shape keys where you marked the key
sounds in the Timeline Window. If your character has a jaw bone and tongue bone(s), you
will need to set these where required as you go.
Trouble in paradise? A quick lesson in handling Shape Keys
If you haven't set shape keys before you might notice one interesting dilemma - they have
great memories! Once you set a slider to any value, it stays at that value until you set
another value somewhere. The shapes change in a linear fashion between keys. At ﬁrst,
this appears to be a problem if you want to key ”MOO” because after you set the ”M” key
slider to 1 (one), it will stay there, making it impossible to get your character to say ”OO”
while his lips are trying to stay shut. So, you have to set the ”M” slider on the ”M” sound,
then as the audio goes into the ”OO” sound, you must set the ”M” slider back to zero and
then set the ”OO” slider to its full value.
This introduces another problem. After you set the ”OO” key, your ”M” sound is messed up
because the mouth is now also being aﬀected by the ”OO” shape that follows it. So, you
must make sure the ”OO” sound is set to zero when you want the lips closed in the ”M”
position.
In general, you'll ﬁnd yourself setting each shape 3 times
• once to determine where you want the mouth to begin moving to this shape (slider set
to zero)
• once to set the slider at the desired level for this phoneme
• and once more to end this shape and move into the next one (slider set to zero)
The same principle applies to the jaw bone and tongue - 3 keys to each move.

Figure 1309

Varying shape key settings

Setting multiple shape keys
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Lip-Sync with Shape Keys
As you get more comfortable with this procedure, you'll ﬁnd you can leave some shapes set
longer or adjust them to diﬀerent levels as they can provide some interesting mouth shapes
when combined with other shapes.

174.3.3. Setting the in-between sounds
Once the key sounds are properly set, you should be able to scrub slowly through the Action
Window and watch your character speak in time with the audio. It won't be perfect but it's
a start. To ﬁx his speech impediment, you now have to ﬁll in the sounds between the key
sounds. Mostly these will be dull vowel sounds (”err, uh, ah”) and silence. These shapes
are set in exactly the same way but here you'll have to really watch the 3D view as you set
the sliders. Try combinations of sliders like ”EE” and ”OH” to get the perfect shape for each
individual sound. You have to be guided by your character. Does he look like he's saying
the sound you're hearing? (Remember that exactly what's being said is not important - it's
only the sound that matters). Test each sound as you set it by scrubbing a few frames over
and over and watching your character mouth the sounds.
All that's left, hopefully, is some polishing and tweaking. If it's not perfect then don't
despair. Like other areas of animation, it can take a while to get a feeling for lip-sync
and as the tools and workﬂow become more familiar you can pay more attention to the
important work.

174.4. Putting it all together
When you're reasonably happy, it's time to combine the audio and video and watch the
result. Since Blender can't do muxing (combined audio/video) you'll need to composite
it with the editing software of your choice (OSX users can use recent versions of iMovie,
virtualDub is often recommended for Windows users and Avidemux2 is often recommended
for Linux users.).
What Blender can do is provide a fully synced version of the audio ﬁle the same length
as the animation - even adding silence at the start and end if need be to maintain the
synchronisation. To make this synced audio ﬁle, go back to the ”Sound block buttons”
panel and press ”MIXDOWN”. This saves a .wav ﬁle using the ﬁlename and location
you entered in your output box (you did didn't you?) plus a frame count (something like
'speech.avi0001_0400.wav'). Then save your animation by pressing the ”ANIM” button.
Combine the audio and video in your video editor and export a muxed ﬁle. You may ﬁnd
when you play it back that the mouth seems to be just slightly out of sync. This may be
for two reasons: You're syncing per frame, the sound doesn't start exactly at a frame. The
second reason is the way the brain processes faces and expressions and mixes it with sounds
heard to comprehend speech. This comprehension phenomenon is barely understood and
is a common challenge in animation, and some physiologists think our brains read lips and
facial expression as a way of setting up to understand the context of sounds received and
comprehending the meaning behind language. To solve it, you can go back into Blender,
select the audio in the Sequencer Window and move it one or two frames later, then press
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Using Blender to render Audio AND Video TOGETHER.
”MIXDOWN” again to create a new .wav ﬁle with a split second of silence at the start.
Remix this with your video and watch the results.
From here on its all a matter of testing and tweaking until you're happy!

174.5. Using Blender to render Audio AND Video
TOGETHER.
Ever since Blender 2.3, it has been possible to render video with the audio attached. Once
you have your animation done, and are ready to render: In the buttons window, click
scene (F10). In the format tab, choose FFMpeg. There will now be three tabs. Click on
Audio. Click Multiplex, and choose your audio codec. Click Video. Choose your video
codec (including AVI). Now, in another section of the window, there will be an Anim tab.
Click Do Sequence. And click ANIM. When you watch the video, you'll notice that it has
sound.
Note: The mac version of blender doesn't have the FFMpeg codec in blender by default.

174.6. Audio Files
You can ﬁnd some interesting audio ﬁles selected for animators at http://www.
animationmeat.com/practice/practice.htmlanimationmeat. These ﬁles come complete
with a pre-marked phoneme sheet.

174.7. Note
One ﬁnal note. Watch how the pros do this. When actors are doing voice overs for major
releases their actions are recorded and even integrated into the ﬁnal animation. If you have
a digital camera, you may also try recording your own mouth performing your dialogue and
approximating its positions to your animation. This can give you a great visual reference,
possibly frames for frames if your frame rates match, and save you time.
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175. Constraints
i Information
Applicable Blender version: 2.4x

175.1. The Constraint
A constraint is what makes everything easier, magic, automatic, customised (add more
words here) in a rig. It tells a bone or an object to do something special based on the
position of another object, and the position of the constrained object itself. There are
many constraint types for you to play with. Most will work everywhere but, the IK solver
will only be available in the Armature Editmode or Posemode.
There are no strict rules to follow when using constraints. As long as they save you time and
make everything work by itself. A constraint should never be ”time-consuming” or diﬃcult
to use. Think about the animator who is going to work with this rig (it could be you!). So,
do everything in a smart way.
It's possible to copy constraints from one object/bone to a bunch of objects/bones. A
useful thing to know when doing a repetitive task like rigging all the ﬁngers of a hand.
Just select all bones/objects that you want to give a copy of the constraint, and then select
the bone/object containing the constraints. Press SHIFT + CTRL-CKEY in 3DView,
and select Object Constraints from the popup menu. The idea behind this is to copy the
constraints of the active object to the selection.
When working on an armature in Posemode, the bones will change color if they contain a
constraint. Green for almost all, except for the IK constraint, which turns the bone Yellow.

175.2. The Constraint Panel
You can add a Constraint to an object or a bone by going in Object button window(F7)
for objects and bones. Look for a Constraint panel like this (note, it's usually empty):
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Constraints

Figure 1310

The panel also appears in Editbutton(F9) when you are in Armature Editmode or Posemode. So what you get:
• A button to add a new Constraint. The choice you have is listed down this page.
• When you add a new Constraint, A block gets added in the stack. The UI is almost the
same as the Modiﬁer Stack. Each block represents an entry. You can delete it with ”X”,
move it up or down in the stack, close or open it.
• Constraints are evaluated from ﬁrst to last. So if you have two Constraints working on
the same channel, let say Location, The last one will most probably win the chance to
move the object. But...
• Most of the constraints have an inﬂuence slider to determine how much it will inﬂuence
the stack. If the last constraint has an inﬂuence of 0.5 it will mix the result with the one
before.
• You can animate the inﬂuence of the Constraint by moving the time, changing the Inﬂuence slider and adding a key with the Key button.
• The Show button will display the inﬂuence IPO curve in an IPO window for editing.
(The IPO window must be opened before pressing the 'show' button).
• You can change the name of the Constraint by clicking on the name when the constraint
is open.
• By Clicking on the white jacket of the Constraint you select which one is active for edition,
same as ”show” button.
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The Constraint Index
• If most of the Constraint you can enter the name of the Object you want to work with
as a target or reference. For a bone, you need to enter in which Armature object it is,
then an other ﬁeld for the bone name will appear. When ﬁlling those ﬁelds, remember
you can use autocompletion using TAB.

175.3. The Constraint Index
•
•
•
•
•
•
•
•
•

1
2
3
4
5
6
7
8
9

Copy Location1
Copy Rotation2
Track-To3
Floor4
Locked Track5
Follow Path6
Stretch-To7
IK Solver8
Action9

Chapter 176 on page 1527
Chapter 177 on page 1531
Chapter 178 on page 1535
Chapter 179 on page 1541
Chapter 180 on page 1543
Chapter 181 on page 1545
Chapter 182 on page 1549
Chapter 183 on page 1551
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FAdvanced%
20Tutorials%2FAdvanced%20Animation%2FGuided%20tour%2FConst%2Fact
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176. Copy Location
i Information
Applicable Blender version: 2.4x
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Copy Location

176.1. Copy Location

Figure 1311

The Copy Location constraint does as the name states: it will copy the location of the
target to the source (constrained object). Less Inﬂuence will drag the constrained object
less and less to the target.
If it's an armature, a new ﬁeld will appear to let you tell which bone will be the target.
Don't forget TABKEY completion while writing the name of your object/bone!
You can tell Blender to work only on the selected axis. Many uses are possible :)
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The Constraint Panel

176.2. The Constraint Panel

Figure 1312

• The Target ﬁeld will let you select which Object the constraint holder will follow.

176.3. Where To Use It
Most of the time this little constraint is useful to stick objects to one another. By playing
with the Inﬂuence you can tell when it will work, when it will remain motionless.
A good use of it is to ask a character to pick up something. By having a bone or empty
for each side of the releationship (hand <-> glass), as the hand approaches the glass, you
can align the two empties and ﬁre the constraint up (1.00) to stick them together. You add
another child-bone in the middle of the hand to tell where the glass will be. Thus moving
the hand will move the glass. On the side of the glass just add an empty and make it parent
of the glass. Add a copy location to the empty pointing to the bone in the hand we just
did. There you go. Of course when the hand rotates the glass will not. For that you will
need to add a Copy Rotation Constraint.
Before Blender 2.40, the above method was a good way of faking parent relationship without
rotation. But now we have the hinge option which does the same.
Create this kind of tracking device using the X Y Z toggle button
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Copy Location

Figure 1313
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177. Copy Rotation
i Information
Applicable Blender version: 2.4x
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Copy Rotation

177.1. Copy Rotation

Figure 1314

This constraint copies the rotation of the target. As simple as that. It can be an object or
a bone. As you can see in the example, only the rotation gets copied.
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The Constraint Panel

177.2. The Constraint Panel

Figure 1315

• You have 3 buttons to select which axis get copied over.

177.3. Where To Use It
Can be used with Copy Location to fake parent relationship. As you can key the inﬂuence
you can make a character pick something up and hold it in his hands.
You can also use this to align a plane with a 2D eﬀect on it to the camera at all times. This
works better than pointing it at the camera in some cases, such as a ring of atmospheric
halo around a planet, where you don't want it disappear behind the planet.
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178. Track-To
i Information
Applicable Blender version: 2.4x
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Track-To

178.1. Track-To

Figure 1316

The Track-To constraint lets you inﬂuence the Rotation of the constrained object by making
it track a target with one of the constrained object's axis.
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The Constraint Panel

178.2. The Constraint Panel

Figure 1317

• You can enter the name of the target you want to track.
• You can select which axis is going to track the target.
• You can select which axis is going to stay up.
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Track-To

178.3. Where To Use It

Figure 1318

A good example of use is the make a camera track an object. The setting to use on a
camera is track: -Z and up: Y. You can turn Axis drawing in objectbutton window to help
you choose the good axis.
Another example with armature would be the eyes of a character:
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Where To Use It

Figure 1319
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179. Floor
i Information
Applicable Blender version: 2.7x/2.8x
Using the ﬂoor constraint will keep a bone from passing through an object from a given
direction. It is useful when making ﬂoors of course but also when making walls and other
items which are obstacles for the armature.
There is also an oﬀset value which is very useful when say for example you have a foot
where the mesh stretches down below the actual tip of the armature you can then use the
oﬀset to make the bone stop before it actually reaches the obstacle object.
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180. Locked Track
i Information
Applicable Blender version: 2.7x/2.8x

180.1. Locked Track
This page is just like Track To, only you can lock an axis to point upwards.
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181. Follow Path
i Information
Applicable Blender version: 2.77

181.1. Follow path
Follow path is a constraint which creates an animation in which the Object follows a Curve.
You of course have to constraint it to a curve of some kind.

Figure 1320
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Follow Path

181.2. The Constraint Panel

Figure 1321

When you added a curve you've to click the ”Animate Path” button, otherwise nothing will
happen.
The ”Follow Curve” checkbox is there to make the objects Forward Axis, here ”Y”, point
in the direction of movement. Of course here you'll ﬁnd the Forward axis choices and Up
choice, weird they still got diﬀerent layouts, but don't bother. Finally, the ”Inﬂuence” slider.

181.3. Where To Use It
It can be very handy when you animate a roller-coaster or something that has to follow
something else perfectly.
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Where To Use It

Figure 1322

Here's an animation of a follow path
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182. Stretch-To
i Information
Applicable Blender version: 2.4x

182.1. Stretch-To
Stretch To causes the aﬀected object to scale the Y axis towards a target object. It also
has volumetric features, so the aﬀected object can squash down as the target moves closer,
or thin out as the target moves farther away. Or you can choose not to make use of
this volumetric squash-'n'-stretch feature, by pressing the NONE button. This constraint
assumes that the Y axis will be the axis that does the stretching, and doesn't give you the
option of using a diﬀerent one because it would require too many buttons to do so.
This constraint aﬀects object orientation in the same way that Track To does, except this
constraint bases the orientation of its poles on the original orientation of the bone! See the
page on Tracking for more info. Locked Track also works with this constraint. Options
R
Pressing the R button calculates the rest length as the distance from the
centers of the constrained object and its target

Rest Length
Rest Length determines the size of the object in the rest position

Volume Variation
Volume Variation controls the magnitude of the effect

Vol
The Vol: buttons control along what axes the volume is preserved (if at all)

Plane

1549

Stretch-To

The Plane buttons define which local orientation should be maintained while
tracking the target

Figure 1323
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183. IK Solver
i Information
Applicable Blender version: 2.4x
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IK Solver

183.1. The IK solver

Figure 1324

The IK solver constraint is a wonderful tool for all animators. IK stands for ”Inverse
Kinematic” and is the opposite of FK (Forward Kinematic).
• FK: You have a dependency to the root of the chain. In Blender, a FK chain is a chain
of bones connected together. You have to animate the bones rotation one by one to get
it animated. It takes longer, but gives you entire control over the rig.
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The Constraint Panel
• IK: Both ends are roots. All bones in the chain are trying to rotate to keep both ends
on targets. Now this Constraint got most of the attention during Animation refactoring,
hopefully we have a lot of toys to play with now.
The IK solver has a special shortcut in Posemode to be added easily to a bone. If you
select a bone and press 'CTRL-IKEY', You get a little menu asking for more info on the
new constraint, the target: to a new empty object or without target. It's now possible
to work without target. Though you have less freedom (no rot feature, diﬃcult parent
relationship).
You can also select the target and then the IK constraint holder and press CTRL-IKEY.
With this way of selecting ensure that your target is selected, but the bone you want to
apply the constraint to is active (the last one selected). The menu will then let you add a
constraint to the current bone with a target. If the target would itself be part of the IK
chain, you get an error message - so make sure the target bone is not connected to the bone
you want to add the constraint to.
It's also possible to remove all IK constraints from selected objects or bones with 'ALTIKEY'.
Q: 'CTRL-IKEY' doesn't seem to do anything
A: Either the 3D Window is out of focus (R-click in empty space to solve) or you're not in
Pose Mode ('CTRL-TAB', selected bone will be magenta in color)
A: In the 2.48 version of Blender, the shortcut is 'SHIFT-I'

183.2. The Constraint Panel

Figure 1325

• You can rename the constraint.
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IK Solver
• You can select which Object or bone will be the target. Don't forget Tab completion.
• The Rot button let you tell Blender to use the rotation of the target to inﬂuence the rest
of the chain:

Figure 1326

• The Tip button lets you tell Blender which part of the bone is the target, the Tip or the
Root. It's interesting to use tip, because this way the Bone holding the IK constraint can
be used to deform geometry.

Figure 1327

• Len lets you tell Blender the length of the chain the IK solver will try to rotate. If set to
0, the entire chain will enter in the constraint. If for example the len is 4, only the 4 last
bones of the chain will try to touch the target.
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The Constraint Panel

Figure 1328

• Also If you set len to 0 and your chain's root is a child of another bone, The IK solver will
reach and rotate all the bones until it gets to the end of the parent relationship. If all the
bones are linked up to a master root, then all other sub-branchs will be aﬀected. If there
is another IK target in other sub-branchs of the rig, Blender will try to mix them. This
concept of multiple IK targets in a rig is called Tree IK and can be used to get completely
automated animations. For example like a doll: if you pull one hand, all the body will
follow. In the 3D-view you'll see a yellow line from the IK solver to the root of the chain
it covers. This line appears when you select the bone containing the IK solver.
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IK Solver

Figure 1329

• PosW and RotW let you tell Blender if this IK solver will inﬂuence the ﬁnal result more
of less in the case of a Tree IK setup. With these options it's possible to use an IK solver
just for location and an other one just for rotation.
• Tolerance and iterations are performance and precision options. IK solving is done in
more than one pass, the more passes you calculate, the more accurate results you get.
The tolerance is the distance from the IK solver to the target you can accept. If Blender
manages to place the target near enough, it will stop doing iterations. The Iterations
value is a hard limit you set to limit the time blender can reach on each IK solver per
frame. Try to set it to a very low value to know why Blender needs more than one pass
;).
• You can set the general inﬂuence this constraint will have over bones, and it's animatable.
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Where To Use It

183.3. Where To Use It

Figure 1330

In any chain of bones you don't want to animate by hand but you want both ends to be at
precise location. The best example is a leg: The leg is connected to the body and to the
foot. You don't need to animate the 2 bones in the legs, just place the body and the foot,
the leg will follow automagically.
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IK Solver

183.4. Degree Of Freedom

Figure 1331

In DOF it is now possible to set it for bones in an IK chain. This way you can set what will
block where. This is very useful when doing a mechanical rig as you can limit the move or
better, lock completely an axis.
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Degree Of Freedom

Figure 1332

• There you can set a limit on each axis, or completely Lock it.
• No limit gives it complete freedom (which is the same as [min:0 max:360] or [min:0
max:0]).
• The stiﬀness lets you tell Blender if an axis is more diﬃcult to rotate than the rest. If all
bones have a stiﬀness of 1 on X and you try to curve that chain in a way that all bones
need to turn on X to follow the target, the Solving will ﬁnd really weird poses to ﬁnd a
way to touch the target without rotating on X.
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184. Timeline Window
i Information
Applicable Blender version: 2.7x/2.8x

184.1. Timeline Window
The Timeline window is below the 3D view in every standard project. You can see where
keyframes are for the selected object and scroll through the timeline
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185. IPO Window
i Information
Applicable Blender version: 2.7x/2.8x

185.1. Graph Editor
The Graph Editor is meant to work with curves, which mostly represent key-frame transitions or drivers.
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186. Data Type
i Information
Applicable Blender version: 2.7x/2.8x

186.1. Dope Sheet
The Dope Sheet is a window in which you can move, very easy, keyframes from one frame
to the other. They are visualised with clear diamonds.
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187. NLA Window
i Information
Applicable Blender version: 2.4x
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188. The NLA Window
It's quite easy and maybe that's why there's no speciﬁc tutorial. Let's say you want to make
two actions, AC:Hit and AC:Kick. Start with posing Hit and an Action will automatically
be created in the Action Editor consisting of all the Bones that use Action IPO's. That's
done so return to Frame 1 which will be your default Stance of AC:Hit.
Now, in the Action Editor, click the X (delete) next to AC:Hit and the datablock menu will
disappear. (If you Add New instead of deleting then it will copy selected bones to the new
action and you don't always want that). If you want a new default pose for AC:Kick, then
Pose it or the same stance will be used as was the default in AC:Hit. Pose and Keyframe
your Kick action and name it.
Over in the NLA Editor you can now use Shift-A to add NLA-Strips of your Actions, Grab
and Scale them and use the Transform Properties tab to input how they Blend.
If you select an Action with the dropdown menu, at ﬁrst its name will appear in the NLA
window along with its keys. To make this Action into an NLA strip, point at the Action's
name in the NLA and press CKEY.
Close any open Actions by clicking the scary X in the Action Editor. If you don't do this,
only this action will play. Now in the NLA editor, play the animation.
If you see any keys (diamonds) in the NLA window, instead of strips (rectangles), you're
still editing an action. It's so much easier if you have both the Action and NLA windows
open so you can see whether an Action is open or not.

188.1. Walkthrough
With no Actions selected, both the Action Editor and the NLA Editor appear empty. Here,
the NLA Editor window does list one Object called -Empty because that object is not an
armature but it has some IPO curves attached.

Figure 1333

empty action window
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The NLA Window
Select an Action you've already made. Here, an Armature named Yui has bones involved
in a one-frame action called -AtEase.

Figure 1334

nla window with action

Figure 1335

action window with action

Convert the listed Action to an NLA Strip in the NLA Editor by pressing the CKEY with
the mouse hovering over the Action to be converted. No change in the Action Editor; it is
still available as an Action.

Figure 1336
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nla window converting to a strip

Walkthrough

Figure 1337

nla window after conversion

Once converted, note the changes in the NLA Editor. The Action icon appears next to the
Armature's name:

Figure 1338

. This is actually a button though it does not look like it, and you can toggle it between
the Action and NLA Strips icon by clicking on it:

Figure 1339
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The NLA Window
.
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189. Introduction To NLA Editor
i Information
Applicable Blender version: 2.4x

189.1. NLA (Non-Linear Animation)
WARNING-This page assumes the reader to understand the IPO window and the Action
Editor window, as well as rigging a character with an armature object. This tutorial will
make little sense without this previous knowledge.
Imagine this--yourself, sitting at your computer late at night, beating away at a huge blender
animation. You didn't think it would take as long as it did, but you lost your composure
staring into the jungle of colorful IPO lines, little white and yellow Action diamonds, and
that annoying green current frame line. You know that the NLA window would help you
make sense of it all, but you are afraid of opening that Pandora's Box because of the
problems that will follow it. Never fear, for this tutorial will clean up all those problems
and revolutionize the way you blend for the rest of your life.

189.2. Setting up the Scene
It will be easier for you if you start with a small demo ﬁle than if you go straight for
the big prize. Give a character or other armature-rigged object a few SEPARATE actions
(remember to name them something distinct, like ”Walk” or ”Run” as you always should with
everything). For your own sanity, you will want to have a path or an IPO that correlates
with the actions in question. All of the blender screenshots I will be using come from a ﬁle
with a very basic stick person, rigged with an armature skeleton. He has two actions; a
normal walk cycle, and then another, hunched over one, as if to pass beneath a low ceiling.
If you use this idea in your own test ﬁle (and I thoroughly recommend it) do yourself a
favor and give them both the same stride length! Give this guy an IPO or a path to follow
that keeps his feet from slipping, and make sure that it has a linear interpolation mode.
The rest of the scene consists of a ﬂoor-plane and an arch too small for him to walk under
(hence the crouching walk). Place this arch exactly one walkcycle away for now, we will
move it around later.
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Introduction To NLA Editor

Figure 1340

Complete the scene before going on to the next step.

189.3. Adding Action Strips
Now, he moves forwards as you scroll through the frames, but how do we get him to walk
forward, duck, and walk under the arch, too? First of all, you need to select the armature
object and create a link to the normal walk. By pressing the up or right arrows, or pressing
”alt+a”, you should be able to see him walk up to the arch, stop walking, but keep sliding
through, with his head sticking out the top. As ridiculous as this seems, right now, however,
you are on the right track. Split your window now and open the NLA window with
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Adding Action Strips

Figure 1341
.
At ﬁrst glance, this window looks almost identical to the action window we all know and
love. This is not totally oﬀ of the mark. The NLA window is, in essence, an abbreviated
version of the action and IPO windows.
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Introduction To NLA Editor

Figure 1342

This is what you should see in the NLA window.

You see a space with the name of your armature (named ”Armature” in my demo) and in
that row you see a few key diamonds. These show the ipo you have put on the person. I
made it so the IPO extended on forever, using the ﬁrst ten frames as a guide. In a subset
beneath the armature object, you see the name of an action. The bullet next to it means
that the armature is currently linked to that object. In that row, you see key diamonds,
and those correlate with the keys you put into the action in question. If you switch actions
in the action window, you see that the NLA window also changes. But how do you get it
to keep the ﬁrst and play the second later?
Go to the ﬁrst frame you want him to walk in (most likely number one) and place your
cursor in the NLA window. Press ”shift+a” to see a dropdown menu. Pick the name of
the ﬁrst walk cycle. You should see a new subset space appear, with the name of the ﬁrst
walk in it. This space should be occupied by an action strip. Two colors of action strips
are yellow and pink, yellow meaning selected and pink meaning deselected, just like IPO
vertices. This strip takes up the amount of frames the walk did. The NLA window has
now saved your ﬁrst action. Now to toggle to the next action, move the frame line to the
end of the ﬁrst strip, then press ”shift+a” again, this time clicking the other action on the
dropdown menu.
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Getting the Strips to Play

Figure 1343

The result.

189.4. Getting the Strips to Play
Now, as cool as this seems so far, if you press ”alt+a”, you will be disappointed and confused.
The animation will only play one of the actions. This is a simple problem to ﬁx. If you look
carefully, you will see that the armature is still linked to the action it played. This data is
overriding any other data from the NLA window. Press the ”X” in the action window right
next to the name of the action. Press ”alt+a” again. It works!
This is, however, a jerky and instantaneous switch from one action to the other. Making it
less weird is easy. Press the ”N” key with your cursor in the NLA window. You will see a
small box with a bunch of functions in it (this will be explained in detail on later pages).
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Introduction To NLA Editor

Figure 1344

The Properties window.

This little box is the lifeblood of the NLA in blender. It contains all the tools you will need
to be able to run this feature smoothly. I will illustrate a few of them right know, but most
others will be shown in the section on this window.
Make sure you have highlighted the second action strip, and look at the space where it
says ”Blendin”. The number there is the number of frames blender will use to smooth the
transitions in to the highlighted action. Depending on how fast your character is walking,
you may need to change the number a bit, but I set my ”blendin” for seven. Whatever
number you used, however, move the second strip back that same amount of frames. The
wedge on the end of the action strip should end as the other strip ends.

1578

Conclusion

Figure 1345

The NLA solution.

189.5. Conclusion
You now have the necessary skills to complete much more involved and complex animations.
You can, however, increase this even more by continuing to read the other NLA tutorials
in this wikibook.
Good Luck!
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190. The Stride feature
At the moment, one of the best documentation for Blender Stride features can be found
here: Blender Stride Tutorial1 , which takes on where the Oﬃcial Blender Stride Page2
takes oﬀ. Good luck! A simpler and shorter, but still very good tutorial can be found here:
Blender wiki: NLA Editor and Stride Path3 .

1
2
3

http://www.telusplanet.net/public/kugyelka/blender/tutorials/stride/stride.html
http://www.blender3d.org/cms/Advanced_Stride_suppor.720.0.html
http://wiki.blender.org/index.php/NLA_Editor_and_Stride_Path#Stride_Support
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191. Relative Vertex Keys
• Letters in brackets i.e.:(z) mean there is addition information at the bottom of the page.

191.1. Introduction:
This tutorial is meant to stop all the RVK (Relative Vertex Keys) questions.

191.2. Window Layout:
Set the left half of the screen as 3D View. The other half is divided in two. The top is
Action and the bottom is IPO (set to vertex display).

191.3. Setting your Neutral Pose
Make sure you are on the ﬁrst frame (a). With the cursor over the 3D View, select the
mesh you want to animate. (mesh in object mode) and press the I key. Select Mesh from
the pop up menu then Relative Keys from the next pop up menu. A line will appear in the
IPO view. This line is your neutral pose.

191.4. Setting up your additional Pose Lines
Now, ﬁgure out how many key frames you will need. If you want to move both eyebrows
up and down then you will need 4 additional IPO lines.
Left Brow Up Left Brow Down Right Brow Up Right Brow Down
Press the up arrow (cursor key) to move to forward 10 frames. Press the I key while over
the 3D View and select Mesh. Repeat until you see a total of 5 lines in the IPO window.

191.5. Set your Poses
Right click on the Neutral pose line in the IPO window. This sets the mesh to the neutral
pose. Now Right click on the next line up in the IPO window. Enter edit mode in the 3D
View and move the vertices as desired (in this case you will be moving verts to get the left
Brow up pose). Press Tab to exit edit mode. Now right click your Neutral pose line in
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the IPO window. You will see your object in its neutral state. Right click the next line up
and you should see the changes you just made to your object. Set up all your mesh poses
following the above instructions.

191.6. Name your Poses
RIght click on the Key names in the Action window. Change the name and click OK.

191.7. Time to Animate (b)
Click on the arrow next to the Sliders text. This will give you access to the pose sliders.
Move to frame 20 to start your action. Move the pose slider but release the mouse when
set to 0. Now move 10 frames forward and move the same slider to 1.00 (maximum). Use
this method to set up all your actions(c). Remember to add a 0 value frame to end the
pose.(d).

191.8. Adjust your Slow in & Out
In the IPO View select from the menu to ﬁnd the IPO curves. You can get back to the Pose
lines by selecting KeyIPO from the same menu. Right click the spline you want to edit and
press TAB to enter edit mode. Move the handles to adjust slow in/out.(e)
(a) In this case moving to a frame has nothing to do with animation. It is done so that
your pose lines are separate from each other. (b) Select your key frame marker and use the
usual commands to move <g> and duplicate <d> them. (c) Be subtle by not pushing the
slider all the way to 1.00. (d) Try overlapping your poses. (e) When setting slider values
they can sometimes go into the negative value. This will give you weird results. Although
sometimes they can make your animation more interesting. To ﬁx this edit the IPO, select
the point where the line dips below zero and press the V key. Do the same at the other end
of the curve if needed.
Warning! Blender has a limit to the number of verts you can use.
---Click here to read the advanced animation tutorial guided tour.1

1
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https://en.wikibooks.org/wiki/..%2FAdvanced%20Tutorials%2FAdvanced%20Animation

192. Working Example: Bob
i Information
Applicable Blender version: 2.7x/2.8x
In this tutorial, we are going to be constructing a fully functional, humanoid character, with
a complete rig1 , and we are going to animate him performing a walk cycle.

1

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FTerminology%23R
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Working Example: Bob

192.1. Getting Started

Figure 1346

• Build the Rig2
• Deform the Mesh3
• Create a Walk Cycle4

2
3
4

Chapter 193 on page 1587
Chapter 194 on page 1591
Chapter 195 on page 1593
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193. Building the Rig
i Information
Applicable Blender version: 2.7x/2.8x
If you think you already know what a rig1 is, then you probably need to read the deﬁnition
of ”rig”2 and ”rigging”3 before we get started. It's important to note that an armature is
not a rig, but a rig can be an armature. Assigning a mesh to be deformed by an armature
is not rigging.
A rig4 should always be designed for the types of animations your character is going to
be performing. Only make your rig as complex as it needs to be to allow for the types of
actions you need.
To make everything with the armature easy to deal with, we're going to make our character
in the cruciﬁx pose. If he's not, you will have headaches trying to deal with bone roll angles.
Once Blender can easily allow the user to roll the bone to align with a roll target, then I'll
edit this tutorial for that. But in the meantime, we will use vertical legs and horizontal
arms. We will build the legs from the side view and arms from the top view. ----

1
2
3
4

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FTerminology%23R
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FTerminology%23R
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FTerminology%23R
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FTerminology%23R
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Building the Rig

Figure 1347

Center the cursor (shift+c) and add an armature. In Object Mode, press alt+r to clear
the rotation. You have to have a bone for the hip, and it needs to stick out of his front or
his back, so take your pick, because they both look bad. Don't point the bone upward at
some odd angle, we need to be able to roll the hips easily, and to that end, we will place
the bone horizontally.
In front view, place the cursor and add a bone. IMAGE
In side view, move points and extrude them until your chain looks like this. Note the slight
bend in the knee. This is very important! IMAGE
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Getting Started
Snap your cursor to the root of this chain (shift+s) and add a bone. Now select the points
at the hip joint and the ankle joint, and snap the cursor to the selection. IMAGE
Select the tip of the newest bone and snap it to the cursor. IMAGE
Now give these bones some names. It's a good idea to use the same names I do to avoid
confusion, since I will refer to the bones by name. Select upperleg.l and then shift+select
leg.l, and press ctrl+p to make upperleg.l the child of leg.l. Do this again, but make leg.l
the child of hip. IMAGE
In front view, center your cursor and select
pivot point5

5

https://en.wikibooks.org/wiki/Blender%203D%3A%20HotKeys%2FKey%2FPeriodKey
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194. Deform the Mesh
i Information
Applicable Blender version: 2.7x/2.8x
This is where you do the animating.
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195. Create a Walk Cycle
i Information
Applicable Blender version: 2.7x/2.8x
This is where you create the walk cycle.
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196. Working example: Piston, Rod and
Crank
i Information
Applicable Blender version: 2.42

196.1. Piston, Rod and Flywheel

Figure 1348 Image 1: Surprisingly diﬃcult: the animation of Piston [Kolben], Rod
[Pleuelstange] and Flywheel [Schwungrad

] A setup like that shown in Image 1 is e.g. typical for a steam engine. It is surprisingly
diﬃcult to animate this setup, because one has to translate a rotating movement (of the
Flywheel) to a horizontal movement (of the Piston). This alone wouldn't be too diﬃcult,
but the Rod has to stay attached to the Piston. The shown setup uses three empties and
two armatures, each with two bones.
The horizontal direction is the Y-direction, if this is diﬀerent in your model you have to
exchange Y with your horizontal direction.
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Working example: Piston, Rod and Crank

196.1.1. Setup
• Use Ctrl-A->Apply scale and rotation on all mechanical parts in object mode.
This will spare you from bad surprises if you rotate the ﬂywheel afterwards.
We need an object which follows the rotation of the ﬂywheel. We use an Empty, which is
parented to a Vertex.

Figure 1349

Image 2: Make vertex parent of an Empty.

• Change to edit mode of the ﬂywheel. Select a Vertex in the middle of the crank.
• Move the cursor to the Vertex (Shift-S->Cursor->Selection).
• Change to object mode and insert an Empty (ERotation).
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Piston, Rod and Flywheel
• Change back to edit mode of the ﬂywheel. The vertex is probably already selected, now
select with Ctrl-RMB the Empty and press Ctrl-P->Make vertex parent (Image 2).

Figure 1350

Image 3: The positions of the three Emptys.

We need two more Emptys:
• Place the second Empty (EGelenk) in the center of the joint between Rod and Piston.
• Place the third Empty (ESteuerung) near to the joint.
• Now select at ﬁrst EGelenk, than Shift-RMB ESteuerung and parent EGelenk to
ESteuerung with Ctrl-P.
We're going to insert two armatures, each with two bones. The ﬁrst armature, helps translate the rotation to a horizontal movement. The second armature drives the Piston and the
Rod. The cursor should be positioned at the Empty ERotation (like in Image 3), else set
it there.
• Add an armature (AHelfer). The root of the ﬁrst bone (BHelfer1) has the same position
as ERotation, the tip has to be positioned to the Empty EGelenk (select Empty ﬁrst,
Cursor->Selection, than select bonetip, Selection->Cursor).
• Extrude another small bone (BHelfer2) in horizontal direction.
BHelfer2 is automatically Child of BHelfer1. The second armature that is driving the movement of piston and rod will be inserted in the opposite direction, i.e. from right to left in
our example.
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Working example: Piston, Rod and Crank
•
•
•
•

Position the cursor on the piston.
Add an armature (AGestaenge).
Move the tip of the ﬁrst bone (BKolben) to EGelenk.
Extrude the ﬁrst bone and place the tip of the second bone (BPleuelstange) to ERotation.

Connecting the two bones will ensure that the rod cannot disconnect from the piston.

Figure 1351

Image 4: The alignment of the two armatures.

Now we're going to add the ”logic”.
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Piston, Rod and Flywheel

Figure 1352

Image 5: The constraint settings for BHelfer1.

• Add a Copy Location constraint to BHelfer1 which points to ERotation. To do this change
to the pose mode of the armature AHelfer and select BHelfer1. In the Constraints panel
click Add Constraint->Copy Location and type ERotation into the Ob: ﬁeld.
• BHelfer1 needs a second constraint: Track To to EGelenk (Image 5).
Now the root of the bone BHelfer1 follows the rotation of the Flywheel. Its tip follows the
joint, but with slight deviations upwards and downwards. The position of BHelfer2 governs
the horizontal position of the Piston. We just have to ”extract” the horizontal position, for
that we're going to use a CopyLocation constraint, but only in Y-direction. There is no
oﬀset for a copy location constraint - else we could have done with one empty less.

1599

Working example: Piston, Rod and Crank

Figure 1353

Image 6: Constraints of ESteuerung.

• ESteuerung gets a CopyLocation constraint in Y-direction to AHelfer->BHelfer2. You
have to inactivate X and Z (Image 6).
• Make ESteuerung the parent of AGestaenge.
The armature AGestaenge gets its horizontal movement from BHelfer2 via ESteuerung.
Nearly ﬁnished:
• Give BPleuelstange a Track To constraint to ERotation.
• Parent the piston and the rod (the meshobjects) to their bones.
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Piston, Rod and Flywheel

196.1.2. Overview about the relations between armature bones and
objects

Figure 1354 Image 7: Parent-Child Relations are drawn with slim arrows, Copy
Location Constraints are drawn with thick black arrows, Track To Constraints are drawn
with thick blue arrows.
•
•
•
•
•
•
•

Schwungrad is vertex parent of ERotation.
BHelfer1 has a Copy Location X/Y/Z constraint to ERotation.
BHelfer1 has a Track To Constraint to EGelenk.
ESteuerung has a Copy Location Y constraint to BHelfer2.
ESteuerung is parent of AGestaenge.
ESteuerung is parent of EGelenk.
BPleuelstange has a Track To constraint to ERotation.
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Working example: Piston, Rod and Crank
• BKolben is parent of Kolben.
• BPleuelstange is parent of Pleuelstange.
The Parent-Child relations between the bones are inserted automatically through extruding,
you have to insert the other relations yourself.

196.1.3. Finishing Touches
• Animate the rotation of the ﬂywheel.
The driving object is the ﬂywheel, all the other movements are synchronized with its rotation.
If you've done everything right, your animation should look like in Image 8.

Figure 1355
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Image 8: Our working Piston, Rod and Flywheel animation.

Links

196.2. Links
The German original of this tutorial (same author)1
Another method using constraint system2

1
2

https://en.wikibooks.org/wiki/%3Ade%3ABlender%203D%2F%20Tutorials%2F%20Armatures%2F%
20Kolben%20und%20Zylinder
http://blenderartists.org/forum/showthread.php?t=140734
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197. Working example: Cutting Through
Steel
i Information
Applicable Blender version: 2.48

Figure 1356

Figure 1: Cutting out a logo, the result of this tutorial
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Working example: Cutting Through Steel
In order to simulate a laser beam which is cutting through a steel plate, we have in Blender
(at least) two possibilities:
1. an animated Mesh with many Shapekeys
2. an animated texture
The latter method is considerably easier to implement and the result is nevertheless convincing enough. We will proceed as follows:
• You need an animated alpha mask for the points at which the metal is changed. For this
use a text object as a path. A cube follows the path and emits a particle system. The
results are rendered as animation and the images stored.
• Then load these pictures and use them as an animated texture on a plane.
• With a second particle system the sparks are simulated.
• With a third particle system we simulate the annealing of the weld. Again, this sequence
is used as an animated texture.
• Smoke is created with a fourth particle system.
The result is shown in Fig. 1.
This guide is based on the well-known tutorial Cutting Through Steel1 , but remade with
the current Blender particle system and with constraints. You need to have basic knowledge
of Blender.

1
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http://www.blendernation.com/tutorials/blender-3d-intermediate-tutorial-cutting-through-steel/

Creating the Alpha-Map

197.1. Creating the Alpha-Map

Figure 1357

Figure 2a: Setup of curve, emitter and camera in the 3D window.

• Start Blender. Save your ﬁle. Delete the cube.
We should save the ﬁle right at the beginning, because we will save the animated textures
in subdirectorys to the current directory. Particle caches are also created as subdirectorys.
• Set the End value to 150 in the Anim panel of the Render buttons. This allows you to
specify the total length of the animation.
• In the Output panel use ”//AlphaMap/” as output directory. When we render the animation the images are than saved in the subdirectory ”AlphaMap” to the current directory.
The animated alpha map consists of gray-scale images whose luminance information is used
to calculate the mask. Bright pixels produce transparency, dark pixels remain opaque.
• Use PNG as output format. This avoids compression artifacts wich occur with the JPEG
format.
I've left the resolution at 800x600, but you need to set your desired resolution here.
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Working example: Cutting Through Steel
• Create the shape you want to cut out as Curve object, or use a text object and convert
this to a curve. I've done the latter, I've used a text-object (a ”W”), and converted this
to a Curve object (Object-> Convert Object Type ...-> Curve).
• With the function Center in the Curve and Surface panel I've brought the object in the
middle of the 3D-coordinate space.
• The ﬁlling of the object is not needed here, therefore activate the option 3D for the curve
object, even though the object should remain two-dimensional.
Now we need again a cube. The cube will follow the curve. It's particle system will create
a glowing trail, that is later used as alpha map.

Figure 1358

•
•
•
•
•

Figure 2b: particle system of the cube.

Insert a cube.
Scale the cube as small as the track of the laser beam (the welder) shall become.
Select the cube, than also select the curve object with Shift-RMB.
Ctrl-P->Path Constraint creates a Follow Path constraint.
Select only the cube and activate the option CurveFollow in the Constraints panel in the
Object buttons.

If you press Alt-A now and let run the animation, the cube will follow the shape of the
curve object, but not necessarily in the desired direction and not from the desired location.
So some work needs to be done:
• Change to the Edit mode of the curve object.
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Creating the Alpha-Map
• Curve->Toggle Cyclic opens the curve object, by adding (Subdivide) of one or more control
points you achieve the desired movement. W->Switch Direction reverses the direction of
the motion of the cube.
By adding a Time Ipocurve to the curve you could set the duration and speed of the
animation, but I've left the preset duration of 100 Frames. The last 50 Frames the path
will glow a bit and the smoke will vanish.
• Add a particle system to the cube, call this Alpha.
• Set the particle lifetime to 150 (or higher) (Fig. 2b). The particles will live the entire
length of the animation.
• Bake the particle animation.
• The cube gets a material:
• Halo
• RGB 1/1/1, that is completely white
• XAlpha
• HaloSize: 0.03
• Hardness: 40
I want to achieve with these settings, that we will get a grayscale image, that is completely
white where the material shall become transparent. We don't need partial transparency,
since a relatively sharp cutting edge shall be created. Slight irregularities in the periphery
are wanted.

Figure 1359 Figure 2c: A
frame of the AlphaMap.

To render the animation, the camera is centered directly over the object.
• View->Top
• Strg-Alt-Num0 sets the camera to the current view. Select the camera.
• With the Transform Properties panel in the 3D-window (Object->Transform Properties)
set the coordinates of the camera exactly vertically above the center of the 3D window
(X/Y=0).
• In the Editing buttons of the camera set the option Orthographic in theCamera panel.
Scale the size of the animation with the Scale value.
• The world color to black in the World buttons.
• Render the animation.
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Working example: Cutting Through Steel
Blender now generates an image sequence from 1 to 150 in the subfolder AlphaMap (Fig.
2c).

197.2. Welding sparks

Figure 1360

Figure 3a: Adding a new Scene

Now we'll create a new scene, in which the diﬀerent eﬀects are joined.
• Rename your current scene to AlphaMap.
• Create a new scene as FullCopy (Img. 3a). Name this new scene Cutter.
The welding sparks are created using a particle system.
• Add a UVSphere with 16 segments and 16 rings.
• Delete the lower half of the sphere in Edit Mode and scale it to approximately the same
size as the cube.
• Switch to Object Mode.
• Select the cube in addition to the sphere. Copy the Follow-Path-Constraint from the
cube to the sphere.
Note that you copy attributes from the active to the selected objects. The active object is
the one you've selected last
Noob Note: Using Blender 2.65, the easiest way I found to do this was to use the '3D
View: Copy Attributes Menu' addon. (To enable the addon press Ctrl+Alt+U to bring up
User Preferences, click the 'Addons' tab, type 'copy' into the search box, located at the top
left of the tab, and put a check in the box to the right of the addon that's found, '3D View:
Copy Attributes Menu'.) First RMB click the sphere, then Shift+RMB click the cube, the
one with the follow path constraint. With the 2 selected press Ctrl+C and choose 'copy
object constraints' from the popup menu. If the sphere gets oﬀset in the process, just move
it manually to the position of the cube or the ﬁrst waypoint on the path.
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Using the alpha map on an object

Figure 1361

Figure 3b: The particle system for the sparks.

• Create a particle system for the sphere.
• Name Sparks
• Amount: 4200
• Life: 5
• Emit From: Random/Verts
• Normal: 0.757
• Random: 0.397
• Rotation Random: 0.116
• AccZ: -1.37
Except for the lifetime the values are relatively arbitrary, I have just experimented with the
values until I was halfway satisﬁed with the results. The sparks have a slight acceleration
in negative Z direction to sink down.
• Visualization:
• Line (which corresponds as much as possible to the setting Vect in the particle system
before 2.46)
• Speed
• Back: 0.04
• Front: 0.0
You achieve a long spark with these settings.
• Bake the particles. Change to the Bake panel and click on the Bake button. The particle
animation is now permanently saved.
The Bake end value is also the ﬁnal value for the normal particle animation, even if you
don't bake. If you need more than 250 frames, you need to increase this value.

197.3. Using the alpha map on an object
The alpha map is now used as texture on a plane. Therefore we have to position the
texture exactly like the previously rendered animation, so that the sparks run in sync with
the blending out of the plane.
• Add a new plane to your scene (Add->Mesh->Plane).
• Scale the plane at about twice it's size - as big as you need it for the ﬁnal shot.
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Working example: Cutting Through Steel
The main problem is now to ﬁt the texture exactly to the plane. We will give the plane UV
coordinates, than ﬁt the plane to the ratio of the texture and ﬁnally adjust the position in
the 3D window with UV coordinates.

Figure 1362

•
•
•
•
•

Figure 4a: Setting the Draw Type

Switch to Draw Type Textured (Fig. 4a).
Split the 3D window, and open in one part the UV/Image Editor.
Switch to edit mode of the plane.
Unwrap the plane ((Mesh->UV Unwrap).
Load an image of the alpha map in the image editor (not the ﬁrst one, so you can see the
course of the map).

Normally the texture is not orientated the way I would like it to be.
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Using the alpha map on an object
• Click the padlock icon in the toolbar of the UV/Image Editor (Update other windows in
real time).
• Rotate the UV vertices in the UV/Image Editor until the texture ﬁts (e.g., while holding
the Ctrl key)
• Switch to object mode.

Figure 1363

Figure 4b: Material settings for the plane

• Add a new material to the plane and name it Rust.
• Select the ﬁfth texture slot and add a new texture. Name it AlphaMap with the parameters:
• Map Input: UV
• Map To:
• Alpha
• Spec
• Nor
• NoRGB
• DVar: 0
With these (Fig. 4b) settings we achieve, that the white pixels in the texture set the Alpha
and the Spec value to zero (DVar). Because the texture delivers RGB colors we have to
activate NoRGB, because we need intensity values. We don't need RayTransp, because the
world background is black anyway. We can't use ZTransp, because Halos are not rendered
in front of materials with ZTransp (probably a bug in Version 2.48a). With Nor we get a
3D eﬀect.

Figure 1364

Figure 4c: Texture settings for the animated alpha map

• Switch to the Texture buttons.
• Type: Image Texture
• Load the ﬁrst image of the alpha map sequence.
• Image: Sequence
• Frames: 150
• Map Image: Extend (Fig. 4c)
Now we adjust the UV coordinates.
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Working example: Cutting Through Steel
• Object->Transform->Scale to Image Aspect Ratio. This scales the ratio of the plane
automatically to the aspect ratio of the image texture.
• Change to a frame where you can judge the particle animation and it's ﬁtting to the
texture.
• Switch to edit mode. Scale the UV coordinates in the UV editor until the texture ﬁts to
the particles.
• Switch back to object mode.

197.4. Material for the plane

Figure 1365

Figure 5: Material for the plane

We will now give the plane a better material. To judge the material we will ﬁrst re-focus
the camera, give it a texture and make some material settings. If you already have a good
metal material, you can use this of course directly and use the Alpha texture from above
on your existing material.
•
•
•
•

Select the camera.
Turn Orthographic in the Camera buttons oﬀ.
Position the camera as desired.
Select the plane.
• I've used the rust texture that is linked at the bottom of the page as image texture.
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Material for the plane
• Map Input: Orco, SizeX/Y each 0.5. The size change is to use a larger part of the
texture on the ﬁnal image. But this depends on the size of the camera and the
texture.
• Map To: Col/Nor
• In the second texture slot I've mapped a Stucci texture to Spec.
• This abridged sentence means: select the texture slot. Set Map To to Spec. Deselect
Col. Change to the Texture buttons. Select Texture type Stucci.
• The Specularity is thus determined by a texture. The spec value is increased by the
texture (DVar=1). Therefore you have to set the Specularity in the Shaders panel to
the smallest value the material shall have (e.g. 0.08).
If you have done a test render, you'll see that the particle track of the cube is still there.
• We don't need the cube anymore, you may delete it. In the Scene Cutter we use the
already generated AlphaMap.
Texture with OSA (Antialiasing) are somewhat blurred, for our purpose we use
CatRom instead of the default Gauss method.
• Set in the Render panel CatRom as AntiAliasing ﬁlter.
We need a new output directory for the animation, to not overwrite the AlphaMap we've
created earlier.
• Set the output directory to ”//Render/” in the Output panel.
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197.5. Lighting the torch

Figure 1366

Figure 6: Ipo curve for the energy of the lamp

The torch itself shall cast light, therefore we parent a Lamp to the Sphere and animate the
energy of the lamp.
•
•
•
•
•
•
•

Change to frame 1.
Select the Sphere.
Place the 3D cursor on the Sphere. Object->Snap->Cursor to Selection
Add->Lamp->Lamp
Select the lamp in addition to the Sphere.
Object->Parent->Make Parent->OK
Select the lamp and move it a bit up (i.e. in positive z-direction). The lighting shall
emit from the sparks, not from the hole.

I ﬁnd it cumbersome to animate the energy of the lamp by setting ipo-keys in the lamp
buttons. Instead I do it directly in the 3D window.
•
•
•
•

Change to the Ipo Curve Editor in one of the open windows.
Change the ipo type to Lamp.
Activate the Energy channel with LMB click in the ipo window.
By holding Ctrl key pressed, you create by left-clicking in the ipo window the points of
the ipo curve.
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More realistic sparks
These values may be larger than 1. However, the last maximum value should be reached in
frame 100, and decrease signiﬁcantly to frame 105. The sparks are only issued up to frame
100, and live up to the 105th frame. After that the metal is glowing a bit.
Your result may look somewhat like mine in Fig. 6. If the amplitude of the curve is not
large enough, you can scale the ipo curve at the y-axis.

197.6. More realistic sparks

Figure 1367

Figure 7: Better sparks

You may animate the material for Line visualization during the lifetime of each individual
particle if you use Halo for the material, so you could change the sparks color from white
to red.
We will show this in the next step, but conﬁne ourself here to make a better, not animated
material (Fig. 7).
•
•
•
•
•

Add a material to the Sphere, name it Sparks.
Activate Halo in the Links and Pipelines panel.
Set the RGB color for Halo to white.
Activate Lines/X Alpha/Shaded in the Shaders panel.
Halo Size: 0.1
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• Add: 0.8

197.7. Smoke

Figure 1368

Figure 8a: Sparks and Smoke

Now were going to create an individual material animation for every particle during its own
lifetime.
We will use particles with a simple texture and animate the alpha value of the material.
We're going to duplicate the Sphere and give it a new particle system.
• Duplicate the Sphere with Object->Duplicate.
Path constraint.
• Remove the Sparks system from the new Sphere.
• Create a new particle system. Name it Smoke.
• Amount: 300
• Emit from: Random/Verts
• Initial velocity:
• Object: 0.02
• Normal: 0.1
• Random: 0.01
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The new sphere already bears the

Smoke
• AccZ: 0.05
• Bake this particle system.
•
•
•
•
•
•

Change to the Material buttons.
Create a new material and call it Smoke.
Alpha: 0.034. This is the basic visibility for the smoke texture.
Add an ipo key for Alpha in frame 1.
Change to frame 100.
Set Alpha to 0.0 and add the second ipo key.

Now the smoke will disappear within the lifetime of each particle, independently of the
lifetime of the particle.
• Halo
• Halo Size: 0.224
• Hard: 12
• Add: 0.014
• Halo Tex This is the crucial setting to use a texture for the shape of the halo.
• X Alpha
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Figure 1369

Figure 8b: Particle texture

• Create a new texture, you may also call it Smoke.
• Texture Type: Image
• Load an image with random, smoke-like structures, like that from Fig. 8b.
If the fading goes to quickly, or the texture is to transparent / opaque, change the animation
of the Alpha value.
You see, even though we use only a few objects and materials, it is extremly helpful if we
designate meaningfull names to the objects, materials, textures etc.
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197.8. After Glow
Now at last we will create another animated texture, that shall simulate the annealing of
the steel plate after it is being cut through.

Figure 1370
Glow-Map

•
•
•
•

Figure 9a: A Frame of the

Change to the scene AlphaMap.
Add a new scene again as a Full Copy.
Name this scene Glow.
Enter the output directory ”//Glow/” in the Output-Panel of the Render buttons.

The texture shall have nice semi transparencies.
• Therefore we select a diﬀerent output format in the Format panel, namely RGBA (RGB
with Alpha).
• Selecting Premul in the Render panel the world background will become fully transparent,
and the particle trace semi transparent.
We use the existing particle system, but change it's material settings.
• Call the material of the cube Glow.
• Increase the HaloSize to 0.04. Our new texture has to be larger than the cutout of the
plane, else it will not be visible.
Now we're going to animate the material of the halos. Again this works only because we
have Point visualization of the particles.
•
•
•
•
•
•

Change to frame 1.
Set an IPO key for the RGB color (here white).
Go to 3rd Frame.
Change the Halo color to 1/1/0.42 (light yellow). Set the next IPO key.
Go to 6th Frame. Change the Halo color to 1/0/0 (red). Set the next IPO key.
Go to 11th Frame. Change the Halo color to 0/0/0 (black). Set the next IPO key.

The particle trace will fade out during 11 frames.
• Render the animation.
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Figure 1371

Figure 9b: A ﬁnished frame of the animation.

• Go back to the scene Cutter.
• Select the plane.
• Load the newly created texture in the third texture slot as an animated image texture.
• Add New. Name the texture Glow.
• Map Input: UV
• Map To: Col/Emit
We need the alpha values in the image for changing the emit value. Also the alpha blends
the glow texture nicely with the plane texture.
• Texture Type: Image
• Select the ﬁrst image from the subdirectory Glow.
• Activate Sequence.
• Frames: 150
• Extend
The settings for the texture are identical with those of the texture AlphaMap (Fig. 4c),
except of course for the directory in which the images reside.
In Fig. 9b, see a ﬁnished frame of the animation. For the video in Fig. 1 I've changed
the animation a bit, scaled the emitter objects a bit smaller, changed the sparks Color and
used a diﬀerent camera perspective.
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Suggestions, critics and approval please write on the commentary page of this article. If
you ﬁnd some obvious mistakes you may correct the article directly of course.

•

Figure 1372

Rust Texture

1623

198. Overview
This set of tutorials is for Blender users who stumble up on the basics of certain games,
such as making a HUD, menu, or even a simple button. This is also a place where users
who know cool ways to spice a game up or explain troublesome aspects of making certain
parts of a game genre's content work (like how to get Blender to calculate the damage of a
bullet shooting).
There are a couple subsections to this. One is for those who don't like the messiness of
python. Learning python to the point of being able to create a game with it will take months,
maybe years, just to learn it, not to mention how long it would take to type the speciﬁc
code and troubleshoot. So, the ﬁrst section is for those who are much more comfortable
with using the GUI Blender screen to make the majority of their game, and the tutorials
exist to help them enhance their game.
Note: No matter how much GUI you'd like to use in game creation, there is a
certain amount of python you will HAVE to use to be able to really make your
game good. Make sure to at least read up on it. Sorry.
Jump to Game Creating Techniques within a GUI1
Then there is the second subsection. This section is to help those who are comfortable with
python learn how to use the code in ways they never thought of, and to show those who
don't do so well with it just what python can do. While it's a simple language, it can still
be incredibly complicated at times, and very, very picky.
Note: DO NOT SUBMIT ANY CODE YOU DO NOT WANT COPIED A
MILLION TIMES! This section is for helping the broad and the narrow range
of Blender users to learn how to use python better, and there will be no expectation of attribution for submitting code you found out yourself.
Jump to Game Creating Techniques with Python2

1
2

https://en.wikibooks.org/wiki/%2FGame%20Creating%20Techniques%28GUI%29
https://en.wikibooks.org/wiki/%2FGame%20Creating%20Techniques%28Python%29
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199. Advanced Game Engine Techniques
(GUI)
199.1. Making Blender Games Graphically
If you're reading this section, I'm guessing that you have either made a game before or at
least are in the process of making one right now. Let's face it: It's probably much harder
than you imagined it. A large amount of people take video games and the work put into
them for granted. And there are probably quite a few times in which you wanted to do
something so simple—such as a menu or even a button—but didn't even know where to
start or what to do.
This is why this section exists.
The next few pages will all be tutorials with diﬀerent techniques on how to make objects
in Blender move and respond to things like your mouse, keyboard (a.k.a. ”HotKeys”) and
making it all look like what a real game does. They will be simple versions of a menu, or
a button, in which you can use this and put it into your own idea with your own graphics
and your own little tweaks.
There will be a certain amount of Python necessary in the next few tutorials, mainly just
to allow the mouse icon to appear on screen. However, you can do the rest of the tutorials
in the 3D View Window, and under the Logic Index in the Tab window.
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200. Creating Pop-Up Menus
i Information
Applicable Blender version: 2.42
In this tutorial, we will be making a Title Screen and a Main Menu Screen to come from
that Title Screen. While most people hardly pay attention to these areas on a real video
game, they do make the game seem much better to play, and gives the player a certain
choice of what they can do before they play the game. Before beginning this, make sure you
familiarize yourself with several logic sensors and actuators, such as ”Scene” and ”Property”,
as they will heavily be relied upon. It is also best if you have several Pictures ready to
use for your game or are ready for additional functions with certain programs (a Word
Processor Program and Image Editing Program [that has a transparency setting] can help
move along your game.)

200.1. Making An Easy Title Menu
The Title Screen will be very simple -- it will be the ”Press Enter to Continue” kind. This will
lead to a more interactive kind of Main Menu, in which you can use either key commands or
the mouse pointer. This tutorial will not be the most visually pleasing, but then again, you
can always add whatever graphics you would like. Again, it would be wise to have handy
a word-processing program and a program like Microsoft Paint. ”Print Screen” will be a
useful function to use while following this tutorial -- the corresponding button is generally
located to the right of the F12 key in the row of function keys on your keyboard.
If you have never used diﬀerent scenes before, you're about to get a crash
course. Also, Blender hotkeys and actions will not be explained with (A-key)
or (numpad-6); it is assumed you have already learned at least how to perform
basic Blender functions.

200.1.1. Making the Menu
First, start up Blender and delete everything in the scene. Then, move to top orthographic
view (press numpad 7, or if you have not a numpad, go to the hidden top menu and in the
System & OpenGL section select ”emulate numpad”).
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Figure 1373

The ﬁrst thing you should do is add a new scene. In the Information view panel at the top,
click the SCE: drop-down menu and click on ADD NEW. Label this new scene something
like ”Main Menu”. Now go back to your original scene and name it something like ”Title
Menu”. These names will be important when it comes to changing the scenes around. So, on
your ”Title Menu” Scene, begin by adding a Camera. Move this Camera in the Z direction
about a point, just to get it above the grid. Now, set the camera view to Orthographic.
Now switch to Camera View. Add a plane that is scaled to cover the entire surface of the
Camera's view-bounds. Move that plane just a little bit in the -Z direction. Then, add
another plane, but scale this plane to be a thin rectangle about 2/3rds down the Y-length
of the Camera, centered in X-direction.

Figure 1374

(Image Shown with Materials for visual purposes, DON'T ADD MATERIALS)

Now this next step isn't necessary, but if you want a good-looking game you will probably
need this step.
Let's add some UV textures. Open a good photo/image-editing program like Photoshop,
GIMP, or Microsoft Photo Editor; something that preferably supports Transparency. Type
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some text appropriate for your game such as, ”Press any key to continue.” What I do is
add lots of extra space and add additional text that I will use in the main menu too, such
as ”New Game”, ”Continue”, ”Story Mode”, etc. so it is all in one image for multiple UV
textures. If your editor supports it, set the background color to transparent. If not, set it to
black so it will register as 0 on the alpha channel in Blender. Save the image (GIF or PNG
are reasonable choices for use with transparency). Now, in Blender, split the 3D screen into
2 screens, and change one screen over to UV face select. Select your small rectangle, and
switch to Edit Mode and Unwrap the face in the 3D window, then open your saved image
in the UV face window. Scale your face in the UV window so it holds only the ”Press Any
Key to Continue” graphic. If you wish, also add a starting Image on the larger rectangle.

200.1.2. Setting Up The Actions
Now this step is necessary. Select the large background rectangle, in the Buttons Window
at the bottom switch it to the Logic Tab. This will be very simple. Add one Sensor, one
Actuator, and one Controller. Make the sensor a Keyboard Sensor, depress the ”True Pulse”
button, and in the key area depress the ”All Keys” button. Make the Controller an ”AND”
controller. Make the Actuator a Scene Actuator. Select the Drop-Down box and make it
”Set Scene” wit ”SCE:Main Menu”. Before you test the game, make sure to save
and add a Camera to the ”Main Menu” Scene. Otherwise the game WILL crash.
If you want the option of returning to this scene, instead of one Actuator make two. Make
both of them Scene, but make one ”Suspend Scene” with ”SCE:Title Menu” and make the
other Actuator ”Add Overlay Scene” with ”SCE:Main Menu”. Also, that means in the Main
Menu Scene later you'll have to add some key to hit or some action to ”Remove Scene”
”SCE:Main Menu” and ”Resume Scene” ”SCE:Title Menu”.

200.2. Author's Starting Menu Example
The following contains actual in-progress work by the original Author of this page. The work
and ideas are heavily copyrighted and it is highly encouraged (begged) that you do not rip
this content oﬀ--the author has submitted this work generously to help less advanced users
more eﬃciently.
The following is my work on a game I am making, and I hope it helps you too.
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Figure 1375

This will get you to the next menu, which will be on the next section.

200.3. A Main Menu
This menu will be more diﬃcult,using a mouse-python function to use and make the mouse
appear when you play your game and a maze of sensors and actuators entangled.
Here is the ﬁrst thing you need: a python script to make the Mouse show --*This code is attributed to the author of the chapter ”Blender Game Engine/A Simple Mouse
Pointer” and this is not my own code.
import Rasterizer as r
r.showMouse(1)
Put this in the text editor, and save the text as something simple like ”Mouse”. Now, on
your Main Menu scene, select the camera and add 1 sensor, 2 controllers, 1 actuator, and
1 property. Name the property ”Switch” ”Int” Type, and set it to 0. Set up your logic as
follows:
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A Main Menu

Figure 1376

A change will need to be made in order to make yours work. The python controller should
be Script:Mouse, not Script:showpointer. If you can't see the connections:
• Connect the Sensor to the 2 controllers
• Connect the AND controller to the actuator
• Leave the Python controller open-ended
If you play the game, you will see the mouse then! Now, back to the Menu, there are
multiple kinds of Menus you can make when it comes to Menus popping up. The one I
believe works best is a 3-layered button. To explain what this means, I'll run you through
the steps of making one. Let's start with the layers themselves. (For this to work best,
make the background of any images you use have transparency, so you can make invisibleyet-clickable faces.) Create a rectangle facing the camera where you want your ﬁrst menu
option to be. Copy the object until you have 3 rectangles, and make each one very slightly
in front of the last. Now, Select the back rectangle, and on this one apply the UV face
of the option's words. The second rectangle is the UV face for a graphic outline around
the words if the option is selected in the game. It's not necessary but then again, it helps
the player with selecting options and it looks nice. The top rectangle will be the selectable
one--make the UV face applied only over a completely transparent area. Now, for the logic.
Text-Rectangle:
-No Logic Needed
Outline-Rectangle:
-Give it a Property named ”Selected”, Int Type, starting at 0.
-Make a Property Sensor, True Pulse, ”Selected” Property is Equal to 1, Connected to an
AND controller, Connected to a Visibility Actuator at ”Visible”
-Make a Property Sensor, True Pulse, ”Selected” Property is Equal to 0, Connected to an
AND controller, Connected to a Visibility Actuator at ”Invisible”
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-Make a Property Actuator, ”Selected” Property is Assigned Amount 1 -Make a Property
Actuator, ”Selected” Property is Assigned Amount 0 -Create AND Controller and connect
both Mouse Sensors. Make this AND Controller connect to the Outline-Rectangle's
Property Actuator ”Selected” Assign=1.
Transparent-Rectangle:
-2 Mouse sensors: ”Mouse Over” and ”Left Button”. Set them to ”True Pulse”.
(Click Image to Enlarge)

Figure 1377

Now here is the trickier part to explain. To make things a little more simple, name that last
Outline-Rectangle's AND controller connected to the 2 mouse sensors. Select all 3 layers,
and duplicate them 3 times. Make each one (in camera view) below the last, making sure
to keep them parallel on the Z axis. Now, to make only one selected at a time, take the
named controller of the ﬁrst, and connect it to the Outline-Rectangle's Property Actuator
”Selected” Assign=0 of second and third button. Do the same from the second button to
the ﬁrst and third one, and same with the third to the ﬁrst and second. It should look like
the picture:
Click Image to Enlarge
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Figure 1378

This logic arraignment should yield (when the game is played) options in which if you click
one it will light up, and if you click another, that one will go down and the other will light
up.
Now this looks nice aesthetically, but the use of it is now all you have to do is make
some Scene Actuators. Add 2 more actuators to each of the Transparent Planes. Use
the same method as you did with the Properties, but instead of ”Property Assign 1/0”
make 1 AND controller, 1 Scene Overlay and 1 Scene Remove for each transparent
button. Now make 3 additional Scenes, and either make an entirely new menu for each,
or to be easier just make colored rectangles on the scene, diﬀerent colors for each scene
-- either way, make sure that, if the scenes overlay, the additional scene won't cover
up the buttons of the Main Menu Scene. So, now connect the 2 Mouse Sensors to the
corresponding AND Controller, and connect that to the Corresponding ”Overlay Scene”
Actuator and 2 Opposing ”Remove Scene” Actuators. Do this with the other 2 Transparent
Rectangles. Make sure your new scenes also have cameras and that they are scaled properly.
Click Image to Enlarge
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Figure 1379

You can use this technique to make Menus and Sub-Menus Galore! It's fairly simple to
make multiple sublevels of this and get back to the original scene with this method.
I hope this helped you make your menus work well.
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201. Creating Dropping Menus
i Information
Applicable Blender version: 2.42
In this section, you are going to learn a variety of ways to make menus with motions. These
menus can be used in more ways than the simple pop-Up menus, such as in-game if you
need to select something you can use this to bring up a menu smoothly. In this section
there is heavy use of Properties, ”Property” Logic Blocks, and especially IPO usage. When
you do it once, it will be very much easier to do it again.

201.1. Making Moving Selectors
To kick this tutorial oﬀ, let's just do a simple icon that will be next to the selected menu
item. There will be 6 possible menu items, which can be controlled with both the arrow
keys and the mouse. Let's begin by booting up Blender, and deleting everything--then
adding a camera.

Figure 1380

Set this camera to orthographic. Now I like making things look nice, but here are the basics
of what you will need for this tutorial:
• Make 6 Planes, all diﬀerent objects, and put them in a vertical list.
• Make a circle next to the ﬁrst plane. This will act as the Selector.
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So after you've made you objects, it should look similar to this:

Figure 1381

For me, I made mine look more like this, a little more detailed:

Figure 1382

So now that we have our menu set up, it's time to set up the properties that will tell the
selector how to move. Select the selector that will be moving and give it a property name
”Selection”. Make it ”Int” type, and start it out at ”1”. To get this selector to move the
way we want it, we have to set up its movements. Make sure you are on frame 1, and put
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the cursor on the ﬁrst menu item, then Insert Keyframe for ”Loc”. Next, move to frame 2,
and put the cursor on the second menu item, then insert ”Loc” Keyframe, and continue in
this fashion for all your menu items. To get this applied in the Game Engine, in the logic
bricks, add an ”Always” Sensor (True Pulse Enabled), connected to an ”AND” connector,
and connected to a ”IPO” Actuator, set to ”Property” with Prop:Selection. Now we can do
3 things with this selector to have it move like a selector in a video game:
Up/Down Arrow Keys
To make the up and down arrow keys work properly, Select the Selector and add four
sensors, controllers, and actuators. Make two sensors keyboard, with one set to ”Uparrow”
and one set to ”Downarrow” (do not activate pulse triggering). Make the other two sensors
Property Sensors, with True Pulse. For the ﬁrst, make it ”Equal”, Prop:Selection, Value:0.
For the other, make it ”Equal”, Prop:Selection, Value:7. For the Actuators, make all four
”Property” sensors. For two of them, make them ”Add”, Prop:Selection, and make the ﬁrst
”Value:-1” and the second ”Value:1”. The other two should be ”Assign”, Prop:Selection,
with the ﬁrst at ”Value:1” and the next as ”Value:6”. Now connect them as follows:
Click To Enlarge Image

Figure 1383

”Keyboard:Uparrow”--”AND”--”Prop:Selection/Add/Value:-1”
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”Keyboard:Downarrow”--”AND”--”Prop:Selection/Add/Value:1”
”Prop:Selection/Equal/7”--”AND”--”Prop:Selection/Assign/Value:1”
”Prop:Selection/Equal/0”--”AND”--”Prop:Selection/Assign/Value:6”
Now you can play your game, and the arrow keys should work just ﬁne!
HotKeys
If you don't know what a HotKey, it's a way to access menu items or action by pressing a
speciﬁed letter, instead of just clicking or arrow keys. This method will require a diﬀerent
step when you make your UV text textures, as you will need to somehow change one letter
(either the color or possibly underline) to let people know that that is a HotKey action.
The HotKey system is easy to set up right alongside the IPO/Selection property. In
each menu item, highlight or make special one unique letter in each menu item. Then,
with the selector selected, set up 6 keyboard logic sensors, each one for a diﬀerent letter.
Add 6 controllers, and 6 actuators as well. Make all the actuators ”Property”, ”Assign,
Prop:Selection, starting with Value:1 progressing to Value:6”
Mouse Selection
Our ﬁnal selection method we can add is the mouse scroll over. Set up the Mouse Sensor
to Scroll Over for all 6 invisible selection planes. Then, make the AND Controllers and
connect to your original set of ”Set Property” Actuators. that matches the Object's IPO
property number. It's fairly simple.
Make the Selection
The ﬁnal thing to do is, once the selections are set up, make another 8 sensors, 7 controllers,
6 and actuators. Now make the 7th one a keyboard sensor for the ENTER key, as most
people usually think they can start a game by pressing ENTER. The 8th Sensor is for
another Mouse Sensor for ”Left Click” so that if any of them is highlighted and you
Left-Click the mouse, then it will be equivalent to pressing the ENTER key. That may
be confusing as, unless you set up the dozen extra sensors, controllers, and actuators, you
don't need to scroll over the selection to pick it, so that 8th sensor is your choice whether
you want to add it. Connect the 7th and 8th sensor to the 7th controller. If you have the
8th sensor, make it an OR controller; otherwise, make the controller AND. As for the ﬁrst
6 sensors, they should be Property Sensors for ”Prop:Selection” ”Value:[1-6]”. Connect each
to their own separate controller. Now connect the 7th controller to all 6 Actuators, and
the ﬁrst 6 controllers connect to their own Actuator alongside the 7th. The Actuators can
be whatever you want them to: whatever the selection causes to happen when you select
the item selection.
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201.2. Make the Menu Move
So we created a selection-based moving icon on a menu, but what might happen if you
select that item and need a sub-menu in-game? You can't very well pause the game every
time (unless it's a pause menu). This is where making the menu itself move comes in very
handy. In this section, you will make an object clickable, and once clicked it will give out
a submenu, which in itself will be able to give out a submenu.
The IPOS
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202. The ”5-Layer” Button
i Information
Applicable Blender version: 2.7x/2.8x

202.1. The 5-Layer Button
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203. Creating Object Outlines
i Information
Applicable Blender version: 2.7x/2.8x

203.1. Creating Object Outlines
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204. Advanced Game Engine Techniques
(Python)
i Information
Applicable Blender version: 2.7x/2.8x

204.1. Game Creation Techniques (Python)
204.2. Additional Resources
• Blender 3D: Blending Into Python1
• GLSL Programming in Blender2

204.3. External Links
• http://www.theboomshelter.com/hss.html
• http://www.youtube.com/watch?v=7hbCEyvVYHI

1
2

https://en.wikibooks.org/wiki/Blender%203D%3A%20Blending%20Into%20Python
https://en.wikibooks.org/wiki/GLSL%20Programming%2FBlender
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205. Hacking Blender
i Information
Applicable Blender version: 2.68
Blender is an Open Source project. That doesn’t just mean you get to use it for free1 ,
you also get to see how it works, and you can even make your own changes and share them
with others.
Blender is also a large software project (well over a million lines of code), with a great
many active contributors over a lifespan of more than a decade, and it continues to be
developed at a rapid rate. This can make things somewhat intimidating for less-experienced
programmers.
This unit assumes you have some decent programming experience under your belt. Blender
is mainly programmed in the C2 , C++3 and Python4 programming languages. It can be
built using either the CMake5 or SCons6 build systems.

205.1. Getting the Blender Source Code
The oﬃcial Blender source is kept in Git7 repositories located at developer.blender.org.
There are actually several separate repositories:
•
•
•
•
•

1
2
3
4
5
6
7
8
9
10
11

blender-main8 — the main part of the Blender source, excluding most Python addons.
blender-addons9 — the Python addons included in the standard Blender distribution.
blender-addons-contrib10 — additional useful Python addons.
blender-translations11 — localized language translations for text messages.

https://en.wikipedia.org/wiki/Free%20software
https://en.wikipedia.org/wiki/C%20%28programming%20language%29
https://en.wikipedia.org/wiki/C%2B%2B
http://www.python.org/
http://www.cmake.org/
http://www.scons.org/
http://git-scm.com/
http://developer.blender.org/diffusion/B/
http://developer.blender.org/diffusion/BA/
http://developer.blender.org/diffusion/BAC/
http://developer.blender.org/diffusion/BT/
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• blender-tests12 — some interesting example .blend ﬁles used for testing and demonstrating
Blender functionality.
• blender-dev-tools13 — tools that are useful for performing maintenance tasks on the
Blender source, but are not actually needed for building Blender.
• blender-cloud14 — looks like a framework for oﬀering a new cloud-based Blender service.

205.2. Layout of the Blender Source
Say you’ve checked out a copy of the main Blender source tree. The top level looks like
this:

• https://developer.blender.org/diﬀusion/B/browse/master/build_ﬁles/build_ﬁles/
—
ﬁles used during the build process
• https://developer.blender.org/diﬀusion/B/browse/master/CMakeLists.txtCMakeLists.txt
— top-level control ﬁle for CMake
• https://developer.blender.org/diﬀusion/B/browse/master/COPYINGCOPYING
—
note about Blender licensing (GPLv2)
• https://developer.blender.org/diﬀusion/B/browse/master/doc/doc/ — documentation
ﬁles, among them:
• https://developer.blender.org/diﬀusion/B/browse/master/doc/blender_ﬁle_format/doc/blender_ﬁle_
— the format of .blend ﬁles
• https://developer.blender.org/diﬀusion/B/browse/master/doc/build_systems/doc/build_systems/
— how to build Blender, and hack the build system
• https://developer.blender.org/diﬀusion/B/browse/master/doc/manpage/doc/manpage/
— the man page
• https://developer.blender.org/diﬀusion/B/browse/master/extern/extern/
—
nonBlender-speciﬁc libraries, primarily developed elsewhere, included in the source
• https://developer.blender.org/diﬀusion/B/browse/master/GNUmakeﬁleGNUmakeﬁle —
simple build script for those who can’t be bothered to go through the CMake setup process
• https://developer.blender.org/diﬀusion/B/browse/master/intern/intern/ — libraries
which are non-Blender-speciﬁc but primarily developed here, also glue code for interfacing
to external libraries not included in the Blender source. Notable subdirectories:
• https://developer.blender.org/diﬀusion/B/browse/master/intern/bsp/intern/bsp/ —
Constructive Solid Geometry routines
• https://developer.blender.org/diﬀusion/B/browse/master/intern/cycles/intern/cycles/
— the Cycles renderer
• https://developer.blender.org/diﬀusion/B/browse/master/intern/elbeem/intern/elbeem/
— the ﬂuid simulator
• https://developer.blender.org/diﬀusion/B/browse/master/intern/ghost/intern/ghost/
— Blender’s platform-independent GUI (including platform-dependent implementations). See https://developer.blender.org/diﬀusion/B/browse/master/intern/ghost/GHOST_ISystem.h
for a more detailed description.

12
13
14
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• https://developer.blender.org/diﬀusion/B/browse/master/intern/guardedalloc/intern/guardedalloc/
— thread-safe memory management with consistency checking
• https://developer.blender.org/diﬀusion/B/browse/master/intern/iksolver/intern/iksolver/
— the Inverse Kinematics library
• https://developer.blender.org/diﬀusion/B/browse/master/intern/smoke/intern/smoke/
— the library for simulating smoke and ﬂames
• https://developer.blender.org/diﬀusion/B/browse/master/release/release/ — additional
ﬁles to be included in the Blender distribution, including GUI icons and fonts
• https://developer.blender.org/diﬀusion/B/browse/master/SConstructSConstruct
—
top-level control ﬁle for SCons
• https://developer.blender.org/diﬀusion/B/browse/master/source/source/ — the main
part of the Blender source, further divided (ignoring the CMakeLists.txt and SConscript
ﬁles which you will ﬁnd just about everywhere) into
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/source/blender/
— the bulk of the source, of which some useful parts are
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/blenlib/source/blender/blen
— low-level stuﬀ for ﬁle management, geometry algorithms, sorting and suchlike
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/blenkernel/source/blender/
— core Blender-speciﬁc code (no UI stuﬀ)
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/blenloader/source/blender/
— code for reading and writing .blend ﬁles
• https://developer.blender.org/diﬀusion/B/browse/master/source/blenderplayer/source/blenderplayer/
— some additional ﬁles for building the Blender Player executable
• https://developer.blender.org/diﬀusion/B/browse/master/source/creator/source/creator/
— the Blender mainline
• https://developer.blender.org/diﬀusion/B/browse/master/source/gameengine/source/gameengine/
— the Blender Game Engine
• https://developer.blender.org/diﬀusion/B/browse/master/source/icons/source/icons/
— some ﬁles speciﬁc to the Windows build
• https://developer.blender.org/diﬀusion/B/browse/master/source/tests/source/tests/
— some test scripts

205.2.1. Common Subdirectory Layout

Within many of the subdirectories in https://developer.blender.org/diﬀusion/B/browse/master/source/blende
and https://developer.blender.org/diﬀusion/B/browse/master/intern/intern/, you will see
the following pattern:
• A bunch of .h ﬁles in the directory, and
• an intern subdirectory.
The .h ﬁles deﬁne the functionality exported to other modules, while the intern subdirectory
contains the .c or .cpp ﬁles that actually implement the module. Sometimes the .h ﬁles are
put into an extern subdirectory instead of the upper directory level.
(And yes, these meanings of intern and extern are not the same as the meanings of intern
and extern at the top directory level.)
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205.3. Blender’s “Genetic Code”: “DNA” and “RNA”
You will ﬁnd references to “DNA” (or “SDNA”) and “RNA” throughout Blender’s source
code. The analogy to the terms from genetics is weak at best, but what they refer to is:

• “DNA” or “SDNA” (“structure” DNA?) is the system for mapping Blender’s inmemory data structures to the on-disk .blend ﬁle format. A .blend ﬁle is little
more than a memory dump, which makes it quick to write. However, the ﬁle
needs to be readable by Blender builds on machines with diﬀerent endianness15 , 32
versus 64-bit16 pointers, etc, not to mention future versions with diﬀerent capabilities. Thus, the saved .blend ﬁle includes a detailed description of the layout of all
the data structures saved in the ﬁle, and this description is stored in the “DNA1”
block at the end. This block is generated by the makesdna tool, which is built
and run automatically as part of the overall build process, so its output can be
included directly into the Blender executable. It parses all the .h ﬁles in the directory
https://developer.blender.org/diﬀusion/B/browse/master/source/blender/makesdna/source/blender/ma
so all data structures that could get saved into .blend ﬁles must be deﬁned here, and
they must be careful to use a limited subset of C that the parsing tool can handle.
• “RNA” deﬁnes the Python interface to Blender’s internal data structures and routine calls.
Here17 is Ton “Mr Blender” Roosendaal explaining DNA and RNA.

205.4. Special Globals: “G” and “U”

There is a frequently-referenced global variable named “G”, of type struct Global, declared in
https://developer.blender.org/diﬀusion/B/browse/master/source/blender/blenkernel/BKE_global.hsource
The variable is deﬁned in https://developer.blender.org/diﬀusion/B/browse/master/source/blender/blenker
This same ﬁle also deﬁnes the global “U”, of type struct UserDef, declared in
https://developer.blender.org/diﬀusion/B/browse/master/source/blender/makesdna/DNA_userdef_types.

205.5. Naming Conventions
Some (but not all) global symbols have preﬁxes on their names indicating (roughly) where
they come from. Here is a partial list.
Preﬁx
AUD_
BKE_
BLF_
BLI_
BLO_
15
16
17

1652

Meaning
audaspace sound library
lowest-level (non-UI) Blender operations
Font/text-handling
common library routines
loading/saving .blend ﬁles

Where Found
https://developer.blender.org/diﬀusion/B/browse/m
https://developer.blender.org/diﬀusion/B/browse/m

https://developer.blender.org/diﬀusion/B/browse/m
https://developer.blender.org/diﬀusion/B/browse/m
https://developer.blender.org/diﬀusion/B/browse/m

https://en.wikipedia.org/wiki/Endianness
https://en.wikipedia.org/wiki/64-bit
http://www.blendernation.com/2008/12/01/blender-dna-rna-and-backward-compatibility/

User-Interface Implementation
Preﬁx
COM_
CTX_

Meaning
compositor
handling of bContext objects

DNA_

include ﬁles containing all type
deﬁnitions that get saved into
.blend ﬁles
editor UI routines
Freestyle renderer
platform-independent UI layer
image-format handling
memory management
modiﬁers
node editor
platform-independent timing

ED_
FRS_
GHOST_
IMB_
MEM_
MOD_
NOD_
PIL_
RE_
RNA_
STR_
WM_

common renderer handling
Python interface
string routines
window management

Where Found
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mast
https://developer.blender.org/diﬀusion/B/browse/mas

https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mast
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas
https://developer.blender.org/diﬀusion/B/browse/mas

205.6. User-Interface Implementation
The UI code is structured into several layers. This code also handles ﬁnding of userpreference ﬁles and shared application data. Starting from the lowest, the layers are:

• https://developer.blender.org/diﬀusion/B/browse/master/intern/ghost/intern/ghost/
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/windowmanager/source/blender
(see https://developer.blender.org/diﬀusion/B/browse/master/source/blender/windowmanager/WM_type
for an overview)
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/editors/screen/source/blender/e
• https://developer.blender.org/diﬀusion/B/browse/master/source/blender/editors/interface/source/blender

205.7. See Also
• Building Blender18 — platform-speciﬁc instructions on the Blender Wiki
• Development resources19 at blender.org, including
• Architecture overview20
• Oﬃcial developer blog21
• Mailing lists22
18
19
20
21
22

http://wiki.blender.org/index.php/Dev:2.5/Doc/Building_Blender/
http://www.blender.org/development/
http://wiki.blender.org/index.php/Dev:Source/Architecture
http://code.blender.org/
http://lists.blender.org/mailman/listinfo/
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206. Introduction to Game Engine
Source
i Information
Applicable Blender version: 2.43
Mission Statement: The purpose of this section is to show a programmer how to make sense
of the blender game engine source code. It is not intended for those who cannot code in
C++. If you're one of the people who have a basic understanding, I'm being careful to use
keywords that if you google, should provide enough information to understand.
When you press P, several things are sent to the GE before anything can be done. What
might these be?
StartKetsjiShell(struct ScrArea *area,
char* scenename,
struct Main* maggie1,
struct SpaceIpo *sipo,
int always_use_expand_framing)

Blender uses a lot of structs and classes.
You need to have a working understanding of these as well as inheritance before we can move on.
For a refresher: http://www-numi.fnal.gov/offline_software/srt_public_context/
WebDocs/Companion/cxx_crib/inheritance.html

The SCA_IObject classhttps://developer.blender.org/diﬀusion/B/browse/master/source/gameengine/Ga
and https://developer.blender.org/diﬀusion/B/browse/master/source/gameengine/GameLogic/SCA_IObject
This class encapsulates a lot of other things, so we can start here and move downwards
to the things that it controls. First oﬀ it uses vectors to store all the diﬀerent Sensors,
Controllers and Actuators that are linked to the object. A vector is like an array, but it is
dynamic and has built in functions.
We will begin by examining how sensors are added.
typedef std::vector<SCA_ISensor *> SCA_SensorList;
SCA_SensorList m_sensors;
The ﬁrst line here is a typedef so it just tells us that we can create a vector of SCA_ISensor
by using the name SCA_Sensor list.
The second line creates the vector with the name, m_sensors
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void SCA_IObject::AddSensor(SCA_ISensor* act)<br />
{
m_sensors.push_back(act);
}

This function allows the parents of an SCA_IObject to add new sensors by calling:
SCA_IObject.AddSensor(keyboard); pseudocode
So now you know how Objects in the GE create sensors (and actuators and controllers, its
the same :) So lets look at how Sensors are grabbed! Since they are dynamically added the
program can't make assumptions about how many are there or what they will be. Thus
there is this helper function:
1''SCA_ISensor* SCA_IObject::FindSensor(const STR_String& sensorname)
2{
3
SCA_ISensor* foundsensor = NULL;
4
5
for (SCA_SensorList::iterator its =
m_sensors.begin();!(its==m_sensors.end());its++)
6
{
7
if ((*its)->GetName() == sensorname)
8
{<br />
9
foundsensor = (*its);
10
break;
11
}
12
}
13
return foundsensor;
14}''

Put simply, you give this the name of a sensor and it returns a pointer to the sensor.
for the newbies: I know you learned all about classes when i asked you to, but just in
case:) the ﬁrst word, ”SCA_ISensor*” this tells us that the function will return a pointer
to a SCA_ISensor. And based on the functions arguments, we know that when you call
FindSensor you must give it a string between the parenthesis.
in line 3 you create an empty pointer which you will use to store the sensor that you ﬁnd.
Then you loop and go through each sensor in the vector of sensors (remember, it was named
m_sensors) until you ﬁnd the one that matches the name. If you don't ﬁnd one, you return
NULL.
void SCA_IObject::Suspend(void)What this does is it loops through all of the sensors and sends each one a ”suspend” call. What this does is change a variable named,
”m_suspended” which makes stops the sensors from running when they are called with
their Activate() function.
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207. Glossary
207.1. A
• Alpha Channel1 is an additional channel in a 2D image for transparency. In an image
element which stores a color for each pixel, an additional value is stored in the alpha
channel containing a value between 0 and 1. A value of 0 means that the pixel does not
have any coverage information; i.e. there was no color contribution from any geometry
because the geometry did not overlap this pixel. A value of 1 means that the pixel is
fully opaque because the geometry completely overlapped the pixel.
• Ambient Light is light that doesn't seem to come from a speciﬁc source, but is just
there. Look under the desk - it's pretty dark, but there's some light there. In the real
world, this is caused by stray photons bouncing around and occasionally ricocheting under
the desk. Ambient light is the basic, minimal amount of light in the whole scene. Adding
too much ambient light makes a scene look washed out. Since the light doesn't come from
anywhere, all sides of an object are illuminated equally, and it won't have any shading
on it.
• Ambient Occlusion2 (AO) is a ratio of how much ambient light a surface point would
be likely to receive. It simulates a huge dome light surrounding the entire scene. If a
surface point is under a foot or table, it will end up much darker than the top of someone's
head or the tabletop.
• Armature3 is the interconnection of bones that form the skeleton of an animated ﬁgure.
The Inverse Kinematics library contains the code to make armatures move. The armature
must still be rigged4 with 3D objects to give shape to its head, hands, trunk, feet, etc.

207.2. B
• Background image: a 2D image (”picture”) that is placed ”behind” the entire 3D scene,
like a backdrop on a movie set. Blender permits the placement of these images in all six
directions from the origin: back, front, top, bottom, left, right.
• Bake: to precompute computationally-intensive elements of an animation. For example,
in a physics simulation involving the behaviour of ﬂuids or clothing, you would set up the
physical parameters, then compute (bake) the positions and shapes of the objects over the
duration of the animation. Afterwards, you can assign materials and lighting, and then
1
2
3
4

https://en.wikipedia.org/wiki/Alpha%20compositing
https://en.wikipedia.org/wiki/Ambient%20occlusion
https://en.wikipedia.org/wiki/armature_%28sculpture%29
https://en.wikipedia.org/wiki/rigging
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render the frames to produce the actual animation. Doing the baking as a separate step,
and saving the results from that, means you can change your mind about the materials
and lighting and rerender the frames more quickly.
• Bézier surfaces5 were ﬁrst described in 1972 by the French engineer Pierre Bézier who
used them to design automobile bodies. Bézier surfaces can be of any degree, but bicubic
Bézier surfaces generally provide enough degrees of freedom for most applications.
• BF is Blender Foundation
• Blend - to Blend, working with Blender; also Blender's ﬁle extension.
• Bounce Light: Simple lighting situations have a single light, called a key light, illuminating one side of an object. This creates strong shading and deﬁnition of the volume of
the object. However, a 3D light will often make the contrast too great - the dark side
of the object is completely black since no light is hitting it. In reality it would still be
lit a little, just not as much as the brightly lit side, because of light bouncing around
the room and hitting the dark side of the object. In realtime 3D, bounce light is not
calculated, so you have to create it yourself. Either add a little ambient color, or put a
second, less bright directional light pointing the opposite direction to give a little light to
the shadows.
• Bump mapping6 is a technique where at each pixel, a perturbation to the surface
normal of the object being rendered is looked up in a texture map and applied before the
illumination calculation is done. Bump Mapping use a gray-scale image map to change
the direction of surface normals. You can use this to simulate height, so that you can paint
wrinkles and bumps. 50 % grey means neutral (no change is made), lighter means higher,
darker means lower. Note that the position of faces is not actually changed; by rotating
just the normals, lighting will change too, to give the illusion of a height diﬀerence. This
has downsides too: the outline of objects isn't changed, so the trick is given away. For
similar eﬀects you can use Displacement Mapping and Normal Mapping.

207.3. C
• Caustics in optics is a bundle of light rays. For example a caustic eﬀect may be seen when
light refracts or reﬂects through some refractive or reﬂective material, to create a more
focused, stronger light on the ﬁnal location. Such ampliﬁcation, especially of sunlight,
can burn — hence the name. A common situation when caustics are visible is when some
light points on glass. There is a shadow behind the glass, but also there is a stronger
light spot. Nowadays, almost every advanced rendering system supports caustics. Some
of them even support volumetric caustics. This is accomplished by raytracing the possible
paths of the light beam through the glass, accounting for the refraction, reﬂection, etc.

5
6
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207.4. D
• Depth of Field7 (DOF) is the distance in front of and behind the subject which appears
to be in focus. For any given lens setting, there is only one distance at which a subject
is precisely in focus, but focus falls oﬀ gradually on either side of that distance, so there
is a region in which the blurring is tolerable. This region is greater behind the point of
focus than it is in front, as the angle of the light rays change more rapidly; they approach
being parallel with increasing distance.
• Diﬀuse Light is even, directed light coming oﬀ a surface. For most things, the diﬀuse
light is the main lighting we see. Diﬀuse light comes from a speciﬁc direction or location,
and creates shading. Surfaces facing towards the light source will be brighter, while
surfaces facing away from the light source will be darker.
• Directional Light is a light that has a speciﬁc direction, but no location. It seems to
come from an inﬁnitely far away source, like the sun. Surfaces facing the light are illuminated more than surfaces facing away, but their location doesn't matter. A Directional
Light illuminates all objects in the scene, no matter where they are.
• Displacement Mapping8 uses a greyscale heightmap, like Bump Mapping, but the
image is used to physically move the vertices of the mesh at render time. This is of
course only useful if the mesh has large amounts of vertices, but the (relatively) new
”Simple Subdiv” subsurf option allows you to add more vertices at render time which will
be moved by the displacement. This makes it much slower than Bump Mapping, as there
need to be many more faces to render, but it is much more realistic.

207.5. E
• Environment Maps (EnvMaps) is the method of calculating reﬂections. Involved rendering images at strategic positions and applying them as textures to the mirror. Now
in most cases obsoleted by Raytracing, which though slower is easier to use and more
accurate.

207.6. F
• Focal Length9 of a lens is the distance along the optical axis from the lens to the focus
(or focal point). The inverse of a lens' focal length is called its power.
• Focus10 of a lens is the point onto which collimated light parallel to the axis is focused.
• Foreshortening

7
8
9
10

https://en.wikipedia.org/wiki/Depth%20of%20field
https://en.wikipedia.org/wiki/Displacement%20mapping
https://en.wikipedia.org/wiki/Focal%20length
https://en.wikipedia.org/wiki/Focus%20%28optics%29
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• Fresnel11 lens is a type of lens invented by Augustin-Jean Fresnel. Originally developed
for lighthouses, the design enables the construction of lenses of large size and short focal
length without the weight and volume of material which would be required in a lens of
conventional design. As it relates to rendering, fresnel refers to the tendency of materials
to be more reﬂective when light strikes at a high angle of incidence-- think of how sunlight
reﬂects from distant water, but penetrates closer water, or of how road glare is most
extreme at dawn or dusk. This varies with material, and speciﬁcation of fresnel is an
important part of material deﬁnition.

207.7. G
• GE is Game Engine.
• Global Illumination12 (GI) is a superset of radiosity and ray tracing. The goal is to
compute all possible light interactions in a given scene, and thus obtain a truly photorealistic image. All combinations of diﬀuse and specular reﬂections and transmissions
must be accounted for. Eﬀects such as colour bleeding and caustics must be included in
a global illumination simulation.
• Gouraud shading13 is a method used in computer graphics to simulate the diﬀering
eﬀects of light and colour across the surface of an object. In practice, Gouraud shading is
used to achieve smooth lighting on low-polygon surfaces without the heavy computational
requirements of calculating lighting for each pixel. The technique was ﬁrst presented by
Henri Gouraud in 1971.

207.8. H
• High Dynamic Range Image14 (HDRI) is a set of techniques that allow a far greater
dynamic range of exposures than normal digital imaging techniques. The intention is
to accurately represent the wide range of intensity levels found in real scenes, ranging
from direct sunlight to the deepest shadows. The use of high dynamic range imaging
in computer graphics has been popularised by the work of Paul Debevec. Blender uses
Yafray for these techniques.

207.9. I
• Index Of Refraction15 (IOR) is about the way that light passes through diﬀerent
types of materials... diamond, glass, water etc. When a light ray travels through the
same volume it follows a straight path. However if it passes from one transparent volume

11
12
13
14
15
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to another, it bends. This is why a straw in water looks bent. The amount of bending
diﬀers between materials. The angle by which the ray is bent can be determined by
knowing two things: the angle at which the incoming ray has been cast and the Index of
Refraction. This IOR value is unique for every material. Glass has an IOR of about 1.5
and water 1.3. By increasing the IOR value for a Blender material, you can control how
much the environment behind the transparent object is distorted, and thus improving
the realism of the shader.
• Interpolation16 (IPO) is an animation curve: it indicates how the object must ”move”
between an initial and a ﬁnal position, at the rate determined by the rendering engine.
Objects can be animated in many ways. They can be animated as Objects, changing
their position, orientation or size in time; they can be animated by deforming them; that
is animating their vertices or control points; or they can be animated via very complex
and ﬂexible interaction with a special kind of object: the Armature.
• Inverse Kinematics17 (IK) is the process of determining the movement of interconnected segments of a body or model, starting from the desired motion of the endpoints
of the armature. Using ordinary Kinematics on a hierarchically structured object you
can for example move the shoulder of a puppet. The upper and lower arm and hand will
automatically follow that movement. IK will allow you to move the hand and let the
lower and upper arm go along with the movement. Without IK the hand would come
oﬀ the model and would move independently in space. The Blender Armature System
includes Inverse Kinematics. For general armatures there are many possible solutions to
the IK.

207.10. J
• JPEG18 Acronym for Joint Photographic Expert Group (pronounced jay-peg) is a commonly used standard method of lossy compression for photographic images. The ﬁle
format which employs this compression is commonly also called JPEG; the most common ﬁle extensions for this format are .jpeg, .jﬁf, .jpg, .JPG, or .JPE although .jpg is the
most common on all platforms.

207.11. K
• Keyframe is a frame in an animated sequence of frames that was drawn or otherwise
constructed directly by the user. When all frames were drawn by animators, the senior
artist would draw these frames, leaving the ”in between” frames to an apprentice. Now,
the animator creates only the ﬁrst and last frames of a simple sequence; the computer
ﬁlls in the gap. This is called tweening.

16
17
18

https://en.wikipedia.org/wiki/Interpolation
https://en.wikipedia.org/wiki/Inverse%20kinematics
https://en.wikipedia.org/wiki/JPEG
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207.12. L
• Luminosity19 (more properly called luminance) is the density of luminous intensity in
a given direction. In astronomy, luminosity is the amount of energy a body radiates per
unit time. It is typically expressed in the SI units watts, in the cgs units ergs per second,
or in terms of solar luminosities, Ls; that is, how many times more energy the object
radiates than the Sun, whose luminosity is 3.827×1026 W.

207.13. M
• Motion Blur20 is the simulation of the phenomenon that occurs when we perceive a
rapidly moving object. The object appears to be blurred because of our persistence
of vision. Doing motion blur makes computer animation appear more realistic. It can
be thought of as adding back some of the time dependence expressed in the Rendering
Equation.

207.14. N
• Nabla21 . Ton wrote: Almost all procedural textures in Blender use derivatives for calculating normals for texture mapping (with as exception ”Blend” and ”Magic). The texture
normal, the derivative, is calculated by using four samples in the texture formula:
s0=
s1=
s2=
s3=

texture(x, y, z)
texture(x+nabla, y, z)
texture(x, y+nabla, z)
texture(x, y, z+nabla)

normal[0]= s0-s1
normal[1]= s0-s2
normal[2]= s0-s3

Up to now, the ”nabla” oﬀset was a constant (0.025) which worked ﬁne in most cases, but
doesn't give proper control over the way a texture is sampled, for example to make the eﬀect
smoother or sharper. This feature especially is useful in combination with the ColorBand
feature.
• Non-Linear Animation (NLA) allows the animator to edit motions as a whole, not
just the individual keys. Nonlinear animation is not just about editing and manipulating
groups of keyframes, but it also allows you to combine, mix, and blend motions to create
entirely new animations.
• Nonuniform Rational B-Splines22 (NURBS) is a computer graphics technique for
generating and representing curves and surfaces.
19
20
21
22
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O
• Normal (Surface Normal) to a ﬂat surface is a three-dimensional vector which is perpendicular to that surface. A normal to a non-ﬂat surface at a point p on the surface is
a vector which is perpendicular to the tangent plane to that surface at p.
• Normal Mapping is similar to Bump Mapping, but instead of the image being a
greyscale heightmap, the colours deﬁne in which direction the normal should be shifted,
the 3 colour channels being mapped to the 3 directions X, Y and Z. This allows more
detail and control over the eﬀect.

207.15. O
• Orange23 is the ﬁrst Blender open movie project.
• Oversampling (OSA), also called Anti-Aliasing is the technique of minimizing aliasing
when representing a high-resolution signal at a lower resolution. In most cases, antialiasing means removing data at too high a frequency to represent. When such data is
left in a signal, it causes unpredictable artifacts.

207.16. P
• Phong shading term is used indiscriminately to describe both an illumination model and
an interpolation method in 3D computer graphics. Phong reﬂection is a local illumination model and can produce a certain degree of realism in three-dimensional objects by
combining three elements - diﬀuse, specular and ambient for each considered point on
a surface. It has several assumptions - all lights are points, only surface geometry is
considered, only local modelling of diﬀuse and specular, specular colour is the same as
light colour, ambient is a global constant.
• Point Light is a light that has a speciﬁc location and radiates equally out in all directions.
Examples of point lights would be candles or bare lightbulbs. Surfaces close to the point
light are brighter than those which are far away. Point lights have attenuation, which
controls how quickly the light intensity drops oﬀ as you move away from it. Lights with
high attenuation are very localized, while lights with low attenuation will spread farther.
• Polygonization (of meta-surfaces) is the process of approximating the meta-surface via
polygons so it can be displayed/rendered in Blender.
• Purple runs as a normal Verse client. It implements a node database to mirror the
contents of its host. It loads the plug-ins, which reside in libraries, from local disk as
DLLs or shared objects depending on the platform.

23

http://orange.blender.org
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207.17. Q
• Quaternion24 is a representation of 3D rotations with four numbers. It can be interpreted as an extension of complex numbers to 3D. The interpretation of the four numbers
is not very intuitive for a human, but the numerical advantage of quaternions is that it
is the smallest mathematical representation that does not suﬀer from the gimbal lock25
singularity26 problem. This problem occurs for example with Euler angle27 representations, when a small change in the 3D orientation can give rise to a large change in Euler
angles.

207.18. R
• Radiosity is a more accurate but also more process-intensive technique than raytracing,
that calculates patterns of light and shadow for rendering graphics images from threedimensional models. One of the many diﬀerent tools which can simulate diﬀuse lighting
in Blender.
• Raytracing works by tracing the path taken by a ray of light through the scene, and
calculating reﬂection, refraction, or absorption of the ray whenever it intersects an object
in the world. More accurate than Scanline, but much slower.
• Render: to generate actual viewable images from a 3D model or scene. This may or
may not need to happen in real time; for example an interactive game requires realtime rendering, whereas a feature ﬁlm does not. These situations require very diﬀerent
rendering techniques.
• Refraction in geometric optics is the change in direction of a wave due to a change in
velocity. It happens when waves travel from a medium with a given refractive index to a
medium with another. At the boundary between the media the wave changes direction;
its wavelength increases or decreases but frequency remains constant. For example, a
light ray will refract as it enters and leaves glass.
• Relative Vertex Keys (RVK) are part of a keyframe animation system that operates on
vertex level objects. Each (shape) key is stored as a morph target such that several keys
may be blended together to achieve complex mesh animation. With RVK you can create
facial expressions, speech, and other detailed animated keyframed movements within your
mesh-based models.
• Rig: the controls that aid in the manipulation of a digital character.
• Rigging is the process by which a person creates constraints and relationships between
objects that will generate controls to aid in the manipulation of a digital character.

24
25
26
27
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207.19. S
• Scanline is one row of pixels in the ﬁnal render. Also the term for one of the methods
of rendering which Blender can use. It is much faster than Raytracing, but allows fewer
eﬀects, such as reﬂections, refractions, motion blur and focal blur.
• Seed: a starting number for generating a random-looking number sequence. Using the
same seed will always give you the same sequence. Technically, such a sequence is not
truly random, it is only pseudorandom.
• Shader: an algorithm for computing the appearance of a given material based on the
colour, angle and intensity of the light. Specular shaders produce a more shiny, mirrorlike
ﬁnish, while diﬀuse shaders give a duller surface appearance. There are also toon shaders,
which are deliberately designed to produce an eﬀect more akin to a cartoon drawing, with
delineated object borders and less gradation of colours over a surface.
• Shadows: simulated lights don't normally cast shadows. And, they also pass through
solid objects - so a light inside a closed box would actually illuminate things outside the
box as if the box were transparent. The shading on objects is only calculated based on
the angle of the surface.
• Specular Light refers to the highlights on reﬂective objects, like diamonds, billiard
balls, and eyes. Specular highlights often appear as bright spots on a surface, at a point
where the light source hits it directly. Ambient, Diﬀuse, and Specular are called the three
components of a light source. Each one is given a color, which, when added together,
create the ﬁnal color of a light. For most lights, the main overall color of the light is
deﬁned by the Diﬀuse color. Sunlight or lightbulbs would be white, while moonlight
would be a darker blue, and a candle would be yellow. You can use the ambient color to
adjust the overall color range of the light source; or, you can get a slight tint to shadows
by making the diﬀuse component yellow and the ambient a slight blue. In many lights, the
ambient color is left at black, meaning that it won't have any eﬀect. Specular components
are often left at white, but you can make them diﬀerent colors to get interesting eﬀects.
Most of the time you can completely ignore the specular and diﬀuse settings on a light,
but just be aware that the way you set the color is by speciﬁcally setting the diﬀuse color.
The ﬁnal color that an object appears to be is a combination of the light hitting it and
the color of the surface.
• Spotlight is a light with both location and direction. A spotlight sends out a cone
of light deﬁned by the spotlight angle, and illuminates only objects within that cone.
Spotlights also have attenuation, as well as a parameter that controls whether the spot
of light is sharply deﬁned or has smooth edges. These 4 types of lights are listed in order
of computational complexity; the more lights you have, the more work the computer has
to do. Generally it's a good idea to use directional lights whenever possible, since they're
the cheapest, and use pointlights and spotlights sparingly.
• Stucci is one of the classes of blender textures. Stucci is not an English word, but is
used in Blender as the plural of stucco28 .

28

https://en.wikipedia.org/wiki/stucco
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• Subdivision Surface (Subsurf) is the tool which subdivides your model at render-time,
without aﬀecting your mesh at design-time. There are two subsurf algorithms in Blender
to choose from - Simple Subdiv, which doesn't aﬀect the shape of your mesh, and is used
to add detail to displacement mapping or render-time radiosity, both of which operate
on a per-vertex basis. The other is Catmull-Clark, a common subdivision algorithm
which smooths out curves, and allows you to make complicated smooth surfaces (e.g.
people, plants, etc.) with very few faces. However this algorithm can sometimes (read:
often) have strange results with meshes containing triangles or vertices with many edges
(”poles”), unless it is correctly handled.
• Sub Surface Scattering (SSS) is a mechanism of light transport in which light penetrates the surface of a translucent object, is scattered by interacting with the material,
and exits the surface at a diﬀerent point. All non-metallic materials are translucent
to some degree. In particular, materials such as marble, skin, and milk are extremely
diﬃcult to simulate realistically without taking subsurface scattering into account.

207.20. T
• Tuhopuu is an experimental version of Blender that is like a code playground, developers
can put their new code in there to be tested and played with by users before it gets put
into the oﬃcial Blender. Tuhopuu is Finnish for ”Tree of destruction”.
• Tweening is short for in-betweening, the process of generating intermediate frames between two images to give the appearance that the ﬁrst image evolves smoothly into the
second image. Tweening is a key process in all types of animation, including computer
animation. Sophisticated animation software enables one to identify speciﬁc objects in an
image and deﬁne how they should move and change during the tweening process. Another
word for tweening is interpolation29 .

207.21. U
• UV Mapping (UV) This refers to the process of re-parameterizing a 3d object with
dimensions x, y and z into a 2d plane with coordinates u and v. Most texturing requires
this step because it tells the program HOW to apply a 2d image map onto a 3d object. If
all your textures must be 2d and ﬂat, the easiest way to determine what pixel goes where
is if your model is ﬂattened and made 2d. It also establishes a relationship between a
2d image and the mesh such that if the mesh deforms, the image map will deform along
with it. Think of it as skinning a cat and pinning its hide onto cardboard to facilitate
painting it!

29
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207.22. V
• Verse is a network protocol that lets multiple applications act together as one large
application by sharing data over a network. If one application makes a change to shared
data, the change is distributed instantly to all the other interested clients.

207.23. W
• WC is Weekend Challenge.
• WIP is Work In Progress.

207.24. X
207.25. Y
• Yet Another Free Raytracer (YafRay) is an open source ray tracing program that
uses an XML scene description language. It has been integrated into, and is often used
to render scenes made in, Blender.

207.26. Z
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208. Frequently Asked Questions
The following questions cover general information about Blender 3D: Noob to Pro and the
software it is designed to teach, Blender.

208.0.1. What is Blender?
Blender is a full-blown 3D content creation suite, usable for 3D editing, animation, texture
mapping, compositing and rendering; as well as 2D video and audio editing/sequencing.
It runs on:
•
•
•
•
•
•

Windows — XP, Vista, and 7, 8.1, 10 32- and 64-bit
Mac OS X — PowerPC and Intel, 32- and 64-bit
Linux — Intel x86 and AMD, 32- and 64-bit
BSD
Solaris
Irix.

It is free, open-source software, available from blender.org1 .
Blender 2.73a is the latest stable release as of January 2015. Beginners are urged to learn
using stable 2.5x versions, as there has been a signiﬁcant UI overhaul since 2.49 and future
tutorials will likely be written or recorded with the new interface. However, keep in mind
that many existing tutorials were written for 2.49. If you're having trouble ﬁnding a button
or tool that has moved, try pressing Spacebar to search for Blender functions.
For more about Blender's history, functionality, and media productions which have utilized
Blender, see the Blender entry in Wikipedia2 .

208.0.2. What is this book? And what isn't it?
Noob to Pro is a collection of tutorials. Following these tutorials you can go from ignorant
new Blender user (noob) to proﬁcient Blender power user (pro). Though the tutorials are
not strictly linked, we recommend going through them in order. Earlier tutorials introduce
skills and information you'll be expected to know in later sections.
Noob to Pro isn't a compendium or reference manual. Use it with other resources, including
those in Blender's Help menu. Noob to Pro provides links to outside resources. We're part
of the Blender community!

1
2

http://www.blender.org
https://en.wikipedia.org/wiki/Blender%20%28software%29
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208.0.3. How accurate is the information in this book?
Blender is still under development! Its appearance, tools, and capabilities change from time
to time. For instance, Blender 2.5x alters both the graphical user interface and the Python
scripting interface and may also change some keyboard shortcuts.
Most of the tutorials should work with any recent version of Blender. Blender 3D: Noob to
Pro readers are encouraged to edit the WikiBook in order help to keep it up to date.

208.0.4. I have a question, where can I get help?
Search or post questions at BlenderArtists3 a large, easy-to-use, English-language forum.
BlenderWiki4 contains a large database of documentation. Find similar forums in other
languages at blender.org's community page5 . The discussion pages there are also useful.
If your question turns out to be very common, please take a moment to see if it can be
added to the book! It is best if it can be smoothly incorporated with an existing page.

3
4
5
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209. Tutorial Links List
This page includes a categorized list of Blender1 tutorials written or spoken in English.
This is by no means a comprehensive list of tutorials, so adding links is encouraged. For
tutorials that are not in English, please refer to the About2 page.
If you would like to learn about editing pages, you can ﬁnd information in the Introduction
to Wikipedia3 .

209.1. General Blender Information
• Blender Documentation4 - Includes information on Blender functionality, developing for
Blender, and creating Addons.
• To Those Learning 3D5 - Recommendations for people ﬁrst diving into Blender.

209.2. Blender Tutorial Websites
This section includes links to websites that host multiple tutorials or provide links to other
Blender tutorials. This section does not contain links to individual tutorials.
• BlenderGuru6 - Run by Andrew Price, BlenderGuru includes free tutorials as well as full
training courses.
• Blender Cookie7 - Part of the CG Cookie Network. Includes many free tutorials. Other
tutorials and full courses are available to members with a subscription.
• BlenderDiplom8 - Free tutorials mostly focused on visual eﬀects, but includes other topics
as well.
• Blender Tutor9 - Includes a series for Blender beginners as well as tutorials for more
advanced users
• BlenderArt Magazine10 - Blender magazine that includes tutorials in each issue.
• Blenderpedia11 - Free video tutorials, mostly about creating scenes and environments.
1
2
3
4
5
6
7
8
9
10
11

https://en.wikipedia.org/wiki/Blender%20%28software%29
Chapter 209.19 on page 1686
https://en.wikipedia.org/wiki/Wikipedia%3AIntroduction
http://www.blender.org/manual/contents.html
http://glenmoyes.com/articles/to_those_learning_3d.shtml
http://www.blenderguru.com/
http://cgcookie.com/blender/
http://www.blenderdiplom.com/en/
http://www.blendertutor.com/
http://blenderart.org/
http://www.blenderpedia.com/
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3D Total Blender Tutorials12 - Includes many tutorials about various topics in Blender.
BlenderCourse13 - 120 page Blender E-Book created for Blender 2.63
Tutorials For Blender3d14 - Many Blender Game Engine tutorials for Blender 2.6
Blender Tutorials Vimeo Group15 - This group the collects video tutorials posted on
Vimeo.
• Super3boy's Blender Tutorials16 - Video tutorials dealing with the basics of diﬀerent
aspects of Blender.
• Greybeard's Blender Video Tutorials17 - Downloadable video tutorials that go over many
topics.
•
•
•
•

These sites include links to Blender tutorials on other sites
•
•
•
•

BlenderNation Tutorials18 - List of tutorials that have been posted on BlenderNation
Blender3d Club19 - Includes links to various Blender tutorials
SurfnLearn.com : Blender 3D Tutorials20 - Links to various Blender Tutorials
Learningblender.com21 - Categorized links to various Blender Tutorials

These sites include tutorials that use Blender versions prior 2.5.
• Dave Jarvis' Blender Tutorials22 - Free tutorials using Blender 2.4x
• Kator Legaz23 - List at bottom includes a couple Blender tutorials
• BlenderMasters24 - Links to tutorials and some embedded YouTube tutorials. All 2.4x
and older.
• Selleri (Link removed, because it is harmful nowadays) - Handful of tutorials on a very
old version of Blender.
• Cogﬁlms Tutorials25 - PDF downloads of tutorials in 2.4x
• Pavaler.se26 - A couple of tutorials on modeling and animation.

209.3. Blender Interface
• Blender Basics: 2 Minute Tutorials - The Interface27
• Blender Interface Theme Repository28

12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
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http://www.3dtotal.com/index_tutorial.php?catDisplay=4
http://blendercourse.com/English.aspx
http://www.tutorialsforblender3d.com/
https://vimeo.com/groups/blendertuts/videos
http://www.youtube.com/profile_videos?user=super3boy
http://www.ibiblio.org/bvidtute/
http://www.blendernation.com/category/education/tutorials/
http://www.blender3dclub.com
http://www.surfnlearn.com/view_tutorials/Blender_3D/All/
http://www.learningblender.com
http://www.davidjarvis.ca/blender/
http://articles.katorlegaz.com/
http://www.blendermasters.com/cms/en/blender-tutorials/index.php
http://www.cogfilms.com/tutorials.html
http://www.palaver.se/page.php?catid=90
https://www.youtube.com/watch?v=wcNukwr3b5w
http://www.graphicall.org/themes/

Modeling
•
•
•
•
•

Basic Editing29
Blender Hotkeys30
Changing Views31
First Impression32
Getting Started33

209.4. Modeling
209.4.1. Mesh Modeling
• Video - DupliVerts Tutorial 34
• How to solve Blender's smoothing problems35 : discussion about smoothing strategies:
Smooth/Solid, Auto Smooth, EdgeSplit modiﬁer...
• Heightmaps36
• Extrusion Controlled by IPO37
• Basic objects38
• Modeling Techniques and Strategies39
• Easily Remove Orphan Edges and Vertices40
• Non-destructive bevel eﬀect41

209.4.2. Nurbs and Subsurface Modeling
• Subsurf modeling 242
• Metaballs43
• Abstract SubSurf modeling I44

209.4.3. Modeling Speciﬁc Objects
• Wooden Crate45
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45

http://www.ee.oulu.fi/~kapu/cg_course/bigfiles/blender/blendman.html
https://en.wikibooks.org/wiki/Blender%203D%3A%20HotKeys
http://blender3dfr.free.fr/anglais/tut2/tut2.htm
http://blender3dfr.free.fr/anglais/premiere.htm
http://blender3dfr.free.fr/anglais/tut1/tut1.htm
http://www.youtube.com/watch?v=M6EPXc8N3qs
http://feeblemind.tuxfamily.org/blog/index.php?post/2007/08/13/
88-how-to-solve-blenders-smoothing-problems
http://members.tripod.com/~funky_munky/tuts/blender/heightmaps.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/en_modelextipo00.htm
http://blender3dfr.free.fr/anglais/tut3/tut3.htm
http://web.archive.org/web/20051214002244/http://www.elysiun.com/forum/viewtopic.php?
t=21382
http://jmsoler.free.fr/didacticiel/blender/tutor/modesel_somparaz_en.htm
http://blendertips.blogspot.com/2006/03/bevel-modifier-workaround.html
http://blender3dfr.free.fr/anglais/tut5/tut5.htm
http://blender3dfr.free.fr/anglais/tut6/tut6.htm
http://www.deviantart.com/view/26691152/
https://www.youtube.com/watch?v=eg4x1QVxFak
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Double-Helix46
Turtle47
Leaf Shader48
Sears-Roebuck Dairy Barn49
Golf Ball50
Celtic Knot51
Quick and Easy Tree52
Ice Cube53 (pdf tutorial)
Water I (Link removed, because it is harmful nowadays) (pdf tutorial)
Water II (Link removed, because it is harmful nowadays) (pdf tutorial)
Dice54
Die with round corners55
Logo56
Cutting through steel57
Candle58
Landscape Cartoon (Link removed, because it is harmful nowadays) (pdf tutorial)
Text59
Hair Tutorial60
Wikipedia: Human Body Proportions61

209.5. Texturing
• Video - Basic Materials62
• Making a Lightsaber with Halos63
• The Unoﬃcial Texturing Tutorial64

46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
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http://www.deviantart.com/view/27132715/
http://web.archive.org/web/20051214001923/http://www.elysiun.com/forum/viewtopic.php?
t=44686
http://web.archive.org/web/20051214003206/http://www.elysiun.com/forum/viewtopic.php?
t=39810
http://www.harkyman.com/searsbarn01.html
http://web.archive.org/web/20070616093442/http://blenderartists.org/forum/showthread?
t=30937
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_celticknot_en.htm
http://web.archive.org/web/20051214003430/http://www.elysiun.com/forum/viewtopic.php?
t=32306
http://caron.yann.free.fr/blender/IceCube.pdf
http://www.blendernation.com/tutorials/blender-3d-beginner-tutorial-a-die/
http://www.youtube.com/watch?v=sp53YwtWdfY/
http://www.blendernation.com/tutorials/blender-3d-beginner-tutorial-creating-a-logo/
http://www.blendernation.com/tutorials/blender-3d-intermediate-tutorial-cutting-through-steel/
http://download.blender.org/documentation/oldsite/oldsite.blender3d.org/93_Blender%
20tutorial%20Candle.html
http://blender3dfr.free.fr/anglais/tut4/tut4.htm
http://web.archive.org/web/20031230091345/http://www.elysiun.com/forum/viewtopic.php?
t=16008
https://en.wikipedia.org/wiki/Body%20proportions
http://www.youtube.com/watch?v=2kk2BkVQkyk
http://blenderartists.org/forum/showthread.php?t=62611
http://web.archive.org/web/20031113173636/http://www.elysiun.com/forum/viewtopic.php?
t=11889

Texturing
•
•
•
•
•
•
•

Material Indice Tutorial65
Transparency and Refraction66
Reﬂections67
Texturing landscapes according to slopes68
Using Texture Stencils69
Textures with Alpha70
Textures with Bumpmapping71

209.5.1. UV Mapping
•
•
•
•

2 Minute Tutorial: Blender Basics - UV Mapping (Project from View)72
Video - UV Mapping73
UV Mapping & Texturing74
Complex material for a sword75

209.5.2. Animated Textures
• Video - Changing Colors Of Objects Mid Animation76
• animating masks for simulating ice freeze77
• Animated Procedural Textures78 (pdf tutorial)

209.5.3. Texture Nodes
• Video - Blender Nodes79
• Vector Blur usage with Blender80

65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80

http://feeblemind.tuxfamily.org/blog/index.php?post/2004/12/21/
5-blender-indices-materiau-material-indice
http://feeblemind.tuxfamily.org/blog/index.php?post/2004/12/26/
7-didacticiel-la-refraction-tutorial-refraction
http://feeblemind.tuxfamily.org/blog/index.php?post/2004/12/26/
6-didacticiel-les-reflets-tutorial-reflections
http://feeblemind.tuxfamily.org/blog/index.php?post/2009/10/12/
113-texturing-landscapes-according-to-slopes
http://feeblemind.tuxfamily.org/blog/index.php?post/2005/02/27/
16-didacticiel-usage-des-masques-de-textures-tutorial-using-texture-stencils
http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/alpha.html
http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/bump.html
https://www.youtube.com/watch?v=eg4x1QVxFak
http://www.youtube.com/watch?v=mVhhZ2KRr4Q
http://biorust.com/index.php?page=tutorial_detail&tutid=85
http://www.3dtotal.com/index_tutorial_detailed.php?roPos=1&catDisplay=4&id=665
http://www.youtube.com/watch?v=Eljv69HOLR4
http://web.archive.org/web/20051214002828/http://www.elysiun.com/forum/viewtopic.php?
p=455683#455683
http://www.cogfilms.com/tutorials.html
http://www.youtube.com/watch?v=-tM1spWQ5aw
http://feeblemind.tuxfamily.org/blog/index.php?post/2006/11/05/
74-blender-and-the-vector-blur
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209.5.4. 2D Texture Painting Techniques
These tutorials do not directly involve Blender, however they cover useful 2D knowledge for
advanced Blender users.
• Steven Stahlberg's Tutorials81 * exposed
• Fixing Lighting Irregulaties in Self-Tiling Maps82
• Texturing with Gimp83

209.6. Lighting, Shadows and Rendering
•
•
•
•
•
•
•
•
•
•

2 Minute Tutorials: Blender Basics - An Outline of Lighting and Rendering in Cycles84
Basic 3 Point Lighting85
Radiosity I86
Radiosity II87
Ramp Shaders88
Simulating Radiosity89
Ambient Occlusion90
Soft Shadows and Area Lights91
Soft Lights (Link removed, because it is harmful nowadays)(pdf tutorial)
Blender's Mist92

209.7. Compositing
• Matching Real Lighting93

209.8. Animation
• Video - Animation Basics

81
82
83
84
85
86
87
88
89
90
91
92
93
94
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94

http://www.androidblues.com/howto.html
http://www.3drender.com/light/EqTutorial/tiling.htm
http://otothecleaner.free.fr/tutorials/GimpTexture/gimptexture.htm
http://www.youtube.com/watch?v=slaBGcmiDgU
http://www.andrew-whitehurst.net/3point.html
http://blenderman.free.fr/tut/radiosity/uk/
http://download.blender.org/documentation/html/chapter_rendering_radiosity.html
http://www.blender.org/development/release-logs/blender-234/ramp-shaders/
http://jmsoler.free.fr/didacticiel/blender/tutor/lumiere_radios_en.htm
http://feeblemind.tuxfamily.org/blog/index.php?post/2005/01/16/
10-didacticiel-locclusion-ambiante-tutorial-ambient-occlusion
http://feeblemind.tuxfamily.org/blog/index.php?post/2005/01/02/
9-didacticiel-les-aires-lumineuses-tutorial-area-lights
http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/mist.html
http://www.andrew-whitehurst.net/fx_light.html
http://www.youtube.com/watch?v=FAZFfLmbD2k

Particles
•
•
•
•
•

Simple Animations95
Eﬀects96
Walking Blues97
Non Linear Action Editor - NLA I98
Non Linear Action Editor - NLA II99

209.8.1. Armatures and IK
• Video - Basic Armatures100
• Dancing Flor101 * exposed
• Animation Workshop II102 * exposed
• Animation recode project103
• Action Constraints tutorial made easy104
• Driven Hand Rig105
• Constrained Mechanics106
• Ikas Blender 3D - Introduction107

209.9. Particles
•
•
•
•
•
•

Video - Particle Basics108
Video - Grass with Particles109
Video - Explosions with Particles and the Explode Modiﬁer110
Particle Interaction111
Static Particles112
Making a Rain Eﬀect113

95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113

http://feeblemind.tuxfamily.org/blog/index.php?post/2005/03/08/
17-didacticiel-animations-simples-1ere-partie-tutorial-simple-animations-1st-part
http://download.blender.org/documentation/html/c1585.html
http://argoslabs.com/~malefico/tutor/walking.html
http://mmaigrot.free.fr/didac-blender/nla/eng/index.php
http://argoslabs.com/~malefico/tutor/nla-en.html
http://www.youtube.com/watch?v=GbFvrilssNo
http://otothecleaner.free.fr/tutorials/Flor/flor.html
http://web.archive.org/web/20060105235144/http://www.elysiun.com/forum/viewtopic.php?
p=511798
http://www.blender.org/development/release-logs/blender-240/how-armatures-work/
http://web.archive.org/web/20060105234833/http://www.elysiun.com/forum/viewtopic.php?
t=49603
http://web.archive.org/web/20060105234104/http://www.elysiun.com/forum/viewtopic.php?
t=19347
http://argoslabs.com/%7Emalefico/tutor/mecano-en.html
http://mmaigrot.free.fr/didac-blender/ikas/ikas-eng/ik-intro.php
http://www.youtube.com/watch?v=4ylN9yjCP_4
http://youtube.com/watch?v=M9aG0xBl9IM
http://www.youtube.com/watch?v=At3hIc-423c
http://www.blender.org/development/release-logs/blender-234/particle-interaction/
http://web.archive.org/web/20060105234605/http://www.elysiun.com/forum/viewtopic.php?
t=41356
http://feeblemind.tuxfamily.org/blog/index.php?post/2004/12/24/
4-blender-faire-pleuvoir-making-rain
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Tutorial Links List
• Setting a prey-predator relationship using Boids particles114
• Particle and ﬁeld basics115

209.10. Fluid Simulation
• Video - Fluid Simulation116
• Fluid Simulation Basics117

209.11. Game Engine
•
•
•
•
•
•
•
•
•
•
•
•

Video - Blender Game Engine Basics118
Video - Making Dominoes119
Game Engine Development120
New fully integrated game engine? 121
[irc://irc.freenode.net/gameblender #GameBlender]
Walkthrough Tutorial122
Mouse Look 1st Person. Options include capping, invert mouse pitch and adjust mouse
sensitivity.123
Viewports. Creating a split screen.124
Python game functions. Sample Code Included. Updated to 2.48125
Car Setup. Use Bullet Physics vehicle wrapper. 126
Python scripting for the Game Engine127 at cgmasters.net.
Python scripting series of tutorials128

209.12. Verge3D
• Video - Verge3D for Blender basics129

114
115
116
117
118
119
120
121
122
123
124
125
126
127
128
129
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http://feeblemind.tuxfamily.org/blog/index.php?post/2007/12/28/
106-setting-a-prey-predator-relationship-using-boids-particles
http://www.deviantart.com/view/27104504/
http://au.youtube.com/watch?v=yMBx2pYiqnY
http://www.deviantart.com/view/27479896/
http://www.youtube.com/watch?v=WGycLDs_dLg
http://youtube.com/watch?v=3kb_utKDu3o
http://wiki.blender.org/index.php/GameEngineDev
http://www.blender.org/forum/viewtopic.php?t=6409&sid=868ed3b00fd68157b704e87f0cc1684a
http://www.blender.org/education-help/tutorials/tutorial-folder/3d-walkthrough/
http://www.tutorialsforblender3d.com/Game_Engine/MouseLook/MouseLook_First_1.html
http://www.tutorialsforblender3d.com/Game_Engine/Viewports/Viewport_1.html
http://www.tutorialsforblender3d.com/GameFunctions/GameLogicPage1.html
http://www.tutorialsforblender3d.com/Game_Engine/Vehicle/Vehicle_1.html
http://www.cgmasters.net/free-tutorials/python-scripting/
http://www.youtube.com/goranmilovano
https://www.youtube.com/watch?v=ibPSGArAfJM&list=PLMnTV0uuRMhRn1QomhOqH4Rt_bSlDGXbP

Python and Plugins

209.13. Python and Plugins
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Povanim Export Script130
AI Path Importer131
3D-No Plugins; Put your 3D Blender space on web!132
Randomizer Script133 Scroll down the page
Diﬀerent Useful Scripts (Link removed, because it is harmful nowadays )
Lsystem tree maker134
Python API Introduction135
Python API, Making a Square Mesh136
Python API, Iterations137
Python API, Automating Vertex Creation138
Python API, Automating Face Creation139
Python API, Making Potatoid140
Python Script, To build an Empty for EnvMap 141
Python Script, Bezier Curves Import142
Python Script, Paths import143
Python Script, Importing Adobe Illustrator Format144
Python Script, Mesh Explosion145
Python Script, Level Of Detail146
Python Script, Wire Shadows and extrusions147
Python Script, Changing the active camera instantly148
Using the Superﬁcial Scattering Script149
City Block Genarator150
Blender Camera Calibration with Live Camera151

130
131
132
133
134
135
136
137
138
139
140
141
142
143
144
145
146
147
148
149
150
151

http://jmsoler.free.fr/util/blenderfile/fr/povanim_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_ai_en.htm
http://www.thoro.de/portfolio/verschiedenes/3DNP.html
http://web.archive.org/web/20051214001351/http://www.elysiun.com/forum/viewtopic.php?
t=37400
http://marief.soler.free.fr/Monsite/lsystem_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script00.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script01.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script02.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script03.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script04.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script05.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/english/eng_scriptmirror.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_curvesimport_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_paths_import_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_ai_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_meshexplosion_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_LOD_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/python_wireshadows_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_changerdecamera_en.htm
http://feeblemind.tuxfamily.org/dotclear/index.php/2005/04/25/
39-mh-tutorial-using-the-superficial-scattering-script
http://web.archive.org/web/20051214001714/http://www.elysiun.com/forum/viewtopic.php?
t=16217
http://web.archive.org/web/20051214003259/http://www.elysiun.com/forum/viewtopic.php?
t=32715
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Tutorial Links List
•
•
•
•

Mesh shaker and tutorial152
Batch STL153
Vertices to a Curve Converter154
Zutils, Z-Buﬀer Utilities155

209.14. Related Programs
•
•
•
•
•
•
•
•
•
•
•

YafRay156
SPE - Python IDE for Blender157
Wings 3D Subdivision Modeler158
Verse Gimp-Blender Plugin159
Kerkythea Renderer160
Equinox 3D161
Povray export162
Adobe Illustrator Paths import163
Inkscape SVG import164
Voodoo Camera Tracker165
Lionhead The Movies166

209.14.1. Distributed Computing
• BURP - Big and Ugly Rendering Project167
• Global Rendering-Farm168

209.15. Blender WikiBooks
• Blender 3D: Blending Into Python169

152
153
154
155
156
157
158
159
160
161
162
163
164
165
166
167
168
169
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http://saltshaker.sourceforge.net/
http://blender.formworks.co.nz/index.pl?p=2z/batch_stl.html
http://web.archive.org/web/20051214002530/http://www.elysiun.com/forum/viewtopic.php?
t=45576
http://web.archive.org/web/20051214002530/http://www.elysiun.com/forum/viewtopic.php?
t=35355
http://www.yafray.org
http://pythonide.stani.be
http://www.wings3d.com/
http://users.pandora.be/blendix/verse/old/demo.html
http://www.kerkythea.net
http://www.equinox3d.com
http://jmsoler.free.fr/util/blenderfile/fr/povanim_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_ai_en.htm
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_svg_en.htm
http://www.digilab.uni-hannover.de/docs/manual.html
http://www.dcmodding.com/main/index.php?option=com_smf&Itemid=79&topic=180.0
http://burp.boinc.dk/
http://renderworld.futureware.at/
https://en.wikibooks.org/wiki/Blender%203D%3A%20Blending%20Into%20Python

FAQ
• Blender 3D: HotKeys170
• Blender 3D: Import and Render a SolidWorks Model171
• Blender 3D: MemoBook172 * exposed
• Blender 3D: Noob to Pro173

209.16. FAQ
• Blender FAQ174 (Generated on September 24, 2001)

209.17. Miscellaneous
These are must reads for CG artists.
• How to succeed in Animation175
• Classical Film and Video Knowledge Base176
• Quick Tips in Design&GFX177

209.17.1. Open Movies
• NaNo - Blender Internet Virtual Movie Studio178

209.17.2. IRC
•
•
•
•
•
•
•
•
•

irc://irc.freenode.net/blender
irc://irc.freenode.net/blenderchat
irc://irc.freenode.net/blenderclasses
irc://irc.freenode.net/blenderqa
irc://irc.freenode.net/blendercoders
irc://irc.freenode.net/blenderwiki
irc://irc.freenode.net/gameblenderdev
irc://irc.freenode.net/gameblender
irc://irc.freenode.net/verse

170
171
172
173
174
175
176
177
178

https://en.wikibooks.org/wiki/Blender%203D%3A%20HotKeys
https://en.wikibooks.org/wiki/Blender%203D%3A%20Import%20and%20Render%20a%
20SolidWorks%20Model
https://en.wikibooks.org/wiki/Blender%203D%3A%20MemoBook
https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro
http://www.museum.state.il.us/ismdepts/library/linuxguides/blender/blender_faq_0.html
http://genedeitch.awn.com/
http://www.rondexter.com/
http://www.atpm.com/9.07/design.shtml
http://nano.prods.free.fr/
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Tutorial Links List

209.17.3. Tests
• Blender Benchmarks179

209.18. Other Lists
Please read more about on talk180 page.
• LANGUAGES (czech)

181

209.19. About
This links list is language ﬁltered and extended version of personal collection originally
provided by IamInnocent. So if you looking for tutorials in other languages check this
link at www.elYsiun.com182 .
• German Blenders should have a look at http://de.wikibooks.org/wiki/Blender_3D:
_Tutorial_Linkliste
If you want to add Blender tutorial link in some other language you can add it temporary
on talk183 page. We will later made such WikiBooks in other languages too.
Thank you all who contributed to this nice and useful links collection! Feel free to add your
name or link if you think you need to be mentioned here.

179
180
181
182
183
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http://www.eofw.org/index.php
https://en.wikibooks.org/wiki/Talk%3ABlender%203D%3A%20Tutorial%20Links%20List
http://www.youtube.com/watch?v=fsHW7J9dTNE
http://www.elysiun.com/forum/viewtopic.php?t=13380
https://en.wikibooks.org/wiki/Talk%3ABlender%203D%3A%20Tutorial%20Links%20List

210. Hotkeys
Blender's user interface is very ﬂexible and often provides more than one way to do something. Many operations that can be done by clicking on buttons and menus can also be
done with keyboard shortcuts called ”hotkeys”. The hotkey is usually much faster than the
corresponding mouse action, so it's a good idea to learn them as soon as possible.
An entire WikiBook (titled Blender 3D: HotKeys1 ) is devoted to Blender hotkeys. We
encourage you to refer to it as often as necessary.

1

https://en.wikibooks.org/wiki/Blender%203D%3A%20HotKeys
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211. Output Formats
Blender can render still images and video to many diﬀerent ﬁle formats. Here is an alphabetical list:
• AVI Codec - AVI codec compression. Available codecs are operating system dependent.
When an AVI codec is initially chosen, the codec dialog is automatically launched. The
codec can be changed directly using the Set Codec button in AVI Codec settings.
• AVI Jpeg - AVI but with Jpeg compression. Lossy, smaller ﬁles but not as small as you
can get with a Codec compression algorithm. Jpeg compression is also the one used in
the DV format used in many digital camcorders.
• AVI Raw - Audio-Video Interlaced (AVI) uncompressed frames.
• BMP - Bit-Mapped Paint is an early lossless format.
• Cineon - format produced by a Kodak Cineon camera and used in high-end graphics
software and directed toward digital ﬁlm.
• DPX - Digital Moving-Picture eXchange format; an open professional format (close to
Cineon) with meta-information about the picture; 16-bit uncompressed bitmap (huge ﬁle
size). Used in preservation.
• FFMPEG - Fast Forward Moving Pictures Expert Group is a collection of free and
open source software libraries that record, convert and stream digital audio and video
in numerous formats. You must have the proper codec installed on your computer for
Blender to call it and use it to compress the video stream through FFMPEG, but there
are preset formats to choose from, such as DV, SVCD, and DVD.
• Frameserver - Blender puts out frames upon request as part of a render farm. The port
number is speciﬁed in the OpenGL User Preferences panel.
• HamX - Blender's own self-developed 8 bits RLE (Run Length Encoded bitmap) format;
it creates extremely compact ﬁles that can be displayed quickly. To be used only for
previsualization of animations (Play button).
• Iris - the standard Silicon Graphics Inc (SGI) format used on Unix OS machines.
• JPEG - Joint Photographic Experts Group (name of the consortium which deﬁned it),
an open format that supports very good compression with little loss of quality. Only
saves RGB value. Re-saving images results in more and more compression and loss of
quality.
• JPEG 2000
• MultiLayer - an OpenEXR format that supports storing multiple layers of images together in one ﬁle. Each layer stores a renderpass, such as shadow, specularity, color, etc.
You can specify the encoding used to save the MulitLayer ﬁle using the codec selector
(ZIP (lossless) is shown and used by default).
• OpenEXR - an open and non-proprietary extended and highly dynamic range (HDR)
image format, saving both Alpha and Z-depth buﬀer information.
• PNG - Portable Network Graphics, a lossless image format often used in web design.
• QuickTime - A proprietary multimedia framework for video and images.

1689

Output Formats
•
•
•
•

Radiance HDR
Targa
Targa Raw
TIFF - Tagged Image File Format created by Aldus for desktop publishing.

If the selection seems daunting, here are pointers:
If you need transparency in your images (i.e., an alpha channel that allows any part of
the rendered image to have varying degrees of opacity), or you will be compositing, you
generally want to use:
•
•
•
•

Multilayer
PNG
OpenEXR
Targa

Of the above four formats, you will ﬁnd that PNG and Targa images can be opened and
edited by most any bitmap editing application, such as GIMP or Photoshop. However,
OpenEXR and Multilayer oﬀer more options within Blender, and may produce smaller,
lossless ﬁles.
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212. Image Portfolio
212.1. Summary
This is the Blender 3D: Noob to Pro1 image portfolio page, where all the categories of the
images used in the book are here in one place for your reference.

212.2. Categories
Blender 3D2
Blender 3D icons3
Blender 3D screenshots4
Non Blender 3D screenshots5
Blender 3D splash screens6
Blender 3D viewports7
Blender 3D suzanne primitive8

212.3. A sampling of images from the above categories
Heres a random sample of 200 images from the over 1,800 images in the above categories

1
2
3
4
5
6
7
8

https://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro
https://en.commons.org/wiki/Category%3ABlender%203D
https://en.commons.org/wiki/Category%3ABlender%203D%20icons
https://en.commons.org/wiki/Category%3ABlender%203D%20screenshots
https://en.commons.org/wiki/Category%3ANon%20Blender%203D%20screenshots
https://en.commons.org/wiki/Category%3ABlender%203D%20splash%20screens
https://en.commons.org/wiki/Category%3ABlender%203D%20viewports
https://en.commons.org/wiki/Category%3ABlender%203D%20suzanne%20primitive
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Image Portfolio

Figure 1384

Figure 1385

Figure 1386

Figure 1387

Figure 1388
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A sampling of images from the above categories

Figure 1389

Figure 1390

Figure 1391

Figure 1392
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Image Portfolio

Figure 1393

Figure 1394

Figure 1395

Figure 1396

Figure 1397
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A sampling of images from the above categories

Figure 1398

Figure 1399

Figure 1400

Figure 1401

Figure 1402
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Image Portfolio

Figure 1403

Figure 1404
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A sampling of images from the above categories

Figure 1405

Figure 1406
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Image Portfolio

Figure 1407

Figure 1408

Figure 1409

Figure 1410

Figure 1411

Figure 1412
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A sampling of images from the above categories

Figure 1413

Figure 1414

Figure 1415

Figure 1416

Figure 1417
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Image Portfolio

Figure 1418

Figure 1419

Figure 1420

Figure 1421

Figure 1422
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A sampling of images from the above categories

Figure 1423

Figure 1424

Figure 1425

Figure 1426

Figure 1427
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Image Portfolio

Figure 1428

Figure 1429

Figure 1430

Figure 1431

Figure 1432
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A sampling of images from the above categories

Figure 1433

Figure 1434

Figure 1435

Figure 1436

Figure 1437
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Image Portfolio

Figure 1438

Figure 1439

Figure 1440

Figure 1441

Figure 1442

Figure 1443

1704

A sampling of images from the above categories

Figure 1444

Figure 1445

Figure 1446

Figure 1447
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Image Portfolio

Figure 1448

Figure 1449

Figure 1450

Figure 1451

Figure 1452
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A sampling of images from the above categories

Figure 1453

Figure 1454

Figure 1455

Figure 1456

Figure 1457

Figure 1458
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Image Portfolio

Figure 1459

Figure 1460

Figure 1461

Figure 1462

Figure 1463
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A sampling of images from the above categories

Figure 1464

Figure 1465

Figure 1466

Figure 1467
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Image Portfolio

Figure 1468

Figure 1469

Figure 1470

Figure 1471
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A sampling of images from the above categories

Figure 1472

Figure 1473

Figure 1474

Figure 1475

Figure 1476
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Image Portfolio

Figure 1477

Figure 1478

Figure 1479

Figure 1480

1712

A sampling of images from the above categories

Figure 1481

Figure 1482

Figure 1483

Figure 1484

Figure 1485
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Image Portfolio

Figure 1486

Figure 1487

Figure 1488

Figure 1489

Figure 1490
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A sampling of images from the above categories

Figure 1491

Figure 1492

Figure 1493

Figure 1494

Figure 1495
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Figure 1496

Figure 1497

Figure 1498

Figure 1499

Figure 1500
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A sampling of images from the above categories

Figure 1501

Figure 1502

Figure 1503
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Image Portfolio

Figure 1504

Figure 1505

Figure 1506

Figure 1507

Figure 1508
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A sampling of images from the above categories

Figure 1509

Figure 1510

Figure 1511

Figure 1512
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Image Portfolio

Figure 1513

Figure 1514

Figure 1515

Figure 1516

Figure 1517
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A sampling of images from the above categories

Figure 1518

Figure 1519

Figure 1520

Figure 1521

Figure 1522
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Figure 1523

Figure 1524

Figure 1525

Figure 1526

Figure 1527
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A sampling of images from the above categories

Figure 1528

Figure 1529

Figure 1530

Figure 1531
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Figure 1532

Figure 1533

Figure 1534

Figure 1535
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A sampling of images from the above categories

Figure 1536

Figure 1537

Figure 1538

Figure 1539

Figure 1540

Figure 1541
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Figure 1542

Figure 1543

Figure 1544

Figure 1545
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A sampling of images from the above categories

Figure 1546

Figure 1547

Figure 1548

Figure 1549

Figure 1550
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Figure 1551

Figure 1552

Figure 1553

Figure 1554

1728

A sampling of images from the above categories

Figure 1555

Figure 1556

Figure 1557

Figure 1558

Figure 1559
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Figure 1560

Figure 1561

Figure 1562

Figure 1563

Figure 1564
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A sampling of images from the above categories

Figure 1565

Figure 1566

Figure 1567

Figure 1568

Figure 1569
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Figure 1570

Figure 1571

Figure 1572

Figure 1573
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A sampling of images from the above categories

Figure 1574

Figure 1575

Figure 1576

Figure 1577
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Figure 1578

Figure 1579

Figure 1580

Image Portfolio9

9
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https://en.wikibooks.org/wiki/%2FProject

213. Blender Glossary
Please add words and phrases to the alphabetical glossary at Blender 3D: Noob to
Pro/Glossary1 .

213.0.1. General Terminology
• 2D (adjective): two-dimensional (ﬂat)
• 3D (adjective): three-dimensional
• axis (noun): one of the primary directions used to deﬁne a coordinate system; plural:
axes
• coordinates (noun): a string of numbers (usually two or three) which denote a location
• coordinate system: a scheme for denoting locations by means of coordinates
• disappearing taskbar: a taskbar which appears only when the mouse pointer reaches
an edge of the display
• geometry:
1. the branch of mathematics concerned with positions, directions, angles, lengths,
areas, volumes, and so on
2. the portion of a 3D model that deals with shapes
• GIMP: an open-source software tool for editing 2D computer graphics
• illusion of depth: the human propensity to imagine a 3D scene when presented with a
ﬂat (2D) picture of it
• light (verb): to describe the intensity, color, direction, etc. of the light sources in a 3D
scene
• model (noun): an abstract description of a 3D object (or scene) which is suitable for
rendering
• model (verb): to create models
• numpad: a numeric keypad
• orthographic view: a 2D view which represents a scene's parallel edges with parallel
edges; from ”orthography”; contrast with: perspective view
• perpendicular (adjective): forming a 90-degree (right) angle
• perspective view: a 2D view which represents a scene's parallel edges with edges that
converge toward a vanishing point
• pose (verb): to position objects and their parts in a 3D scene
• render (verb): to generate a 2D view from a 3D model of a scene, by means of a computer
• rig (noun): to describe how diﬀerent parts of an object are capable of moving relative to
one another
• texture (verb): to describe how a 3D object interacts with light (scattering, bending,
etc.)
1

Chapter 207 on page 1661
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213.0.2. Blender User Interface Terminology
•
•
•
•

active window: the window currently responding to keystrokes
blender unit: the height and width of each grid square in a 3D View window
header: a row of controls along the top or bottom of a window
panel: a rectangular area in a Buttons window which can be rearranged relative to other
panels
• window (noun): a rectangular area of Blender's user-interface which can be split or
resized
• window type (noun): one of the sixteen varieties of windows in Blender's user interface:
• Scripts Browser - This window is used to initiate any Python2 scripts saved in
Blender to add functionality.
• File Browser - Browses the ﬁles on your computer in Blender.
• Image Browser - Browses the ﬁles on your computer in Blender with visuals of images
displayed.
• Node Editor - The enhanced material editing system in Blender in which you can
customize the input/output of materials or scenes and composite them together.
• Buttons Window - Displays the Blender scene and object editing options.
• Outlines - Breaks down the entire collection of objects and their properties in an
organized list.
• User Preferences - Allows you to change Blender's controls and preferences.
• Text Editor - Simple text editor for any notes/Python code.
• Audio Window - Allows you to upload, enhance, and save audio ﬁles into the Blender
library.
• Timeline - Shows the animation's beginning, ending, and current frame, as well as a
timeline with marks indicating all the key positions of an object.
• Video Sequence Editor - Feature for the composition of sound, scenes, videos and
other cinematographic elements.
• UV/Image Editor - Allows you to add and alter image ﬁles in Blender and also apply
these images onto the faces of meshes in an editable fashion as a material.
• NLA Editor - Allows you to change the key positions of all actions/IPOs.
• Action Editor - Allows you to alter the key positions of an armature and it's collection
of bones.
• IPO Curve Editor - Allows you to insert saved key points of the positions, transformations, and settings of objects of the course of a series of frames.
• 3D View - Window through which you work with, add, and place objects in a 3D
world.

213.0.3. Blender Modeling Terminology
• Quad n. - A face with four sides.
• Mesh n. - A collection of faces, edges, and vertices which can be modeled and manipulated in Edit Mode.

2
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https://en.wikibooks.org/wiki/Python

A sampling of images from the above categories
• Vertex (pl. vertices) n. - A 3-dimensional coordinate, which in groups comprise
a polygon. With default settings, it is represented in Blender by a purple dot when
unselected, or a yellow dot when selected.
• Edge n. - A wire-like line representing the boundary of 2 adjacent vertices.
• Face n. - A planar connection of edges representing a boundary, ﬁeld, or solid surface.
Identiﬁed individually in Edit Mode as a black box in the middle of the corresponding
face.
• Icosphere n. - A sphere composed of n triangular faces composed in a manner to give
the best ”smoothness” for the lowest memory consumption.
• UVSphere n. - A sphere composed of n square faces arranged in rings to allow the
smoothest application of real-time movement of vertices/faces and application of images
onto the spectrum of faces.
• Lamps - Category of 5 light-emitting objects:
• Lamp - Light is emitted in the scene with a uniform spherical output which fades with
distance, decreasing eventually to 0. The distance can be speciﬁed in its options.
• Sun - Light is emitted in the scene with a uniform spherical output and remains uniform
regardless of the distance from it.
• Spot - Light is emitted in the scene in a predetermined conical area with light properties
similar to lamp and also initially calculates the shadow (lack of light) present behind
an object (Known as ray shadow).
• Hemi - Sun-like light emitted in a 180 degree arc. Works just like a Sun lamp, but with
less functionality. Best used for quick, broad illumination.
• Area - Light which works similar to a Spot lamp but shape of the cone is deﬁnable.
• Ray shadows n. - Method of generating shadows cast by light by calculating the angle and faces of the interfering object to create a smooth, sharp and complete shadow.
Memory-intensive, best quality.
• Buﬀer Shadows n. - Method of generating shadows cast by light by calculating the
angle of a mesh's edge and creating a set amount of shadow ”squares” on the shadowreceiving objects which are calculated from a set buﬀer-ratio. Memory-friendly, while
possibly lower quality.
• Camera n. - An object which acts as the viewpoint (when active) for the scene when
the scene is to be rendered.
• Armature n. - An object which contains 'bones'. Bones are sub-objects which are
connected with each other in a chain, each bone-link is parented to the bone before it.
The purpose is to parent any objects to the bone, and also you may parent a mesh to the
entire armature and have selected vertices of the mesh parented to bone(s) percentagewise (0% means no eﬀect, 50% means vertices copy half the transformation value, 100%
means vertices transformed as full child of bone.)
• Empty n. - An object with no mesh or relating object data. It is useful for using in
object input ﬁelds where the object needs no speciﬁc properties e.g. parenting it to an
object for organisational purposes.
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214. Materials Directory: Every Material
Known To Man
214.1. ”Every Single Material Known To Man” Project
Want to share your material settings with the world? This is the place! This page is going
to be turning from a page to a chapter, but to do that we need your support! If you have
an idea for a material, even if you don't know how to make it, just put it in the list to help!
Someone out there knows how to make it, and if they come across this page with it listed,
they might be willing to share.
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215. Sources of free 3D models
Here are some sources of free 3d models from across the web. Take them apart, put them
back together, understand what makes them tick, to improve your own modeling.

215.1. Blender-Speciﬁc
These sites oﬀer .blend ﬁles for download.
The Oﬃcial Blender Model Repository1
Blender for Architecture2
http://opengameart.org — more Blender models
http://katorlegaz.com/3d_models/index.php -- they have furniture, arcade video
games, joysticks, toys, vehicles, road and sidewalk items, and simple human models
• Yorik’s site3 — some Blender ﬁles for his architectural projects are available for download.
• BlenderKit4 — free models, materials and brushes available through Blender add-on.
•
•
•
•

215.1.1. Sites Requiring Registration
• http://www.blendswap.com/ — speciﬁcally for swapping Blender models.

215.2. Non-Blender-Speciﬁc
These sites oﬀer models in other formats.
• http://archive3d.net - 15,000+ free models from archive 3d
This seems to have some licensed models and might be legal trouble see Discussion at
http://blenderartists.org/forum/archive/index.php/t-237569.html
• http://sketchup.google.com/3dwarehouse/ - Google's 3d warehouse repository; take
the collada version, when available ( the Google Earth downloads are actually .zip ﬁles
with a collada inside them, so just rename and unzip)
Note: some of the 3d warehouse models can't be understood by blender due to a zillion
repeating elements, others will show up invisible (one sided, or inside out), be gigantic in

1
2
3
4

http://www.blender-models.com/
http://blender-archi.tuxfamily.org/Models
http://yorik.uncreated.net/
https://www.blenderkit.com/
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size, or all parented to some crazy spot out in space. Fixing these to be usable will push
your blender skills to new levels in some cases.
Tips: I’ve tried importing a few of these 3D Warehouse models, and so far I’ve only noticed
a couple of issues:
• • The model imports into a new Blender scene, called something like “SketchupScene”
or “SketchupScene001”. You may also ﬁnd additional scenes created with nothing in
them, that you can delete. If you try rendering, you may not see anything, because
the default camera is only linked into the original default scene named “Scene”. Just
select the camera and hit CTRL+LKEY to link it into the new scene.
• You may notice parts of the model appearing and disappearing as you try viewing it
from diﬀerent angles. This is because it is scaled very large (several hundred Blender
Units on a side). Try scaling it down so it’s no more than a few BU on a side.
• There will usually be a lot of doubles, so remove them with WKEY->remove doubles.
• There may be many separate objects, so select what you want to combine and hit
CTRL+J to join them all into one object.
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•

•
•
•

https://www.stlfinder.com - The free 3d model search engine
https://www.yobi3d.com - 3D model search engine with previews in 3D
http://free3dbase.com/ - furniture models without registering
http://artist-3d.com/ - wide variety of free models
http://nasa3d.arc.nasa.gov/ - all kinds of free models from the space program
http://www.3dm3.com/modelsbank/ - around 300 free models
http://www.amazing3d.com/free/free.html - free section on amazing 3d about 75
models of all kinds of things.
http://www.corporatemedianews.com/2002/03_mar/features/3dmodellibrary.htm
- free models from corporate media news; a very interesting collection from klingon space
ships to footballs.
http://3dplants.0catch.com/download.html - about 70 free 3d plant models
http://www.3delicious.net - 3d delicious, lots of models, but way too many popover
ads! (click the picture, then click the bigger preview in the next page to download)
http://www.top3dmodels.com/products/3d-models/free - 20 free models
http://www.top3d.net/free-3d-models/ - about 85 models, including washing machines, tires, and jewelry
http://www.oyonale.com/modeles.php?lang=en&format=OBJ - about 17 free models
form guns, to rubber duckies
http://dmi3d.comeze.com/ - a few hundred free models of cars, race cars, trucks, tanks,
backhoes, etc.
http://www.scifi3d.com/list.asp?intGenreID=14&intCatID=36 - free models of scﬁ
empires like, Aliens, Babylon5, Blade Runner, BS Galactica, Original SciFi, Other SciFi,
Star Trek, Star Wars
resources.blogscopia.com5 - models in Blender and other formats.
http://www.hobbycncart.com/ - Free relief models (all modells are free) in .STL .OBJ
and depth map (.BMP) formats.
http://www.craftsmanspace.com/free-3d-models - Free 3D models (Creative common licenses) in .STEP, .IGES, .STL .OBJ and .BLEND formats.

5
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http://resources.blogscopia.com/category/models/

Non-Blender-Speciﬁc
• http://tf3dm.com — models in various common formats, including some in .blend; can
be downloaded without registration (subject to slight delay). However, most seem to be
under “personal use only” or “non-commercial use” licences.

215.2.1. Sites Using .RAR Format
Separated out because they may not be decodable with Free Software.
• http://www.3dmodelfree.com/ - 3d model free, lots of variety here
• http://dlegend.com/html/free-3dmodels.html - design company with a few huundred free 3d models
• http://3ddb.blogspot.com/search/label/Models - lots of free luxury style models in
sets (has a giant picture at the top, just scroll down).

215.2.2. Sites Requiring Registration
• http://www.turbosquid.com/Search/Index.cfm?keyword=&max_price=0 - 13,000+
free models at 3d stock site turbosquid ( registration required for download)
• https://hum3d.com/free/ - have more than 7000 3D models.
• http://dd-freebies.blogspot.com/search/label/3D%20models - a few baubles and
ornaments
• http://www.exchange3d.com/free-3d-models/cat_35.html?noredirect=1&act=
viewCat&catId=35 - about 100 free models, some even made in blender!
• http://www.wirecase.com/Gallery-Free-3D-Models_s-2_v-20-1_f-fc-0-321_
f-fpx-_f-fpn-_f-oid-.html - 25 sets of models from airplanes to bottles
• http://www.sharecg.com/b/5/3D-Models?PSID=e3aa02d1ef780c432e9f9d7e95409369
- wide assortment of free models
• http://www.cg-files.com/3dmodels.html - from tires to fans (lots of popover ads)
• http://www.3dcontentcentral.com/default.aspx - Free 3D Models of Parts & Assemblies like brackets, resistors, motors, shafts, valves.
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216. All Blueprints Links
This page contains links to 2D images and drawings that can be useful for constructing
models.
•
•
•
•
•
•
•
•
•
•
•
•
•

http://www.shipschematics.net - Starship Schematics Database
http://www.suurland.com/blueprints_archive.php
http://www.luft46.com/profiles/profiles.html - 3 views
http://www.aviastar.org/index2.html - 3 views
http://www.rcgroups.com/forums/showthread.php?t=557457 - 3 views on a lot lot
lot of airplanes
http://www.google.com/intl/en/sketchup/3dwh/pdfs/modeling_a_city.pdf
Google’s guide on how to model a city
http://www.boatdesign.net/boat-plans-archive/index.htm boats
http://www.mgussin.freeuk.com/00Plans.htm old cars
http://www.airwar.ru/other/draw_1w.html War Planes
http://web.archive.org/web/20081108194053/http://jpracing.racerplanet.
com/ Cars, Trucks, Buses
http://www.swaqvalley.com/blueprints.php?section=samples sports cars
http://www.newhomesource.com — site run by builders, but low-res plans are viewable
online
http://drawingdatabase.com/ Vehicles: cars, military, aircraft

216.1. Registration Required
• http://www.the-blueprints.com/ — requires registration for full-quality downloads
• http://smcars.net/

216.2. Payment Required
• http://www.monsterhouseplans.com/ - source of over 23,000 ﬂoor plans
• http://www.eplans.com/ - ﬂoor plans, but if you navigate around a bit to ﬁnd em.
• http://www.emporis.com/application/ - heights and details of buildings; photos available for purchase
• http://skyscraperpage.com/ - building heights, diagrams, but downloads and screenshots are prohibited
• http://humster3d.com/category/blueprints/ - cars, trucks, motorcycles, buses
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216.3. Shouldn’t Really Be Here?
• http://www.archiplanet.org/wiki/Main_Page - building encyclopedia, can’t ﬁnd any
actual plans
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217. Materials, Textures, Photos
Here are some sources of materials, textures and photos from across the Web.

217.0.1. Materials
• Large Free Repository of Materials1

217.0.2. Textures
• Textures Library2
UNKNOWN TEMPLATE dead link
September 2016
• Mayang's Free Textures Hi-Res3
• Jeremy Engleman's Public Textures Hi-Res4 (doesn’t seem to display properly)
• Image*After Free Images Hi-Res5
• Free Textures Mid-Res6
• Sky Maps7
UNKNOWN TEMPLATE dead link
September 2016
• CG Textures8
• Texture Labs9

217.0.3. Photos
•
•
•
•
•
•
1
2
3
4
5
6
7
8
9

http://Blogpiks.com/ — Free images for blogs, websites and social media
http://www.med.harvard.edu/AANLIB/cases/caseNA/pb9.htm - Brain scan
http://www.morguefile.com - the morgue ﬁle
http://www.sxc.hu - Stock exchange
http://www.everystockphoto.com everystockphoto
http://www.pixelperfectdigital.com/free_stock_photos - Pixel Perfect Digital
http://matrep.parastudios.de/index.php
http://textures.z7server.com/
http://www.mayang.com/textures/index.htm
http://www.art.net/~jeremy/photo/public_texture_frameset.html
http://www.imageafter.com/
http://digitalcraftsman.com/textureBin/textureBin.htm
http://www.elysiun.com/forum/viewtopic.php?t=24738
http://cgtextures.com/
http://texturelabs.org/
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•
•
•
•
•
•
•
•
•
•
•

http://openphoto.net - OpenPhoto.Net
http://www.imageafter.com - Image*After
http://www.aboutpixel.de - aboutpixel.de
http://www.freephotosweb.com/freephotosweb - Free Photos Web
http://www.bigfoto.com - Big Foto
http://www.freephotosbank.com - FreePhotosBank.com
http://www.freejpg.com.ar - FreeJPG
http://www.stockvault.net - Stockvault.net
http://www.freepixels.com - FreePixels
http://www.freerangestock.com - Freerange Stock
http://pixabay.com/ — requires registration
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Advice
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218. Asking for Help
So you've come to learn Blender, eh? You've made a great choice. Blender is one of the
most powerful 3D animation and 3D creation tools out there, especially if you're short on
cash. Learning how to use Blender can be a daunting task, so don't give up! With the
help of this wikibook, you can become a Blender power user and put those Maya folks to
shame.
If you ever get stuck in a tutorial for some reason, there are a number of places you can
turn for help. The best way to get help is with an Internet Relay Chat (IRC) client such as
X-Chat1 . Connect to irc.freenode.net and talk to blender users in the following channels.
•
•
•
•
•

[irc://irc.freenode.net/blenderwiki #blenderwiki]
[irc://irc.freenode.net/blender #blender]
[irc://irc.freenode.net/blenderchat #blenderchat]
[irc://irc.freenode.net/blenderqa #blenderqa]
[irc://irc.freenode.net/gameblender #gameblender]

If you can't get help there, click the ”discussion” tab at the top of the page that you're
having trouble with, and explain your problem on that page. Wait at least 24 hours for
help.
If you're still not getting help, try asking for help in the BlenderArtists.org forums2 .
es:Blender 3D: novato a profesional/Clases particulares de principiante3

1
2
3

http://xchat.org
http://blenderartists.org/forum
https://es.wikibooks.org/wiki/Blender%203D%3A%20novato%20a%20profesional%2FClases%
20particulares%20de%20principiante
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219. Tips for a Successful Project
The following tips may improve your chances of enjoying a successful project with Blender.

219.0.1. Organize early, organize thoroughly
In Blender projects, you may work with complex scenes containing hundreds of items:
models, lights, cameras, scripts, materials, and more. This can be overwhelming if it is not
properly organized.
We suggest that you organize as you go, giving each item a descriptive name. There will
be ways to search for items by name, so start early. Similarly, give each ﬁle a descriptive
name and organize ﬁles into folders (or directories): a separate folder for each project, with
sub-folders for renders, texture images, background images, and so on.

219.0.2. Don't bite oﬀ more than you can chew
One of the greatest challenges faced by Blender users is their own imagination. While it's
great to be creative and imaginative, you have to pace yourself. Be aware of your limits
and the limits of your computer.
When making something from scratch, start with a very simple version of it and add details
gradually.
Test frequently; see how well your recent changes work before proceeding to the next step.
In this way, you will meet with fewer problems, and the ones you do run into will be simpler
and easier to ﬁx because there will be fewer possible causes to consider.
Monitor the complexity of your projects, watching for ”lag” or excessive disk activity which
might mean you are nearing your computer's limits.
When working on the computer, take frequent breaks to rest your eyes and stretch your
muscles. Eat, sleep and exercise regularly. While focused time at the computer is necessary,
inspiration and solutions to problems often come when our bodies are relaxed and our
mental focus is elsewhere. While you may be tempted to go wild, keeping a level head
while swimming in your imagination will give you a much more satisfying result with fewer
headaches along the way.
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220. Modeling Realistically
Everyone who starts a new career or hobby in 3D Modeling also seems to look around
their immediate environment for things to model. Things like your computer monitor,
your keyboard, and even the desktop which they are resting are all common ”ﬁrst models.”
Developing an eye for geometry takes time and this is a great chance to practice.
For this tips and techniques discussion, I'll start with the concepts of furniture and walls,
but the ideas really extend to anything and everything you can model in Blender, from
spaceships to fantasy demon-women, from your barbecue deck blueprints to biologically
accurate squids.

220.1. Assemble Things, Don't Chisel Them
Let's start with the furniture around you.
You may think it's easy to model your desk using a couple of boolean operations on cubes.
But it rarely comes out looking quite right. It seems like such a good idea at ﬁrst. Then
you ﬁnd that the drawers won't open realistically. The corners are all amazingly sharp and
crisp. The writing surface seems to be at the wrong scale for thickness. The woodgrain
goes in the same direction everywhere. You then realize it will be hard to bevel just the
few edges that need beveling. The more you look at it, even with good render settings, the
more it looks like dollhouse furniture instead of a real life, full size desk.
Real furniture is not chiseled out of a half-ton cube of mahogany, because trees don't grow
that thick, and it's a real waste to chip out the spaces for drawers. Instead, cabinetmakers
tend to assemble a piece of furniture from many component parts. Think of those ”selfassembly” kits from the local superstore, or even the showroom examples from a nearby
unﬁnished knotty pine store.
Model several kinds of boards and ﬁttings, then copy and assemble them appropriately.
You don't need to model every nail and dowel, and you don't even need to know what a
dovetail joint1 is. But you can make realistic furniture when you build things from their
natural components.
• Cut lumber in a variety of sizes and thicknesses.
• Measure real example furniture and take note of the construction details.
• Choose varying woodgrains by duplicating materials and adjusting them to be more
individual.
• Align those woodgrains or other materials in an appropriate direction and scale for the
model.
1

https://en.wikipedia.org/wiki/dovetail%20joint
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• Bevel just the parts or edges which are naturally worn or intentionally beveled.
• Any cloth, glass or metal ﬁttings are separate components using their own materials.
• Create an ”Empty” type object, give it a descriptive name, and parent all of the pieces to
it.
There are a couple more beneﬁts to this form of component modeling:
• Working with things made from multiple real materials is easier: one object, one material.
• The model is more ﬂexible, because they can be reconﬁgured to other styles more easily.
• Components come in handy for other models: adapt a desk's drawers in kitchen cabinets
and bedroom furniture.

220.2. Separate Objects for each Material

Figure 1581

skateboards, modeled in parts

A common question for new modelers is how to make one mesh that uses more than one
material. For example, a skateboard with metal trucks, rubber tires, and a wooden deck.
While Blender does provide an interface to allow such a combination, it is not usually the
best approach for modeling realistically.
If you model the skateboard as separate parts, based on the way diﬀerent real parts are
assembled, then you have a lot more control over the ﬁnal model. You can replace the
wheels or use trucks of diﬀerent styles later. You can adjust the mesh that deﬁnes the
shape of the deck, without having to re-assign the areas that should be one material or
the other. And lastly, you can choose to use subsurface tricks on the various parts, while
avoiding them on other parts. Even if the whole model needs subsurfaces, it becomes a bit
hard to control where one material starts, and another material ends.
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Removing the Fourth Wall

220.3. Removing the Fourth Wall
Just as with furniture, you may model your ﬁrst building interior as a hollowed-out cube.
It seems straightforward to make a big cube, turn it inside out, and call it a living room.
There are a lot of drawbacks to working with a room that was carved out of a single chunk
of solid rock.
Buildings and rooms are assembled from parts. Just like the furniture modeling tip, design
your rooms as a collection of separate pieces.
• You don't need to measure out the internal beams and joists, but remember they're there.
• Each interior or exterior wall should be its own object or assembly.
• Take care to note the correct dimensions and placement of doorways, windows, ceiling.
The beneﬁts of a component-modeled interior include:
•
•
•
•

Easier to see inside, just hide some walls on a diﬀerent layer.
Walls are much easier to move around to reconﬁgure the room layout.
The same modeling work on one area can be copied to other rooms more easily.
A more realistic architecture with consistent scaling is achieved quickly.

220.4. Proportions and Measurements
For realism, it's vitally important to get the right proportions for familiar objects. If your
audience sees a bookshelf with 5” thick shelves, or a human hand which has a 5” long thumb,
their brain is going to tell them that something is wrong. They might not be able to decide
why, but they'll tell you it looks fake.
Even when you're animating fantasy characters, you should develop an understanding for
proportion. Many cartoon characters have very large heads when compared to their bodies;
this allows room for greater expression and makes the characters seem younger. Deciding how many ”heads high” each character should appear will ensure that your ﬁgures all
maintain proper proportions to each other and to their environment.
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Figure 1582

soda cans and glass, modeled in parts

To get good proportions, you need to think about measurements.
•
•
•
•

Grab a ruler or ﬁnd some existing blueprints.
Think in terms of those measurements for the duration of the project.
Choose a base scale that will let you work comfortably within a 500x500x500 unit volume.
Blender limits cameras to 1000 unit distances, for better numerical accuracy.

You can mix and match base units, by using Empty objects as parents. For example, you
can model your furniture in inches or centimeters, and model your house in feet or meters.
Then when you append your bed.blend's objects, just parent that bed to a new Empty
object, and scale the Empty. This will conveniently scale all of the separate component
pieces of the object together.
There's only one big wrinkle with working with multiple scales: materials should be designed
with a certain base scale in mind. Many material surface properties are scaled according to
the units you choose for a given object, or the world units. Just consider this as you design,
and check your work critically.
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221. Modeling tips
This is not really a tutorial, but a list of handy tricks you will probably use a lot when
modeling.
1: Extrusion: to extrude, press EKEY in edit mode with the vertices selected, move and
click to place the extrusion. You'll basically need this for every model in blender, without
it, most models would be really hard to create.
2: Set Smooth: setting smooth will smoothen everything, without increasing the amount
of polygons and vertices. You can use it for models with a smooth surface. To apply set
smooth, select the mesh, go to the editing buttons (F9) and in the Links and Materials tab,
press Set Smooth. If you press the Set Solid button, it will go back to normal.
3: Remove Double: when you remove double vertices, they will melt together, this is good
for attaching things to each other. to remove double vertices, select the vertices, go to
editing (F9) in edit mode, and in the Mesh tools tab, press Rem Doubl, the limit button
next to it is the distance that the vertices have to have to be melted together.
Example use of these techniques:
http://www.geocities.com/gauravnawani/tutorials/beginner/
Extrusion:
a-vase-modeling.html (they explain subsurf here too, but I'd recommend set
smooth, because it doesn't increase the number of polygons and subsurf does)
http://biorust.com/index.php?page=tutorial_detail&tutid=77&lang=en
Remove Double: http://biorust.com/index.php?page=tutorial_detail&tutid=77&
lang=en (same tutorial as in the extrusion section)
Set smooth: http://www.blender.org/documentation/htmlI/x2681.html
If you want to add more handy techniques, please add them.
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222. Cheat the 3D
222.1. Ways to Improve Performance
In 3D Graphic Design, there are many issues to consider. First, consider how the project
moves, how the project performs. Next, consider how you create objects in your project,
especially when working with meshes and lighting.

222.1.1. Mesh
Modifying an object's properties
When you add a modifying property to an object, the computer has to calculate that
property every time it moves in the animation. These modifying properties include soft
bodies, particles, or mirror textures. They can signiﬁcantly slow down the computer.
To make things move faster, pre-calculate and ”bake” the modiﬁer into the object. To bake
a modiﬁer, such as a soft body movement, save the modiﬁer as a permanent animation.
That way no matter how the object changes, it moves the same way. As a result, your
computer does not calculate how the object moves. The move is already set.
There is a drawback. If the object moves and hits another section with diﬀerent slopes, it
will continue to move as if it was in the original baking site. You will have to calculate and
bake the section again to get new results.
Making 2D backgrounds
Scenes will have a foreground, background, sky, and more.
Your computer will take more time to render a scene that is big, open, and ﬁlled with
modeled objects. This wastes time and memory, especially when modeling an object far
in the distance. I'm guessing however, you do not want to make a quick, plain model. So
what do you do?
That is easy. You make a 2D background.
• Put the distant image or background on a plane.
• Verify that everything on the plane around the image is black.
If it is not black, set the Alpha to 0 if the image was saved in a format that supports Alpha.
This will retain the detail but reduce the number of faces the computer must count in the
scene.
• Set the image to Billboard to prevent the image from skewing by perspective.
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222.1.2. Materials
Using UV maps
For those who do not know the term, a UV map is an image applied to a 2D plane. The
2D plane is then applied to the mesh.
Here is how to create a UV map:
• Spread out the image onto a 2D plane.
• Apply the 2D plane over the face of the mesh using the 3D view.
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223. Performance vs. Quality
223.0.1. Mesh
Polygon Count - when you work with meshes in 3D, be aware that the memory usage
in Blender with reference to meshes comes from the number of faces (or vertices) the
mesh contains. That means that if you have many useless faces (such as 55 faces on the
side of a mesh that are as ﬂat as one face), the number of faces will directly aﬀect the
Render time of Images and Animations. Also remember that for smooth rounded meshes,
you do not need an inﬁnite number of faces to make it look really nice and smooth. You
actually don't need that many faces to keep a smooth slope looking smooth when viewed
from the side. The viewer's eye will not actually identify every ﬂat face, but will trace it
as a smooth curve.
Face Structure - 4-side (quad) vs.3-side (tri) - Poly Count is very important when
working in 3D graphics, and depending on the type of mesh you are making you could be
wasting a vast number of faces because they are not the right structure. For example, if
you want a smooth object, you can make it look mostly smooth when viewed from the
side if you make it with well-structured 3-vertex faces. You will also yield the same results
with fewer faces than if you use 4-vertex faces. Another example is that if you need to
apply UVTexture, or have something to animate, a mesh being evenly deformed will yield
a lower face-count if it is a 4-vertex versus a 3-vertex face-structure.
It is worth bearing in mind, however, that most graphics libraries deal exclusively with
triangles. This means if you are planning to export your mesh to a game or other external
3D application, whether you use quads or triangles will make no diﬀerence as all quads will
likely be converted into two triangles anyway.

223.0.2. Lighting
Using RayShadows or Buﬀer Shadows - There are a few options you have for using
shadows. Ray Shadows use an advanced algorithm to trace the edge of any interfering
objects and create a perfect shadow onto the receiving object(s); however, the Ray Shadow
calculation is memory-intensive and can seriously slow down your Render-Time. Buﬀer
Shadows, on the other hand, use a diﬀerent algorithm for similar results. The diﬀerence is
that buﬀer shadows use a bit-rate of shadow ”pixels” that ﬁll in the shadowing area. You
can adjust the bit-rate to make the shadow higher or lower quality. This calculation is
much more memory-friendly, and your Render-Time will not jump up as much as with Ray
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Shadows. An interesting topic because this will change with better hardware performance
and eventually won't matter. Until we get into 3D.
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Part VIII.

Miscellaneous Tutorials
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224. Modeling a Gingerbread Man
In this tutorial you will learn how to make a simple gingerbread man. In a later tutorial
you will be able to make an animation with this gingerbread man.
In this tutorial we will tie together everything we've talked about up to this point, including
extruding, subdividing and rendering, and throw in basic lighting.

224.1. Modeling
First, start Blender. You should see the usual top view of a cube in the 3D window,
surrounded by a grid 'ﬂoor'.
Review— Zoom in or out with SCROLL or CTRL+MMB. Pan with
SHIFT+SCROLL and CTRL+SCROLL. Make sure you are in orthographic
view. Press NUM5 to toggle between orthographic view and perspective view. You can
tell you're looking at an orthographic view while looking down from the top (NUM7) of
the cube: wherever you pan the window, you never see any part of the cube except the
top.
• Display editing controls in the buttons window by clicking on the Editing context button
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Figure 1583
or by pressing F9.

224.1.1. Adding Vertices
• Select the cube by clicking RMB on it. (It may already be selected.) Remember, selected
objects are outlined in pink.
• Switch from object mode to edit mode by pressing TAB, which toggles between object
and edit modes. In edit mode, at ﬁrst, you'll see colored dots at the vertices of the cube.
Selected vertices are highlighted in yellow. Unselected vertices are pink. (You'll see the
dots when editing in vertex select mode. In edge select or face select mode, you'll see
colored edges and faces instead.)
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• Select all vertices of the cube. Press AKEY once. If the vertices are yellow, you've
selected all of them. If they are pink, you've deselected all of them. If necessary, press
AKEY again so that all vertices are selected/yellow.

Figure 1584

• Subdivide the faces of the cube, using any of the following methods. (All vertices of the
cube should still be selected.)
• Click the Subdivide button in the Mesh Tools panel in the buttons window.
• With the mouse pointer in the 3D window −
• Press WKEY to display the Specials menu, then choose Subdivide.
• Press SPACE to display the toolbox, then choose Edit → Edges → Subdivide.
• Click the 3D window's Mesh menu, and choose Edges → Subdivide.
• Your cube now has more vertices. Subdividing edges adds vertices so you can create
more complex shapes.
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Figure 1585

224.1.2. Selecting a Subset of Vertices
We'll select six vertices on the upper half of one side of our cube, where we'll extrude an
arm.
• Deselect all vertices by pressing AKEY.
• View the cube from the front (NUM1).
• Select the six vertices on the top half of the left side of the cube (see below) using one of
the following methods.
• Press BKEY and drag a rectangle around the top left and middle left vertices (viewing
from the front).
• Press CKEY to see a circle around your mouse pointer. SCROLL to change the size
of the circle. Position the circle around the top left and middle left vertices, together
or one at a time, and click LMB. Click RMB to ﬁnish.
• Take a closer look at the selected vertices by viewing the model from a diﬀerent angle
(drag with MMB).
• If you ﬁnd that you have only selected two vertices and not six, make sure the ”Occlude
Background Geometry” button is oﬀ. That button is the right-most of the selection mode
buttons, below. (It's called ”Limit selection to visible” in Blender 2.45 and earlier. It
doesn't appear if Blender is drawing in wireframe style.) Try selecting the vertices again.
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Figure 1586

• If you still selected just two vertices, change to a wireframe drawing by pressing ZKEY,
which toggles between wireframe and solid drawing types. Try selecting again.
• Yet another way to select the six vertices is to select the two faces they deﬁne. Click the
Face Select button from the selection mode buttons (above), or press CTRL+TAB to
display a Select Mode menu and choose Faces. Rotate the cube to view the left side and
click RMB in the center of one of the two upper faces. Hold SHIFT and click RMB in
the center of the other upper face.
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Figure 1587

224.1.3. Extruding Arms
• View from the front by pressing NUM1.
• Extrude the selected vertices/faces by pressing EKEY to display an Extrude menu, then
choosing Region. Hold CTRL to snap your position to the grid, then move your mouse
left to put the new vertices on the adjacent gray line of the grid one unit to the left. Click
LMB.
• Repeat so that your model looks like below (from front view, NUM1).

1772

Modeling

Figure 1588

• Deselect all vertices/faces with AKEY.
• Perform the same extrusion on the right side of the cube, selecting six vertices and
extruding twice as explained above.
• The gingerbread man's arms are in place, as in the illustrations below.
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Figure 1589
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Figure 1590

224.1.4. Extruding Legs
• Make sure all vertices are unselected, using AKEY once or twice.
• View from the front (NUM1).
• Select the six vertices on the left half of the cube's bottom. Extrude them downward to
a point in between the ﬁrst and second heavier gray lines beneath the cube. (The gray
lines in the grid represent Blender units.) Holding down CTRL, the extruded region may
snap to the heavier gray lines—hold down CTRL+SHIFT and the region will snap to
tenths of Blender units. Click LMB to ﬁnish.
• An alternative to positioning the extrusion with the mouse is simply typing the distance.
Enter 1.5 to extrude 1 1/2 units out. On a Mac, enter the number 1, press fn with the
key that is right under LKEY and MKEY on Azerty (the one with /:,), and press the
number 5.
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Figure 1591
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Figure 1592

• Extrude the same region again, to the third gray line (1.5 again). It should look like this:
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Figure 1593

• Shift the lower leg to the outside as follows.
• Select the bottom 12 vertices of the leg (which look like 4 from front view), using
BKEY.
• Grab the selection with GKEY. Press XKEY to limit movement to the x axis. Move
the vertices to the left by half a square, holding CTRL or CTRL+SHIFT to snap
to the grid, and click LMB.
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Figure 1594
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Figure 1595

• Create a second leg on the right side, in the same fashion.
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Figure 1596

224.1.5. Dropping the Groin
Lengthen the groin (where the two legs join):
• Deselect all vertices by pressing AKEY.
• Select the 3 vertices at the groin (which look like 1 from front view), using BKEY.
• Grab the vertices by pressing GKEY. Press ZKEY to limit movement to the z axis.
Move the vertices down 1/2 of a square, or type -0.5 to specify the distance. (Older
versions of Blender require NKEY before typing -0.5.)
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Figure 1597
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Figure 1598

224.1.6. Adding a Head
• Switch the 3D window from Edit mode back to Object mode by pressing TAB.
Noob Note: I found it easier to remain in edit mode while creating the cube as this makes
the cube part of the original mesh. This allows you to add the subsurf to all parts at once.
• Click RMB on the object to select it then press SHIFT + SKEY and select Cursor →
Selection. This will make sure the cube you'll add next will be near where you want it.
• Press SPACE and put your mouse on the mesh option and select cube. In others versions,
you can also hit SPACE and , in the menu that comes up, choose Add → Mesh → Cube.
• Press GKEY and put your new cube about 1/3 of the way down the neck (to achieve
this, you can press GKEY and ZKEY : enter 1.33).
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Figure 1599

Now we will make it look more like a ginger bread man by making it thinner.
• Select all with AKEY.
• Go to side view with NUM3.
• Press SKEY for scale and press YKEY for Y-axis and then move your mouse to the
middle until it is about 0.3 (use CTRL for ﬁxed values).
• Remember X-axis is the Red arrow/line, Y-axis is the Green one, and Z-axis is Blue (like
RGB video mode).
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Figure 1600

• Use the MMB to spin the view around and examine your handiwork.
At this point, it doesn't look entirely like a gingerbread man, does it? It's a bit too ...
chunky. For the last bit, we'll smooth it out.
• Make sure you've selected the body in object mode.
• Select the editing panel in the buttons window (or hit F9).
• In the Modiﬁers tab, Add a ”Subsurf” modiﬁer.
• Set the level of the subdivisions to 2, and the number of render levels to 3.
Noob question: When I add the cube for the head, it stops me from being able
to edit the body - it will only select the head to apply subsurf to, even if the
body looks like it's selected!
Answer: When you created the cube you made a second object. To select a
diﬀerent object, press tab to enter Object mode. Select the body. Then enter
edit mode again if you want to edit the body.
• You can press the ZKEY to switch back and forth between wire-frame view and solid
view.
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• (Noob Note: Easiest way to really get a feel for what is going on in the 3d world is to
split into four screens and setting each one to NUM7, NUM3, NUM1, and NUM0 to
see all angles and what it will look like at render.)
Noob Question: How?
Answer: To split an area move the cursor to an area between two current areas
(e.g. between the 3D view and the buttons), when you see the double ended
arrow (used to move the divide) click RMB and select Split Area, you will then
see a line appear dividing the area in two. Move this to where you want the
divide and click LMB.
• In the 'Link and Materials' section, select 'Set Smooth'.
Noob question: Where? Assuming this refers to the 'Materials' section on the
'Properties' window, there is no 'Smooth' setting.
(Note that here I had the same problem as before, with superposed vertices. Select all
vertices, then press WKEY and selectRemove Doubles to clean your model. You will see
that it will look much better after removing the extra vertices with Remove Doubles)

Figure 1601

• Press the ZKEY to return to wire-frame view.
• Now repeat the process above to smooth the head.
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Figure 1602

Looks a lot more like a gingerbread man now, doesn't it?

224.2. Camera Positioning and Rendering
This guide will show you how to intuitively get the best frame of your 3D scene with no
eﬀort!
•
•
•
•

Press TAB for Object view mode.
Press NUM0 to get the Camera View.
Select the camera by clicking RMB on the outermost rectangle.
Press GKEY and move your mouse to adjust the position of the camera (XKEY,
YKEY, ZKEY and CTRL may be useful here).
• In addition, you can press NUM7 to get the Top View and press RKEY to rotate the
camera to the best angle.
• After you are happy with the position, press F12 to render it.
If your render comes out a little dark, try moving the lamp closer to the gingerbread man.
Noob note: Another way to move around the camera is pressing SHIFT + FKEY after
pressing NUM0 to enter Fly mode. The keys for ﬂy mode appear in the header of the 3D
view pane.
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Noob note: Ctrl+Alt+NUM0 ”teleports” the camera to your 3d view.

Figure 1603

Noob Note: By pressing X, Y or Z twice you will use a local base of the space, with those
it's much easier. For example if you are facing the Z axis from 45 degrees, and you want to
go left 1 unit, using the global base, you will have to go 1.72 (around sqrt(2)) along X and
the same along Y, instead moving by 1 in the local frame of reference.

224.3. Applying Textures
This builds on the previous guide: Modeling a Volcano1 .
Note: It seems that textures can only be applied to one object at a time, so this must
be done twice (i.e. The head and body are two separate objects.) The settings that were
chosen can successfully be applied to each object for a consistent result. Some settings can
not be applied equally for consistent results.

1
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http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Modeling_a_volcano

Applying Textures
N00b Note: if you join the 2 objects before applying the textures you do not have to do
the process 2 times, just select the 2 objects, CTRL+J and the accept
• In ”Object Mode,” select the body (or the head.)
• Press F5 to open the shading panel or use the shading panel button.
• In the ”Links and Pipeline” panel, under ”Link to Object,” click ”Add New.”

Figure 1604

• Press F6 to open the ”Texture Buttons” panel or use the textures button.
• In the ”Texture” panel, click ”Add New.”

Figure 1605

• Change the ”Texture Type” to ”Stucci.”
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Figure 1606

• In the new ”Stucci” panel, change ”Noise Size” to something near 0.025 and leave the
”Turbulence” at 5.00.

Figure 1607

Note: When ﬁnished with this section of the guide, come back to this panel and try
diﬀerent combinations of ”Plastic,” ”Wall In,” ”Wall Out,” and ”Soft Noise” / ”Hard Noise.”
Press F12 to render after each change to see the eﬀect.
• Press F5 again or use the ”Material” button directly on the left of the ”Texture” button.
Then look for the ”Map To” panel.
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Figure 1608

• In the ”Map To” panel, deselect ”Col[or]” and select ”Nor[mal].” and change the ”Nor”
Value to approximately 1.30.
• In the ”Map Input” panel, change the texture coordinates to ”Object” by clicking the
corresponding button.
• In the ”Material” panel, change the ”R[ed]” slider to approximately 0.400 and the ”G[reen]”
slider to approximately half that, about 0.200. Blue can be set at 0.00.

Figure 1609
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Figure 1610

Figure 1611

Note: While it is true that textures can only be applied to one object at a time, textures
as well as materials can be shared between objects. In this case it is best to let both the
head and the body share the same material.
• To do this, simply select the object without the materials(head or body).
• Press F5 to open the shading panel or use the shading panel button.
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• In the ”Links and Pipeline” panel, under ”Link to Object,” click the arrow next to(left of)
the ”Add New” button.
• Select the brown material.
The steps in this section give a nicely textured, brown surface to the ”Gingerbread.”

Figure 1612

Now all you need to do is add eyes and gumdrop buttons!
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225. Modeling a simple space-ship
225.1. Modeling a simple spaceship using Blender 2.49b
This is a simple tutorial on how to build a simple spaceship using blender
2.49b. One of the best things about blender is the adaptability that can be accessed through
its user interface. This tutorial will give you a look at some of the included blender scripts.
If you would like to make your own, however, you can refer to the scripting chapter of this
wiki book. So now, I guess we can get started.
Step 1: First, open blender. You should get the default blender scene with the cube in the
center. If you don't, try resetting your blender settings. Select the box in the center of the
screen.
Step 2: Now we're going to shape the box into any shape we want. For now, we are going
to shape it into a sort of triangle. If you want to use it as a box, that's ﬁne, but I suggest
following this tutorial using it as a sort-of triangle. To be able to modify it, in the lower
buttons area (with stuﬀ like Modiﬁers, Shapes, Multires, Mesh, and Link and Materials)
you should see a drop-down menu that is currently on Object Mode. Change that to Edit
Mode or hit the tab button. Now you will be able to modify diﬀerent aspects of your box.
Step 3: With your box selected, hit Ctrl+Tab, and choose Faces. This allows you to modify
the diﬀerent faces. Faces are basically the diﬀerent sides of your object, Edges are the edges
of your object, and Vertices are points on your object where edges connect.
Step 4: Now, on your box, right click on one of the sides to select that side. If you want,
ﬁrst take a look around the box and then choose a side, but don't select the bottom or top
face. To rotate around the box, hit the 8, 2, 4 or 6 button on your number pad, the one to
the right of the arrow keys usually. Those buttons allow you to rotate around your objects
and change your view. After you select the face you want, then rotate so that the face is
facing towards you and looks like a square, and so that the grid around it looks like a ﬂat
horizontal line.
Step 5: There should be three arrows converging in the center of your face (or in the
center of your box), and either the red or the green one should now be in the center
of your face, and the other should be going oﬀ to the left or right, with the blue arrow
going straight up or straight down. Use the 4 or 6 number pad button to rotate your
view so you can see whichever arrow was in the center of your face, and left click mouse
button on it, and hold the left click button, and drag the arrow around. Drag it until
you have a rectangle. http://i238.photobucket.com/albums/ff55/bryguy336/uh.png
http://i238.photobucket.com/albums/ff55/bryguy336/box.png
Step 6: Now to resize that face. With that face still selected, hit the S key, and move the
mouse around. This should enable you to change the size of the face, and once you click,
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it should stop resizing and stay at that size. Experiment and get the hang of it, and then
resize it so that it is an itsy bitsy teeny tiny box, and your rectangle more like a triangle.
Congratulations! You have just made your ﬁrst shape/object
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226. Create an animated GIF wallpaper
(Blender/GIMP)
This is my ﬁrst tutorial. I'll be teaching you to create this The quality is low because it is a gif. if it's a png or avi the quality'll be much better.

Figure 1613

Created for a tutorial for Blender particle systems
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227. Part 1 - Preparing the Scene
i Information
Applicable Blender version: 2.68

227.1. Start a new scene in Blender
• Delete the default cube.

227.2. Prepare the individual particles
Go to layer 2 -

Figure 1614

The layers buttons

Add a UV Sphere with 8 segments and 6 rings(Go to the toolshelf and change the values)
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Figure 1615

The Toolshelf

Add a new material with any bright color. Change the emit value to 2 or higher -

1800

Prepare the individual particles

Figure 1616

Material settings

Note - if you want a single-coloured version,
you can skip a few of the following steps -

227.2.1. Duplication of the particles
Duplicate the sphere and move it nearby ( SHIFT + D ). Duplicate the material by
clicking on the 'plus' button indicated in the picture below. Change the color to another

1801

Part 1 - Preparing the Scene
bright color
Important note - Not clicking the plus button will change the
color of the previous sphere also.

Figure 1617
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Material settings

Deﬁning the motion of the particles

Figure 1618

Single-coloured version

Repeat this process until you are satisﬁed with the no. of spheres with diﬀerent colours.
Now create a group ( CTRL + G ) Name it anything you like in the toolshelf ( T toggles
the toolshelf).
Now you're ready to start creating the animation and particles!

227.3. Deﬁning the motion of the particles
Go back to layer 1.

227.3.1. Creating the path for the particles to follow
If you haven't learnt about Bezier curves1 already, go ahead and do so now.
Add a bezier curve, and tab into edit mode. Now you have to model the path by extruding
and subdividing the curve. The shape of the curve deﬁnes the path of the particles. After
you are done with the curve, you can proceed to create the emission object.

1

Chapter 68 on page 637
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227.3.2. Creating the 'emitter' of the particles
Add a UV Sphere with 32 segments and 16 rings. This is going to be the emitter, i.e. the
object that gives out those coloured spheres.
This is going to have a completely transparent material since hiding it hides the whole
thing.
So go to material properties, add a new material. Scroll down to the Transparency panel,
check it and change the alpha value to zero, making it completely transparent. Also change
the specular intensity to zero. Leave everything else as such.

227.3.3. Making the sphere follow the path
In this part, you are going to make the sphere follow the curve you had modeled earlier.
Select the cube, and add a Follow Path Constraint. Select the target, i.e. the curve and
click on Animate Path. All these steps speak for themselves, there's no need for me to
explain. You could check follow curve, but since this is a sphere this is not needed. All it
does is make the object face the direction it is moving towards.
As for the speed of the object, you can change it by • Select the curve.
• Go to Object properties -

Figure 1619

The Object Properties

• Scroll down to Path Animation panel.
• Change Path Animation Frames value to the no. of frames you want the animation to
last. I prefer it to be 150.
In the end, make a few changes until you are satisﬁed with the result. Now you are ready
to proceed to part 2.
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228. Creating Weapons based on 2D
Images
Alright, this is my ﬁrst tutorial here, I made this a while back, but hopefully it will be a
good addition to this Wikibook. It was originally made for a game called Fable - The Lost
Chapters1 , but I think it is worthy of another place in the world. Please note that this is a
WIP and will be updated time to time.

228.1. Modeling Technique 1
Modeling Technique 1 Part 1 Video2
Part 1:
1. After emptying the screen, go to view and click background image, load, then choose
a picture of the weapon you want
2. Go to top view and add a square, then delete two of the vertices and place one of the
remaining on a point on the picture, and the other out of the way.
3. Select both vertices and subdivide.
4. Move the generated point to the next good-looking spot on the picture
5. With that selected still, select the outside vertex also, and subdivide.
(Note: A much easier way is to select one vertex, move it to where you want it, select the
other vertex, move it to the next spot, then extrude the second vertex to the next point,
rinse and repeat. This requires a lot less eﬀort.) Another guy's note: For an easier way,
just click CTRL+LMB where you want the next point to appear.
1. Continue until you are on your third to last one, then select your outside vertex and
move it where you would move the next vertex.
2. Select the ﬁrst and last vertices and go to mesh>>make edge/face
3. Extrude to half your preferred thickness, then extrude the rest of the way.
4. Select the center vertices on the blade, and scale up.
Modeling Technique 1 Part 23
Part 2:
cont.)
1. Then move vertices to your liking.
1
2
3

https://en.wikipedia.org/wiki/Fable_%28video_game%29
http://youtube.com/watch?v=isQzBvPGIx8
http://youtube.com/watch?v=R3UgOXYZMX4
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2. Select the vertices of the handle, go to mesh>>vertices>>separate.
3. Add a modiﬁer, choose subSurf, turn up the level until it looks close to what you want
without too many vertices. Click apply next to the modiﬁer.
4. Modify vertices (using proportional edit helps) to your liking.
5. Go to object mode, and turn oﬀ double-sided on any meshes that are.
6. If black appears on any parts of the mesh, highlight it, go to edit mode, select all
vertices, go to mesh>>normals>>recalculate outside.
7. If there is still black, select those faces and go to mesh>>normals>>ﬂip.
8. If there is still black, then you are missing a piece of mesh. Highlight the vertices
around the hole, go to mesh>>vertices>>ﬁll.
9. If black did not appear, then select everything (in object mode) and go to object>>join
objects and say yes.

228.2. Modeling Technique 2
Video Here4 Download it for high quality.
Blade:
1. Select all with the 'A' key, and delete everything.
2. Go to view and choose background image >> use background image >>load and pick
the sword you'll be doing.
3. Close the dialog after you see it in the background (you can change the brightness of
it by changing the 'blend' option)
4. Make a bezier circle by pressing spacebar and going to add>>bezier>>bezier circle.
5. put a bar at each main point of your weapon (anywhere the curve changes direction)
Bezier Controls5
1.
2.
3.
4.
5.
6.

Modify the bars until they match.
You might want to go into wireframe view.
Go down and turn up the bevel depth a little, to give it some sharpness.
To lower the poly count you should turn down the DefResolIU number.
Go back to object mode, hit spacebar, go to object>>convert object type>>to mesh.
Modify vertices to your liking.

For the handle:
1. Do steps 1-7.
2. Turn up the bevel resolution, to give it some roundness.
3. Repeat steps 8-10
For That one thing (see video):
Just watch the video, but here is a summary.
Extrude and ﬂatten a circle, use proportional edit to make it easier on you when you curve
the circle.
4
5
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http://files.filefront.com/modeling+tecnique+2+agkavi/;9221627;/fileinfo.html
http://wiki.blender.org/index.php/Manual/Curves#B.C3.A9ziers

Modeling Technique 2
For hilt guard:
1. Repeat steps 1-6
2. Add some extrusion.
3. Repeat steps 8-10.
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229. Modeling with Meta Balls
i Information
Applicable Blender version: 2.49

229.1. Getting started
To begin, open a new scene in Blender. Let's clean up the scene a little by selecting the
lamp and camera in the scene, press M to move them to a diﬀerent layer and click on the
ﬁfth layer from the left to place the objects. Go back to layer 1 and delete anything else.
You may also want to get rid of the grid by opening the View Properties and turning oﬀ
the Grid Floor and X & Y axes.
To block out our character, we're going to use an object type that is probably the least
used and useful of any known to mankind. Let's hear it for... Metaballs!
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229.2. Sculpting With ”Lumps of Clay”

Figure 1620

Go into the top view (important), press Space and add a metaball. Metaballs are a nifty,
ancient piece of 3D technology that is useful for creating blobs. (Similar to lumps of clay,
eh?) You create simple primitive shapes and scale and rotate them to block out your
character's shape. When the primitives come close to one another, they ”bleed into one
another” in much the same way that water droplets merge when they touch. Cool.
If you're using an earlier version of Blender that jumps out of Object mode into Edit mode
when you create an object, then press Tab to switch back to Object mode, as you won't be
able to scale your Meta primitive non-proportionally in Edit mode.
In Object mode, you can change these options for the entire Meta object, while tabbing
into Edit mode gives you more options for the selected meta primitive, such as changing
the type from Ball to Tube, Plane, Cube, ;;etc.; (You can also make ”Negative metaballs.”)
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Figure 1621

Press Shift+D to duplicate the Metaball, and place it where you like. Continue blocking
out your character, building enough blobs to represent the limbs or forms you will need to
sculpt your masterpiece.
The balls at the end of the limbs, were scaled SKEY larger, and then moved GKEY out
a bit more.
Don't get carried away and put in too much detail at this stage: use as few shapes as you
need. (This is supposed to be quick and fun, after all...)
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229.3. Meta-mess!
You should still be in object mode.
Now that you've got something that resembles what you're after, select all the Metaballs
and ( be in object mode) type ALT+C -> ”delete original”, to convert it to polygons so
you can actually do something with your blob.
Noob note: if you pick ”keep original” you will still have the meta balls present, plus have
a mesh version of the metaballs sharing exactly the same space. When you select ”delete
original”, the meta balls are turned into the mesh, and the circles that the metaballs were
originally in hang around, but are empty.

Figure 1622
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Beginning to sculpt
Still in object mode!
Delete any of those black rings left over from the metas and select your new polygon mesh.
If you Tab into Edit mode you will see terrifying ugliness instead of nicely gridded mesh.
”Surely we can't be expected to create anything useful out of this!” you shriek. Take it easy,
my friend. It's time to add a Decimate modiﬁer (make sure you're in object mode when
doing this to see changes).
Switch back to object mode!
The Decimate modiﬁer (you will only see things change if you're in object mode) will do
two things for us. Its primary job is to reduce the poly count of a mesh. A pleasant sideeﬀect for our purposes is that it will begin to rearrange the topology into a more manageable
heap of triangles and quads. Keep reducing the Ratio slider below 0.5 until it becomes as
coarse as you can stand. You want the lowest polygon base you can have that still maintains
enough detail in the limbs and shapes you made with the Metaball phase.
One thing to watch for is that this process sometimes creates holes as it does its best to
simplify the mesh. I ﬁnd that usually you can slightly change the Ratio to ﬁx the problem,
but if you're still ﬁnding holes, check out the ”Tips & Tricks” section at the end.
As you can see, this step greatly reduces the Face Count, which will be good later. Next
we need to get rid of as many of those triangles as possible. Click Apply (in the modiﬁer
panel)
Switch to Edit mode!
Press A until all of the vertices are selected (turn yellow) and hit Alt-J to convert the faces
from triangles to quads, which will subdivide better. Now you should have something you
can work with.

229.4. Beginning to sculpt
Right next to the Modiﬁers panel is the Multires panel. (Note: In recent versions of
Blender this is not its own panel---it is a Modiﬁer.) A multires object has the options to
add numerous levels of smooth subdivision to a mesh. While you can use the sculpt tools
on any polygon or nurbs mesh, the great strength of sculpting with Multires is the ability
to jump back and forth to diﬀerent levels, quickly sketching out the gross form at lower
levels, and adding ﬁner detail at the higher levels. Add the Multires and Add a level; we're
ready to sculpt!
Noob note: If nothing seems to be happening while you're trying to sculpt your mesh,
it's because you haven't applied your Decimate. it must be locked down and applied before
you're actually allowed to do anything to your mesh.
Noob note: Only apply multires once, doing it a few times will quickly increase the
polygon count to amounts that will really slow blender down
In case you haven't noticed, Blender's diﬀerent modes oﬀer diﬀerent tool sets and options.
To make the sculpting tools available you need to be in Sculpt mode, accessible through
the Mode drop-down in any 3D window header. You'll see two new tabs next to the multires
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panel, Sculpt and Brush. Sculpt has most of the options you'll need to begin shaping your
mesh. Note that most of the diﬀerent brushes in this panel have hot-keys which will save
a lot of time(G=Grab, D=Draw, S=Smooth, etc.). Most important here is changing the
brush size and intensity. Pressing F and dragging the mouse will resize the brush, while
Shift-F will allow you to adjust the Brush Intensity. You can also turn on Symmetry to
paint, for instance, both sides of a face at one time. This can speed up tasks tremendously,
as long as your mesh is aligned to the axis properly.

1814

230. Match Moving
Match moving is the technique of recreating the position of the camera used in recording
live action footage. This information can then be used within Blender to merge 3D objects
with live action ﬁlm. For a more detailed discussion of the concept, take a look at the
Wikipedia article on Match Moving1 .
Blender cannot perform match moving itself, you must use a 3rd party tool to determine the
camera position and the way it moves, then import this data into Blender. While there are
many software tools to do this, this page references two free options: Voodoo and Icarus.

230.1. Icarus
Icarus2 is a discontinued University of Manchester project which can be used for noncommercial work. The download links from the oﬃcial page no longer function, but Windows and MacOS X versions are available from this Icarus video tutorial3 by Colin Levy.

230.2. Voodoo
Voodoo4 is an actively developed free match mover available for Windows and Linux. Here
is a tutorial on using Voodoo and Blender5

1
2
3
4
5

https://en.wikipedia.org/wiki/Match%20Moving
http://aig.cs.man.ac.uk/research/reveal/icarus/
http://peerlessproductions.com/tuts/pages/Icarus.html
http://www.digilab.uni-hannover.de/docs/manual.html
http://fictionality.co.uk/doku.php?id=tutorials:matchmoving
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231. Match Moving/Motion Tracking
with Icarus and Blender
Motion tracking, also called Match moving1 , is an essential element when integrating
3D elements with live footage. Motion tracking software is usually pretty expensive, but
the Icarus application (Windows and Mac) is available for free for educational use. Icarus,
which hasn't been updated for while, was later replaced by the commercial application
PFTrack2 . Other popular motion tracking applications are PFMatchit3 and PFHoe4 (both
also from The Pixel Farm), Voodoo5 (for Windows/Linux; free for non-commercial use),
SynthEyes6 , Boujou7 and 3D-Equalizer8 (commercial).
The excellent CG prodigy Colin Levy9 hosts Icarus(by kind permission of The Pixel Farm
Ltd), the Icarus import script for Blender, as well as a splendid video tutorial (see Download
Icarus and Video Tutorial10 ). However, I lacked a brief text tutorial about motion tracking,
so I decided to write my own. This tutorial is extremely brief and high-level, and requires
some previous knowledge on video editing, 3D, and Blender.
Note: this tutorial was created using Mac OS X 10.5 Leopard, Blender 2.46, Icarus 2.09,
and the Icarus Import Script for Blender11 v1.07e (for Blender 2.41, written by Alfredo de
Greef).

231.0.1. Tutorial
Phase 1: Preparing the Video Footage
Note: this tutorial explains the Auto-feature Tracking mode in Icarus. There are other
options which gives more user control - see the Icarus UserGuide.pdf for more information.
1. Record your video footage. Having the camera on a tripod (thus limiting to just
panning/rotating) simpliﬁes the tracking, but Icarus can handle a hand-held camera as well. Filming a background with orthogonal lines (that can align to X/Y/Z
dimensions), such as a room, also helps the tracking.
1
2
3
4
5
6
7
8
9
10
11

http://en.wikipedia.org/wiki/Match_moving
http://www.thepixelfarm.co.uk/product.php?productId=PFTrack
http://www.thepixelfarm.co.uk/product.php?productId=PFMatchit
http://www.pfhoe.com/
http://www.digilab.uni-hannover.de/docs/manual.html
http://www.ssontech.com/
http://www.2d3.com/product/?v=1
http://www.sci-d-vis.com
http://www.peerlessproductions.com
http://www.peerlessproductions.com/tuts/pages/Icarus.html
http://old.colinlevy.com/tuts/IcarusTutorials/Icarus.php
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2. Capture/import your video footage to your computer. Icarus handles video up to DV
resolution (720*576 pixels).
3. Start the Icarus Calibration application (there is also a Distortion and a
Reconstruction application).
4. Create a new project (Project->New).
5. Import your video footage (Project->Import Movie).
6. Fill in the Camera Parameters information in the window that pops up - especially
the Camera Motion and the Pixel Aspect options.
7. In the left panel, expand the group called Coordinate Frame. You should see X Axis,
Y Axis, etc.
8. Click the Z Axis tool (blue) and mark vertical lines in your video footage. Use the
X Axis (red) and Y Axis (green) tools to mark horizontal lines (up to you to decide
which should be X and Y).
9. Estimate the focal length (Camera->Estimate Focal Length).
10. Navigate in time in your video footage using the time slider (beneath the video image).
Add more X/Y/Z marker lines on a few key frames, especially as new pieces of the
background are revealed when the camera moves.
11. Save your project (Project->Save).
12. Start the tracking process (Camera->Track and Calibrate). This will take some time.
13. Export the results in human-readable form (Project->Export 3D Motion, select Human Readable (*.txt) as ﬁle type).
Phase 2: Importing the Motion Tracking Data into Blender
1. Start Blender, and open a Text Editor view.
2. Open the Icarus import script ICARUS_import241.py (File->Open).
3. Start the script (File->Run Python Script). You should now see the Icarus Import
screen.
4. Press the FSEL button, and open the results you exported from Icarus.
5. Press the Create Curves button. This imports the camera motion from the Icarus
data and applies it to the Blender default camera.
6. Press the Feature Points Mesh button. This imports 3D shape dots from the Icarus
data, which helps as reference when you want to align your own 3D elements to the
video footage.
You are now ready to add your own 3D elements to the Blender scene.
Phase 3: Compositing 3D Elements on top of Video Footage
If you want to easily composite the 3D elements on top of an image, you can add the image
as the rendering back buﬀer in Blender (Scene tab in the Buttons view). However, this
doesn't work for videos, so we need another solution.
1. In Blender, switch to SR:4 - Sequence in the layout dropdown menu at the top of the
screen.
2. In the Video Sequence Editor view (middle of screen), add your video ﬁle (Add>Movie). Move the new strip to layer 1, frame 1.
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3. Add the current scene to the sequence (Add->Scene, Scene). Move the new strip to
layer 2, frame 1.
4. Select the scene strip on the second layer (right-click).
5. Open the Scene panel in the Buttons view, and then open the Sequencer sub-panel.
6. Change the Blend Mode dropdown from Replace to Alpha Over. Your 3D elements
should now render over the background video in the top-right preview screen.
7. In the Render panel, enable Do Sequence just below the ANIM button. This will
enable the background video when rendering.

231.0.2. Troubleshooting
• If your imported Feature Points Mesh looks a bit spherical, you need to generate camera
distortion data using the Icarus Distortion application.
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232. Create a Clayman
232.1. Create a Clayman
(under construction)
This Tutorial was made using Blender version 2.41
Upon completing this tutorial, you will have made something like this:

Figure 1623

Completed Clayman Render

232.2. Making The Clayman
Upon start, delete the default cube (X-KEY) and switch to front view with NUM1. Now
add a mesh plane and under The Edit Buttons Window, Mesh Tools Tab click the subdivide
button. Now select the 3 vertices on the left and delete them. (B-KEY for Border Select
Tool)
If you can't select the vertices then deselect the Limited Selection to Visible button.

1821

Create a Clayman

Figure 1624

Now select/deselect all vertices with A-KEY (we want them selected)In the Modiﬁers Tab
in the Edit Buttons Window, Click Add Modiﬁer > Mirror You should now see something
like this.
Figure 1625

Now select the 3 right vertices and extrude them on the X axis by movement of 1.0 units
by pressing E-KEY (Extrude > Only Edges), X-KEY (to constrain it to the X axis) and
holding CTRL to constrain it to simple movements. Do this twice.
Figure 1626

Now extrude the legs by selecting the 3 bottom-right vertices and extruding them on the Z
axis by 1 unit. Do this twice as well.
Figure 1627

Now extrude the top of the clayman on the Z axis (in units of 1.0) 7 times so that it looks
like this.
Figure 1628
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Now let's make the arms by extruding the 2 boxes that are 3 boxes down from the top.
Let's extrude it on the X axis by 1 unit 4 times so that it looks like this.
Figure 1629

Now comes the extrusion of the whole body. As you can see, we only have a ﬂat shape of a
rough ”Block”. so lets move our view around with the NUMPAD arrows and extrude it on
the Y axis. Select all vertices with A-KEY. Extrude > Region on the Y axis until it reaches
2.0 units. After done correctly, it should look like this.
Figure 1630

With the Clayman successfully extruded, its now time to add some deﬁnition to him by
adding a subsurface modiﬁer. In the Edit Buttons window, under Modiﬁers, click Add
Modiﬁer > Subsurf and set the Levels bar to 2. It should look somewhat like this.
Figure 1631

Now, Select all vertices with A-KEY, and click the Set Smooth button in the Links and
Materials tab. Let's get to shaping the Clayman.Using the Border Select Tool (press B to
get the Border Select Tool), grab the according vertices to make a shape like this.

Figure 1632

after that's done, select the head vertices and grab them on the Z axis and move them up
by 0.2 to make it look like this.
Figure 1633

Now select all vertices with A-KEY, and scale them down (S-KEY) on the Y axis until it
reads 0.6000. And ﬁnally, select the underside of the foot (the vertices that make it up)
and subdivide it to make ir more ﬂat on the bottom.
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232.3. Adding Materials
Start by going to the Material Buttons window (F5) and Clicking on Add New, and going
down to the collumn of 3 rectangles that have one gray one and two blank white ones.
Click on the gray one and in the top-right corner of the pop-up window, you'll see a Hex
Code. Click on the current hex code and type in this new hex code to get the right color:
73BCF7. Now hit F6 to go to the Texture buttons window and click on Add New. Change
the Texture type to Stucci. Now you'll see a new tab appear. On it, for NoiseSize enter
0.150. Now go back to the Materials Buttons window. On the far right there will be three
tabs in one. On the Map To tab, Deselect Col and select Nor. Now your example should
look like this.
Figure 1634

232.4. Inserting Armatures
Now lets move on to inserting armatures in our clayman. Lets start by going into object
mode (alternate between Object and Edit mode with TAB) and adding an armature. Press
Space > Add > Armature. It automatically puts you in Edit mode upon adding the object.
Switch to Object mode and grab it along the Y axis by 1.0 units so that it's inside the
clayman. Sure, you can't see it now, but turn on X-axis Mirror Edit and X-Ray in the Edit
Buttons window.
Figure 1635

Now switch back to edit mode, and select the top of the bone. Etrude it on the Z axis by
1.4 units two times so that the tip of the second extrude is right in the center of the two
arms. Now extrude it on the X axis by 3.0 units, then grab the tip of it and move it on the
Z axis by 0.1700 units. Now extrude it on the X axis by 2.0 units twice. And do the same
to the other side. It should look like this.
Figure 1636

Now let's extrude the neck. Extrude the top bone along the Z axis by 1.0 units to make a
pretty good size neck. Then extrude it up on one side so that the position reads like so. If
you can't get it exact then at least try to get it as closest to the number as you can.
Figure 1637

Then do the same to the other side so that it looks like 2 antennaes. Now let's extrude
the hips and legs. Lets start by extruding the bottom bone by 2.0 units on the X axis and
for the Z axis, -1.0 units. Then extrude the foot by -2.0 on the Z axis. And last, select
a forearm bone (select a whole bone by clicking the middle of it) and in the Edit Buttons
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window, you'll see a tab called Armature Bones. Deselect the Con button in that tab, and
do the same with the other forearm bone. This allows us to be able to move the forearm
out, instead of having it locked to another bone.

232.5. Applying The Armature
Ok, now we're going to apply the armature to the mesh so that when we move the bones,
the mesh moves along with them. Lets start by switching to object mode and selecting
the clayman mesh, and under the Modiﬁers tab, click apply on the Mirror modiﬁer. You
may see a pop-up, just click OK. Not only have we just made room in the Modiﬁers tab,
we applied the mirror modiﬁer to the mesh, so now we will have to edit both sides if we
want to change something. But worry not, we wont need to change anything from here on.
With that new space in the modiifers tab, let's add an Armature modiﬁer. You may see
a line that says ”OB:” type in the name of the Armature in here (the default name for an
armature is ”Armature” unless you have made more than one) also, deselect the Envelopes
button,for we will not be using envelopes in this tutorial. Here is what you should have.
Figure 1638

Now, select the Armature and press CTRL + TAB. If you already have a bone selected,
it should be highlighted blue now. We have just switched to Pose Mode. Now, while in
Pose Mode, select the clayman mesh (if you cant select it, zoom in closer to get some of the
bones out of the way) and press CTRL + TAB on the clayman mesh. We have just entered
Weight Paint Mode. This allows us to assign vertices to the bones so that the mesh moves
with the bones. Let's start by setting up the weight painting. You should see a new tab
called Paint in your Edit Buttons window. Adjust your settings so that they conform to
this.
Figure 1639

Start by selecting the top-right bone of the head and start weight painting the front and
back (you'll have to switch your view so that you can see the back to get the painting in
there) Weight Paint it according to this.
Figure 1640

Now Weight Paint the Neck. (pictures not shown of back view, but be sure to get the back
anyway)
Figure 1641

Now the Shoulder.
Figure 1642
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Now the Forearm.
Figure 1643

Now The Hand.
Figure 1644

And after getting the other side of the body, let's get the upper chest.
Figure 1645

Now the middle chest.
Figure 1646

Now the lower chest.
Figure 1647

Now for the hips.
Figure 1648

Now the Feet.
Figure 1649

After doing the other side of the leg, switch back to Object Mode with CTRL + TAB, and
select the Armature. You should already be in Pose Mode with the Armature. Now select
a bone and grab it to move it. if you have Weight painted correctly, the Clayman mesh
should move with the bone. There's two tips to moving the bones around in Pose Mode.
1) In the Edit Buttons window, whether Automatic IK is turned on or not aﬀects how the
bones move.
2) Where your view is aﬀects how the bones rotate. (unless you have it constrained to an
axis)
If you ﬁnd that a part of your clayman isn't moving, just switch back to Weight Paint mode
for that bone and repaint it.
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233. Organic Modeling
Subsurface modeling
Organic modeling is considered by some the most challenging. Non-organic can mostly be
accomplished by extrusion and scaling. Organic modeling on the other hand involves mainly
curves, as nature has a thing against straight lines. Because of this, organic modeling is
usually done with subsurfaces. To subsurf a mesh, ﬁrst select it and navigate to the 'Editing'
tab. Then go to the modiﬁers stack and add a new Subsurf modiﬁer.

1827

Organic Modeling

Figure 1650

In Blender 2.5 Alpha 0, Subsurf has been removed from the modiﬁers list. Instead hit Ctrl,
followed by a number which will specify the subsurf level. For example Ctrl-1 adds a new
Subsurf modiﬁer of level 1. This also works in Blender 2.4. Increasing the level greatly
increases the number of verts in your model, so make the level relative to the number of
vertices in your original model (pre-subsurfed). Subsurf often works best in conjunction
with smoothing, so be sure to set your object to smooth, again in the 'Editing' tab, or
in 2.5 A0 under 'Object Tools', which you can bring up by hitting the T key in the 3D
viewport.
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Figure 1651

In this way you can create a smoother, higher-poly shape based on that of the original
mesh. This is controlled by the vertices, edges and faces of the original.In order to control
the rounding of your mesh you can use two methods: loopcuts, which is a very sloppy
method as it adds more verts to your mesh, which serve very little purpose and can get
in the way of modeling; and Edge Creasing. The latter can work extremely well in most
circumstances. By default all edges are declared uncreased, and so allow complete rounding
in subsurﬁng, by creasing the edges using Shift-E you can far better control the amount
of rounding on your mesh, and most importantly, without adding extra vertices. However,
unfortunately Edge Creasing is not available in Blender 2.5 A0. Yet. And so loopcuts and
extra verts are the only option.
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Figure 1652

Before

Figure 1653

After

Now, start shaping your mesh into an organic shape. There are various tutorials for modeling bodies and faces, but it is often a good idea to use references. Only use quads - that is,
shapes with four vertices. Triangles do not subsurface well, they create bad looking rough
surfaces - avoid if at all possible. Also avoid Poles, which are vertices connected to anything
other than 2 or 4 other vertices, as they create literal creasing in your subsurfed mesh, that
is, sudden bunching up and pinching of faces.
To make the object shape properly, you will need good edgeloops and edgeﬂow. This
means that all your vertices and/or faces line up in a continual line or curve around your
model. It is possible to select edgeloops all in one, fantastic when you have to resort
to them in controlling rounding, by holding down Alt when selecting a vert. This really
expands into topology, which is an advanced subject. I would recommend visiting http:
//www.subdivisionmodeling.com/forums, although it has just been closed down, which
was a great place to start, however it still (at the time of revision) is active and well worth
a look if you are struggling with modeling heads. It is best not to have too many vertices to
avoid making the subsurfaced shape look rough - in other words, the original shape should
be quite low-poly.
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234. Understanding the Fluid Simulator
234.1. Understanding the Fluid Simulator
When I ﬁrst encountered the Fluid Simulator I had a hard time understanding its behavior,
especially the Start time and End time didn't seem to make any sense at all. Going on a
Google spree revealed that many people have problems ﬁguring out the secrets behind ﬂuid
simulation, and I didn't ﬁnd any truly helpful guides. In this little guide I'll try to explain
it in a newbie friendly way. It may not be entirely correct, although it might help newbies
understanding how it works.

234.2. First of all
Start time and End time are in seconds. Don't forget this. Even if your simulation seems
to go insanely fast when you set Start time to 0 and End time to 10 and having 250 frames
in your animation with 25 frames per second, there is a good reason for this. For now, just
remember this, don't let your mind wander and believe that the values are in milliseconds
or that you have to do some wicked math dividing/multiplying with frames and so on.
Also notice that the domain is the bounding box for the whole ﬂuid calculation. EVERYTHING is done inside this box. It acts as the ﬂoor, ceiling and walls for all of the ﬂuid.
This is very important, as the number 1 reason why I couldn't get a good ﬂuid simulation
going. If I have time, I will do a section on Fluid > Control, but for now, I will say that it
adds a LOT of calculation time. Running on an I7, ATI Radeon 8970 Video, Asus P6X58D
Premium, 64-bit Windows 7 and 64-bit Blender, I crashed my computer with the lowest
quality settings. So just remember that the domain MUST surround the area in which you
do calculations. Also note that after you set up your simulation, the domain becomes the
actual liquid, so give it proper material and try not to bake until you're pretty sure of your
simulation.

234.3. Setting up the scene
We'll learn how the ﬂuid works the practical way. plane
•
•
•
•

Start with the default box, this simulation will be very simple.
Let's work in wireframe mode, press the ZKEY to turn oﬀ solid mode.
Go in to camera view by pressing Numpad0.
With the box selected, scale it up to two times by pressing SKEY, then 2, then ENTER.
This ﬁts the camera fairly well.
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• Press Numpad7 for a top view.
• With the box selected, press Shift-D (don't move the mouse or else the duplicated box
will move) then press ENTER to conﬁrm the duplicated box's location. If you do move
the box, just press Escape then the new box will be kept but the move cancelled.
• While the new box is selected (and in exactly the same spot as the other box), press
SKEY, then .5, then ENTER to scale it to half size.
• Stay away from the mouse, accuracy is important here and I'll explain why later.
• Now we want to move the new box into one of the upper corners. Press the GKEY,
then press the XKEY, type in -1, press ENTER and the box should move to the left
wall of our larger box.
• We want the box in a corner, so press GKEY Y 1 Enter, the box should now be in the
top left corner from our current view.
• However, we're in 3 dimensions, not 2 so click Numpad1 for a side view. This time we'll
move the box up along the Z-axis: G Z 1 Enter.
• Excellent, our setup is done.

234.4. Setting up the simulation
• Make sure you're in Object Mode, and that you followed the above steps precisely.
• Select the smaller box and click F7 twice. You should get a panel where the rightmost
pane says ”Fluid Simulation”. Click Enable.
• Our small box will be the ﬂuid, so just click the Fluid button. That's all there is to do
with the small box.
• Now select the large box. The Physics panel should still be visible, click Enable in the
Fluid Simulation pane and then select Domain.
• By default your animation should have 250 frames. Rendering should also be set to 25
frames per second by default, this tutorial assumes this setup.
• Since we got 250 frames and 25 frames per second that means our animation is 10 seconds
long. So here comes the tricky part, which actually isn't that tricky at all:
• Start time is by default set to 0 seconds. This means that on the very ﬁrst frame the
simulation has just begun. You could increase this value to say, 1 second and that
would mean that on the ﬁrst frame the ﬂuid simulation has already run for 1 second.
We don't want to do this, so keep it at 0 seconds.
• End time is by default set to 0.3 seconds. What does this mean? This means that
on the 250th frame the simulation has run for 0.3 seconds. However, by default our
animation is 250 frames long with 25 frames per second, making those 0.3 seconds
stretched over 10 seconds. Basically this means that we're watching the show in slow
motion, or slightly less than 1/33 the realtime speed. So now you may think ”it looks
quite realtime to me!”, and yes, it does, but why does it do that? Well, that's hard to
explain. Consider this: In a world without friction, how far would a drop of water fall
after 1 second? The answer is about 4.9 meters. So, if a drop of water falls from 4.9
meters it will take 1 second before it reach the ground. How long would it take the
waterdrop to reach the ground if it falls from 3 centimeters? About 0.078 seconds. So
why do i mention 3 centimeters? Because by default the size of our domain is 3x3x3
centimeters, or really small. If you're like me, you were probably thinking that the
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ﬂuid was ﬂowing around in a bathtub or a barrel, not in the wrapping of a cupcake.
Set End time to 10 seconds.
Since our imagination likes big things, let's crank up that cupcake to say, a swimming
pool. Make sure the big box is selected in Object Mode In and look at the Fluid Simulation
pane. Just to the left of the ”BAKE” button there should be 3 other buttons, possibly
named ”St”, ”A”, ”B”. Click A for advanced options.
Some new boxes should appear, Gravity (should be -9.81 for the Z-axis, nothing else),
Water and the option we're looking for, ”Realworld-size”. Also Gridlevels and Compressibility, but let's not care about those now.
The ”Realworld-size” value says how large our domain is in meters, and as you can see
it's 0.03 meters by default, or 3 centimeters. We want it huge, so crank it up to 10,
which is the limit for Blender 2.45. Now our swimming pool is 10x10x10 meters (don't
drown!), remember this because scale matters with ﬂuid. Do not think we're playing with
cupcakes again :)
Now click BAKE, and read on while your computer is chewing zeroes and ones.
Remember how I told you to be very accurate about placing that second box? And how
I began talking about gravity, falling waterdrops and stuﬀ? Well, now you're going to
see why.
As stated, our ”swimming pool” is 10x10x10 meters. The smaller box we added is exactly
half the size (well, in terms of length/width/height, not volume), or 5x5x5 meters. Remember that a drop of water would fall 4.9 meters in 1 second? And that our animation
got 25 frames per second? This means that the bottommost part of our blob of water
will be exactly 5 meters above the ”ground”, and that after 25 frames our water should
be very close to the ground.
If you got a fast computer, Blender should be done baking by now. Go to frame 25, for
example by using the arrow keys (up/down goes 10 frames forwards/backwards, right/left
goes 1 frame forward/backward). Take a close look at the blob, then go forward 1 frame.
Notice how the blob hits the ground? Rings a bell, doesn't it? :)
Although, we're not done! We gotta render our swimming pool. It's easy, but takes time,
hit Ctrl-F12 and go make dinner.
When the rendering is done, press Ctrl-F11, and think of a 10x10 meter large pool. You
might want to keep an eye on your kids if your local swimming pool acts this way, though.

234.5. Final notes
Scale matters. It's really diﬃcult to understand ﬂuid dynamics on a very small scale,
especially when you don't even know what scale is used. The ”Realworld-size” value seems
to be left out in many guides, I would recommend you set it to something you can relate to,
or you'll end up with simulations that look really slow/fast or having an End time value
that seemingly makes no sense. Further I'm not a mathematical genius, for all I know I
could be way oﬀ with my explanation, although this way the values makes sense to me, and
I'm able to make ﬂuid simulations without ”guessing” on values for End time.
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234.6. Extra Practice
This YouTube tutorial on ﬂuids might also help: Link1 and this Realistic Water Texture2

234.7. Links
• Youtube: Comparison of diﬀerent values for resolution and real-world size3

1
2
3
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http://au.youtube.com/watch?v=yMBx2pYiqnY
http://forum.nystic.com/viewtopic.php?f=34&t=1445
http://www.youtube.com/watch?v=okHt4z3FGGM&hd=1

235. Creating a jewel in Blender
In this tutorial we will create a jewel in Blender. It is fairly simple. I recommend you do
this tutorial if you are a noob, because it explains some basic features, but I suggest you
read the tutorial syntax and the pages at the very beginning of this Wikibook ﬁrst.

235.1. Modeling the jewel
Start up Blender if you haven't already. There is a cube in top view (it looks like a square
because it is in top view.) Delete it by pressing the X key. Then, to begin modeling, add a
circle by pressing SPACE→Add→Mesh→Circle. Set the vertices to 10 and make sure it is
not ﬁlled in. Then press OK.

Figure 1654

Next, we will extrude the vertices down. First enter side view by pressing Numpad 3 on
your keyboard. As you can see, the circle is ﬂat and not ﬁlled in. We will give it some depth.
Switch to Edit Mode (TAB) and extrude the circle by pressing the E key and selecting ”Only
Edges”. Move the mouse down and click to conﬁrm the position (you may want to limit to
Z axis by pressing the Z key).
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Figure 1655

OK, what we just did is turn the circle into a hollow cylinder by extruding. But we don't
want a cylinder. We want the bottom to be a nice tip. To do this, press Alt-M. This creates
a Merging menu. Select ”At Center”. Now the bottom is a nice tip, like we want it!

Figure 1656
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Modeling the jewel
Now we will edit the top of the jewel. Press A to deselect everything and press the B key.
This enters Box-Select Mode. Drag a box over the top vertices to select them.

Figure 1657

Now extrude the vertices upwards a bit (again: E key and ”Only Edges”). Next, we will
scale down these vertices to look a bit more like a jewel. Make sure the ring of vertices are
selected and press the S key. This enters Scale Mode. Scale down the top vertices a bit and
click to conﬁrm.
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Creating a jewel in Blender

Figure 1658

To look around your jewel model use the Middle Mouse Button or Alt-Left Click. Your
jewel is looking fantastic! But there's a big gaping hole at the top. We'll ﬁx that. First,
enter side view (Numpad 3). Now extrude the topmost ring of vertices but don't move them
anywhere with the mouse. If you are feeling doubtful, just press 0 and then Enter (or just
click right mouse button). This makes a duplicate of rings placed over the original. Next
merge this new ring with Alt-M -> At Center. This merges the duplicate ring, thus ﬁlling
up your hole.
At last! Your jewel is ﬁnished! Feel free to rotate around it and make further adjustments
if you are more advanced with using Blender.
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Shading

Figure 1659

235.2. Shading
Switch back to Object Mode (TAB) and show the Shading Panel (F5). Enable the Material
Buttons (click on the button with a red ball). Add new material by clicking on ”Add New”
button in the ”Links and Pipeline” tab. Copy the settings in the screenshot below. If you
are having trouble setting the precise value to a slider, just click on the number. This allows
a manual type-in. First, make it green by setting R to 0, G to 1, and B to 0. Next set the
alpha slider to 0.458 (it looks like an A). Now press ”Ray Mirror” (raytracing reﬂection) to
turn it on and set it to 0.13. Now press ”Ray Transparency” and set the IOR value to set
1.44. When you're done it should look like this:

Figure 1660
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235.3. The ﬁnishing touch
To improve the eﬀect, add a plane underneath the jewel. In the Object Mode (TAB) press
SPACE>>ADD>>MESH>>PLANE. Scale it 5 times using the S key. Then move it down
a bit using the G key (press the Z key to restrict movement to the Z axis).
You may try to render your jewel now. Press the F12 key. You may ﬁnd that camera
doesn't see whole jewel. Move and rotate the camera (using the G and R keys) to set it
in the right position. You may want to switch to ”Camera View” (Numpad 0) and try out
”Camera Fly Mode” (SHIFT F). Try also moving the lamp and see what happens.
I've found that the jewel looks best with Ambient Occlusion on. So go to the Shading
window, then the World buttons, click the Amb Occ tab and click the Ambient Occlusion
button.
Here is an example of what you can do:

Figure 1661

235.4. External links
• http://www.blender.org
• http://www.blenderartists.org
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236. Modeling a picture
236.1. Modeling a picture
Ever seen an awesome looking picture you wanted to turn into a 3D model? Like a logo or
a symbol? Well, it's actually pretty easy... it just takes some time to do.
• First oﬀ, you're going to need a picture to trace. I'm currently doing a project for a
friend to do with devils and demons, so I chose a demonic looking face for this tutorial:
Demonic Face1
• Now open Blender and start a new project. Delete the default cube. Before you start
tracing the face, you need to set the face as the background image. To do this, click
'view', then 'Background Image'. A box should pop up with only one button in it (Use
Background Image), click it. Now some settings appear, we're only interested in one of
them for this tutorial. Click the small button with a picture of a miniature folder on
it (it looks kind of like a feather pen). It's the ﬁrst one under the Use Background
Image button. From there, select the picture you want to trace. Like this: Background
Selection2
• OK, now for the long part. Zoom in to the new background image just a little bit. Now,
add a Bézier curve, and size it down a little. Hit F9 and, in Curve Tools, ﬁnd and
click the Poly button. Now there should be a few more vertices to work with and the
curve should be just a bunch of joined lines. Select one point at a time and using the
GKEY move it to a point along the background image(or face in this case). Do the same
for all of the rest of the vertices, making sure you only have one vertex selected at a time
or you'll move more than just the vertex you want to. Once this is done, select one of
the end vertices of the curve (it doesn't matter which end) and use SHIFT+DKEY to
copy that vertex. Move the newly copied vertex to a point along the edge of the face a
small ways away from the vertex you copied it from. Continue doing this until you have
a complete outline (of the whole face or just one part, like the ear). Here's what it should
look like (I did the left ear): Tracing3 . You can't see it in the picture, but six of the
points on the right side of the ear are connected, while the rest aren't. In order to get
the eﬀect we're looking for here, we need to connect all of the points around the edge to
make an outline (make sure not to connect the points across the picture or you'll have a
messed up outline).
(user note: hitting CTRL-LMB instead of SHIFT-DKEY will add a vertex that is already
connected.)

1
2
3

http://www.masterpiecepumpkins.com/Graphics/Devil2%20(1.5)_______________PM.JPG
http://k.domaindlx.com/genis/images/bg_select.jpg
http://k.domaindlx.com/genis/images/points.jpg

1841

Modeling a picture
• To get the outline for the whole face, just do exactly the same thing around all of the
edges. We still have a problem though: most of the points aren't joined by a line, so all
we have is a bunch of dots. This is easily solvable. Using the BKEY or the right click
of the mouse, we select a bunch of vertices at a time (somewhere between 5 and 10),
and hit the FKEY a few times. Every time you hit the FKEY it should connect two
of the points. Do this until all of the selected points are connected, then deselect them
and select another group and use FKEY to join them. Keep doing this until all of your
points are connected. To connect the last two points, select all the points and press the
CKEY, to close the polygon.
[edit: A better option would be to select a vertex on one of the ends of the whole line, hold
down the CTRL and left-click on a certain point on the image. This will create a new
vertex, immediately connected to the vertex you selected.]
• Now that we've got the entire face traced (or outlined if you want to call it that), we can
make it 3D. Hit F9 again and ﬁnd the Ext1 and Ext2 properties, shown here: Ext1 &
Ext24 . Change the values and see what happens. They correspond to the depth of the
outline. Try changing them around until you ﬁnd what looks good. Now, you'll notice
that the lines just stick out straight. I'm still investigating how to actually model a head
from the outlined face ... so if anyone has any ideas, feel free to add them to this page.
• In order to make it have depth you should make the outline out of mesh points instead
of a curve. Add a primitive mesh and delete all the vertices in edit mode, then ctrl click
to all point outline. Add depth to the surface in a side view (split views so you can see
what you're moving). It helps to have 2 or more reference images, but you can wing it.
Usually the ﬁnal result has to be subsurfed.
(USER EDIT: I accidentally started it with mesh instead of curve. You can do the same
thing with extrude, but I have no idea how to go on after that) (USER EDIT LATER: If
you subsurf it, it creates a relatively 3D looking image. Its really cool)
(Another user, even later: If you want to turn your curve into a mesh, hit Alt-C while in
Object Mode. Note that this is NOT reversible.)
(user edit: You can delete one vertex of a plane, in order to get a line. You may ﬁnd easier
to outline the picture extruding and moving points of the line you created.)
(user edit: you can use this tracing technique to make solid and symmetric models, else,
you would really have to use normal modelling)

236.2. Printing a Rendered Image
Render your image. Exit or minimize the ”Blender:Render” window. In blender, go to File
-> Save Image... Then save your image. Then you can print it as you would print any other
picture, using The Gimp, Paint, Microsoft's Photo Editor, or many others.

4
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http://k.domaindlx.com/genis/images/make3D.jpg

237. Modeling with the Spin Tool

Figure 1662

A collection of objects modeled with the spin tool

The Spin tool is a great tool for modeling objects you might make on a lathe quickly and
easily.
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Modeling with the Spin Tool
Lathe objects have circular cross sections along a certain axis. That is to say, when you
cut such objects perpendicular to a certain axis you'll get circles. Examples of such objects
includes rods, poles, wineglasses, and pails. A Blender render at the left shows some of
these.
With the Spin tool you only have to ”model” half the outline of your object. The object is
completed after you spin this outline. A bit of cleanup here and there and your model is
ﬁnished.
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238. Spin Tool Introduction
238.1. How the Spin Tool Works
The Spin tool works by making copies of the selected vertices in a radial array around an
axis indicated by the 3d cursor. Each copies of vertices are connected to previous vertices
that corresponds to it with necessary geometry, i.e. edges and planes.
A picture explains this more clearly.

Figure 1663

Selected vertices before using the Spin tool
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Figure 1664

Result after using the Spin tool

Note that the copied vertices are arranged in a radial array around our 3d cursor and parallel
to our view plane.

238.2. Typical Work Flow
1) Make half of the outline of our object with connected vertices. If you want to model a
wineglass, make the half of the outline of the wineglass.
2) Spin our outline. After this the Spin tool would complete our object.
3) Clean up the resulting mesh. The mesh created by the Spin tool is not so perfect so we
had to ”clean” it up.
Modeling Half of the Outline
To start we make half of the outline. Here we do it by creating vertices.
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Typical Work Flow
Open Blender. Don't remove the default cube since we are going to use it. If you don't
have any object after you open Blender (like mine), add a mesh object. Any of them will
do. I tend to use the plane. At this time it is good to give your object a proper name.
Name it sensibly, like ”wineglass” if we are modeling a wineglass. This will help us locate
it if there comes a time when we have a lot of objects in our scene. We don't want to have
all objects to be called cube.001, sphere.003 or something. That could get confusing.
Hit Tab key to enter Edit Mode, if we are not in there yet. Select all vertices by hitting
AKey, then delete them with XKey -> Vertices. Then go to the front view by hitting Num1.
Now, we are going to make the outline by creating vertices. Press and hold CtrlKey then
click the left mouse button. A new vertex will be created. Click the left mouse button
again, another vertex will be created but this time it is connected to the previous vertex by
an edge. Click again to add more vertices. We are going to use this to create our outline.
You might notice that the 3d manipulator (red, green and blue arrows) could get in the
way. Deactivate it by hitting Ctrl+Space Bar, then select Enable/Disable, or by clicking
the white pointing hand icon in the 3d view window.
Let's start making the outline. Delete our previously created vertices ﬁrst. Using what we
have learned, let's create vertices again but this time let's add them to form some sort of
outline. Let's be creative here. It could be anything you want. Here I've made two to
illustrate two situations that we might encounter when modeling with the Spin tool. That
is, modeling objects that are hollow or non-hollow.

Figure 1665

Half outline of a drinking glass
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The ﬁrst one is an outline of a glass. Here, we are modeling an object that is not hollow.
We had two vertices that are located in the center of our would-be glass bottom. We need
to align the two central vertices perfectly along the z axis. Select this two vertices then
scale it along the x axis to zero (SKey, xKey, 0Key, Enter).

Figure 1666

Half outline of a napkin ring

The second one we will make into a napkin ring. This time our outline is closed and no
vertices are located in the center of our would be napkin ring. Here we are modeling an
object that is hollow.
To make the closed outline, select the two vertices on the open side then press FKey. The
two vertices will be bridged by an edge, thus closing the outline.
Adjust vertices when necessary.
For those who may like to have an image in the background to guide them. Upload a
background image by selecting the View menu from the 3d View Window then select ”Background Image”. A new internal window will appear. Click ”Use Background Image” Button,
then click ”Load”. Navigate to where the Image is located, select it, then click ”SELECT
IMAGE”. Our image will appear on the 3d Window as a background. Bellow, I used a
picture of a wineglass.
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Typical Work Flow

Figure 1667

Half outline of a wineglass with a background image as a guide

Spinning Our Outline
Now that the outline is ﬁnished, we are ready to use it with the Spin tool
Two things you must know is that the Spin tool is dependent on the location of the 3d
cursor, and view where we activate our Spin tool.
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Figure 1668

Setup with an arbitrary shape

Here is our setup with the vertices all selected. In the nest pictures are results when this
shape is spun with the 3d cursor at diﬀerent locations.
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Figure 1669

Shape spun with 3d cursor at the origin
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Figure 1670

Shape spun with 3d cursor at another location

Here we have the same shape but is spun around in diﬀerent views.
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Figure 1671

Shape seen in top view
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Figure 1672
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Shape spun in top view

Typical Work Flow

Figure 1673

Shape seen in an arbitrary view
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Figure 1674

Shape spun in an arbitrary view

Note that its important only to place the 3d cursor properly relative to the view where you
are going to use the Spin tool
Placing Our 3d Cursor
We can see that the location of our 3d cursor is very important in Spin modeling so we
need to know how to place it properly. If you prepare it to be, the cursor would already be
in position after we make our outline but accidents happen and we accidentally misplaced
our 3d cursor. Here are some ways we could make our 3d cursor go to the place where we
want it to be.
Snapping
Snapping the 3D cursor is a quick and simple way to place our 3d cursor to its proper
location. In the 3d window, hit Shift + SKey. A list of options would appear. We are
interested with the last three options, namely the cursor snaps options. They are the
Cursor->Selection, Cursor->Grid and Cursor->Active. The name are pretty descriptive
but we'll give a short description here.
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Cursor->Selection places the cursor to the exact location of our selected element or elements.
In case of multiple selected elements, our cursor is placed on the median of the selected
elements. In edit mode, select a vertex and use Cursor->Selection snap to it. Our 3d cursor
would jump to the exact place where our selected vertex is located.
Cursor->Selection snapping is especially useful when modeling non hollow objects because
there are vertex or vertices located at the center of our model to snap to. Just select one
central vertex and snap to it.

Figure 1675 Here our 3d cursor is not at the center of our
drinking glass outline. We select one of the central vertex and do
Cursor->Selection snapping.
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Figure 1676

Result after doing the Cursor->Selection snap.

Cursor->Grid snaps the cursor to the nearest cross of the visible grid. Try clicking at a
center of a square in our Blender's grid and use it. See its eﬀect.
Cursor->Grid snapping is useful for spin modeling hollow models. Usually if you are careful,
our object outline would be on a plane that contains one of the axises. If we make our
outline in front view as advised, go to the top view (or side view depending on what we are
modeling). If you are doing okay, you will see all our vertices aligned perfectly along the x
axis. It just a matter of LMB close to a cross on the grid that contains our objects center
then snap to it.
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Typical Work Flow
Cursor->Active might not be so helpful in spin modeling. Cursor->Active snaps the cursor
to the active element (usually the element that is last to be selected). Try it by selecting
several vertices, then do Cursor->Active snap. The vertex where the 3d cursor goes is the
active element in your selection.
Spin Tool Parameters
The spin accepts two parameters to execute its function. These are Degrees (degr) and
Steps.

Figure 1677

Degrees speciﬁes the angle at which the selected geometry will be rotated from its initial
position around the axis. It accepts values in degrees. A 360 degrees value being a whole
turn around the axis. Values lesser than 360 produces something like a wedge is sliced from
the side of the form.
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p Sample Outline

Figure 1678

p Sample Outline Spun with Degress parameter set at 245 degrees

Figure 1679
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p Sample Outline Spun with Degress parameter set at 360 degrees

Figure 1680

Figure 1681

none

Steps speciﬁes the number of ”copies” of the selected geometry the spin tool makes that
it arranges in a radial array around the 3d cursor. A higher value result in much rounder
form.
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p Sample Outline Spun with Steps parameter set at 4 steps

Figure 1682

p Sample Outline Spun with Steps parameter set at 32 steps

Figure 1683

Cleaning Up the resulting Mesh
After using the spin tool, a little clean up work might be necessary, especially if you speciﬁed
a 360 degree turn. Though the mesh looks clean to the eye, the tool actually make geometries
(vertices) that are in the same blender position as another one. So what might look like one
vertex may actually be two. A simple way to clean up our mesh would be to select the whole
geometry then activating the ”remove doubles” from the specials menu ( Wkey(Specials
Menu) -> remove doubles or Wkey->6key). This would remove these problem geometries,
ﬁnds vertices that are too close to each other and merging them to one.
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Post Modeling

238.3. Post Modeling
After the lathe able parts are done it would be ready to adding non latheable parts. For
example a cup may have a bowl-like body, that we could use the spintool. Alas the handle
can't be so we had to put it there after. Depending on the geometry added. This geometries
could be formed from the mesh itself or be adding in a separate mesh.

1863

239. Illustrative Example: Model a Wine
Glass
Lets start with a classic spin tool model. Here we go step by step in making a wine glass...
or any other latheable models... using the spin tool.

239.1. Model half the outline
Using what you have learned earlier, create a simple outline of the wine glass. Just the half
part and leave the center part open. As a recap, go ﬁrst to front view. Select the cube (or
if you have no object create one) and press Tab to go to edit mode. Delete all vertices of
the object, then using Ctrl+ LMB, add connected vertices. Keep holding Ctrl and clicking
until ﬁnished. Adjust vertices as required.
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Illustrative Example: Model a Wine Glass
p Finished wineglass outline

Figure 1684

239.2. Spinning the outline
Remember to align the two end points in the open side. Select the two vertices and scale
at the x-axis to zero (Skey->Xkey->0key). Move the 3d cursor to the center by snapping
to the selection (Shift+S -> 4key). Then select all vertices by hitting Akey twice.
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Spinning the outline
p Wineglass outline in preparation for spinning

Figure 1685

Now go to top view (Num7). Select the editing button (F9Key) and ﬁnd the mesh tools
tab. Change Degr to 360 for a complete turn and change steps to 20 or higher to form a
much rounded shape.
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Illustrative Example: Model a Wine Glass
p Parameter settings for the project

Figure 1686

Press the Spin button.
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Cleaning up the Mesh
p Wineglass result seen in front view

Figure 1687

239.3. Cleaning up the Mesh
Select all vertices by pressing Akey twice then apply remove doubles operation (WKey>6Key/Remove doubles). Now the model is ﬁnished. Make it shade smooth using set
smooth (Wkey -> set smooth). If you like, add a Subsurf modiﬁer to the object to make
it geometrically smoother. If dark bands appear, recalculate normals outside (Ctrl+N), to
eliminate them.
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Illustrative Example: Model a Wine Glass
p Finished wineglass rendered with no textures

Figure 1688

1870

240. Illustrative Example: Model a Mug
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241. Creating Ogg-Theora movies using
Blender
Wikimedia Commons requires that movies be uploaded as Ogg-Theora (OGG) ﬁles. As of
Blender 2.42a, this is not a builtin feature of Blender. To get OGG ﬁles from your ﬁnished
animation isn't diﬃcult, though. However, you'll need additional software.
There are basically two ways to generate OGG ﬁles: you can use one of the many ﬁne video
editors or you can use special conversion programs. Video editors like LiVES or Cinerella
allow you to load your AVI or your rendered frames, manipulate them, and create the OGG
ﬁle from it. Please refer to the editor's documentation on how to achieve this.
A disadvantage of a video editor is they are huge pieces of software, duplicating functionality
that you already used when you created your animation ﬁle/s with blender. It's actually
not necessary to install a video editor just for converting your animation to OGG Theora
format.

241.1. Converting saved frame picture ﬁles to Ogg Theora
It's actually possible to convert frame pictures that you saved before to OGG format
movies. The ﬀmpeg2theora software package1 , which is available in source or binary
for all relevant systems, is capable of batch-processing ﬁles into an Ogg format movie.
For example, if your frames were saved as PNG (with ﬁlenames filename001.png,
filename002.png, etc.), you could convert them to a soundless OGG ﬁle with:
ffmpeg2theora filename%03d.png -o output.ogv

Sound is possible too, as well as being able to set the quality and framerates. Consult the
ffmpeg2theora documentation for more.

241.2. Converting AVIs to Ogg Theora
ffmpeg2theora can also convert AVI movies to OGG. Usage example:
ffmpeg2theora --optimize my.avi

1

http://www.v2v.cc/~j/ffmpeg2theora/
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242. Creating animated GIFs using
Blender and Gimp
This tutorial will guide you through how to make a simple animated Gif Using Blender
and Gimp. This is useful for creating Avatars for forums etc. This tutorial assumes basic
knowledge of blender and Gimp, see the basic animation tutorial1 .
To start oﬀ you will need an animation, this usually should be no longer than 25 frames
long.
1. Open Blender. and delete the default cube and add a UV sphere, the default settings
for the sphere work ﬁne.
2. Now set the camera size in the scene buttons (F10) to 50 by 50 (I am creating an
avatar for deviant art where the required size is 50 by 50 pixels, you may change this
if you want)
3. set the frames to start at frame 1 and end at frame 20.
4. select the sphere and insert a LOC keyframe at frame 1 and 21, then go to frame
11, move the sphere and insert another LOC keyframe. this will create a looping
animation.
5. Set the image type to PNG or JPEG (it doesn't matter) and render the animation.
Now to combine the images into an animated GIF using Gimp.
1. Open the ﬁrst image with gimp.
2. Now click File-> open as Layer or press ”Ctrl-Alt-O”. Select the next frame and it
will be added as a new layer. Repeat this for all of the images, or select all of the
images by pressing ”Ctrl-A”.
3. If you press Filters->Animation->Playback it should play the animation. It will
probably have a low frame rate making it ”choppy”. this will be ﬁxed in the next step.
4. Change the frame rate to 40 ms(25 frames per second). Choose ﬁle->Export as->
”Name”.gif, then choose Save as Animation.
Note: Don't know wheter this is an additional feature of Gimp 2.6.8 or not, but i found
out following: In Gimp 2.68, within the export wizard, you have to choose option: -save as
animation- ﬁrst and next at the option: -single picture where not mentioned- the option:
one single picture per layer. -Sorry i use the german version of gimp-.
You should end up with something like this:

1

Chapter 100 on page 955
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Figure 1689

Alternatively, you may try using addons to create animated Gifs directly from Blender. 2
options include Spritify2 and Bligify3
yes

2
3
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https://github.com/Fweeb/blender_spritify
https://github.com/doakey3/Bligify

243. 3D Tiling Backgrounds For The
Web
243.1. Overview
This tutorial will guide you through the process of making 3D tiling backgrounds for use
with web pages, your desktop, or anything else for that matter. We will be using Blender
and a graphic editing program such as Adobe Photoshop or GIMP. I will provide detailed
explanation to cator to beginners, however more experienced Blenderists can probably get
away with just following the picture diagrams provided. You may also ﬁnd the diagrams
useful if English is not your native language, or if you hate reading instructions.
----

243.2. Create The Object You Wish To Tile
Start up Blender and look at your lonely cube. We will use this cube as a starting point for
the sake of demonstration, but feel free to use any shape you like. Press ”Tab” to enter Edit
Mode. Press the ”E” key on your keyboard and the Extrude menu will appear. Select
”Individual Faces”. As you then drag your mouse cursor you will see some numbers move
in the bottom left in the window and text saying ”Shrink/Fatten”. I recommend setting
it to 1.0000 to keep it simple. Hold down the ”Ctrl” key while dragging to do so in set
increments.
Next, with the six faces of the cube still selected, press the ”S” key to scale those faces. I
recommend scaling to 0.8000.
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Figure 1690

Good. Now that we have created our object we will prepare to tile it.
----

243.3. Specify Your Tiling Area
”Tab” back into Object Mode and press ”NumPad 7” to go to the Top View, or manually
click ”View” at the bottom of the window and select ”Top”.
Press ”spacebar” and from the menu that appears select ”Add” > ”Mesh” > ”Plane”.
The plane has appeared, but is obstructed by our cube object, so press ”S” to scale the
plane to 5.0000.
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Figure 1691

You'll notice that I've colored my plane black. This is only to make it easier for you to see.
You need not bother with this as we will be deleting the face of this plane shortly.
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Figure 1692

We now have an easily visible boundary representing the area which will be tiled. If at any
point we decide we no longer need or want this we can move it to another layer by pressing
”M” and selecting a layer to move it to.
----

243.4. Tile Away!
Now the fun part begins. If you have created 2D tiling backgrounds before, this concept
will be very familiar to you.
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While in Object Mode, select your cube object. At this point you have a couple of options.
One is to make duplicates of the cube object. Another is to make linked duplicates of the
cube object. I recommend making linked duplicates because you can later edit the mesh of
one object in order to change the mesh of all the duplicated objects. This can be especially
useful if you later plan to animate your tiling background (careful not to distract from the
foreground). It is also useful if you want to experiment with new designs easily without
having to re-place all your objects.
With your cube object still selected, press ”Alt+D” to make a linked duplicate. (Non-linked
duplication is done with ”Shift+D”) Now hold down ”Ctrl” to move in set increments and
move the object to one of the corners of our plane. Make sure the center of the object
(represented by a pink dot) is aligned with the very corner of the plane. At this point you
may notice it's somewhat diﬃcult to tell whether the center of the object is exactly on the
corner of the plane, and that's why we are going to press ”NumPad 5” or click ”View” and
select ”Orthographic”. For all practical purposes we can spend the rest of the time we are
building the tiling pattern in Orthographic View because this view is essential for tiling.

Figure 1693

Now with your duplicate object still selected, scale it (”S” key) so that is somewhat smaller
than the ﬁrst. Then rotate it using the ”R” key. While rotating you can constrain to a
particular axis by typing ”X”, ”Y”, or ”Z” respectively.
We will now make linked duplicates (Alt+D) of our rotated and scaled cube object and
place one in each corner exactly on the grid (remember to hold ”Ctrl” while dragging). If
you place an object in one corner, you must place it in all four corners because corners
touch both the X axis and the Y axis.
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Figure 1694

Now as you will notice in the following diagram, I made an object that is crossing over the
edge of our plane. This is good. This is how to make natural tiling backgrounds. However!
Whenever we do this we must be absolutely certain to do the same on the opposite side, or
else our backgrounds will not tile properly.

Figure 1695

So now we've created a few objects of diﬀerent sizes and orientations, however they have
all been along the same spot on the Z axis. So let's give our pattern some depth - after all,
that is the joy of working in 3D!
Before we do this, we'll want to get our guide plane out of the way. So right click on
the plane to select it, then ”Tab” into Edit Mode. Press ”X” and from the Erase menu
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choose ”Only Faces”. Now ”Tab” back into Object Mode. There! We now have only the
segments of the plane as our guide.

Figure 1696

Hold down the middle mouse button while dragging the mouse to see what our design
looks like in three dimensions. Now right click one of the cube objects, duplicate a linked
copy (Alt+D), and press ”Z” to constrain movement to the Z axis.
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Figure 1697

Navigate in this way along the X and Y axis as well and once you've found a good spot,
scale and rotate. Remember to make a duplicate on the opposite side whenever you cross
the outline of the plane guide. You can go on like this and populate your tiling pattern with
as many objects as you wish. The grid is your friend during this process, so you should
always have your ﬁnger on ”Ctrl” while moving the duplicate of an object that crosses a
border of the guide plane. Also, any object that will ”tile” across the border must be at the
same point on the Z axis as its counterpart on the other side of the seam. Press ”NumPad
7” periodically to see where you are from a 2D standpoint. This is the view from which
we will eventually render the image, so this perspective is the one that counts. Beginners,
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remember that mouse wheel zooms in and out, and ”Shift+middle mouse button”
allows you to ”drag” your way around.

Figure 1698

Keep in mind that in Orthographic View we do not perceive the depth of objects. Those
far away and those near by appear to be at the same distance. This is what allows us to
make a tiled image, but it also limits the apparent depth of the scene. We can compensate
for this by scaling down the objects we want to appear further away. Or, as in this example,
we can just make each object a diﬀerent size and place some in front of others.
----

243.5. Camera Settings
We will now position the camera directly over our cluster of objects. Press ”NumPad
7”, center the view on the cluster using ”Shift+middle mouse button”, and zoom out a
couple notches with the mouse wheel. From the 3D View Window's menu, click ”View”
> ”Align View” > ”Align Active Camera to View”. Now you may be wondering why
everything appears to be distorted. This is because when we changed to the camera's
perspective, the view automatically reverted to Perspective View because by default the
camera is set to that view. But just as we changed to Orthographic View in the 3D
View Window, we can change the view of the camera as well. While in Object Mode,
swivel the view until you see the camera. It is represented by a pyramidal wireframe with
a black triangle atop the opening. Right click to select it. Now press ”F9” or click the
Editing button (it's icon is four vertices joined in a square). Now in the Camera panel
you will see a button labelled ”Orthographic”. Press it. Above the button is a value
labelled Scale. Set it to around 20. (See ﬁgure below)
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Figure 1699
----

243.6. Lighting & Materials
Place some lights in your scene, and add some materials to your objects. Lighting and
materials are subjects which demand their own tutorials, so if you don't know how to do
these things yet, please consult the Wiki.
Note: I advise lighting your scene pretty evenly in order to make the tiling seem contiguous.
Note: You could also only use Sun lamp, so the light is clean all over the mesh!
----

243.7. Rendering
Now that you've presumably got your lighting and materials as you want them, it's time to
render the scene. Under User Preferences click ”Render” > ”Render Settings” or just
press ”F10”. In the Format tab you can choose the dimensions of your rendered image,
the ﬁle format you prefer, and the quality. I'm going with 800x600 at 100% quality.
----
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243.8. 'Shopping
And it's time to begin post-production. Open your rendered image in your preferred image
editor. I will be using Photoshop in this example. Now ﬁnd and mark the four corners of
your tile (on a new layer of course). Just eyeball it.

Figure 1700

We will use guides to mark the tile boundaries. In Photoshop guides can be inserted by
selecting ”View” > ”New Guide...”. Guides can be positioned with the Move Tool. You
can zoom in and make sure your guides are accurately positioned by holding ”Ctrl” while
typing ”+” or ”-”. You can now hide or delete the layer with the markers, as that was only
to help us get accurate guides.
Should you decide to make an animated tiling background I recommend layering all your
frames on top of one another in your image editor before editing in order to keep the position
uniform. You can then animate them using Adobe ImageReady (comes with Photoshop) or
ﬁnd decent low-budget and occasionally free GIF animation programs online.
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Figure 1701

Now select an area just outside of the guides with the Marquee Tool. Make sure ”Feather”
is set to 0px and that the marquee is rectangular and Style is set to Normal (meaning
no Fixed Aspect Ratio or Fixed Size). Also, it will help you to have Snap enabled, so go
to ”View” and make sure it is enabled for guides.
Once you have selected the area, copy (Ctrl+C) and paste (Ctrl+V). Then drag to the
right using the Move Tool and that piece should snap to the inside of the rightmost vertical
guide.

Figure 1702

1888

'Shopping
Select the Eraser Tool and choose a brush size. I'm going with a diameter of 65. You'll
want to use a soft gradient-like brush for this. Now erase the left edge of the newly pasted
selection so that it blends into the picture. Don't erase any of the right edge.

Figure 1703

Press ”Ctrl+E” or alternatively, select ”Layer” > ”Merge Down”.
Alright, so that procedure you just performed copying from left to right - now do it bottom
to top. Once again, erase the edge. Do a Save As.
Finally, select the square center area that will become your tile and do ”Image” > ”Crop”.
Now scale your new tiling background to a web-friendly size. Save As a JPEG, GIF, or
PNG. You're done!
Note:If your pattern still isn't tiling quite perfectly, load the version with the guides again
and repeat the copy-paste-erase process. Remember to merge down your layers each time or
the corners may not tile correctly. If still no joy, try tiling the background in a web browser,
taking a screenshot, pasting that into your graphics editor, and touching up from there.
Here is the ﬁnal result:
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Figure 1704
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244. Cool Things That Aren't That
Obvious in Blender
Cool things in blender that aren't that obvious. Useful tips and tricks in Blender.

244.1. Attribution
Many of The Following Tips and Tricks have been contributed by members of the CGsociety.org1 , a Public Society for Digital Artists. The tips have been extracted from a CGsociety
thread2 . They have been roughly edited to improve readability.

244.2. File Browser Functions
244.2.1. Delete, Move, Rename, and Make Directory
When you are inside a ﬁle browser for loading or saving something and you want to create a
new directory, just add the name to the path on top of the window and conﬁrm 'Makedir'.
you can also delete(x), move(m), or rename(n) a ﬁle. you can do action on multiple ﬁles by
seling with right click

244.2.2. Preview images when loading them as a texture
Whenever you are loading images as a texture, you can hold down Ctrl while clicking on
the 'load'

244.2.3. Trick for Creating Quick File Revisions
After you have saved a blend ﬁle or an image you can then save it in progression that is:
car .blend. or car .JPG
Next time do ”Save As” then press the + (plus) key which will advance the blend ﬁle by 1
every time it's pressed. example: car .blend becomes car 1.blend. press again car 2.blend
and so on.

1
2

http://www.cgsociety.org/
http://forums.cgsociety.org/showthread.php?t=52560&page=1&pp=15
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The - (minus) key will subtract one. I've gotten into the habit of saving frequently. Yeah
I know there is now the undo feature but I like this better because it gives you a history
in case you need to back a few levels of a build. You get a saved version at the level you
choose.
Note: Blender automatically detects the number... meaning it does not need to be in any
position. For instance: If you have a ﬁle named 001starport.png or .blend or whatever,
pressing the + (plus) key will automatically name it 002starport.png. If you want to name
it starport1.png, it will change it to starport2.png.
Two rules: The ﬁlename has to have a number. It can be 0, or 1, or 3.141569.
If the ﬁle number is a negative, pressing + (plus) key will increase the ”magnitude” of the
negative number. I may have used magnitude wrong, if so, I mean pressing the + (plus)
key will make -0.04 drop to -0.05. The - (minus) key will bring you only to 0, and then it
will start to eat itself up.

244.2.4. Open Recent
Control O

244.3. Object/Vertex Manipulation
244.3.1. Constrain Movement to one Axis or to a plane
when moving objects/vertices or set of objects/vertices ([G] key) if you move in the direction
of the global X axis (Up/Down) and then press the MMB, movement will be constrained
to only move in the X axis, or if you move the vertices in the direction of the Y axis and
then press MMB it will be constrained to move only in the Y axis. The same is true of
the Z axis.
You can achieve the same eﬀect by using the X, Y or Z keys while in grab mode. You
simply have to press X key, Y or Z, once to lock to X Y or Z global axis,*
To Constrain the Movement to two axes (a plane): Press Ctrl+X to move in the Z-Y-Plane.
Ctrl+Z=XY, Ctrl+Y=XZ.*
Alternatively, Select scaling mode and select the axis not to scale with the selecting button
at the same time as you hit Shift.
• in every case You can hit the X,Y or Z button again to constrain movement to a diﬀerent
set of axes. Normally this diﬀerent set of axes is local. However you can change the
identity of this set to global, local, normal, or view by pressing Alt+Space. which
cycles through the diﬀerent identites.
Note: All of these shortcuts work with scaling and Rotating as well
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244.3.2. Shrink/fatten mesh in direction of vertex normals
When you're mesh-editing, Alt+S will shrink/fatten the mesh selection in the direction of
the vertex normals.

244.3.3. Vertex Parenting
You can parent object to a Mesh, in that case you are parenting to the center of the mesh..
BUT if the mesh is translated somehow (let's say by an armature'[S] pose) the center
remains in the same spot, and thus the child object doesn't receive any transformation at
all.
To solve this, you can parent the child object to a vertex (or a face) within the mesh, and
any transformation that the vertex receives is passed to the child.
There are only 2 options, to parent to any 3 vertex within the mesh or to parent to just one
vertex. If you parent to 1 vertex then only location information is passed, with 3 vertex all
transformations (rotation, location and size) are passed to the child.
How to do it? Starting in object mode select the child(ren), hold Shift and select the
parent, enter edit mode, select one or three vertex, press Ctrl+P. That's it!

244.3.4. Work around to welding Verts
For Edge loop (Verts) position both loops together as close as possible then hit W then
4 (not on numkey pad). You can adjust how far the eﬀect of collapse can go in the Edit
window (a button on the right labeled Limit: ***, where * is a number).
As for individual Verts, e.g. Two vertices welded to become one, select both Verts, scale
until they are very close then hit W then 4.
you can also do this with the snap combo
select the vertex you want to weld together Ctrl+S, Cur -> Sel Ctrl+S, Sel -> Cur [W],
Remove Doubles
Also, whenever Blender pop up a menu with diﬀerent options, you can just type in a number
to choose one of the options (use the numbers not on the NumPad)

244.3.5. Make individual objects the camera and Change them back
If you select certain objects and press Ctrl+0(zero)it will make them the camera. I use
it all the time to align spotlights.
Select your camera and hit Ctrl NumPad 0 to make it the active camera again
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244.3.6. Ordering Meshes in Vertex Groups
If you are preparing to skin your meshes and you are ready to create the vertex groups, you
should pay attention to the order in which you create them, because once they are created
there is no way to re-arrange them on the vertex-group list.
That means that if you are a ultra-by-the-book person and you would like the vertex group
alphabetically ordered on the list them you must create them in alphabetical order.
.. Or, if you would like them to be ordered according to their function (shoulders, then
arms, then forearms, then palms, etc. you must create them in that order.
This may all sound like a stupid thing to care about, but If you have a character with 39
vertex groups you may quickly ﬁnd that when one of them needs ﬁxing it is a little diﬃcult
since they were randomly created.

244.3.7. Position and scale along face normal,
-Shift V: Position camera along face normal, Alt S: scale selected vertices along face
normal

244.3.8. Using Fake Users
pressing Shift+F4 will turn the window into a ¨Data Select Window¨ where you can assign
and unassign fake users to almost everything by selecting the name and pressing the F key
Creating a fake user allows you to keep useful data blocks (materials, textures, base meshes)
at hand even if they are not linked to an object. You can use it to set a default material
that would have the shader you like best.

244.3.9. Align a selection of vertices on a plane
If you want to perfectly align a selection of vertices on a plane, you just have to follow these
little steps:
1.) Before you are selecting the vertices you want to align, position your 3D cursor in
the plane that you want to align to (you could select the 4 vertices of a big plane and hit
Shift+S / Cursor->Selection for example, but you can position it anywhere)
2.) Now select those vertices you want to align
3.) Choose ”3D Cursor” under ”Rotation/Scaling Pivot”
4.) Now with the [S]-key start scaling mode, hit the key of the axis you want to move the
vertices on (X,Y,Z)
5.) Holding down the Ctrl-Key, you can now move the vertices in one line towards the
cursor, until the value for the chosen axis is 0.000. Alternatively, just enter, using the
keyboard, the scale factor you want (0 in this case) .
6.) Hit LMB. The vertices are perfectly aligned along a plane through the 3D cursor.
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This even works very well while in perspective view mode, so you can align on the ﬂy and
don't have to switch to front/side/top view all the time.

244.3.10. Welding Vertices
You can weld vertices by selecting them in edit mode and pressing Alt+M.

244.3.11. View wireframe of hidden Verts
to view the wireframe of hidden Verts, make sure you are in WIREFRAME MODE and
then turn SubSurf on and change the level to 0 If you already knew about this then

244.3.12. Select a true loop
shortcut is Shift + Alt + right Button of the mouse, serves to select true loop, in
vertices as in edges like in faces.

244.3.13. Selecting one object from a single mesh comprised of multiple
objects
If you have more than in Edit Mode, you can place your mouse cursor next to one of the
Verts in the desired object, then press the ”L” key to select all of the Verts linked to that
one. ”Alt+L” reselects in the same manner.

244.3.14. Precise Zoom and Select/Deselect
Selecting: If you Hold down the Ctrl+LMB (left mouse button) and drag the mouse, it
will allow you draw a selection as opposed to using the B button which gives you a square.
Deselecting:To draw an area to deselect, Hold down the Ctrl+ Shift+ LMB(left mouse
button) and drag the mouse,
Zooming:Hold down the Ctrl+MMB. Move your mouse vertically to can get a more controlled zoom versus scrolling the Mouse wheel.
This feature may not be present in 2.37 or earlier versions.

244.3.15. Mouse Gestures
Left click and draw:
• a straight line - moves the selected object.
• a circle - rotates the selected object (note: this must be drawn fairly circle-like).
• a V - scales the selected object.
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244.3.16. Selecting Obscured or Hidden Objects
Say you are in front or side view and you want to select an object, but it is obscured or
hidden behind other objects. If you press Alt RMB over a group of objects, a menu will
be displayed in the 3D window allowing you to pick the object you wish to select.

244.3.17. Select or Deselect Multiple Vertices
In Edit mode, when you click the RMB near a vertex that vertex (face or edge)will be
selected, RMB again will reselect. By holding the Shift key this will allow you to add
each selected vertex (face or edge) in that highlighted group.
Pressing the U key (Undo in Edit mode) will also remove the last selection you made.
Alternatively, you can Press B and then draw a box with MMB. Anything caught in the
box will be deselected. Also works with BB and the draw selection. Draw with MMB and
you reselect.

244.3.18. Selecting multiple items
You can hold Shift and use right mouse button to select multiple items to append.

244.3.19. Measuring, length, distance on an object.
Hit ”F9” (editing), you should have split (2) windows. One ”3d” the other ”buttons” go to
the Mesh Tools 1 panel and press the Edge Length, Edge Angles and the dimensions will
appear on your selections in the 3d view.

244.3.20. Adding Connected Vertices
In Edit Mode, if only one vertex is selected, pressing ”E” will add a vertex, on a freely
deﬁned place, connected to the selected one. As will holding CTRL and left clicking the
mouse where you want the new vertex to be positioned.
Note: It must be an Image texture and in wireframe mode to be visible.
(2.37a)

244.3.21. Recalculate Normals
Ctrl + N = Recalculate normals outside (you might have to select faces before doing so)
Shift + Ctrl + N = Recalculate normals inside
These two hotkeys are useful when you extrude some edges and see a kind of seam in
between (due to normals pointing in diﬀerent directions).
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Then, after selecting an edge, Ctrl + NumPad(+) selects the face associated with this
edge. Ctrl + NumPad(-) deselect the face.

244.3.22. Create a Quad from two Tris
Alt + J when having two Tris selected makes a Quad.

244.3.23. Remove Doubles
To Remove Doubles use hotKey: W. You can adjust the ”limit” option so that ”Remove
Doubles” has more or less tolerance. This option is located in editing window under the
mesh tools panel, (i.e. weld vertices that are further?)

244.3.24. Combine edit levels on a mesh.
When in Edit mode for a mesh (TAB key) you can choose the level that you wish to edit
at. At the bottom of the 3D window, there are four buttons. Vertex, edge, face & back-face
cull.
By default the vertex level is selected, if you hold Shift and press the edge button, you can
use both at once.

244.3.25. Change Select Mode
to change select mode (vertex, edge or face) you can press Ctrl+Tab. But this way you
can't use the Ctrl+Key to ADD the select modes.. Still could be useful, if you don't have
a header for the window you're working in..

244.3.26. Precision Warping
When using the warp tool (Shift+W) you may ﬁnd that there are times when you have
trouble perfectly closing a 360-degree loop. This is because Blender will warp based on the
total width of the selection, which may not necessarily be what you want.
Getting around this is simple, just select two verts to denote the new endpoints, duplicate
them (Shift+D), scale the two verts times two, so they are just twice as far apart. Then
select what you want to warp plus those two marker verts, and warp 720 degrees.
When done, click a vert on your mesh and type L to select everything linked to it. Then
type H to hide it. Once you've hidden all of your mesh, all that remains are the two
marker verts. Do a Select All (A) and type X to delete them. Now unhide your mesh using
Alt+H and you have just the warped mesh, extra guide verts are all cleaned up.
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244.3.27. Precision Cutting
The Knife Tool can actually be quite precise if you take advantage of the snap feature. Press
K, choose ”Knife(Exact)” and then hold the Ctrl key while choosing where you wish to
cut and you will ﬁnd that the path to be cut will now snap to nearby vertices.
Keep in mind that the vertices being snapped to don't have to be the ones you are cutting.
Say you want to cut the midsection out of a UV sphere and you want the cut to be two
grid units in height. While viewing the side of the sphere, add a plane, and scale it to be
two grid units tall, and wide enough so that it extends beyond the sphere. Now select the
vertices of the sphere (because what we have selected is what gets cut) and when you cut
it, snap to the four verts of the plane. Now hit Enter to apply your perfect cut.
Using guide geometry such as a plane to cut other geomery ”cookie-cutter” style can be
extremely useful when accuracy is needed. Remember to align your view before cutting,
since your view will determine the angle from which the geometry is cut.

244.4. Working with Meshes
244.4.1. Turning Sub-Surfed Mesh into Normal Mesh
If you have a sub-surfed mesh you can turn THAT sub-surf mesh into a normal mesh. Just
select the sub-surfed mesh and press Alt+C (Conversion).

244.4.2. How to remove (numb) black spots on a Mesh
If a Sub-Surfed mesh becomes (numb) black on some places, that's because of the normals.
Select all and press Ctrl+n and then conﬁrm. now it should look prettier!
if the above solution does not work , save your Blend ﬁle, Quit Blender then restart. Use
Ctrl O to open the last ﬁle and your mesh will have returned to correct shaded state.

244.4.3. Select all holes in a mesh and ﬁll them
Shift+M* selects all Non-manifold edges/vertices (holes) in a mesh **. Then all you have
to do is hit Ctrl+F to auto-ﬁll those holes with ”beauty ﬁll”.
Shift+Mis an alternative shortcut for 'Select Non-manifold'. You'll ﬁnd this in the select
menu when in mesh edit mode. The listed short cut there is Ctrl+Alt+Shift+M. Shift
M is obviously a lot more comfortable on the ﬁngers though!
• •
Although 'Non-manifold' usually refers to holes in your mesh, it is not necessarily only holes
e.g., an edge with three faces coming out of it is also a non-manifold edge!
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244.4.4. Fill in four or fewer vertices
Select the vertices and press [F], this will ﬁll in the empty space around them.
To clean up a ﬁlled in space, select all the vertices for the area, and press [F]. Choose
OK to make FCon. For example: add a plane in wireframe mode, extrude it several times,
select all vertexes, then hit [F].

244.5. Animation
244.5.1. Animation Preview in all windows at the same time
It is well known that Alt+ a is for previewing an animation on the 3D window. But that's
not all of it. Divide your screen into multiple 3D Windows, each from a diﬀerent point of
view.
Press Alt + Shift + a
Enjoy!!!
If you have an Action/Ipo Window and 3D windows open, and you issue the Alt + Shift
+ a command from the Action (or the Ipo) window, it will animate both (the action and
the 3D) in sync!! Great for visualization of Ipo's eﬀect on your model.

244.5.2. Choose animation mode, Convert mouse movements to IPO
-T in IPO window: Choose animation mode, i.e., linear, bezier, constant -[R] in IPO window: Record mouse movements, and convert to IPO

244.5.3. Animate procedural textures
To animate procedural textures, press 'i' with the mouse pointer in the materials window,
and select the type of Key-Frame you wish to set in the pop up menu. advance a few frames,
tweak your materials, and set another key frame.

244.6. UV Mapping, Particles and Texturing
244.6.1. Blender color picker
Blender has a PhotoShop-esque color picker. Simply click on the color preview next to the
sliders to use it. Hit enter when you have the color you want.
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244.6.2. Saving your face groups selections
Regarding UV mapping and Face Groups Selections there seems to be the general misconception that you can't save your face groups selections on Blender.
Most people already know that from within the Face Select Mode (Potato Mode) you can
switch into Edit Mode and whatever selection you do while in Edit Mode is passed back to
Face Select Mode when you exit the Edit Mode.
Well, Did you ever wonder why Material Index Groups (that are nothing more than face
groups with a common material on them) have those little 'Select' and ´Deselect' buttons
there? Sure they come handy for later modiﬁcation of the material index but that is not
all about them.
Do this: Before starting the UV unwrapping job, cut your mesh by creating as many material
indexes as you need, you can even assign each one a diﬀerent color so you can be sure that
there is no face orphan. Once you have the mesh all cut and sliced (so to speak) you enter
in Face Select Mode, then switch into Edit Mode, select the index containing the faces you
want to unwrap, press 'Select', leave Edit Mode and Voile! You now have an entirely useful
face group waiting for you to unwrap. No more manual (and imprecise) face selection is
needed.
If you later need to change the mapping of those faces, don't fear. Just make sure there isn't
any face selected on Potato Mode, do as you did ﬁrst (enter edit mode, select the index,
exit edit mode) and there are your very same faces selected again with the UV mapping
you already assigned to them.
Note: Another beneﬁt of have precise face selection groups is that, initially, you don't have
to worry about UV coordinates overlapping, since you know have the way to select ONLY
the faces you want to. For example, you unwrap all your faces by groups and when you
are done you can start thinking about scale and position within the texture map, not like
before when you have to solve those things as you go.

244.6.3. Bulk Texture Change
Consider a scenario in which you have a scene with a 100 mesh objects, and 50 of them
have one texture and 50 of them have another.
If you want to change the texture of the ﬁrst 50, but don't want to change each individually,
do the following. Add a Plane out of the view of the camera. Add your new texture
(Material) to the plane. Then use the “Copy to material Buﬀer” button in the header of the
Material buttons. Select one mesh object of the same sort that you want to change, open
Material buttons and Paste from Material Buﬀer.
All the mesh objects with the same texture will now have the new texture.
Alternatively, If you have a material that you want to apply to a lot of objects at once:
1. Select all the objects you want to apply the material to. 2. Apply a material. (this only
applies to the last selected object) 3. press Ctrl+L > Materials. (this links the material
of the last selected object to all the other objects)
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244.6.4. Negative Meta-Balls
Add>Metaball as usual. Exit EDIT mode and Add>Metaball. This time before you exit
EDIT mode, hit the Negative button in the EDIT buttons window. Then leave edit mode.
If you move the negative Metaball around, you can see the eﬀect it has on the positive
metaball.
Be careful though, as negative metaballs are not displayed in the same manner as positive
metaballs, you will only see the Pivot point not a meta-mesh.
This is a little test you can try to see the amazing eﬀects negative metaballs can produce.
Make 1 Metaball, make it big. Place three spheres (UV) inside, make them emit particles,
one 100, one 200, one 300 particles. Parent three negative metaballs, one to each sphere,
and use dupli-vert on each sphere. Make the 100 duplicate metaball quite big, the 200
medium and the 300 small. Hit Alt A to run animation in 3D window.
(Click here for this author's negative-metaball thread... oops, it's not there anymore, well,
not the AVI anyway!)3
(Click here for this author's negative-metaball AVI.)4

244.6.5. Maintain the UV layout when moving/scaling/rotating UV
co-ords.
When you have the UV image/editor window open and have loaded an image you want to
UV map to a mesh, click on the UV tab in the header bar and turn oﬀ 'Snap UV to pixels'.
This will help to maintain the UV layout when moving/scaling/rotating UV co-ords.

244.7. Rendering
244.7.1. Tricks, related to the view ports and the render buﬀers
First. Switching among screens
So you have your screen made oﬀ the 3D window, the buttons window and the info window...
but you are doing some ﬁne tunning to the mesh in two places simultaneously, and they
both need to zoom in the 3D window. You could scroll or zoom out, translate the view and
zoom in again. None of them an elegant solution.
Another situation. You are working on a model and are using an image for reference. You
are not tracing over the photo, just take a look at it often to make sure you don't deviate
to much from the concept. So you open the photo in a 2D program and keep switching
back and forth from Blender.. or you have the photo open in an image window and keep
maximizing and minimizing the window... another hassle
3
4

http://www.elysiun.com/forum/viewtopic.php?t=14058&highlight=metaball
http://www.selleri.org/Blender/movies/Metaball.avi
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Worry no more!!! Blender can handle multiple virtual screen (ala Linux) and you can come
and go from them with just one key stroke.
Just press Ctrl+Left Arrow or Ctrl+Right Arrow (for all of you OS X users, add a
Shift) and you are switching screens. Go ahead! By default EVERY .blend ﬁle comes with
3 screens ... and of course you can add/delete as many as you see ﬁt.
the magic button to add or delete screens is right beside the Tools menu, up there in the
info window.

244.7.2. Using the render buﬀers
Ok, so you set your scene and press RENDER, a nice window comes up and you see your
hard work coming to existence (that's the default behavior, if your change it on the display
buttons then this may not work for you).
Do you realize that the window containing your render image is also a render buﬀer? Actually they are 2 buﬀers for your to play with. Whenever the render window is open (and you
can re-open it by pressing F11 without having to wait again for the render) if you press the
J key you can switch from Buﬀer A and B. (the last active one is what you save when you
press F3). You can even switch buﬀers in the middle of a rendering (but I advice against
that when rendering very complex scenes, you have been warned!)
The cool thing about having two separate render buﬀers is that you can have instant beforeand-after images for things that you change in the scene. For example you are searching
the perfect position for a light source in a scene, you place it and do a render, place the
light in another position, switch to the second buﬀer and do a new render. Now, with the
render window open, just press J to see how the change on the light's position inﬂuence
your scene and that makes your decision easier.
By the way, the render window can be zoomed (by the normal ways or by pressing Z ) to
do a closer inspection of the image.

244.7.3. Render window Tricks
To zoom into the render window, use the ZKEY.
To ﬁnd out what the (Red, Green, Blue, Alpha) values of rendered image are, left click
and hold the button of your mouse.this will reveal the RGBA values of the pixel below the
mouse cursor. i.e. R 127, G 255, B 13, A40. The values will appear in the bottom left
corner of the render window. You can also hold the button and drag the mouse around.
This will display the values of the pixels your mouse pointer passes over.
With the render window open, you can press AKEY to view an alpha version of the image.
Press AKEY again to go back to the normal colour view.
To do a before/after comparison after making a change, hit JKEY to switch render buﬀers,
then hit F12 to render. In the render window, use JKEY to alternate between the previous
render and the current one, so you can easily see the diﬀerences.
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244.7.4. Working while you Render
If you use a X/X11 based window manager, you do not need to watch blender while it
renders, go to a diﬀerent virtual desktop. Blender doesn't have to keep X informed of
what's going on and rendering speed may increase.

244.7.5. Border Rendering
In the rendering buttons ﬁnd the buttons marked ”Border” and ”Crop”. If you depress
”Border”, you can get a rendering of any part of what the camera sees. Just do the following
:
Go into a camera view using NumPad 0, press Shift+B. Then, mark the limits of the
rendering as you want them using LMB. Next, render the usual way and the section you
marked will be rendered ﬁrst, then it will be integrated to the complete rendering. If you
wish that *only* the chosen section would be rendered then click on the button marked
”Crop” also.

244.7.6. Creating a cluster of particles which takes little time to render
Render some particles, and make the picture into an alpha mapped tga in GIMP or whatever
graphics editing application you use.
Load the image onto a plane. Adjust the alpha settings accordingly. Parent the plane to
the emitter. Press dupli-verts.
You now have a cluster of particles which takes relatively little time to render. Of course it
doesn't have to be an alpha map of particles. That's entirely up to you.

244.7.7. Alpha from render view
When cut & pasting stuﬀ from render window to {insert your favorite image editor here}
using Alt+ PrtScr, cut and paste the render ﬁrst, come back to render window and press
”A”. It changes the view to alpha and you get black & white mask to cut the background
nicely in the {again, favorite image editor}. Nice when you do testing in low res.

244.7.8. View alpha texture as wire.
Ctrl+d in 3d very usefully for preview without rendering.
Also, if you have an object (works best on a mesh plane) with an image texture, you can use
Alt+V key outside edit mode. This will adjust the object's size values so that the image
won't be stretched when projected.
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244.8. Miscellaneous
244.8.1. Restoring your “lost” work.
If you go to the temp folder where you have Blender save its temp .Blend ﬁles, reload the
most recent one and this will save you losing the whole of your work. You don't even need
to save a .Blend ﬁle for this to work. You can change the settings for this in the tool window
at the top of the Blender screen.

244.8.2. Built in Hot-Key List
Since the few last versions (since 2.28 I think) blender has a built-in all inclusive hot-key
list. Just open a text-editor window, and right besides the option to create a new text-buﬀer
there is a menu option called ¨KEYLIST.intrr¨. Select that option and the full list is loaded
in memory
--Edit: There may be many hot-keys missing, especially the newest ones, like M to mirror a
mesh, K for the Knife tool, Alt+Z for textured view... but the list is a good start at least.

244.8.3. Un-compiled PlugIns
Blender can load plug-ins for texturing, sequence editor, etc. . However, Blender comes
with a few of such PlugIns un-compiled.
In Linux they are located on the plug-ins sub-directory of the default Blender install, and
all that you need is a Make command to compile them. I don't know how to compile them
in Windows, but there they are, just waiting for you to awake them!!!

244.8.4. Blender “Easter Eggs” (Weird things included in blender)
All Publisher versions of Blender have been shipping with a Monkey mesh called Suzanne.
Just open the main tool box (Space Bar) -> Add -> Mesh -> and right below the other
primitives you'll see the Monkey.
Why/What it is for? Only NaN programmers know*. It is supposed to be a private joke
among the blender developing team. Since then, its considered as a sort of mascot for
blender. However, it is incredibly useful as a quick complex object for testing textures,
shaders, etc..
By the Way, Suzanne isn't the only joke included... but I won't spoil the surprise. You will
bump with them on your daily work, that is for sure.
• NaN was the company that originally developed Blender
Try this: run blender with the -Y argument (open the command prompt/terminal, go to
your blender executable ﬁle folder, and type blender -Y)
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244.8.5. Weird Error Message
Sometimes, when trying to use a boolean on a tri-based mesh, Blender gives the prompt:
”Wanna Crash?” >Yes Please!
but clicking it doesn't crash. This is because Blender is a lot more stable now compared
to when that 'crash' request was coded. It also used to appear when using beauty ﬁll after
face ﬁll. (Ctrl+F in edit mode)
Blender 2.37 now has a 'widget', which replicates the red/blue/green axis symbol in 3DSMax
in the 3d windows. Rotation scaling and movement of objects/Verts/faces etc., can be
manipulated using the widget, or in the usual manner of earlier versions of Blender.

244.8.6. Turn your blender animation into a screen-saver (Windows)
to turn your blender animation Windows binary ﬁle into a Windows screen saver, rename
the EXE ﬁle into SCR and right click it and install !

244.8.7. Discover the FPS rate of a Window
If you hit Ctrl+Alt+T key in a window, Blender will tell you how much time it takes to
render a single frame of that window, in milliseconds. Valuable Benchmark

244.9. ???
using construction widget press Shift to get precision mode for ﬁne tuning. Release left
mouse button (LMB) and holding Shift down press it again, then you'll get moving along
another axis.

244.10. Sculpt Mode Hotkeys
•
•
•
•
•
•
•
•
•
•
•
•
•
•

F: an interactive brush resize
Shift F: an interactive brush strength adjuster
Ctrl F: in interactive texture angle adjuster for your brush.
Shift B: a rectanglular zoom selection for close-up work
Alt B: hides all but selected rectangle
A: toggles airbrush
S: smooth
D: draw
G: grab
L: layer
I: inﬂate
P: pinch
V: toggles add and subtract in draw mode
Use X, Y and Z to toggle axis mirroring.
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245. Troubleshooting
245.0.1. ATI Radeon Slowdown Problems
Go the ATI site driver downloads section and select the appropriate OS/graphic card. This
will (most likely) link you to the d/l for the current Catalyst 4.4 drivers.
At the bottom of that page is a link to ”Previous driver versions”.
D/L the Catalyst 3.7 driver package. Run the EXE and it will extract the driver install
package to:
C:\ATI\SUPPORT\
In this directory will be a directory named (for XP/Win2K users: \wxp-w2k-7-93-030812a1010735c-efg\
This is where the driver install package is located. DO NOT RUN THE SETUP. You don't
need to install the old driver.
Navigate down thru the dir structure to the following dir: C:\ATI\SUPPORT\wxp-w2k-793-030812a1-010735c-efg\2KXP_INF\B_10679
In this dir you'll ﬁnd a ﬁle called: atioglxx.dl_ This is a ”packed” version of the ATI OGL
driver.
The next step speciﬁes how you can extract these ﬁles to your hard disk using the 'expand.exe' utility included on the cd.
The 'I386' folder on the Windows XP CD contains a utility 'expand.exe' that can be used
to uncompress all compressed dll ﬁles. It is a commandline utility, so you have will have
to run it from either the command prompt or the Run dialog. Some examples of its usage
are:
expand X:\I386\ADROT.DL_ C:\ADROT.DLL
The above command decompresses the compressed DLL

ADROT.DL_ on the WinXP CD, copies it to C:, and changes the extension to .DLL .
Just extract that ﬁle (atioglxx.dll) to your Blender install directory. Usually C:\Program
Files\Blender Foundation\Blender\
Launch Blender.... no more slowdown.
Addendum: I found this solved a problem of crashing on start up after updating my Catalyst
driver from 7.2 to 7.8, that is expanding the old 7.2 atioglxx.dl_ to atioglxx.dll and copying
it to the Blender directory.

1907

Troubleshooting

245.0.2. For people who the above solution leads to Blender crash at
start up
Thanks to Xenobius at Blenderartists Forum
This solution is tested on ATI radeon express 200 (x200) integrated video card. However it
should work on other ATI card.
Download the Nvidia 53.03 Driver HERE1
Extract the driver to C:\NVIDIA
Copy the nvoglnt.dll from the C:\NVIDIA folder to your blender program folder (i.e.
C:\Programs Files\Blender 2.40\)
Rename nvoglnt.dll (the one in the blender program folder) to atioglxx.dll
Run blender...voilà! Blender runs like it should!
[This works, because it can't use proper gl calls and uses no hardware acceleration so speed
goes crappy...]

1
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http://www.megagames.com/news/redir.cgi?http://download.nvidia.com/Windows/53.03/53.
03_winxp2k_english_whql.exe

246. Creating Blender Libraries
You've ﬁnally made that perfect object, armature or material: a gamepiece, a robot, a fully
rigged vampire character, or a millimeter-accurate model of the Empire State Building.
Besides using this work in your own artistic project, you have made the courageous decision
to share that creation with the world.
Sharing your creative work is a great way to ”give back to the community,” even if you don't
write Blender code and you can't translate the Blender documentation to Swahili.

246.1. How to Make a Library
So how do you make a library? In Blender, you don't need to export to a special format.
In fact, you don't need to do anything special beyond saving your regular .blend ﬁle. Every
.blend is a library ﬁle. Users can Append what they like from your .blend ﬁle, and ignore
parts which they don't need for their own project.
This scheme has some beneﬁts and some drawbacks.
The beneﬁt of using .blend ﬁles as a library format is that it's super easy to include extra
stuﬀ to help the user see the objects. If the user loads the .blend ﬁle directly, it works
like the pretty packaging for foods, including a quick and easy way to get a pretty ”serving
suggestion” rendering of the library contents. What you save in your .blend is what the
user will see when they load it, including all your user interface settings, lighting types, and
camera positions.
The drawback of using .blend ﬁles as a library format is that it's super easy to include
unintended things, such as extra meshes, unused material and texture channels, and other
things which the user will not ﬁnd helpful. Blender doesn't save things which are no longer
referenced anywhere, but it cannot read your mind if you leave a spare mesh on layer 13
which uses some abandoned Material.034.
Also, some people are not accustomed to the way that Blender saves all of the user interface
settings along with the .blend ﬁle. When they load your mesh, they see your way of working.
This can be instructive, but unless that's your intention, it's best to try to stick to a simple
and clean user interface setup for your library ﬁles.
For best results, you need to apply some discipline to publish a clean and useful library.
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246.2. Library Usefulness Checklist
After having used several library .blend ﬁles from various sources, I propose that anyone
making libraries follow a few suggestions:
• keep to a certain object, theme or area of focus for each library ﬁle
• all the test cameras and lights preﬁxed with a dash; e.g., -Camera, -HemiLight.001,
etc.
• any other components not intended for Appending preﬁxed with a dash; e.g., -ground
• all the test cameras and lights on the last one or two layers (lower right layer button)
• any composite object intended for Appending organized in a group to hold it together
• any groups, objects, materials, textures intended for Appending given meaningful
names
• document your unit scheme; e.g., 1 blender unit == 1 imperial foot, etc.
• any other layer contains test-render-ready objects or scenes
• choose rendering and world settings which will not take an hour to make a simple
test render
• make visible upon loading the layers required for a camera, a good lighting angle, and a
shared object
• make visible upon loading one small text ﬁle which lists layers and objects
• make visible upon loading any python script, with instructions on how to start it in
a big comment
• make your licensing expectations clear: artistic license, creative commons, etc.
• pack the texture ﬁles and other data before saving that ﬁnal .blend for publishing
• sign your work, stable email address or website url if possible
The dash preﬁxes for test-rendering cameras, boxes, ﬂoors and lights will help the user know
at a glance what to Append and what not to Append from your library.
Here's a quick way to throw out all the stuﬀ you really don't need, including extra meshes,
materials and user interface complexity.
•
•
•
•
•

save your current .blend (and make a nice backup ﬁle too)
shut down Blender entirely
open up Blender again, which will load the default settings
delete the cube and cameras from the default settings
Append all the useful parts of your library .blend ﬁle (including the useful test-rendering
items)
• select the proper test-rendering camera for users to try out your model quickly (select,
then Ctrl+KEYPAD0)
• adjust the views to ensure important things are visible and ready to render
• save the new library .blend, ready to publish
Blender saves the default settings in a ﬁle called .b.blend on your disk. If your own
preferred default settings are still too complicated for newcomers to understand, you can
move that ﬁle away temporarily to get the ”factory” built-in default settings which the
Blender team produces as a part of each new version of the software. Move the ﬁle back
again when you want to go back to your individual way of working.
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246.3. Publishing Your Library
It's helpful to include the .txt ﬁle and/or post it separately so that people can read a
summary before loading the blend ﬁle. This should include any credits, usage notes, layer
explanations, and licensing information. For you Unix folks, remember to run it through
unix2dos to enforce \r\n CRLF newlines, readable by people with less ﬂexible tools such
as Windows Notepad.
It's also of immense beneﬁt to put up small test-renders of your library objects or materials.
They don't need to be large but they should give an honest view of the work you're sharing
before a potential user takes the time to download library ﬁles that will not be useful to
them.
So, where do you publish your work of artistic genius?
• http://www.e2-productions.com/bmr Blender 3D Model Repository -- link has been
taken over to serve malware
• http://blenderartists.org/ forums
• http://www.deviantart.com/
• http://www.blendswap.com
• your own website
If you post things on your own website, try not to rely on a free site that will over-run your
bandwidth limits and disappear two months later. Search engine links will sometimes live
on for years, just frustrating those who were hoping to ﬁnd a millimeter-accurate model of
the Empire State Building.

246.4. Beyond Libraries
If you have even more time to spare, consider writing up a tutorial on how you achieved
any tricky results!

246.5. Thank You
For every artist who chooses to share their creative works with the community, there are a
dozen artists, or even hundreds, who thank you immensely.
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247. Add some depth with stereo
This tutorial contains some tips for how to work with stereo images.
Stereo viewing is to see the same thing from two slightly diﬀerent angles. This is what
humans normally do with their two eyes. There are many ways to view a stereo image. A
perfect method is to use a stereo monitor. But they are quite expensive, and many are of
very low quality. In the other end of the price-scale you can use crossviewing. Put the two
images next to each other, and look at one with one eye, and the other with the other eye.
Needs a bit of practice though. A popular solution is red/blue anaglyph glasses, but they
give very bad colors.

247.1. The stereo camera
I wanted a stereo camera rig that was easy to work with. It should have three cameras
(center, left, and right), have an easy way to set separation (should be 1/30 of the distance)
and the center cam should be used to control position etc, the two others should just follow.

247.1.1. Create it
Manually
1. Reset the cameras position, rotation and size (you can use ALT + G , ALT + R
and ALT + S ). You may want to note these values ﬁrst, so you can change them
back later. I just make sure there's an IPO-curve for them, for example by making a
keyframe ( I ).
2. Create two new cameras. Reset their position, rotation and size too.
3. Name them Camera.Right and Camera.Left or similar.
Set LocX to 1 for
Camera.Right and -1 for Camera.Left. (Press N to see data for selected object,
in this window you can change name and values.) (Select a camera by clicking RMB
several times on the cameras, until the right one is selected.)
4. Create a new cube (remember to press TAB to exit edit mode). Reset position,
rotation and size. Name it Distance Cube and set these values: LocZ: -30. SizeX: 0.1.
SizeY: 0.1. SizeZ: 30.
5. Switch to front view. ( 1 )
6. Select Camera.Left. Then select Camera while holding down SHIFT so both are
selected. Press CTRL + P and press ENTER to register Camera as parent. Then
press CTRL + L and select Camera Data. Repeat with right Camera.Right and
Distance Cube.
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With a script
Editor’s note
I tried making a script that creates the rig, it almost works. Any help ﬁnishing it?
import Blender
from Blender import *
# Prepare
scene = Scene.getCurrent()
camera = Object.Get("Camera") # TODO validate that it is a camera
oldLocation = camera.loc
oldRotation = camera.rot
oldSize = camera.size
# Create stuff
c = Camera.New("ortho")
cameraLeft = Object.New("Camera", "Camera.Left")
cameraLeft.link(c)
scene.link(cameraLeft)
c = Camera.New("ortho")
cameraRight = Object.New("Camera", "Camera.Right")
cameraRight.link(c)
scene.link(cameraRight)
dEmpty = Object.New("Empty", "Distance")
scene.link(dEmpty)
# Configure
camera.loc = (0,0,0)
camera.rot = (0,0,0)
camera.size = (1,1,1)
cameraLeft.loc = (-1,0,0)
cameraLeft.rot = (0,0,0)
cameraLeft.size = (1,1,1)
cameraRight.loc = (1,0,0)
cameraRight.rot = (0,0,0)
cameraRight.size = (1,1,1)
dEmpty.loc = (0,0,-60)
dEmpty.rot = (0,0,0)
dEmpty.size = (1,1,1)
scene.update(1)
# Connect
camera.makeParent([cameraLeft, cameraRight, dEmpty], 0, 0)
# do that CTRL+LKEY thing
cameraLeft.link(Camera.Get("Camera"))
cameraRight.link(Camera.Get("Camera"))
# Reset original values
camera.loc = oldLocation
camera.rot = oldRotation
camera.size = oldSize
# Finish
Blender.Redraw()
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247.1.2. How to use it
• Never change the cube or the two side-cameras. Only change the center camera. Use
that one for positioning, rotation etc.
• To set the separation: As always, select the center camera. Resize it (with S ) so you
can see the end of the cube if needed. Point at the end of the cube with the mouse
pointer, and press S . Move the mouse pointer to the point of the main motive, that is
closes to the camera. The end of the cube may not end exactly there, but that doesn't
matter.
• To render (or preview) with one of the side cameras, select it and press CTRL + 0 .

247.1.3. What needs improvement
The cube is visible
Instead of using a cube, I'd rather use something that doesn't render. It could be an
”empty”, but see below.
The cube is hard to see
It can be hard to see where the cube ends, even in a simple scene. You can select the center
camera AND the cube, then it is clearly visible. But you must remember to only select the
camera, before you insert a keyframe, so your changes to the cube doesn't get saved.
Distance plane is at inﬁnity
The distance plane is where ”zero depth is”. When viewing a stereo image, the distance plane
is where the medium is. In this rig the distance plane is at inﬁnity, meaning everything is in
front of it. While stuﬀ popping out in front of the screen is cooler than stuﬀ being ”inside”
the screen, it's a lot harder to make it look nice. Specially because with everything in front
of the screen, it's easy to get stuﬀ that is just way to close to the viewer. It can get so hard
to see that the 3d-eﬀect is completely gone.
A diﬀerent solution is to make the side cameras point at the end of the cube, or add a plane
to the rig, and point at that. But then the cameras are no longer parallel, and that creates
distortion.
The compromise solution is to (conceptually) render the images too wide, and then crop
the excess from the left side of the left image, and the right side of the right image. Then
it will look like it points just like in the previously mentioned solution, but without the
distortion.
But this give a lot of problems. First, I'd like to do this a smarter way, instead of just
following the path describe above. But I don't think that's possible in Blender. (I think
povray can actually do this.) So I need to render the image too wide. But if I increase width
in output, it actually renders the same width of the motive, but decreases height. Then
I need to do some weird math to get the right FOV, and I don't know half the formulas.

1915

Add some depth with stereo
Cropping must be done outside Blender, and the rest of ”the production line” is hard to get
back into Blender if wanted.
I guess a couple of planes in the rig close to the cameras could simulate the cropping, but
that is of limited value. To make an adjustable distance plane with them seems quite hard
to me, it would need some scripting I guess.

247.2. Stereo viewing with the rig
This is where it gets exciting, now you are actually getting something to look at.
1.
2.
3.
4.
5.
6.
7.
8.

Create a new screen, you could call it Stereo View.
The screen should have one big area from side to side.
Set the area to 3D View
Unlock it (The Locks layers and used Camera to Scene-lock)
Select Camera.Right and press CTRL + 0
Split the area in half so there is two parts next to each other
In the right area, select Camera.Left and press CTRL + 0
Adjust zoom in both areas so the frame that shows what is rendered is completely
visible, but ﬁll as much as possible. If you can't make them same size, the two areas
are not same size.
9. Use cross-view method to see the 3d-eﬀect. Look at the left area with the right eye
and right area with the left eye. (It's a skill you need to learn and practice.)
10. Press SHIFT + ALT + A to see your scene animated in stereo.
If you cannot see these, there is a lot of help with viewing them on the web. Use a search
engine to ﬁnd them.

247.3. Stereo rendering
247.3.1. Anaglyph
Create two render layers in the Render Layers tab.
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Stereo rendering

Figure 1705

Editor’s note
You need to ﬁnd how to associate one camera with one render layer
Then go the Node Editor and click on the button with a human face. Click on Uses
nodes and remove the created items by selecting the items and clicking on DEL . Now,
using the Add menu, you need to do this diagram:
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Add some depth with stereo

Figure 1706

Once done, return to the Buttons window and select the button Do Composite on the
Anim tab:

Figure 1707

Then click on the button Render on the Render tab:
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Stereo rendering

Figure 1708

You should see your objects as an anaglyph:

Figure 1709
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248. Ways to create a ”ﬂuﬀy” eﬀect
(materials and lights)
248.1. Spherical Blend Texture
This technique maps a spherical blend texture to the outsides of an object.
Create a new material and name it something intelligent. Create a new texture for this
material, change the texture type to Blend, and then in the texture properties, change the
blend shape to ”Sphere”.

Figure 1710

Back in the material buttons, go the ”MapInput” tab and change the texture coordinates
to Blank-Blank-Z and Nor and as demonstrated in the next screenshot:

Figure 1711

Finally go the ”MapTop” tab, and depress the Emit button and set the Texture Blending
Mode to ”Add”:
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Ways to create a ”ﬂuﬀy” eﬀect (materials and lights)

Figure 1712

That's all there is to it, and here is how it looks:

Figure 1713
----

248.2. Backlighting
This is a technique that a rather famous blender user called ”@ndy” uses. Very simple and
eﬀective.
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Backlighting
All you need to do is place a Hemi light BEHIND the object you want to light in respect
to the active camera.
Breakdown: First add a Hemi lamp to your scene:

Figure 1714

Next, Select the lamp THEN press and hold down the Shift key, and select the Camera.
Press Control-C to bring up the copy attributes menu, and copy location AND rotation.
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Ways to create a ”ﬂuﬀy” eﬀect (materials and lights)

Figure 1715

Now select JUST your lamp, press R to rotate it, then press the X key TWICE to rotate
around the local X axis. Using your numpad, key in ”180” to rotate the object 180Degrees.
All that remains to do is to press G to grab the lamp, then press Z TWICE to move along
the local Z axis, and move the lamp until it is past and behind the object of interest. your
resulting setup should look something like this:
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Backlighting

Figure 1716

And here is the rendered result:
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Ways to create a ”ﬂuﬀy” eﬀect (materials and lights)

Figure 1717
------• Color ramp1 with input set to normal.
Pretty straighforward, but many advise against it.
• Minnaert shader
Available in 2.37, ”Darkness”<1 actually brightens edge. A cool shader, but not very useful
for this purpose.

1
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http://www.blender3d.org/cms/Ramp_Shaders.348.0.html

249. Human Body
This tutorial should cover the modelling, skinning and animation of human body, plus facial
expressions.
There are some tools to generate human body from parameters like:
• makehuman1 free software program (gpl). The models generated are under MIT license.
The models generated can be easily imported in blender.
Use lightwave(obj) export. The exported ﬁle is located at ...\Documents\makehuman

Figure 1718

1

http://www.makehuman.org/
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Human Body
Delete the original cube ﬁrst. The human object is smaller than the standard cube. Use the
UVImage editor to see the UV mapping but it actually uses a texture stored in the image
ﬁle texture.png

Figure 1719

• facegen2 proprietary program. Used for The Elder Scrolls IV: Oblivion3 .
links to anatomy sites :
• ﬁneart4
• Body proportions5
2
3
4
5
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http://www.facegen.com/
https://en.wikipedia.org/wiki/The%20Elder%20Scrolls%20IV%3A%20Oblivion
http://www.fineart.sk/
https://en.wikipedia.org/wiki/Body%20proportions

Backlighting
tutorials: Blender 3D: Tutorial Links List6

6

https://en.wikibooks.org/wiki/Blender%203D%3A%20Tutorial%20Links%20List
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250. Rendering Information
Only some links to wikipedia articles for now
• wikipedia:Rendering (computer graphics)1
• wikipedia:Specular reﬂection2
• wikipedia:Diﬀuse reﬂection3
• wikipedia:Flat shading4
• wikipedia:Gouraud shading5
• wikipedia:Phong shading6
• wikipedia:Lambertian diﬀuse lighting model7
• wikipedia:Phong reﬂection model8

1
2
3
4
5
6
7
8

https://en.wikipedia.org/wiki/Rendering%20%28computer%20graphics%29
https://en.wikipedia.org/wiki/Specular%20reflection
https://en.wikipedia.org/wiki/Diffuse%20reflection
https://en.wikipedia.org/wiki/Flat%20shading
https://en.wikipedia.org/wiki/Gouraud%20shading
https://en.wikipedia.org/wiki/Phong%20shading
https://en.wikipedia.org/wiki/Lambertian%20diffuse%20lighting%20model
https://en.wikipedia.org/wiki/Phong%20reflection%20model
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251. Using Blender Libraries
You can append libraries in two ways. You can make a local copy of data blocks (like
objects, meshes, ...) of the content of a .blend ﬁle in your .blend ﬁle (appending) or you
can use data blocks from another .blend ﬁle (dynamic linking).
You can Append with the command in the 3d view File -> Append or SHIFT+F1. When
you give this command a ﬁle browser window opens. There are two buttons Append and
Link at the bottom of the window. The default action is appending. But you can use
dynamic linking selecting the link button.
At this point select the .blend ﬁle to append. You can select one of the following data blocks
type to append:
•
•
•
•
•
•
•

Group
Mesh
Object
Scene
Text
World
(not complete yet)

Note that this is a complete list, when you append only block types present in the ﬁle will
appear. Select the desired type. Now you can select the particular data block to append
by selecting its id.

251.1. Indirect linking
When you give an append or link command almost all relations between data blocks in
Blender get expanded. For example, when you link (or append) a speciﬁc Group, all its
objects, the meshes associated with the objects, the materials and the animations will
be linked (or appended) too. That is called ”indirect linking”. When you use dynamic
linking such indirect linked data is not stored when you save a .blend ﬁle, when you load
the ﬁle again blender will look for the indirect linked data blocks in the library ﬁle.

251.2. Groups
When you append a Group, blender will also create links in the current Scene to the objects
that are part of the group. The Objects then become visible. However, when you decide
to dynamic link a Group, it won't do that. To use the objects in your blender project
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Using Blender Libraries
you can use the group as a duplicator ”SHIFT+AKEY -> Group menu -> group id to
duplicate”.

251.3. See also
• http://www.blender.org/cms/Library_Linking.769.0.html
• http://www.blender.org/cms/Blender_Architecture.336.0.html
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252. Beginning Modeling Final Project
Now that you've gotten the hang of 3D modeling, it's important to get some community
feedback on your progress. Don't be an idiot and skip this part, or you'll regret it later.
Basically this will help you track your progress and give you something that you'll be
working on over a long term and something you'll be proud of.
• First, you need to come up with a project idea. You can choose your own modeling
project, or choose one from the list below.
• Second, you need to create a model of your idea. Spend a couple of hours on it, and give
it some details.
• Third, once you believe you've come far enough with the model, post it in the Works In
Progress1 forum on BlenderArtists.org(formerly elysiun.com) (you will have to create an
account if you haven't already). Post several screenshots of your model from within the
Blender (note: creating screenshots is outside the scope of this wikibook, though see note
lower down the page). You can post whatever subject and message with your posting
that you would like, or you can use this suggested subject and message:
Subject: Beginning Modeling Final Project - <project name>
Please assist me with any feedback on my model, keeping in mind that I am an absolute
beginner still. I appreciate your help.
• Wait for feedback. It usually comes very quickly. If you have any questions about feedback
that you are given, don't be afraid to ask your questions in the forum.
• When you and others that have viewed your work feel that you are ready, save your model
in some place you can get back to easily. You will continue working on this project once
you've learned some new skills.
• Move on to the next page.
(BTW. in Windows and/or maybe other OS, to take a screenshot press 'PrtScn'
(PrintScreen). It will copy the screen to clipboard for you to paste in your favourite graphics
application. This may not work in other OSs but try anyway. You can also create Blender
screenshot directly from Blender using menu File>Dump 3DView... or File>Dump
Screen... )
(In linux under the KDE I use ksnapshot, check under the graphics tab and see if you have
it. If not it should be just a google search away :) gl and happy blendering)
(On Mac OS X, press Command (Apple) + Shift + 3 to do a full screen capture)

1

http://blenderartists.org/forum/forumdisplay.php?s=b6a3696a3b803274bb7c1b49df9a22a2&
f=16
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Beginning Modeling Final Project
•
•
•
•
•
•
•
•
•
•
•

List of ideas:
A Computer and keyboard
A ﬁshing rod
A train engine
A skyscraper
A robot
A Tank (real or made up)
An airplane
A truck or car
Household appliances
A Weapon
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253. Using Inkscape to make advanced
Bezier curves
253.1. Introduction to Inkscape
Inkscape is a free program that uses SVG (Scalable Vector Graphics) for its ﬁle format,
and these SVG ﬁles can be imported into blender as Bezier curves. Inkscape has some great
tools for making advanced shapes that would take forever to make in Blender itself. We
will use Inkscape because it is free, and it is very easy to learn.

253.1.1. Installing Inkscape
• Mac OS X and Windows: Go to Inkscape.org1 and click download. there will be installation ﬁles for each operating system.
• Linux: Go into the terminal.
For Arch Linux, type pacman -S inkscape
For Debian based distributions, type sudo apt-get install inkscape
For Fedora and rpm based distributions, type yum -y install inkscape
For any other distribution, check your package manager to see if it has a package for
inkscape. if not, download the source code at Inkscape.org2 and run PKGBUILD in the
directory of the source.
Inkscape is a pretty large program, so it will take a while to download and install.

253.2. Getting Started
Because blender doesn't import any eﬀects or ﬁlters from SVG ﬁles, we will only have to
learn basic path modeling. This is very easy to learn, and will take no time at all. Once it's
ﬁnished installing, open Inkscape. You will see a large empty page and a bunch of buttons
to the left. Don't mind the empty page, we won't be needing it. We will re-size this once
we are done with the tutorial. Before we get started, I will show you how to use some of the
controls. You will probably be right clicking a lot because you're used to blender, but that's
okay. Let's start out with a star to practice some of the controls. Click the Star/Polygon
tool to the left, and click anywhere on the paper and drag.

1
2

http://inkscape.org/
http://inkscape.org/
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Using Inkscape to make advanced Bezier curves

253.2.1. Simple Controls
go back to ”Object Mode” by clicking the cursor icon to the left. Now, let's try out some of
the controls:
Action
Zoom In/Out
Move along Y Axis
Move along X Axis
Move along both axes
Select Path/Curve
Select All
Select all paths/curves within a
rectangle

Hotkey
CTRL+SCROLL
SCROLL
SHIFT+SCROLL
Hold MMB and Drag
LMB
CTRL+A
Hold LMB and drag (Like selecting icons on
your desktop)

These are only a few of the controls, you will learn more controls later in this tutorial.

253.2.2. Editing your Bezier path
Go back to the Star/Polygon tool so we can edit the star. You will see 2 dots appear on the
star. You can drag these around, and see what happens. Another thing you can do is add
more points to the star, change the spike ratio, make it rounded, and make it randomized
with the ”CHANGE:” Dialog right above your image.

Figure 1720

If you want to edit each node separately without symmetry, go back to 'Select and Transform
Objects' mode

1938

Getting Started

Figure 1721

and click Path>Object to Path. Now you can just go to 'Edit Paths by Nodes' mode
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Using Inkscape to make advanced Bezier curves

Figure 1722

and play around with the shape a bit.
By clicking and dragging, you can move a node or curve an edge. when you make a curve,
2 nodes will show up that you can drag and edit the curve with more precision.
To add a node in the path, select an edge and press the plus button
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Getting Started

Figure 1723

to remove a node, press the minus button, and, well, the buttons pretty much explain
themselves, so you can just play around and see what you get.
After you think you know how to edit paths pretty well, let's try to make a path from
scratch. Click the 'Draw Bezier Curves' button
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Using Inkscape to make advanced Bezier curves

Figure 1724

and click to add nodes for the shape you want. If you click and drag, you will make a node
and curve the node while dragging the mouse. To ﬁnish the path, go around to the ﬁrst
node that you made and click on it. This will ﬁnish the path and make it a solid shape.
When it is done, a outline, or stroke of the shape will appear. If you want it to show as a
solid shape, you can click one of the colors on the bottom and it will ﬁll the path with that
color.
Now, move the star inside the path (In 'Select and Transform Objects' mode, of course),
without it overlapping the borders of the path. If the star is too big, scale it down and hold
ctrl to keep the same scale on the X and Y axis. Select both your path and the star, and
press Path>Diﬀerence to cut a star-shaped hole inside your path.
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Getting Started
Congratulations, You have made a completely pointless random shape and learned the basics
of creating a shape in inkscape! Now, It's time to get this into Blender! Save your SVG
image, and open up blender. Press File>Import>Paths(.svg, .ps, .eps, .ai, gimp) (Blender
2.49). Select your SVG ﬁle and the settings are ﬁne how they are. Press OK and see your
path appear in blender (You may have to delete the default cube to see it) From here, you
can Extrude, bevel, and do whatever you want to you bezier path in blender.
The result may look something like this:

Figure 1725
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254. Light Mapping
254.1. Needs Expert
The original writer of this section is not knowledgeable about the subject of ”Light Mapping”
and hopefully can beneﬁt from someone who has much more experience with it
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255. Platonic Solids
The Platonic solids or Platonic polyhedra are the convex polyhedra where all faces are
copies of the same regular polygon, and the same number of edges meet at every vertex.
There are ﬁve of these shapes: the tetrahedron (like a pyramid but with a triangular base):
cube, octahedron, dodecahedron and icosahedron.
Recent versions of Blender include an addon called “Regular Solids”, which lets you instantly
generate these and a whole bunch of other similar shapes. However, the following steps do
not require any addons.

i Information
Applicable Blender version: 2.67

255.0.1. The Tetrahedron
Bring up the Add Mesh menu (Shift+A), and select a Cone. Set the number of Vertices to
3,
√ leave Radius 1 at its default value of 1.000 and Radius 2 at 0.000. Now, set the Depth to
2 ≈ 1.414. To make sure that you have a regular tetrahedron, you can check the lengths
of the edges (in Edit Mode, press N to open the Properties panel and locate the checkbox
Length in the section Edge Info).

255.0.2. The Cube
This happens to be a built-in shape in Blender. Just bring up the Add Mesh menu, and
select Cube. Done!

255.0.3. The Octahedron
This shape is the dual of the cube—it has vertices where the cube has faces, and faces where
the cube has vertices. To make it, ﬁrst create a cube. Press TAB to switch to Edit mode.
All the vertices should already be selected. Press W to bring up the Specials menu, and
select the Bevel function (or select it directly with CTRL + B ). As you move the mouse,
you will see each vertex of the cube turn into a triangular face; don’t bother getting the
shape exactly right, simply press LMB to ﬁnish the drag. Then, look in the panel that
should have appeared at the bottom of the Toolshelf on the left of the 3D view (press T
to toggle its visibility); you should see an editable numeric ﬁeld labelled “Oﬀset”. Type the
value 1.0 into this ﬁeld, and that should exactly form the octahedron shape.
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Platonic Solids
Finally, bring up the Specials menu again, and this time select Remove Doubles.

255.0.4. The Icosahedron
Bring up the Add Mesh menu, and select an Icosphere. Set the Subdivision to 1. Simple!

255.0.5. The Dodecahedron
This shape is the dual of the icosahedron. To create it, make an icosahedron as above. Then
do what you did to make an octahedron out of a cube: press TAB to switch to Edit mode.
All the vertices should already be selected. Press W to bring up the Specials menu, and
select the Bevel function. As with the octahedron, press LMB to ﬁnish the drag. Then
set the Oﬀset value to 0.607, the closest I could ﬁnd.
Then, bring up the Specials menu again, and this time select Remove Doubles. However,
the default Merge Distance of 0.0001 will not be enough to remove all the doubled vertices;
change this to 0.001, and you should see the message “Removed 40 vertices” brieﬂy ﬂash up.

Figure 1726

255.0.6. Exercise
What’s the dual of the tetrahedron? Try applying the Bevel operation to one of those; what
do you end up with?

255.1. External Link
Wikipedia article1

1
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http://en.wikipedia.org/wiki/Platonic_solid

256. Modeling techniques and Workﬂow
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257. Polygonal Modeling
As the name suggest, polygonal modeling involves constructing the models out of polygons.
Strictly, software packages works only with triangles. Blender could show you quads and
some software packages could even let you work with polygons with more than 4 sides (ngons) but these packages work internally only with triangles. These triangles are hidden so
that you could concentrate more on modeling.
While diﬀerent modelers works diﬀerently, they would still follow certain workﬂows (some
call this techniques). These are familiarly called box modeling and polygon-by-polygon
modeling (poly-by-poly modeling).
Box modeling is a top-down approach where modelers start with a primitive (usually a
cube (box), hence the box in box modeling). Then from this primitive, the model's form is
build up where details are gradually added.
Poly-by-poly modeling is almost the opposite of box modeling. It is the bottom-up
approach where modelers start with a plane or even a vertex. Using extrusion and other
tools, more geometries are added. Polygon by polygon the model is gradually build.
Neither of the two is better than the other but there are instances where one workﬂow lends
much better to the situation. One typical advantage of box modeling is that at early stage,
you are able to conceive ﬁrst the form (the whole) of the model and is better equipped to do
general corrections without bothering yet with the details. Poly-by-poly otherwise give you
more control on the geometry and is much more easier to use in modeling complex forms
like the human ear. Complications do arise when working with the two. In box modeling, it
is typically diﬃcult to manage the geometry when adding details. Experience is necessary
so as not to create a mess. Poly-by-poly modeling otherwise has its own quirks. Since
you are going detail by detail, it is easy to make a mess with the models form (i.e. wrong
proportions).
While the two are opposites, they compliment each other beautifully. Most modelers would
combine the two workﬂows in a variety of proportions, combining the strength of each. For
example one might model a human body using box modeling while the head and the ears
are done using poly-by-poly modeling.
Blocking with primitives is added to enrich approaches is modeling. It is basically box
modeling in conjunction with divide-and-conquer approach. Diﬀerent parts are modeled
separately with their own primitives and later attached with the others to form the whole.
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258. Box Modeling
Easy to undertake and ﬂexible, box modeling is a favorite of beginners and veterans alike.
It is fun to work with and general results are visible in a short time. It is a powerful work
ﬂow that any modelers should know.

258.1. Before We Start
Before doing any modeling, it is vital to plan ﬁrst. Gather references and make a general
plan on how to tackle the modeling phase. Being ready will save you a lot of complications
later

258.2. The Work Flow
With box modeling, start with a primitive that is appropriate for your subject. Most start
with a box and generally a good primitive to start. Then, from the primitive, using a
variety of tools, mold the essential form of your model. Also called the roughing phase.
Don't delve on details here, those are to be tackled later. Finally, on this form, we go to
the nearly recursive process of adding details. Layer by layer, details are added until the
required amount of detail is achieved.
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Box Modeling
Start with a Primitive
p The Primitive

Figure 1727

Select the proper primitive for your work. Most modelers start with a cube. The cube is
the most ﬂexible primitive available and is suitable to almost all form of subjects. But, in
many cases, selecting other form of primitives would cut out most of the modeling required.
A gun is a cinch to model using a cylinder. With a little adjustment, a torus forms a good
doughnut. In an instant a ball can be made out of a sphere. So produce your primitive to
work with.
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The Work Flow
Rough It Out
p The Form

Figure 1728

Take the primitive and start modifying it to capture the essential form of your subject.
Tools like extrude, loop cut, scale and grab are very handy for this. Avoid worrying about
details at this stage. Those are to be done later.
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Box Modeling
Adding Details, Details and more Details
p Details, details and more details

Figure 1729

Now, we approach the most diﬃcult and unquestionably the most fun part. Using a variety
of modeling tools, modify the form again to incorporate details. Add details layer by layer,
from general to speciﬁc. Planning, studying and experience would help you go through.
Continue until you achieve the desired level of detail.
Adding details requires subdivision or addition of polygons. The knife and the loop cut
tool is handy for subdividing meshes. Extrusion is great for adding details like horns and
ﬁngers. Face and edge loop must be herded to other directions at times and warrants a
study by itself. Blender provides you with required tools to achieve all of this.
At this stage, beginners and experienced modelers alike will ﬁnd their meshes getting more
and more diﬃcult to work with as the mesh gets a more and more dense at each level of
details added. Planning, an eye to the edge ﬂows and experience alleviate this. So plan and
keep practicing.
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259. Illustrative example: Model a Chair
(Swan Chair)
Now let's start with real modeling. In this tutorial we will study in greater depth how to
model using box modeling work ﬂow. Let start with a swan chair. It is great piece to model
for its a popular piece of furniture so reference images are easy to ﬁnd. It also have a simple
geometric structure so its shape easy to grasp and also contains simple edge and face loop
ﬂow so as not to necessitate diﬃcult edge loop face loop ﬂow herding techniques.
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Illustrative example: Model a Chair (Swan Chair)
p Scene with the chair model as seen in Blender

Figure 1730
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The Work Flow
p Rendered Scene with the chair

Figure 1731

The techniques learned could also be used to model other chairs (Example: the Egg chair,
Tulip chair or Parson's chair which is advised to be modeled too) and other subjects.
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260. Model a Chair-Preparations
Many people do not know what a Swan chair look like. Its time to open up the internet
browser and search for images. Or if you have an actual Swan chair with you, your lucky.
You can look at a real model while modeling. This would simplify decisions and remove the
need for guessing certain details that you are not available with image searches alone.

260.1. Knowing our model
We need to know what we are modeling look like. You can't do this without references to
guide you. A simple image search with Google would provide you the references you need.
Gather several images that gives you diﬀerent views of the chair. A front and a side view
is great to use as a background image to guide as while modeling. Also, gather at least one
image that shows the chair at an oblique angle so that it will provide a much more ”3d”
view. This will shows more clearly the shape of the chair, more than the front and side
view alone would give you.

260.2. Loop study
Take time to study the model. For simple models like this, it would be quite quick, especially
with experience. For this project, the loops are as shown bellow.
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Model a Chair-Preparations
p Swan chair's loops

Figure 1732

The pink loop goes around the edge of the chair deﬁning the chair's edges and thickness.
The light green, light blue and light purple loops follows and create the form of the chair.
The crossing green loops forms the bottom of the chair. The light blue and green loops
contribute for the form of the ”wings”, while the purple and green loops form the back. Its
a simple loop structure, its topologically (sorry for using the term) the same as this cube
extruded to form a T (upside down so the loops would match more).

1962

Loop study
p The T shape piece loops

Figure 1733

While modeling keep these loops in mind and try to achieve the loops. For this project, the
loops are achieved with simple extrusions of a cube, just like the T piece above, but in a
form that looks more like the chair.

1963

261. Model a Chair-The Seat
After studying the subject, we are ready to tackle modeling it. Start up Blender.

261.1. Start with a Primitive
For this project we would use a cube. The cube already has several face loop we need and
none of that we don't, so this primitive is a good starting point.
Opening Blender, we are already supplied with the default cube which is handy. If you
don't have the default cube because you change the setting or remove it, simply add a new
cube. Name this primitive something sensible like ”Swan Chair” because it would become
our chair later. Move the cube or adjust the background image until the cube is centered
at our image. After doing that we proceed shaping our cube to create the basic form of our
chair.

261.2. Rough it out
Since we are modeling a symmetrical object, lets take advantage of it and use the mirror
modiﬁer. Cut the cube in the front exactly in half by using loop cut at center (Shift +
RKey -> middle click, or Ctrl + RKey -> middle click on this editor's computer). For
those with no middle buttons you could use subdivide. Select the vertical edges (go to edge
select mode ﬁrst, Ctrl + Tab -> 2) then use subdivide tool (WKey -> 1). Remove the left
half by deleting the vertices. Then add a mirror modiﬁer in the modiﬁer stack. This is
available at the edit buttons, select the modiﬁers tab the click the ”Add Modiﬁer” button
and select ”Mirror” from the selection. Activate ”do clipping” from the mirror modiﬁer panel
that appeared to prevent accidental movement of the central vertices.
(Noob Note: If you follow these instructions, you'll have a gap between the mesh and its
mirror. I ﬁxed this by increasing the ”Merge Limit” option in the Mirror modiﬁer menu to
.1.)

1965

Model a Chair-The Seat
p The cube primitive with mirror modiﬁer on

Figure 1734

Move the vertices so that it would follow the shape of the bottom of the chair image.
p Shaping the bottom

Figure 1735

1966

Rough it out

Note that the reference images used does not match very well. This is because of perspective
and camera angle distortion. In this case use the side image sice it shows less distortion. Use
the front reference image as an eyeballing guide for the front side of the chair. An oblique
reference as stated earlier in planning stages is helpful to guide you in this condition.
Add an edgeloop using the loop cut tool (Shift+RKey) as shown in the image bellow. Move
the newly created vertices to follow the references
p Shaping the bottom

Figure 1736

Its is good practice that while modeling you had to view your model at various views not
only the standard front, side and top views. Remember that you are modeling a 3d object.
What looks good in this some views are not necessarily good in other views. This would
result in complications like the familiar ﬂat face look in face models. Moving your view
around would help you prevent this. Shown bellow is the view of the model at an oblique
view.
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Model a Chair-The Seat
p Shaping the bottom oblique view

Figure 1737

Now extrude the back part of the model to form the back part of the chair. Adjust the
newly formed vertices to follow your guide images as shown bellow.
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Rough it out
p Shaping the back

Figure 1738

Its a good practice to see the model at various views while modeling here is how it look like
now at an oblique view:

1969

Model a Chair-The Seat
p Shaping the back oblique view

Figure 1739

Select the following faces. We are going to extrude it to form the sides for the chair.

1970

Rough it out
p Shaping the sides, faces to select

Figure 1740

Extrude the faces and adjust newly formed vertices to conform with the guide images.
p Shaping the sides

Figure 1741

1971

Model a Chair-The Seat

And now the oblique view.
p Shaping the sides, oblique view

Figure 1742

The back still does not look good so add the following edge loop.
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Rough it out
p Shaping the back again

Figure 1743

Adjust it.
p Shaping the back again

Figure 1744

Remember to rotate your view to see problem areas.
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Model a Chair-The Seat
p Shaping the back again, oblique view

Figure 1745

Add this edge loop too.

1974

Rough it out
p Shaping the back again

Figure 1746

Adjust.
p Shaping the back again

Figure 1747

And keeping with our good practice.
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Model a Chair-The Seat
p Shaping the back again, oblique view

Figure 1748

Say, the form is ﬁnished. The loops are all in place and the form is easily identiﬁed as a
rough model of the Swan chair.

261.3. Adding More Details
Now the basic form of the model is ﬁnished and with all important loops in place detailing
this model is easy. Lets start by deﬁning the back. Add these edge loops.
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Adding More Details
p Add these loop

Figure 1749

Move the newly created vertices to ﬁt the references.
p Adjust the form

Figure 1750

Be sure that the model looks right at various angles. The references images collected earlier
will help. Adjust vertices if necessary.
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Model a Chair-The Seat
p Our model

Figure 1751

The sides need to be taken care of too so add these edge loops.
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Adding More Details
p Add these loops

Figure 1752

Then adjust the vertices.
p Reﬁne

Figure 1753

This is how the model now looks like.
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Model a Chair-The Seat
p Our model

Figure 1754

Continue by adding these loops.

1980

Adding More Details
p Add these loops

Figure 1755

And adjust as usual.
p Tweak

Figure 1756

Check that it looks good at other views too. Move vertices as necessary.
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Model a Chair-The Seat
p Our model

Figure 1757

Keep repeating this procedure. Add loops then adjust. Here is the loops that was added to
the model. Tweaked after adding each.
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Adding More Details
p More loops

Figure 1758

The outline of the chair needs rounding up. Add these loops and tweak so it looks like the
one shown.

1983

Model a Chair-The Seat
p Rounding loops

Figure 1759

This is now how the mode looks like.

1984

Adding More Details
p Our model

Figure 1760

Its rather tedious to add more loops at this time so lets do a cheat. Select all vertices (press
AKey a few times) and then subdivide (WKey -> 1Key) to add more vertices.
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Model a Chair-The Seat
p Subdivide the whole mesh

Figure 1761

The model looks blocky so lets smooth it out. While the whole chair is still selected smooth
the vertices by clicking Smooth a few times (Edit buttons ->Mesh tools -> Smooth; also
available at WKey->Smooth). It would smooth out the model.
p Smoothing the model

Figure 1762

Admire the work (and tweak if necessary).

1986

Adding More Details
p Our model

Figure 1763

This is optional. Add this loop and scale along normal (Alt + Skey) to scale it in. Adjust
vertices if necessary.
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Model a Chair-The Seat
p Modeling the seams

Figure 1764

1988

262. Model a Chair-The Feet
Now the seat is ﬁnished, time for the legs for it to stand on.

262.1. Starting Primitive
The leg is mainly made up of cylinders so a cylinder is a very good primitive to start. In
object mode add a cylinder with 16 vertices.Center the cylinder on the upper part of the
telescope.
p Adding the cylinder primitive

Figure 1765

Tip: to make the cylinder centered relative to the seats center, while in object mode select
the seat then hit Shift+Skey (Snap options) then select Cursor->Selection. The 3d cursor
would be moved to the center of our seat. Now when you add the cylinder, the cylinders
center would be located at the cursor which is also at the seats center. Now all you have
to do is to move the cylinder along the y and z axis because it would be properly located
relative to the x axis.
Hide or move the Seat to another layer so that it would not intrude while modeling the leg.
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Model a Chair-The Feet

262.2. The Upper Telescope
Go to edit mode and scale the cylinder until its radius match the radius of the upper
telescopic element of the chair's leg. Then move the top and bottom vertices to match the
reference.
p Modifying the primitive to ﬁt reference

Figure 1766

Extrude the bottom part and place it a little lower. Extrude again and right click so that the
newly created vertices would remain in their position. Scale the vertices a little. Extrude
again and move the extruded region up the cylinder.
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The Upper Telescope
p Shaping the bottom of the telescope

Figure 1767

Remove the top and bottom vertices that cap the ends.
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Model a Chair-The Feet
p Opening ends

Figure 1768

We will be using subsurf modiﬁer to make this part smother. Add this loop to constrain
the smoothing on this area.
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The Lower Telescope
p Adding control loop

Figure 1769

262.3. The Lower Telescope
Now lets start with the lower part. Add a cylinder in object mode and adjust the newly
created vertices to match the reference.
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Model a Chair-The Feet
p Start modeling the lower telescopic part

Figure 1770

The legs would be extruded from this cylinder. Add this loop to prepare.
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The Lower Telescope
p Add this loop to enable extrusion of legs

Figure 1771

Select the faces between the newly added loop and the bottom loop. Extrude this faces but
right click after extrusion so the extruded faces remain in their position. Now scale them
constrained along the xy-plane (Skey->Shift+Zkey) a little. This is how it should now look.
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Model a Chair-The Feet
p Forming the base

Figure 1772

In top view select the two topmost faces and extrude to form the back leg. Shape the
tip according based on the reference. Here is the steps taken to shape the tip. First after
extruding, Constrained scale the tip along the x-axis (SKey->XKey) to make the tip thiner.
Then move the tip lower. Deselect all, then select the top vertices of the tip and lower this
vertices further.
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The Lower Telescope
p Extruding a leg

Figure 1773

Shape the base as shown bellow. This is done by selecting the vertices where the leg connects
to the base then constrained scaling it along the y-axis to zero (Skey->YKey->0key). Then
move the scaled vertices further back.
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Model a Chair-The Feet
p Shaping the leg

Figure 1774

Then add an edge loop as shown bellow. constrained scale the newly created edgeloop along
the x-axis to make it thiner.
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The Lower Telescope
p Shaping the leg

Figure 1775

We will be using the subsurf modiﬁer to smooth our model so lets add the following edge
loops so that the model will smooth properly. Add an edgeloop at the tip.
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Model a Chair-The Feet
p Adding control loop

Figure 1776

And this loops on the side.
p Adding control loops

Figure 1777

Also remove the vertex that cap the top because we will not be needing it and it would
cause smoothing artifact when subsurfed.
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The Lower Telescope
p Shaping the leg

Figure 1778

Now how about the other legs? We will be using Spin duplicate tool to make those. In top
view select the central vertex then snap our 3d cursor to it.
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Model a Chair-The Feet
p Relocate 3d cursor to the center of the base

Figure 1779

Now remove the other part of the cylinder as shown. We would be left with a quarter part
of the whole leg assembly.
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The Lower Telescope
p Delete extra vertices

Figure 1780

Select all the vertices that are left. Change the parameters of the spin tool to this: degrees
to 360, steps to 4. Click on the ”Spin Dup”. If you have multiple 3d views, your mouse
cursor would turn into a question mark. Move your cursor to the top view and then click.
The other legs would appear as shown bellow. This legs are made of separate mesh and the
original leg have a duplicate at exactly the same position creating double vertices. Connect
the mesh and remove the doubles by selecting the whole mesh then remove the doubles
(Wkey->Remove Doubles).
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Model a Chair-The Feet
p Spin duplicating other legs

Figure 1781

262.4. The Stops
Now lets create the Black Stops on every tip of the leg. We would be creating this joined
to the legs as one object then separate it later. Its just that it seems more easy that way.
Without leaving edit mode, add a cube. scale an move it to one of the tip. Move the cube
so that it would be lower that usual to separate it from the other mesh making it easier to
edit it without disturbing the others.
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The Stops
p Primitive for the stops

Figure 1782

Shape the cube to match the tip. This should be easy by now. The whole step is left out.
p Shape the primitive

Figure 1783

Subsurf would be used to this too so add extra loops to control how the mesh would be
smooth.
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Model a Chair-The Feet
p Stop with control loops added

Figure 1784

Now make copies of the stops using the Spin Duplicate tool. Don't forget to remove the
doubles.
p Creating the whole stops with Spin duplicate tool

Figure 1785

Select all the tips then move them together up until they intersect with the tips of the legs.
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The Stops
p Positioning stops

Figure 1786

Now lets separate separate meshes to individual objects. Press Pkey and select ”all loose
part” option.
p Separating the Stops

Figure 1787

Notice that the other part of the mesh would suddenly change in appearance. Don't worry.
It just means that those meshes are now separate objects by them selves. If you go to object
view you would now be able to select the leg and the tips as separate objects.
There are some issues though when you use the subsurf modiﬁer on the leg base as shown.
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Model a Chair-The Feet
p Unwanted smoothing eﬀect

Figure 1788

Select the leg and go to edit mode. Add the following edge loop.
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The Stops
p Adding control loop

Figure 1789

Scale the base loop too as shown.

2009

Model a Chair-The Feet
p Scale lower loop

Figure 1790

The issue should now be solved.

2010

The Stops
p Much better

Figure 1791

This is how the whole leg assembly should look. All have subsurf modiﬁer on.
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Model a Chair-The Feet
p Leg assembly

Figure 1792

There is still an issue though. This is not important in most part but will be taken care of
for this time.
When one of the leg stops is selected in object mode, it would show that its center is not
at the center of the mesh. The center is where the gizzmo (the red, blue and green arrow)
would be located.
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The Stops
p object center not at the center of the mesh

Figure 1793

To correct this select the oﬀending object. Click the Mesh menu (located at the header)
and navigate to ”Transform” and select ”Center New” from the options. Blender would
automatically calculate the new center based on the objects mesh. Now when the object is
selected, the center would be located at a mush more appropriate location.
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Model a Chair-The Feet
p Center at proper place

Figure 1794

Do the same to the other stoppers.
Now if you haven't named each individual part yet, You can do it now. Name each part
sensible names like uppertelescope, lowertelescope, etc.

262.5. The Whole Chair
Unhide or Show the layer where your chair seat is so that it would unite with the legs. Now
this is how the whole model should look like.
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The Whole Chair
p Finished Model

Figure 1795
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263. Illustrative Example: Modeling a
Simple Human Character
p Simple human ﬁgure

Figure 1796

2017

Illustrative Example: Modeling a Simple Human Character

We will be modeling this very simple human ﬁgure. This time many details are left out to
save time and space. Its assumed that enough knowledge is gained from previous tutorials
for readers to understand this stage. Shortcut keys are also left out. Read ﬁrst the chair
modeling tutorial if this comes out too diﬃcult to read.
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264. Modeling a Human Character Preparations
Actually, this model is made without any background reference images but enough knowledge of human ﬁgure makes this possible. Modeling the human body or any model in that
case requires knowledge of it beforehand. Even with the background image references, there
are still some details (like the armpit) that is not easily visible or are diﬃcult to comprehend
with just simple orthogonal projections. It is advised to make some study on basic human
ﬁgure and proportions ﬁrst.
For those who likes to have a background reference image to use while modeling, use this
orthogonal views of the model. You could still try and test your knowledge on the human
ﬁgure later by trying to model one without image references.
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265. Modeling a Human Character Modeling
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266. Blocking the Figure
As with many models done in box modeling, let's start with a cube. The model is symmetrical so let's make use of it. Add a loop1 running vertically at the middle and delete the
vertices2 on the left, leaving you with only half of the cube. Now add a mirror modiﬁer3 .
p Initial box

Figure 1797

Now add a loop running horizontally and fashion out the torso.

1
2
3

http://wiki.blender.org/index.php/Doc:2.4/Manual/Modeling/Meshes/Editing/Subdividing/
Loop_Subdivide
http://wiki.blender.org/index.php/Doc:2.4/Manual/Modeling/Meshes/Editing/Basics/
Deleting
http://wiki.blender.org/index.php/Doc:2.4/Manual/Modifiers/Generate/Mirror
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Blocking the Figure
p Forming the torso

Figure 1798

Add a vertical loop on the torso so that we will have more geometry to work on.
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The Whole Chair
p Adding more geometry

Figure 1799

Extrude the head and the legs. Add loops around the head and the bottom of the legs and
extrude out the head and feet.
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Blocking the Figure
p Extrude head and legs

Figure 1800
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The Whole Chair
p The model at another view

Figure 1801

Now add a loop around the torso and extrude out the arms. This is all for blocking
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Blocking the Figure
p Extruding out the arms

Figure 1802
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The Whole Chair
p From another view

Figure 1803
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267. Detailing and Finishing
Add a loop that goes through the torso and the arms and another at the sides. This
geometry will enable us to round and shape the ﬁgure.
p Adding more geometry and rounding the ﬁgure

Figure 1804

Extrude out to form a rough hand. Add an extra loop around the hand and extrude out
the thumb.
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Detailing and Finishing
p Extruding the hand and thumb

Figure 1805

Add more loops around the arm, thumb and hand. Work out this additional geometry to
shape the parts.
p Shaping the hand

Figure 1806

Add this loop to add more geometry on the legs and to the torso.
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The Whole Chair
p Adding geometry

Figure 1807

And then shape.
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Detailing and Finishing
p Shaping

Figure 1808

Add more loops on the leg and shape out the form.
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The Whole Chair
p Forming the legs

Figure 1809

Now time to shape the foot add more geometry and shape out the foot.
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Detailing and Finishing
p Initial form of the foot

Figure 1810
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The Whole Chair
p Final form of the foot

Figure 1811

Now take a look at your model. Adjust the form until satisﬁed. Work ﬁnished.
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Detailing and Finishing
p Doing ﬁnishing touches

Figure 1812
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268. Illustrative Example: Model a Car
(Box)
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269. Illustrative Example: Model a
Dragon
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270. Polygon by Polygon modeling
Although quite demanding, many modelers savor the control poly-by-poly modeling allows.
However, its demanding nature makes many modelers, beginners and experts alike, to avoid
it. Still, poly-by-poly modeling, if properly used, is a powerful tool.

270.1. Before we start
For this work ﬂow, being ready is of great importance. Have several references of your
subject, especially a front and side view. Also, have minutes of study on the subject and
try to make out an approach in modeling it. Being ready is crucial for this.
p Image used as a reference available at the commons

Figure 1813
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Polygon by Polygon modeling
p Loop plans for the model

Figure 1814

270.2. The Workﬂow
Poly-by-poly modeling provides the most free modeling workﬂow ever. This freedom, however, causes confusion on how to approach modeling the subject. Searching the internet for
tutorials on modeling the face using this method, you will ﬁnd hundreds and each will be
diﬀerent from each other. Some start with the eyes, others with the mouth, others the ridge
of the nose. And then each will proceed diﬀerently from that. No wonder its confusing.
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The Workﬂow
Even though poly-by-poly modeling is such a free form method and constitutes a very
vogue way to start and continue, a general guideline is provided in the hope that it will
help modelers in using this approach.

270.2.1. To Start
Poly-by-poly modeling rather sets you free on choosing how and where to start. The only
requirement is that you have a geometry, a vertex or a plane to start with. Many beginners
are stumped by this. Somehow such liberty leaves them undecided.
p Starting geometry

Figure 1815

A very good approach is to start by creating the important loops ﬁrst. For example, in
modeling the face, you could start by creating the eye, mouth and face loops. With the
loops in place, it is easy to build other geometries around them.
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Polygon by Polygon modeling
p Starting with important loops

Figure 1816

Another good approach is to start with the most important part of the subject. For the
face, this is the eyes and the mouth. You could model these parts ﬁrst and then proceed
adding geometry from there.
p Starting with the mouth

Figure 1817
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The Workﬂow
As said, poly-by-poly modeling lets you free, so if you would like to start on other parts
ﬁrst, say the nose, then you could do so.

270.2.2. To Continue
p Continue Adding more geometry. Notice how the loops are placed

Figure 1818

Continuing from your beginnings is not as easy as connecting-the-dots as it ﬁrst appears to
be. Rather than proceeding in a connect the dots fashion, proceed by thinking of edge and
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Polygon by Polygon modeling
face loops of your model ﬁrst then creating and adjusting geometry to ﬁt them. Such view
would ease decision on placing your geometry.

270.2.3. To Finish
p Rendered face after few adjustments

Figure 1819

When you ﬁnd that you don't need to add more geometry, you can call it quits. But still,
its a good practice to take another look of your model and make trial renders of it. There
might be an awry edge loop, geometries that mess the model, or triangles that you wanted
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The Workﬂow
out. Do some ﬁxing and adjusting and when you ﬁnally have the model good, give yourself
a pat on the back.
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271. Illustrative Example: Model a
Woman Face
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272. Illustrative Example: Model a Car
(Polygon-By-Polygon)
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273. Blocking with Primitives
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274. Animation Notes and FAQ
274.1. Blender 3D: Animation Notes and FAQ
274.2. IMPORTANT
This page is under heavy construction. It will probably not be edited better until early May
2012. If someone sends me information on how to convert a OpenOﬃce odt ﬁle to a wikidoc
format, then it may be done sooner. Until then this will be quite a work in progress.

274.3. Authors & Contributors
See here1 .

274.4. Introduction
I found it quite cumbersome to ﬁnd all of the little quirks, problems, and tricks in multiple
sources whenever I would forget something. Therefore, I compiled all of the things I found
important—primarily with character animation. Almost all the information here is consolidated from many sources. Some sources still need to be cited and any help on this would
be much appreciated. For that reason I did not intend to make this public but I think there
is enough need for this type of information so here it is.
Just as a special aside, I made these notes to help myself with my animation project.
Although I have organized them and posted them online for my and others beneﬁt, I will
not be dedicating any large amount of time to this website. All of my extra time needs to
be allocated to the animation project. However, I do not mind suggestions and am willing
to possible use them. I want to make sure that the viewer understands my time is very
limited.
There may be many typos or confusing areas of organization. I tried to organize the mess
of notes as best as possible but I am sure there is an even better way. Feel free to ﬁx any
aspect of this.
Any suggestions or comments feel free to e-mail me at wiki [at] pagodaproductions.com.

1

http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Authors_%26_Contributors
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274.5. Todo List
See here2 .

274.6. Animation FAQ
274.7. Armatures
Q: I managed to create an acceptable walk cycle ﬁnally, now when I reopend the ﬁle to
add additional animation, It keeps falling back to walk cycle, is their something i am doing
wrong. Even after adding the LocRotScale key frame, it still ignores them, and goes back
the corisponding frame for the walk. Ugggghhhh!!!
Q: What is the best approach for rigging a character in Blender?
Q: How do I attach a separate object to a bone?
Q: When you try to scale the root bone of the armature(which scales the mesh), the bones
move out of the natural placement causing unwanted positioning and distortion. Is there
any way around this?
Q: What is a pole vector?
Q: How do I know that my armature is correctly positioned in global space in edit, object,
and pose mode with proper bone rolls and axis pointing in proper directions? What are
the best methods for building? And what axis is up Y or Z?

274.8. Hotkeys
Ctrl-C/Ctrl-V Trick One simple way to get the right name is to select the Lattice, go to
F9, Link and Materials panel and where it says Ob:Lattice or Ob:Lattice.001 etc., move the
mouse over this ﬁeld and press Ctrl-C (don't click on it, just hover over it). This copies the
Lattice name. Then select your object, go to the Lattice Modiﬁer panel, hover the mouse
over the Ob: ﬁeld and press Ctrl-V to paste the name in. Now it should stay there and
your Lattice should work in Edit Mode.
H hides bones
Alt+H shows all bones
Shift+H hides everything except the chain
Ctrl+I [Pose Mode] will automatically add an IK contraint
M [Pose Mode] to move a bone to a bone-layer, select it in POSE mode then press ”m” and
click on the desired layer button. When the bone is selected, you can see which bone layer

2
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http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Todo
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it is on in the Editing buttons / Selected Bones panel. Whichever of the 16 layer buttons
is enabled is the layer the bone will be on.
Shift+M [Pose Mode] You can use the hotkey SH-M to display a ﬂoating bone-layer panel
in the 3d viewport. Select the armature, change to POSE mode, then change to the Buttons/Editing panel (F9). Under the Armature-Panel, Display Options SH-LMB the 8th
button under the Display Options Bone-Layer buttons to enable it. Check out this3 by
BlenderArtists.com.
Alt-N normalize the bone orientation This can ﬁx problems sometimes.
Alt+P clears parent
Alt+S [Pose Mode] in edit mode allows b-bones shape to scale visual changes without
aﬀecting the bones.
W [Edit Mode] subdivides bones
W [Pose Mode] will calculate paths to see how a bones movement is mapped out along a
path or If you've named your bones correctly ( with .L and .R at the end of the name ) ,
you can ﬂip the mirrored bone name by pressing ”W” and ”ﬂip name” . A relevant post on
BlenderArtsists.com is available here4 .

274.9. Approaches, Techniques, Tips and Tricks
Constraining IK or FK In the Armature Bones Panel is where you can limit the movement
of the bone for IK and Limit Rotation Constraint for FK
Customizing Frame Skipping Steps(F10 playback) allows for a customizable way of skipping
frame in increments.
Copying Constraints in pose mode 1. Select all bone(s) you wish to copy the constraints to,
from a particular bone 2. Now, select the bone you wish to copy constraints from 3. Ctrl
C --> Constraints (All)
You can do CTRL-CKEY to copy stuﬀ from a bone to bones. The options are location,
rotation, scale and constraint. Constraint is very handy when you wan to copy a constraint
to other bone. The way it works is easy. The WKEY menu get some neat options too:
Select constraint target: Will select the target of the bone's constraint currently selected.
Flip name: Yep, you can ﬂip name in Posemode too. Calculate/Clear path: This is a visual
way to see the action linked to your armature. You can select just some bones and ask
Blender to show you the paths of the bones.
It's possible to copy constraints from one object/bone to a bunch of objects/bones. A
useful thing to know when doing a repetitive task like rigging all the ﬁngers of a hand. Just
select all bones/objects that you want to give a copy of the constraint, and then select the
bone/object containing the constraints. Press CTRL-CKEY in 3DView, and select Object

3
4

http://blenderartists.org/forum/showthread.php?t=88090&highlight=hotkey+bone+layer
http://blenderartists.org/forum/showthread.php?t=93705&highlight=mirrored+bones
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Constraints from the popup menu. The idea behind this is to copy the constraints of the
active object to the selection.
Rigging Q: What is the best approach for rigging a character in Blender?
A: Apollux Honestly, I don't think that there is a golden set-up that will solve all your
problems. For example, when I design a character rig I need to know beforehand what type
of actions he will perform.
If you want general pointers, I guess this would do: Allways set your rigs in a half relaxed
fashion.. totally relax your hand for a few minutes and see the position of the palm and
ﬁngers, that is position you should model and rig-them on the 3D world. Same goes for
mouth, legs, arms, etc. etc. etc.
When in doubt over IK or FK always choose IK, since it is quite easy to switch a IK rig
into FK when needed and then back to IK.
Bone's axis orientation can't be an afterthought!! It is no coincidence that every selfrespecting rigging tutorial for blender mention it... And don't trust blindly on the automatic
axis orientation ﬁx command (Ctrl-N), since it can introduce some odd solutions on complex
armatures. Always check each bone by hand, even if Blender says they are ﬁxed.
Ultimate rig design is not the in-and-all of character animation. Sometimes I would spent
crazy amounts of time preparing a rig for a special squence, and in the end realize that if
I had used a simple FK rig tricked by hand during animation I would get the same results
in half of the time and half the frustration. Not because it can be done means that it must
be done. BlenderArtists post here5 .
Item Pickup A good use of it is to ask a character to pick up something. By having a bone
or empty for each side of the relationship (hand <-> glass), as the hand approaches the
glass, you can align the two empties and ﬁre the constraint up (1.00) to stick them together.
You add another child-bone in the middle of the hand to tell where the glass will be. Thus
moving the hand will move the glass. On the side of the glass just add an empty and make
it parent of the glass. Add a copy location to the empty pointing to the bone in the hand
we just did. There you go. Of course when the hand rotates the glass will not. For that
you will need to add a Copy Rotation Constraint. Before Blender 2.40, the above method
was a good way of faking parent relationship without rotation. But now we have the hinge
option which does the same.

274.10. Problems and Questions
Separate Object/Bone Attachment Q: How do I attach a separate object to a bone?
A: To do that simply Ctrl-Tab into Pose Mode with the armature selected then select the
object/mesh you want to parent to a bone then shift-select the bone you want to be the
parent and Ctrl-P>”MakeParent to”>Bone .
Armature Scaling Problems Q: I have been trying to scale my character which has many
similarities to the mancandy and ludwig rigs. However, when you try to scale the root
5
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bone of the armature(which scales the mesh), the bones move out of the natural placement
causing unwanted positioning and distortion. Both the mancandy and ludwig rigs have this
same problem. Is there any way around this?
A: Why are you trying to scale the root bone (to scale the whole model)? Are you doing
this in pose mode or object mode? If you are trying to scale the whole model try it in
Object Mode. Also check if you are scaling around the cursor instead of median point
Q: What is a pole vector?
A: Vertex Pusher 2) Pole vector is actually a term used in Maya. It refers to the direction
a bone is set to point towards in Maya rigging. For example, the direction you want the
knees to point towards can be set using pole vectors. Apparently, Blender should be getting
this feature soon . Right now you have to add target bones so that the knees will only bend
one way (see Ryan Dale's BSoD tutorial), but with the option to use pole vectors you won't
need to do this in the future .
BlenderArtists post about bones6 .
Bone Orientation Q: How do I know that my armature is correctly positioned in global
space in edit, object, and pose mode with proper bone rolls and axis pointing in proper
directions? What are the best methods for building? And what axis is up Y or Z?
A: 1. Build up all the bones, as you did before. (Every foot, arm, etc. should be a bit bent,
and drawn from the proper view.)
2. Select all these armatures, and with Ctrl-J join them into one armature. (Or with
parent/child connection, as is necessary.)
3. Select this armature, go to ”Editing” (F9), and then turn on ”draw axes”. Then you can
see the axes of the bones. You will see, that the axes are diﬀerent. Some bones has the
Z-axis up, some has the Z-axis to the left, etc.
4. First you should tell Blender that this is the original position of your skeleton/model by
pushing Ctrl-A. This is applying rotation. This means, that now all the rotations of the
bones will be ”0, 0, 0”, so if you push later Alt-R (clear rotation), you will get this position.
(Turn on numerical menu with N, to see what happens when you make this apply rotation
command.)
5. Select the whole skeleton/model again. Go to edit mode. Then push A, to select all the
bones. (They should be yellow now.) Then hit Ctrl-N, and you will see all the axises will
be changed to stay on the same way.
6. That is, your skeleton now is ready to deﬁne the IK solvers, and then the skinning, and
ﬁnally the animation.
http://blenderartists.org/forum/showthread.php?t=25653
A: Vertex Pusher 4) Yes you should always add in top view[numpad 7]. An armature bone
always has its axes set (Y is always up X side to side and Z depth) and you cannot change
this like you can with mesh objects, so it seemingly won't matter which view you add a
bone while in Edit Mode but in Object Mode your armature object will have a 90 degree
6

http://blenderartists.org/forum/showthread.php?t=110721

2061

Animation Notes and FAQ
rotation around the X axis (if you add it in front view) which can and usually does create
problems down the road . If for some reason you want to add bones in front view simply
start by adding the ﬁrst armature bone in top view ad then switch to front view to add
additional bones . You can just delete the ﬁrst bone or rotate it while in Edit Mode .
Blender's default views have the Z as the ”up” axis while the armature system is coded with
the Y as the ”up” (like most 3D apps)
When you rotate a bone in the front view, when the bone is aligned to that view and the
Z is the up axis, you will give a roll value the bone because it is rotating perpendicular
to its coded up axis ... this can cause you problems in some situations when you want a
”neutral” roll value in Pose Mode... in most cases you'll want to recalculate the roll value
with Ctrl-N (which will remove the visible rotation and insert a value in the ”Roll:” ﬁeld
in the Transform Properties subwindow) and give it a non zero roll value in Edit Mode so
that in Pose Mode it is properly aligned and rotated for poses and constraints ...
You won't get that behavior if you rotate in either the top or side views if the bone is
aligned to the view ...
It's just that if you have the Y axis (the axis the bone rolls on) perpendicular to the Global
Y axis then you will have to recalculate the bone roll angles to get it aligned properly for
pose space .
By ”bone is aligned to the view” I mean what it is like when you ﬁrst add a bone in a preset
view, i.e. head at bottom and tip up at top in Edit Mode with no rotation applied .
http://blenderartists.org/forum/showthread.php?t=110721
A: Fligh If you look at your left hand, palm down, from above, and assume for this exercise
that all four ﬁngers have their X-Axis pointing towards the thumb and have a Roll Angle
of zero (same as if you created an Armature in Top View), but the thumb would need a
Roll Angle of about 90. So if you rotate the ﬁrst digit of the ﬁngers around their Local X
(R-XX) they would go down perpendicular to the back of the hand, but if you rotate the
thumb (Roll Angle 90 and again around the Local X) it would go Left, towards the ﬁngers.
Ahh.... but who bothers to pose bones like that? You just grab the IK Target and move
it!. Well the Transform Matrix is divided into four chunks (I think? I'm not sure of this
but it helps to think of it [or look at it] this way and if you actually test it in Blender it
works), Bone Space (the structure of the bone including Roll Angle), Armature Space (the
structure of the Armature = the sum of all BoneSpace), Pose Space (transforms relative to
Rest Position = recorded changes in BoneSpace within ArmatureSpace) and World Space
(the sum of all the above relative to the (transforms of) the Armature Object.
http://blenderartists.org/forum/showthread.php?t=102209
A: Fligh Anyhow, In Blender, In Top View (always add armatures in Top view) the Z-Axis
is Facing you and Y is Up. So when you add the ﬁrst Bone it lies along the Y-Axis. You
cannot change that parallel-to-Y and any future Bones you extrude will use that bones axis
as reference. If you add an Armature in Front view the bone's (local) Z-axis will point to
the Global -Y (Y-Negative) and can lead to problems later on.
http://blenderartists.org/forum/showthread.php?t=102609&highlight=bone+
orientation
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A: Vertex Pusher Well I guess I may have a little something to contribute to this ... but
I have been trying to learn the armature system in depth for the past few months and
this particular issue came up with a complicated rig I was working with ... and I basically
”discovered” that you really shouldn't have any other axis other than the Y as the ”up” axis
. And precisely because the bone roll angle issue .
It seems that despite how the view ports are conﬁgured (with the Z as the ”up” axis) the
default ”up” axis is the Y ... for everything ... This is a bit annoying but if you have, like
me, conﬁgured Blender to start with the front view open and have the Transform Properties
window always open, you will see that everything when created in the front view is actually
rotated 90 degrees along the X axis once you tab into Object Mode and that you need to
Ctrl-A all objects so created (I guess Blender ”out of the box” has the top view open ? ...
it's been a while so I can't remember ...) . This isn't all that important for most things but
for the armature system this does create a problem - bone roll values that you don't want .
Just as a simple test : Open up Blender and add an armature in the front view . Grab the
tip and move it to a corner of the grid so that it is angled 45 degrees . Tab into Object
mode . Open up the Transform Properties window . You will notice that your armature is
rotated 90 degrees along the X axis . So ... Ctrl-A the armature to have it's ”up” axis as Z
... And suddenly you will see the bone rotate along its roll axis . Tab back into Edit Mode,
select the entire bone and Ctrl-N to recalculate the bone roll angles ... the bone will rotate
back to the way it was ... but with a change in its roll value (-45 or 45 depending on which
way it is angled) ... Now repeat the above but this time create the armature in top view
... And you will realize that despite being angle at 45 degrees to the view like above no roll
value ... not even after recalculating the bone roll angles (Ctrl-N) ...
Now I am assuming that this occurs because the Y axis is the one used to calculate the
bone's roll ... and that if you have anything other than the Y as the ”up” axis the roll values
get screwed up because now the roll axis (Y) is tangent to the up axis instead of being the
up axis . Just turn on ”Draw Axes” and look at what the ”up” axis is for an individual bone
is ... the Y .
And just another bit of proof ... The really great new ”limit” constraints (loc,rot and scale)
added in the last release ... Try and apply the limit rotation constraint to the ﬁrst armature
(the one with Z up and rotation applied) . Now turn LimitX on with no min or max values
and do not turn on the ”local” co-ordinate space ... it will fall ﬂat along the Y axis as if
created in the top view ... This is occurring because despite the fact that you have applied
the 90 degree rotation along the X axis to the object, the constraint is enforcing the global
up axis ... which is ... the Y .
Now the only work around that I could come up with was to create an empty and parent
a Y up armature to it then rotate the empty 90 degrees to be able to use the Z up view
ports and also making sure the mesh also had the proper orientation as the armature .
This prevents me from accidentally applying the rotation to the armature and I can use
the numbpad hotkeys to navigate the views ... ... Else you could just clear the roll values
manually if you insist on having the Z as the up axis ... though you won't be able to get
rid of the rotation that is caused by being tangent to the Y axis without odd roll values ...
Sorry for the long winded response, but this has been bugging me for a while ... Hopefully
with the refactoring for v2.5 later this year there will be an option as to which axis will be
the ”up” axis with regards to the various views ..
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274.11. General Armature Information
Armature Object is like any other object type: It has a center, a position, a rotation and a
scale factor. It can be edited. It can be linked to other scenes, and the same armature data
can be reused on multiple objects. All animation you do in object mode is only working
on the object, not the armature's contents like bones. Link and Materials panel: The AR:
ﬁeld let you rename your armature Datablock. The dropdown is a quick way to select
which Armature datablock you want to connect to this armature. You can keep more than
one version for the same character. Useful when you have a special move to achieve in
a shot, you can turn on an armature for a special purpose. The F button is an option
to assign a Fake user to the Armature. Again if you have more than one armature for
your character, it's a good idea to turn the Fake on, because if your armature datablock is
not used (linked) it's not going to be saved in your .blend ﬁles. You can always do batch
Fake-assignment of armatures by opening the Datablock browser (SHIFT-F4KEY), go in
Armature datablock, select all the armatures you want to keep, and Press the FKEY. The
OB: ﬁeld is just to Rename your armature Object to something more cool and useful than
Armature... Armature.001...
Delay Deform: This was useful before as the old system was very slow. What it does is
when you do a manipulation to the rig, it waits until you ﬁnish to update the view. Can
still be useful though.
Weight: This speciﬁes how strongly this bone will inﬂuence the geometry around it, relative
to the other bones. If two bones crossing each other, both with envelope inﬂuence, have the
same weight (like 1:1) they will inﬂuence the surrounding geometry equally. But if you set
one to 0.5, the geometry will be aﬀected more signiﬁcantly by the other one, with weight 1.
For example, in this image, 2 bones using envelope inﬂuence try to move the same geometry.
The 2 on the left have the same weight, you can see the geometry didn't move. On the
right, one of the bones has 0.5 so the bone with weight 1 is winning the tug-of-war!: Deform:
This lets you say if you want the bone to deform the geometry at all. Switching it oﬀ is like
setting the weight to 0, except it's faster this way. Useful when using a bone as a target or
a controller, i.e. a bone you just want to use to control other bones, but not the geometry
itself. Mult: to deform geometry you can use vertex group and/or Envelope. The ability
to mix both of these methods is handy for using one to tweak the other. For example, you
might use envelope everywhere but tweak diﬃcult places manually with vertex group. We'll
discuss this in more detail later on. There are two number ﬁelds to better tweak the eﬀect
of B-Bones. The in/out is used to tell the scale of the virtual handle of the bezier curve. In
is the Root of the bone, and Out is the Tip. The bigger the value, the bigger the eﬀect of
rotation. You can do ALT-SKEY on one or more bones while in Envelope display mode to
tweak the envelope size in real time while animating. Useful when for example you move
the hand and some part of the character isn't in the inﬂuence zone; the result will be that
some vertices will stay behind.
Tip: Bake envelope to vertex groups The workﬂow is very simple. When you are done with
the envelope's tweaking and you have gotten the best out of it, delete the Armature modiﬁer
and parent the mesh to the armature(CTRL-PKEY). Parent it to ”armature” when asked
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and ”Create From Closest Bones”. Do ALT-PKEY and redo the Armature modiﬁer. Now
all the envelope inﬂuence are converted to Vertex Groups. This way you can further tweak
inﬂuence zone using Weight paint. More info in the following pages. You can edit this
white zone in Editmode or posemode by going in Envelope display mode, selecting bones
and using SKEY or ALT-SKEY The Mult option will tell Blender to multiply the weight
it get from envelope (let say 0.7) with the weight you painted in weight paint (let say 0.5).
The result will be 0.5*0.7=0.35 so in fact you just tweaked the envelope inﬂuence to 0.3
when it was at 0.7. If you don't want vertices to be part of the zone, you can always paint
it with 0, as 0*(something) will always give 0. This way you can give custom shape to your
envelope. More on weight paint on next page.
Deform with only things weight painted Deform + Multiply with only things that are weight
painted within the envelope radius
Process: Make bones. Make good envelope transformations(including some overlap). Alt+P
to make virtual parent(from nearest bones)this will already weight paint parts based on
envelope inﬂuence
”All faces” tells Blender if you want to paint on all faces in the mesh or just the visible
one. ”Vertex Dist” tell blender to use vertex distance instead of faces. When active, the
painting will only check if the vertex is in the brush, then apply a weight value. If it's oﬀ,
all vertice part of the faces in the brush will receive weight value. Turning on Vertex Dist
can give good results when you have a lot of polys in your mesh. Constraints are calculated
from ﬁrst to last. So if you have two Constraints working on the same channel, let say
Location, The last one will most probably win the chance to move the object. But... Most
of the constraints have inﬂuence slider to tell how much it inﬂuence on the stack. If the
last constraint have an inﬂuence of 0.5 it will mix the result with the one before. Most of
the time this little constraint is useful to stick objects to one another. By playing with the
Inﬂuence you can tell when it will work, when it will remain motionless.

274.12. Building Armatures
Ludwig's Stretchy Spine In the spine Ludwig model keep in mind the following things. The
SpineStretch.null is necessary. It must be set to Hinge and Deform to keep the bones from
scaling. IKSpine must have Deform turned oﬀ(none selected). Spine 4 or the last bone
child in the chain(closest to the neck) must have Deform turned oﬀ(none selected). Scaling
problem is usually tied(maybe always) tied to an improper child/parent relationship to a
bone that is involved with stretching.
Created a mirrored copy without using X-Axis Mirror select the bones that you want to
mirror , put the 3D cursor at the center : And make shift + d , and directly , S , X , -1 ...
Other Information You can extrude a new bone from the selection using EKEY. This will
create a bone connected to the original one, meaning the Root of the new bone will follow
the Tip of the original one. You can also CTRL-LMB to extrude a new bone. It will extrude
to where you clicked.
Alternatively, you can connect two existing bones by selecting them one after the other and
pressing CTRL-PKEY. You can then choose either 'Connected' (the child bone - the one
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you selected second - will automatically be moved so that it touches the parent) or 'Keep
oﬀset'. aa Using the WKEY menu, You can subdivide your bone or ﬂip the name of the
bone between Left-Right (See Naming convention below). You can delete the bone with
XKEY You can select a chain of bones (connected together) using LKEY, when you hover
your mouse over a bone. In many cases, rigs are symmetrical and can be mirrored in half.
In these cases, it is helpful to use a left-right naming convention. This is not only useful
for your own sake, but it gives Blender a hint that there is a pair of equivalent bones, and
enables the use of some very cool tools that will save you some signiﬁcant work. It's helpful
to name your bones with something useful telling you what it's there for, such as leg, arm,
ﬁnger, back, foot, etc. If you get a bone that has a copy on the other side, however, like the
arm (you have 2 arms right?), then the convention is to call them arm.Left and arm.Right.
Other alternatives are also possible, like _L, _LEFT, _left, .L, and .Left. Anyway, when
you rig try to keep this left-right thing as accurate as possible; it will pay oﬀ later on. You
can copy a bone named blah.L and ﬂip it over using WKEY --> ﬂip name. So the bone
will be blah.L.001 after you copy it, and ﬂipping the name will give you blah.R. Blender
handily detects if the .001 version already exists, and increments the number for you.

274.13. Useful Rigs
Bassam's(slikdigit) Mancandy 1.0 http://freefactory.org/posts/candy-for-everyone
Bassam's(slikdigit) Mancandy 2.0 One of the most complex rig I have available for Blender.
It has lattice based stretching. http://freefactory.org/posts/candy-for-everyone
Calvin's 05, 2017 This is an alternate foot roll method to Ludwig's rig.
Calvin's handy02
Clean3D's Mouserig http://blenderartists.org/forum/showthread.php?t=79305
Cognis's AnimTest Interesting use of empty's as a bone.
Daniel Martinez Lara's 3-plender leg This is a complex leg rig. It has many IPO driven
bones. http://www.daniel3d.com/pepeland/misc/3dstuff/blender/rig/3-plender_
leg_v0-1.zip
Jason Pierce's(sketchy)
ludwig/ludwig.html

Ludwig

http://jasonpierce.animadillo.com/resource/

Kugyelka's Walkcycle
Martin Georgiev's(Animarto) Walk_anim
Master Yoda
Michael Thoenes's Suzanne Rigged http://creationanimation.com/sites/thoenes/
animation/3dtutorials.htm
Nathaniel Shaw's Generi
Noodlesgc's
(Mike
Roberts)
W1r3z
http://www.esnips.com/doc/
276d8bd1-0070-4ee4-bd8c-e787b507d6a9/W1r3z.blend
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Nozzy's Driven hand http://blenderartists.org/forum/showthread.php?t=18754
Nozzy's Skinny Guy http://blenderartists.org/forum/showthread?t=30994
Otothecleaner's Flor
Virgilio's Otto 1.6 Interesting constraint to keep the feet on the ﬂoor. http://uploader.
polorix.net//files/99/otto_v1.6.zip
Rbackman's Bounce9
Rbackman's Zeyne
Simple's Character
Tugkan's Sharlo
Woodman5k's Bunny http://web.pdx.edu/~wlf/Bunny.rar
Yagapayanata's Rig
Yagapayanata's Rig(2, 4, 6 legs)
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275. Customization
275.1. Changing the Theme
Like many other programs with a graphical user interface, Blender allows you to customize
or modify many aspects of its appearance. A collection of such customizations is called a
theme.
Theme controls are found in the User Preferences window. Click LMB on the ”Themes”
button to activate a drop-down menu which can be used to select diﬀerent themes. Below
this is an ”Add” button that can be used to create new themes. If any themes have been
added, a ”Delete” button will appear, along with other controls to adjust the current theme.
This book presents screen shots using the default theme. If you are new to Blender, you
should continue using the default theme as you progress through the book, to avoid confusion.
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276. Mist - Make Objects Opaque
276.1. How Blender's Mist works
If you render Objects within Blender's Mist, they mix up with the Background-Color,
because Blender decreases their Alpha-Value by increasing Mist-Intensity and distance from
the Camera.

276.2. The Problem
This does a well job if your scene has a constantly-colored Background, but
in case of a real Background or World-Texture it looks not convincing.
All objects are looking like ghosts.

276.3. The Solution explained brieﬂy
This page will show you two ways to get rid of that Problem.
The major thought is to mix Objects with an opaque color, instead of making them
transparent.
The more Transparency, the more of the opaque color will be added.
Because Blender delivers a (dynamic) Alpha-Value with Mist enabled,
we can use this value as a factor for increase or decrease of mixing the objects
with a certain color (or even to enhance or lower the contrast of materials, etc.)
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Figure 1820 Here's a render result with mist and the ”Mixing-Technique”. You see,
that you don't see shining the Background through.

The ﬁrst solution goes with the help of an external compositing program
and won't be explained in depth as we want to focus on how to solve
this issue within blender since it is open source.

276.4. Solution 1: Make use of an external composite
software.
Just render your Background and your Objects separately with Alpha-Channels.
Then you import these ﬁles into a composite program on two layers.
(One for the Objects and one for the Background).
Between these layers you set a new ”Color-Layer” with a solid greyish-blue color
(because this ﬁts the color of the atmosphere) and create a clipping mask.
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Solution 2: Make use of Blender's Composite-Nodes.
A ”clipping mask” means that the ”Color-Layer” is only visible where the objects of the top
layer are.
And where there's no object you can see the Background.
As the object is partially transparent (because of Blender's Mist),
you will see the greyish-blue color shining through.
The more the object is away, the more transparent it is,
and the more the color-Layer will shine through the Objects.

276.5. Solution 2: Make use of Blender's Composite-Nodes.
Since Solution 1 seems not to be a big deal as we cannot aﬀord expensive packages, we are
also able
to achieve this ”Mix-Technique” by Blender's built-in Composite-Nodes.
To continue reading it would be good, if you know a little about Blender's CompositingNodes.
Now, here's the interesting part of the tutorial, the Graph of the Nodes in the Node-Editor:
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Figure 1821

Description:
Step 1 Render Layer1
In the Render Settings Tab you assign the Objects which you don't want to be transparent
to Render Layer1.
See http://wiki.blender.org/index.php/Doc:Manual/Render/Layers for how to deal
with RenderLayers.

Figure 1822

It is important that you turn oﬀ ”Sky” and that you turn on ”IndexPass”. (The Option
”Mist” delivers the same Value as the Alpha-Output in the Node RenderLayer1)
”IndexPass” will be explained in Step 5.
Step 2 Render Layer2
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Solution 2: Make use of Blender's Composite-Nodes.
This Layer renders only the Background, the Sky. In my case I had to enable other
elements also, because otherwise the groundplane won't render.
I don' t know why, but this doesn't matter in our case.
Step 3 Separating RGB+Alpha
The ”Image output” of the Node RenderLayer1 delivers RGB+A, that's a little distracting,
because you can see an Alpha-Output also. Select ”Add” -> ”Color” -> ”Separate RGBA”
in the Node-Editor Window.
Step 4 Combining RGBA
Now the Separated RGB gets combined again to RGB, but this time with a new Alpha of
Step 5.
Step 5 Making the transparent Objects opaque
The good thing is, that Blender's Object-ID Alpha Value does ignore mist.
So we can add an ID-Mask Node to get the Alpha of the Object into the new Image.
Here you must set the ID of the Object to the same number as in the ID-Mask Node.
Select the Object and set its ID Pass-Index!
Beside is a screenshot where you set the Object ID.
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Figure 1823
the object

In the red marked section of the buttons window, you can set the ID of

Step 6 Mixing the Object with a Color
Here you add a Mix-Node to mix the Object with a ”Horizon-Color”.
The Color should be set to a bright greyish-blue as this is the color of the air inner the
atmosphere.
Any color is possible, you may think of a dark red in a ﬁre-hollow or of black if somewhere
out in space.
Step 7 Setting the Factor of how much of the color should be added
Blender delivers an Alpha-Value to the Objects due to the Mist.
If an object is far away or if the Mist-Intensity is very high,
the Alpha-Value of the Object decreases, which means the Alpha-Value becomes more
black.
And if the Object is close, it has accordingly high Alpha, which means getting white.
Black means a Value of R-G-B 0-0-0 and White a Value of R-G-B 1-1-1.
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Solution 2: Make use of Blender's Composite-Nodes.
Since we want to use these values as a factor of how much to blend the Object
with our ”Horizon-Color”, we need to invert this Value.
(Close Objects = High Alpha = Factor almost 1 - but we need Blend Factor close to 0,
because we want low mist as the Object is close)
So let's add an ”Invert-Color-Node”.
Get the Settings of the Node-Graph for this Node.
This Node inverts Black to white, dark-grey to bright grey, etc.
We now use this inverted alpha-value (or Mist-value)
as a factor for mixing the Horizon-Color with the Object.
Step 8 Layering the colored Objects over the Sky-Background
Now you add an Alpha-Over-Node which will layer our Objects over the Sky-Background.

Be aware to use the settings shown in the screenshot and that the order of the two
Image-Inputs
of the Alpha-Over-Node is very important.
The second Input always gets over the ﬁrst Input.
Step 9 Add an Output-Node
Finally you need an Output-Node and to enable ”Do Composite” in the RenderSettings.
Step 10 Example
Here an Example, of how it worked out in my project:
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Mist - Make Objects Opaque

Figure 1824
Mist

Close Distance - Almost no

Figure 1825 Far Distance - Low Mist or
atmospheric opacity

Figure 1826 Further Distance - (!)The
Object is even scaled

Figure 1827 Farthermost Distance - In
original size the Object would be so small
that it isn't visible -only to make the Logic
clear
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Summary

276.6. Summary
Be sure, you got every step right - then all will work out properly.
What is almost of more importance, that you understood the logic behind this,
so that you learn about Blender's Compositing-Nodes and the 01-Logic ;)
Since ”Mist” means something like ”Bullsh**” in German I did not believe that it really
is like that in Blender - and it isn't! Blender is a quite nice and powerful tool.
And I hope that it'll ever be Open-Source.
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• EPL: Eclipse Public License. http://www.eclipse.org/org/documents/epl-v10.
php
Copies of the GPL, the LGPL as well as a GFDL are included in chapter Licenses1053 .
Please note that images in the public domain do not require attribution. You may click
on the image numbers in the following table to open the webpage of the images in your
webbrower.

1053 Chapter 278 on page 2221
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278. Licenses
278.1. GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. <http://fsf.org/>
Everyone is permitted to copy and distribute verbatim copies of this
license document, but changing it is not allowed. Preamble
The GNU General Public License is a free, copyleft license for software
and other kinds of works.
The licenses for most software and other practical works are designed
to take away your freedom to share and change the works. By contrast, the GNU General Public License is intended to guarantee your
freedom to share and change all versions of a program–to make sure
it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our software;
it applies also to any other work released this way by its authors. You
can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price.
Our General Public Licenses are designed to make sure that you have
the freedom to distribute copies of free software (and charge for them
if you wish), that you receive source code or can get it if you want
it, that you can change the software or use pieces of it in new free
programs, and that you know you can do these things.
To protect your rights, we need to prevent others from denying you
these rights or asking you to surrender the rights. Therefore, you have
certain responsibilities if you distribute copies of the software, or if you
modify it: responsibilities to respect the freedom of others.
For example, if you distribute copies of such a program, whether gratis
or for a fee, you must pass on to the recipients the same freedoms that
you received. You must make sure that they, too, receive or can get
the source code. And you must show them these terms so they know
their rights.
Developers that use the GNU GPL protect your rights with two steps:
(1) assert copyright on the software, and (2) oﬀer you this License
giving you legal permission to copy, distribute and/or modify it.
For the developers’ and authors’ protection, the GPL clearly explains
that there is no warranty for this free software. For both users’ and
authors’ sake, the GPL requires that modiﬁed versions be marked as
changed, so that their problems will not be attributed erroneously to
authors of previous versions.
Some devices are designed to deny users access to install or run modiﬁed versions of the software inside them, although the manufacturer
can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software. The systematic pattern of
such abuse occurs in the area of products for individuals to use, which
is precisely where it is most unacceptable. Therefore, we have designed
this version of the GPL to prohibit the practice for those products. If
such problems arise substantially in other domains, we stand ready to
extend this provision to those domains in future versions of the GPL,
as needed to protect the freedom of users.
Finally, every program is threatened constantly by software patents.
States should not allow patents to restrict development and use of software on general-purpose computers, but in those that do, we wish to
avoid the special danger that patents applied to a free program could
make it eﬀectively proprietary. To prevent this, the GPL assures that
patents cannot be used to render the program non-free.
The precise terms and conditions for copying, distribution and modiﬁcation follow. TERMS AND CONDITIONS 0. Deﬁnitions.
“This License” refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds
of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” and “recipients”
may be individuals or organizations.
To “modify” a work means to copy from or adapt all or part of the work
in a fashion requiring copyright permission, other than the making of
an exact copy. The resulting work is called a “modiﬁed version” of the
earlier work or a work “based on” the earlier work.
A “covered work” means either the unmodiﬁed Program or a work
based on the Program.
To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement
under applicable copyright law, except executing it on a computer or
modifying a private copy. Propagation includes copying, distribution
(with or without modiﬁcation), making available to the public, and in
some countries other activities as well.
To “convey” a work means any kind of propagation that enables other
parties to make or receive copies. Mere interaction with a user through
a computer network, with no transfer of a copy, is not conveying.
An interactive user interface displays “Appropriate Legal Notices” to
the extent that it includes a convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells the
user that there is no warranty for the work (except to the extent that
warranties are provided), that licensees may convey the work under
this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a
prominent item in the list meets this criterion. 1. Source Code.
The “source code” for a work means the preferred form of the work for
making modiﬁcations to it. “Object code” means any non-source form
of a work.
A “Standard Interface” means an interface that either is an oﬃcial
standard deﬁned by a recognized standards body, or, in the case of
interfaces speciﬁed for a particular programming language, one that is
widely used among developers working in that language.
The “System Libraries” of an executable work include anything, other
than the work as a whole, that (a) is included in the normal form of
packaging a Major Component, but which is not part of that Major
Component, and (b) serves only to enable use of the work with that
Major Component, or to implement a Standard Interface for which an
implementation is available to the public in source code form. A “Major Component”, in this context, means a major essential component
(kernel, window system, and so on) of the speciﬁc operating system (if
any) on which the executable work runs, or a compiler used to produce
the work, or an object code interpreter used to run it.

The “Corresponding Source” for a work in object code form means all
the source code needed to generate, install, and (for an executable
work) run the object code and to modify the work, including scripts
to control those activities. However, it does not include the work’s
System Libraries, or general-purpose tools or generally available free
programs which are used unmodiﬁed in performing those activities but
which are not part of the work. For example, Corresponding Source
includes interface deﬁnition ﬁles associated with source ﬁles for the
work, and the source code for shared libraries and dynamically linked
subprograms that the work is speciﬁcally designed to require, such as
by intimate data communication or control ﬂow between those subprograms and other parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.
The Corresponding Source for a work in source code form is that same
work. 2. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License explicitly aﬃrms your unlimited permission to run the unmodiﬁed Program. The output from running a
covered work is covered by this License only if the output, given its
content, constitutes a covered work. This License acknowledges your
rights of fair use or other equivalent, as provided by copyright law.
You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in
force. You may convey covered works to others for the sole purpose
of having them make modiﬁcations exclusively for you, or provide you
with facilities for running those works, provided that you comply with
the terms of this License in conveying all material for which you do not
control copyright. Those thus making or running the covered works
for you must do so exclusively on your behalf, under your direction
and control, on terms that prohibit them from making any copies of
your copyrighted material outside their relationship with you.
Conveying under any other circumstances is permitted solely under
the conditions stated below. Sublicensing is not allowed; section 10
makes it unnecessary. 3. Protecting Users’ Legal Rights From AntiCircumvention Law.
No covered work shall be deemed part of an eﬀective technological
measure under any applicable law fulﬁlling obligations under article
11 of the WIPO copyright treaty adopted on 20 December 1996, or
similar laws prohibiting or restricting circumvention of such measures.
When you convey a covered work, you waive any legal power to forbid
circumvention of technological measures to the extent such circumvention is eﬀected by exercising rights under this License with respect
to the covered work, and you disclaim any intention to limit operation or modiﬁcation of the work as a means of enforcing, against the
work’s users, your or third parties’ legal rights to forbid circumvention
of technological measures. 4. Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you
receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms
added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of
this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may oﬀer support or warranty protection for a fee. 5.
Conveying Modiﬁed Source Versions.
You may convey a work based on the Program, or the modiﬁcations
to produce it from the Program, in the form of source code under the
terms of section 4, provided that you also meet all of these conditions:
* a) The work must carry prominent notices stating that you modiﬁed
it, and giving a relevant date. * b) The work must carry prominent
notices stating that it is released under this License and any conditions
added under section 7. This requirement modiﬁes the requirement in
section 4 to “keep intact all notices”. * c) You must license the entire
work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any
applicable section 7 additional terms, to the whole of the work, and
all its parts, regardless of how they are packaged. This License gives
no permission to license the work in any other way, but it does not
invalidate such permission if you have separately received it. * d) If
the work has interactive user interfaces, each must display Appropriate
Legal Notices; however, if the Program has interactive interfaces that
do not display Appropriate Legal Notices, your work need not make
them do so.
A compilation of a covered work with other separate and independent
works, which are not by their nature extensions of the covered work,
and which are not combined with it such as to form a larger program,
in or on a volume of a storage or distribution medium, is called an
“aggregate” if the compilation and its resulting copyright are not used
to limit the access or legal rights of the compilation’s users beyond
what the individual works permit. Inclusion of a covered work in an
aggregate does not cause this License to apply to the other parts of
the aggregate. 6. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of
sections 4 and 5, provided that you also convey the machine-readable
Corresponding Source under the terms of this License, in one of these
ways:
* a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source ﬁxed on a durable physical medium customarily used
for software interchange. * b) Convey the object code in, or embodied
in, a physical product (including a physical distribution medium), accompanied by a written oﬀer, valid for at least three years and valid
for as long as you oﬀer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a
copy of the Corresponding Source for all the software in the product
that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no more than your
reasonable cost of physically performing this conveying of source, or
(2) access to copy the Corresponding Source from a network server at
no charge. * c) Convey individual copies of the object code with a
copy of the written oﬀer to provide the Corresponding Source. This
alternative is allowed only occasionally and noncommercially, and only
if you received the object code with such an oﬀer, in accord with subsection 6b. * d) Convey the object code by oﬀering access from a
designated place (gratis or for a charge), and oﬀer equivalent access to
the Corresponding Source in the same way through the same place at
no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the
object code is a network server, the Corresponding Source may be on a

diﬀerent server (operated by you or a third party) that supports equivalent copying facilities, provided you maintain clear directions next to
the object code saying where to ﬁnd the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain
obligated to ensure that it is available for as long as needed to satisfy
these requirements. * e) Convey the object code using peer-to-peer
transmission, provided you inform other peers where the object code
and Corresponding Source of the work are being oﬀered to the general
public at no charge under subsection 6d.
A separable portion of the object code, whose source code is excluded
from the Corresponding Source as a System Library, need not be included in conveying the object code work.
A “User Product” is either (1) a “consumer product”, which means any
tangible personal property which is normally used for personal, family,
or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer
product, doubtful cases shall be resolved in favor of coverage. For a
particular product received by a particular user, “normally used” refers
to a typical or common use of that class of product, regardless of the
status of the particular user or of the way in which the particular
user actually uses, or expects or is expected to use, the product. A
product is a consumer product regardless of whether the product has
substantial commercial, industrial or non-consumer uses, unless such
uses represent the only signiﬁcant mode of use of the product.
“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to install
and execute modiﬁed versions of a covered work in that User Product
from a modiﬁed version of its Corresponding Source. The information
must suﬃce to ensure that the continued functioning of the modiﬁed
object code is in no case prevented or interfered with solely because
modiﬁcation has been made.
If you convey an object code work under this section in, or with, or
speciﬁcally for use in, a User Product, and the conveying occurs as
part of a transaction in which the right of possession and use of the
User Product is transferred to the recipient in perpetuity or for a ﬁxed
term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be accompanied by
the Installation Information. But this requirement does not apply if
neither you nor any third party retains the ability to install modiﬁed object code on the User Product (for example, the work has been
installed in ROM).
The requirement to provide Installation Information does not include
a requirement to continue to provide support service, warranty, or updates for a work that has been modiﬁed or installed by the recipient,
or for the User Product in which it has been modiﬁed or installed.
Access to a network may be denied when the modiﬁcation itself materially and adversely aﬀects the operation of the network or violates
the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly
documented (and with an implementation available to the public in
source code form), and must require no special password or key for
unpacking, reading or copying. 7. Additional Terms.
“Additional permissions” are terms that supplement the terms of this
License by making exceptions from one or more of its conditions. Additional permissions that are applicable to the entire Program shall be
treated as though they were included in this License, to the extent that
they are valid under applicable law. If additional permissions apply
only to part of the Program, that part may be used separately under
those permissions, but the entire Program remains governed by this
License without regard to the additional permissions.
When you convey a copy of a covered work, you may at your option
remove any additional permissions from that copy, or from any part
of it. (Additional permissions may be written to require their own
removal in certain cases when you modify the work.) You may place
additional permissions on material, added by you to a covered work,
for which you have or can give appropriate copyright permission.
Notwithstanding any other provision of this License, for material you
add to a covered work, you may (if authorized by the copyright holders
of that material) supplement the terms of this License with terms:
* a) Disclaiming warranty or limiting liability diﬀerently from the
terms of sections 15 and 16 of this License; or * b) Requiring preservation of speciﬁed reasonable legal notices or author attributions in
that material or in the Appropriate Legal Notices displayed by works
containing it; or * c) Prohibiting misrepresentation of the origin of
that material, or requiring that modiﬁed versions of such material be
marked in reasonable ways as diﬀerent from the original version; or *
d) Limiting the use for publicity purposes of names of licensors or authors of the material; or * e) Declining to grant rights under trademark
law for use of some trade names, trademarks, or service marks; or *
f) Requiring indemniﬁcation of licensors and authors of that material
by anyone who conveys the material (or modiﬁed versions of it) with
contractual assumptions of liability to the recipient, for any liability
that these contractual assumptions directly impose on those licensors
and authors.
All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program as you
received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further restriction,
you may remove that term. If a license document contains a further
restriction but permits relicensing or conveying under this License, you
may add to a covered work material governed by the terms of that license document, provided that the further restriction does not survive
such relicensing or conveying.
If you add terms to a covered work in accord with this section, you
must place, in the relevant source ﬁles, a statement of the additional
terms that apply to those ﬁles, or a notice indicating where to ﬁnd the
applicable terms.
Additional terms, permissive or non-permissive, may be stated in the
form of a separately written license, or stated as exceptions; the above
requirements apply either way. 8. Termination.
You may not propagate or modify a covered work except as expressly
provided under this License. Any attempt otherwise to propagate or
modify it is void, and will automatically terminate your rights under
this License (including any patent licenses granted under the third
paragraph of section 11).
However, if you cease all violation of this License, then your license
from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and ﬁnally terminates

your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.
Moreover, your license from a particular copyright holder is reinstated
permanently if the copyright holder notiﬁes you of the violation by
some reasonable means, this is the ﬁrst time you have received notice
of violation of this License (for any work) from that copyright holder,
and you cure the violation prior to 30 days after your receipt of the
notice.
Termination of your rights under this section does not terminate the
licenses of parties who have received copies or rights from you under
this License. If your rights have been terminated and not permanently
reinstated, you do not qualify to receive new licenses for the same
material under section 10. 9. Acceptance Not Required for Having
Copies.
You are not required to accept this License in order to receive or run
a copy of the Program. Ancillary propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to
receive a copy likewise does not require acceptance. However, nothing
other than this License grants you permission to propagate or modify
any covered work. These actions infringe copyright if you do not accept
this License. Therefore, by modifying or propagating a covered work,
you indicate your acceptance of this License to do so. 10. Automatic
Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to this License. You are not responsible for
enforcing compliance by third parties with this License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organizations. If propagation of a covered work
results from an entity transaction, each party to that transaction who
receives a copy of the work also receives whatever licenses to the work
the party’s predecessor in interest had or could give under the previous
paragraph, plus a right to possession of the Corresponding Source of
the work from the predecessor in interest, if the predecessor has it or
can get it with reasonable eﬀorts.
You may not impose any further restrictions on the exercise of the
rights granted or aﬃrmed under this License. For example, you may
not impose a license fee, royalty, or other charge for exercise of rights
granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any
patent claim is infringed by making, using, selling, oﬀering for sale, or
importing the Program or any portion of it. 11. Patents.
A “contributor” is a copyright holder who authorizes use under this
License of the Program or a work on which the Program is based. The
work thus licensed is called the contributor’s “contributor version”.
A contributor’s “essential patent claims” are all patent claims owned
or controlled by the contributor, whether already acquired or hereafter
acquired, that would be infringed by some manner, permitted by this
License, of making, using, or selling its contributor version, but do
not include claims that would be infringed only as a consequence of
further modiﬁcation of the contributor version. For purposes of this
deﬁnition, “control” includes the right to grant patent sublicenses in a
manner consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free
patent license under the contributor’s essential patent claims, to make,
use, sell, oﬀer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express
agreement or commitment, however denominated, not to enforce a
patent (such as an express permission to practice a patent or covenant
not to sue for patent infringement). To “grant” such a patent license
to a party means to make such an agreement or commitment not to
enforce a patent against the party.
If you convey a covered work, knowingly relying on a patent license,
and the Corresponding Source of the work is not available for anyone
to copy, free of charge and under the terms of this License, through
a publicly available network server or other readily accessible means,
then you must either (1) cause the Corresponding Source to be so
available, or (2) arrange to deprive yourself of the beneﬁt of the patent
license for this particular work, or (3) arrange, in a manner consistent
with the requirements of this License, to extend the patent license to
downstream recipients. “Knowingly relying” means you have actual
knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient’s use of the covered work
in a country, would infringe one or more identiﬁable patents in that
country that you have reason to believe are valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered
work, and grant a patent license to some of the parties receiving the
covered work authorizing them to use, propagate, modify or convey a
speciﬁc copy of the covered work, then the patent license you grant is
automatically extended to all recipients of the covered work and works
based on it.
A patent license is “discriminatory” if it does not include within the
scope of its coverage, prohibits the exercise of, or is conditioned on the
non-exercise of one or more of the rights that are speciﬁcally granted
under this License. You may not convey a covered work if you are
a party to an arrangement with a third party that is in the business
of distributing software, under which you make payment to the third
party based on the extent of your activity of conveying the work, and
under which the third party grants, to any of the parties who would
receive the covered work from you, a discriminatory patent license (a)
in connection with copies of the covered work conveyed by you (or
copies made from those copies), or (b) primarily for and in connection
with speciﬁc products or compilations that contain the covered work,
unless you entered into that arrangement, or that patent license was
granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any
implied license or other defenses to infringement that may otherwise
be available to you under applicable patent law. 12. No Surrender of
Others’ Freedom.
If conditions are imposed on you (whether by court order, agreement
or otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations
under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For example, if you agree to
terms that obligate you to collect a royalty for further conveying from
those to whom you convey the Program, the only way you could satisfy

both those terms and this License would be to refrain entirely from
conveying the Program. 13. Use with the GNU Aﬀero General Public
License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under
version 3 of the GNU Aﬀero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the covered work, but
the special requirements of the GNU Aﬀero General Public License,
section 13, concerning interaction through a network will apply to the
combination as such. 14. Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may diﬀer
in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program
speciﬁes that a certain numbered version of the GNU General Public License “or any later version” applies to it, you have the option of
following the terms and conditions either of that numbered version or
of any later version published by the Free Software Foundation. If
the Program does not specify a version number of the GNU General
Public License, you may choose any version ever published by the Free
Software Foundation.
If the Program speciﬁes that a proxy can decide which future versions
of the GNU General Public License can be used, that proxy’s public
statement of acceptance of a version permanently authorizes you to
choose that version for the Program.

Later license versions may give you additional or diﬀerent permissions.
However, no additional obligations are imposed on any author or copyright holder as a result of your choosing to follow a later version. 15.
Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR
AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER,
OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF
THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR
THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. 17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above
cannot be given local legal eﬀect according to their terms, reviewing
courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a
warranty or assumption of liability accompanies a copy of the Program
in return for a fee.

You should have received a copy of the GNU General Public License
along with this program. If not, see <http://www.gnu.org/licenses/>.

END OF TERMS AND CONDITIONS How to Apply These Terms
to Your New Programs

If the program does terminal interaction, make it output a short notice
like this when it starts in an interactive mode:

If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these
terms.

<program> Copyright (C) <year> <name of author> This program
comes with ABSOLUTELY NO WARRANTY; for details type ‘show
w’. This is free software, and you are welcome to redistribute it under
certain conditions; type ‘show c’ for details.

To do so, attach the following notices to the program. It is safest to
attach them to the start of each source ﬁle to most eﬀectively state the
exclusion of warranty; and each ﬁle should have at least the “copyright”
line and a pointer to where the full notice is found.
<one line to give the program’s name and a brief idea of what it does.>
Copyright (C) <year> <name of author>
This program is free software: you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation, either version 3 of the License, or (at
your option) any later version.
This program is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty
of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details.

Also add information on how to contact you by electronic and paper
mail.

The hypothetical commands ‘show w’ and ‘show c’ should show the
appropriate parts of the General Public License. Of course, your program’s commands might be diﬀerent; for a GUI interface, you would
use an “about box”.
You should also get your employer (if you work as a programmer) or
school, if any, to sign a “copyright disclaimer” for the program, if necessary. For more information on this, and how to apply and follow the
GNU GPL, see <http://www.gnu.org/licenses/>.
The GNU General Public License does not permit incorporating your
program into proprietary programs. If your program is a subroutine
library, you may consider it more useful to permit linking proprietary
applications with the library. If this is what you want to do, use the
GNU Lesser General Public License instead of this License. But ﬁrst,
please read <http://www.gnu.org/philosophy/why-not-lgpl.html>.

278.2. GNU Free Documentation License
Version 1.3, 3 November 2008
Copyright © 2000, 2001, 2002, 2007, 2008 Free Software Foundation,
Inc. <http://fsf.org/>
Everyone is permitted to copy and distribute verbatim copies of this
license document, but changing it is not allowed. 0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other
functional and useful document ”free” in the sense of freedom: to assure everyone the eﬀective freedom to copy and redistribute it, with or
without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to
get credit for their work, while not being considered responsible for
modiﬁcations made by others.
This License is a kind of ”copyleft”, which means that derivative works
of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license
designed for free software.
We have designed this License in order to use it for manuals for free
software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the
software does. But this License is not limited to software manuals;
it can be used for any textual work, regardless of subject matter or
whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.
1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium,
that contains a notice placed by the copyright holder saying it can
be distributed under the terms of this License. Such a notice grants a
world-wide, royalty-free license, unlimited in duration, to use that work
under the conditions stated herein. The ”Document”, below, refers to
any such manual or work. Any member of the public is a licensee, and
is addressed as ”you”. You accept the license if you copy, modify or
distribute the work in a way requiring permission under copyright law.
A ”Modiﬁed Version” of the Document means any work containing the
Document or a portion of it, either copied verbatim, or with modiﬁcations and/or translated into another language.
A ”Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of
the publishers or authors of the Document to the Document’s overall
subject (or to related matters) and contains nothing that could fall
directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial,
philosophical, ethical or political position regarding them.
The ”Invariant Sections” are certain Secondary Sections whose titles
are designated, as being those of Invariant Sections, in the notice that
says that the Document is released under this License. If a section does
not ﬁt the above deﬁnition of Secondary then it is not allowed to be
designated as Invariant. The Document may contain zero Invariant
Sections. If the Document does not identify any Invariant Sections
then there are none.
The ”Cover Texts” are certain short passages of text that are listed, as
Front-Cover Texts or Back-Cover Texts, in the notice that says that
the Document is released under this License. A Front-Cover Text may
be at most 5 words, and a Back-Cover Text may be at most 25 words.
A ”Transparent” copy of the Document means a machine-readable
copy, represented in a format whose speciﬁcation is available to the
general public, that is suitable for revising the document straightforwardly with generic text editors or (for images composed of pixels)
generic paint programs or (for drawings) some widely available drawing
editor, and that is suitable for input to text formatters or for automatic
translation to a variety of formats suitable for input to text formatters.
A copy made in an otherwise Transparent ﬁle format whose markup,
or absence of markup, has been arranged to thwart or discourage subsequent modiﬁcation by readers is not Transparent. An image format
is not Transparent if used for any substantial amount of text. A copy
that is not ”Transparent” is called ”Opaque”.
Examples of suitable formats for Transparent copies include plain
ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standardconforming simple HTML, PostScript or PDF designed for human
modiﬁcation. Examples of transparent image formats include PNG,
XCF and JPG. Opaque formats include proprietary formats that can
be read and edited only by proprietary word processors, SGML or
XML for which the DTD and/or processing tools are not generally
available, and the machine-generated HTML, PostScript or PDF produced by some word processors for output purposes only.
The ”Title Page” means, for a printed book, the title page itself, plus
such following pages as are needed to hold, legibly, the material this
License requires to appear in the title page. For works in formats
which do not have any title page as such, ”Title Page” means the text
near the most prominent appearance of the work’s title, preceding the
beginning of the body of the text.
The ”publisher” means any person or entity that distributes copies of
the Document to the public.
A section ”Entitled XYZ” means a named subunit of the Document
whose title either is precisely XYZ or contains XYZ in parentheses

following text that translates XYZ in another language. (Here XYZ
stands for a speciﬁc section name mentioned below, such as ”Acknowledgements”, ”Dedications”, ”Endorsements”, or ”History”.) To ”Preserve
the Title” of such a section when you modify the Document means that
it remains a section ”Entitled XYZ” according to this deﬁnition.
The Document may include Warranty Disclaimers next to the notice
which states that this License applies to the Document. These Warranty Disclaimers are considered to be included by reference in this
License, but only as regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has no
eﬀect on the meaning of this License. 2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either
commercially or noncommercially, provided that this License, the
copyright notices, and the license notice saying this License applies
to the Document are reproduced in all copies, and that you add no
other conditions whatsoever to those of this License. You may not use
technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept
compensation in exchange for copies. If you distribute a large enough
number of copies you must also follow the conditions in section 3.
You may also lend copies, under the same conditions stated above, and
you may publicly display copies. 3. COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have
printed covers) of the Document, numbering more than 100, and the
Document’s license notice requires Cover Texts, you must enclose the
copies in covers that carry, clearly and legibly, all these Cover Texts:
Front-Cover Texts on the front cover, and Back-Cover Texts on the
back cover. Both covers must also clearly and legibly identify you as
the publisher of these copies. The front cover must present the full title
with all words of the title equally prominent and visible. You may add
other material on the covers in addition. Copying with changes limited
to the covers, as long as they preserve the title of the Document and
satisfy these conditions, can be treated as verbatim copying in other
respects.
If the required texts for either cover are too voluminous to ﬁt legibly,
you should put the ﬁrst ones listed (as many as ﬁt reasonably) on the
actual cover, and continue the rest onto adjacent pages.
If you publish or distribute Opaque copies of the Document numbering
more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque
copy a computer-network location from which the general networkusing public has access to download using public-standard network
protocols a complete Transparent copy of the Document, free of added
material. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity,
to ensure that this Transparent copy will remain thus accessible at the
stated location until at least one year after the last time you distribute
an Opaque copy (directly or through your agents or retailers) of that
edition to the public.
It is requested, but not required, that you contact the authors of the
Document well before redistributing any large number of copies, to
give them a chance to provide you with an updated version of the
Document. 4. MODIFICATIONS
You may copy and distribute a Modiﬁed Version of the Document under the conditions of sections 2 and 3 above, provided that you release
the Modiﬁed Version under precisely this License, with the Modiﬁed
Version ﬁlling the role of the Document, thus licensing distribution
and modiﬁcation of the Modiﬁed Version to whoever possesses a copy
of it. In addition, you must do these things in the Modiﬁed Version:
* A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions
(which should, if there were any, be listed in the History section of
the Document). You may use the same title as a previous version if
the original publisher of that version gives permission. * B. List on
the Title Page, as authors, one or more persons or entities responsible
for authorship of the modiﬁcations in the Modiﬁed Version, together
with at least ﬁve of the principal authors of the Document (all of its
principal authors, if it has fewer than ﬁve), unless they release you
from this requirement. * C. State on the Title page the name of the
publisher of the Modiﬁed Version, as the publisher. * D. Preserve
all the copyright notices of the Document. * E. Add an appropriate
copyright notice for your modiﬁcations adjacent to the other copyright
notices. * F. Include, immediately after the copyright notices, a license
notice giving the public permission to use the Modiﬁed Version under
the terms of this License, in the form shown in the Addendum below.
* G. Preserve in that license notice the full lists of Invariant Sections
and required Cover Texts given in the Document’s license notice. *
H. Include an unaltered copy of this License. * I. Preserve the section
Entitled ”History”, Preserve its Title, and add to it an item stating at
least the title, year, new authors, and publisher of the Modiﬁed Version as given on the Title Page. If there is no section Entitled ”History”
in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item
describing the Modiﬁed Version as stated in the previous sentence. *
J. Preserve the network location, if any, given in the Document for
public access to a Transparent copy of the Document, and likewise the
network locations given in the Document for previous versions it was
based on. These may be placed in the ”History” section. You may omit
a network location for a work that was published at least four years
before the Document itself, or if the original publisher of the version it
refers to gives permission. * K. For any section Entitled ”Acknowledgements” or ”Dedications”, Preserve the Title of the section, and preserve
in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein. * L. Preserve all
the Invariant Sections of the Document, unaltered in their text and

in their titles. Section numbers or the equivalent are not considered
part of the section titles. * M. Delete any section Entitled ”Endorsements”. Such a section may not be included in the Modiﬁed Version.
* N. Do not retitle any existing section to be Entitled ”Endorsements”
or to conﬂict in title with any Invariant Section. * O. Preserve any
Warranty Disclaimers.
If the Modiﬁed Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied
from the Document, you may at your option designate some or all of
these sections as invariant. To do this, add their titles to the list of
Invariant Sections in the Modiﬁed Version’s license notice. These titles
must be distinct from any other section titles.
You may add a section Entitled ”Endorsements”, provided it contains nothing but endorsements of your Modiﬁed Version by various
parties—for example, statements of peer review or that the text has
been approved by an organization as the authoritative deﬁnition of a
standard.
You may add a passage of up to ﬁve words as a Front-Cover Text,
and a passage of up to 25 words as a Back-Cover Text, to the end
of the list of Cover Texts in the Modiﬁed Version. Only one passage
of Front-Cover Text and one of Back-Cover Text may be added by
(or through arrangements made by) any one entity. If the Document
already includes a cover text for the same cover, previously added by
you or by arrangement made by the same entity you are acting on
behalf of, you may not add another; but you may replace the old one,
on explicit permission from the previous publisher that added the old
one.
The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modiﬁed Version. 5. COMBINING
DOCUMENTS
You may combine the Document with other documents released under
this License, under the terms deﬁned in section 4 above for modiﬁed
versions, provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodiﬁed, and list
them all as Invariant Sections of your combined work in its license
notice, and that you preserve all their Warranty Disclaimers.
The combined work need only contain one copy of this License, and
multiple identical Invariant Sections may be replaced with a single
copy. If there are multiple Invariant Sections with the same name
but diﬀerent contents, make the title of each such section unique by
adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or else a unique number.
Make the same adjustment to the section titles in the list of Invariant
Sections in the license notice of the combined work.
In the combination, you must combine any sections Entitled ”History”
in the various original documents, forming one section Entitled ”History”; likewise combine any sections Entitled ”Acknowledgements”, and
any sections Entitled ”Dedications”. You must delete all sections Entitled ”Endorsements”. 6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document and other documents released under this License, and replace the individual copies
of this License in the various documents with a single copy that is
included in the collection, provided that you follow the rules of this
License for verbatim copying of each of the documents in all other
respects.
You may extract a single document from such a collection, and distribute it individually under this License, provided you insert a copy
of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document. 7.
AGGREGATION WITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate
and independent documents or works, in or on a volume of a storage or
distribution medium, is called an ”aggregate” if the copyright resulting
from the compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit. When the
Document is included in an aggregate, this License does not apply to
the other works in the aggregate which are not themselves derivative
works of the Document.
If the Cover Text requirement of section 3 is applicable to these copies
of the Document, then if the Document is less than one half of the
entire aggregate, the Document’s Cover Texts may be placed on covers that bracket the Document within the aggregate, or the electronic
equivalent of covers if the Document is in electronic form. Otherwise
they must appear on printed covers that bracket the whole aggregate.
8. TRANSLATION
Translation is considered a kind of modiﬁcation, so you may distribute
translations of the Document under the terms of section 4. Replacing
Invariant Sections with translations requires special permission from
their copyright holders, but you may include translations of some or all
Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License, and all the
license notices in the Document, and any Warranty Disclaimers, provided that you also include the original English version of this License
and the original versions of those notices and disclaimers. In case of a
disagreement between the translation and the original version of this
License or a notice or disclaimer, the original version will prevail.
If a section in the Document is Entitled ”Acknowledgements”, ”Dedications”, or ”History”, the requirement (section 4) to Preserve its Title

(section 1) will typically require changing the actual title. 9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document
except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will
automatically terminate your rights under this License.
However, if you cease all violation of this License, then your license
from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and ﬁnally terminates
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.
Moreover, your license from a particular copyright holder is reinstated
permanently if the copyright holder notiﬁes you of the violation by
some reasonable means, this is the ﬁrst time you have received notice
of violation of this License (for any work) from that copyright holder,
and you cure the violation prior to 30 days after your receipt of the
notice.
Termination of your rights under this section does not terminate the
licenses of parties who have received copies or rights from you under
this License. If your rights have been terminated and not permanently
reinstated, receipt of a copy of some or all of the same material does
not give you any rights to use it. 10. FUTURE REVISIONS OF THIS
LICENSE
The Free Software Foundation may publish new, revised versions
of the GNU Free Documentation License from time to time. Such
new versions will be similar in spirit to the present version, but
may diﬀer in detail to address new problems or concerns. See
http://www.gnu.org/copyleft/.
Each version of the License is given a distinguishing version number.
If the Document speciﬁes that a particular numbered version of this
License ”or any later version” applies to it, you have the option of
following the terms and conditions either of that speciﬁed version or
of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published
(not as a draft) by the Free Software Foundation. If the Document
speciﬁes that a proxy can decide which future versions of this License
can be used, that proxy’s public statement of acceptance of a version
permanently authorizes you to choose that version for the Document.
11. RELICENSING
”Massive Multiauthor Collaboration Site” (or ”MMC Site”) means any
World Wide Web server that publishes copyrightable works and also
provides prominent facilities for anybody to edit those works. A public
wiki that anybody can edit is an example of such a server. A ”Massive
Multiauthor Collaboration” (or ”MMC”) contained in the site means
any set of copyrightable works thus published on the MMC site.
”CC-BY-SA” means the Creative Commons Attribution-Share Alike
3.0 license published by Creative Commons Corporation, a not-forproﬁt corporation with a principal place of business in San Francisco,
California, as well as future copyleft versions of that license published
by that same organization.
”Incorporate” means to publish or republish a Document, in whole or
in part, as part of another Document.
An MMC is ”eligible for relicensing” if it is licensed under this License,
and if all works that were ﬁrst published under this License somewhere
other than this MMC, and subsequently incorporated in whole or in
part into the MMC, (1) had no cover texts or invariant sections, and
(2) were thus incorporated prior to November 1, 2008.
The operator of an MMC Site may republish an MMC contained in
the site under CC-BY-SA on the same site at any time before August
1, 2009, provided the MMC is eligible for relicensing. ADDENDUM:
How to use this License for your documents
To use this License in a document you have written, include a copy
of the License in the document and put the following copyright and
license notices just after the title page:
Copyright (C) YEAR YOUR NAME. Permission is granted to copy,
distribute and/or modify this document under the terms of the GNU
Free Documentation License, Version 1.3 or any later version published by the Free Software Foundation; with no Invariant Sections,
no Front-Cover Texts, and no Back-Cover Texts. A copy of the license
is included in the section entitled ”GNU Free Documentation License”.
If you have Invariant Sections, Front-Cover Texts and Back-Cover
Texts, replace the ”with … Texts.” line with this:
with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being
LIST.
If you have Invariant Sections without Cover Texts, or some other
combination of the three, merge those two alternatives to suit the situation.
If your document contains nontrivial examples of program code, we
recommend releasing these examples in parallel under your choice of
free software license, such as the GNU General Public License, to permit their use in free software.

278.3. GNU Lesser General Public License
GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. <http://fsf.org/>

The “Corresponding Application Code” for a Combined Work means
the object code and/or source code for the Application, including any
data and utility programs needed for reproducing the Combined Work
from the Application, but excluding the System Libraries of the Combined Work. 1. Exception to Section 3 of the GNU GPL.

Everyone is permitted to copy and distribute verbatim copies of this
license document, but changing it is not allowed.

You may convey a covered work under sections 3 and 4 of this License
without being bound by section 3 of the GNU GPL. 2. Conveying
Modiﬁed Versions.

This version of the GNU Lesser General Public License incorporates
the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below. 0.
Additional Deﬁnitions.

If you modify a copy of the Library, and, in your modiﬁcations, a facility refers to a function or data to be supplied by an Application that
uses the facility (other than as an argument passed when the facility
is invoked), then you may convey a copy of the modiﬁed version:

As used herein, “this License” refers to version 3 of the GNU Lesser
General Public License, and the “GNU GPL” refers to version 3 of the
GNU General Public License.

* a) under this License, provided that you make a good faith eﬀort to
ensure that, in the event an Application does not supply the function
or data, the facility still operates, and performs whatever part of its
purpose remains meaningful, or * b) under the GNU GPL, with none
of the additional permissions of this License applicable to that copy.

“The Library” refers to a covered work governed by this License, other
than an Application or a Combined Work as deﬁned below.

3. Object Code Incorporating Material from Library Header Files.
An “Application” is any work that makes use of an interface provided
by the Library, but which is not otherwise based on the Library. Deﬁning a subclass of a class deﬁned by the Library is deemed a mode of
using an interface provided by the Library.
A “Combined Work” is a work produced by combining or linking an
Application with the Library. The particular version of the Library
with which the Combined Work was made is also called the “Linked
Version”.
The “Minimal Corresponding Source” for a Combined Work means the
Corresponding Source for the Combined Work, excluding any source
code for portions of the Combined Work that, considered in isolation,
are based on the Application, and not on the Linked Version.

The object code form of an Application may incorporate material from
a header ﬁle that is part of the Library. You may convey such object
code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts
and accessors, or small macros, inline functions and templates (ten or
fewer lines in length), you do both of the following:
* a) Give prominent notice with each copy of the object code that the
Library is used in it and that the Library and its use are covered by
this License. * b) Accompany the object code with a copy of the GNU
GPL and this license document.
4. Combined Works.

You may convey a Combined Work under terms of your choice that,
taken together, eﬀectively do not restrict modiﬁcation of the portions
of the Library contained in the Combined Work and reverse engineering for debugging such modiﬁcations, if you also do each of the following:

You may place library facilities that are a work based on the Library
side by side in a single library together with other library facilities that
are not Applications and are not covered by this License, and convey
such a combined library under terms of your choice, if you do both of
the following:

* a) Give prominent notice with each copy of the Combined Work
that the Library is used in it and that the Library and its use are
covered by this License. * b) Accompany the Combined Work with a
copy of the GNU GPL and this license document. * c) For a Combined Work that displays copyright notices during execution, include
the copyright notice for the Library among these notices, as well as a
reference directing the user to the copies of the GNU GPL and this
license document. * d) Do one of the following: o 0) Convey the
Minimal Corresponding Source under the terms of this License, and
the Corresponding Application Code in a form suitable for, and under
terms that permit, the user to recombine or relink the Application
with a modiﬁed version of the Linked Version to produce a modiﬁed
Combined Work, in the manner speciﬁed by section 6 of the GNU
GPL for conveying Corresponding Source. o 1) Use a suitable shared
library mechanism for linking with the Library. A suitable mechanism
is one that (a) uses at run time a copy of the Library already present
on the user’s computer system, and (b) will operate properly with a
modiﬁed version of the Library that is interface-compatible with the
Linked Version. * e) Provide Installation Information, but only if you
would otherwise be required to provide such information under section
6 of the GNU GPL, and only to the extent that such information is
necessary to install and execute a modiﬁed version of the Combined
Work produced by recombining or relinking the Application with a
modiﬁed version of the Linked Version. (If you use option 4d0, the
Installation Information must accompany the Minimal Corresponding
Source and Corresponding Application Code. If you use option 4d1,
you must provide the Installation Information in the manner speciﬁed
by section 6 of the GNU GPL for conveying Corresponding Source.)

* a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library facilities,
conveyed under the terms of this License. * b) Give prominent notice with the combined library that part of it is a work based on the
Library, and explaining where to ﬁnd the accompanying uncombined
form of the same work.

5. Combined Libraries.

6. Revised Versions of the GNU Lesser General Public License.
The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time.
Such new versions will be similar in spirit to the present version, but
may diﬀer in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library
as you received it speciﬁes that a certain numbered version of the GNU
Lesser General Public License “or any later version” applies to it, you
have the option of following the terms and conditions either of that
published version or of any later version published by the Free Software
Foundation. If the Library as you received it does not specify a version
number of the GNU Lesser General Public License, you may choose
any version of the GNU Lesser General Public License ever published
by the Free Software Foundation.
If the Library as you received it speciﬁes that a proxy can decide
whether future versions of the GNU Lesser General Public License
shall apply, that proxy’s public statement of acceptance of any version is permanent authorization for you to choose that version for the
Library.

